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Welcome to Cumulus

The Cumulus® Digital Asset Management System provides powerful tools for

archiving, managing and marketing your digital files. Cumulus can store any type of

digital media assets, including all types of documents, images, audio, video, layouts

from publishing programs, presentations, and PDF files. 

Once assets are stored, Cumulus becomes a central media repository from which you

and your co-workers can view, locate, search, organize, copy, move, categorize, and

otherwise manipulate the cataloged assets. Once you've settled on a process for stor-

ing and retrieving your digital assets that works for you, the process can be automated,

further enhancing the efficiency of your workflows. 

Cumulus has three distinct access points, designed for different types of users.

Cumulus Portals offers a web portal style interface for file sharing and publishing.

Cumulus Web Client is for work-in-progress. It is ideal for daily work on assets. Cumulus

Desktop Client is where the power user sits. Administrative and user tasks can be done

here.

http://www.canto.com/cumulus
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Using Cumulus Help
The central component of the Cumulus user assistance is Cumulus help.

Canto offers different editions of Cumulus and various add-on products. This help cov-
ers the functionality of Cumulus Workgroup and Enterprise employing the Desktop 
Client or the (Web) Server Console. Functions and feature that are available with cer-
tain editions or add-product only are denoted. 

The Cumulus Web Client and Cumulus Portals provide own help systems. For an over-
view on the help available for different Cumulus components and releases, see 
help.canto.com. How to install Cumulus editions is described in the corresponding 
Installation Guides. These guides also contain descriptions on how to register and acti-
vate add-on products. 

TIP: Are you a Cumulus newbie? 

Then you should start with the Quickstart Guide. 

This help is organized just like a book:

• To page through, use the arrows at the top right.
• To browse chapters, click the Contents icon. The table of contents entries in the 

form of an expandable/collapsible tree view are displayed. Closed folder icons rep-
resent TOC entries that have subentries. To open such a TOC entry, click the folder 
icon. To view a topic, click its entry. The corresponding topic is displayed. 

• To find an item via index, click the Index icon. A list of topics is displayed. Scroll to 
find the index entry you want.

http://help.canto.com/CIG/InstallationGuides_Versions.htm
http://www.canto.com
http://www.canto.com
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• To search for a specific word, enter it in Search field. Type the words you want to 
find and hit Enter or click on the magnifying glass icon. A list of topics is returned.
Note that all search words and phrases are combined with “and”. Entering Canto 
Cumulus will result in all topics that contain Canto AND Cumulus. Wildcard (*) and 
phrase searching are supported. To search for a specific phrase that consists of 
more than one word, enclose the words with double quotation marks. The words 
in quotation marks as one search term. Entering “Canto Cumulus” will result in all 
topics that contain the string Canto Cumulus (i.e. the words Canto and Cumulus 
separated by a space).

Different from a book some text sections are hidden and only denoted by headings 
with a triangle arrow at the right side. To toggle the display on and off, click the head-
ing. Try it below!

TIP: Be up to Date

Load Cumulus Help from the Canto website, where the latest updates will 
always be available. (Help > Source > Online)

Do you prefer reading on paper? Click the Print icon in the top right corner and have 
the current topic printed.

Tell us what you think! We are committed to providing you with high quality docu-
mentation and you can help us to continually improve the documentation that we 
offer by telling us what you think. We appreciate all types of feedback and look for-
ward to hearing from you. Write to us by clicking the email icon  in the top right 
corner.

http://www.canto.com
http://www.canto.com
http://www.canto.com
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Cross-Platform Issues

Cumulus is a cross-platform application, meaning that it runs on Windows® and Mac® 
OS X (Macintosh®) systems. Though the program’s features are identical in each ver-
sion, portions of the user interface differ due to operating system or keyboard conven-
tions. These differences are denoted or explained when necessary and assumed 
otherwise (e.g., the difference between “maximizing” a window in Windows, and 
“zooming” a window in the Mac OS X is not explained).

This icon denotes what pertains to Mac OS X only.

This icon denotes what pertains to Windows only.

User Interface Item Conventions

To differentiate user interface items – buttons, menus, text fields, etc. – from surround-
ing text, those items are displayed in bold. For example:

“Click Open.”

This example means to click the Open button.

Another example: “Select File > Open to open a file.”

This example means to select the Open item from the File menu.

Cumulus Step by Step

Instructional steps are identified by numbers:

1. This would be the first step (and could be the least as well). 

http://www.canto.com
http://www.canto.com
http://www.canto.com
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2. This would be the next step (and could be the least as well).

Copyrights

Copyright 2019, Canto GmbH. All rights reserved.

Canto, the Canto logo, the Cumulus logo, and Cumulus are registered trademarks of Canto, 
registered in the U.S. and other countries.

Apple, Mac, Macintosh and QuickTime are registered trademarks of Apple Computer, Inc. , reg-
istered in the U.S. and other countries.

Microsoft, Windows and Windows NT are either trademarks or registered trademarks of the 
Microsoft Corporation in the U.S. and other countries.

Other third-party product and company names mentioned in this document are trademarks or 
registered trademarks of their respective holders.

CU-C-1115-H-Z-1
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Understanding Cumulus
To get started with Cumulus, you need to understand only a few basic concepts. 
Cumulus creates special files called catalogs, which Cumulus uses to keep track of your 
valuable assets. As you catalog your assets, Cumulus creates special catalog entries 
called records that represent the assets to be managed. Each record contains vital 
searchable information about the asset it represents. To make searching and retriev-
ing records easier, Cumulus lets you organize and classify records into logical groups 
called categories. Any individual set of records comprises a collection. A collection is a 
way of looking at catalog(s).

Get more details about these Cumulus terms:

Assets

An asset in Cumulus is simply any one cataloged file or data stream. A video clip, an 
audio clip, an image, or a page layout document are examples of files that are com-
monly cataloged in Cumulus. But the word file suggests an asset that is stored on a 
digital medium like a hard-disk or CD-ROM. What if the asset is a record in a database? 
This is not a file per se, but as far as Cumulus is concerned, it is a data stream that can 
be cataloged, kept track of and accessed. 

Catalogs

Like a filing cabinet, Cumulus catalogs serve as storage locations for asset collections. 
You can have as many catalogs as you like. Catalogs are cross-platform compatible, so 
it doesn’t matter what type of computer is used to create a catalog. For more informa-
tion, see “Catalogs”.

http://www.canto.com
http://www.canto.com
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Collections

Collections are like snapshots from your open catalog(s). When you work with your 
assets in Cumulus, you’re viewing a constantly changing group of records. Without 
collections, each view of this group would be lost as soon as it is was changed. Collec-
tions, however, enable you to capture any particular set of records and save it as you 
see it - all without disrupting your workflow. Once you see something you like or could 
use again, save it as a collection and recall it whenever you need it. You can even send 
your collection as an attachment to an email message in one easy step.

A collection also acts as your temporary workspace in Cumulus, meaning that changes 
made to your collections do not affect the content of your catalogs. Even deleting a 
record from a collection does not remove it from the catalog (unless you really want 
it to, which you can do, too). For more information, see “Collections”. 

Categories

Like folders in a filing cabinet, Cumulus categories serve to organize assets (files). But 
here the similarities end. Assets can appear in any number of Cumulus categories at 
the sametime. For more information, see “Categories”. 

Records

Records represent assets. Each record represents one asset. Records hold information 
on the asset, such as file size, type, location, creation date, and much more. Cumulus 
allows the creation of customizable record fields, which can contain almost any sort of 
information you desire. Since these user-defined record fields are also fully searchable, 
you can tailor Cumulus to fit your requirements.

http://www.canto.com
http://www.canto.com
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It’s very important to draw the distinction between records and assets. Records are 
part of Cumulus catalogs; assets are not. Records represent assets. For more informa-
tion, see “Assets/Records”.

http://www.canto.com
http://www.canto.com
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Quickstart Guide

Cumulus is Canto’s state-of-the-art Digital Asset Management solution. Cumulus

makes it easy to quickly organize, find, share, and track all of your digital files: photos,

logos, presentations, videos, as well as PDF, Office, or InDesign documents – anything

digital, on any platform. 

http://www.canto.com/cumulus
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Introduction
This Quickstart Guide is designed to give a first impression of Cumulus, its power and 
possibilities, as well as a basic knowledge of the user interface of the Cumulus Desktop 
Client.

Among other things, you will learn how to retrieve assets that are already cataloged in 
Cumulus. Furthermore, you will learn how to catalog your digital assets and how to 
categorize, rate and label them. And for the Cumulus Administrators among you, 
there is a chapter on how to set up a simple Cumulus catalog of your own. 

But let’s start at the beginning. Here’s where you are introduced to the user interface 
of the Cumulus Desktop Client, the most powerful application mainly used when 
working with Cumulus.

All you need to begin is:

• a working Cumulus installation (the installation of Cumulus is not within the scope 
of this document. You’ll find this described in the Installation Guides.

• access to the Cumulus Sample Catalog or any other catalog
• some digital files to catalog
• a certain amount of time (30 minutes at least)

NOTE: Most Cumulus functions can be performed in various ways: via menu 
items, via shortcut menu items from within Cumulus or other applications, via 
keyboard shortcuts, or via drag & drop. 
Therefore, the step-by-step instructions in this Quickstart Guide are just exam-
ples – more often than not, there are other ways to achieve the same goal. Feel 
free to find out which way suits your working habits best! 

http://help.canto.com/CIG/InstallationGuides_Versions.htm
http://www.canto.com
http://www.canto.com
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Further Reading If you have finished this Quickstart Guide and want to start working with Cumulus, or 
if at any point you feel lost and need more detailed information, call the Cumulus 
online help via the help menu, or by pressing F1. Most likely you’ll find everything you 
need to know here, both as the end user and as the person who administrates and 
manages the Cumulus system. 

If you need to know even more, there’s plenty of additional information, articles and 
answers to frequently asked questions in the Canto Customer Community. Not yet a 
member of the Canto Customer Community? Find out how to join via the Canto Web-
site.

http://www.canto.com
http://www.canto.com
http://www.canto.com
http://www.canto.com/support/
http://www.canto.com/support/


CUMULUS – QUICKSTART GUIDE INTRODUCTION

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Some Basics
When working with Cumulus, you will encounter some central terms over and over 
again. These terms and their underlying concepts are crucial for the understanding of 
Cumulus:

Asset Cumulus is all about organizing and managing your digital assets. Each and any digital 
file can be an asset – photos, graphics, PDF files, spreadsheets, Power Point presenta-
tions, even single slides from within a presentation, word documents, audio and video 
clips – you name it. An asset is a file with value added. And this additional value springs 
from the files’ metadata.

Metadata Metadata is any kind of information about an asset – file name, creation date, modifi-
cation date, author, size, number of contained characters, number of pixels, creating 
application, caption, comment, keywords, categories – whatever. some kinds of meta-
data are provided by the files themselves, others are supplied by Cumulus or Cumulus 
users.

Record A record is the representation of an asset inside Cumulus – not the asset itself, but a 
set of information about the asset: its metadata. What kind of metadata are stored in 
a record depends on the kind of asset it represents as well as on the settings specified 
for the respective catalog.

Catalog A catalog comprises all records created from your assets. Technically speaking, it is a 
database, and it is cross platform compatible and thus can be shared between Mac 
and Windows computers. You can even have more than one catalog, e.g. different cat-
alogs for different asset types or purposes.

http://www.canto.com
http://www.canto.com
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Collection A collection is the body of all records you are actually working with, meaning all 
records from a single catalog, or a subsets of records belonging to one or several cat-
alogs. For example, a collection may comprise only records that are relevant for the 
project you are currently working on, or records of a certain type, etc. Collections may 
be saved and re-used later on.

You can open several collections at the same time. Each of them can be displayed in 
its own Collection window within the Cumulus main window. 

Categories Last but not least, there are categories. Each asset can be assigned to one or more cat-
egories – and the other way round: each category can be assigned to one or several 
assets. Information about categories assigned to an asset is stored in the respective 
record as metadata. Categories are a great way to making your life easier and to 
quickly find the needles in the haystack of your assets. 

That’s it – now let’s begin.

http://www.canto.com
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How Does It Feel: 
The Cumulus Main Window

Cumulus is designed as a client/server solution where the Cumulus Server runs on a 
computer somewhere on the network and is accessed by the Cumulus Desktop 
Clients through standard TCP/IP connections, or by a Cumulus Web Client via a stan-
dard Internet connection. What a user of a Cumulus Client – i.e. you – can see and do, 
depends on settings managed by the Cumulus Administrator. So if you can’t use or 
even see some of the features described in this guide, it may be on purpose. If in 
doubt, ask your Cumulus Administrator!

Canto provides a Cumulus Sample Catalog which we use to illustrate the following 
explanations. If for any reason this Sample Catalog is not at your disposal, any other 
catalog you can access will work as well.

Opening a Cumulus catalog:

1. Start the Cumulus Client, e.g. by double clicking the Cumulus icon on your desk-
top.
The Cumulus window appears.

2. Select File > Open Catalog, or click the Open Catalog button ( ).
The Connect to Cumulus Server window appears, 

3. Select a server, if necessary, then enter your user name and password and click 
OK. If in doubt, ask your Cumulus Administrator!
The Catalog Access window appears.

http://www.canto.com
http://www.canto.com
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4. From the Catalog Access window, select the Sample Catalog (or any other cata-
log) and click Open.

The Cumulus main window is displayed, showing the records of the assets in the cat-
alog with thumbnails and selected information.

Menu Bar The menu bar provides the Cumulus functions arranged in clearly named menus. For 
example you’ll find catalog related functions in the Edit menu, or functions to control 

Cumulus main window

http://www.canto.com
http://www.canto.com
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the visual representation of the records on the screen in the View menu. The Meta-
data menu hosts the functions related to the metadata of the assets, and the Asset 
menu functions to handle the assets themselves.

Main Toolbar The main toolbar provides buttons for some of the most popular of these functions. 
When hovering with the pointer over a button, a tip appears revealing details on the 
respective function.

Category Pane The Category pane displays categories belonging to the catalog. The bar at the top of 
the Category pane indicates the total number of categories in all open catalogs, the 
number of currently visible categories and the number of selected ones (if any).

Record Pane The Record pane displays the records of cataloged assets. The bar at the top of the 
Record pane indicates the total number of records in all open catalogs, the number of 
currently visible records and the number of selected ones (if any).

Cumulus offers several ways, or views, to display the records in a catalog. e.g. the 
Thumbnail View as shown in the picture above.

Status Bar With the buttons contained in the status bar, you can toggle on and off additional 
panes, change their order, and manage your workspace.

http://www.canto.com
http://www.canto.com
http://www.canto.com
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View It As You Like It
Cumulus lets you look at your records in various ways. For example, you can change 
the size of the thumbnails using the slider in the main toolbar. Or you can quickly 
switch between views using designated buttons: from the Thumbnail View, which is 
the default, to e.g. the Details View or the Report View 

Each of these views presents specific subsets of the information stored in the records, 
and each of them presents it in a specific way. Which of these views you use in your 
daily work depends on your tasks and your personal preferences.

Which information exactly is presented in any given view, and in which order, is 
defined in so-called Record View Sets. The View Set specially designed for the Sample 
Catalog is “Show Case”. 

The currently applied Record View Set is displayed in the right-most field in the top bar 
of the Record pane and can be changed via the attached list of Record View Sets:

Try switching between views and View Sets to see the differences between them:

Current Record View Set and list of available Record View Sets

http://www.canto.com
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Main toolbar, Details View, Report View

http://www.canto.com
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1. Toggle between different views by clicking the respective buttons –  
– in the main toolbar.

2. Change the current View Set by selecting a different one from the Record View 
Set list. 

3. Again, toggle between different views.

4. Finally, switch back to the Show Case View Set and the Thumbnail View.

See the difference? Each View Set provides a specific flavor with regard to the kind and 
the amount of information that is displayed, but also with regard to background col-
ors, fonts, thumbnail size, etc.

Record View Sets are highly configurable, but they are usually in the responsibility of 
the Cumulus Administrator. If you have questions or proposals concerning the View 
Sets to which you have access, contact your Cumulus Administrator! Beyond that, 
you’ll find all about Record View Sets in the Cumulus online help.

Sorting
One of the most basic things you can do with records displayed in any of these views 
is changing the applied sorting criteria and the sorting order. This works irrespectively 
of the current View Set.

Both sorting criteria and sorting order can be adjusted in the top bar of the Record 
pane, where the current sorting criterion is displayed. 

http://www.canto.com
http://help.canto.com/
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You can choose a different sorting criterion via the drop down list, and you can 
change the sorting order (e.g., ascending or descending) via the arrow symbol to the 
left of the sorting field.

In addition, you may also sort the records in your collection manually by just dragging 
them with the mouse into any convenient order. If you do so, the sorting criteria field 
will display Unsorted.

Current sorting criteria with list of available sorting criteria

http://www.canto.com
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Where Have All My Assets Gone?
So what about the needle in the haystack? How can you quickly find the one asset, or 
that bunch of assets, that you urgently need just now? How can you limit the over-
whelming number of records in your catalog to a reasonable amount of displayed 
records?

• Finding Assets: Quicksearch
• Finding Assets: The Power of the Find Window
• Finding Assets: Search by Category
• Finding Assets: Calendar Search
• Filtering: Less Might Be More

Finding Assets: Quicksearch
The easiest way to find specific records is the Quicksearch function located in the main 
toolbar. 

Simply type a name, a term, or a number into the Quicksearch field and hit Enter, or 
click the magnifying glass button ( ). Cumulus searches the metadata that is stored 
in the records of a Cumulus catalog. (Actually, not all metadata – by default, only cer-
tain metadata fields are taken into account by Quicksearch, like Record Name, Docu-
ment Text, Notes, Keywords, and Categories.) 

Quicksearch field

http://www.canto.com
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The result of your Quicksearch – the records containing the search term – are dis-
played in the Record pane. If no matching record exists, a message is shown.

But of course, searching in Cumulus is not restricted to single words or numbers. To 
search for a term consisting of two or more words, enclose them in quotation marks. 

For example, the search for Canto Cumulus will result in records that contain either 
Canto or Cumulus or both in at least one of the searched record fields. But searching 
for “Canto Cumulus” – with quotation marks – will result in records that contain the 
exact phrase only, i.e. the words Canto and Cumulus separated by a space. You will find 
more search options explained in the tip that pops up when you hover the pointer 
over the magnifying glass.

If the search result still contains a huge number of records, just perform a new search 
and limit it to the current collection, i.e. the results of the previous search. Type a new 
search term into the Quicksearch field, then click the arrow next to the magnifying 
glass button to open the Quicksearch menu and select Find in Collection: 

Quicksearch menu – Find in Collection

http://www.canto.com
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Please notice that this menu also offers a history of your searches. Any of 
these searches can be selected and performed again as a new search:

So, the Record pane now displays the search result – but where is the rest of 
the records from your catalog? You can easily restore the view of the whole 
catalog. Either you clear the Quicksearch field and hit Enter (or click the mag-
nifying glass button ( ), or you just hit  Ctrl+G /  Cmd+G, and there 
you are.

Finding Assets: 
The Power of the Find Window

If the Quicksearch isn’t your cup of tea and you’re looking for really sophisti-
cated search options instead, have a look at the Find Window which reveals 
the true search power of Cumulus. 

To open the Find window:

Quicksearch menu – Search history

http://www.canto.com
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Finding Assets: Search by Category
The Category pane on the left hand side of the Cumulus main window offers another 
easy way of finding records: Double-click a category name to change the current col-
lection to the records that are assigned to the selected category (press Alt and double-
click any other category to add the records of that category to the collection).

Oops, where are the categories? Categories are hierarchically structured. Categories 
with subcategories show a triangle in front of their name, categories without subcat-
egories show a little square. Click a triangle to expand the next level, or Alt-click to 
expand all levels below, and you can easily navigate to the category you are looking 
for. 

Category tree, partially expanded

http://www.canto.com
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If you know the name of the category you are looking for, just type this name into the 
Category Quicksearch field and hit Enter, or click the magnifying glass button ( ), 
and there you are. This comes in especially handy if you can’t remember where a cat-
egory is buried in a category tree (and category trees can be really huge...).

NOTE: By default, double-clicking a category confines the records displayed in 
the Record pane to the records that are assigned to that category (and its sub-
categories, if any). However, this behavior can be changed, either by the 
Cumulus Administrator or even by the user himself, so that only the records of 
the current levels are displayed.

You’ll learn more about categories later. See “Categories, Categories”

Finding Assets: Calendar Search
Assets can also be found by date – to be more precise, by one of the different dates 
stored in one of the records’ fields, such as asset creation date, asset modification date, 
record creation date, capturing date, and many more – depending on the asset type 
as well as on the settings of the respective catalog. 

To perform a calendar search:

1. If the Calendar pane is not already visible, click the Calendar pane button ( ) in 
the Status bar.

http://www.canto.com
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2. Click the Menu button on the Calendar toolbar, then select Field from the menu 
and activate the desired type of date:

In the Calendar pane, dates that will find records are highlighted. 

3. Use the arrow buttons in the Calendar toolbar to switch between months and 
find specific dates.

Calendar Search

http://www.canto.com
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4. Move the pointer over a highlighted date to see a tip displaying the number of 
records related to that date.

5. Double-click a highlighted date to change the current collection to the records 
related to that date. 

6. Double-click another highlighted date to change the collection accordingly.

To display all records in the collection again, hit  Ctrl+G /  Cmd+G, or select Find 
> Find All Records.

Calendar pane with highlighted date and 
number of records related to that date

http://www.canto.com
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Filtering: Less Might Be More
Another convenient way of narrowing down the huge amount of records displayed in 
the Collection window is to filter them. With filters, you can easily adjust what you see 
(what is in your collection): for example, PDF files only, or assets that were created last 
February, or pictures of a certain size, or any combination of criteria.

 Filtering: Setting up filter criteria
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As long as a filter is active, any further search operation – Quicksearch, Category 
Search, whatever – will only take into account the collection as defined by the filter cri-
teria, not the whole catalog. Accordingly, the Find All Records command (or the  
Ctrl+G /  Cmd+G shortcuts, respectively) will only find records that match the filter 
criteria.

Once you’ve found adequate filtering criteria, you can save your configuration(s) as fil-
ters and subsequently switch them on and off as you need them.

Filtering
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All About Assets: 
What to Do With Them

Now that you have found certain assets, you may want to know more information 
about them, or view them in their full beauty instead of as tiny thumbnails. With 
Cumulus, both is easy to achieve.

Mysterious Things: 
Getting Information on Your Assets

Every Cumulus view presents a specific subset of the information stored in the records, 
and each view mode presents it in a specific way, depending on the settings of the 
Record View Sets. 

To to get an overview of relevant information on an asset, use the Information win-
dow. 

To open the Information window:

1. Select a record and click the Information window button ( ) in the main tool-
bar.
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The Information window appears.

Information window (fields with light-colored background are user-editable)
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2. You may want to arrange the Cumulus main window and the Information win-
dow side by side on your monitor. Thus you can benefit from the fact that the 
information displayed in the Information window can follow the selection in the 
main window.

3. Change the record selection in the main window. The Information window 
changes accordingly.

As you might expect, the Information window as seen on your monitor may differ 
from the screenshot above, depending on the chosen Record View Set and the set-
tings of the catalog you use. You may change the Record View Set via the Record View 
Set list in the Information window toolbar.

The information displayed in the Information window may be segmented into groups 
divided by separators. Clicking a separator collapses or expands the respective group 
of information.

The Information window not only displays a vast variety of information, or metadata, 
on your assets – it also allows you to modify certain metadata values such as Notes, 
Keywords, or Rating. If you have the appropriate permissions, of course. You will learn 
how to do this later on, see “Do It Yourself: The Information Window” 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – QUICKSTART GUIDE ALL ABOUT ASSETS: WHAT TO DO WITH THEM

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Beautiful Things: 
Preview Your Assets

Thumbnails are nice for getting an overview or a first impression, but if you want to 
explore an asset in detail, you must use other means. Therefore, Cumulus provides 
asset previews or, to be more specific, different modes for previewing assets. To see a 
preview of an asset:

1. In the Record pane, select the record of the asset you want to preview and click 
the Preview window button in the main toolbar.

A preview of the asset is displayed in a new window. Thus you can see your cur-
rent collection and the preview of the selected asset side by side.

The toolbar of the Preview window offers functions for handling the preview, such as 
zooming in and out, flipping and rotating, and adding comments and annotations in 
different styles directly into the preview of the asset. When hovering with the pointer 
over an button, a tip appears presenting details on the respective function. 
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Preview window with comments column
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Commenting On Your Assets
The commenting feature is a means to clip hints or thoughts about an asset and to 
share them with other users. 

To add a comment to an asset opened in the Preview window:

1. Make sure that user comments are switched on via the appropriate button in the 
Preview toolbar.

2. From the Comments toolbar, select the kind of comment you want to add by 
clicking the respective icon: either a general comment (“just a comment”), or a 
comment that is tied to a specific area on the preview of an image.

3. For a general comment, just enter it in the text box.

Preview window toolbar and Comments toolbar
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For a comment that is tied to a specific area, draw a rectangle or a polygon or 
place a sticky note symbol in a suitable position, then enter your comment into 
the text box.

4. When you close the Preview window, your comments are automatically saved 
and subsequently displayed to other users. 

The comments and notes you add are stored as metadata in the asset’s record and can 
be searched and retrieved anytime – provided that your Cumulus Administrator has 
prepared the catalog to support searching in comments.

A Polygon Comment on an asset preview
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Big Things: The Fullscreen Preview
Finally, there is the Fullscreen Preview. To open an asset in Fullscreen Preview:

1. Select the respective record in your collection.

2. From the Asset menu, select Fullscreen Preview, or 
press  Ctrl+Shift+Y /  Cmd+SHIFT+Y
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A preview of the asset is opened in fullscreen mode.

Fullscreen Preview
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Move the pointer to the bottom of the Fullscreen Preview, and a toolbar appears offer-
ing buttons for navigating, for getting help and for closing the window. 

If you leave the mouse pointer for a second on the Help button ( ), a list of com-
mands available in Fullscreen Preview is displayed. Clicking this button opens the 
Cumulus help.

But the Fullscreen Preview can do even more. If you move the pointer to the left hand 
side of the screen, an information pane is displayed. By default, this pane disappears 
again when you move the pointer away. However, you can make it sticky, if desired, 
by clicking the pin symbol in the upper left corner.

To quit the Fullscreen Preview, just pres the ESC key on your keyboard.

By the way, with the Fullscreen Preview, you are not restricted to preview just one 
asset at a time. In fact, you can preview ut up to six assets simultaneously by first select-
ing their records, then selecting Fullscreen Preview from the Asset menu. This makes 
the quick comparison of various assets a mere child’s play.

Fullscreen Preview toolbar
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Real Things: Get Your Assets
Now that you have searched your catalog and found certain assets, and have addition-
ally examined them in fullscreen preview – now you know which of your assets you 
need for your further work. But how can you get to them? Well, that's another thing 
that’s made very easy by Cumulus: just drag the appropriate records from the Collec-
tion window to any folder or directory within your file system, and the corresponding 
assets will be copied to that place. 

Instead of a record, you may also drag a category to any place you want, and a folder 
is created with the same name as the category containing all assets assigned to that 
category. It is as simple as that.

Furthermore, you may select one or more assets and select Show Location from the 
Asset menu. The folder(s) containing the selected asset(s) will be opened in new  
Explorer /  Finder windows. The respective file(s) are highlighted.

Last, but not least you may even drag the assets directly to the application where you 
want to use them, if the target application supports drag & drop.
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Metadata: Make Things Significant
Remember what we said at the beginning of this Quickstart Guide: Cumulus is all 
about organizing and managing your assets. However, in order to do so, Cumulus 
leaves the actual assets alone and only handles their metadata.

Metadata is any kind of information about an asset – file name, creation date, modifi-
cation date, author, size, number of contained characters, number of pixels, creating 
application, caption, comment, keywords, categories – whatever.

There are countless possibilities for metadata, depending on the type of asset. Some 
of them, such as file name, date, or size, apply to all assets, others only to certain asset 
types. Data like aperture or exposure time make sense with photographs, but not with, 
say, PDF files. 

A lot of metadata is supplied by the asset itself. The user, however, can add as much 
user-defined metadata as needed. Adding various kinds of metadata to your records 
– or modifying existing metadata values – can not only considerably facilitate the 
organizing of your assets, but can also substantially increase their value. You already 
got to know the commenting function (see “Commenting On Your Assets” ), which 
provides some quite a sophisticated ways of adding metadata to your assets. But 
there’s a whole bunch of other options, too.

Do It Yourself: The Information Window
You can modify certain of your assets’ metadata values from within the Information 
window (see “Mysterious Things: Getting Information on Your Assets” ).

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – QUICKSTART GUIDE METADATA: MAKE THINGS SIGNIFICANT

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Whether values are editable or not depends on the settings of the catalog and on your 
user permissions. Most likely, you will at least be able to edit fields like Notes, Key-
words, or Rating. In the Information window, user editable fields have a white back-
ground color, while fields whose values cannot be changed have a grey background 
color.

To edit a metadata value in the Information window, e.g. to add a note:

1. Select the record to which you would like to add a note and click the Information 
window button ( ) in the main toolbar.The Information window appears.

2. If necessary, change the Record View Set, scroll through the Information window, 
or expand/collapse sections until you see the Notes field. 

3. Click into the Notes field and type in your note (e.g., “What a beautiful picture!”).

4. Save your modification by clicking the Save button ( ) in the Information win-
dow toolbar.

Your note is saved with the record.

If you forget to save your modification, Cumulus will ask you to do so as soon as you 
select a different record. 

NOTE: Depending on the settings of the catalog and on your user permissions, 
the contents of the Notes fields of your records may be searchable via Quick-
search or the Find window. (See “Finding Assets: Quicksearch”, and “Finding 
Assets: The Power of the Find Window” .)
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Categories, Categories
Cumulus categories are used to organize records, much like folders are used to orga-
nize files in a traditional filing cabinet. But as well as a category can be assigned to any 
number of records, the contrary is also true: any asset can appear in any number of cat-
egories. This not only facilitates retrieving assets, but allows for the creation of a net-
work of relations between assets. That is the big difference between categories and 
folders in a filing cabinet or even in an operating system.

 By default, each Cumulus catalog comes with three master categories – Sources, Key-
words and Categories. Each master category has its own hierarchical structure of 
nested subcategories. Whether all master categories are displayed in the category 
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pane or only one of them is up on you. Just open the drop-down list on top of the Cat-
egory pane and select the type of category you want to display.

You’ve already learned how to use categories as one of the easiest methods to quickly 
find assets – double-clicking a category displays all records assigned to that category 
in the current collection (see “Finding Assets: Search by Category” ). But how do assets 
get categorized? 

Automatically
Created

Categories

First of all, Cumulus automatically adds source categories to the metadata during the 
cataloging process. (Other categories can be automatically added, too, but that’s 
another story.) The Sources categories reflect the folder or directory hierarchies in 
which the assets were stored when they were cataloged.

Master categories and categories of the Sample Catalog with nested subcategories, 
collapsed and expanded
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Categories
Created by You

Apart from the automatically created categories, it’s basically up to you to categorize 
your assets – provided, as always in Cumulus, that you have the appropriate permis-
sions. If in doubt, talk to your Cumulus Administrator!

To take full advantage of Cumulus, you have to create and implement your own cate-
gory tree, either as Categories or as Keywords or both (but it is a good idea not to tam-
per with the automatically generated Sources categories).

You might ask yourself, what is the difference between Categories and Keywords? Well, 
basically, they are the same thing, the difference is merely a semantic one. 

For example, you could devote Categories to reflect the states of a workflow, or the 
structure of your organization, and use Keywords to tag your assets and make them 
accessible with regard to their content. That is completely up to you – or maybe rather 
to your Cumulus Administrator.

To create a new category (no matter whether under Categories or under Keywords):

1. Right-click the category in which the new category should be nested.

2. From the Shortcut menu, select New Category. 

This creates a category nested in the selected category.

3. Give the new category an appropriate name. 

You can easily change the category hierarchies by dragging a category onto another 
category anywhere in the category tree(s). 
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Assigning Records to Categories, or Vice Versa
Assigning categories to records, or records to categories, is easy:

1. Select a category or several categories and drag them onto the record you want 
to assign them to.

OR

Select one or several records and drag them onto the category you want to 
assign them to.

That’s handy if you only have to deal with a few records and a few categories. But with 
lots of categories and lots of records, its much more convenient to use the Assign Cat-
egories menu item:

1. Select the records you want to categorize.

2. Select the categories to which you want to assign the selected records.

3. Select Metadata > Assign Categories. The records are assigned to each of the 
currently selected categories.
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Detaching Category Assignments
Removing a record’s category assignment is just as easy:

1. Select the record whose category assignments you want to change.

2. Select Metadata > Information. The Asset Information window appears.

3. Select the category you wish to remove and press the Delete key.

4. In the Asset Information window, click the Save button ( ) to save your 
changes.

Again, if you have to deal with lots of categories and lots of records, it is much more 
convenient to use the Detach Categories menu item:

1. Select one or more records.

2. Select the categories which you want to detach from the selected records.

3. Select Metadata > Detach Categories. The records are detached from each of 
the currently selected categories.
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Ratings
With Cumulus you can rate your assets from 1 to 5. Rating values are searchable, so 
when you want to find your best assets, it's easy to do so. 

Ratings are shown as stars. A rating field can be displayed in most views and windows, 
depending on the settings in the respective Record View Sets. 

To set (or remove) a rating value:

1. Select the record(s) you want to rate.

2. Right-click the selected record(s). From the Shortcut menu, select Assign Rating 
and then the value you want to assign.

Thumbnails with rating stars
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Labels
With Cumulus you can label your assets with various colors, which is a convenient way 
to mark them for different purposes. 

Labels can be displayed in most views and windows, depending on the settings in the 
respective Record View Sets. 

To set (or remove) a label:

1. Select the record(s) you want to label.

2. Right-click the selected record(s). From the Shortcut menu, select Assign Label 
and then the label color you want to assign.

Thumbnails with labels of different colors
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Files to Assets: Cataloging Your Digital 
Files

Chances are that you never need to do this. Maybe someone else in your organization 
is responsible for cataloging things, and you don’t even have the appropriate Cumulus 
permissions. 

On the other hand, maybe you are the one who’s in charge of the catalog? Your 
Cumulus Administrator may assign you appropriate permissions anytime. Then you’ll 
be glad to know how simple it is to add files to a Cumulus catalog. 

As you might expect, Cumulus offers a whole bunch of ways for adding assets to cat-
alogs. Besides the drag & drop method as described here, you could also use the File 
> Add Assets to Catalog menu item from within Cumulus. And there is the Add to 
Cumulus Shortcut menu item available from in the Windows Explorer or the Mac OS 
Finder. The result would be the same.

To add new items to a Cumulus catalog via drag & drop:

1. Use the Mac OS Finder or the Windows Explorer, respectively, to navigate to the 
files you want to catalog. Select the respective files or the containing folders and 
drag them into the Record pane of your catalog.

2. Possibly, the Add Assets to Catalog window box appears. If so, choose an Asset 
Handling Set from the Use Asset Handling Set list, e.g. Images (Fast), and click 
OK. (If in doubt, ask your Cumulus Administrator.)

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – QUICKSTART GUIDE FILES TO ASSETS: CATALOGING YOUR DIGITAL FILES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Cumulus starts to create records for the selected files or the files contained in the 
selected folders and their subfolders. This may take some time.

While Cumulus catalogs your assets, the Metadata Editor window is shown displaying 
some information, a progress indicator, and a Cancel Progress button.

Once the cataloging process is finished, the respective records are displayed in your 
current collection. If you can not see them immediately, try to sort your collection 
anew. 

TIP: Dragging onto a category

Instead of dragging files or folders onto the Record pane, you can also drag 
them onto a category in the Category pane. Then the assets will not only be 
cataloged, but simultaneously assigned to that category.

Now, that is easy, isn’t it?
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Making It Work: Setting Up a Catalog
NOTE: This section is mainly aimed at Cumulus Administrators, because if you 
are not the Cumulus Administrator, you are not allowed to create new catalogs. 
In this case, feel free to skip this chapter!

Imagine you’ve got a whole lot of images and PDF files – photographs, product 
descriptions, newspaper articles –, files you may want to share with other people like 
customers or employees. Of course you don’t want anybody to mess things up in your 
file system or local network, or to modify your original assets. 

That’s why you need Cumulus. 

Setting up a catalog of your own is easily done – assumed, of course, that you have 
been granted the appropriate permissions. 

Technically speaking, a catalog is a database that holds all the information about your 
assets. A catalog does not contain the assets themselves, but records about them – 
one record per asset.

Thus, it is crucial to ensure that your new catalog contains all appropriate data fields 
for the storage of the desired information. To make things easier, Cumulus provides 
preconfigured Catalog Templates for different purposes. For example, a catalog based 
on the Catalog Template for Images contains fields for picture-specific information like 
the EXIF data or the IPCT data that is contained in your digital photographs. This would 
not be the case with a catalog based on the Standard Catalog Template.
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Create a new catalog, e.g. for your images and PDF files:

1. Start the Cumulus Desktop Client and connect to the Cumulus Server: File > 
Connect to Cumulus Server.

2. In the Catalog Access window, click New.

3. In the Browse window, enter a name for the new catalog into the File name field 
(e.g. MyPictures), then click OK.

4. In the Create New Catalog window, select Catalog Template for Images from 
the template list, then click OK.

The new catalog is listed in the Catalog Access window.

5. Make sure that the Open selected catalog(s) in new window is activated.

6. Finally, click Open.

The new, still empty catalog is displayed in a new Collection window. 

So far, the new catalog is available only to its creator – to the Cumulus Administrator. 
There is one more step necessary to make the new catalog available for other 
Cumulus user:

1. Make sure the Collection window containing your new catalog is the active win-
dow in Cumulus. 

2. Select Cumulus > Preferences / Edit > Preferences. 

3. Click Catalog Settings.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – QUICKSTART GUIDE MAKING IT WORK: SETTING UP A CATALOG

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

The Catalog Settings window appears. If the active Collection window contains 
more than one catalog, select your new catalog from the Catalog list.

4. In the Sharing section, activate the Share catalog option. 

5. Confirm your settings and close the Preferences window with OK.

Only with the Share catalog option activated, other Cumulus users can access the 
new catalog, too. That is, if they have the appropriate permissions. But user manage-

Preferences – Catalog Settings: Sharing
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ment and permission handling are different stories, and not in the scope of this Quick 
Start Guide.

Just in Case: Central Asset Location
Before you actually start to catalog your assets, there is one more topic to be consid-
ered: Where will your cataloged assets reside? You have two options: either leaving 
them where they are, or copying them to a central storage location.

Cumulus can manage assets regardless of their storage location in your file system. 
Perhaps you have already set up a folder hierarchy that fits your specific needs or your 
sense of order. Then there is no need to change that. The cataloged assets remain 
where they are. Cumulus, however, will preserve your order and map it out in the 
Sources categories, thus allowing you to easily navigate within a structure you are 
already familiar with. If that is the case, you may now begin to add assets to your cat-
alog, just as described in the chapter “Files to Assets: Cataloging Your Digital Files” 

On the other hand, you might consider to collect your newly cataloged assets in a cen-
tral storage place on your file server. This might be a good idea especially if the files 
you want to catalog and manage with Cumulus are scattered all over your hard disks 
or your local network. It is also more secure to use a central location, because it lowers 
the risk of accidentally corrupting your data structure. Arbitrary files or folders are easily 
moved or deleted, and even though this would not affect your catalog or the con-
tained records, the assets referenced within them could no longer be accessed.
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NOTE: A Central Asset Location is a per-catalog-setting, i.e. each catalog can 
have its own Central Asset Location, regardless of the settings in any other cat-
alog.

So, if you do want to have your assets copied to a central storage location just while 
cataloging them, here is how:

1. Make sure the Collection window containing your new catalog is the active win-
dow in Cumulus. 

2. Select Cumulus > Preferences / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window appears. If the active Collection window contains 
more than one catalog, select your new catalog from the Catalog list.
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4. In the Copy Assets to Central Location section, activate the Use Central Asset 
Location option. 

5. Click Browse to specify a location. In the Choose an Asset Storage Module win-
dow, confirm the preselected asset store for your operating system. The Browse 
For Folder window appears. Select a folder you want to use as your Central Asset 
Location and click OK.

6. From the Mode list, select Always.

Preferences – Catalog Settings: Central Asset Location
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7. Confirm your settings and close the Preferences window with OK.

Now you can begin to add assets to your catalog, just as described in the chapter “Files 
to Assets: Cataloging Your Digital Files” . During cataloging, the assets are automati-
cally copied to the Central Asset Location defined for your catalog.
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This is Not the End... 
This is the end of our short survey of Canto Cumulus which introduced you to the user 
interface and some of the most popular and important functions of Cumulus. Maybe 
you already feel quite familiar with Cumulus? Congratulations, then!

However, chances are that you still feel a little confused and overwhelmed by 
Cumulus and its countless functions and possibilities. If so, do not worry – this is quite 
normal. The more you use Cumulus, the more familiar you will get with it, and the 
more you will benefit from it.

In any case, you should now feel confident to perform basic tasks with Cumulus. If 
questions arise, or if you just want to learn more, call the Cumulus online help via the 
help menu, or by pressing F1. Or visit the Canto Cumulus Website, providing you with 
a wealth of information and useful links to Cumulus Professional Services, Cumulus 
News, Experts, and Webinars.

http://www.canto.com
http://www.canto.com
http://www.canto.com
http://www.canto.com/cumulus/


CUMULUS – QUICKSTART GUIDE THIS IS NOT THE END...

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

http://www.canto.com
http://www.canto.com
http://www.canto.com


canto.com/cumulus

Explore Cumulus

In order to exploit the potential of Cumulus fully, it’s necessary to proceed from a

strong foundation. It’s a good idea to know the meaning and capabilities of the fea-

tures you’re using in Cumulus and how they’re related. 

This chapter contains an overview of the Cumulus Desktop Client interface and

describes the basic components of Cumulus in more detail:

• Catalogs 

• Collections 

• Assets/Records 

• Categories 

• Sets and Templates 

http://www.canto.com/cumulus
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The Desktop Client User Interface
The Cumulus Desktop Client main window, your workspace, is the Collection window. 
It provides two main panes, the Category pane and the Record pane. Additional 
panes, e.g. the Info pane, can be activated.
 

1 Main Toolbar – provides icons for some of the most popular functions and for modifying 
the workspace. For details refer to the tool tips that appear when hovering with the mouse 
over an icon.

2 Category Pane – displays categories. Each Cumulus catalog provides three master cate-
gories by default (Categories, Keywords and Sources), each of which builds its own category 
tree. A drop-down list (A) allows to switch between the display of all categories or any of the 
master category trees. Categories may be searched for via the category quicksearch field (B).

1

2 3

4

A

B
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The top bar of the Category pane indicates the total number of categories in all open cata-
logs, the number of currently visible categories and the number of selected ones (if any). 
Additionally, the Category pane top bar contains three icons.

• Category Pane Top Bar Icons

 indicates the active category search options; opens the Search & Sort preferences 

 opens a menu to change the Category View Set

 closes the Category pane
3 Record Pane – displays the records of cataloged assets.

The top bar of the Record pane indicates the total number of records in all open catalogs, the 
number of currently visible records and the number of selected ones (if any). Additionally, the 
Record pane top bar contains icons and selection lists.

• Record Pane Top Bar Icons and Selection Lists

 displays and/or activates filters

 toggles the display of records (records of master assets only/records of all assets). (For 
more information, see page 318.)

 toggles the sort order (ascending/descending)

 displays the current sorting criteria; 
clicking on the arrow opens a selection list of available sorting criteria (record fields)

 displays the current Record View Set; 
clicking on the arrow opens a selection list of available Record View Sets

 opens/closes a subpane of the Record pane (for more information, see page 315.)
4 Status Bar – contains icons for toggling the display of additional panes and one icon to 

change the order of the left side panes.

http://www.canto.com
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• Status Bar Icons

 opens a menu to mange the workspace

 hides/shows the Category pane

 shows/hides the Information pane (providing further information on the selected 
record)

 shows/hides the Category Information pane (providing information to the selected cat-
egory)

 shows/hides the Thumbnail pane

 shows/hides the Preview pane

 shows/hides the Calendar pane
All panes listed above are displayed on the left side of the Record pane.

 shows/hides the Collection Basket pane on the right side of the Record pane

 opens a dialog to rearrange the order in which the panes on the left side are displayed.

http://www.canto.com
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Catalogs
A Cumulus catalog is a group of records that, together, represent the assets you want 
to manage. Each asset is represented by one record. There is no limit to the number 
of different media file formats that can be represented in one catalog. One of the 
greatest features of Cumulus is its ability to catalog any digital asset, in addition to the 
file formats directly supported. 

A catalog has a database file at its core. The way you work with the information in this 
file can be extensively customized. 

When you catalog assets, the catalog settings determine how and what sort of infor-
mation Cumulus extracts, creates and stores on the assets as metadata in the record 
fields and category fields.

Each catalog can have its own distinct properties. Any changes made to the catalog set-
tings affect the way information is stored on all of that catalog’s assets. For more infor-
mation see “Catalog Settings” . To set up a catalog to store information in addition to 
or differently from the default settings, fields can be added to the catalog either by 
activating them from the list of fields that Cumulus supports or by defining your own 
custom fields. (See “Adding Fields” , and “Creating a Custom Field” .) 

With Workgroup or Enterprise, catalogs can only be created by the Cumulus Adminis-
trator. And the Cumulus Administrator can give each user different rights for each cat-
alog. The range of functions a specific user is allowed to perform depends on the 
rights the Cumulus Administrator assigned to her/him.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS CATALOGS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Catalog Size and Performance
As catalogs increase in size, so do the requirements they place on computer hardware. 
It takes more processing power to work with 200,000 records than it does with 200. It 
also takes more RAM to hold the larger catalog in memory. 

NOTE: The unique way Cumulus searches for records prevents large catalogs 
from slowing down the search speed.

There is virtually no limit to the size of a catalog file (up to 1 TB). Most users will find it 
best to split catalogs for organizational and performance reasons. The actual number 
of records that can be stored in a catalog and the catalog’s actual file size is deter-
mined by the size of each record. (See “Record Size” .)

http://www.canto.com
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Catalog Scope
Catalogs can include records for as many different asset types as you like. But you may 
find it best to have different asset formats cataloged independently. For example, it 
might not make sense to have your image assets in the same catalog as your audio 
clips, though it is possible. 

On the other hand, don’t limit the scope of each catalog too much. For example, when 
you’re looking for an image to be used on a Web page, do you care if it’s in GIF or JPEG 
format? Separating similar asset types by specific file format can be inconvenient 
when searching. Cumulus cannot search through catalogs that aren’t open. If each of 
your image file formats has its own catalog, they’ll all have to be open if you want to 
search through all of them. Remember, you can use Cumulus’ categories or built-in 
information fields to find files based on format, projects in which they were used, or 
status, for example.

http://www.canto.com
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Live Filtering
Optional feature! May not be available with your Cumulus configuration.

Maybe you have a “filtered view” on a certain catalog or some or all accessible cata-
logs. The Cumulus Administrator can limit the view of a user or a user group to prese-
lected categories and/or records. For example, the asset access for the sales staff can 
be limited to final, approved material, while the work in progress in the Marketing 
department should not be visible. 

For a description on how to set up Live Filtering as a Cumulus Administrator, see “Live 
Filtering” .

http://www.canto.com
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Things You Can Do with Catalogs
You can:

• Open the catalogs assigned to you. (See “Connect to Cumulus Server”, and “Open 
Recent Catalog” .)

• Search through one or multiple catalogs. (See “Find Assets”.)
If you are the Cumulus Administrator or have the appropriate permissions, you can:

• Backup. (See “Backing Up Catalogs”.)
• Change catalog setting. (See “Catalog Settings”.)
• Compress. (See “Compressing Catalogs”.)
• Copy a catalog. (See “Copying Catalogs”.)
• Create a new catalog. (See “Catalog Access Window for Administrators”.)
• Delete a catalog. (See “Deleting Catalogs”.)
• Divide a catalog into smaller catalogs. (See “Dividing Catalogs”.)
• Merge one catalog with another. (See “Merging Catalogs”.)
• Publish catalogs on the Internet using Cumulus Portals or Cumulus Web Client. 

(For more information, see the corresponding Administrator Guide.)
• Rename a catalog. (See “Renaming Catalogs”.)
• Repair a damaged catalog. (See “Repairing Catalogs”.)
• Update catalogs from earlier Cumulus versions. (See “Migrating Catalogs”.)

http://www.canto.com
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Adding Assets to Catalogs
The term cataloging describes the process of importing and storing information about 
your digital assets. This information, called metadata, is the data associated with a dig-
ital asset beyond the actual file data itself. So, while the words you type in a Microsoft 
Word file constitute the file’s data, the file’s name, size, location, author, creation date 
etc. are examples of the file’s metadata.

Metadata

Some metadata is added to assets automatically by the software used to create or edit 
the asset. This is the case with the most common file metadata, such as size and mod-
ification date. But, depending on the creating software (or hardware), additional meta-
data can be embedded, too. This is the case with digital cameras that embed photo 
shoot dates, camera type, lens aperture and shutter speed, and even the GPS coordi-
nates of the shot location into the files. 

Additional metadata can be added after the asset has been cataloged. An asset's 
metadata serves as the basis for how you find the asset, so it’s important that your 
DAM system enables you to create as much metadata as you need. For example, if you 
need to find photographs based on the photographer’s name, you want to make sure 
photographer names are included in the metadata stored for your photograph assets. 
If you need to find a Microsoft Word file that includes a certain text phrase, is associ-
ated with a given fiscal year's revenue, and edited within the last month, the proper 
metadata enables that too. A complete DAM solution like Cumulus can also enable 
you to automatically find all images used in that document, and even find the PDFs 
that were later generated from it.

http://www.canto.com
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Supported Formats

With regard to file formats, Cumulus can catalog any type of digital asset and offers 
enhanced support for the most popular formats. (You can download an overview on 
Cumulus enhanced format support from Canto’s website.) The term “enhanced sup-
port” means different things, depending on the file format in question. For example, 
Cumulus offers enhanced support for Adobe® InDesign® and QuarkXPress® files by 
enabling you to preview individual layout pages right from within Cumulus. Enhanced 
support for Microsoft® PowerPoint files enables you to actually generate new Power-
Point presentations—right from within Cumulus—using assets and PowerPoint slides 
cataloged in Cumulus. Enhanced support for Microsoft® Word, Excel, Illustrator and 
PDF files includes extracting text that's included inside the files and making it search-
able catalog metadata. So, not only can you find the files in Cumulus based on meta-
data—file name, modification date, production status, etc.—you can also find some 
files based on their actual contents. 

Tasks Behind the Scenes

When you catalog digital assets, Cumulus performs a number of behind-the-scenes 
tasks in order to generate an asset record that best represents the asset. It’s easiest to 
think of these tasks as a series of steps through which the asset flows during the cata-
loging process. They are:

• Filters
• Metadata Extraction
• Field Linking
• Metadata Templates 
• Asset Handling Sets

http://www.canto.com
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Filters
Filters provide “knowledge” of a given asset type to Cumulus. They are, in fact, what 
enables the program to offer enhanced metadata support for so many file formats. For 
example, the JPEG filter knows to parse incoming JPEG assets for information com-
mon to that file type, such as horizontal and vertical dimensions (and much more). The 
MP3 filter extracts audio-related metadata, such as length and sample rate. Filters are 
like plug-ins—they can be added, activated and deactivated at any time. The Cumulus 
SDK (software development kit) enables others to create custom filters.

http://www.canto.com
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Metadata Extraction 
As mentioned, all file formats include at least a basic set of metadata that Cumulus 
captures during the cataloging process. For many file formats, this core information is 
the only metadata captured during cataloging. Some formats, however, store exten-
sive metadata right “inside” the file itself through the use of metadata standards called 
XMP, IPTC and EXIF. Popular formats that support one or more of these standards 
include JPEG, PDF and TIFF.

Many applications enable users to “stuff” metadata directly into files using these stan-
dards. During the cataloging process, Cumulus copies this data into the asset record, 
making it easily searchable. (Cumulus can also write data back into some “metadata 
fat” file formats.)

Metadata can also come from sources other than assets, such as databases or financial 
systems. Cumulus enables you to import metadata originating from sources like these 
into your catalogs through a menu command. This offers a great way to synchronize 
your Cumulus catalogs with other systems, such as product databases or financial sys-
tems. 

http://www.canto.com
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EXAMPLE: Product Details From Database
Say you have a database that contains details about each of your products—
UPC codes, color options, sizes, etc.—and you use Cumulus to keep track of 
product photographs used for packaging, online sales and advertising. By 
importing the product data into Cumulus, you can perform the same searches 
for product images as you can for product information.
This is a workflow example already in use successfully at Cumulus installations 
now. One customer produces weekly fliers that showcase sale items. UPC 
codes for products to be featured are sent to the graphics department who 
then use Cumulus to find acceptable product images. This ensures the correct 
image is used for each product in the advertisements. (If you’ve ever seen a 
weekly mailer that describes one product, but shows another, you can under-
stand the value of this workflow.)

Category trees can also be constructed based on imported data. This makes it easy to 
create an organizational structure that’s familiar to your employees: just provide 
Cumulus with a text file that represents your current organization structure, and the 
category tree is created for you automatically. The import function can also make 
upgrading to Cumulus from other DAM systems much easier.

No matter what the origin, Cumulus stores all metadata in catalog fields. A default set 
of fields is provided with each newly created catalog, and you can also define any 
number or type of custom fields you need. Later, you’ll read about the various field 
types available in Cumulus.

http://www.canto.com
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Field Linking 
Cumulus can map and copy the metadata found inside your assets to appropriate 
fields inside your Cumulus catalogs. So, for example, the contents of the “Notes” field 
in the asset can be copied to the “Notes” field in the catalog. 

You can also define field links of your own, in case you want to override default map-
pings, or create new ones. This is especially helpful when you want certain fields in 
your catalog to serve the same purpose for different asset types. 

EXAMPLE: Author & Writer
Say you work with video in both QuickTime and Windows Media formats. 
QuickTime includes a standard metadata field for video that's called “Writer.” 
Windows Media, on the other hand, includes a field called “Author.” You could 
have fields in your catalogs for both, but then you'd have to include both when 
searching for that information. A more convenient way to go about this would 
be to choose one of those field names for your Cumulus catalog and use field 
linking to map the contents of the other field to that field. That way QuickTime 
“Writer” and Windows Media “Author” metadata are stored in the same catalog 
field, making searching a breeze.

Asset metadata fields can also be field-linked to generate Cumulus categories. This is 
handy if your assets contain metadata keywords that you want translated into 
Cumulus categories. Cumulus can even generate category trees that emulate the 
folder structure the asset was found in. If your current folder structures are based on 
hierarchies that enhance your workflow, this option offers a great way to get instant 
category trees that will be familiar to users.

http://www.canto.com
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Collections
A collection is Cumulus-speak for a set of records from any one catalog or even multi-
ple catalogs. It is a way of looking at your catalog(s) – the way that you look at it at any 
given time. Whenever you work with assets in the record and category panes – which 
make up the Collection window – you’re creating or modifying collections. When you 
view the records in any category, you’re looking at a collection. When you view the 
results of a search, you’re also looking at a collection. The same is true for individual 
records you’ve dragged and dropped into the window – any ‘snapshot’ of your cata-
log can comprise a collection. A collection acts as your temporary workspace in 
Cumulus, and you can also save it as a file.

While a collection can contain all records in a single catalog or all in a single category, 
it is neither one nor the other. A collection can also contain – and here is where its 
advantages become obvious – the results of a search (either as a new collection or 
replacement of the current collection), or any records you drag and drop into the Col-
lection window. Any individual set comprises a collection. The records in one collec-
tion may even belong to different catalogs.

Once saved, a collection file remembers the records it contains and the Record View 
Set used. A collection file also keeps track of column width of the Details View.

http://www.canto.com
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EXAMPLE: Special Project Collection
Assume that you have a catalog containing thousands of records organized 
neatly into categories. Your latest project, however, only requires assets from 
four of those categories, and from those it only requires the image files. You 
could first run a search to pull all image files from those four categories. Then 
you could select a Record View Set and emphasize the exact information you 
need for this project. Save the collection, and from now on you can simply 
open the collection containing the records you really need – while the entire 
catalog remains available to you in the background. You could then email the 
collection to in-house members of the project team.

A collection, whether saved or unsaved, is always connected to its catalog(s). When a 
collection is open, the catalog(s) storing the records of the collection are also open. In 
order to open a particular collection, you must have access to its catalog(s). If a record 
is removed from a catalog, it is removed from any of the collections it was in. Similarly, 
if you delete a category, it is deleted not only from one collection, but also from the 
catalog.

You can, however, delete a record from the collection without deleting it from the cat-
alog – as long as you press only the DEL key. But if you press both Command / 

Control and DEL, the record will be removed from both collection and catalog (see 
“Delete” , for more information).
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Working with Collections
Collections can be customized and then saved, so that your particular preferences for 
a special set of records can be recalled. A collection file remembers the records it con-
tains, the Record View Set used and the column width of the Details View.

As collections are such flexible and malleable creatures, it might be a good idea to 
save your special collection once you have configured it. This is because an unsaved 
collection with its specific configuration is not automatically saved when you close it. 
And as soon as your collection changes – which can happen quite often – any 
unsaved changes are lost. Saving a collection is easily done via File > Save Collection 
As. A dialog appears for you to choose the name and location for the collection file. 
Once a collection is saved, it is easy to open it via File > Open Collection

Cumulus provides several collection types:

• Private collections – collections private to the user who created them.
• Shared collections – collections that are available either to all Cumulus users, or 

to selected ones. The sharing state of a collection can be changed anytime via its 
properties (on Cumulus Desktop Client only).

• Download collections – collections that have been made accessible by sending 
either a general download link, or personalized download links, to arbitrary recipi-
ents who don’t even need to be Cumulus users. – Note that with Cumulus Portals 
and the Cumulus Web Client, only personalized links can be sent.
Recipients can open the link and view the collection with Cumulus Portals in any 
web browser. Via the Send Collection Link dialog, you can specify a password and 
an expiration date for your download collection. You can also specify which 
actions recipients may perform on the assets in the collection. Note that this func-
tion will only work if your Cumulus installation includes Cumulus Web Solutions 
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(with Portals). Also, a Base Web URL for Portals must be defined by your Cumulus 
Administrator.

• Upload collections – a special kind of collections that are created implicitly when-
ever a Cumulus user sends out an invitation to upload files. Upload collections can 
not be saved manually, i.e. the only way to change their content is by uploading 
files. However, they can be saved as normal collections via the Save As command 
(with Cumulus Desktop Client only).

The usage of both download collections and upload collections can be tracked. Via 
the Properties of the collection, information on every recipient of a respective upload 
link or download link, as well as the last access to the collection, is provided. 

BACKGROUND INFO:  Usage Tracking with External Users
To enable the usage tracking for download and upload collections, every 
recipient’s email address not yet known to Cumulus is saved to the Cumulus 
users catalog, as a so-called “external user”. 
Initially, the email address is the only piece of information known about any 
external user. Also, external users don’t have any permissions by default. 
However, it is possible to add more information to such users, and to grant 
them permissions, and even to change their state from external to internal 
via the User Manger.

All collections are stored at the Cumulus Server and can be shared between users. 
When connecting to the Cumulus Server with the Cumulus Desktop Client, you can 
open catalogs and/or collections. 

Shared collections can be created and modified only by users who are allowed to do 
so (User Manager > User/Role Properties > Server Permissions > Collections Permis-
sions.)

http://www.canto.com
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On Cumulus Desktop Client only: 

Collections stored with previous Cumulus versions on the computer running the Cli-
ent application can be imported (File > Import > Collections.) To store collections at 
any location other than the Cumulus Server, you can use the export function (File > 
Export > Collections.) 

For sending a collection via email to another user (as opposed to sending a link to a 
collection), a special export function is provided (File > Export > Mail Collection To.) 
However, don’t forget: Since a collection is always connected to catalog(s), it is necessary 
for the recipient to have access to the catalog(s) ‘serving’ the collection.

To make use of a collection you received, you use the import function. 

When you create a new collection via File > New Collection, it can either be empty or 
contain the currently selected records. However, concerning the view, the new collec-
tion will be a copy of the active collection. In other words, the colors, fonts, and fields 
of the new collection will be the same as the previous one. From here, you can pro-
ceed to make any changes you like while retaining the old collection in the back-
ground. You might want to save your new collection after you have assembled the 
desired records and carefully arranged them.

IMPORTANT! If the Remember Password option is activated in your Connect 
to Server window, any collection you export or mail contains your login infor-
mation. Opening such an exported or mailed collection will connect to the 
Cumulus Server with your (the sender’s) login and password. And this means 
that the user who opens the collection works as you and has your permissions. 
If this option is not activated, the Connect to Server dialog will appear when 
an exported or mailed collection is opened. 
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Things You Can Do with Collections
• Create a new collection manually (see “New Collection” ), or create a new upload 

collection by sending out an invitation to upload files (see “Send Upload Link” )
• Open an existing collection (see “Open Collection” )
• View and Edit the Properties of collections (see “Open Collection” )
• Save a collection (see “Save Collection As”  and “Save Collection”)
• Search through a collection (see “Searching with the Find Window” )
• Send a collection by email. (see “Export” )
• Send a link to a collection (see “Send Collection Link” )
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Assets/Records
In Cumulus, each asset is represented by one record. Cumulus is able to catalog every 
sort of digital asset such as Photoshop® image files, video clips, sound clips, or QuarkX-
Press® page layouts. However, a digital asset can also be a spreadsheet file or even a 
data stream such as an entry in a data base that Cumulus is keeping track of for you. 
Records can contain a thumbnail image of the asset. Records can (and should) be cat-
egorized for easy maintenance and searching. (See “Categories”, for more informa-
tion.)

Records are not actual copies of the asset. They merely "point" to the original file. This 
saves disk space and avoids confusion caused by maintaining multiple copies of an 
asset. Records contain information on the assets, which is called metadata. Using 
metadata makes it possible for Cumulus to track your assets and find their records at 
lightning-speed. A record is the sum of metadata stored on an asset. The metadata is 
kept in Record Fields.

All records contain at least some searchable information in their record fields on the 
asset file they represent. Generally, the range of information each record includes 
depends on the kind of asset represented.

However, Cumulus makes it possible to determine precisely what sort of information 
should be kept on assets. Remember, this can be defined differently for each catalog 
as each catalog has its own properties. It is the catalog settings that determine what 
information is stored on the assets in the record fields. 

As it comes ‘out of the box,’ Cumulus has many record fields ready to be filled while 
cataloging, depending on the nature of the asset. Not all of the record fields that 
Cumulus supports are activated with Cumulus’ default settings. 
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BACKGROUND INFO:  Asset Types Supported

Cumulus can catalog any kind of digital asset you throw at it. Moreover, it 
directly supports file formats with specially developed filters. (see Asset Format 
Support, for details on supported formats or download an overview on 
Cumulus enhanced format support from Canto’s website.) 
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Asset Information
The information stored on an asset can be viewed and edited in the Information view 
or in the Information window. 

What you see depends on:

• the fields selected to be displayed in the current Record View Set.
• the fields of the catalog the asset is cataloged in and whether these fields contain 

any information or not.

TIP: View Set Should Match Catalog

The View Set you select should match with the catalog(s) you use it with. For 
example, if you have a special catalog for images that includes all fields that are 
important for images and you use a View Set that was designed for audio files, 
you may not see much information. If the catalog does not contain the fields 
that are selected for display in the View Set, no information can be displayed.

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Record View Sets by selecting the Customize entry in the drop-down list for 
selecting Record View Sets. This entry opens the preferences for the current 
Record View Set.
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To change to the Information View, click  on the toolbar.

To open the Asset Information window for an asset:

1. Select the record of the asset of which you want to see the information.

2. Select Metadata > Information or click  on the toolbar. The Asset information 
window opens.

Once the Asset Information window is open you can use the arrow buttons to load 
other records into the window. For more details on the Information window, see 
“Information Window” .
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Field Types
Information on assets can be viewed and accessed via record fields and information 
on categories can be viewed and accessed via category fields. Cumulus can store dif-
ferent kinds of information. Consequently, Cumulus features many different field types 
for storing information. The different field types are (the examples are drawn from the 
default record fields):

• String – Can be used to store textual information (e.g. Notes). String fields can be 
set to support multiple languages. In this case, the content of the field can be hold 
in different languages.

• Boolean – Great for on/off, yes/no options. Displays as a check box (e.g., Don’t 
Delete Record).

• Integer – Any non-fractional number up to 32 bits (e.g., non-decimal numbers as 
a price of $2).

• Real – Any number up to 64 bits (e.g., a decimal number such as a price of $2.99).
• Long – Can store 64-bit integer numbers. 
• Data Size – Size in bytes (can store 32-bit values up to 4 GB) 
• Data Size (Long) – Size in bytes (can store more than 4 GB values up to 64-bit val-

ues)
• Date – Any valid date (including time) between than January, 1st, 1970 and Janu-

ary 19, 2038 03:14:07, entered in the format that is standard for your country.
• Date (Extended) – Any valid date (including time) between January, 1st, 0001, 

00:00:00 and December, 31st, 9999, 23:59, in the format that is standard for your 
country.
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• Date only – Any valid date for any day entered in the format that is standard for 
your country.

• Time only – Any valid time of day entered in the format hh:mm:ss. Optionally you 
can also enter milliseconds by employing a dot as separator: hh:mm:ss.123

• Length – In inches – displayed in the measurement you have chosen in your User 
Settings for the Cumulus application.

• Resolution – in dots per inch.
• Binary – Not user-editable; administered by custom asset information applica-

tions, which can manipulate and store binary data for further automation.
• Asset Reference – Special binary field used for asset references only. Not user-edit-

able.
• Picture – Pictures can be pasted into these fields (e.g., Thumbnail).
• String List – This field type supports lists, such as menus, which can make data 

entry easier. The items in the list can be defined by the user (e.g., Status). The items 
can only be defined by users with the appropriate rights.

• Audio – Can store voice annotations that can be recorded directly into the com-
puter or come from the assets themselves.

• Label – Enables users to label records by assigning colors. 
• Rating – Enables users to rate assets or records. 
• Table – Special field type that can include other metadata fields. This field type was 

designed for special usage purposes, e.g. the user comments added to a preview 
are managed by such a field. The fields included in a Table field can be configured 
to be searchable and sortable.

• Vocabulary – Special string list field type used for controlled vocabulary assign-
ments only. Vocabulary fields only accept predefined values (terms) as input – the 
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categories of a special $Vocabularies catalog. This catalog requires special permis-
sions for editing.

For more information on Cumulus custom fields see “Catalog Settings” .
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Editing Asset Information
In general, you can edit the information stored on an asset. But you can only edit infor-
mation which is stored in record fields you are allowed to edit.

To edit the information stored on an asset:

1. Select a Record View Set that displays the information you want to edit in the 
Information View or the Asset Information window. 

2. Select the record you want to edit and change to Information View or open the 
Asset Information window.

3. Click the field you want to edit.

Fields with white backgrounds can be edited. If a field has a gray background, 
then it cannot be edited. (Either you are not allowed to edit or the field is not edit-
able in general.)

4. Make your changes.

5. Click  to save your changes.

If you want to edit further records in the collection, you can use the arrow icons to load 
a new record.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS ASSETS/RECORDS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Editing a String Field in Multiple Records 

If you are about to edit the content of a string field for multiple records at once and 
one or more records already contain text in the field you want to edit, Cumulus will ask 
you how to handle the new text.

Editing Fields with Validators

If a catalog contains fields with validators and one or more of these fields contain 
invalid values, or if mandatory fields have no value at all, a validator pane is displayed 
at the bottom of the Information Window or Information View, and the respective 
fields are marked with a special icon.

The message(s) displayed in the validator pane can be different for each field, depend-
ing on the settings defined by the administrator. Clicking on a message immediately 
activates the field with the erroneous value, even if it is not visible in the first place. As 
soon as you enter a correct value, both the special icon and the message disappear.
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As long as a record contains invalid field values, it can not be saved. Either you fill in 
appropriate values in all of these fields, or any changes made to the record will be dis-
carded.
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Using a Metadata Template
To add information to the metadata information that is stored on an asset or a cate-
gory, you can employ a Metadata Template. Metadata Templates can be set up by any 
user. (For a description on how to set up Metadata Templates, see “Metadata Tem-
plates” .)

To make use of such a template, you can either use it while cataloging (along with the 
Prefiller Utility, see page 466) or apply the metadata information to existing records or 
categories.

There are different methods through which you can apply information from Metadata 
Templates to records or categories:

• Select one or more records or categories, then select Metadata > Assign Meta-
data From Template. A list containing all your Metadata Templates is displayed. 
Select the desired one. The changes are applied immediately.

NOTE: With this method, all fields are taken into account, that are 
– contained in the catalog the records or categories belong to and
– set in the selected Metadata Template.

• Select one or more records or categories, then select Edit > Paste Metadata. The 
Bulk Edit window is displayed. Click the icon in the lower left corner and select a 
Metadata Template. The respective values are displayed in the Bulk Edit window. 
You can edit them before applying them to the selected records or categories. 

NOTE: With this method, all fields are taken into account, that are 
– included in the Information window of the current View Set and
– user editable and
– set in the selected Metadata Template
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• Open the Asset Information window or Category Information window and click 
, then select the Metadata Template you want to apply. You must explicitly 

save your changes in order to apply them.

NOTE: With this method, all fields are taken into account, that are 
– included in the Information window of the current View Set and
– user editable and
– set in the selected Metadata Template

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Metadata Templates by selecting the Customize entry in the drop down list 
for selecting a Metadata Template. This entry opens the preferences for the cur-
rent Metadata Template.
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Record Size
In general, a record’s size can depend on several factors:

• The size and quality setting of the thumbnail (if you choose to include one).
• The amount of text and notes stored in various record fields.
• The asset format the record represents. (Different assets generally require different 

amounts of data to describe them.)
• The amount of additional information you include in the record.
The customizability of Cumulus means that you can determine what information is 
stored on the assets in a particular catalog. If catalog size is a concern, there are a few 
catalog settings to keep in mind. These settings can affect the size of the records cat-
aloged. 
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Renaming Records
Records are named as the assets they represent by default. Sometimes asset names 
are not what you would like them to be. For renaming assets (and their records) 
Cumulus provides a special function. (See “Rename”, for details.) However, you can 
also rename the record only. Though there is no menu item specifically for this use, 
renaming records is easy:

1. Select the record to be renamed.

2. Select Metadata > Information. The Asset Information window opens, which 
shows information on the asset.

3. Find and change the record’s name in the Record Name field.

4. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons in the 
Information window toolbar to load a new record. 
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Editing a Record’s Category Assignments
Also found within the default Asset Information window is a list of the categories cur-
rently assigned to the record. From this list you can remove category assignments or 
add new ones. 

To remove a record’s category assignment:

1. Select the record whose category assignments you want to change.

2. Select Metadata > Information. The Asset Information window opens, which 
shows information on the asset.

3. Select the category you wish to remove and press the DEL key.

4. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons in the 
Information window’s toolbar to load a new record. After deleting a category in the 
category pane, all assignments to this category are automatically deleted as well.

There are different ways to add a category assignment to a record, or to assign a record 
to a category, depending on your perspective. The perhaps most intuitive way is by 
dragging and dropping the category to the record, or the record to the category. (See 
“Editing a Record’s Category Assignments”.) It is also possible to add a category assign-
ment to a record via the Asset Information window, which displays a list of the cate-
gories the record is associated with.
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To add a category assignment to this list:

1. Select the record whose category assignments you want to change.

2. Select Metadata > Information. The Asset Information window opens, which 
shows information on the asset. If necessary, drag this window aside so that you 
can also see the Category pane of the Collection window.

3. Click the category in question in the Category pane.

4. Drag the category to the categories list in the Asset Information window. The cat-
egory is assigned to the record.

5. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons to load 
a new record. 
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Things You Can Do with Records
• Assign a record to a category. (See “Editing a Record’s Category Assignments”.)
• Change a record’s category assignments. (See “Editing a Record’s Category Assign-

ments”.)
• Copy/Cut and Paste records between catalogs and/or collections. (Record cate-

gories are copied along with records.)
• Create a new record (same as cataloging assets). (See “Browse for Assets”.)
• Create custom record fields. (See “Creating a Custom Field”.)
• Delete a record and (optionally) its asset. (See “Delete”.)
• Drag and drop a record into another drag and drop-supporting application. Drag-

ging a record copies the asset into the target document. You may prefer, instead, 
to place the asset manually and access it by reference.

• Export records. (See “Export”) 
• Import records. (See “Import”.)
• Optimize a records’ preview icon. (See “Optimize Thumbnail”.)
• Print records. (See “Print”.)
• Rename a record. (See “Renaming Records”.)
• Rotate a record’s preview icon. (See “Rotate Thumbnail”.)
• Search for specific records. (See “Searching with Quicksearch”, and “Searching with 

the Find Window” .)
• Update a record to reflect an edited asset. (See “Update Record”.)
• Update a record to reflect a relocated asset. (See “Update Record”.)
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NOTE: It’s very important to keep records in sync with their associated asset files. 
If you move an asset after cataloging it, be sure to update its record by using the 
menu item. (See “Update Asset Reference(s)”.) 

• View and optionally edit a record’s asset information. (See “Asset Information”, for 
details.)
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Things You Can Do with Assets
Cumulus is also able to help you manage your original assets. Cataloged assets can be 
copied, deleted, moved, printed – all from the Cumulus interface using the Asset 
menu commands. And when you copy, delete or move an asset, Cumulus takes care 
of its TAG file at the same time, treating it accordingly. For further information on TAG 
files, see “Options While Cataloging” .

• Convert the asset to another file format. (See “Convert To”)
• Copy the asset into another application by dragging the record into the applica-

tion.
• Create copies of the assets in another location. (See “Copy To”.)
• Customize the display of the information on an asset. (See “Record View Sets”.)
• Delete an asset. (See “Delete”.)
• Move assets. (See “Move To”.)
• Open assets using the application they were created with or another application. 

(See “Edit With”.)
• Preview a record’s asset. (See “Preview”.)
• Print assets using the application they were created with or another application. 

(See “Print With”.)
• Send your assets by email. (See “Mail To”.)
• Rename assets. (See “Rename”.)
• Show information on an asset. (See “Asset Information”.)
• Show the location of the asset. (See “Show Location”.)
• Show a preview image of the asset. (See “Preview”.)
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Categories
Cumulus categories are used to organize records, much like folders are used to orga-
nize files in a traditional filing cabinet. But the asset can appear in any number of 
Cumulus categories at the same time. They are similar in purpose to keywords used in 
other programs. 

Simply double-clicking on a category is the most direct method of searching in 
Cumulus. All records assigned to that category are displayed. You can also use the cat-
egory list to find contents of two or more categories at a time. Other options for cate-
gory list searching include the ability to see the contents of categories in the tree 
either above or below the one you double click. (See “Search & Sort Tab”, for more 
detailed information.)

To make organizing easier, Cumulus by default provides multiple master categories 
each of which constitutes its own category tree. Categories can be created in each 
tree independently. Which categories are displayed in the category pane, either all, or 
just the categories belonging to a specific master category, can be specified any time 
via a drop-down list.  

• The Keyword tree contains those categories that are created with the intention of 
organizing the assets via keywords. These categories may be created manually by 
the user or automatically by Cumulus Filters and AssetStores. 

• The Sources tree contains automatically created categories that reflect the folder 
or directory hierarchy in which the assets reside. 

• Use the Categories tree to build a hierarchical order of your own that suits your 
specific needs. 
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• All displays all master categories and their respective subcategories contained in 
the current collection. In this case, the master categories are denoted with names 
that begin with a $ sign. 

NOTE: Do not rename or move these special categories. 

If you don’t get all default category trees displayed, your administrator has restricted 
your access to categories.

Categories can be nested within one another. The highest hierarchical category level 
– the one that is not nested in any other category – is the category representing a cat-
alog. A category that nests other categories is also denoted by a small triangle. A 
square denotes a category that does not nest any other category. To expand a cate-
gory in order to see its subcategories, click on the triangle. Use drag and drop to move 
categories to where you want them inside the master category they belong to, or 
even between master categories. 

The Category pane displays all available categories. To see the categories a record is 
assigned to, open the Asset Information window and check the entries in the Catego-
ries field. (For information on how to edit, see “Editing a Record’s Category Assign-
ments” .) 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS CATEGORIES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Category Types
Cumulus offers different types of categories: Normal Categories, Related Categories 
and Folder Categories. These category types have the following characteristics:

• Normal Categories can be created by the user at any position in the category hier-
archy. We recommend creating individual categories either in the Categories or 
the Keyword tree.

• Related Categories are aliases of existing categories which can be created by the 
user. They can be placed in any position in the category hierarchy. Complete alter-
nate catalog hierarchies can be built using related categories. 

• Folder Categories are automatically created by Cumulus during the cataloging 
process. These automatically created categories reflect the folder or directory hier-
archy in which the assets reside. The Source tree displays them all. They are cre-
ated by default but this option can be disabled (with Workgroup or Enterprise, by 
users with the specified rights only). 

NOTE: Live Filtering (optional)
If you can see categories but can’t select them, your administrator has activated 
pre-selections for you and those categories do not belong to the range of pre-
selections. 
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Creating Categories
If you’ve been snooping around the Cumulus menu bar, you can probably guess how 
to create a new category.

To create a category:

1. Click the category in which the new category should be nested.

2. Select Metadata > New Category or New Related Category. This creates a cate-
gory nested in the selected category.

3. Rename the new category. (Category names can be up to 255 characters in 
length.)

You can easily change the category hierarchies by  dragging a category on top of 
another category. This places the category inside the other category. To move a cate-
gory to the top level of a catalog, drop it on the category representing the catalog. 

Master categories can’t be dragged to a different place.

Renaming categories is easy:

1. Double-click the category’s name (not its icon). Its name will be selected for edit-
ing. 

2. Edit the name. (Category names can be up to 255 characters long.)
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Custom Ordering of Categories
By default, the categories displayed in the category pane are sorted alphabetically. As 
this may not always be the most convenient solution, the order of the categories can 
be changed manually by dragging a category to a different place in the category tree, 
e.g. to have frequently used categories shown on top of the category tree.

Custom ordering of categories only works if 

• the respective catalog contains the category field Custom Order,
• the Enable/Show Language Specific Category Sorting and Custom Ordering 

option is activated in the used Category View Set,
• the user who wants to reorder the categories has the permission to modify cate-

gories.
A custom-ordered category tree is displayed in that order only for users that employ a 
Category View Set with the Enable/Show Language Specific Category Sorting and 
Custom Ordering option activated. Else wise the category tree is displayed in the 
default order. 

NOTE: It is advised to be extremely cautious with custom ordering of catego-
ries, as this may effect the view of potentially all other users.

To manually change the order of categories:

1. Drag any category with the mouse to the position where you want to have it.  

A thin black line indicates where it will be placed when you release the mouse 
button.
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To override custom ordering and re-establish the alphabetic sorting of categories:

1. Right-click into a category level that you want to sort alphabetically and select 
Sort by Name from the shortcut menu. 

The respective level of categories is sorted alphabetically.

NOTE: Sorting categories by name only affects the current level. If subcatego-
ries have a custom order, they will retain it. Thus you can sort any level in your 
category tree either by name or manually as you need it, independent of any 
other level.
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Category Fields
Category fields are used for information that relates to all records assigned to that cat-
egory, or they can be used to store additional information on the category itself. 

Category fields can be activated and set up in the Catalog Settings. This can only be 
done by the Cumulus Administrator. 
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Category Information Window
Information on categories can be viewed in the Category Information window. What 
you see depends on:

• the fields selected to be displayed in the Category View Set defined for the cate-
gory tree the selected category resides in.

• the fields of the catalog the selected category resides in and whether these fields 
contain any information or not.

TIP: Access Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Category View Sets by selecting the Customize entry in the drop-down list 
for selecting Category View Sets. This entry opens the preferences for the cur-
rent Category View Set.

To open the Category Information window:

1. Click once on a category to select it.

2. Select Metadata > Information. The information window for the selected cate-
gory appears.

The information on categories can be viewed and accessed via category fields. What 
category fields are displayed and also how the category fields are displayed depends 
on the selected View Set. 
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Once the Category Information window is opened, you can use the arrow buttons to 
load other categories into the window. For more details on the Information window, 
see “Information Window” .
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Editing Category Information
In general you can edit the information stored on a category. But you can only edit 
information which is stored in category fields you are allowed to edit. 

To edit the information stored on a category:

1. Load the category you want to edit into the Category Information window.

2. Click the field you want to edit.

Fields with white backgrounds can be edited. If a field has a gray background, 
then it cannot be edited. (Either you are not allowed to edit or the field is not edit-
able in general.) 

3. Make your changes.

4. Click  to save your changes.

If you want to edit more categories, you can use the arrow icons of the Information 
window’s toolbar to load another category.
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Categories and Auto-cataloging
NOTE: Auto-cataloging makes use of the AutoSync function. Starting with 
Cumulus 10.1, this function is disabled by default with new Cumulus installa-
tions for performance reasons. Canto recommends to make use of the 
Cumulus FileSystemCompanion or RoboFlow for watching folders and auto-
cataloging assets. 
If for any reason you need to use the old Cumulus AutoSync function, contact 
Canto Professional Service or a Canto partner. 

Cumulus can auto-catalog the contents of folders that are represented by folder cat-
egories in Cumulus. Any new assets saved to this folder will be cataloged periodically, 
depending on how often you would like this done. This feature can be customized to 
be performed anything from hourly to daily to weekly. It is performed on the machine 
you are working at. 

To make use of this feature:

1. Select the Sources master category. 

2. Select the category representing the folder you want to have auto-cataloged.

3. Select File > Add Assets to Catalog >Setup Auto Cataloging.
OR
Open the context menu by clicking the right mouse button /  Control key + 
mouse button and select Setup Auto Cataloging. 

The Auto Cataloging dialog is opened.

4. Activate the Use AutoSync on Category option.
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5. Define the performance options:

• Select the Asset Handling Set for the auto-cataloging.

NOTE: You should select an Asset Handling Set with the Skip Duplicates 
option activated for cataloging. Otherwise all assets in the folder will be cata-
loged again and again with each run. 

• Under Next Start, enter date and time when the function should be performed.
• Under Period, enter the regularity time interval you want the function to be per-

formed. For example: to start it once a day enter 24:00 
• Under User, enter your Cumulus Login name.

6. Click OK.

NOTE: With this version of Cumulus the Auto Cataloging feature works only for 
folders that were created when cataloging was performed on the same oper-
ating system you are working with. You can check this with the information in 
the Category Type field. A category of the type Directory Category can only be 
auto-cataloged when you are working under Windows. And a category of the 
type Directory Category Mac can only be auto-cataloged when you are work-
ing under OS X. 
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TIP: More Autocataloging Features

Optional features provide additional auto-cataloging options; e.g. a Cumulus 
Scheduler Action that enables Cumulus to check a standard POP3 email 
account and retrieve and automatically catalog any email it finds. For more 
information, see “Provided Scheduler Actions” .
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Individual Master Categories
Instead of having all categories appear in one category tree, Cumulus provides multi-
ple master categories, each with its own category tree: Cumulus lets you create your 
own master categories with their own individual category trees.

To create a new master category:

1. Click on the entry for the catalog in which you want to have the new master cate-
gory.

2. Select Metadata > New Master Category. The New Master Category dialog is dis-
played. Enter a name for the new master category and press Enter. 

You can rename or delete such a category just as any other category.
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Things You Can Do with Categories
• Assign a category to a record. (See “Editing a Record’s Category Assignments”.)
• Create a new category. (“New Category” , and “New Related Category”.)
• Create a related category. (See “New Related Category”.)
• Delete a category. (See “Editing a Record’s Category Assignments”.)
• Export categories. (See “Export”.)
• Import categories. (See “Import”.)
• Move a category inside or outside another category. (See “Creating Categories”.)
• Remove a category assignment from a record. (See “Editing a Record’s Category 

Assignments”.)
• Rename a category. (See “Creating Categories”.)
• Search for categories. (See “Searching with Quicksearch”.) 
• Show or hide categories. (See “Collection Basket Pane”.)
• Use AutoSync on categories. (See “Categories and Auto-cataloging”.)
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Information Window 
The information stored on an asset or category can be viewed and edited in the Infor-
mation window. What you see depends on:

• the fields selected to be displayed in the current Record View Set or Category View 
Set,

• the fields of the corresponding catalog and whether these fields contain any infor-
mation or not. 

BACKGROUND INFO:  Information Window vs. Properties Window

Whereas the Information window provides access to the metadata stored on 
an asset or a category, the Properties window provides access to the triggers 
and permissions set for an asset’s record or a category.
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Overview: The Information Window
The Information window provides access to the information (metadata) stored on a 
category or on an asset. The Asset Info window provides access to the information on 
the asset stored in the record. The Category Info window provides access to the infor-
mation on a category. Which fields are displayed in which order depends on the 
selected View Set. The field contents are editable depending on the field type and the 
properties set for it. However, to edit the metadata stored you need the appropriate 
permissions to modify records.

• Information Window Toolbar (1-8)

1 Save the edits you made in this window.
2 Click to add information from a Metadata Template. (For details on how to set up Metadata 

Templates, see “Metadata Templates” .)

IMPORTANT!  The template will only fill in the fields that are included in the Infor-
mation window. And only those that you are allowed to edit. Note that these 
changes will not be saved until you do so. 

TIP: If you have the appropriate permissions, you can easily access the preferences of 
Metadata Templates by selecting the Customize entry in the list for selecting Meta-
data Template. This entry opens the preferences for the current Metadata Template.

3 Loads the first record/category from the collection window’s current selection.
4 Loads the previous record/category from the collection window’s current selection.
5 Loads the next record/category from the collection window’s current selection.

4 5 72 6 831

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS INFORMATION WINDOW

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

6 Loads the last record/category from the collection window’s current selection.
7 Displays the selected Record View Set. 
8 Click to select a Record View Set.

• Field Display (9-12)

This sample Information window shows:
9 Name of the field (as defined in the Catalog Settings).
10 Content of the field for the selected record/category (editable or not depending on the field 

type and whether Allow User to Edit is checked in the record field properties). If the field 
background is dark gray it cannot be edited.

11 Displays the categories the asset is assigned to. (For more on categories and category trees, 
see “Categories” .)

12 Separator for grouping fields. Click to expand or collaps the display of the fields.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS INFORMATION WINDOW

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

•Field Types (A-H)

The letters mark a few examples of the 
various field types.
ADate: Can be user-editable; click in 
field and type new value (or in Win-
dows use arrow up/down keys).
BInteger: User-editable; numbers 
only (without decimal places), up to 
32 bits.
CBoolean: Check box to be selected or 
deselected. Can be user-editable. 

NOTE: Besides being activated or 
deactivated, boolean fields can have 
a third state: No Value. This state can 
be set via an options menu.

DPicture: Not user-editable; main-
tained by Cumulus or an Asset Stor-
age Module.
EString: User-editable; characters 
and numbers.
FString List: Can only be filled with 
predefined values. (For details on 
inserting a value to a String List, see 
“Editing a String List Field” .)
The values are either displayed as a list 
or as radio buttons (defined in the 
View Set.) Click the arrow button to 
select a value from a list.

4 5 72 6
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G String List – Multi-Select: The values are displayed with check boxes. You can select multi-
ple values by activating them in the check boxes.

H Asset Reference: Not user-editable; maintained by Cumulus or Asset Storage Module.
I Vocabulary: Can only be filled with predefined values (controlled vocabulary items). 

Click Add/Remove to add/remove vocabulary items.

Adding Terms to a Vocabulary Field
Enter a letter or phrase and click Find. The Add Vocabulary Terms window opens, displaying 
matching terms. 

Select the desired term and click OK. (Note: Which Details are displayed for a term depends on 
the available metadata, and on the view configuration of the Vocabulary field.)
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NOTE: Multiple Records in Asset Information window
If you have selected multiple records before opening the Asset Information 
window and the option Display values identical for all selected records (User 
Settings> Display > Asset Info Window) is activated, you can change the field 
values for multiple records at once.
If the asset information of multiple records is shown in one window, only those 
field contents are displayed which have the same value. So the Asset reference 
and Thumbnail fields will always be empty. Check boxes (Boolean fields) with 
different values display the string Multiple values. The field Categories only 
displays those categories the selected records have in common. All other field 
types are displayed with no value if there are different values for fields.
Fields with different values do not show a value but can be edited - as well as 
gray (neutral) check boxes. If you add an additional category, this category is 
added to the set of categories for each record.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS SETS AND TEMPLATES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Sets and Templates 
To ease your work Cumulus provides several sets and templates. Access to them is 
controlled via user permissions. Users who are allowed to create them can share them 
so that they are accessible to all users with the permissions to use them.

View Sets
What Cumulus calls view sets are the screen layouts that enable users to interact with 
the metadata stored for the managed assets. Each View Set contains several different 
types of views, or view modes, including thumbnail view, list view, asset preview, and 
more. A single View Set represents the way each of these individual views appear to 
users. 

View sets make it easy for you to switch between different views that are set up for cer-
tain formats or tasks. Once view sets have been appropriately defined to meet differ-
ing demands, you can switch between them with just a mouse click.

Each view in a View Set can contain a different array of metadata fields from a catalog. 
This is helpful because you don't likely want to see all data fields when looking at 
thumbnails, but you might want to see them when looking at an Information View. 
Some metadata fields, such as thumbnail or record name, might be useful in both 
views.

The ability to create different view sets enables you to configure screen layouts that 
are task or user specific. 
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Examples

When browsing catalogs for images, a layout artist might want to see a Thumbnail 
View that includes no other fields. To address this, you'd create a “Browsing” View Set. 
The omission of others fields in the Thumbnail View enables Cumulus to display as 
many thumbnails on a single screen as possible, which is great for browsing. The Info 
View of your “Browsing” View Set might include the remaining fields that a layout artist 
should see before making a selection, such as “License Restrictions,” “Copyright 
Notice” and “Approval Status” fields.

If that same layout artist was cataloging new assets, he/she would want to see more 
than just those few fields useful for browsing. She might need access to a “Notes” field, 
a “Production Status” field or even the “Categories” field, which enables her to easily 
see and edit the category assignments made for the asset.

These are examples of task-specific view sets. But user- or group-specific view sets are 
just as important. Your catalog might include financial or licenser contact fields that 
are of no interest to designers, but paramount to accountants. On the other hand, 
your accounts probably don't care about “Color space,” “File Resolution” or “Workflow 
Status” fields. You'd create view sets for them that include only the fields they need to 
see. 

Access to view sets is permissions based, so you can easily determine which users can 
access which view sets. This is particularly important if any of your metadata fields con-
tain sensitive or private information. For example, you might use “Notes” fields to 
enable managers to communicate thoughts to one another that designers shouldn’t 
see. Using view sets in this manner offers an additional layer of security to your meta-
data, but it also helps “clean up” everyone's workspace by displaying to them only 
what they need to see.
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Category View Sets

Cumulus categories have view sets of their own. We call these Category View Sets to 
differentiate them from the Record View Sets just covered.

Category View Sets are required because Cumulus categories also have metadata 
fields. This enables you to use categories as a type of “asset container” for project man-
agement—each category can have a manager, budget, due date, etc. Asset records 
added to the category are assumed to be a part of the project. Double-click on the cat-
egory and you see all the assets used in it. In practice, Category View Sets are created, 
edited and chosen by users, just like Record View Sets.

View Sets & Catalogs

Newly created Cumulus catalogs include default view sets for records and categories. 
These view sets include many of the default metadata fields created for each new cat-
alog, which enables you to start managing assets immediately. 

If you add any metadata fields of your own, however, you’ll also need to add those 
fields to view sets before users will be able to see the fields and edit their contents. You 
can add your custom fields to existing view sets, or you can create new view sets from 
scratch. There is no limit on the number of view sets that you can create.

View sets are not “connected” to any one catalog—they are Server specific. This 
means that each view set you create will potentially be available from all catalogs 
hosted on that Server. This enables you to create view sets that include fields from 
multiple catalogs. (Cumulus enables users to open several catalogs at once.)

You can limit view set access on a catalog-by-catalog basis, so if a given view set 
includes fields not found in other catalogs, you can create custom view sets for that 
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catalog and configure user permissions to ensure that those view sets are not acces-
sible in other catalogs.
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Asset Handling Sets
An Asset Handling Set is also not specific to any one catalog. It affects how Cumulus 
deals with your assets – during the cataloging process and when accessing assets. 

Asset Handling Sets define:

• Which filters should be active during cataloging,
• What metadata should be extracted from the assets (via filter settings),
• How field linking should be configured, 
• Which Metadata Template (if any) should be used, and
• Whether central asset storage should be used, and where that location should be. 

(file server, ftp site, Vault, etc.) 
Additional configuration options include:

• The size of the “thumbnail” that represents the asset record,
• Whether Cumulus should catalog duplicate assets, or ignore duplicates while cat-

aloging,
• Whether Cumulus should resolve operating systems aliases and shortcuts and cat-

alog the assets they point to, and
• Whether Cumulus should automatically catalog assets referenced in “container” 

documents, such as InDesign and QuarkXPress, which is a powerful option avail-
able with some Cumulus solutions.

You can define as many Asset Handling Sets as you need, which is great because they 
serve so many useful purposes. 
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Examples

One set, for example, might extract all text from a Word document and add that as 
metadata to the asset record. Another set might extract a maximum number of char-
acters or none at all. (Similar options exist for the PDF, PowerPoint, Excel and even the 
Adobe Illustrator filters.)

Or, you might have a set for laptop-based remote users that copies all assets they cat-
alog into a secure, remote location, turning Cumulus into a convenient on-the-road 
back-up solution. A “hotspot” Internet cafe is never far away; now users can back up 
new orders and expense reports while they’re there.

Asset Handling Sets can also determine special ways in which assets are accessed after 
cataloging, such as whether QuarkXPress files should be previewed inside Cumulus, 
or opened from within QuarkXPress itself.

For details on how to customize Asset Handling Sets, see “Asset Handling Sets” .

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – EXPLORE CUMULUS SETS AND TEMPLATES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Asset Storage Modules
At the heart of Asset Handling Sets are a series of “engines” called Asset Storage Mod-
ules. Asset Storage Modules enable Cumulus to communicate with different types of 
storage systems and provide additional functionality for certain file types. Examples of 
different systems Cumulus supports “out of the box” include the filing systems of the 
Mac OS, Windows and Unix. Without Asset Storage Modules for these operating sys-
tems, Cumulus would not be able to read and write data to storage devices hosted on 
those systems as it does. Keep in mind that Cumulus Servers are available on many dif-
ferent operating systems, and the Client software is available for OS X and Windows. 
Because it’s transparent to the user, you might not wonder what enables Cumulus to 
“speak” all those different filing system languages so fluently, but the credit goes to the 
Asset Storage Modules.

Asset Storage Modules that offer additional file-handling capabilities include those for 
Zip, QuarkXPress and PDF files. Using the Zip module, for example, you can drag a Zip 
archive onto your catalog and Cumulus will extract and catalog its contents on the 
fly—each file within the archive becomes its own searchable asset record. On the flip 
side, this same module enables Cumulus to deliver one or more assets to a user 
already Zipped up and ready to go. This is especially handy when assets are down-
loaded over the Web.

Similarly, Asset Storage Modules for PDF, InDesign, PowerPoint and QuarkXPress give 
users the option of splitting the various pages (slides) found in those files into individ-
ual asset records, each with its own set of metadata. These modules have output ben-
efits too: For example, users can assemble brand new PowerPoint presentations using 
cataloged slides or even stand-alone assets in the catalog. 
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In a nutshell, Asset Storage Modules enable Cumulus to read from and write to storage 
locations. Those locations include the physical storage locations we naturally think of, 
such as hard discs and servers, but they can also be less conventional “locations,” such 
as Zip archives and PowerPoint presentations.

Fore more details on Asset Storage Modules, see “Asset Storage Modules” .

Default Asset Handling Sets 

The Asset Handling Sets that come standard with Cumulus are not configured with 
any custom purposes in mind. While this makes them useful for all cataloging pro-
cesses, it also makes them less efficient. To ensure optimum performance from 
Cumulus, set up custom Asset Handling Sets to specifically deal with the asset types 
your company uses. (Cumulus “offers” each file being cataloged through each of the 
activated file filters. So if you know what type of asset you’re cataloging, it makes sense 
to disable unnecessary filters.)
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Asset Handling Sets and Workflow
Access to Asset Handling Sets is based on user permissions, so administrators can 
define, in advance, exactly how assets should be cataloged for each user or group. If a 
user is permitted access to only one Asset Handling Set, that set will be used automat-
ically during all cataloging performed by that user. If more than one set is available to 
the user, a dialog appears that prompts the users to select an Asset Handling Set for 
the cataloging operation.

Cumulus can also “watch” certain folders and automatically catalog assets dropped 
into them. Asset Handling Sets and Metadata Templates can be determined in 
advanced for these operations, making the process entirely automatic. 

If your workflow were to use a system like this, and you needed an easy way to see 
which assets were newly cataloged, you could have a Metadata Template automati-
cally load a field called “New” with the value “yes.” Users could then easily find new 
asset records based on that value, make any metadata edits needed, and then change 
the “New” field value to “no,” indicating the asset record was ready for use.
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Metadata Templates 
In order to fill asset records or categories with predefined metadata values, Cumulus 
provides Metadata Templates. You can think of Metadata Templates as a “rubber 
stamp” that’s applied to a selection of records or categories. Metadata Templates can 
be used to update existing asset records or “prefill” new asset records during catalog-
ing. 

For example, say you’re about to catalog a group of photographs taken by the same 
photographer on the same date, using the same camera. Each photograph has 
unique attributes, which you’ll enter into its asset record later, but you can save your-
self some time by using a Metadata Template to “stuff” the asset records at cataloging 
time with the information common to all. In this case you'd be using the photogra-
pher's name. But you could also “pre-choose” category assignments, set a status field 
to “new,” or any other combination of field edits. 

You can define as many Metadata Templates as you need. At cataloging time, you can 
choose an existing template, or manually enter data to be “prefilled” into the new 
asset records.

Access to Metadata Templates is controlled via user permissions. They can be shared 
so that they are accessible to all users with the permissions to use them.

For details on how to customize Metadata Templates, see Metadata Templates.
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Print Templates
Different combination of print options can be combined and saved as Print Tem-
plates. A Print Template defines how records will be printed. Print Templates include 
definitions for the document layout (page size and orientation, as well as margins) and 
the layout of the records to be printed. Either a Record View Set or defined advanced 
print settings can serve as print layout for the records.

For details on how to customize Print Templates, see “Print Templates” .

Permissions Templates
Permissions templates enable you to assign, remove or explicitly set individual asset 
or category permissions for users or entire groups at once. Note that permissions tem-
plates are an optional feature which may not be available with your Cumulus config-
uration. 

A Permissions template includes permissions for records and categories. Depending 
on the context in which a template is used, either the record or the category permis-
sions will be used. With selected records, the defined record permissions will be used; 
with categories, the defined category permissions will be used.

For details on how to customize Permissions Templates, see “Permissions Templates” .
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Collaboration and Workflow
Cumulus provides features that support your workflows as well as the ad-hoc collab-
oration between Cumulus users, such as:

• the possibility to set up, manage and employ status-based workflows, and to 
attach workflows to individual files

• the possibility to comment on assets and mention someone in the comment text 
who will be notified about the mentioning

• subscriptions to individual files in order to get notified whenever metadata of this 
file is changed

In addition to status-based workflows, Cumulus also offers workflow support func-
tions that are based on Action types, such as:

• User-defined actions (see Cumulus Asset Actions) 
• Event-based actions see (Cumulus Trigger Actions)
• Time-based actions (see Cumulus Scheduler Actions)

Workflows
A workflows consists of a sequence of freely definable states, and the activities that 
cause the transition from a source state to a target state. To each state, one or several 
users (or roles, if your Cumulus runs in role-based mode) can be assigned which are 
responsible for the further processing of the files (assets) in the current state, and for 
promoting the file (asset) to next possible state in the workflow.
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From an Administrator’s Point of View

Workflows are created via the Workflow Manager of the Cumulus Web Server Con-
sole and must be added to catalogs via the Catalog Settings section of the Preferences 
window at the Cumulus Desktop Client.

Creating Workflows with the Workflow Manager

First you must create the states you need in your workflow (which basically consists in 
giving them meaningful names...), then the activities. For each activity, you must select 
one or more possible source states (i.e., the states in which the activity can be per-
formed) and one target state, thus defining the sequence and order of the states in the 
workflow.

In addition to the modification of the state, an activity can also:

• assign one ore more users / roles to the target state, or clear the assignment

• trigger an asset action that is performed on the file during the transition to the 
next state

• have their availability restricted to certain users only

For details, see Configuring Workflows.

Adding Workflows to a Catalog via the Preferences Window

Workflows are defined catalog-independent. However, in order to be applicable to the 
files/assets in a catalog, a workflow must at first be added to the catalog. Files/assets 
can only be attached to workflows that have been added to the catalog containing 
the assets. You add workflows to a catalog on the Workflows tab of the Catalog Set-
tings section of the Preferences window.
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Additionally, workflows must be made known to Asset Handling Sets, e.g. in order to 
attach newly cataloged assets automatically to a workflow.

Fore details, see the Workflow Tab section in Overview: Catalog Settings Window, and 
the Workflow Tab section in Overview: Asset Handling Sets.

From a User’s Point of View

If a catalog contains workflows, they are available 

• with the Desktop Client via a Workflows menu
• with the Cumulus Web Client on the Workflows overview page.
Users can manually attach workflows to individual files: with the Web Client via the 
Start workflow entry in the tool box, and on the Desktop Client by applying the start-
ing activity from the Workflows menu (or the shortcut menu). 

Workflows can also be attached automatically to files during the cataloging process 
via an Asset Handling Set, and they can be started by a Scheduler action, or a Trigger, 
on files that match a given query (see Provided Scheduler Actions and Cumulus Trig-
ger).

Files/assets with an attached workflow have a workflow state and are assigned to one 
or several users (or roles, if your Cumulus runs in role-based mode). To which user(s)/
role(s) a file/asset is assigned depends on its current workflow state.

• Only users which are assigned to a certain state can perform the activity that leads 
to the next workflow state:

• With the Cumulus Web Client, a user gets displayed all files he/she is assigned to 
on the Workflows page. If the user is responsible for files in different states, the 
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Workflow page provides a tab for each state. For each file on the workflows page, 
the appropriate activities are provided in the toolbox. As soon as the user selects 
such an activity, the file is promoted to the next workflow state (and therefore no 
longer displayed on the current tab).

• With the Cumulus Desktop Client, a user can find all assets/files he/she is assigned 
to for any single workflow via the Workflows menu (Workflows > [workflow 
name] > Currently assigned to me). 

Commenting and Mentioning
Cumulus provides a user comments function, both with the Desktop Client as with the 
Web Client, allowing Cumulus users to comment on assets. A comment can apply to an 
asset in general, or it can refer to a specific detail in the asset, e.g. an area of a picture. 

With the Cumulus Web Client, it is additionally possible to mention Cumulus users 
within a comment by entering the @ character followed by a username (@username). 
Mentioned Cumulus users are notified about the comment via email.

Subscriptions
With the Cumulus Web Client, users can subscribe to individual files/assets in order to 
get notified if the metadata of these files/assets is modified. These notifications are 
sent via email to the subscribing user. Which metadata fields are taken into account 
for a notification can be specified by an administrator for each catalog individually. 

Fore details, see the Workflow Tab section in Overview: Catalog Settings Window.
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Find Assets

If you can’t find it, you can’t use it. With Cumulus it is easy to find the assets you are

looking for as Cumulus provides easy and powerful search capabilities. These are

described in this chapter.

There are several ways to find what you are looking for: searching by category, quick

searching and searching with the Find window. Depending on the size of your catalogs

and the complexity of your search requirements, you may find one way better suited

to your needs.

The topics of this chapter include:

• Searching for Records By Category

• Searching with Quicksearch

• Searching with the Find Window and Working with Saved Search Queries

• User Live Filtering

For additional specific Find options, see “The Find Menu” .
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Searching for Records By Category
The simplest form of searching for records is simply double-clicking on a category in 
the Category pane, also known as Category list Search. This quickly finds all of the 
records that are associated with that category. You can also select multiple categories 
before the double click to see all the records associated with the set.

There are several Preference options that affect the way category list searching works. 
(See “Search & Sort Tab”, for more detailed information.)

In order to find records by category, it may be helpful to find appropriate categories 
initially. Finding categories even in deeply nested category trees is easy with the Cat-
egory Quicksearch.
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Searching with Quicksearch
Cumulus provides two Quicksearch fields, one to search for records (located in the 
toolbar), and one  to search for categories (located in the Category pane).

Both Quicksearch fields work the same way – just enter a search term (e.g. a name or 
a number) into the field and click the icon or press Enter. 

With Record Quicksearch, Cumulus by default searches the record fields Record Name, 
Document Text, Notes, Keywords, and Categories. The result shows all records that 
contain the search term in any one of these fields.

With Category Quicksearch, Cumulus by default searches the Category Name field. 
The result shows all categories that contain the search term in their names. To provide 
orientation in the category hierarchy, the categories above the found categories are 
displayed additionally.

By default, the Quicksearch is performed as a “contains” search for all included String 
fields and String List fields, and as an “is” search for all included Integer fields in all cat-
alogs open in the current collection.

A contains search means, that searching for the string dog not only will find the word 
dog, but also doggy, dogma, bulldog, endogenous, etc – in short, any word containing 
that particular sting.

Additionally, word-searching for String fields and String List fields can be enabled by 
activating the Index for word-searching option in the properties of the field, via the 
Catalogs section of the Preferences dialog (see Overview: Field Properties / General 
Tab / Indexing, for details.
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The selection of fields used by Record Quicksearch as well as by Category Quicksearch 
can be changed in the User Settings section of the Preferences dialog (see Search & 
Sort Tab / Records and Categories, for details). 
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Search Options
If you enter two or more terms into a Quicksearch field, Cumulus combines these 
terms with AND. Searching for canto cumulus will result in all records that contain 
Canto (or belcanto, cantor, cantonese ...)and Cumulus in any of the searched record 
fields.

To use a term that consists of more than one string, you have to enclose the strings 
with double quotation marks. Quicksearch handles the strings in quotation marks as 
one search term. Searching for “canto cumulus” will result in all records that contain   
canto cumulus, i.e. the strings Canto (or belcanto, but not cantor, cantonese ...) and 
Cumulus, separated by a blank, in any of the searched record fields.

To combine search terms with OR, you have to separate them with two pipes (||). 
Searching for canto || cumulus will result in all records containing either canto (belca-
nto, cantor, cantonese ...), or cumulus, or both, in any of the searched record fields.

To search for records that do not contain certain terms in any of the searched record 
fields, you have to prepend the terms with a minus symbol (-). Searching for cumulus 
-cloud will result in all records that contain cumulus, but do not contain cloud, in any 
of the searched record fields.

To search for one of the special characters you have to put a backslash in front; e.g. \- 
to find - (the minus symbol), \&& to find &&, \/ to find / (the slash), and \\ to find \ (the 
backslash itself).

NOTE: If the Categories field is included in the Record Quicksearch (which is the 
default), the search results also depend on the settings specified under Cate-
gory Search Also Finds Records of (Preferences > User Settings > Application 
> Search & Sort). (See “Search & Sort Tab”, for details.) 
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Additional Search Options with Index for word-searching activated

Only if an administrator has activated the Index for word-searching option in the 
properties of a string field or string list field, it is possible to perform a word search in 
the respective field, that is, to search for a term exactly as it is.

To perform a wordsearch, you must enclose the search term in single quotation marks: 
Searching for ‘canto’ then will result in all records containing exactly the word canto in 
any of the searched record fields, but not belcanto, cantor, cantonese, etc.

To perform a word search for a term that consists of two or more strings, you must 
enclose the strings first in single quotation marks, then in double quotation marks: 
doble quote - single quote - term1 - blank - term 2 - single quote - double quote.. 
Searching for ” ‘canto cumulus’ ” will result in all records, that contain precisely the 
strings canto and cumulus, separated by a blank, in any of the searched record fields.
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The Quicksearch Menu
The Quicksearch menu is displayed by clicking the arrow button next to the magnify-
ing glass icon on either Quicksearch field.  

Besides a section displaying previously used search terms, and a section displaying 
saved search queries (see “Working with Saved Search Queries” ), the Quicksearch 
menus provide the following entries:

• Find in Collection – Searches in the currently displayed collection only, e.g. in the 
result of a previous search. Handy for narrowing down search results. (Record 
Quicksearch only)

• Find and Add to Collection – Searches in all open catalogs; adds the search result 
to the currently displayed collection. Handy for broadening a search result. (Record 
Quicksearch only)

• Clear Quicksearch List – Deletes the previously used search terms.
• Advanced – Opens the Find window (See “Searching with the Find Window,” 

below, for details.)
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Searching with the Find Window
The Find Window reveals the true search power of Cumulus. Complex search set-ups 
(queries) can be constructed to find virtually any type of data stored for an asset. Bool-
ean operators (and, or) increase the query possibilities even further. Different search 
methods let you define the search area (either all records of all catalogs opened in the 
current collection or only the records contained in the current collection.) The 
matches can either be added to the current collection, replace the records in the cur-
rent collection or comprise a new collection of their own. 

For a detailed description of the Find window, see “Overview: The Find Window” . 

For a comprehensive listing of searchable fields, see “Sample Search Options” . 
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Overview: The Find Window 
To open the Find window: Select Find > Find Records or Find > Find Categories 

1 Displays the name of the collection/catalog(s) that will be searched by the query in this Find 
window and that is referred to as ’current collection’. 

2 Search criteria.
3 Search operator.
4 Search value. (If the selected search criteria is a Vocabulary field, a Browse button is offered 

to select a value from the given terms.)

NOTE: You can search for whole words, not just for matching strings – if the Record field set 
as search criteria is activated for word-searching. Enclose the word you are searching for in 
single  quotation marks and Cumulus will only find the records that contain the exact word. 
For example searching for  copy will find records containing the words copy as well as 
copyright, copyhold, copyfree and so on. Searching for ‘copy’ will find records containing 
the word copy only.

5 Inserts a new search condition before the current one.

3
5

42
6

7

1

8
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10

11

15141312

16
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6 Inserts a new search condition after the current one.

NOTE: The order of search conditions is important when you connect search conditions with 
the Boolean operator “or”. (For more details, see “Sequence of Search Conditions” .)

Find Method (7 - 9)

7 Will search all open catalogs of the current collection.
8 Will search the current collection only. (For more information and examples, see “Narrow-

ing the Search” .)
9 Found records/categories are added to the current collection. (For more information and 

examples, see “Narrowing the Search” .)

Found Records/Categories (10 - 16)

10 Found records/categories replace the current collection.
11 Found records/categories will comprise a new collection.
12 Displays help text.
13 Opens the Advanced Find windows for entering nested queries.
14 All records/categories of those catalogs opened in the current collection will be shown.
15 Starts the search.
16 Opens a menu for saving or loading queries. (For more details, see “Working with Saved 

Search Queries” .)

NOTE: Cumulus search options are NOT case sensitive. 
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BACKGROUND INFO:  Window Connected to Collection

When a Find window is opened, it is connected to the active collection or cat-
alog window. That’s why the name of the source window is displayed in the 
title of the Find window. It is important to be aware of this fact, when you use 
an open Find window for multiple searches – especially, if you decide to have 
the search results displayed in a new collection. Be aware of this fact when 
using the following search methods: 
– Find in Current Collection: the contents of the source window defines the 
’search area’ 
– Find and Add to Current Collection: the matches of the search are added to 
the contents of the source window
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Sample Search Options 

Criteria Field 
Type

Opera-
tor

Searches for Sample Data/Instructions

Categories Special Records associated with specified category. Type category name or drag category  onto Value field. Use drag method 

if catalog has multiple categories of the same name. Current Search Pref-

erences settings affect results. (See “Search & Sort Tab”)

Thumbnail Special Similar thumbnails. Compares brightness and 

contrast.

Type record name or drag record thumbnail onto Value field.

Horizontal 

Resolution

Real Dot-per-inch resolution of an image asset file. 200, 300

File Data Size Integer The asset file size. (Not the record size.) 1024 KB (use KB for kilobytes)

24 MB (use MB for megabytes)

Asset Creation 

Date

Date  The date the asset was created. 11/22/97

Color Mode String List  The color mode of an image. Select from Value list.

Cataloging User String The name of the user who cataloged the asset. Clint, Carolyn

Notes String Records with a group of characters in the Notes 

field that matches criteria. 

Any line of text. For example, “ball” finds ball, balloon and baseball. “ll 

rights res” finds “All rights reserved.”

Record /Cate-

gory Name

String The name of the record /category. Balloon, Clouds, Gun Shot / Illustration, Aircraft, Sounds

a

b

c

c

c

d

e

e

e
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bOperator
Menu
Options

a c e

Field 
Type Categories Thumbnail

Date, Real, 
Integer

String 
List* String*

* The menu options for 
this field type may differ 
depending on the field 
properties the Cumulus 
Administrator has set up 
for the selected field.

d

NOTE: If the searched field is empty (has no value), the operators “is not” and “doesn’t contain” 
will not return a result. 
To find records with no value in a specific field, use the operator “has no value”.
Instead of a value to be searched for, you can enter a placeholder string. This causes Cumulus to 
display a dialog for specifying the search value each time the query is executed. See “Using Place-
holders”.
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Simple Searches
To set up a simple search (as opposed to a compound search, described on page 156):

1. Click Find > Find Records or Find Categories to open the Find window.

2. Select a search criterion from the Criteria list. This list contains all record or cate-
gory fields activated for searching.

3. Select an operator from the Operator list. This list contains all operators that are 
possible for the field type of the field selected as criteria.

 

4. Either select a value from the Value list, type a value in, or drag an appropriate 
object onto the field. (Appropriate objects can be either thumbnails or catego-
ries.)

Search Criteria

Criteria

Operator

Search Operator
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5. Leave the default search method Search in All Open Catalogs. This method 
searches all catalogs included in the current collection.

6. Click New Collection so that the records found will be displayed in a new collec-
tion of their own.

7. Click Find.

Value

Search Value 
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Compound Searches
In larger catalogs, finding records with a single search criterion may not be efficient. 
To avoid sifting through tens of thousands of records, you may need to use more than 
one search criterion. 

Cumulus lets you do this in two different ways:

• You can enter a compound search (more than one search criterion), OR
• You can narrow the results of a simple or compound search. (See “Narrowing the 

Search”.)
Setting up each condition in a compound search is the same as setting up a simple 
search. The only additional steps are adding a new line of search fields, and specifying 
the Boolean connector between each condition. 

Additional conditions may be added to further refine the search. Add and delete con-
ditions using the following buttons:

•  Inserts a new search condition before the current condition. (The current con-
dition is the line in which a field is highlighted or the flashing cursor I-beam is 
found. Click in any field to make that line the current condition.)

•  Inserts a new search condition after the current condition.
•  Deletes the current condition. This is not undoable!

Example

Building a compound search isn’t much more difficult than building a simple search. 
You just have to think in terms of what you are asking Cumulus to do, and then trans-
late that request into the search fields. 

Your request, in English, might read:
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“I need all records in the Pictures category that have ‘tree’ somewhere in their 
names.”

Translated into Cumulus-speak, this becomes:

• Category is Pictures and Record Name contains tree.

Now let’s break it down into separate search statements, called “conditions.”

• Category is Pictures

In our first condition, Category is our search criterion, is  our operator, and Pictures is 
the value we’re searching for. This tells Cumulus that the records we want are all in the 
Pictures category. This alone would find the records we’re looking for, but if our cata-
log contained thousands of images in the Pictures category, we’d spend quite a bit of 
time browsing through them all.

• and

This next little bit is very important. This is a Boolean operator that tells Cumulus how 
to consider the previous and next search conditions. By selecting and, we tell Cumulus 
that the records we want must match both conditions of our compound search. 
Another option here is or, which would tell Cumulus that the records we want only 
need to match one of the conditions.

• Record Name contains tree

In the second condition of the search, we help Cumulus narrow the search results by 
giving it part of the record name that we want. We use the operator contains instead 
of is because we’re looking for records that have ‘tree’ anywhere in their names. Is 
would require that the record be called exactly ‘tree,’ with no variation.

In the Find window, the field values will construct a sentence similar to the one we just 
broke down. When you can see each condition on a line by itself, it’s easier to visualize 
the results of the request.
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Sequence of Search Conditions
When performing a Find window search Cumulus performs one search condition after 
the other. The Boolean and and or operators define how Cumulus has to connect the 
previous and next search conditions. The operator and defines that the records must 
match both conditions. The operator or defines that the records need to match one of 
the conditions only. If you have more than two search conditions in a search query, a 
condition connected with and will search the matches of the previous condition and 
reduce this result – whereas a condition combined with or will search the entire 
’search area’ (as defined under Search Method) and add the new matches to the pre-
vious matches. 

SPECIAL TECH INFO:  Nested Queries

If you want to enclose search conditions in brackets and set up nested queries, 
you must use the Find window in advanced mode. See “Using the Find Win-
dow in Advanced Mode”, for details.

Examples

Search Query A: 

Category is Photographs 
and 
Record Name contains penguin
and 
Record Name contains balloon
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First, Cumulus will search for all records that are assigned to the category Photo-
graphs and then, second, the result will be refined by searching for records that con-
tain penguin in their names. Third, this result will be refined by searching for records 
that contain balloon in their names. 

In the Sample Catalog the final result of this search query is:

• Penguin Balloon.psd

Search Query B: 

Condition 1: Category is Photographs 
and 
Condition 2: Record Name contains penguin
or 
Condition 3: Record Name contains balloon

First Cumulus will search for all records that are assigned to the category Photographs 
and then, second, the result will be refined by searching for records that contain pen-
guin in their names. Third, the ’search area’ (as defined under Search Method) will be 
searched for records that contain balloon in their names and the matches will be 
added to the results of the previous conditions. 

In the Sample Catalog the final result of this search query is: 

• Penguins.jpg
• Penguin Balloon.PSD
• Balloon Race.BMP
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Narrowing the Search
If the results you get from either a simple or compound search are too broad, Cumulus 
can help. The search method Find In Current Collection allows you to search through 
the set of records contained in the current collection, instead of the entire catalogs of 
the current collection, thereby reducing the number of records found.

If it helps, you might want to think of Narrow Current Collection as an and Boolean 
operator. That is, after your first search, you conduct another search with different 
search criteria, and the final results are the same as from the corresponding com-
pound search using and. In the example above, the same final results were achieved 
with the compound search previously conducted.
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Broadening the Search
If the results you get from either a simple or compound search are too narrow, 
Cumulus can be of assistance again. The search method Find and Add to Current Col-
lection adds the results of a subsequent search to the records contained in the current 
collection.

This search method can be seen as an or Boolean operator. That is, after your first 
search, you conduct another search using a different criteria, and the final results are 
the same as from the corresponding compound search using or.
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Working with Saved Search Queries
Although Cumulus remembers your search set-ups if you leave them open when you 
quit Cumulus, you can also save search set-ups, called queries. This prevents you from 
having to rebuild them each time you need them. It also ensures that your searches 
are consistent from session to session, which is important for some purposes.

With saved queries, you can use placeholder in the search value field, thus allowing 
the users to specify the query further during its execution.

Cumulus query files can be used on any supported platform. You can store and load 
queries for quick retrieval if you have the appropriate permissions.

NOTE: A saved query can be used with any catalog you have access to. How-
ever, there is something to take account of: If a query uses a field with the oper-
ator “has no value”, and you run that query in a catalog that does not contain 
that specific field, the query will find all records in that catalog. Although this 
may not be what you expect, it is the proper behavior.

Saving and Loading Search Queries

To save the current query: 

1. Click the  button and select Save.

A dialog appears in which you can name the query.

2. Type a name for the query in the Query Name field.
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3. Enter a description for the query. Make the description meaningful especially for 
queries that contain placeholders, because the description text will be displayed 
in the dialog window.

4. To make the query available for other users, activate the Share Query option.

5. Click Save.

The query is stored in one of the two special query files Cumulus provides – one for 
the individual queries of a user and the other one for shared queries. With Workgroup 
or Enterprise these files are centrally stored at the Cumulus Server. 

To load a query:

1. Click the  button. A menu containing entries for all queries that are available 
to you is displayed. These include those that you set up as well as those set up by 
other users for sharing.

2. Select the entry for the desired query file.

Using Placeholders

Placeholders enable you to set up complex search queries which appear for the exe-
cuting user as easy search forms. With placeholders included in a query, Cumulus dis-
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plays a dialog each time the query is invoked, forcing the user to enter appropriate 
values before the query is finally executed. 

Placeholder can be used with most field types except UserUID, Binary and Picture 
fields. 

To include a placeholder with a query:

1. Enter ${} as an identifier into the search value field of a search option. 

In a compound query, you can use as many placeholders as you need.  However, 
when using several placeholders in one single query, each placeholder must have 
a unique identifier, e.g. ${p1}, ${p2}, ${abc}, ...

TIP: Query Description is Displayed

When saving a query with placeholders use the description to inform the user 
what to do.

Example: Dialog window for a query 
with two placeholders, one for a string 
to be found in the record name, and 
one for a string to be found in the 
Notes field.
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Exporting and Importing Search Queries

If you want to store a query as a separate file anywhere in the file system, you have to 
export it:

1. Click the  button. 

2. Select Export. A dialog appears from which you can save the current query any-
where in the file system.

3. Select a location.

4. Click the button Save.

To load such an exported query file you have to import it:

1. Click the  button. 

2. Select Import. A dialog appears from which you can select a query.

3. Select a query file.

4. Click the button Open.

Things You Can Do with Searches/Queries

• Create a new search condition. (See “Compound Searches”.)
• Load search queries. (See “Working with Saved Search Queries”.)
• Save search queries. (See “Working with Saved Search Queries”.)
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Using the Find Window in Advanced Mode
This mode is designed for advanced users only who know how to set up search que-
ries that are of greater technical depth. In standard mode, the Find window combines 
search conditions in a sequence for a complex query, whereas in advanced mode, the 
Find window allows you to set up nested queries. If you are working in a multilingual 
environment, the advanced mode provides another advantage as the queries that are 
set up in this mode are language independent.

To switch the Find window to advanced mode, click the Advanced Mode button in 
the Find window. In advanced mode the Find window looks like this:

In the edit field you can enter any combination of search criteria, operators, values, and 
Boolean operators. For a detailed description see Query Format. 
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NOTE: If the edit field was empty before you switched to the advanced mode, 
the field will contain the search query set up in standard mode.

Record fields that can be used as search criteria are displayed when you click the 
Fields button. This list displays all fields contained in the current collection that are 
indexed for search. If you select an item in this list, it is inserted in the edit field of the 
Advanced Find window at the current cursor position.

The symbols you can use for search combinations are displayed when you click the 
Symbols button. 

If you select an item in this list, it is inserted in the edit field at the current cursor posi-
tion – exception: If you have marked a selection and then choose the “combine” sym-
bol, the “combine” symbol will wrap the selection (opening bracket at the start and 
closing bracket at the end of the selection).

You can also set up a query in standard mode first and then switch to advanced mode. 
When switching back to standard mode by clicking the Simple Mode button, the 
query will be the same as before switching to the advanced mode. Note that it does 
not reflect the changes made in advanced mode. When changing back to advanced 
mode, the query set up in this mode is displayed again.
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Searching for Categories
The Find Categories window has the same look and feel as the Find Records window 
and offers the same possibilities to configure your searches.

For more details, see “Overview: The Find Window” .

The categories found as a result of your search are displayed in the Category pane. The 
found categories are displayed and can be used. Additionally, the categories above 
the found categories are displayed for better orientation.

The categories found as a result of your search can either replace the categories of the 
current collection or comprise a new collection of their own. 

NOTE: The result of a category search also depends on the Live Filtering 
options the Cumulus Administrator may have set for you. 
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User Live Filtering
User Live Filtering enables you to set parameters that serve as a filter for all the records 
you find. Easily hide the file formats you don’t need, make sure what you see has been 
approved for use, or any other combination you need. Save your filters and even share 
them with others.

With User Live Filtering activated, the records on your Record pane get ’filtered’ by 
conditions you set up. 

NOTE: User Live Filtering vs. Live Filtering
Do not mix up this User Live Filtering with that Live Filtering the Cumulus 
Administrator can set up to limit the view of a user or a user group to prese-
lected categories and/or records. 

You activate and deactivate User Live Filtering via the Filter icon in the Record pane 
top bar. 

As long as filtering is active, any further search operation – Quicksearch, Category 
Search, whatever – will only take into account the collection as defined by the filter cri-
teria, not the whole catalog. Accordingly, the Find All Records command will only find 
records that match the filter criteria.
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Working with Filters
Create filters to quickly find files. For example, you can create a filter to find all files in 
a specific workflow state, a filter to limit the results you see in the Cumulus window to 
certain file types or to just those assets that belong to a certain client. 
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Adding Filters 
Conditions define the criteria that files must meet to be included in filter results. You 
can combine multiple conditions to perform more complex filtering. 

To add a filter condition:

1. If filtering is not activated, click the Filter icon. 

2. Click the plus sign icon. A list of record fields opens. 

The list contains all record fields that are contained in the catalogs opened in the 
current collection and that have Include Field in Find and Filter Options activated 
in their properties. 

NOTE: Record Fields Offered as Criteria
Per filter a record field can only be used once as a criteria for a condition. This 
means that a record field already used for a condition is not offered in the list 
when adding a new condition. 

3. Select the record field you want to function as criteria. 

The Define Filter Condition dialog opens.

Depending on the field type of the field you selected as search criteria, the 
options differ. 

4. Set the criteria records must meet to pass the filter. For information on the differ-
ent options, see “Using Filters” .

5. Click OK to save your settings and activate the filter condition.
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To add additional filter conditions, repeat steps 2-5. 

To edit an existing filter condition, maximize the pane (  ) and click the pencil icon.

To remove a filter condition, click the minus sign icon in the maximized pane.

To remove all filter conditions at once, from the Manage Filters menu select Remove 
all Conditions. Note that conditions not saved as filter will be lost. 
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Saving Filters
Use the Manage Filters menu to save the active filter conditions as a filter under a 
name. Saved filters are added to the menu and can be used any time you need them. 
You can share them with others.

1. Click the Manage Filters icon to open the menu.

2. Select the Save Filter option. The Save Filter dialog opens. 

3. Enter a Filter name. Make sure you use a descriptive name. If you want this filter to 
be available for other users, activate the Share Filter option. Note that you may 
only be able to save shared filters depending on your permissions for shared que-
ries.

4. Click OK to save the filter. 

An entry for this filter is added to the Manage Filters menu.
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Using Filters 
You can filter the records of a collection window to display specific records only. Use 
the Manage Filters menu to select the desired filter. 

1. Click the Manage Filters icon ( ) to open the menu.

2. The available filters are listed at the bottom of the menu. The menu displays all 
shared filters in addition to private filters that you created.

3. Select the desired filter. 

Only the records of assets that meet the filter criteria are displayed. 
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Deleting Filters
Use the Manage Filters menu to delete filters you need longer.

1. Click the Manage Filters icon to open the menu.

2. Select the Delete Filter option. The Delete Filter dialog opens. It lists the available 
filters.

3.  Select the filter you want to delete.

4. Click OK to delete the filter. The entry for this filter is deleted from the Manage Fil-
ters menu.
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Configuring Filters 
Filters comprise one or multiple conditions. 

Defining Conditions in General

Conditions are criteria that records must meet to be included in filter results. Depend-
ing on the field type of the field you selected as criteria, the options differ. For most of 
them you first have to decide on one of the three main options – either on one of the 
simple ones:

• Has value – Record will be included in the filter result if the field contains some-
thing.

• Has no value – Record will be included in the filter result if the field is empty.
Or the third one which offers further options that allow a precise description:

• Matches / Does not match (for most types) OR 
Contain / Does not contain (String lists only) OR
Is assigned to (Categories field only)

The further ’sub-options’ depend on the field type and range from general search cri-
teria to exact matches with existing values. For most types the option From existing 
values is offered. It enables you to search for exact matches with existing values. 
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Field Type Specific Condition Options
The options offered as conditions depend on the type of the field you have selected 
as search criteria.

String 

Limits filter results to records with: Text that matches or does not match specific text 
string or a regular expression

Select a matching option:

• Select Matches to search for records that contain the text.
• Select Does not match to search for records that do not contain the text.
Select the type of value to search for and enter or select the value: 

• Select Custom value to search for a text string you define. Enter the string and 
select the search operator.

• Select From existing values to search for exact matches with existing values. Once 
you have activated this option, existing values are displayed which you can select 
to be searched for.

String List

Limits filter results to records with values, such as workflow states, that contain or do 
not contain any or all of the values selected. 

Select an option to indicate if the results contain the selected values:

• Select Contains the following items to search for records that contain the values.
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• Select Does not contain the following items to search for records that do not con-
tain the values.

Select the value(s) to search for: 

• Select Restrict to existing values to search for exact matches with existing values. 
Once you have activated this option, existing values are displayed which you can 
select to be searched for.

Long & Integer, Real & Data Size

Limits filter results to records with: numbers that match or do not match a number or 
numbers in a range. Integer restrictions, which are based on non-decimal numbers, 
limit results to records that contain or do not contain numbers in a range or list.

Select a matching option:

• Select Matches to search for records that contain the numbers.
• Select Does not match to search for records that do not contain the numbers.
Select the type of value to be searched for, and enter or select the value: 

• Select Range to search a range of values. Enter the From and to values.
• Select Any of the following numbers to search for multiple numbers. Enter the 

numbers to be searched for, separated by semicolons.

TIP: Greater Range
You can search for ranges greater than or less than a specific value. Leave the From 
field empty to search for matches less than the value in the to field. Leave the to field 
empty to search for matches greater than the value in the From field.

• Select From existing values to search for exact matches with existing values. Once 
you have activated this option, existing values are displayed which you can select 
to be searched for.
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Time Only & Date Only 

Limits filter results to records with: Time data or dates that match or do not match a 
specific date, date range, or time period. 

Select a matching option:

• Select Matches to search for records that contain the selected dates. 
• Select Does not match to search for records that do not contain the selected 

dates.
Select the type of value to be searched for and enter or select the value: 

• Select Range to search a specific date/time range. Enter the range in the From and 
through fields.

• Select Any of the following dates/times to search for multiple statements. Enter 
the time data to be searched for, separated by semicolons.

TIP: Greater Range
You can search for ranges greater than or less than a specific value. Leave the From 
field empty to search for matches less than the value in the to field. Leave the to field 
empty to search for matches greater than the value in the From field.

• Select From existing values to search for exact matches with existing values. Once 
you have activated this option existing, values are displayed which you can select 
to be searched for.

Date/Time

Limits filter results to records with: Dates that match or do not match a specific date, 
date range, or time period. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – FIND ASSETS USER LIVE FILTERING

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Date range restrictions limit results to records that contain or do not contain a date 
range, date/time range, or time period.

Select an option to indicate if the results meet the specified dates and times:

• Select Matches to search for records that contain the selected dates and times. 
• Select Does not match to search for records that do not contain the selected dates 

and times.
Select the time period to search.

• Select From date to search a specific date range. Enter the range.

TIP: Greater Range
You can search for ranges greater than or less than a specific value. Leave the From 
field empty to search for matches less than the value in the to field. Leave the to field 
empty to search for matches greater than the value in the From field.

• Select From date/time to search a specific date/time range. Enter the range. This 
option is only available for date/time fields.

• Select a time period option to search a specific period, such as last week or last 
year. This option is only available for date fields that include the time, such as event 
date/time fields.

• Select In the to search a specified number of days, weeks, months, or years before 
or after the current date. Select Last or Next, enter a number, and select the time 
period.

• Select From existing values to search for exact matches with existing values. Once 
you have activated this option, existing values are displayed which you can select 
to be searched for.
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Boolean

Limits filter results to records with: True or false set  

Select an option.

Categories

Limits filter results to records that are assigned to any or all categories selected. 

Check the categories to be searched for. Note that the categories available under Is 
Assigned To depend on the tab currently selected in the Category pane.
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Use Assets

If you intend to do anything more than simply browsing through catalogs, you should

read this chapter. It describes how to use, present and share your cataloged assets. This

is followed by a few simple guidelines that will ensure your workflow is as efficient as

possible.

The topics of this chapter include:

• Drag and Drop

• Mailing Your Assets

• Previewing Assets

• Repurposing Assets

• WebAlbum

• Configuring Web URL

• Importing and Exporting

• Workflow Enhancements

• Workflow Automation with Cumulus

• Managing Related Assets

• Automatic Tagging of Assets
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Drag and Drop
Cumulus does not only support drag and drop in the Cumulus application and for cat-
aloging. From within Cumulus you can drag and drop assets into other applications 
that support drag and drop. Under OS X you have to press the ALT key when starting 
dragging. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS DRAG AND DROP

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Copying Assets
You can drag and drop a record into another drag and drop-supporting application. 
Dragging a record copies the asset into the target document. Dragging a record into 
the Windows Explorer or the OS X Finder copies the asset into the selected folder.

NOTE: It is not recommended to use drag and drop for copying a large number 
of files, because this may seriously impact the performance of your system and 
the available disk space. To copy a large number of files, use the Copy to menu 
command instead.
The reason for this is that both methods are handled in different ways internally. 
With the Copy to menu command, Cumulus creates a temporary file for each 
asset which is deleted as soon as the asset is copied. On the other hand, with 
drag and drop, temporary files of all selected assets are created before the first 
asset is copied, and these temporary files are not deleted until a new copy pro-
cess via drag & drop is started, or Cumulus is closed.
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Copying Categories and Associated Assets
Categories can be dragged and dropped – along with the assets associated with each 
category – into the Windows Explorer or the OS X Finder. When you drop the catego-
ries, Cumulus creates a folder with the same name as the category and copies the 
assets to that folder. If the category contains subcategories, subfolders will be created 
and the assets assigned to these subcategories are copied to the corresponding sub-
folders.

This option may be handy for collecting production files for output (assuming the files 
all have at least one common category, such as project name).

To copy categories and associated assets:

1. Select one or more categories that you want to copy along with the associated 
asset files.

2. Drag and drop the selected categories into the target application. 

NOTE: If you use this way of copying assets, any associated metadata files (e.g. 
TAG files) will not be copied even if the corresponding metadata modules are 
activated. 

A folder named as the category is created containing the asset assigned.

You also have the option of copying only the asset files associated with selected cat-
egories (see “Copy Assets Assigned to Category To” ).
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Mailing Your Assets
Cumulus also lets you email the assets themselves, so that you can easily share them 
with people who don’t have access to your Cumulus catalogs. You can use Cumulus’ 
powerful search and display features to find just the right assets, and then send them 
off with a single command.

To email assets from within Cumulus:

1. Select one or more records whose assets you want to mail.

2. Select Asset > Mail To. A dialog opens prompting whether you want to send the 
original asset or to have a Cumulus Action performed on the asset(s) before it is 
sent.

3. Select the desired option (and if you decided on an Action, the desired Action) 
and click OK.

Cumulus launches your email application (in case you have more than one, 
offers you a menu to select) / launches your default email application and 
attaches the selected asset(s) to an outgoing message. (If you decided on an 
Action, the result of the Action will also be saved as defined for the delivering 
module of the Action.)
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Previewing Assets 
Cumulus provides several ways of previewing assets:

• Preview pane
• Preview view
• Preview window
• Fullscreen Preview
• Fullscreen Slide Show
Viewing an asset in Preview view or window lets you add user comments to it. In 
Fullscreen Preview you can compare up to six different assets and add labels and rat-
ings. The Fullscreen Slide Show displays assets as fullscreen previews in a slide show. 
The Preview pane can be opened additionally at the left side of a collection window. 

For the preview of video files, an appropriate player is used which provides usual con-
trols (play/pause, stop, volume control, timeline, full screen, etc).
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Preview View and Window
The records’ assets must be available to display.

Previews can be zoomed in or out and displayed in different sizes using the window’s 
toolbar or menu options. (See “Overview: Toolbars for Previews”and see “Zoom In” , 
and “Zoom Out”.) 

The default size of the preview display can be set in the User Settings. (See “Display 
Tab”). 

You can copy all or part of a preview to the Clipboard. To select a portion of the pre-
view image:

1. Click the Select Tool ( ) on the toolbar and then click and hold the mouse 
down in the upper left hand corner of the region you want to copy.

2. Drag the mouse to the lower right of the region. A box is drawn around the 
selected area.

3. Press Command / Control and c to have the selected portion on the Clip-
board.

The selected portion of the preview is on the Clipboard and may be pasted into other 
applications. Remember, this is a copy of the preview image, not the actual asset. 
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A selected portion of a preview can also be zoomed in:

1. Click the Select Tool ( ) on the toolbar and then click and hold the mouse 
down in the upper left hand corner of the region you want to zoom in.

2. Drag the mouse to the lower right of the region. A box is drawn around the 
selected area.

3. Click the Zoom in icon ( ) on the toolbar to have the selected portion fill in the 
entire size of the Preview window.
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Overview: Toolbars for Previews

1 Select tool: Use to select an area of the preview.
2 Handtool: Use to move around the preview so you view all areas of it. (Works only if the pre-

view is larger than the window.)

NOTE: Toggling between Hand Tool and Select Tool: Activating the Hand Tool deactivates 
the Select Tool and vice versa.

3 User Comment tool: Show or hide the comments column.
4 Rotates the preview 90° counter-clockwise
5 Rotates the preview 180° 
6 Rotates the preview 90° clockwise
7 Zooms in the preview.
8 Zooms out the preview.
9 Shows preview in original size.
10 Fits preview to window.

TIP: Independent from the selected tool, using the ALT key in conjunction with the mouse 
lets you move the image inside the Preview window. 

1 2 3 5 6 7 8 16104 9 12 1311

Preview Window

Preview View

1714 15

Comment Tools

2118 19 20
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• Icons with Preview Window Only (11-17) 

11 Shows preview in fullscreen.

TIP:  If you have a fullscreen preview, you can use the mouse scroll wheel to get the 
next or previous asset displayed. 

12 If activated, the displayed preview follows the selection in the collection window (same 
behavior as the Information Window). If not activated, the displayed preview remains inde-
pendent from the selection in the collection window and must be changed manually.

13 Shows the preview of the first record from the current collection.
14 Shows the preview of the previous record from the current collection.
15 Shows the preview of the next record from the current collection.
16 Shows the preview of the last record from the current collection.
17 Displays the current Record View Set; clicking on the arrow opens a selection list of available 

Record View Sets.

• Icons with Comment Tool Only (18-21) 

18 Rectangle tool.
19 Polygon tool.
20 Sticky notes tool.
21 General comment tool.
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Multi-page Previews 
Multi-page previews are available for the following file formats: GIF, InDesign, JPEG, 
PCX, PDF, PowerPoint Presentations, Photoshop, Quark XPress, and TIFF. 

For InDesign a multi-page preview can be provided only if one of the following 
requirements is fulfilled:

• A Cumulus Metadata file (TAG file) is available which was created by the Cumulus 
Plug-in for Adobe InDesign
OR

• The corresponding XPV file is available (and a licensed HELIOS Image Server acces-
sible in the network).

For Quark XPress a multi-page preview can be provided only if one of the following 
requirements is fulfilled:

• The corresponding XPV file is available (and a licensed HELIOS Image Server acces-
sible in the network) 
OR

• The Cumulus DDS Companion is installed and configured in the Cumulus Quark 
DDS Filter 
OR

• Under Mac OS: Quark XPress is installed.

NOTE: The preview always shows the current status of an asset. So the number 
of pages/slides might differ from those cataloged as contained sub assets if the 
asset has changed and the records were not updated. 
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User Comments 
For work-in-progress management Cumulus provides user comments. From the Pre-
view view or window, add comments, draw rectangles or polygons and communicate 
your ideas, approvals or anything else to other users. All comments are searchable, 
meaning you can find assets based on comments they contain. Plus, you have an 
archive of change requests stored right alongside the assets.

Cumulus provides several types of user comments: general comments to an asset, and 
comments that are related / linked to specific areas on the preview of an asset. For 
comments related to specific areas, three different tools – the rectangle tool, the poly-
gon tool and the sticky note tool – allow to precisely place a respective mark wherever 
it is desired on a file’s preview. All comment text is displayed in a column to the right 
side of the preview. The comments column itself can be hidden.

Comments are displayed in chronological order (newest first). 

A comment and the replies to it constitute a thread. If there is a new reply to an older 
comment, the whole thread is regarded as new and displayed on top of older threads.

Prerequisites

To have the user comment feature available for assets, the catalog which manages 
them requires the record field User Comment Thread (and the fields contained in that 
table field) to store the comment information. If the User Comment Thread field is not 
yet included in your catalog, you must add it from the catalog template Fields for user 
commenting). For a description on how to add fields to a catalog, see “Adding Fields” .
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To use the user comment feature, a user requires the appropriate permissions for the 
User Comment Thread field. (For more information, see “Subtable Permissions” .)
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Adding User Comments
You can add general comments to a file as well as comments to specific areas marked 
on the file’s preview.

To add a comment, the Comments column must be displayed. The visibility of the 
Comments column can be toggled with the User Comment tool  in the Preview 
toolbar.

General Comment

To add a general comment: 

1. Click the general comments icon  in the Comments toolbar.
A new section is added to the Comments column. The entry field is activated.

2. Enter the text for the comment, then click Post comment.

Your comment is saved and is immediately visible to other Cumulus users.

Sticky Note Comment

To add a sticky note comment:

1. Click the sticky note icon  in the Comments toolbar.

2. Click the location where you want to place the note.
As soon as the note is set, a new section is added to the comments column. The 
entry field is activated.
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3. Enter the text for the comment, then click Post comment.

Your comment is saved and is immediately visible to other Cumulus users.

Rectangle Comment

To add a rectangle comment:

1. Click the rectangle icon  in the Comments toolbar.

2. Draw a rectangle wherever you want it to appear on the preview.
As soon as the rectangle is set, a new section is added to the comments column. 
The entry field is activated.

3. Enter the text for the comment, then click Post comment.

Your comment is saved and is immediately visible to other Cumulus users.
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Rectangle comments: See how it works!
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Polygon Comment

To add a polygon comment:

1. Click the polygon icon  in the Comment toolbar.

2. Draw a polygon wherever you want it to appear on the preview. Clicking adds a 
corner, double clicking closes the polygon.
As soon as the polygon is set, a new section is added to the comments column. 
The entry field is activated. 

3. Enter the text for the comment, then click Post comment. 

Your comment is saved and is immediately visible to other Cumulus users.

Polygon comments: See how it works!
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Editing User Comments
You can edit your own comments (but not comments of other users).

You can edit the comment’s text and modify size, shape and position of the markers 
placed on a file’s preview.

NOTE: As an administrator, you may have the permission to edit the comments 
of any user.

For editing comment, the Comments column must be displayed. The visibility of the 
comments column can be toggled with the User Comment tool  in the Preview 
toolbar.

To edit the text of a comment:

1. On the comment that you want to edit, click the edit icon ( ).
The comment is displayed in edit mode.

2. Edit the text as needed, then click Save. 

Your modified comment is saved and is immediately visible to other Cumulus users.

To modify size, shape and position of a marker on a file’s preview:

1. Click on a marker to activate it.

2. Drag the marker to a different position.
OR
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Use the handles (little squares) at the corners of activated rectangles or polygons 
to resize or reshape them.

Modifications to markers are saved implicit and are immediately visible to other 
Cumulus users.

NOTE: Displaying User Comments in a Sub-Pane
With any Cumulus view, you can use the sub-pane filter User Comments to 
have all comments of the selected assets displayed in a sub-pane. 

NOTE: Searching for User Comments
Use the Find window to search for text entered as user comments. As search 
criteria select the field User Comment Thread – User Comment – Comments. 
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Replying to User Comments
You can reply to exiting comments.

For replying to comment, the Comments column must be displayed. The visibility of 
the comments column can be toggled with the User Comment tool  in the Pre-
view toolbar.

To reply to a comment:

1. On the comment that you want to reply to, click the reply icon ( ).

A new entry field is added below the comment. The entry field is activated.

2. Enter the text for the reply, then click Post reply.

The reply is saved and is immediately available to other users.
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Deleting User Comments
You can delete your own comments (but not comments of other users).

NOTE: As an administrator, you may have the permission to delete the com-
ments of any user.

If you delete a comment that has replies, the whole thread is deleted (i.e. the original 
comment including all replies).

For deleting comment, the Comments column must be displayed. The visibility of the 
comments column can be toggled with the User Comment tool  in the Preview 
toolbar.

To delete a comment:

1. On the comment that you want to delete, click the wastebasket icon ( ).
A confirmation window is displayed.

2. Click OK to confirm the deletion of the comment.

The comment is deleted and is no longer available to other users.
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Fullscreen Preview
The Fullscreen Preview offers an interactive display of up to six different assets at once, 
making it easy to pick the perfect one each time – compare quality, sharpness, com-
position, etc. 

To open the Fullscreen Preview:

1. Select the records of the assets you want to have displayed in the window.

2. Select Asset > Fullscreen Preview.

Additional information on a previewed asset can be displayed, depending on the set-
tings for the Preview Window in the current Record View Set. (For a description on 
how to configure the view of the Preview window see “Record View Sets” .) Always dis-
played on the status bar and not depending on the selected Record View Set are the 
record name, the label and the rating of the respective asset (if contained in the cata-
log.)

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS PREVIEWING ASSETS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Linking Panels
In Fullscreen Previews of multiple assets, two or more panels can be linked together 
for synchronous zooming, rotating and panning.

To link panels:

1. Click the icon on the statusbar of every panel you want to link, OR

CTRL-click /  CMD-click any of the  icons to link all panels in the 
fullscreen preview.

In linked panels, the  icon is highlighted.

To unlink panels, i.e. to exclude them from synchronous zooming, rotating and pan-
ning:

1. Click the highlighted  icon of every panel you want to unlink, OR

CTRL-click /  CMD-click any of the  icons to unlink all panels in the 

fullscreen preview.

NOTE: In fullscreen previews of single assets, the  icon is not displayed. 
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Displaying the Info Window
Ready “slide on” access to the Info Window makes metadata edits easy. Move your 
mouse pointer to the left edge of the screen and the Info window will show up. Click 
the pin icon to dock it so it will stay when you change the mouse pointer position.

Using the Toolbar

Move your mouse pointer to the bottom of the window and its toolbar pops up. 

Fullscreen Preview Toolbar Items

1 Shows the preview of the first record from the current collection.
2 Shows the preview of the previous record from the current collection.
3 Shows the preview of the next record from the current collection.
4 Shows the preview of the last record from the current collection.
5 Shows/hides statusbar (comprising label, rating, rotating & zooming icons.)
6 Mouse over: Display list of available commands / Click: Open help system
7 Closes the window.

1 2 4 653 7
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Displaying a Command Overview

Position your mouse pointer on the question mark icon to have a list of available com-
mands and keyboard shortcuts is displayed. 
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Marking Assets
In the Fullscreen Preview window you can mark assets by using labels and ratings. 

Color labels are set using the square symbol. Clicking on this icon opens a list of avail-
able labels. Select the label you want to mark the asset with. 

You can also mark assets using star ratings. Use the shortcuts CTRL+ALT+1-5 / 
ALT + CMD+ 1-5 to set the rating. See “Labeling”, for more about labels; see “Rating”  

for ratings.

Adjusting Preview Size

The magnify glass icons of the statusbar let you scale how an asset is displayed within 
each preview area (panel). To zoom in on a preview image, you also use the + (plus) 
and - (minus) key shortcuts. 

Rotating Previews

The rotation icons of the statusbar let you rotate a preview 90° clockwise or counter-
clockwise.
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Next and Previous Assets
You can use the arrow icons of the toolbar or the PAGE DOWN and PAGE UP key to 
load assets in the window. When there is more than one asset on-screen, the asset that 
is changed is the one that is marked as selected by a light green border and a big 
check mark symbol. If none is selected, the entire group of previewed assets is 
replaced by the next group. If one is selected, the PAGE DOWN key changes the asset 
to the next one in the collection and the PAGE UP key changes it to the previous one. 
You can also use the mouse wheel to scroll through.

TIP: Loading Another Preview

If multiple assets are displayed in the Preview window, a single asset can be 
loaded into more than one preview area, enabling you to pan, zoom and exam-
ine it in detail. To load another preview in a preview area, select the preview 
area and use ALT+Mouse Wheel.

NOTE: Linked preview images are navigation locked, i.e. they never change 
position and can’t be replaced with other assets via the PAGE UP / PAGE DOWN 
keys or scroll wheel navigation.
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Comparing Previews
Any two selected preview images can be automatically compared by Cumulus, with 
a visual representation of the comparison result displayed in the Fullscreen Preview. 
For details, see “Preview Comparison” 
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Fullscreen Slide Show
Shows assets as fullscreen previews in a slide show. You can load the assets manually 
or run them in a loop.

To open the Fullscreen Slide Show:

1. Select the records of the assets you want to have displayed in the slide show 

2. Select Asset > Fullscreen Slide Show.

You can have record fields displayed. What is displayed along with the previews 
depends on the selected Record View Set and its setting for the Preview window. (For 
a description on how to configure the view of the Preview window see “Record View 
Sets” .)

Using the Toolbar

Move your mouse pointer to the bottom of the window and its toolbar pops up

Fullscreen Slide Show Toolbar Items

1 3 42 5 6 7 8 9
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1 Shows the preview of the first record from the current collection.
2 Shows the preview of the previous record from the current collection.
3 Shows the preview of the next record from the current collection.
4 Shows the preview of the last record from the current collection.
5 Displays how many seconds each slide (asset’s preview) will be displayed in a looping slide 

show. You can enter the number of seconds you want.
6 Stops/starts the loop.
7 Shows/hides statusbar (Statusbar comprises of label, rating, rotating & zooming icons.)
8 Mouse over: Display list of available commands / Click: Open help system
9 Closes the fullscreen slide show.
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Preview Comparison
Cumulus provides a smart option that allows you to compare two image assets. A 
visual representation of the comparison result as well as the previews of the compared 
assets are presented in fullscreen preview. 

The comparison is done on a pixel-by-pixel base, i.e. any pixel in the preview of an 
asset is compared to the according pixel in the preview of the other asset. The com-
parison result is computed – and displayed – as the difference of the RGB values of the 
corresponding pixels. Pixels that are identical in both images appear as black in the 
comparison result.

If the two images to be compared have the same aspect ratio but different sizes, the 
larger one is scaled down to the size of the smaller one. If the images differ both in size 
and aspect ratio, they are overlaid centered.

Compare Previews is especially useful for detecting subtle differences in apparently 
identical image assets.
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Starting the Comparison
The preview comparison can be started either from the collection window, or from 
the fullscreen preview.

1. In the collection window, select the records of the two assets you want to com-
pare, then select Asset > Compare Previews.

OR

In a Fullscreen Preview of multiple assets, select the previews of the two assets 

you want to compare, then open the context menu (with the right mouse but-

ton /  Control key + mouse) and select Compare.
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Using the Window
A fullscreen preview comprising a comparison result behaves the same way and offers 
the same options as any fullscreen preview (see “Fullscreen Preview” .) 

The statusbar of the panel with the resulting image displays the title Comparison 
Result and the current zoom factor. 

By default, the comparison result and the two previews of the compared assets are 
linked for all zooming, rotating and panning commands, i.e each zooming or panning 
operation in either panel is performed on the other two panels at the same time and 
in the same way (see “Linking Panels” ).

Comparison results can only be viewed, but not saved, rated, or labeled. And of course, 
there is no metadata for the comparison result to be displayed.

To get rid of the comparison result and possibly restore the preview image that was 
displayed previously in that panel, select the compare image, then open the context 
menu (with the right mouse button /  Control key + mouse) and select Reset 
Compare Panel.
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Repurposing Assets
Cumulus provides several ways for you to repurpose your cataloged assets. The fol-
lowing sections describe how you can do this making use of Cumulus Converter mod-
ule.

• Converting Image Assets with the Pixel Image Converter
• Cropping Image Assets with the Pixel Image Crop Processor
• Cropping Image Assets with Templates with the Pixel Image Crop Template Pro-

cessor
• Watermarking Assets with the Watermark AssetProcessor
• Creating Presentations with the MS PowerPoint Asset Processor or the Office Open 

XML Presentation Asset Processor
• Creating ZIP Archives with the ZIP AssetProcessor
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Converting Image Assets
The Pixel Image Converter enables you to convert any cataloged pixel image into the 
different formats on the fly, e.g. JPEG, TIFF^^, BMP, GIF, ScitexCT, PNG, PCX, and PDF. 
It also lets you resize the image and convert it into another color space.

With Cumulus, the images can also be cropped, rotated or flipped. Sharpen and Blur 
filters can be applied for the image processing. The sequence of the conversion pro-
cesses is cropping first, then resizing and after that applying a filter. Finally the image 
is saved in the specified color space and output format.

To convert image assets into another format:

1. Select the record(s) representing the image asset(s) to be converted.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the converted 
asset.

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you. Available to you for converting are the Asset Processors that are 
activated in the Asset Handling Set which is chosen for Asset Access in your User 
Settings. 

4. Select Pixel Image Converter as Asset Converter. 

The Pixel Image Converter Parameters dialog opens.

5. Choose your settings. For details, see “Pixel Image Converter Parameters” .
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6. Click OK.

The selected image asset(s) will be converted and the resulting images will be stored 
in the selected destination.
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Pixel Image Converter Parameters
For the conversion you can define parameters referring to:

Image Size

You can not only determine the image size (in pixel as well as inches, cm or percent). 
You can also have the image cropped before it is scaled to the dimension defined by 
width and height. 

• Alternate Source Resolution
If you want to use the image with a resolution different from the stored original, 
activate the User Alternate Source Resolution option.

• Crop Area 
Cropping refers to cutting down an image by cutting away unwanted parts at the 
edges. You specify left, top, right, bottom margins to be cropped off the source 
image. 
The cropping function can be used to trim the edges of an image. Enter the size of 
the edges to be removed. Define the measurement under Units.

NOTE: If you use an alternate source resolution, be aware that this resolution is 
the basis for any cropping in inches or cm measurements. 

• Scale Dimension 
The values for width, height and resolution determine the size of the converted 
image. The image size can be specified in pixel dimensions or print dimensions. 
And you can decide to have the image converted either to an individual size or to 
a fixed size, the maximum of which is defined by a bounding box. The result 
depends on the selections set for the conversion:
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• Work at
If you want to specify the size in inches or cm and have the software calculating 
the pixel dimension automatically depending on the set resolution, select 
Document Size. If this option is activated, the entered values determine the 
print dimensions.
If you want to specify the pixel dimension (not caring about print size), select 
Image Size. 
Note that the final output size depends on the output device’s settings (e.g. dpi 
of printer).

TIP: Changing Pixel Dimensions
Working at Image Size is useful when preparing images for online distribution. Keep 
in mind that changing pixel dimensions affects not only the size of an image on-
screen but also its image quality and its printed characteristics – either its printed 
dimensions or its image resolution. 

• Constrain Proportions
To maintain the current proportions of width to height, activate this option. (This 
option is not available if you have selected multiple records for converting or if 
you are defining a Cumulus Action.)

TIP: Percent
To keep the proportions if you have selected multiple records or if you are defining a 
Cumulus Action we recommend you to specify height and width in percent. 

• Use Size as Bounding Box
If this option is activated, the size defines the bounding box into which the 
images has to fit. The image will be resized proportionally to fit the size of the 
bounding box. No dimension of the converted image will exceed the size of the 
box. When using this option, the proportions of the images are always con-
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strained and that’s why the Constrain Proportions option is not available.
If you want images that are smaller than the size of the bounding box to be 
enlarged to this size, activate the Enlarge Smaller Images option. 

TIP: Square
To define the size for a box you want to fit for portrait and landscape images, make it 
a square. Then the longest edge of an image (height or width) will be resized to the 
entered value and the shorter edge will be resized according to the proportions of the 
image. 

You can choose different units of measurement. To enter values as percentages of 
the current dimensions, choose Percent as the unit of measurement.

Image Processing

With the conversion the image can be processed. You can have a filter run, rotate and 
flip the image. Select the desired processing options.

• Filter 
To have a filter run with the conversion, select a filter type and the radius range for 
the filter (small, medium, large.) The radius determines how far the filter considers 
surrounding pixels that affect the filter action. The following filters are available:
• Average Blur filter

Softens an image. It smooths transitions by averaging the color values of sur-
rounding pixels. Eliminates noise where significant color transitions occur in an 
image. 

• Median Filter
Reduces noise in an image by blending the brightness of pixels. The filter adapts 
the brightness of pixels to the median brightness value of the surrounding pix-
els. 
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• Gaussian filter
Works similarly to the Blur filter but uses a weighted average of the color values 
of the surrounding pixels. The weighting is generated using the Gaussian bell-
shaped curve that is generated. 

TIP: Blur & Gaussian Filter
The Blur as well as the Gaussian filter decreases high-frequency details and can pro-
duce a hazy effect. 

• Sharpen filter
Increases the visual sharpness of images by increasing the contrast at edges. 

TIP: Sharpen Filter
Applying the Sharpen filter is recommended when scaling up images to keep their 
visual sharpness as high as possible. 

• Unsharp Mask Filter
Makes images appear sharper by increasing the contrast of small brightness 
changes.

• Add Noise Filter
Applies random pixels to an image, simulating distortion or noise. You can also 
use the Add Noise filter to give a more realistic look to heavily retouched areas. 

• Rotation 
You may rotate the image by selecting image rotation degrees.
0no rotation
90to rotate the image clockwise by a quarter-turn
180to rotate the image by a half-turn
270 to rotate the image counterclockwise by a quarter-turn.
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• Flip 
– activate horizontal to flip the image along the vertical axis.
– activate vertical to flip the image along the horizontal axis.

Output Format

For the output you can define the following parameters:

• Color Space
Select the desired color space for the converted image. The available color spaces 
depend on the selected file format (e.g. GIF, PNG, PCX, and BMP do not support 
CMYK.)

NOTE: ICC Profile Embedded
The ICC profile of an original image will be embedded in the converted asset if 
the color space is not changed and the output file format supports ICC profiles. 

• File Format
Select the file format for the converted image. Depending on the selected file for-
mat, the available further parameters for the output format may differ. 

• Compression
Select a compression scheme that is supported for the selected file format. (This 
version of the Pixel Image Converter provides a compression scheme for TIFF only.)

• Quality (JPEG)
For JPEG and PDF files only, select the desired quality.

• Keep Transparency
Activate this option to keep the transparency information of the original file if the 
color space of the converted image is different from the original color space. (Only 
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for output formats that support transparency information, such as GIF, TIFF, or 
PNG.)

• Store IPTC Information
Activate this option to store IPTC metadata within TIFF and JPEG images.

• Store XMP Information
Activate this option to store XMP metadata within TIFF, JPEG, PNG, and PDF files.

The selected asset(s) will be converted and stored under the name of the original asset 
in the selected destination. The Pixel Image Converter will automatically add the cor-
rect File Type and Creator / file extension to the file name. The name will be 
extended by a number if a file with that name already exits at the selected destination.
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Cropping Image Assets
The Pixel Image Crop Processor enables you to crop any cataloged pixel image on the 
fly, e.g. JPEG, TIFF, BMP, GIF, PNG, etc. It also lets you resize the final output of the 
cropped section. The resulting image is saved as a new file.

To crop an image assets:

1. Select the record representing the image asset to be cropped.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the output of 
the cropping process.

3. Select a folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you, i.e. all Asset Processors that are activated in the Asset Handling 
Set which is chosen for Asset Access in your User Settings. 

4. Select Pixel Image Crop Processor as Asset Converter. 

The Pixel Image Cropping Parameters dialog opens.

5. Choose your settings. For details, see “Pixel Image Cropping Parameters” .

6. Click OK.

A preview of the selected image asset is displayed allowing for final adjustments. 
Depending on the Pixel Image Cropping parameter settings, you can use your mouse 
to:
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• modify size and position of the cropping area, OR

• modify the position of the cropping area, OR

• freely draw a cropping area
If activated in Pixel Image Cropping parameter settings, you can specify the output 
size, i.e. the dimensions of the resulting image by entering appropriate values for 
width and height (in pixels).

The resulting image is finally stored in the initially selected destination.
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Pixel Image Cropping Parameters
For the cropping you can define parameters referring to:

Cropping Area

You can either set the aspect ratio of the cropping area, or its size in pixels, or you can 
allow the user to set the size (and implicitly, the aspect ratio) by using a mouse to draw 
a rectangle on the image preview. 

• Enforce aspect ratio
The aspect ratio of the cropping area is set to the specified value. However, the 
cropping user can still change the size and position of the cropping area on the 
image preview.

• Enforce crop size
The size of the cropping area is set to the specified values for width an height. 
However, the cropping user can still change the position of the cropping area on 
the image preview.

• User defined
The cropping user can determine size, aspect ratio, and position of the cropping 
area by drawing a rectangle on the image preview.

Output Size of Cropped Area

The final size of the output of the cropping process can be set to your needs, e.g. to 
enlarge or reduce the dimensions of the resulting image. To avoid distortion in the 
resulting image, make sure that the chosen values for width and height match with 
the chosen aspect ratio value.
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• Same as cropped area
The resulting image has the same width an height as the cropped area.

• Set manually
The cropping user can enter values for the width an height of the resulting image 
on the image preview.

• Enforce output size
The resulting image is always resized to the width and height values specified 
here.

Additional Options

For special purposes only!

• Store coordinates of cropping area in subtable
Select this option and enter an name for the saved coordinate in the Crop name 
field if you want the values available. This will allow other applications to access 
these values and to repeat a cropping process with precisely the same result on a 
given asset. 
The coordinates are only saved after a cropping has been performed for the first 
time. If you thereafter perform a cropping with different coordinates, the saved val-
ues will be overwritten, unless you have specified a new crop name.
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Cropping Image Assets with Templates
The Pixel Image Crop Template Processor enables you to crop any cataloged pixel 
image, e.g. JPEG, TIFF, BMP, GIF, PNG, etc., by means of pre-configured crop templates. 

NOTE: To use this function, a user must have the appropriate Crop Template 
Permissions. 

To crop an image assets using a template:

1. Select the record representing the image asset to be cropped.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the output of 
the cropping process.

3. Select a folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you, i.e. all Asset Processors that are activated in the Asset Handling 
Set which is chosen for Asset Access in your User Settings. 

4. Select Pixel Image Crop Template Processor as Asset Converter. 

The Pixel Image Crop Template Parameters dialog opens.

5. Choose a template from the drop-down list.

6. Click OK.

What happens next depends on the settings of selected template:
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• Either the crop is performed and the resulting image is downloaded immediately 
to the selected destination folder, OR

• a preview of the selected image asset is displayed allowing for final adjustments. 
Depending on the selected template, you may be able to:
• modify size and position of the cropping area, OR

• modify the position of the cropping area, OR 
• freely draw a cropping area,
• specify output size of the resulting image by entering appropriate values for 

width and height (in pixels).
When you confirm our settings with OK, the crop is performed and the resulting 
image is downloaded to the selected destination folder.
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Watermarking Assets
With the ever increasing number of digital assets, digital watermarking has become an 
important topic. Watermarking helps you to protect your intellectual properties. Pro-
tect your images by adding watermarks.

Digital watermarking is a technology for embedding information into digital assets. In 
general, information for protecting copyrights is embedded as a watermark. A water-
marked image can prove its origin, thereby protecting copyright. A watermark also 
discourages the making of illegal copies.

BACKGROUND INFO:  Aspects of Protection

Watermarking can serve many different purposes from tamper proofing to 
authentication. Three major aspects in the protection of digital assets have 
been pointed out, each of them with different requirements: first copyright 
protection, protecting ownership and usage rights; secondly tamper-proofing, 
aiming at checking document integrity; and thirdly authentication, the pur-
pose of which is to check the authenticity of a document. While robust water-
marks are typically used for copyright protection, fragile or semi-fragile 
watermarks are proposed to ensure tamper proofing and authentication.

For embedding watermarks, Cumulus provides the Watermark AssetProcessor. It 
enables you to embed visible watermarks into following pixel image formats: JPEG, 
TIFF, BMP, GIF, PNG, and PCX. It creates a copy of a cataloged asset with the digital 
watermark embedded. 
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Watermarking Parameters
You can provide both an image and text for your watermark. The position of the text 
can be set in the properties. You can provide just the image or just the text. Or a com-
bination of the two.

Visible Image 

As a watermark image you can use most common pixel image formats, e.g. JPEG, PNG, 
and TIF. If an animated image file is supplied, the first frame will be used as the water-
mark image. You can either type in or browse to find the watermark image file.

You define the opacity of the watermark from 0 to 100. If you set the opacity to 0, the 
watermark image will be totally transparent and you will not be able to see it. If you 
set it to 50, the watermark will be semi-transparent. The watermark will be completely 
opaque (solid) if the opacity level is set to 100. 

Under Image Position, you define the area where the watermark image should be 
placed. The position of the watermark image within the resulting image is defined by 
anchor points.

You can control the size of the watermark image by scaling it. When scaling, propor-
tions are constrained, and the images will be scaled to provide the maximum overlay. 
Small watermark images will be enlarged and large ones will be made smaller. You can 
also define to have only small images enlarged. Following scaling options are avail-
able: 

• At long edge – The watermark image is scaled at its long edge. The long edge will 
be scaled to fit the source image and with proportions constrained the short edge 
will be scaled accordingly.
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• At short edge – The watermark image is scaled at its short edge. The short edge 
will be scaled to fit the source image and with proportions constrained the long 
edge will be scaled accordingly.

• Fit to image size – The watermark image is scaled to fit the size of the image, 
depending on the image orientation (portrait or landscape). 

• Scale up only – A watermark image that is smaller than the source image is 
enlarged to provide the maximum overlay. Proportions are constrained.

NOTE: If you do not activate the scale option, watermark images larger than the 
source image will be cropped. 

The Previously selected image field will display an image only if the watermarking 
parameters are defined for an Asset Action. Then the watermarking image will be pro-
vided by the Cumulus Server and the field displays a preview of the image that was 
transferred by the Cumulus Server.

Visible Text

The visible text can be entered by you and/or taken from a Cumulusrecord field. Using 
a record field enables you to have individual watermarks when batch processing 
images. 

To include a record value as text, select the desired field from the Record field drop-
down list and click Append. The corresponding placeholder entry will be inserted at 
the end of the Content field.

You are allowed to enter multiple lines of text in the Content field. Enter \n for carriage 
return. You can also type special characters (like ©, ®, etc.). They will be rendered prop-
erly in the processed images. 
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You can control the position of the text. You can specify the Horizontal Position (Left, 
Center, and Right) and Vertical Position (Top, Middle, and Bottom) of the text. 

You define the opacity of the watermark from 0 to 100. If you set the opacity to 0, the 
watermark will be totally transparent and you will not be able to see it. If you set it to 
50, the watermark will be semi-transparent. The watermark will be completely opaque 
(solid) if the opacity level is set to 100. 

You can choose the font, style, size and color of the text. To have the text fit best to the 
image size independently of the font size setting, activate the Fit text to image size 
option.

Under Text Position, you define the area where the watermark text should be placed. 
The position of the text within the resulting image is defined by anchor points.

Employing Custom Record Fields 

The drop-down list for selecting a record field displays the Cumulus standard fields 
only. If you want to include a custom field, you must enter the GUID (Globally Unique 
Identifier) of the field into the Content field of the Watermark AsssetProcessor Param-
eter dialog.

To find out the GUID open the Properties of the field ( Cumulus / Edit > Prefer-
ences > Catalog Settings) and on the General tab double-click the field name of the 
field Field Name.  

This copies the GUID to the clipboard and you can paste it. A Cumulus GUID is com-
posed of exactly 38 characters and looks like this: 
{af4b2e12-5f6a-11d2-8f20-0000c0e166dc}
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Embedding Watermarks into Image Assets
You embed watermarks into image assets by employing the Convert menu command 
or by including the Watermark AssetProcessor in a Cumulus Asset Action. (For infor-
mation on how to include an Asset Processor in an Asset Action, see “Cumulus Asset 
Actions” .) 

To watermark image assets via the Convert menu command:

1. Select the record(s) representing the image asset(s) to be watermarked.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination folder for the 
watermarked asset(s). 

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you. Available to you for converting are the Asset Processors that are 
activated in the Asset Handling Set which is chosen for Asset Access in your User 
Settings. 

4. Select Watermark AssetProcessor as Asset Converter. 

The parameter dialog opens. 

5. Make your settings. For details, see “Watermarking Parameters” .

6. Click OK.

The selected image asset(s) will be converted and the resulting images will be stored 
in the selected destination.
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Creating Presentations
Within Cumulus you can create PowerPoint presentations from cataloged PowerPoint 
assets (individual slides or entire presentations), image assets and previews of other 
asset formats. 

Cumulus offers two Asset Processor modules for creating presentations. Both enable 
the user to create PowerPoint presentations from selected PowerPoint assets and 
image assets within Cumulus. They differ in the format of the presentation they create: 

• The MS PowerPoint Asset Processor creates presentations in PowerPoint 97-2003 
format (*.ppt). It requires a Microsoft PowerPoint installation on the computer 
where you want to make use of it (e.g. Cumulus Client.)

• The Office Open XML Presentation Asset Processor creates presentations in Office 
PowerPoint 2007 format (*.pptx and *.ppsx).

Note that these modules are optional and may not be available with your Cumulus 
configuration.

When creating a new presentation with Cumulus, both Asset Processors offer a range 
of parameters to be defined. (For details, see “Office Open XML Presentation Processor 
Parameters” , and “MS PowerPoint Asset Processor Parameters” .)

If your selection of assets includes presentations, you can define to exclude them, to 
include the entire presentations or just the first slides. 

If your selection of assets includes images, each image is placed on a separate slide. 
You can define the area where they will be placed and determine where they should 
be aligned. The images can be scaled down or up to fit this area. If you do not activate 
a scale option, only large images will be scaled down to fit on the slide, according to 
the determined alignment. You can also have the images processed before they are 
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included in the presentation. If you enable this option, the Parameters button lets you 
select the processing parameters. For details on the available parameters, see “Con-
verting Image Assets” .

SPECIAL TECH INFO:  Using Previews

You can use any asset format to be included as an image in a presentation if a 
Cumulus Filter module is available that provides a preview.

You can create presentations by employing the Convert menu command or by 
including the Asset Processor in a Cumulus Asset Action. (For information on how to 
include an Asset Processor in an Asset Action, see “Cumulus Asset Actions” .) The fol-
lowing section describe how to create presentations with the Convert menu com-
mand.
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Creating Presentations in Office PowerPoint 2007 Format
To create an Office PowerPoint 2007 format presentation (*.pptx or *.ppsx) from 
selected assets within Cumulus:

1. Put the records of the assets you want to include into the order you want them to 
appear in the new presentation. 

2. Select the assets to be included in the new presentation

3. Select Asset > Convert To. 

The Browse for Folder dialog opens for choosing a destination folder for the pre-
sentation asset(s). 

4. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you. Available to you for converting are the Asset Processors that are 
activated in the Asset Handling Set which is chosen for Asset Access in your User 
Settings. 

5. Select Office Open XML Presentation Asset Processor and click OK. The dialog 
for the parameters opens. 

6. Enter a file name for the new presentation.

NOTE: If you enter the file name of an existing presentation, the new slides will be 
appended to the existing presentation.

7. Make your settings. For details, see “Office Open XML Presentation Processor 
Parameters” . 
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8. Click OK. 

NOTE: If your selection of assets includes presentations or slides in PowerPoint 
97-2003 format, a Microsoft PowerPoint 2007 installation is required to convert 
such assets before they are embedded. It must be installed on the computer 
where you want to make use of the processor (e.g. Cumulus Client, Internet Cli-
ent Pro or Web Publisher Pro.) 
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Office Open XML Presentation Processor Parameters 
The Office Open XML Presentation Asset Processor offers a range of parameters to be 
defined. The parameters are grouped by tabs:

• File Options Tab – parameters referring to the entire new presentation
• Slide Handling Tab – parameters defining the slides created from presentation 

assets
• Image Handling Tab – parameters defining the slides created from image assets 

File Options Tab

Define how the created presentation is composed. Decide on the name, the format 
and whether images are embedded or linked.

File name – Enter the name for the presentation to be created or enhanced. If you 
enter an existing presentation, the new slides will be appended to the existing presen-
tation

NOTE: The Asset Processors will not replace an existing presentation. They will 
append the new slides to the existing presentation. However, if included in an 
Asset Action, the Asset Processor will not append slides, as the Delivery module 
of the Action will save a new presentation (name of the existing one extended 
by a number.) 

Format 

Define the format of the presentation to be created: 
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• Presentation (*.pptx) – Creates an Office PowerPoint 2007 presentation, which is 
an XML-enabled file format. 

• Show (*.ppsx) – Creates an Office PowerPoint 2007 presentation that always 
opens in Slide Show view rather than in Normal view.

Media Handling

The options for embedding or linking the images determine how the image is embed-
ded in the presentation. 

• Embed media – Media such as images will be saved with the presentation.
• Link media – Media such as images will be linked to the presentation only. 
If you decide on linking the images, following options are available:

• Save presentation and link media in same folder – Images will be saved in sepa-
rate files in the same folder where the presentation will be saved. 

• Save linked media images, placed in folder next to presentation – Images will 
be saved in separate files in a subfolder of the folder where the presentation will 
be saved. 
– Folder name – Enter a name for the subfolder where the images should be 
saved – either an existing folder or a new one. Entering a new name will create a 
folder.
– Append name of presentation – The name of the presentation will be added to 
the name of the folder (existing or new).

• Make presentation usable on any computer – The created presentation is pre-
pared to work on other computers. The path information for the linked images are 
changed from absolute to relative paths. This enables the presentation to find the 
linked images relative to its location.
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– Create ZIP archive containing presentation and linked media – 
The presentation and its linked media are compressed to a ZIP archive. 

Slide Handling Tab

Define how to handle presentation assets (entire presentations or single slides). 

Presentations

If your selection contains presentations, decide on how to handle entire presenta-
tions.

• Embed entire presentations – All slides of the presentations will be included in 
the new presentation.

• Embed first slide only – Only the first slide of a presentation will be included in the 
new presentation. 

• Ignore – Any selected presentations are ignored and will not be included in the 
new presentation.

Master and Layout 

Define master and layout for the slides included in the new presentation.

• Keep slides as they are (no changes) – Each slide selected to comprise the new 
presentation keeps its original master and layout. 

• Use from previous slide – Slides added will adopt master and layout from the last 
slide of the existing presentation. 
Example: If you are adding slides to enhance an existing presentation, the last slide 
of the existing presentation will determine Master and Layout of the slides added. 

• Use from other presentation – Enter the name or use the Browse button. If you 
want to use the same presentation master and layout as employed for slides cre-
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ated from images (Image Handling tab), the Same as Image Slide button makes 
this easy for you. It inserts the name of this presentation into the File field.

Image Handling Tab

Define how image assets are processed before they are placed on separate slides, 
where they are placed, how they are scaled, and the master and layout for the slide.

Image Processing

Images can be processed before they are used for the presentation to be created. The 
Cumulus Pixel Image Converter is employed for the preprocessing, so you can have a 
filter run, rotate and crop the image. If you activate the Perform Image Processing 
before insertion option and click the Parameters button, you can set the parameters 
available for preprocessing. (For details, see “Pixel Image Converter Parameters” .)

Image Placement

Define the area where the images should be placed. The size of the area is defined by 
margins set corresponding to the slide size. The position of an image within this area 
is defined by anchor points. 
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To define the area for the images on the slide, you determine the margins from the 
top, bottom, left and right edges of a slide. You can choose from different measure-
ment units to determine the margins.

You can scale the images placed in the area up or down so that they fit within the area.

• Scale down larger images – The images that are larger than the area are made 
smaller. Proportions are constrained.

• Scale up smaller images – The images that are smaller than the area are enlarged. 
Proportions are constrained.

Master and Layout

Define master and layout for slides created from image assets.

• Use from previous slide – Image slides added will adopt master and layout from 
the last slide of the presentation. 
Example: If you selected Slide 1, Image 2, Slide 3, and Image 4 (in this sequence) to com-
prise a new presentation and decided on the Keep slides as they are option for 
Master and Layout under Slide Handling, the slide for Image 2 will look like Slide 1 and 
the slide for Image 4 will look like Slide 3. 

• Use from other presentation – Enter the name or use the Browse button. If you 
want to use the same presentation master and layout as employed for the other 
slides (Slide Handling tab), the Same as Slides button makes this easy for you. It 
inserts the name of this presentation into the File field.
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Creating Presentations in PowerPoint 97-2003 Format
The layout of a new presentation is determined by the first asset of the selection for 
the new presentation. If the first one is not a PowerPoint asset, the layout is deter-
mined by the standard layout of PowerPoint (depending on the settings of the Pow-
erPoint installation).

To create a PowerPoint 97-2003 format presentation (*.ppt) from selected assets 
within Cumulus:

1. Put the records of the assets you want to include into the order you want them to 
appear in the new presentation. 

NOTE: Remember that the first asset of the selection determines the layout. 

2. Select the assets to be included in the new presentation

3. Select Asset > Convert To. 

The Browse for Folder dialog opens for choosing a destination folder for the pre-
sentation asset(s). 

4. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you. Available to you for converting are the Asset Processors that are 
activated in the Asset Handling Set which is chosen for Asset Access in your User 
Settings. 

5. Select MS PowerPoint Asset Processor. The dialog for the parameters opens. 
(See “MS PowerPoint Asset Processor Parameters,” below, for details.)

6. Enter a file name for the new presentation.
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NOTE: If you enter an existing presentation, the new slides will be appended to 
the existing presentation. 

7. Make your settings. For details, see “MS PowerPoint Asset Processor Parameters” .

8. Click OK. 
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MS PowerPoint Asset Processor Parameters 
The MS PowerPoint Asset Processor offers a range of parameters to be defined.

Destination File: Enter the name for the presentation to be created.

NOTE: If you enter the name of an existing presentation, the Asset Processors 
will not replace an existing presentation. It will append the new slides to the 
existing presentation. However, if included in an Asset Action, it will not 
append slides as the Delivery module of the Action will save a new presenta-
tion (name of the existing one extended by a number.) 

Embedding PowerPoint Assets

Presentations – If your selection contains presentations, you can decide whether 
such presentations are to be included in the new presentation – either the entire asset 
or on the first slide. Activate the desired options. Remember: The layout of a new pre-
sentation is determined by the first asset of the selection for the new presentation. If 
the first one is not a PowerPoint asset, the layout is determined by the standard layout 
of PowerPoint (depending on the settings of the PowerPoint installation).

Image Asset Processing

The options for embedding or linking the images determine how the image is embed-
ded in the presentation. 

• Embed images – Images will be saved with the presentation.
• Link images placed next to presentation – Images will be saved in separate files 

in the same folder where the presentation will be saved, and the images will be 
linked to the presentation only. 
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• Link images, placed in folder next to presentation – Images will be saved in sep-
arate files in a subfolder of the folder where the presentation will be saved, and the 
images will be linked to the presentation only. 
– Folder name – Enter a name for the subfolder where the images should be 
saved – either an existing folder or a new one. Entering a new name will create a 
new folder.

NOTE: The options for embedding or linking images are disabled if the 
PowerPoint Asset Processor is used within an asset action. Embedding and link-
ing will not work in this case. PowerPoint always uses the full path to linked /
embedded images, but the steps of an asset action are executed in a temporary 
folder which subsequently is deleted. This would lead to invalid file paths in the 
PowerPoint presentation.

The next step is to define the area where the images should be placed. The size of the 
area is defined by margins set corresponding to the slide size. To define the area for 
the images on the slide you determine the margins from the top, bottom, left and 
right edges of a slide. You can choose from different measurement units to determine 
the margins. The position of an image within this area is defined by anchor points. 

You can scale the images placed in the area up or down so that they fit within the area.
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• Scale down larger images – The images that are larger than the area are made 
smaller. Proportions are constrained.

• Scale up smaller images – The images that are smaller than the area are enlarged. 
Proportions are constrained.

• Image Preprocessing
Images can be processed before they are used for the presentation to be created. 
The Cumulus Pixel Image Converter is employed for the preprocessing, so you can 
have a filter run, rotate and crop the image. If you activate the Image Processing 
option and click the Parameters button, you can set the parameters available for 
preprocessing. (For details, see “Pixel Image Converter Parameters” .)

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS REPURPOSING ASSETS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Creating ZIP Archives
The ZIP AssetProcessor compresses assets into Zip archives. 

To compress cataloged assets into Zip archives:

1. Select the record(s) representing the asset(s) to be compressed.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the ZIP asset.

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Processors 
available to you. Available to you for converting are the Asset Processors that are 
activated in the Asset Handling Set which is chosen for Asset Access in your User 
Settings. 

4. Select ZIP AssetProcessor as Asset Converter. 

The ZIP AssetProcessor Parameter dialog opens.

5. Select the parameters for the conversion:

• Under Archive Name you have to choose a name for your ZIP asset. The ZIP 
AssetProcessor will automatically add the extension ".zip" to the file name. On 
OS X this means that the name can be up to 27 characters in length without the 
extension.

NOTE: If you choose an existing ZIP asset as archive name, the ZIP AssetProces-
sor will update the already contained assets and append new assets. 
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• Under Use Character Encoding you can define the character encoding used to 
save the file name(s) in the ZIP file. The default is your local system encoding – 
the encoding of the computer you are working with (this encoding would be 
used by WinZip and StuffIt also). The character encoding chosen should account 
for the language and the operating system of the computer where the ZIP is to 
be unpacked. Find some common encoding recommendations listed below.
– Windows and West European languages: WinLatin1
– Windows and East European languages: WinLatin2
– Windows and 2 byte character encoding (e.g. Japanese): WinJapanese
– OS X: UTF8
– Mac OS 9 and West European languages: MacRoman
– Mac OS 9 and 2 byte character encoding (e.g. Japanese): MacJapanese
– Mac OS 9 and Russian: MacRussian
– UNIX: Ask the person you will provide the ZIP archive with, which encoding is 
needed.

• Under Macintosh Resource Support you can define how to support Macintosh 
resources. 
– Activating the Store as MacBinary Format option determines the assets to be 
stored including the Mac OS resource fork, data fork and finder information (e.g. 
File Type/Creator). This option should only be activated, if the file will definitely 
be extracted under OS X, as the MacBinary format often cannot be extracted 
properly under Windows or UNIX.
– Activating the Store as OS X archive compatible option saves the files in the 
same structure as in an archive created with the Finder of OS X (10.3 or later). 

NOTE: If you have activated the Macintosh Resource Support with the option 
Store as OS X archive compatible, the character encoding is always UTF-8.
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6. Click OK.

The selected asset(s) will be compressed and the ZIP asset stored in the selected des-
tination.
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WebAlbum
Cumulus WebAlbum enables Cumulus to output selected images’ records as a Web-
ready album. This album is based on static HTML pages, complete with thumbnails, 
scaled versions of images and links to the original assets. You can use different skins 
for the layout and functionality of your album, such as those provided by Canto or 
other providers (e.g. by JAlbum), or those you develop yourself. WebAlbum takes the 
selected records and converts their assets to files suitable for display on the Web. This 
includes the automatic creation of copies of the assets in the Web-ready JPEG image 
file format. You have full control of album design through the use of skins. WebAlbum 
will create thumbnails of your images and display them in index pages in HTML. Web-
Album can also produce slide shows of your images for easy navigation.

An album created with Cumulus WebAlbum can be uploaded on any common Web 
server (no special system requirements) and can be viewed with any standard Web 
browser. You can also use WebAlbum to create local albums on your hard disk or on 
CD-ROM. 
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Creating an Album
When you create an album, WebAlbum uses the records you selected and:

• generates thumbnails in JPEG format (e.g. used for index pages) – always
• generates scaled images in JPEG format (e.g. used for slide pages) – if a corre-

sponding option is activated
• copies the original assets to a defined output folder for the upload – if a corre-

sponding option is activated
Furthermore WebAlbum generates:

• index page(s) – always
• slide pages – if a corresponding option is activated. Depending on the activated 

option, slides contain selected record fields’ information and scaled images or 
original assets.

NOTE: Do not to use the WebAlbum when connected as the Cumulus Admin-
istrator. 

To create an album:

1. Select the records of those images you want your album to consist of.

NOTE: You need the Transfer Assets permission for the catalogs that contain the 
selected records. 

2. Select Asset > Create WebAlbum.
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A dialog for configuring your album opens. Now you can either configure a new 
layout for your album or use a saved one by clicking the  (Open) button.

3. Configure the album.

Three sections provide access to the configuration options:

• The General Section

• Title: Enter a title for your album. Where this title is displayed depends on the 
selected skin.

• Output Location: Define the folder to hold the output of your configured 
album. This should be an empty folder when you start creating a new album.

• Output Options:
Make Slides – Enable this option, if you want your album to include slides 
(scaled images and contents of the selected record fields). If the selected skin 
supports these functions, next/previous buttons are provided to display the 
slides.
Upload via FTP – Enable this option if you want your album to be uploaded 
onto the Web directly after creation.

NOTE: This option can only be enabled if the settings on the FTP tab were 
tested and did not show any errors. 

• Link Options: Decide on one of the options (for further information on these 
options, see the section “Provided Skins and Link/Output Options”.)
Link to Originals – Clicking on a thumbnail will display the original asset. 
Link to Originals through Scaled Images – Clicking on a thumbnail will display 
the slide including the scaled image and clicking on this image will display the 
original.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS WEBALBUM

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

NOTE: Albums that include links to the original are quite large in size. 

Link to Scaled Images Only – Clicking on a thumbnail will display the scaled 
image without any further link to the original.

• Image Size & Quality
Thumbnails – Select or enter the size for the thumbnails (left field) and select 
the compression quality (right field).
Images – Select or enter the size for the scaled images (left field) and select the 
compression quality (right field).

NOTE: Images will maintain aspect ratio and constrain their proportions. 

• Page Layout (valid only if the skin interprets these values)
Columns – Enter the number of columns for the index page(s).
Rows – Enter the number of rows for the index page(s).

• Image Order: Select the record field you want used for alphabetical sorting of 
the thumbnails.
Reverse Sorting Order – If this options is enabled the sorting order is Z to A or 9 
to 0

• Skin
Name – Select the skin you want to use for this album. The selected skin defines 
the overall appearance of your album: layout and functionality.
Style – Select a style (e.g. color theme and look) for the above selected skin.
Automatically load Skin Settings – Enable this option, if you want the selected 
skin’s layout hints to be loaded automatically (valid only if there are any hints 
provided with the selected skin).
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• The Fields Section

Use the Add button to add the fields of the contents you want to include with the 
slides.
Use the arrow buttons to place the fields in order.

• The FTP Section

• FTP Settings 
FTP Server – Enter the name of the FTP server you want to upload the album to. 
Port – If it is not the standard FTP port number 21, enter the required port num-
ber of the FTP server you want to upload the album to.
User Name – Enter the user name of the FTP account. 
Password – Enter the password of the FTP account. 
Path – Enter the directory on the FTP server you want to upload the album to. 
Enter at least a slash (/) but be aware that an existing index.html will be overwrit-
ten.
Passive Mode – Enable this option if you expect any trouble when connecting 
through a firewall. 
Overwrite Existing Files – If this option is enabled, existing files will be overwrit-
ten when uploading a new album. If not enabled, existing files will not be over-
written with the new version.

To test your FTP settings you can click the Test Settings button. Only in cases 
where the settings do not include any errors, you can enable the Upload via FTP 
option on the General tab.

4. Click Start to create your album. 

If you have changed any setting of the album layout or if it is a new album layout, 
you are asked whether you want to save your changes. If it is a new album layout 
you want to save, you are asked to enter a name for it.
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If the folder you defined under Output Location contains any files, you are asked 
whether this folder should be cleared. We recommend selecting Yes. If you select 
Yes, all files and subfolders in the output folder will be deleted before the new 
output files are created. If you select No, HTML files with the same names as the 
newly created ones will be overwritten and new copies of the assets will be 
added. If you select Cancel, the creation of your new album will be canceled.

The output files of your album are created in the folder you defined under Output 
Location. Start the index.html page in that folder to see (and test) your album.

You can save your album layout configuration by clicking the  (Save) button. If you 
want to save it under another name, click the (Save As) button. 

NOTE: You may select records of any file formats to create an album – not only 
images. However, in this case you should not include slides but use links that 
point directly to the originals. 
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Provided Skins and Link/Output Options
The album design is controlled by skins. Canto provides different skins for Cumulus 
WebAlbum. The skin named “Canto” supports the following output depending on the 
selected link and output options:

Link to Originals

~
~
~
~

Index page with 
thumbnail overview

Slide page with field informa-
tion and scaled image

Original asset 

Link Option “Link to Originals through Scaled Images” (Output Option “Make Slides” ignored)
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~
~
~
~

Index page with thumbnail overview Slide page with field information and original asset

Link Option “Link to Originals” (Output Option “Make Slides” activated)

Index page with thumbnail overview Original asset 

Link Option “Link to Originals” (Output Option “Make Slides” not activated)
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Link to Scaled Images Only

~
~
~
~

Index page with thumbnail overview Slide page with field information and scaled image

Link Option: “Link to Scaled Images Only” (Output Option “Make Slides” activated)

Index page with thumbnail overview Scaled image

Link Option “Link to Scaled Images Only” (Output Option “Make Slides” not activated)
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Preferences
Within the Preferences dialog of your Cumulus application, you can define the startup 
settings for WebAlbum. WebAlbum can either be started with a new and empty 
album layout or with the last album layout you used.

To set WebAlbum to open the last album layout used when starting:

1. Select Cumulus / Edit > Preferences. The Preferences dialog window 
opens. 

2. Select User Settings and click WebAlbum on the General tab.

3. Enable the checkbox.

4. Click Apply to save your changes and select the next preference you want to edit.
OR 
Click OK to save your changes and close the Preferences window.
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Customize
You can easily customize your album by using different skins. You can either develop 
your own skins or use skins created by other providers. 

A skin consists of a folder that contains subfolders for images included in the skin itself 
(the res folder) and cascading style sheets (the styles folder) as well as files that define 
special pages, e.g. the index pages and the slide pages. The About text file will inform 
you if the skin contains any extraordinary functions or definitions.

The skins provided with Canto can be found in the skins folder inside the webalbum 
folder. The webalbum folder is located in the ejp folder in your Canto installation 
folder.

It is easy to customize the fonts (type, size and color) and the background colors of a 
skin by editing the cascading style sheet (.css). If you want to develop your own skins, 
you have to know how to do it on your own. Canto cannot give you any support for 
developing skins. 
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TIP: Cumulus WebAlbum and JAlbum

You may use JAlbum skins with Cumulus WebAlbum. If you want to use JAl-
bum skins, you have to replace </ja: and <ja: with </wa: and <wa: in the 
index.htt and slide.htt files. Then test the skin. The following skins seem to 
work with Cumulus WebAlbum: Mamba, Film, XP, and CameraGeek. 
You may look at the JAlbum skin repository site, the site that is intended to act 
as a central area where makers of skins for JAlbum can share their skins with 
others: http://jrepository.engblom.org 
However, note that Cumulus WebAlbum does not support all JAlbum skin pos-
sibilities. 
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Configuring Web URL
Cumulus Web Links need Cumulus Sites to work. If your version of Cumulus does not 
include Cumulus Sites, there is no use in configuring Cumulus Web Links. Since 
Cumulus 10, you can make use of the Media Delivery Cloud (MDC) and Media Delivery 
on Premise (MDO) options to provide links to assets in Cumulus

If your Cumulus installation includes Cumulus Sites, records – and potentially thumb-
nails, previews and assets – can be accessed via Web Links (URLs). For this purpose, 
Cumulus provides different kinds of URLs that can be sent via email, or embedded in 
web pages, and that can be opened in any web browser, of course. 

PRECONDITIONS: The Web Link feature only works if at least one Base URL has been 
defined by your Cumulus Administrator in the Cumulus Server Settings, if the respec-
tive catalog is marked to be published on the internet, and if the catalog contains spe-
cific fields for thumbnail, preview, and asset URLs. 

Cumulus provides the following kinds of URLs 

• Record URL for Display in Web Clients – opens Cumulus Sites displaying the 
selected record only

• Thumbnail URL – links to the thumbnail of the respective asset
• Preview URL – links to a preview of the respective asset
• Asset URL – links to the respective asset
While record URLs are always available, thumbnail, preview and asset URLs can be 
enabled / disabled (switched on and off) independently for every record.
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To switch web URLs on and off:

1. Mark the record(s) for which you want to configure web links.

2. Select Asset > Configure Web URL. 

3. The Configure Web URL window is displayed. 

4. For each record, activate the check boxes for the URLs you want to enable, or 
deactivate the check boxes for the URLs you want to disable, respectively.

5. Confirm your settings with Apply. The URLs are enabled (or disabled, respectively); 
the window remains open for further actions.

OR

Confirm your settings with OK. The URLs are enabled (or disabled, respectively); 
the window is closed.

To copy or open an URL:

1. Mark the record(s) for which you want to copy or open an URL.

Select Asset > Configure Web URL. 

2. The Configure Web URL window is displayed.

3. If your Cumulus Administrator has defined more than one Base URL, check the 
Base URL list to make sure that the appropriate Base URL is selected.

4. From the URL Kind list, select the URL kind you want to copy or open.

5. Click Copy URLs to copy the corresponding URL(s) to the clipboard.
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6. Click Open URL to open the corresponding URL for a selected record in your Web 
browser (Open URL is disabled, if more than one record is selected in the Config-
ure Web URL window!).

TIP: Using Metadata Template

If Web URLs must be configured for lots of records, e.g. for whole catalogs, it is 
more convenient to use a Metadata Template. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS IMPORTING AND EXPORTING

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Importing and Exporting
Cumulus can export and import records, categories and collections. Collections can 
only be imported and exported in Cumulus exchange file formats whereas records 
and categories can also be exported to and imported from XML files. Exported catalog 
metadata in XML files can be used by other programs as well as on other platforms. 
Paired with the metadata import options Cumulus offers, you have a complete meta-
data “round-tripping” solution to make integrations with your other systems easy.

Cumulus supports XSL Transformations (XSLT). XSLT is a programming language for 
transforming XML documents into other XML documents. XSLT was designed to be 
used with XSL, which is a stylesheet language for XML. Apart from the XSL Metadata 
Processor, the Cumulus export function XSLT can be used for example to place images 
and metadata in InDesign documents.

Importing and exporting data with Cumulus is easy, but there are a few things to be 
aware of in order to avoid unexpected results.
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Cumulus Exchange File Formats
XML is the recommended export format. 

For special purposes Cumulus can also export and import records, categories and col-
lections in special Cumulus exchange file formats. These files can be used on any sup-
ported Cumulus platform. But note that records and categories do not support the 
Cumulus 8 Table fields. Canto recommends you use these formats only for special pur-
poses concerning Cumulus versions prior to 8. The Cumulus exchange file formats are:

• Categories – Cumulus exports categories in a Cumulus Category Exchange File. 
The file name extension is .cce

• Records – Cumulus exports records in a Cumulus Record Exchange File. The file 
name extension is .cre

• Collections – Cumulus exports collections in a Cumulus Collection Exchange File. 
The file name extension is .cfe

Exporting data in these formats can be used for transferring data between catalogs for 
archiving category listings. These archive files can be imported into any other catalog 
when you need them. (You could do the same thing with records, but it’s probably 
more convenient just to keep copies of the records in catalogs.) 

Character Encoding for Export

When exporting information in Cumulus exchange file formats, you can employ dif-
ferent character encoding. Universal Encoding (UTF-8: Unicode characters coded as 8-
Bit Transformation Form) makes sure that special characters are transferred correctly 
across platforms. Choose this format only if you want to use the exported file on 
another operating system.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS IMPORTING AND EXPORTING

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Maintaining Category Assignments
The most important thing to know when you are exporting records to be imported 
into another catalog, is whether the new catalog already has the categories to which 
the records are assigned. If it does not, the categories assigned to the imported 
records will be created. But categories of the type “Folder” lose their type (assignment 
to the Source category tree). They are created as normal categories. If you want to 
keep the type of these categories, you must first export and import the categories. 

Remember that it may be easier just to drag and drop records from one catalog to 
another, if both the source and destination catalogs are available to you. If they are 
not, or you are moving thousands of records at a time, then the export/import route 
is the way to go.

NOTE: When exporting records from one catalog and exporting them into a 
different catalog, the category assignments from the old catalog are always 
maintained and missing categories will be created. With drag & drop, however, 
you can choose if category assignments are maintained or ignored. If you 
choose to ignore them, missing categories will be ignored, too.
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Exporting and Importing Records and Categories 
The exporting and importing process is pretty much the same, regardless of the data 
type. 

Exporting

Exporting goes like this:

1. Find and select the items you wish to export. (See “Find Assets”, if needed, for a 
refresher on how to find records.)

2. Select File > Export and then the appropriate export option:

• Selected Records – Exports the currently selected records. (This menu item is 
disabled if no records are selected.)

• All Records – Exports all records of the active collection. To export all records of 
the catalog(s) included in the collection, you must perform Find > Find All 
Records first.

• Selected Categories – Exports the currently selected categories in the active 
collection. (This menu item is disabled if no categories are selected.)

• All Categories – Exports all categories of the Category pane. 
3. Select the export format. Note that the XML format is recommended for most 

purposes. This format enables Cumulus to export from multiple catalogs and sup-
ports data from Cumulus Table fields.

• When exporting records into an XML file, a check box offers the option to have 
the export file compressed (*.zxml) . Another check box offers to enable XSL 
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transformation by applying an XSLT stylesheet which describes the rules for the 
transformation.

• When exporting selected categories, a check box offers the option to export the 
subcategories as well. 

4. Click the  button for browsing for the location where the export file should be 
saved. 

5. Select the location, name the export file and click Save. Note that Cumulus will 
add the correct file extension.

6. Click Next. If you are exporting into XML, you can select the fields that contain the 
values to be included in the export file.

7. Make your selections and click Start. Messages inform you of the export process. 

8. When you get the message that the process is finished, click Finish to close the 
dialog.

Importing

Importing is just as easy:

1. Select File > Import.

2. If you have multiple catalogs open in one window, select the catalog to which 
you want to import the data.

3. Click the  button for browsing to the location where the file to be imported 
resides. 

4. Select the file and click OK. 
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5. Select the appropriate file format. Note that the XML format will also work for 
zipped XML files (*.zxml).

If your Cumulus configuration supports Permissions Templates, you can select 
one to be applied to the imported records/categories.

NOTE: Importing Categories
If a category in the import file has the same name as an existing category at the 
same hierarchy level, the category is not imported.

6. Click Next to start the import. Messages inform you of the import process. 

7. When you get the message that the process is complete, click Finish to close the 
dialog.
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Importing and Exporting Collections 
Collections stored with previous Cumulus versions on the computer running the Cli-
ent application can be imported (File > Import > Collections.) To store collections at 
any location other than the Cumulus Server, you can use the export function (File > 
Export > Collections.) 

For sending a collection via email to another Cumulus user, a special export function 
is provided (File > Export > Mail Collection To.) However, don’t forget: Since a collec-
tion is always connected to at least one catalog, the recipient must have access to the 
respective catalog(s) to make use of the mailed collection.

To make use of a collection you received, you use the import function. 

IMPORTANT! If the Remember Password option is activated in your Connect 
to Server dialog, any collection you export or mail contains your login informa-
tion. Opening such an exported or mailed collection will connect to the 
Cumulus Server with your login and password. This means that the user who 
opens the collection works as you and has your permissions. 
If the Remember Password option is not activated, the Connect to Server dia-
log will appear when an exported or mailed collection is opened.
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Importing from Text/CSV Files
The Cumulus Importer utility enables the import of metadata (e.g., from other data-
base systems) into Cumulus catalogs via text files (separated by delimiters.) The data 
can be imported into record or category fields, into string list fields as values, or into 
the category tree, which enables the Importer to create hierarchical categories. The 
details specified for an import process can be saved as an Import Configuration Set. 

There are different types of import destinations available with the Cumulus Importer:

• Import of Categories into the Category Tree 
You can import data from an import file as categories to a Cumulus catalog. You 
specify the field of the import file which data is to be imported as categories. And 
you specify the hierarchy level where they shall be inserted.

• Import of Metadata into Record Fields
You can import data from an import file into record fields of a Cumulus catalog. 
You define relations between a record field and a field of the import file. Further-
more, you can create new records that are not related to assets for entries in the 
import file that do not correspond to records already existing in the current cata-
log.

• Import of Metadata into Category Fields (Enterprise only)
You can import data from an import file into category fields of a Cumulus catalog. 
You define relations between a category field and the field of the import file. The 
procedure is identical to the procedure for importing information into record 
fields. Furthermore, you can create new categories for entries in the import file that 
do not correspond to already existing categories in the current catalog.

• Import of Values to String List Fields
You can import data from an import file as values into the properties of a string list 
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field, even different values for different languages in multi-lingual string list fields. 
Values can be imported to any category or record field of the type String List.
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Delimiters 
A lot of database systems use the tabulator as the field delimiter (even Cumulus while 
exporting data from a catalog). If your import text file uses another character as field 
separator, you can specify the appropriate delimiter. Also, the delimiter for category 
levels can be set to any character.

Escaping Delimiter Characters 

If the delimiter character is used as a normal character within the content of a field, you 
must enclose the respective field in double quotes in order to escape the contained 
delimiter character. All characters enclosed in double quotes, including the delimiter 
character, are interpreted as a text block. For example, your CSV file uses the colon as 
a delimiter and contains a field which has the colon in its name, such as Author: 
Title. To import this field properly, it must be escaped as follows: "Author: 
Title". Without the quotes, the importer would generate 2 fields, Author and Title.

Make sure to properly match any opening quotes with corresponding closing quotes. 
As long as the importer doesn't find matching closing quotes, it won't recognize a 
delimiter character, which will cause the import to fail.

If double quotes are used as normal characters within the content of a field, you must 
escape any of these double quotes with a second double quote. For example, your 
CSV file uses the colon as a delimiter and contains a fields Author: "Title". To 
import this field properly, it must be escaped as follows: "Author: ""Title""".

Simple Import Mode

If the delimiter character is not used anywhere in the field content of the import file, 
you can add an exclamation mark (!) to the specified delimiter, thus switching to a 
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simple importing mode that treats any character other than the delimiter character as 
normal characters, including any double quotes. For example, enter \t! into the 
Other field if the tab is used as delimiter, or enter ,! if the comma is used.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS IMPORTING AND EXPORTING

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Definition of Additional Information
For the import you can define additional information that is imported prior to the text 
that comes from the import file. The additional information may increase the readabil-
ity of information in a field.

EXAMPLE: Additional Text
It might be helpful to define additional text that is inserted in front of the infor-
mation from the import file. For example, if you want to import the price of a 
product into the notes field and your import file contains the figures only, you 
can define additional information like Price Euro: that is added to the text 
before importing it into the Cumulus catalog. After the import the notes field 
looks like this: Price Euro: 99
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Running an Import Process from a Text File

IMPORTANT! Before you start importing information into a Cumulus catalog 
using the Cumulus Importer utility, make sure that a safety copy of the catalog 
exists. There is no UNDO function for the import available. You can only roll 
back to the initial version of the catalog if there is safety copy available that you 
can open instead of the changed catalog. 

To set up an Import Configuration Set and run an import process:

1. Open the Cumulus catalog, to which you want to import the information.

2. Select File > Import > From Text/CSV File. The Select Import Configuration win-
dow is displayed.

3. Choose whether you want to create a new set or load an existing one. 
To select an existing one, open the drop-down list of available sets. 

4. Click Next.

5. If you have decided to load an existing set, continue with step 7

If you are creating a new set, the Select Import Destination window is displayed. 

For information on the different types see above.

6. Select the destination and click Next. The Select Import File window is displayed.

7. Specify the import file, the delimiter character used, the encoding type and the 
region:
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• File
Choose the file you want to import the data from. Use the  button to browse 
for the file.

• Delimiter 
A lot of database systems use the tabulator as the field delimiter (even Cumulus 
while exporting data from a catalog). If your import file uses another character 
as separator, you can choose or enter another delimiter. 

• Character Encoding
Select the character encoding of the import file.

• Region
Select the region used for date/time values and numbers in the import file if it is 
different from the application’s region setting. Otherwise, date/time values and 
numbers may not be imported properly.

The results of your settings are displayed in the Data Preview list which provides 
two columns:

• Import Field Identifier
Lists the field identifiers from the chosen import file as interpreted using the 
defined delimiter.

• Import Field Value
Displays what the values of a field will look like. Use the arrow buttons to page 
through the data. 

8. If this is how you want to import the data, click Next.

The next steps depend on the selected destination type. Each destination type 
requires different specifications. See below for further information (Import to Cat-
egory Tree, Import to Records/Categories, Import to String List Fields. 
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In any case you, have to add entries for the fields to be imported. Use the Add 
button to do so. Use the Remove button to remove entries for fields.

If no more configurations are required, a Start button is displayed.

NOTE: Now you can save your Import Configuration set for the data import in an 
import scheme file by clicking the Save as button. This set holds information 
about the field assignments, the name of the import file and the appropriate 
delimiters. 

9. Click Start. The data will be imported.
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Import to Category Tree

To import data as categories to the Category Tree of a Cumulus catalog, you must 
specify the import field which holds the data to be imported as categories and the 
hierarchy level where you want the categories to be inserted. 

• Delimiter for Category Hierarchy 
By default, Cumulus uses a colon as separator for indicating the levels in the cate-
gory hierarchy. If your import file uses a different character, enter the appropriate 
delimiter. 

• Skip First Line
Often the first line of the import file does not contain information that you want to 
import (e.g. column headings). Activating this option prevents the import of the 
data of the first line.

• Import Field Pattern Preview
Displays how the data will be imported.

• Parent Category
Displays the category to which the data from the import field will go as subcate-
gories. See below on how to define the parent categories.

• Import Field Pattern 
Lists the fields from which the values should be imported as categories. You can 
insert additional information by clicking in the field’s entry in this column (see Defi-
nition of Additional Information).
To import data from more than one field, use a right/alternate mouse click in a 
field’s entry in this column to get a list for selecting additional fields.

To add field entries, click Add. This displays a dialog that lets you: 
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• Determine a parent category. You can import the categories as subcategories of a 
specific category. Determine this category either by entering the category hierar-
chy data for the parent category, or by using the currently selected category in the 
category pane. When entering the category hierarchy data you must use the dis-
played delimiter. 

• Select the field that contains the values to be imported as categories
To add the selected field  to the selection of Import Fields, click OK. This brings you 
back to the main dialog. 
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Import to Records/Categories

To import data into a record field of the Cumulus catalog, you must define a relation 
between the import text file and the Cumulus catalog by specifying one or more rela-
tions. In most cases, it will be the Asset Name to determine the record and in addition 
to that multiple relations that determine from which import field the data should be 
imported to which Cumulus field.) 

NOTE: You can assign fields of the import file to the Cumulus record field Cat-
egories. Then the affected Cumulus records will be assigned to these catego-
ries.

To import information into category fields of the Cumulus catalog, you must define a 
relation between a category field and the field of the import file. The procedure is 
identical to the procedure necessary when importing information into record fields.

• Skip First Line
Often the first line of the import file does not contain information that you want to 
import (e.g., column headings). Activating this option prevents the import of the 
data of the first line.

• Create new records/categories for lines that do not correspond to existing 
records/categories.
Activating this option initiates the creation of a new record (without a related 
asset) or a new category for each line in the import file that does not correspond 
to an already existing record/category.

• Import Field Pattern Preview
Displays how the data will be imported.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – USE ASSETS IMPORTING AND EXPORTING

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

• Import Field Pattern 
Lists the fields from which the values should be imported. You can insert addi-
tional information by clicking in the field’s entry in this column (see Definition of 
Additional Information).
To import data from more than one field, use a right/alternate mouse click in the 
field’s entry in this column to get a list for selecting additional fields.

• Relation
If you want to import data into a record or category field of the Cumulus catalog, 
you have to specify relations between the field of the import file and the Cumulus 
field. 
Two different relation types can be specified
= (equals) – The Cumulus Importer will only import the data if the value of the 
Cumulus field is equal to the value of the Import Field. This relation type is used to 
perform the search for the appropriate records.
-> (insert) – The Cumulus Importer will import the data of the Import field speci-
fied in the left hand column to the Cumulus field specified in the right hand col-
umn.

NOTE: If you import data without identifying corresponding records by a 
= (equals) relation, the Cumulus Importer utility will create new records that are 
not assigned to assets. You may do so if, for example, you want to import meta-
data for assets that are not cataloged yet. Corresponding assets can be assigned 
to the records later. 

• Cumulus Field
Lists the Cumulus fields into which the data of the import fields shall be imported. 
Whenever a new Import Field entry is added, this column shows the first of the 
available Cumulus fields (record or category field – depending on the destination 
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type you have chosen for the Import Configuration set.) Click this entry to select 
the desired Cumulus Field.

• Fill Mode
Displays how the field will be filled. For String fields, you can define whether the 
imported value shall replace the existing value, or shall be added to the existing 
value (before or after.) Click the field’s entry to select the desired mode.

Only if you are importing data to the Categories field of records (to assign records to 
categories), you must determine the delimiter that is used to separate the category 
levels. 

To add field entries, click the Add button. This displays a dialog that lets you select the 
field that contains the metadata to be imported.

To add the selected field to the selection of Import Fields, click OK. This brings you 
back to the main dialog. 

NOTE: Importing multiple values into Multi-Select String List fields
The CSV import also supports multiple string list field values. The respective val-
ues in the CSV file must be separated with commas.
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Import to String List Fields

To import data as values of a string list field of the Cumulus catalog, you must specify 
the assignments between the import fields and the Cumulus string list fields (target 
fields).

The Cumulus Importer is able to fill the fields with different languages. 

• Skip First Line
Often the first line of the import file contains information that you don’t want to 
import (e.g., column headings). Activating this option prevents the import of the 
data of the first line.
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• Import Field Pattern Preview
Displays how the data will be imported.

• Import Field Pattern 
Lists the fields from which the values shall be imported. You can insert additional 
information by clicking in a field’s entry in this column (see Definition of Additional 
Information).
If you want to import data from more than one field, use a right/alternate mouse 
click in a field’s entry to get a list for selecting additional fields.

• Relation 
Two different relation types are available
-> (insert) – The Cumulus Importer creates a new string list entry in the target field 
specified in the right hand column and writes the values (several languages) of the 
Import field to this new entry.
= (equals) – This relation is used to control the import process and must be used 
only once in any import set. 
The Cumulus Importer checks whether the value of the import field equals the 
value of an existing list entry (in the specified language) of the target field.
• If yes, the found existing string list entry is processed and the values specified in 

the other rows of the import set are written to the specified languages of the tar-
get field list entries. – Note that in these rows, the Relation must be set to “->”!

• If no, the “=” relation is treated as insert (“->”), and a new string list entry is created 
in the target field.

• Cumulus Field
The target fields into which the data shall be imported. Whenever a new row for 
an Import Field entry is added, this column shows the first of the available Cumulus 
fields. Click this entry to select the desired target field.
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• Language
The language-specific values of the target field that shall be replaced with the val-
ues from the import field.

To add more field entries, click the Add button. A dialog is displayed that lets you 
select a field containing the values to be imported.

To add the selected field to the selection of Import Fields, click OK. This brings you 
back to the main dialog. 
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Workflow Enhancements
Cumulus provides several possibilities to enhance your workflow. Upon them:

• Labeling 
• Rating 
The next section describes how to use color labels and star ratings to quickly organize, 
sort, and filter your files. For a description on how to use the work-in-progress man-
agement feature user comments in Preview view or window, see “User Comments” . 
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Labeling 
The record field type Label enables users to label records by assigning colors. Each 
Cumulus catalog provides a standard Label field but the user can add more fields of 
this type. For any field of this type the user can define a color range. The Label Editor 
tab of this field type’s properties window lets you determine the label colors. Addi-
tional colors can be defined by a color picker value. 

Label fields can be displayed in all views. For certain views you can select the colors of 
a specific label field to be the background of the entire record or of the record’s name. 

Of course a label field itself can also be included in a view. To set up views that display 
labeling: Cumulus / Edit > Preferences > Record View Sets.

The labeling color for a record can be set in the Information window via list selection 
or by a menu item via the Asset menu. 

The menu item Assign Label will be available only if the effects of assigning the label 
can be immediately seen by the user. This means that it is available only if at least one 
label field is included in the catalog AND if at least one label field is included in the cur-
rent view or set as background for records (entire record or record name) in the cur-
rent view.

The menu item will assign the label set as background of the current view. If no label 
is set as background or for views where a label cannot be set as background, the menu 
item will assign the label from the first field of type Label from the current view. (The 
order refers to the field list of the view settings in the Preferences dialog.) 

In the Information window, the field will be displayed as a drop-down list. The current 
color is displayed and the available colors are included in the hidden list. To select a 
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color, open the list and select the desired label color. To remove a label, open the list 
and select the no value entry.

When printing labeled records, the label marks are printed as displayed (if the Label 
field is included in the fields to be printed.)

NOTE: Multiple Labeling Systems!
Each catalog can have its individual labeling system. However, be careful using 
multiple labeling systems. If you work with several catalogs in one collection, 
you might not like to have different colors caused by individual labeling sys-
tems for the different catalogs. Label fields with the same name included in 
multiple catalogs but with their colors defined differently might cause confu-
sion. The records will always show the label colors set for the catalog they 
derive from. But if you have multiple records selected that come from different 
catalogs with different labeling systems the Assign Label menu item is of 
course disabled. 

You can search for labeled records and save such searches as search queries.

NOTE: Changing Label Color
Each label's value is defined by the label color. So, if you change a label color, 
make sure any saved queries that refer to the label are updated to use the new 
color value. 
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Rating 
The rating system enables you (and your co-workers) to rate assets from 1 to 5. Rating 
values are searchable, so when you want to find your best assets, it's easy to do so. 
Each Cumulus catalog provides a standard Rating field (field name and type: Rating) 
but more fields of this type can be added. For example you can have one separate field 
for each member of your team. 

Ratings are displayed by star icons. A rating field can be displayed in Details View, 
Thumbnail View, Info View and in the Information window. The rating value for a 
record can be set in the Information window via clicking or by a menu item via the 
Metadata menu. The menu item employs the first field of type Rating from the current 
view. (The order refers to the field list of the view settings in the Preferences dialog.)

In the Information window, clicking on a star in the rating row sets the rating value 
immediately to the selected value. Clicking close left of the first star removes the value. 

When printing rated records, the rating marks are printed as displayed (if the Rating 
field is included in the fields to be printed). 
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Workflow Automation with Cumulus
Cumulus provides various workflow support functions. Many of them are based on 
Action types. Workflow can be automated by:

• User-defined actions: Cumulus Asset Actions 
• Event-based actions: Cumulus Trigger Actions
• Time-based actions: Cumulus Scheduler Actions
In addition to that, Cumulus offers status-based workflows. Such workflows are con-
figured via the Workflow Manager of the Cumulus Web Server Console and applied to 
catalogs. If open catalogs contain at least one of these workflows, a Workflow menu is 
displayed. For more information, see “The Workflow Menu”  and “Configuring Work-
flows”.
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Cumulus Asset Actions
Cumulus Asset Actions simplify your daily workflow needs. An Asset Action refers to a 
combination of certain functions and can be saved under a chosen name. Whenever 
you wish to perform this combination of functions, all you have to do is select the cor-
responding Action and it will be done. You can perform an Asset Action either on 
selected records or when mailing assets. To perform an Asset Action on records 
selected in the Record pane, you employ the menu item Asset > Perform Asset 
Action. To perform an Asset Action on records in the Collection Basket pane, you 
employ the Collection Basket’s toolbar. (For details, see “Outputting the Collection 
Basket’s Contents” . 

These Asset Actions can be defined in your User Settings in the Preferences dialog – 
for a description, see “Cumulus Asset Actions” . With Workgroup or Enterprise, you 
need the appropriate permissions for Asset Actions. 

To perform an Asset Action on records in the Record pane:

1. Select one or more records.

2. Select Asset > Perform Asset Action. A submenu opens that lists the available 
Actions.

3. Select the desired Asset Action.

Depending on how the action is defined dialogs for the included modules may 
show up. Make your selection and click the appropriate buttons. The Actions will 
be performed on the selected records.
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Progress information is displayed on those actions that take a certain amount of 
time.

If the selected Asset Action failed to be performed on certain assets, theses assets are 
listed as soon as the Asset Action is completed, together with the respective error 
messages. 

Clicking Reveal in collection displays these assets in a collection of its own for further 
processing.

Clicking Ignore closes the window without any further action.
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Cumulus Trigger
A Trigger is a stored procedure that is activated automatically when a specified event 
occurs. Typically, there are three event types that activate Triggers: delete, insert or 
update (see below). Triggers can be used to perform many tasks, such as auditing cat-
alogs, records and categories. Cumulus Triggers complement the capabilities of the 
Cumulus Scheduler. The Scheduler might cause an event that activates a Cumulus 
Trigger. 

Triggers can be set for catalogs, records and categories. 

Once set, a Cumulus Trigger can be temporarily disabled (deactivated) and enabled 
(activated) again. This can be very useful when testing a configuration, or when 
searching for errors.

Cumulus Triggers are defined by:

• Events — The event that will activate the Trigger.
• Trigger Actions — The function that will be performed when the Trigger is acti-

vated.
Trigger events for a catalog can either affect the catalog itself (updated Catalog Set-
tings), or all records or categories of the catalog. 

Event types that can be chosen for all records or all categories of a catalog are:

• Item Deleted — A record or category of the catalog was deleted.
• Item Inserted — A record was added or a category created.
• Item Updated — The value of a record field or a category field has changed. 

(Whether this refers to any field or to a specific field can be chosen as well. So the 
change of the value of a specified record or category field can activate a trigger.)
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Similar event types can be chosen for selected records or categories. Event types set for 
a selected category or record are:

• Item Deleted — The selected record or category was deleted.
• Item Updated — The value of a record field or a category field has changed. 

(Whether this refers to any field or to a specific field can be chosen as well. This 
means that the change of a value of a specified record or category field can acti-
vate a trigger.)

The Trigger Actions available depend on the Cumulus Server you are connected to. 
Available actions are stored in a special folder. The following preconfigured trigger 
actions are included:

• Apply Metadata Template: a specified metadata template is applied when the 
action is triggered by any event

• Apply Permissions Template: a specified permission template is applied when the 
action is triggered by any event

• Mail Notifier: an email is sent to one or more specified recipients when the action 
is triggered by any event. 

• Rename Asset: the asset is renamed when the action is triggered by any event.
• Run Asset Action: a specified asset action is performed when the action is trig-

gered by any event.
• Start Workflow: a specified workflow is started when the action is triggered by an 

Item Updated event, and a specific condition defined by a query is met.
Note that such a query must be created manually. It is not possible to use a previ-
ously saved query! The most convenient way to create a query is to compose it in 
the Cumulus Desktop Client’s Find window in Advanced Mode, then copy it into 
the Query to match field of the Configure Module window.
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BACKGROUND INFO:  More Trigger Actions 

The Trigger Actions are based on modules which are implemented as ESPs. If 
you want to have more Trigger Actions available, contact Canto Professional 
Services or your Canto partner on how to develop an ESP that ’shows up’ as a 
Trigger Action.

PRECONDITIONS: Triggers can be created, edited or enabled/disabled only by users 
who are allowed to do so. To edit or create triggers, the user needs – depending on 
the kind of trigger – one or all of the following permissions:

• Manage Catalog Triggers 
• Manage Record Triggers 
• Manage Category Triggers 
These permissions are set for the user in the User Manager (Permissions > Application 
Permissions.) With Enterprise, these permissions can also be set as Record or Category 
permissions for selected records or categories. Remember that Record or Category 
permissions for selected records or categories expand the record or category permis-
sions a user has for the catalog in general.

The Trigger Administrator permission (set under Permissions > Administrator Per-
missions) allows a user to manage all triggers for a catalog. A user with this permission 
gets an additional option displayed in the Properties dialog for a record, category or 
catalog, Show All Triggers. If this option is enabled, all triggers are displayed to the 
user as well as an additional column displaying the name of the user who ‘owns’ the 
trigger (i.e., the user who created it.)
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Setting Up Triggers for Records and Categories
To set up triggers for selected records/categories:

1. Select one or more records/categories.

2. Open the context menu for these records/categories (with the right mouse 
button /  Control key + mouse) and select Properties. The Properties dialog 
window opens.

3. Click the Triggers tab. 

The Triggers tab displays the triggers you have set up.

NOTE: Show All Triggers
If you have the Trigger Administrator permissions, the Show All Triggers option 
is available to you. If this option is enabled, the Triggers tab displays all triggers 
defined for the catalog where the record/category resides. 

4. Click Add. Add Trigger dialog appears. It lists the available event types. 

5. Select the type of event that activates the trigger. 

6. The next steps depend on the selected type of event. 

• If you select Item deleted, the trigger is activated when the selected record or 
category is deleted. Click Next. Continue with step 7.

• If you select Field Value Changed, the trigger is activated when the value of a 
field of the selected record or category has changed. To define this field, click 
Next. This opens a dialog that allows you to selecting a specific field. 

• If you want changes in any field to activate the trigger, click Next and continue 
with step 7.
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• If you want only a certain field to activate the Trigger, activate the Wait for 
changes in a specific field option. This lets you select a specific field.
Select the field.

NOTE: Triggers can be based on specific field values. Then the Trigger will react 
when the field value is changed to a predefined value. To make use of this fea-
ture and define such a value, activate the option Wait for Specific Condition 
and then click Configure. This opens a dialog that lets you define the value 
which you want the Trigger to react to. 

Set up your condition and click OK to save the condition. 
Click Next. 

7. A window for selecting the Trigger Action is opened. 

Select the action you want performed when the event for this trigger occurs.

8. The next steps depend on the selected Trigger Action. 

• If the selected action can be configured, click Next. This opens a dialog to con-
figure the action. (For details on how to configure the Mail Notifier action, see 
“Configuring Trigger Actions” .)

• If no more configurations are required, a Close button is displayed.
9. Click Close. The Trigger is registered with your Cumulus installation and acti-

vated.

NOTE: Cumulus Triggers can be temporarily disabled, and enabled again, via 
the Deactivate / Activate button, e.g. for testing a configuration or searching 
for errors.
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Setting Up Triggers for Catalogs
To set up triggers for a catalog:

1. In the category pane select the category that represents the catalog. (TIP: Catego-
ries that represent catalogs are displayed in bold.)

2. Open the context menu for these records/categories (with the right mouse 
button /  Control key + mouse) and select Properties. The Properties dialog 
window opens.

3. Click the Triggers tab. 

The Triggers tab displays the triggers you have set up.

NOTE: Show All Triggers
If you have the Trigger Administrator permissions, the Show All Triggers option 
is available for you. If this option is enabled, the Triggers tab displays all triggers 
defined for the catalog. 

4. Click Add. The Add Trigger dialog opens and prompts you to select the source 
for events to be selected. 

5. Select the source, either Catalog Events (events performed on the catalog itself, 
e.g. updated Catalog Settings), or Record Events or Category Events (events on 
all records or all categories of the catalog, e.g. inserted, deleted or updated 
records/categories). 

6. The Add Trigger dialog lists the event types available for the selected source and 
prompts you to select one.. either:

• Item deleted (step 7), OR 
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• Item added (step 8), OR 
• Field Value Changed (step 9)

7. Item deleted activates the Trigger when a record or category is deleted from the 
catalog. Click Next and continue with step 10.

8. Item added activates the Trigger when a record or category is added to the cata-
log. Click Next to configure this event:

• Select In Any Field if the Trigger shall be activated for every new item. 
Click Next and continue with step 10.

• Select Wait For Value in a Specific Field if the Trigger shall be activated for new 
items, but only if a specific field has a value, then select the respective field. If 
desired, additionally activate the option Wait for Specific Condition and click 
Configure to define a field value that must be met for the trigger to be fired.
Click Next and continue with step 10.

9. Field Value Changed activates the Trigger when the value of a record field or cat-
egory field is changed. Click Next to define this field. 

• Select In Any Field if the Trigger shall be activated by changes in any field. 
Click Next and continue with step 10.

• Select Wait For Changes in a Specific Field if the Trigger shall be activated only 
by changes in a specific field, then select the respective field. If desired, addition-
ally activate the option Wait for Specific Condition and click Configure to 
define a field value that must be met for the trigger to be fired.
Click Next and continue with step 10.

10. A dialog for selecting the Trigger Action – the action that is to follow the event – 
is opened. 

Select the action you want performed when the event for this Trigger occurs.
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11. The next steps depend on the selected action. 

• If the selected action can be configured, click Next. This opens a dialog to con-
figure the action. (For details on how to configure the Mail Notifier action, see 
“Configuring Trigger Actions” .)

• If no more configurations are required, a Close button is displayed.
12. Click Close. The trigger is registered with your Cumulus installation and acti-

vated.

NOTE: Cumulus Triggers can be temporarily disabled, and enabled again, via 
the Deactivate / Activate button, e.g. for testing a configuration or searching 
for errors.
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Configuring Trigger Actions
The Trigger Actions available depend on the Cumulus Server you are connected to. An 
action available by default is Mail Notifier which will send you an email when the 
action is triggered. If you select the Mail Notifier as Trigger Action when setting up a 
trigger, the following configuration dialog is displayed:

You can select the language of the message sent (the text is included in the Mail Noti-
fier ESP.) If you have the Browse for Users permission, you can determine whether 
other Cumulus users get an email as well. If you want other users to get emails, click 
the Add User button to select them. 

You can search for the login names of available users. Enter the search value (a match-
ing string) and click the Find button. The result of this search is listed below. Select the 
user(s) you want and click OK. The users are added.

TIP: for the User Administrator:

The Browse for Users permission is set under File > Admin > Server Console > 
User Manager > [User] > Server Permissions > User Administrator Permis-
sions.
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Cumulus Scheduler
The Cumulus Scheduler enables you to define and schedule tasks to be automatically 
performed by Cumulus. It will save you time and increase your productivity by auto-
mating frequent tasks. The Scheduler enables you to run time consuming functions 
during off-peak hours, and also enables you to automate routine tasks. In combination 
with the Cumulus Trigger feature, the Cumulus Scheduler makes a powerful tool to 
automate business processes and save wasted resources.

The Cumulus Scheduler consists of the Scheduler Manager and the Scheduler Server 
Application. The Scheduler Manager lets you set up tasks that are to be performed by 
the Scheduler Server Application.

The Scheduler Manager utility is included in the Cumulus Server Console. For more 
information on the Cumulus Scheduler, see “Scheduler Manager” .
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Managing Related Assets
Cumulus can manage related assets and provides a user interface that displays these 
relations and also enables the user to determine relations between assets. 

Relation Types
Relations can be different, there are hierarchical and flat relations. In a hierarchical rela-
tion one is special, it might be the master or the preferred one, it might be the source... 
By default, following types of hierarchical relations between assets are supported by 
Cumulus:

1. Contain/Contained – An asset contains other assets: e.g. a Zip archive, a Power-
Point presentation that contains slides, an InDesign or PDF document that con-
tains pages.

2. References/Referenced – An asset includes references to other assets: e.g. a Pow-
erPoint presentation or an InDesgin document that includes references to the 
images on the slides/pages.

3. Variants – Assets derive from the same source asset: e.g. the PDF of a Word docu-
ment, an image stored in different file formats or renditions of an image (for 
example cropped or with a filter employed.)

NOTE: Whether variants and alternates are available with the current catalog 
depends on the catalog’s settings defined by your Catalog Administrator.
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4. Alternates – Assets that you want to group concerning a certain topic and for 
which you have a preferred one that you want to represent the others. (For exam-
ple, you have a series of images on the same topic and the preferred one is the 
one you decided to use for your current project.)

In addition to these relations, a CumulusCatalog Administrator can add other hierar-
chical relations to a catalog – so called custom relations.

And in addition to hierarchical relations, you might want to determine groups of 
’equal’ assets. Assets that you want to group concerning a certain topic, theme or task 
but to which you don’t want to designate a preferred member. Cumulus offers sup-
port for this demand: assign the assets to the same category. However, this well-
known way of defining groups is included in the Cumulus management for related 
assets (referred to as relation type 5). 

Another type of relation between assets is the versions managed by a Version Control 
System (e.g. Cumulus Vault). Support for this type of relation is not yet included in the 
Managing Related Assets concept of Cumulus. Use the Version History window to 
have the versions displayed. (See “Managing Versions”, for details.)
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Different Relations between Assets
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How does Cumulus Know about Relations between Assets?
1. Contain – The Cumulus Asset Storage modules detect if an asset contains other 

assets when the asset is cataloged.

2. References – The Cumulus AXR (Asset Cross References) function detects if an 
asset includes references to other assets when the asset is cataloged.

3. Variants – The user can determine that an asset derives from a source asset or 
Cumulus can ascertain that automatically if the deriving asset was created using a 
Cumulus function.(For a description on how to determine such a relation, see 
“Assigning Variants” .)

4. Alternates – The user can create groups of alternate assets. An asset is determined 
as an alternate by assigning it to the’preferred alternate’. (For a description on how 
to determine such a relation, see “Assigning Alternates” .)

The information on an asset’s relations is stored in the asset’s record.

SPECIAL TECH INFO:  Record Fields for Storing

The information on an asset’s relations is stored in the record fields Related 
Master Assets and Related Sub Assets. The field Related Sub Assets stores the 
information which assets are contained, referenced, deriving, or alternates. 
Whereas the field Related Master Assets stores the information in which other 
assets the asset is contained in, referenced by, derives from, or which asset is its 
preferred alternate.
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Example of Several Relations Between Assets
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Supporting AssetStores 

Following AssetStores can create records for “contained” items: 

Asset Store Items Asset Store  Items

Apple iWork Pic-
ture 

Images Office Open 
XML 
Pictures and 
Media

Images, media

Apple Keynote 
Slides

Slides (pages) Open Docu-
ment 

Images

HELIOS XPV Pages; QXP Pages 
(but D&D not pos-
sible)

PDF** Pages

InDesign Pages (but D&D 
not possible)

PDF Image** Images

Mac Binary Assets QXP Pages, layouts

MS PowerPoint Slides (pages) QXP Server** Pages, layouts 
(but D&D not 
possible)

MS PowerPoint 
Picture 

Images Video** Shots

Office Open XML 
Pages and Slides

Pages, sheets, 
slides

ZIP Assets

** with Options only (not included in any standard edition/solution)
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How does Cumulus Display Relations between Assets?
In a split view: an additional pane can be opened up below the Record pane. The addi-
tional pane displays the records that are related to the record selected in the main 
Record pane. How the assets of the additional pane are related to the selected record 
is determined by the display option that is set for the additional pane. 

So, having related assets displayed is as easy as: select a record, open up a sub-pane 
and select what you want to see in it. 

You can select multiple assets in the upper pane and you can open up multiple sub-
panes. Each sub-pane will display those assets that are related to the selection in its 
upper pane. How they are related is determined by the selected display option.If the 
selection in the upper pane changes, the content of the sub-pane is synchronized. It 
changes simultaneously.

To open up a new sub-pane: Click the  button of the current sub-pane. To close a 
sub-pane: Click the  button of the pane. To refresh the display of a sub-pane: Click 
the  button of the pane. 
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TIP: Resizing Panes

You can resize the panes by pressing the ALT / Option key and dragging 
the split bar. (Just clicking the split bar will resize the main pane and the sub-
pane of the dragged split bar only.) 
Collapsing: Pressing the ALT / Option key and double-clicking in a pane’s 
statusbar will collapse the pane so that the statusbar only is displayed and the 
pane above will fill the area. (Just double-clicking lets the pane above remain 
its size and the main pane will be enlarged.) A double-click on the statusbar of 
the main pane (topmost pane) will collapse all panes below.
Expanding: Pressing thethe ALT / Option key and double-clicking in a col-
lapsed pane’s statusbar will expand the pane again – using space from the 
above pane. (If you just click it – without the ALT / Option key – the pane 
will be expanded using space from the main window.) A double-click on the 
statusbar of the collapsed main pane will expand all panes below.
Minimizing: Double-clicking a pane’s split bar minimizes the pane or resizes it 
again.

For each pane you can choose the view, the sorting direction and an option for the 
content to be displayed. How the displayed assets are related to the asset selected in 
the upper pane is chosen from a menu that offers the following options by default:
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The list options can be renamed, configured and assigned to specific users. The list 
options are configured via Sub-Pane Filter definitions. So you can customize it in 
wording and include search strategies for individual tasks. Sub-Pane are created and 
edited in the Preference dialog window ( Cumulus / Edit > Preferences > Sub-
Pane Filters.) For details on how to set up a Sub-Pane Filter, see “Sub-Pane Filters” . The 

RELATION 
TYPE

Display options are: 

0 Selected Asset

1 Contained Pages/Slides

Contained Assets

Container Asset

2 All Referenced Assets

Referencing Documents

Referencing Pages/Slides

3 All Variants

Variant Source 

Top Level Variant Source 

4 – All Alternates

– Preferred Alternates

5 – Assets Assigned to the Same Categories
– Assets Assigned to at least One Same Category
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availability of Sub-Pane Filters for users is defined with the User Manager in the each 
user’s properties.

You can get information on the different relations of an asset in the Info view or Asset 
Info window. If the fields Related Sub Assets and Related Master Assets are added to 
the corresponding view settings (and given more than 1 line), for each type of relation 
a tab is provided that displays the names of the related assets.

What Else do You Need to Know? 

In the split view, Cumulus can only display related assets that are cataloged to the 
same catalog as the one selected. That’s why it is recommended that you use a simple 
collection and not a multi-catalog collection when your work includes the relation 
aspect.

Display of Master Assets Only

You don’t want to see any contained or referenced assets in the main pane? You want 
to see only the preferred alternate and not the others? Cumulus can help you. It pro-
vides a special display option for the main Record pane. You can have records of ’mas-
ter assets’ displayed only. What are ’master assets’?

A ’master asset’ is defined by: 

• not contained in any other
• not a variant of
• preferred alternate or no alternate of 
The main Record pane provides the  button that lets the main pane display records 
of master assets only. If you activate this button, your current collection will be filtered 
and only the master assets of the collection are displayed. Further search results will 
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only display master assets. If you deactivate the button, your collection remains in its 
’filtered’ version but further search results will display all matching assets again – 
whether they are master assets or not.

SPECIAL TECH INFO:   Master Only button

The button can be activated only if the Related Master Assets field is indexed 
for Contain Search. Reason: The search that is started by this button checks the 
contents of the Related Master Assets field. 
NOTE for Migration: The field Related Master Assets must be included in the 
catalog(s) and indexed for Contain-Searching.
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Assigning Relations Manually
You can manually assign variants to an asset or group alternates of assets. In addition 
to that you may have other relations that your Catalog Administrator has created – so 
called custom relations.

Assigning Alternates

You can manually group alternates of assets. When you group them as alternates you 
have to determine one as the preferred alternate. 

Select the records of the assets you want to become alternates and select Metadata 
> Assign Relation > Alternates. Then a message prompts you to select the preferred 
alternate. Select the record you want to be the preferred alternate (master) and click 
OK.

To delete such relations you must delete the corresponding entries in the Related Sub 
Assets and Related Master Assets fields from the Alternates tab in the Information 
window or view.

To get the alternates of an asset listed, use the split view and an according list option 
(Sub-Pane Filter). For more information, see “How does Cumulus Display Relations 
between Assets?” .

Assigning Variants

You can manually assign variants to an asset. The asset you assign them to is called the 
source of the variant. 

Select the records of the assets you want to assign as variants to a source asset and 
select Metadata > Assign Relation > Variants. Then a message prompts you to select 
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the source. Select the record you want to be the one assigned as the source of the vari-
ants (master) and click OK.

To delete such relations you must delete the corresponding entries in the Related Sub 
Assets and Related Master Assets fields from the Variants tab in the Information win-
dow or view.

To get the variants of an asset listed, use the split view and an according list option 
(Sub-Pane Filter). For more information, see “How does Cumulus Display Relations 
between Assets?” .

Assigning Custom Relations

You can manually assign custom relations to assets. Custom relations are defined by 
your Catalog Administrator for the current catalog.

Select the records of the assets you want to become related and select Metadata > 
Assign Relation and then the desired relation type. A message prompts you to select 
the master asset. Select the record you want to be the master and click OK.

To delete such relations you must delete the corresponding entries in the Related Sub 
Assets and Related Master Assets fields from the tab in the Information window or 
view that is named as the relation type.

To get the alternates of an asset listed, use the split view and an according list option 
(Sub-Pane Filter). For more information, see “How does Cumulus Display Relations 
between Assets?” .

For more information watch the video tutorials Using Asset Relations and Configuring 
Asset Relations.

http://edge-cdn.net/video_929298?playerskin=38685
http://edge-cdn.net/video_929242?playerskin=38685
http://edge-cdn.net/video_929242?playerskin=38685
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AXR
AXR (Asset Cross References) is the automatic detection of usage and cross-references 
of assets within Cumulus. Cumulus is able to detect links and placed assets in com-
pound documents such as Adobe InDesign, EPS and Illustrator (version 8, 9) as well as 
Microsoft Word and PowerPoint documents. 

AXR requires that the filter employed for cataloging must support AXR (e.g. Com-
pound Document, EPS and InDesign filters). AXR works for assets that are managed by 
the same catalog only. 

With a standard Workgroup installation the referenced assets must be cataloged 
before Cumulus can detect them in a compound document. The existence of the field 
Related Sub Assets is required for the information in the field Related Master Assets. 

TIP: Re-cataloging

If the field Related Sub Assets was not one of the record fields of the catalog 
when cataloging, you can employ the menu item Update Record from the File 
menu to re-catalog the assets.

With Enterprise or a corresponding add-product you make use of the AXR cataloging 
option. (For details, see below.) 
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Automatic Cataloging of Referenced Assets
However, there are differences between AXR with a standard Workgroup installation 
and with an Enterprise or an enhanced Workgroup installation. With Enterprise or 
Workgroup enhanced with the corresponding add-on product, AXR provides the 
option that referenced assets can be cataloged automatically when detected by AXR. 
To have referenced assets that are not included in a catalog, cataloged automatically 
is defined in the Asset Handling Set. If you use an Asset Handling Set with the option 
Also Catalog Referenced Assets not yet Cataloged activated when cataloging an 
asset that contains references, the referenced assets will be cataloged automatically 
with the same cataloging process. 

TIP: Add Only in combination with AXR Also Catalog Referenced ... 
activated!

If you use the Add Only option and activate the Also Catalog Referenced 
Assets not yet Cataloged option, you should also have the Skip Duplicates 
option activated. Otherwise Cumulus will catalog the referenced assets twice, 
if the referenced assets come later in the sequence of the selected assets than 
the asset that contains the references.
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Automatic Tagging of Assets
Automatic Tagging brings the power of artificial intelligence (AI) to Cumulus. With this 
optional Cumulus feature, external image recognition services can be configured to 
analyze your assets. As a result, the services provide a number of tags denoting the 
contents of the images. These tags will be added to the metadata of the assets – that 
is, written into the catalog fields that have been specified for this purpose. The tags 
can be used e.g. as keywords (as categories under the $Keywords tab), or as descrip-
tions, or captions, etc. Enriching your assets with automatically generated tags makes 
exploiting your stock more effective and ensures that you find the proper assets for 
any purpose more easy and in even less time. 

The Automatic Tagging feature can be evoked manually via a menu command, or via 
a dedicated Scheduler task.

PRECONDITIONS: Automatic Tagging is an optional Cumulus feature. A license must 
be purchased, and activated via the Remote Admin module of the Cumulus (Web) 
Server Console. Additionally, a valid account with one of the supported Automatic 
Tagging providers must exist.

For details on how to set up Automatic Tagging support in Cumulus and the prereq-
uisites that must be met, see Automatic Tagging Setup.
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Manually starting the Automatic Tagging
To manually start the Automatic Tagging:

1. Select the records of the asset you want to tag automatically.

2. Select Metadata > Run Automatic Tagging. A confirmation dialog is displayed. 
Click Yes to continue.

The Automatic Tagging process may take some time. When it is finished, the tags for 
each of the selected assets are written into the field(s) that are configured to contain 
them. 

Using the Scheduler to start the Automatic 
Tagging

If you want to start the Automatic Tagging feature on a regular schedule with the 
Cumulus Scheduler, an appropriate Scheduler task must be configured (see Scheduler 
Task). 

The Cumulus Scheduler reads the content of a specific catalog field, Automatic Tag-
ging Request. If the value of this field is Analyze, the Scheduler evokes the Automatic 
Tagging process. When this process is finished, the value of the Automatic Tagging 
Request field is changed to Review, thus indicating that it might be wise to review the 
results received from the Automatic Tagging service. 
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To use the Scheduler for Automatic Tagging assets the assets must be prepared

1. Make sure to set the value of the Automatic Tagging Request field to Analyze, for 
all assets you want to automatically tag. This can be done by directly editing the 
assets’ metadata as well as by applying a Metadata Template, either while catalog-
ing assets, or anytime later (see Using a Metadata Template).

Automatic Tagging Log

Messages from the Automatic Tagging server (if any) are written into the Automatic 
Tagging Log catalog field for each asset that has been selected for Automatic Tag-
ging. Which messages are written into this field depends on the Log Level configured 
via the Automatic Tagging module of the Web Server Console. Whether the Auto-
matic Tagging Log is visible to you depends on the configuration of the used Record 
View Set.
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Specialized Usage

This chapter covers Cumulus functions that help you with special tasks. It includes

descriptions on how to work with the revision control system Cumulus Vault and the

URL AssetStore, how to work with Microsoft Office and Adobe InDesign documents

within Cumulus, and how Cumulus supports you working with images by maintaining

raw image formats of digital cameras.

The last section of this chapter describes how to assign individual permissions for

records and categories.

The topics of this chapter include:

• Using Vault

• Using URL AssetStore

• Working with Images

• Working with the Video Cloud

• Using the Media Delivery Cloud

• Working with Office Documents
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• Working with InDesign Documents

• Assigning Individual Permissions for Records and Categories
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Using Vault 
Cumulus® Vault is a revision control system that gives your workgroup added data 
security and up-to-the-minute information on the status of each asset. As its name 
suggests, Vault enhances the security of your team’s assets – controlling who accesses 
them, how and when. It also gives you more ways working with your assets in 
Cumulus, providing version retention and tracking, at-a-glance version information, 
and integration into the existing Cumulus environment.

Cumulus Vault can control and monitor access to all assets. Think of it as the Cumulus 
librarian. Users check assets out for editing and check them back in again when they’re 
through. Vault allows only one user at a time to check out an asset. This prevents it 
from being edited by multiple persons simultaneously, possibly resulting in conflict-
ing – and confusing – versions of the asset. If another user attempts to check the asset 
out, Vault informs the would-be editor which user is working on the file. 

When a user checks an asset back in, Vault saves the updated file as a new version 
without overwriting previous versions. It keeps all back revisions, making it possible to 
track changes to an asset during the production cycle – a concept referred to as a ver-
sion control system. It also provides information on all versions: Who made the 
changes? When? With Vault, these questions are easy to answer, making last week’s 
edits just as accessible as today’s.
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Organization
This chapter is one of two descriptions that cover Cumulus Vault:

• This description, which covers using it to track and control access to assets, and 
integrating it into your Cumulus environment.

• A description, which covers how to set up the Vault Server and how to configure 
catalogs to work with Cumulus Vault. This description is included in the Adminis-
trator Guide.

This chapter covers everything you need to know about working with Vault in the fol-
lowing sections:

• Working with Vault – Gives you the basics on placing assets under Vault’s control, 
checking them in and out, and managing asset versions. 

• Integration – Describes the effects Cumulus Vault has on existing Cumulus func-
tions, and how you can integrate these new options into your existing workflow. (
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Working with Vault
This section covers the basics of working with Cumulus Vault. It describes how to place 
your assets under Vault’s control, and then how to work with Vault to check these 
assets in and out. It goes on to explain how you can view and manage the versions 
resulting from these check in/check out procedures. Once you’ve mastered these 
functions, you’ll be ready to take advantage of the capabilities offered by Cumulus 
Vault.
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Assets Controlled by Vault
Whether or not cataloged assets are controlled by Cumulus Vault depends first of all 
on whether the catalog that manages them is set up to work with Vault. If your 
Cumulus Administrator sets up a catalog to work with Vault, assets can be placed 
under Vault’s control when they are added (i.e., cataloged) to that catalog. During the 
cataloging process, Cumulus hands the assets over to the location that Vault controls.

Your Cumulus Catalog Administrator sets up a catalog to work with Vault in one of the 
following ways:

• Always – whenever users catalog assets to that catalog, they are handed over to 
Vault. In this case, all you need to do is catalog the assets. (See the Cumulus Client 
User Guide for information on cataloging assets.)

• As Set in Asset Handling Set– users decide before cataloging assets whether or 
not the assets should be handed over to Vault. (See “Cataloging to Vault as Defined 
for the Employed Asset Handling Set,” below, for details.)

• Always and Exclusive – whenever users catalog assets to that catalog, they are 
handed over to Vault and their asset storage location is Vault exclusively. In this 
case, all you need to do is catalog the assets. 
For your information: A catalog that is set to the Always and Exclusive option has 
a forced 1-to-1relation with Vault: every record in the catalog represents an asset 
stored in Vault and each asset in the Vault folder assigned to this catalog is repre-
sented by a record in this catalog. This is the guiding principle for all functions per-
formed. For example, this means that assets managed by this catalog cannot be 
moved and that deleting the records which are representing them will always 
delete the assets as well.
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NOTE: Catalog Housing Records from a Vault Exclusive Catalog!
If you have another catalog housing records that derive from a catalog set to 
Always and Exclusive, the permissions you have on these records (and their 
assets) are the permissions you are given for the catalog the records derive from. 
For example: you have all permissions for catalog A but if catalog A houses 
records from catalog B which is a Vault exclusive catalog, then the permissions for 
records may differ if you don’t have the same permissions for both catalogs. 

If you don’t know which of your workgroup’s catalogs are set up to work with Vault 
and how, ask your Cumulus Administrator. You should also ask your Cumulus Admin-
istrator which Asset Handling Sets were adjusted for the use with Vault. The Asset Han-
dling Sets you use with Vault must have the Asset Storage module Vault AssetStore 
activated. And if a catalog is set to let each user decide whether cataloged assets 
should be placed under Vault’s control or not, the Copy to Central Asset Location 
option must also be activated. If working with assets stored in Vault, you should take 
care that the Asset Handling Sets defined in your User Settings for cataloging and 
asset access are adjusted for the use with Vault. Asset Handling Sets also include the 
Vault settings for version handling. For details on how to set up Asset Handling Sets 
for version handling, see “Defining Asset Version Handling” .

If you’ve already cataloged assets to a catalog before it was placed under Vault’s con-
trol, and now want to hand them over to Vault, you can do that, too. You don’t have 
to re-catalog them, but can simply move them to the location which Vault stands 
guard over. To find out how, see “Adding Already Cataloged Assets to Vault” below.
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Cataloging to Vault as Defined for the Employed 
Asset Handling Set

For each catalog, the Cumulus Administrator has the option of letting Clients specify 
which assets should be cataloged to Vault. In this case, Clients can specify whether or 
not the assets will be placed under Vault’s control by selecting a corresponding Asset 
Handling Set. If you select an Asset Handling Set that has the Copy Asset to Central 
Location Option activated, the assets will be placed under Vault’s control. If this option 
in not activated, the assets will not be placed under Vault’s control.

To view the settings for cataloging of an Asset Handling Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want to view.

4. Click Cataloging.

5. Check whether Copy Asset to Central Location under Central Asset Location is 
activated.

If activated, Cumulus will add the assets to the catalog and copy them to the 
Vault location when this Asset Handling Set is used for cataloging (and if the cata-
log is set up for Vault).

However, you should also check that the Asset Storage module Vault AssetStore is 
activated (click Modules and then Asset Storage).
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Adding Already Cataloged Assets to Vault
Just because your Cumulus Administrator has set up a catalog to work with Vault, it 
doesn’t necessarily mean that all of that catalog’s assets are controlled by Vault. For 
example, assets may have already been cataloged to the catalog before it was set up 
to work with Vault.

In this case, users have the option of placing already cataloged assets under Vault’s 
control. The assets don’t have to be re-cataloged, but can simply be moved to the 
location guarded by Vault.

To add already cataloged assets to Vault:

1. Open the catalog whose assets you would like to add to Vault. 

2. Select the record(s) representing the asset(s) you would like to hand over to Vault.

3. Select Asset > Move To.

The Select AssetStore Module dialog appears.

4. Select Vault AssetStore and click OK.

The Select Remote Module dialog appears.

5. In the Computer field, select the computer running the Vault Server and click OK. 

Cumulus moves the selected assets to Vault, where they are now subject to 
access and version control.
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Checking Assets In and Out
These two steps form the basis of the Cumulus Vault concept. They ensure that only 
one person can edit an asset at a time, and also provide the version information asso-
ciated with each asset. If you check an asset out but don’t need to check it back in as 
a new version, you can undo the check out (see “Undoing a Check Out” ).

Checking Assets Out

When you check an asset out, Cumulus places a copy of the latest version in a location 
you specify and locks the associated record in the Cumulus catalog for other users. 
You can then edit the copy you checked out, and later check it back in as a new ver-
sion.

There are two things that you will be prompted to tell Cumulus when checking assets 
out:

• Which Asset Storage Module should be used to manage the access to the asset’s 
destination location. The destination location is typically the file system – such as 
the Windows or macOS file system – to which the checked-out asset will be cop-
ied. The destination is not Cumulus Vault.

• Where exactly in the destination location the copy of the asset should be placed, 
i.e., the specific folder on your hard disk or network.

If another user has already checked the asset out, you will not be able to check it out 
to yourself. In this case, Cumulus Vault informs you who has the asset and when it was 
checked out. If you would like to see whether or not assets are checked out without 
having to attempt a check out yourself, you can add the respective fields to your Col-
lection and/or Asset Information view. For details, see “Viewing Asset Status” .
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To check assets out:

1. Select the record(s) representing the asset(s) you would like to check out.

2. Select Asset > Check Out. 

If you have defined a Check out Location in the Application Preferences 
(Cumulus/Edit > Preferences > User Settings > General > Application), 
Cumulus makes a copy of the latest version and inserts it in the defined location. 
The asset is checked out and you can start editing it.

If you have no defined Check out Location, continue as follows. 

The Select Asset Storage Module dialog appears. This is a list of available Asset 
Storage Modules. One is Cumulus Vault, and others include the file system you are 
currently using (such as the Windows or macOS File System, among others). 

3. Select the Module for the destination location and click OK. 

NOTE: The destination is not Cumulus Vault. If you check the asset out to Vault, 
you will not be able to edit it! 

A window appears for you to select the target folder on the file system you 
selected.

4. Choose the desired folder and click OK.

Cumulus makes a copy of the latest version and inserts it where specified.

If you want to edit the asset now, open it with the application that created it and start 
editing.
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TIP: Edith With & View With

Cumulus offers you a convenient way of combining check out and launching 
the application for editing the asset. The procedure is the same as described 
above, except that you select Edit With instead of Check Out from the Asset 
menu. Cumulus recognizes that the asset is controlled by Vault and automati-
cally triggers a check out procedure. Once you’ve completed the check out 
steps, Cumulus launches the editing application and opens the checked-out 
asset in it. If you only want to view the asset without checking it out, use View 
With from the Asset menu.

Checking Assets In

When you have finished working with an asset and check it back in, Cumulus lets you 
enter comments on the new version (what sort of changes you made, etc.). It then 
moves the updated asset back to the Vault as a new version, and unlocks and updates 
the associated record in the catalog. Since a check in procedure moves the new ver-
sion into the Vault, that version is removed from the location you checked it out to.

To check an asset in:

1. Select the record(s) representing the asset(s) you would like to check in.

2. Select Asset > Check In.

The Version Comment dialog appears. The asset’s name and your user name are 
entered automatically. 
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You may enter your comments in the Comments field. If you want this comment 
to be used for further selected assets to be checked in, activate the Use for All 
Remaining Items option.

If the Keep Checked Out option is activated, the changed asset is copied to Vault 
as a new version but also left checked out. So you can continue working on the 
asset.

3. Click OK.

Cumulus moves the new version to Vault and updates the associated record in 
the catalog.

Checking an asset in moves the latest version to Vault. It doesn’t overwrite the previ-
ous versions, however, which are retained so that they can be viewed, tracked or used 
again. (See “Managing Versions,” below, for details.)

TIP: Drag & Drop

Cumulus gives you a quick and easy alternative to checking assets in via menu 
command: simply dragging and dropping the asset from your desktop into the 
associated catalog. Cumulus recognizes the checked-out asset and automati-
cally triggers a check in procedure.

Undoing a Check Out

If you check an asset out and then realize that, for whatever reason, no changes are 
necessary, you can return it to Vault without checking it in as a new version. You simply 
need to undo the check out.
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When you undo a check out, Cumulus deletes the asset from the location you checked 
it out to and unlocks the record in the catalog, but does not move the asset back to 
Vault or update the record.

To undo the check out of an asset:

1. Select the record representing the asset you previously checked out.

2. Select Asset > Undo Check Out.
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Managing Versions
With your workgroup constantly checking assets out, editing them, and checking 
them back in, it would seem easy to lose track of the many different versions. To avoid 
such confusion and to guarantee a hassle-free workflow, Cumulus provides the ability 
to manage different versions of assets – but only if you employ versioning (for details 
on how to set up versioning, see the Administrator Guide). 

Via the Show History function, you can get information on the versions of an asset, e.g. 
which version is the latest, who has edited the asset and when, and the comments 
that the users made on their versions. Furthermore, you can:

• Edit the information included with each version
• Delete any versions you no longer need—thus saving storage space
• Designate an older version of an asset as the current version
• View (and compare) versions in full screen preview

Viewing an Asset’s Version History

To view the version history of an asset and to manage the respective versions: 

1. Select the record representing the asset whose version history you want to view.

2. Select Asset > Show History. The Version History window opens.

The columns in the Versions list display the following information:

• Version – the number of the version. The higher the number, the later the version.
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• Date – the date and time at which the version was checked in.
• User – the user who checked that version in.
• Comment – any comments the users who were checking in made.
Since the Comment column is limited in space, the full text of a comment is provided 
in an area below the table. 

Actions that can be performed on versions:

Click Delete to delete the selected version(s). Since every version of an asset is a file in 
itself, it’s often a good idea to free up disk space by deleting any versions you no lon-
ger need. Keep in mind that deleting the latest version makes the next-latest version 
the current version. If this is the case, Cumulus Server re-catalogs the “new” current 
version and updates the record representing it. Deleting all versions of an asset deletes 
the asset itself.

NOTE: You need to have permissions to delete records from a catalog in order 
to use this function. To find out if you have this permission, ask your Cumulus 
Administrator. 

Click Make Current to designate the selected version of an asset as the current ver-
sion. The version number will increment, even though the asset is not physically 
changed by the designation. 

NOTE: The function is implemented as virtual rollback’, which doesn't erase any 
previous version of an asset. 

Click Preview to open the selected version(s) in Fullscreen Preview (for details see 
“Fullscreen Preview” ) 
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NOTE: If the Fullscreen Preview is evoked from the Show History window, nav-
igation to other than the selected versions and the display of the Info Window 
are disabled!

Click Edit Comment to edit the comment of a version. The Version Comment win-
dow opens. Make your changes and click OK to save your changes and get back to the 
Version History window.

Click Done to close the Version History window.
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Integration
Cumulus Vault doesn’t just store and protect your assets—it also adds a new dimen-
sion to the way you manage your assets. This chapter explains the effects that working 
with Vault has on your asset management with Cumulus. It also gives you tips for tak-
ing advantage of these effects so that you can optimally integrate Cumulus Vault into 
your existing workflow.
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Asset Version Handling
Cumulus Vault expands the functionality of your base Cumulus installation. By retain-
ing and tracking assets in multiple versions, it adds a new dimension to your asset 
management solution.

This new dimension comes into play when you would like to preview, mail, copy and 
delete assets controlled by Vault. Since these assets may exist in multiple versions, you 
may have to make a choice between the different versions available.

Cumulus makes it easy for you to make this choice. It even enables you to pre-set your 
decision to best suit the way you work. If you want to preview, mail, copy or print an 
asset controlled by Vault, you can have Cumulus always get the latest version – with-
out asking you any further questions. Or if you’re more interested in a previous version, 
you can have Cumulus provide you with a list of all versions that are available – com-
plete with check-in times, users and comments – to make sure you get the right one.

You have a similar option when deleting assets. You can have Cumulus prompt you to 
select the version you would like to delete, or, if you’re trying to free up a lot of storage 
space at once, have Cumulus delete all versions without any further questions.

The sections that follow explain how to define these version settings and then use 
them when working with your assets.

Defining Asset Version Handling

When you use standard Cumulus commands to access assets controlled by Vault, the 
assets you access may exist in multiple versions. Which version you use is up to you – 
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but Cumulus provides the information to make the decision easy for you. You can 
even pre-set how you want these versions handled to best suit the way you work.

How asset versions should be handled is defined on the Cataloging tab of the Asset 
Handling Set you use to access the asset. (For the different options, see “Cataloging 
Tab” .)

Deleting Assets Controlled by Vault

One option for deleting asset versions from Vault is to use the Version History dialog 
(see “Managing Versions” ). To delete a record and its asset including all asset versions, 
use the Delete command in the Edit menu.

NOTE: You need to have permission to delete records from this catalog in order 
to use this function. To find out if you have this permission, ask your Cumulus 
Administrator. 

Previewing, Mailing or Printing Assets Controlled by Vault

To preview a version of an asset controlled by Vault:

1. Select the record whose asset version you would like to preview, mail or print.

2. Select Asset > Preview or Mail To or Print.

If your version setting is Always Get Latest Version, Cumulus opens the preview 
window with the latest version of the selected asset or mails or prints the latest 
version of the selected asset.
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If your version setting is Ask for Version to Get, Cumulus prompts you to choose 
the version you would like to preview/mail/print. Select the desired version and 
click OK to preview/mail/print it.
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Outside the Revision Control
While Cumulus Vault gives your workgroup a secure way to manage your asset ver-
sions, it may be more security than you need in every instance. For example, your 
workgroup could use an existing asset for a new project, but it’s currently locked up in 
the catalog of another project. Or, you may want to give samples of your latest work 
to a client. Since the client won’t be updating the assets and checking them back in, 
you wouldn’t want to check the assets out.

Cumulus gives you a couple of options for accessing assets outside of Vault’s control 
system: you can either get a copy of an asset version controlled by Vault, or you can 
move an asset out of Vault’s control entirely.

There are a couple of important things to keep in mind, however, if you decide to copy 
or move an asset directly out of Vault:

• Asset versions copied or moved out of Vault in this manner are not checked out, 
meaning they cannot be checked back in! If you want to update the asset and 
return it to Vault, you will have to re-catalog it, possibly resulting in multiple 
records representing different versions of the same asset.

• Moving an asset version out of Vault deletes all versions from Vault. Make sure you 
want to take this asset out of the revision control system before proceeding.

These functions give you extra flexibility when working with your Vault assets, but they 
also have the potential to undermine Vault’s access and version control. Make sure 
that you want to work outside of this control system before you proceed to copy or 
move.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE USING VAULT

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Copying an Asset Controlled by Vault

One way to get an asset out of Vault without checking it out is to copy it to another 
location (such as your hard disk). In this procedure, Cumulus simply makes a copy of 
the asset and inserts it wherever you specify. The asset is not checked out, and the 
associated record in the catalog is not locked for other users.

To get a copy of an asset controlled by Vault:

1. Select the record whose asset version you would like to copy.

2. Select Asset > Copy To.

If your version setting is Always Get Latest Version, Cumulus gets the latest ver-
sion of the asset for you to copy.

If your version setting is Ask for Version to Get, Cumulus prompts you to select 
the version to copy.

A list of available Asset Storage Modules appears. 

3. Select the Module for the destination location (not Vault) and click OK.

4. Choose the desired location and click OK.

Cumulus copies the latest/selected version to the location you specified.

Dragging and Dropping Assets Controlled by Vault

One way to get an asset out of Vault without checking it out is to copy it to another 
location using the Copy To menu command. An other way is drag and drop. To copy 
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any asset you can drag and drop a record into another drag and drop-supporting 
application. Dragging a record copies the asset into the target document. Dragging a 
record into the Windows Explorer or the macOS Finder copies the asset into the 
selected folder. When dragging and dropping an asset controlled by Vault it works the 
same, Cumulus simply makes a copy of the asset and inserts it wherever you specify. 
The asset is not checked out, and the associated record in the catalog is not locked for 
other users. And when dragging the record of a Vault asset, Cumulus always gets the 
latest version of the asset for you to copy. 

When dragging the record of a Vault asset into a target document of another drag and 
drop-supporting application, be aware that most applications need a path to the 
“dropped” file which Vault does not provide. In this case you should copy the Vault 
asset to your file system first and then place this copy into the application. 

When dragging the record of a Vault asset into a drag and drop-supporting applica-
tion that opens the asset, a temporary file will be created. Be aware that for Vault assets 
this is not the same function as the Edit With menu command where Cumulus recog-
nizes that the asset is controlled by Vault and automatically triggers a check out pro-
cedure. 

Moving an Asset out of Vault’s Control

Moving an asset out of Vault’s control destroys revision tracking and retention for the 
asset. The latest version will be moved out of the Vault location (to your hard drive, for 
example), and all versions will be deleted from that location. If you move it to a place 
that Clients cannot access, it will no longer be available to others in your workgroup. 

Cumulus does provide you with some protection in this case, however. When you 
move an asset from Vault, Cumulus updates the asset reference in the catalog to 
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“point to” the new location, i.e., the location you specified. Other users will still be able 
to see where the asset is located, even if they may not be able to access it. Remember, 
completing the following procedure deletes all versions of the asset from Vault. If this 
is not what you are trying to do, you may want to consider simply getting a copy of 
the asset (see “Copying an Asset Controlled by Vault,” this page).

To move an asset out of Vault’s control:

1. Select the record whose asset you would like to move.

2. Select Asset > Move To.

A list of available Asset Storage Modules appears. 

3. Select the Module for the destination location and click OK.

4. Choose the desired location and click OK.

Cumulus moves the latest version to the location you specified. It then deletes all 
versions of the asset from Vault.
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Viewing Asset Status
You can set up your catalogs to give you an at-a-glance view of whether or not assets 
are currently checked out and by whom, as well as who has previously edited the var-
ious versions. You do this by adding the fields that contain this information to one of 
the views.

The following sections describe which fields provide what information. For information 
on adding fields to a view, see “Adding a Field to a Record View” .

Viewing Asset Availability

You can immediately see whether or not an asset is checked out – as well as by whom 
and when – by using a Review Set that includes the fields that contain this informa-
tion. These fields are:

• Check out Date – contains the date and time the asset was last checked out. If the 
asset is not currently checked out, this field is empty.

• Check out User – contains the name of the user who checked the asset out. If the 
asset is not currently checked out, this field is empty.

Viewing Revision History

One way to view an asset’s revision history is from the Version History window, as 
described under “Viewing an Asset’s Version History” . You can also customize the view 
of a Record View Set to give you this information directly. If you add the field Version 
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History to either one of these views, you will be able to see right away how many ver-
sions exist as well as who edited each one.
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Using URL AssetStore
This chapter covers the basics of working with Cumulus URL AssetStore Module. It 
describes how to catalog assets from FTP or HTTP servers and how to work with them 
in Cumulus. Although the records of URL-cataloged assets behave just like any record 
which has been cataloged through the supported file systems – working with the 
assets themselves from within Cumulus is slightly different. 

This chapter also describes how to copy or move cataloged assets to FTP servers and 
how to set up the Central Asset Location for a catalog on an FTP server.
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Cataloging Assets from FTP or HTTP Servers
If you want to catalog from FTP or HTTP servers or to work with URL-cataloged assets, 
you must use an Asset Handling Set that has the Asset Storage Module supporting 
URL activated. If you want an Asset Handling Set to neither work with URL-cataloged 
assets nor to catalog from FTP or HTTP servers, you may want to deactivate the URL 
AssetStore Module. For details on how to activate or deactivate an Asset Storage mod-
ule for an Asset Handling Set, see “(De)activating Asset Handling Modules” .

There are two ways to catalog assets from FTP or HTTP servers: via menu item and with 
drag and drop. Let’s start with the menu item method. And remember: You need a 
fully licensed version of the URL AssetStore Module to catalog from FTP or HTTP serv-
ers.

NOTE: TAG Files!
Cumulus can create TAG files on an FTP server while cataloging, if the Metadata 
module Cumulus Metadata Support is activated for the employed Asset Han-
dling Set and the user, who catalogs, is allowed to save files on this FTP server. 
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Cataloging Assets via Menu Command
You can catalog employing any valid URL pointing to a file and starting with ftp:// or 
http://. But you may not use localhost as IP address. You may even catalog a folder but 
only if it is on an FTP server.

NOTE: User Authentication
Some FTP or HTTP servers require user authentication. In this case, the host 
address must be prefixed with a user name and password like “user:pass-
word@host”. For example, the complete URL then looks like “ftp://
smith:secret@server.com/path/file”. 

To catalog assets from FTP or HTTP servers via menu command:

1. Open the catalog to which you want to add the assets.

2. Select File > Add Assets To Catalog. 

If you are prompted to select an Asset Handling Set for this cataloging process, 
make sure, you select an Asset Handling Set that has the URL AssetStore acti-
vated.

If multiple Asset Storage Modules are activated in the employed Asset Handling 
Set a dialog appears. This lists the available Asset Storage Modules. One is the URL 
AssetStore, and others include the file system you are currently using (such as the 
Windows or macOS File System, among others).

3. Select the URL AssetStore and click OK. 

A window appears which asks for an URL.

4. Enter the URL for the asset file (or folder – on FTP only) you want to catalog.
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A window appears that shows the status of the cataloging process. 

After a moment, a thumbnail for the asset appears, indicating that the cataloging 
process was successful and a record has been created for the asset.

NOTE: If you catalog many or huge files, you can save time by deactivating the 
display of the cataloging progress. Before you start cataloging, disable the 
Show Progress Bar (General section of an Asset Handling Set definition, under 
While Cataloging). 
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Cataloging Assets via Drag and Drop
To catalog assets from FTP or HTTP servers via drag and drop:

1. Open the catalog to which you want to add the assets.

2. Launch your Web browser application.

3. Navigate to the asset, FTP folder or Web page which you want to catalog.

4. Select the link for the asset or FTP folder and drag it into the Cumulus Collection 
window. 

The progress information window appears and records are created for each of the 
assets.
If you are prompted to select an Asset Handling Set for this cataloging process, 
make sure you select an Asset Handling Set that has the URL AssetStore activated.
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Working with URL-cataloged Assets
Certain functions in Cumulus work slightly different for assets stored on FTP or HTTP 
servers. The following sections describe only these slightly different functions. All of 
these functions are options of the Asset menu. If you open, print or mail an URL-cata-
loged asset, Cumulus first makes a copy of the asset. 

To work with assets stored on FTP or HTTP servers you need to employ an Asset Han-
dling Set with URL Support activated.

NOTE: If assets were cataloged from FTP or HTTP servers requiring a user 
authentication, the Cumulus application knows about this protection. When 
you access such an asset, Cumulus will ask you to enter user name and pass-
word. During the same session Cumulus remembers the entered name and 
password and will not ask you again if you access an asset from this FTP or HTTP 
server. 

Opening Assets 

You can open an asset stored on an FTP or HTTP server with either the application that 
created the asset, or another application of your choice. Applications you choose are 
added to the menu. You can add up to four. The fifth addition replaces the first, and 
so on. You cannot manually delete any of the added applications. 

To open an URL-cataloged asset from another application:

1. Select the record whose asset you would like to open.

2. Select Asset > Edit With and select the desired application from the submenu.
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A dialog appears from which you can select a location for the copy of the asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and opens it with the chosen 
application.

Printing Assets 

You can print an asset stored on an FTP or HTTP server with either the application that 
created the asset, or another application of your choice. Applications you choose are 
added to the menu. You can add up to four. The fifth addition replaces the first, and 
so on. You cannot manually delete any of the added applications. 

To print an URL-cataloged asset from another application:

1. Select the record whose asset you would like to print.

2. Select Asset > Print With and select the desired application from the submenu.

A dialog appears from which you can select a location for the copy of the asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and prints it with the chosen 
application.

Mailing Assets 

As with other assets you can also attach an asset stored on an FTP or HTTP server to an 
outgoing email message. 
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To mail an URL-cataloged asset:

1. Select the record whose asset you would like to send as an email attachment.

2. Select Asset > Mail To.

A dialog appears from which you can select a location for the copy of the asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and asks you to select an 
email application / launches your default email application and attaches the 
selected asset(s) to an outgoing message.
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Storing Assets on FTP Servers
The URL AssetStore Module also enables you to upload cataloged assets to FTP servers 
by using the Cumulus menu commands. It also allows you to employ FTP servers as 
the Central Asset Locations for catalogs.

Moving an Asset to an FTP Location

To move an asset to an FTP location:

1. Select the record whose asset you would like to move.

2. Select Asset > Move To.

The Select Asset Storage Module dialog opens which lists all available Asset Stor-
age Modules. 

3. Select the URL AssetStore and click OK. A window for entering an URL opens.

4. Enter a valid FTP-URL and click OK.

Cumulus moves the asset to the selected location and updates the reference of 
the selected record. 

Copying an Asset to an FTP Location

To copy an asset to an FTP location:

1. Select the record whose asset you would like to copy.
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2. Select Asset > Copy To.

The Select Asset Storage Module dialog opens which lists all available Asset Stor-
age Modules. 

3. Select the URL AssetStore and click OK. A window for entering a URL opens.

4. Enter a valid FTP-URL and click OK.

Cumulus copies the asset to the selected location. 
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Central Asset Location on FTP Server
Each individual catalog can be configured, so that Cumulus saves a copy of each cat-
aloged asset to a specific location (called Central Asset Location’). This option allows 
for the quickest possible way to locate and track a catalog’s assets. The URL AssetStore 
Module enables you to employ an FTP server as a Central Asset Location for a catalog.

NOTE: Only the Cumulus Administrator is allowed to change the properties of 
a catalog which define the Central Asset Location. 

To set a URL as Central Asset Location:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click General. This tab includes the options on central asset location. 

Three situations are possible. The following describes the actions necessary for 
each situation.

• When the Central Asset Location Option is active and only its settings need to 
be changed, you can continue with step 5 below. 

• When a Central Asset Location is defined but not active, enable the desired 
option and continue with step 5 below. 
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• When configuring a Central Asset Location for the first time, enable the desired 
option. The Select Asset Storage Module dialog opens and you can skip step 5. 

5. Click Browse to choose the location.

The Select Asset Storage Module dialog opens which lists all available Asset Stor-
age Modules. 

6. Select the URL AssetStore and click OK. A window for entering an URL opens.

7. Enter a valid URL of an existing FTP directory and click OK.

8. Click Apply to save your changes.
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Working with Images
Cumulus provides special functions for users who work with images: 

• The Cumulus Image Editor makes self-service image processing easy for anyone.
• The Information Window lets you easily view and edit IPTC metadata. 
• The Digital Camera Raw Filter enables Cumulus to capture information when cat-

aloging raw image formats and to preview raw image formats. 
These special functions are described in the following sections. For a description on 
how to convert cataloged images, see “Converting Image Assets” , and to learn how 
Cumulus supports Open Prepress Interface, see “OPI System Support” .
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Editing Images
The Cumulus Image Editor makes self-service image processing easy for anyone. Get 
the quick edits you need of your cataloged images. Cumulus offers image cropping as 
well as calibration tools that can enhance the color, sharpness and brightness of your 
images.
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Image Editor
The features of the Image Editor apply to any asset that can be previewed in Cumulus. 
Start the Image Editor by selecting Asset > Image Editor.

Use the slider of the Navigator to zoom in and out the selected image. Clicking on the 
icons at the edges of the slider also zooms in and out. Double-clicking the navigation 
image optimizes the display size of the image for the window size of the Image Editor. 
The statusbar at the bottom of the window displays the zoom factor, the size of the 
image, its color space and color mode. The various tools for image editing are offered 
on the toolbar. Click the icons to activate a tool and see its options.

To save the image modifications performed with any of the tools described in the fol-
lowing sections, click the Save icon (  ) in the Image Editor toolbar. Then you may 
define the file format and color space (and compression rate or image quality, if appli-
cable for the chosen file format) for the edited image. The following options for saving 
a file are offered:

• Save as new version of asset (only available if asset versioning is enabled for the 
respective catalog, either via Vault or via File System Versioning).

• Save as new asset – creates a new asset and, if desired, assigns it as variant to the 
original asset

• Overwrite asset – replaces the original asset with the modified file
• Export to file system – saves the modified file to any place on your file system

IMPORTANT! Embedded digital photo metadata (IPTC, XMP or EXIF) that may 
have existed in the original file, will not be saved with the edited image. 

The following sections describe how each of the Image Editor tools work. 
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Cropping

The Crop tool is used to reduce the visible area of an image. 

To begin cropping, click the image and draw a box around the desired area. Before 
accepting the crop, you can adjust the edges of the selection. Simply place the cursor 
over one of the four side handles and drag to the desired location. While adjusting the 
cropped area, you can review the coordinates of the crop in the fields on the right.

You can also enter the desired size of the area to be cropped. This is useful for crop-
ping an image for specific print or screen sizes, such as 4x6 or 640x480. If you enter a 
size, a box according to the dimensions is displayed and can be dragged over the 
image. To add sizes click the  button.

You can adjust the unit of dimension by selecting pixels, inches or centimeters in the 
Unit list.

Select the resolution for the cropped area from the Resolution list.

Click Crop to accept the crop.

Click Cancel to exit the Crop tool.

Rotating

The Rotate tool is used to adjust the angle of an image. You can rotate by 90 degrees 
clockwise and counter clockwise, and by 180 degrees. You can flip the image horizon-
tally (along the vertical axis) and vertically (along the horizontal axis.)

Click the button for the desired rotation.
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TIP: Transform JPEG Original Command

If you want to rotate JPEG images, you might prefer to use the Transform JPEG 
Original command in the Asset menu.

Adjusting Brightness and Contrast, Gamma and Colors

This tool offers to adjust the tonal range of your images through brightness and con-
trast, the gamma value and colors.

Select the desired adjustment from the pull down menu. Depending on the selected 
adjustment., you are offered different options.

To see the result of your modifications in real time, activate the Live Preview option.

Click Apply to accept the adjustments.

Click Cancel to exit the tool.

Brightness and Contrast

It can help to correct blurry images and bring out fine details in tone. Dragging the 
sliders to the left decreases the levels of brightness and contrast; dragging them to the 
right increases the levels.

When Preserve Color option is activated, you can change brightness and contrast 
without losing color. (Only the brightness information of the image is affected by the 
modification, the color shades are left unchanged.) 

Gamma 

The gamma value of an image affects the way how its colors are perceived.
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Dragging the slider to the left decreases gamma value; dragging it to the right 
increases the value.

Color

The options offered depend on the color space of the asset. 

Dragging the sliders to the left decreases the levels; dragging them to the right 
increases the levels.

Resizing

The Resize tool is used to change the size of an image. To resize an image, define the 
new width and height in the corresponding fields. To maintain the current propor-
tions of width to height, activate the Keep Proportions option.

The original resolution of images is not affected by resizing with Cumulus.

Click Apply to accept the resizing.

Click Cancel to exit the tool.

Applying Filters

Select a filter type from the pull down menu. Depending on the filter type you can 
define the strength and the radius range for the filter (1-100.) The radius determines 
how far the filter considers surrounding pixels that affect the filter action. Select the 
radius according to the image resolution.

The following filters are available:

• Average Blur Filter 
Softens an image. It smoothes transitions by averaging the color values of sur-
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rounding pixels. Eliminates noise where significant color transitions occur in an 
image. 

• Median Filter
Reduces noise in an image by blending the brightness of pixels. The filter adapts 
the brightness of pixels to the median brightness value of the surrounding pixels. 

• Gauss Filter
Works similarly to the Average Blur filter but uses a weighted average of the color 
values of the surrounding pixels. The weighting is determined using the Gaussian 
bell-shaped curve that is generated. 

TIP: The Average Blur as well as the Gaussian filter decrease high-frequency details 
and can produce a hazy effect.

• Sharp Filter
Increases the visual sharpness of images by increasing the contrast at edges. 

TIP: Applying the Sharp filter is recommended when scaling up images to keep their 
visual sharpness as high as possible. 

• Unsharp Mask Filter
Makes images appear sharper by increasing the contrast of small brightness 
changes.

• Add Noise Filter
Applies random pixels to an image, simulating distortion or noise. You can also use 
the Add Noise filter to give a more realistic look to heavily retouched areas. 

To see the result of your modifications, you can activate the Live Preview option. To 
avoid time consuming live preview recalculations, you should activate this option 
after you changed the filter parameter values. 

Click Apply to have the filter applied.
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Click Cancel to exit the tool.
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Working with Raw Images
Cumulus supports raw image formats of a wide array of digital cameras. You can find 
and organize raw image formats efficiently. Cumulus can extract metadata of raw 
image formats and store it in Cumulus catalogs. Additionally, EXIF information (camera 
settings, date, aperture and shutter speed etc.), and depending on the camera model, 
annotations and GPS are also captured when cataloging. Even Canon thumbnail files 
(THM) are supported. Converting assets stored in raw image format to JPEG and TIFF 
images on-the-fly is a breeze with Cumulus. 

The Digital Camera Raw Filter enables Cumulus to capture information when catalog-
ing raw image formats and to preview raw image formats. The captured information 
will be stored in Cumulus record fields. 

The Digital Camera Raw Filter can capture metadata from the different raw image for-
mats defined by leading camera manufacturers, namely, Canon, Fuji, Kodak, Minolta, 
Nikon, Olympus, Sigma, Sinar and Sony. Check Canto’s website for a detailed list of 
which cameras are supported.

Most cameras supporting Canon CRW files create additional thumbnail files (THM 
files). The Canon Raw Metadata Support enables Cumulus to capture metadata from 
these files and to manage these files. For more information, see “Canon DC Raw Image 
& Thumbnail File” .
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Cataloging Raw Image Formats
When cataloging raw image formats, your catalogs and Asset Handling Sets have to 
be prepared for this. The catalogs in which you want to manage your raw images must 
provide the corresponding record fields to store the special raw image information 
and the Asset Handling Sets you want to employ must have the Digital Camera Raw 
Filter activated. Its format entries must be in a certain sequence to achieve best results. 

Captured Information

When cataloging, the Digital Camera Raw Filter can capture the following information 
from your raw images:

Of course the filter can only capture the information contained in the cataloged 
images. The captured information will be stored in Cumulus record fields. The corre-
sponding record fields have to be included in the catalog to which you want to add 
the raw images.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH IMAGES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Some of the fields above may not be available in the catalog to which you want to add 
the raw images. To include them in a catalog, you have to add the corresponding 
fields to the Record Fields in the Catalog Settings dialog before cataloging your doc-
uments or updating your records. (For details on how to add record field to a catalog, 
see “Adding Fields” .) Note that only the Cumulus Administrator or a user who has the 
appropriate permissions is allowed to change the settings of a catalog and add record 
fields. 

Format Entry Order

The Digital Camera Raw Filter is the only Cumulus filter that can read raw images. How-
ever, the entry numbers of the formats supported by this filter are important. When 
cataloging, Cumulus starts searching for matching formats at the lowest entry num-
ber. It employs the formats according to their entry numbers (lowest entry number 
first). If you want the Digital Camera Raw Filter to be employed for assets, check the 
order of the format entries in the Asset Handling Set you use for cataloging.

In order to ensure the Digital Camera Raw Filter works ideally for cataloging assets, you 
have to move the entries for the formats supported by it up in the list, so that they are 
at least before the first format supported by the TIFF Filter. The Sinar DC Raw Image 
Format should have a lower entry number than the first format supported by the Pho-
toshop Filter.

Defining Filter Properties

The Digital Camera Raw Filter allows you to define properties for the different formats 
supported by this filter.

• Canon DC Raw Image (extension: crw, Mac File Type: CCDR)
• Fuji DC Raw Image (extension: raf, Mac File Type: RAF *)
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• Kodak DC Raw Image (extension: dcr, Mac File Type: KDCR)
• Minolta DC Raw Image (extension: mrw, Mac File Type: MRW *)
• Nikon DC Raw Image (extension: nef, Mac File Type: NEF *)
• Olympus DC Raw Image (extension: orf, Mac File Type: ORF *)
• Sigma DC Raw Image (extension: x3f, Mac File Type: FOVb)
• Sinar DC Raw Image (extension: sti, Mac File Type: TIFF)
• Sony DC Raw Image (extension: srf, Mac File Type: SRF *)

* Mac File Types with 3 characters only end with a space

These properties are important for cataloging and previewing. For cataloging they are 
important only if you have activated the option Entire Asset under Create Thumbnail 
from on the Thumbnail tab of the Asset Handling Set employed for cataloging. Then 
the values set for the color settings and the color interpolation are used for creating 
the thumbnail.

For the previewing of each of the formats, you can define the source for a preview 
(thumbnail or entire image). If the source for the thumbnail to be created or the pre-
view to be shown is the entire asset, the color settings and the color interpolation can 
be set.
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Canon DC Raw Image & Thumbnail File
Most cameras supporting Canon CRW files create additional thumbnail files. Along 
with a 160 x 120 JPEG thumbnail of the original image in the associated CRW file, these 
files contain the EXIF information and optionally IPTC information. They always have 
the same name as the original CRW file, but with a THM file extension.

Cumulus supports these THM files. If the Canon Raw Metadata Support is activated in 
the Asset Handling Set employed for the CRW image, the THM files are treated as fol-
lows:

• If an image of this format is cataloged, the associated THM file will not be cata-
loged but the information it contains will be captured by Cumulus and stored in 
the record for the image.

NOTE: If the Canon Raw Metadata Support is activated when cataloging, you get 
a list displayed that informs you of the THM files that have not been cataloged. 

• If you employ Cumulus to manage the cataloged image (copy, move, email or 
delete), the associated THM file will be processed as well. Only when you employ 
the special copy function to select a category and then copying the associated 
assets by dragging this category on your desktop, the THM files will not be copied 
as well. 

• If you rename the assets employing the Cumulus Rename To function, the THM 
files will not be renamed as well.

The Canon Raw Metadata Support is activated by default. If you want to deactivate it 
for certain Asset Handling Sets, see “(De)activating Asset Handling Modules” .
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Using the Similarity Search
With Cumulus you can search for assets – especially image assets – which are visually 
similar to other assets. Similarity is detected by comparing specific hash values of dif-
ferent assets. Such a hash value is generated for an asset every time when the thumb-
nail is changed (or created), i.e. during cataloging and check-in, or caused by an 
update of the record. 

For details on how to search for similar assets with the Cumulus Web Client, see the 
Web Client help, to be accessed from within the Web Client, or via help.canto.com.

Prerequisites
Some prerequisites must be met in order to make use of the similarity search feature.

Permissions

No special permissions are required for Cumulus users who want to use the similarity 
search feature.
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Catalog-related Prerequisites

The similarity search feature requires the Similarity Hash field to be available in a cata-
log. Once this field is contained in the catalog, the respective hash value is computed 
automatically when assets are added to the catalog, or when the thumbnail is 
changed for whatever reason. 

For details on how to add fields to a catalog, see Adding Fields.

NOTE: Similarity Hash values for asset that have been already in a catalog 
before this field was added, are not computed automatically! To get the Simi-
larity Hash values for such legacy assets, you must first perform an Update For-
mula Fields operation at the Cumulus Desktop Client.
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Working with the Video Cloud
For better availability, worldwide distribution and public streaming, Videos in 
Cumulus can additionally be published to a Video Cloud, as offered by various provid-
ers. The “original” video files and all their metadata remain safe in Cumulus (stored in 
a Vault, or on a file server), but the delivery of the video to websites – including 
Cumulus Portals and the Web Client – is performed by the Video Cloud.

There are two ways to enhance Cumulus with the capabilities of a Video Cloud:

• either by means of the Cumulus Video Cloud, 
• or by means of Cumulus Video Connectors and a contract with one of the Video 

Cloud providers supported by Cumulus. 
From a user’s point of view, however, the actual usage of the Video Cloud feature 
remains the same for any chosen solution.

For details on how to set up Video Cloud support in Cumulus and the prerequisites 
that must be met, see Video Cloud Setup.

Required Permissions

Cumulus users who want to use the Video Cloud feature (i.e. uploading and publish-
ing videos, making use of video links and embed codes) must have special Video 
Cloud Catalog Permissions.

Cumulus provides three Video Cloud specific Catalog Permissions.

• Video Cloud Consumer – can view and make use of video links and embed codes
• Video Cloud Contributor – can (additionally) alter the embed code with different 

player skins, can make use of derivatives, can view some video-related statistics 
data, and can control the availability period (from - to)
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• Video Cloud Administrator – can (additionally) manage video files in the Video 
Cloud (upload to/remove from Video Cloud, publish/un-publish), can access the 
Video Cloud module of the Web Server Console, and can see the upload queue.
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How it works
In order to make a video publicly available in the Video Cloud, it must first be uploaded 
and published.

Video Cloud related functions (upload/remove, publish/un-publish, setting publish-
from and publish-to dates) can be performed via the Desktop Client or the Web Client, 
but not via Portals. Cumulus Portals only serves for displaying metadata and previews 
of videos.

To upload video files to the Video Cloud, and to publish uploaded video files, users 
need the Video Cloud permission “Video Cloud Administrator”.

NOTE: Some Video Cloud providers (e.g. Wistia) don’t support publishing/un-
publishing videos as distinct from uploading/removing videos. With such pro-
viders, an uploaded video is implicitly published, and un-publishing such a 
video leads to its immediate removal from the provider’s site. 

Upload/Publish

To initiate the upload of a video:

1. Select the video.
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2. Select the menu Assets > Video Cloud > Upload on the Desktop Client, 
OR
select Upload to Video Cloud from the toolbox of the Web Client.

This changes the value of the record field Video Cloud Request to Upload to Video 
Cloud. On its next run, the Cumulus Scheduler finds this value and initiates the upload 
to the Video Cloud. This is indicated in the Video Cloud State record field, which 
changes to Uploading, then to Uploaded once the upload is finished.

Derivatives from uploaded files for various resolutions/devices/bandwidths are cre-
ated automatically by the Video Cloud. For users with appropriate permissions (Video 
Cloud Contributor, at least), download links to these derivatives are provided in the 
Desktop Client (Video Cloud Data window) and the Web Client (Video Cloud tab).

NOTE: Links to generated derivatives may only be valid for a certain period of 
time.

Uploaded videos must additionally be published in order to become available for the 
public. 

NOTE: With some Video Cloud providers (e.g. Wistia), an uploaded video is 
published implicitly!

To publish an uploaded video:

1. Select the video.
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2. Select the menu Assets > Video Cloud > Publish on the Desktop Client 
OR
select Publish at Video Cloud from the toolbox of the Web Client.

This changes the value of the Video Cloud Request record field to Publish to Video 
Cloud. On its next run, the Scheduler finds this value and switches the state of the file 
in the Video Cloud to published. This is indicated in the Video Cloud State record field, 
which changes to Publishing, then to Published once the publishing process is fin-
ished.

NOTE: Uploading, publishing and the creation of derivatives are time consum-
ing processes that can take anything from several minutes up to several hours. 
However, the exact duration can not be predicted. Limiting factors are the size 
of the video file, the available bandwidth, the load at the video server, among 
others.

When a Video is Published...

As soon as a video is published, its video link and embed code are available. They are 
displayed in the Video Cloud Data window (Desktop Client) and the Video Cloud tab 
(Web Client), respectively. This window / tab displays video-related data that is deliv-
ered from the Video Cloud, but is not part of the video’s metadata as stored in 
Cumulus. (For details see Video Cloud Data.)

Cumulus users with any Video Cloud permission can make use of video links and 
embed codes, e.g. by sending them via email or incorporating them into a web page. 
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However, links and embed codes will only work if and as long as the respective videos 
are published.

Once the video is published, the previews that are displayed in Cumulus Web Client 
and Portals are no longer delivered by Cumulus, but will be streamed by the Video 
Cloud instead. Thus, the availability of your videos is significantly enhanced, and the 
load on the Cumulus Server is reduced.

Published videos will be available to everyone who encounters a respective link, e.g. 
on web page that contains the proper embed code, until they are un-published or 
deleted from the Video Cloud.

Un-publishing/Deleting Videos

Un-publishing videos from the Video Cloud – i.e. making them unavailable for public 
use – works just the other way round. However, it is not required to first un-publish, 
then delete a video – even published videos can simply be deleted from the Video 
Cloud.

To un-publish or remove videos from the Video Cloud, users need the Video Cloud 
permission “Video Cloud Administrator”.

To un-publish a video from the Video Cloud:

1. Select the video
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2. Select the menu Assets > Video Cloud > Unpublish on the Desktop Client
OR
select Unpublish at Video Cloud from the toolbox of the Web Client.

With the next run of the Cumulus Scheduler, the video will no longer be available from 
the Video Cloud.

Additionally, a video in the Video Cloud can be un-published at a specific date and 
time by specifying appropriate values in the Video valid to metadata field (see 
Restricting the Availability of Videos in the Video Cloud).

Videos that have been unpublished remain in the Video Cloud and can be published 
again, if desired, until they are explicitly removed from the Video Cloud.

Videos can be removed from the Video Cloud anytime, whether they are published or 
not.

NOTE: With some Video Cloud providers (e.g. Wistia), un-publishing a video 
removes it immediately from the Video Cloud!

To remove a video from the Video Cloud:

1. Select the video.

2. Select the menu Assets > Video Cloud > Remove on the Desktop Client
OR
select Remove from Video Cloud from the Toolbox of the Web Client.
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Removing a video from the Video Cloud does not affect its status or availability in 
Cumulus!

Restricting the Availability of Videos in the Video Cloud

By default, publishing a video makes it available within several minutes and for an 
unlimited period of time.

The availability period of a video can be precisely controlled by specifying a Video 
valid from and/or Video valid to date. Such dates can be specified in advance (before 
the video is published) as well as while the video is already published

• In advance: dates that are specified in the Video valid from and/or Video valid to 
record fields are taken into account by the Video Cloud during the publishing pro-
cess, and the availability period is set accordingly.

• Later: any modification of the values in the Video valid from and Video valid to 
record fields of a published video fires a Cumulus trigger action which in turn sets 
or modifies the respective values in the Video Cloud. Any date entered into the 
Video valid to field while the video is in the status “published” will initiate the un-
publishing of the video on the given date.

NOTE: Some Video Cloud provider (e.g. Wistia) don’t support the possibility of 
limiting the availability period of a published video. As soon an a video is 
uploaded to such a provider, it will be available until it is removed from the pro-
vider’s site. 
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File Versioning and the Usage of the Video Cloud
If a video file that has been uploaded or published to the Cumulus Video Cloud or to 
the Video Cloud of an external provider gets a new version in Cumulus, the uploaded 
or published version can be updated automatically as well.

This requires a Cumulus trigger action which is fired if the value of the Video Cloud 
Asset Modification Date record field of an uploaded or published video is modified, 
and in turn sets the value of the record field Video Cloud Request to Upload to Video 
Cloud or to Publish to Video Cloud, depending on the value of the of the Video 
Cloud State field. On its next run, the Cumulus Scheduler finds this value and initiates 
the update of the video in the Video Cloud.

NOTE: Automatic update of uploaded/published videos only works with the 
Cumulus Video Cloud, and with certain external video providers (currently, only 
movingimage and Kaltura are supported)!
With all other external Video Cloud providers, checking in a new version of an 
already uploaded/published video file will not affect the uploaded/published 
file! With these providers, an old version of a video file must be explicitly 
removed from the Video Cloud, then the new version must be uploaded/pub-
lished. That’s why a new version of a video in the Video Cloud always comes 
with a completely new embed code and video link.

NOTE: With both the Cumulus Video Cloud, and with moving image as external 
Video Cloud provider, the start frame of the video as displayed in the player is 
NOT updated. If this is required, the video must be manually removed from the 
Video Cloud and subsequently the new version must be uploaded/published. 
But then, the new version also gets a new embed code and video link!

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH THE VIDEO CLOUD

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Video Cloud Data
For videos that are published to the Video Cloud, additional data is provided by the 
Video Cloud. This data is not available or stored with the metadata of the file in 
Cumulus, but can be accessed via the Web Client or the Desktop Client.

• On the Web Client, this data is displayed in the Video Cloud tab which is added to 
a video’s details view as soon as the video is uploaded to the Video Cloud.

• On the Desktop Client, this data is displayed in the Video Cloud Data Window. To 
open this window, select a video file, then choose Asset > Video Cloud > Show 
Video Cloud Data.

The given information is split into 4 sections. Some settings can be changed. What’s 
actually displayed may vary depending on the configured Video Cloud.

NOTE: The contents of the Video Cloud tab and Video Cloud Data window, 
respectively, is not updated automatically! To initiate a refresh on the Web Cli-
ent, perform a page reload, or switch to a different tab and back. On the Desk-
top Client, use the refresh icon in the upper left corner, or close and reopen the 
window.

• Embed Code – Used to directly embed the video into whatever web page - no fur-
ther contact with Portals or any other Cumulus instance is required. The video is 
streamed to player as delivered from the Video Cloud. This player comes with a 
default player skin and a default resolution (“responsive”, that is, the resolution 
adapts to the size and the abilities of the device and browser used by the viewer). 
However, users may be able to select form different player skins available at the 
Video Cloud, and to select a custom resolution value, to be used instead of the 
default ones.
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• Player Skin – To be used with the embed code; drop-down list to select a player 
skin from the skins provided by the Video Cloud.

NOTE: A player skin must be specified in the metadata of each video. If not, 
streaming of the videos from the Video Cloud will not work in Cumulus Portals 
or Cumulus Web Client.

• Size – To be used with the embed code; drop-down list to select a value for the 
size of the player from the sizes provided by Video Cloud, or to define a player 
size of your own.

• Embed Code – The code that you can insert into the source code of any web 
page in order to have the video displayed there. – Note that any modification to 
the Size or Player Skin values alters the embed code!

• Video Link – Used to call a landing page, which is delivered by Portals. This landing 
page contains a player with a default player skin and size, as delivered from the 
Video Cloud.
• Base URL – The base URL to your Cumulus Portals instance constitutes the first 

part of the video link. If there are multiple Portals instances at your disposition, 
you must select the appropriate one from the drop-down list.

• Video Link – The link that you can insert into the source code of a web page, or 
send via email etc.

• Derivatives – Links to the various derivatives of the original video, rendered by the 
Video Cloud for a bunch of different devices, resolutions etc. These links can be 
used in web pages or emails, etc, in order to provide download links for the video.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH THE VIDEO CLOUD

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

NOTE: As long as not all derivatives are generated at the Video Cloud, the title 
of this section is Processing... 
Note also, that the generation of derivatives can take up to several hours, and 
that links to such derivatives may only be valid for a certain period of time.

• Statistics – Basic statistics information on the usage of the video.
• Video Views – Number of calls of this video from the Video Cloud.

NOTE: The information about player skins, derivatives and statistics is not dis-
played to users with the permission Video Cloud Consumer only!
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Using the Media Delivery Cloud
In order to provide worldwide distribution and availability of enterprise media assets, 
Cumulus can be enhanced with the Media Delivery Cloud option. Cataloged assets 
can then be provided through a Content Delivery Network (CDN) based on Amazon 
Web Services. 

The Media Delivery Cloud caches assets into Amazon’s CloudFront CDN. Images can 
be managed centrally in Cumulus and delivered directly from the CDN to a variety of 
platforms including e-commerce, Web Content Management (WCM) systems, Enter-
prise Resource Management (ERP) systems, Product Information Systems and more.

All kinds of assets in Cumulus can be published to the Media Delivery Cloud – either 
as the “original” assets, or as so called master images for image assets, or as both. A 
master image is a PNG version of the original image and, in general, of smaller dimen-
sions than the original. The size of master images can be configured via the Media 
Delivery Cloud configurator in the Web Server Console. Crop and resize operations 
can be performed to a master image, which results in different renditions of that 
image that will be generated on-the-fly, and cached in the CDN.

Prerequisites
Some prerequisites must be met in order to make use of the Media Delivery Cloud fea-
ture.
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License

A Media Delivery Cloud license must be purchased, and activated via the Remote 
Admin module of the Cumulus (Web) Server Console. 

Additionally, a fitting amazon S3 Customer ID (either of customer’s existing account, 
or obtained from Canto) and an Endpoint URL (obtained from Canto) must be entered 
via the Media Delivery Cloud Setup module of the Web Server Console.

Permissions

No special permissions are required for Cumulus users who want to use the Media 
Delivery Cloud feature.

Catalog-related Prerequisites

Media Delivery Cloud Specific Record Fields

The Cumulus Media Delivery Cloud (MDC) feature can be used only with catalogs that 
contain some MDC specific fields. These fields are provided in the catalog template for 
Media Delivery Cloud and can be added to any existing catalog.

For details on how to add fields to a catalog, see Adding Fields.
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Scheduler Task

Cumulus provides a Media Delivery Cloud Scheduler action that reads the content of 
certain Media Delivery Cloud related record fields and performs the following tasks:

• uploading original assets to MDC Service
• generating of master images and uploading them to MDC Service
• deleting any asset or master image at MDC Service
• extending the expiration date of any asset/image, shortly before the expiration 

date is reached.
A Scheduler task with this scheduler action must be set up, specifying the catalogs on 
which the action shall be performed, and its frequency in time. 

For details on how to set up a Scheduler action, see Setting Up a Scheduler Task.

Trigger

Cumulus provides a Media Delivery Cloud trigger action that can

• un-publish an asset or master image from the Media Delivery Cloud
• change the value of the Media Delivery Cloud Request field to Publish original 

asset, or Publish master image, or Publish original asset and master image, 
depending on what has been published before.

Canto recommends to setup two triggers with the Media Delivery Cloud trigger 
action: 

• One catalog-specific trigger that is fired when a record is deleted. This trigger 
would initiate the deletion of the respective asset or master image from the MDC 
service.
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• One field specific trigger that is fired when the asset modification date of an asset 
is modified. This trigger changes the value of the Media Delivery Cloud Request 
field to Upload ..., which subsequently causes the scheduler to upload the modi-
fied asset (and/or generate and upload a new master image) on its next run.

For details on how to set up triggers, see Setting Up Triggers for Catalogs.
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How it works
Publishing or un-publishing an asset in the Media Delivery Cloud is a matter of chang-
ing a value in the Media Delivery Cloud Request record field. Field values can be 
changed via the Desktop Client or the Web Client, but not via Portals. 

Prerequisites: 

You need to employ a Record View Set that contains the MDC-specific fields.

To initiate the publishing of an asset and/or master image:

1. Select the asset an open it in edit mode view (Web Client), or open its Information 
window (Desktop Client).

2. In the MDC Request field, select either Publish original asset, or Publish master 
image, or Publish original asset and master image. 

3. Save your changes

On its next run, the Cumulus Scheduler reads the value in the MDC Request field and 
performs an appropriate action. The MDC state field value is updated accordingly.

Uploaded assets and master images are provide with an expiration date by default. As 
long as the Scheduler runs regularly, this expiration date will be extended automati-
cally. 
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Un-publishing assets

Assets and/or master images can be un-published from the Media Delivery Cloud any-
time if they are not longer needed. 

To un-publish an asset from the Media Delivery Cloud:

1. Select the asset an open it in edit mode view (Web Client), or open its Information 
window (Desktop Client).

2. In the MDC Request field, select either Unpublish original asset, or Unpublish 
master image, or Unpublish original asset and master image. 

3. Save your changes.

With the next run of the Cumulus Scheduler, the asset will be deleted from the Media 
Delivery Cloud.

File Versioning and the Usage of the Media Delivery Cloud
Checking in a new version of an asset file into Cumulus affects the asset creation date 
value. If triggers and scheduler tasks are set up properly, new versions of assets will be 
automatically uploaded to the Media Delivery Cloud on the next run of the scheduler. 

If you do not want to automatically re-publish updated assets, you must not specify a 
field-specific trigger with the Media Delivery Cloud trigger action!
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Working with Office Documents
Cumulus provides special support for documents of certain office systems. This special 
support is based on specific support modules.

Special support is provided for documents of the following office systems:

• Microsoft Office 2007/8 or later
• Microsoft Office 2003 or prior for Windows, 2004 or prior for macOS
• Apple iWork 
• OpenOffice.org
When cataloging, Cumulus can capture all office document information such as 
author, dates and version, and even all text contained in the document. 

If you have installed LibreOffice on the Client machine, Cumulus can properly create 
high quality previews and thumbnails from office documents. This includes RTF files, 
MS Office Open XML files and templates, MS Office files and templates, Open Docu-
ment files and template, and Open Office files and templates. The client machine is 
any computer on which a Cumulus Client application is running, e.g. the Cumulus 
Desktop Client or a Cumulus Java Classes based application like Cumulus Web Solu-
tions (for installations employing the Cumulus Web Client or the Cumulus Integration 
Platform). 
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TIP: Quality Problems? Check the LibreOffice Installation Path

If LibreOffice is installed and you still encounter issues with thumbnails and pre-
views from office documents, check whether the path to LibreOffice is properly 
specified in the client.xml file, or inform your Cumulus administrator. For details 
on how to check the path, see “Appendix / Support for Office Formats: LibreOf-
fice” in the most recent Cumulus Installation Guide.

If you have installed PowerPoint on the Client machine, the Cumulus PowerPoint Filter 
will create high quality previews and thumbnails for PowerPoint assets. You can also 
create new presentations out of your cataloged single slides directly in Cumulus. 
When you are working with Microsoft PowerPoint, Cumulus allows you to insert cata-
loged assets into presentations. For more details see “PowerPoint Support” , and “The 
PowerPoint Add-In” .

Special modules for office documents are:

Asset Store Modules for Office Documents

Some of the special AssetStores for office documents enable Cumulus to create 
records for pages, sheets or slides of office documents. These records are created in 
addition to a record for the entire document. Other special AssetStores enable 
Cumulus to create one record for each picture embedded in an office document while 
cataloging. All these records are created in addition to a record for the entire docu-
ment and in addition to separate records for pages or slides. The records will be 
assigned to the corresponding document as “related sub asset”. A category for each 
document will automatically be created and the records are assigned to these catego-
ries. For further details on such AssetStores, see “Asset Storage Modules” .
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NOTE: If none of the special AssetStores is activated for the Asset Handling Set 
used, Cumulus will just create one record for the entire asset.

Asset Processor Modules for Presentations 

The MS PowerPoint Asset Processor and Office Open XML Presentation Processor 
enable the user to create PowerPoint presentations from selected PowerPoint assets 
(slides, presentations) and image assets within Cumulus. For further details on such 
Asset Processors, see “Asset Processor Modules” . (For more information on how to use 
the PowerPoint/Presentation Asset Processors, see “Creating Presentations” .)

Cumulus Office Document Filters

The office document filters can capture: 

• Document description information (such as Title, Subject, Keywords, Headings ...) 
• Document origin information (such as Author, Document Creation Date, Revision 

Information) 
• Document text
• Custom document properties as defined by a user

NOTE: All office document filters support AXR (Asset Cross References). 
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Formats supported by Cumulus office document filters

File Format Extension Mac File 
Type

Cumulus Filter

Apple Pages pages Apple iWork Filter

Apple Keynote key     Apple iWork Filter

Apple Keynote Slide     Apple iWork Filter

MS Office Binder Wizard obz Compound Document Filter

MS Office Binder Template obt Compound Document Filter

MS Access Project adp Compound Document Filter

MS Access Wizard mdz Compound Document Filter

MS PowerPoint Add-In ppa PPPA Compound Document Filter

MS PowerPoint Wizard pwz Compound Document Filter

MS PowerPoint Template pot PPOT Compound Document Filter

MS PowerPoint Show pps PPSS Compound Document Filter

MS PowerPoint Slide ppt SLD3 Compound Document Filter

MS PowerPoint Presentation ppt SLD8 Compound Document Filter

MS Excel Add-In xla XLA8 Compound Document Filter

MS Excel Template xlt sLS8 Compound Document Filter

MS Excel Document xls XLS8 Compound Document Filter

MS Word Wizard wiz Compound Document Filter
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MS Word Template dot W8TN Compound Document Filter

MS Word Document doc W8BN Compound Document Filter

MS Outlook Item msg Compound Document Filter

MS Outlook Item Template oft Compound Document Filter

Compound Document Format Compound Document Filter

MS Picture It! Image mix Compound Document Filter

Text Document docx/docm Office Open XML Filter

Text Template dotx/dotm Office Open XML Filter

Spreadsheet Workbook xlsx/xlsm/
xlsb

Office Open XML Filter

Spreadsheet Workbook Template xltx/xltm Office Open XML Filter

Spreadsheet XLSX Office Open XML Filter

Presentation pptx/pptm Office Open XML Filter

Presentation Template potx/potm Office Open XML Filter

Presentation Show ppsx Office Open XML Filter

Presentation Slide SLDX Office Open XML Filter

XPS Document xps Office Open XML Filter

XPS Page XPSP Office Open XML Filter

Open Document Text odt     Open Document Format Filter

Open Document Text Template ott     Open Document Format Filter

File Format Extension Mac File 
Type

Cumulus Filter
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Open Document Spreadsheet ods     Open Document Format Filter

Open Document Spreadsheet Tem-
plate

ots     Open Document Format Filter

Open Document Presentation odp     Open Document Format Filter

Open Document Presentation Tem-
plate

otp     Open Document Format Filter

Open Document Drawing odg     Open Document Format Filter

Open Document Drawing Template otg     Open Document Format Filter

Open Document Formula odf     Open Document Format Filter

Open Document Master Document odm     Open Document Format Filter

Open Document Database odb     Open Document Format Filter

OpenOffice 1.0 Text sxw     Open Document Format Filter

OpenOffice 1.0 Text Template stw     Open Document Format Filter

OpenOffice 1.0 Spreadsheet sxc     Open Document Format Filter

OpenOffice 1.0 Spreadsheet Tem-
plate

stc     Open Document Format Filter

OpenOffice 1.0 Presentation sxi     Open Document Format Filter

OpenOffice 1.0 Presentation Tem-
plate

sti     Open Document Format Filter

OpenOffice 1.0 Drawing sxd     Open Document Format Filter

OpenOffice 1.0 Drawing Template std     Open Document Format Filter

File Format Extension Mac File 
Type

Cumulus Filter

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH OFFICE DOCUMENTS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Some office document filters have properties that you can change. The range of 
options depends on the filter. 

OpenOffice 1.0 Formula sxm     Open Document Format Filter

OpenOffice 1.0 Master Document sxg     Open Document Format Filter

MS PowerPoint Template pot PPOT PowerPoint Filter

MS PowerPoint Show pps PPSS PowerPoint Filter

MS PowerPoint Presentation ppt SLD8 PowerPoint Filter

MS PowerPoint Slide ppt SLD3 PowerPoint Filter

File Format Extension Mac File 
Type

Cumulus Filter
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Configuring 
To have the fully functional range of Cumulus for office documents available, the 
Cumulus catalogs in which you want to store special additional information on cata-
loged documents have to be prepared. 

Of course the office document filters can only capture the information contained in 
the cataloged documents. The captured information will be stored in Cumulus record 
fields. The corresponding record fields have to be included in the catalog to which you 
want to add the office documents. 

Some of the fields ’fed’ by the special office filters and support modules may not be 
active in the catalog to which you want to add the documents. To include them in a 
catalog, you have to add the corresponding fields to the Record Fields in the Catalog 
Settings dialog before cataloging your documents or updating your records. (For 
details on how to add record field to a catalog, see “Adding Fields” .) Note that only the 
Cumulus Administrator or a user who has the appropriate permissions is allowed to 
change the settings of a catalog and add record fields. 
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Cataloging Outlook Messages
Cumulus lets you catalog mail messages stored in the Microsoft Office Outlook Mes-
sage Format (file extension: msg) and all attachments or embedded images as sepa-
rate assets along with it. The Compound Document Filter will capture mail addresses 
to the record fields Email CC, Email From, Email To and the text of the message to the 
Document Text record field. 

The Outlook Message AssetStore enables Cumulus to create one record for each 
attachment or embedded image of a Microsoft Office Outlook message while catalog-
ing – in addition to creating a record for the message. These records will be assigned 
to the corresponding message as “related sub assets”. A category for each message 
will automatically be created and the images’ and attachments’ records are assigned 
to these categories. The record name of an attachment or an embedded image is the 
name of the image as saved with the message. 

To have the full support for Outlook messages, you must use an Asset Handling Set 
that has the Outlook Message AssetStore activated for cataloging and the catalog must 
provide the corresponding record fields. (For details on how to add record fields to a 
catalog, see “Adding Fields” . For a description on how to customize an Asset Handling 
Set see “Editing An Asset Handling Set” .)
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PowerPoint Support
This section covers the basics of working with the Cumulus PowerPoint support mod-
ules for Windows and Mac OS X. It describes how to catalog PowerPoint presentations 
including slides, how to work with cataloged slides in Cumulus and how to import cat-
aloged graphic files and slides directly into Microsoft PowerPoint presentations. 

For information on how to use the Presentation Asset Processors to create PowerPoint 
presentations from selected PowerPoint assets (slides, presentations), image assets 
and previews of other asset formats within Cumulus, see “Creating Presentations” .
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Formats and Requirements
Cumulus offers different modules for supporting the different PowerPoint formats:

• The MS PowerPoint AssetStore, the MS PowerPoint Picture AssetStore and the 
PowerPoint Filter handle presentations in PowerPoint 97-2004 format (*.ppt). 
To have full support for files of this format, a Microsoft PowerPoint installation is 
required on the computer where you are working. Microsoft PowerPoint 97/
2000/XP/2003/2007/2010 or 2004/2008 is required. 

• The Office Open XML Pages and Slides AssetStore, the Office Open XML Pic-
tures and Media AssetStore and the Office Open XML Filter handle presentations 
in Office PowerPoint 2007/8 format (*.pptx and *.ppsx). If you are working with 
Office PowerPoint 2007/8 formats, a PowerPoint installation is not required – 
unless you want to generate high quality previews or thumbnails for slides.

The PowerPoint support AssetStore modules enable Cumulus to create records for 
slides as well as for images and objects embedded in a presentation. The PowerPoint 
support filter modules create high quality previews and thumbnails if the correspond-
ing PowerPoint application is installed on the Client machine.

Most Cumulus PowerPoint support modules run on Windows and on Mac OS X. 
Under UNIX, only the Office Open XML Presentation Processor and the document fil-
ters (Compound Document and Office Open XML) are available. 

The fact that some PowerPoint support components employ Microsoft PowerPoint in 
the background may sometimes result in slow performance of some functions.
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Employing the PowerPoint Support Filter Modules
The PowerPoint support filter modules (PowerPoint Filter, Office Open XML Filter) 
deliver better thumbnail and preview quality for PowerPoint assets than the Com-
pound Document Filter, but the Compound Document Filter is faster, does not 
require PowerPoint and works on all platforms. To employ the PowerPoint support fil-
ter modules for cataloging those formats it supports, you have to move the format 
entries up in the list at least before the corresponding entries of the Compound Doc-
ument Filter.

BACKGROUND INFO:  Sequence of Formats

When cataloging, Cumulus starts searching for matching formats. Cumulus 
employs the formats according to their entry numbers (lowest entry number 
first) in the Asset Formats list of the employed Asset Handling Set. 

NOTE: for macOS only 
For PowerPoint 2008 assets (*.pptx and *.ppsx) numbered thumbnails will be 
created for slides, no individual ones. Previewing a slide will display its thumb-
nail. These restrictions are due to the fact that Microsoft decided to remove the 
VBA/OLE technology from Office 2008 for OS X. 
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Cataloging the Slides of a Presentation
To catalog the slides of a PowerPoint presentation, you simply catalog the PowerPoint 
presentation file – using an Asset Handling Set that has the corresponding office 
AssetStore(s) activated. Then Cumulus will automatically catalog the presentation and 
all slides contained. A root category named PowerPoint is then automatically created 
as well as a subcategory with the same name as the presentation. All slides will be 
assigned to the presentation’s category. If the slides contain embedded pictures or 
other media and the corresponding Picture or Pictures and Media AssetStore is acti-
vated, a record of embedded media will be created. A subcategory for each slide of 
the presentation file is automatically created and the media’s records are assigned to 
these categories.

Records for the PowerPoint presentation file and each of its slides will be created, indi-
cating that the cataloging process was successful.

NOTE: No Individual Thumbnail!
If no individual thumbnail was created for a slide’s record – although Power-
Point is installed –, the reason could be that the slides contain one or several 
media that can’t be opened by the PowerPoint application (e.g. linked images 
or embedded objects). If such an individual record could not be created, a 
default thumbnail is used. For PowerPoint 2007 assets (*.pptx and *.ppsx) the 
slide number is added to the thumbnail embedded in the presentation. 
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Working with Records of Slides
Certain functions in Cumulus work slightly differently for records of PowerPoint slides. 
The following sections describe only these specific functions.

• Showing Location
If you select Asset > Show Location for the record of a cataloged slide, Cumulus 
opens the presentation in PowerPoint and displays the selected slide – if the cor-
responding PowerPoint application is installed on the computer running the 
Cumulus Client.

• Copying Slides or Creating New Presentations
If you select Asset > Copy To for the record of a cataloged PowerPoint slide and 
select a folder as the destination, Cumulus creates a new presentation containing 
the selected slide. If you select an existing presentation as the destination, 
Cumulus adds the selected slide at the end of the presentation if the correspond-
ing PowerPoint application is installed on the computer running the Cumulus 
Client.

• Deleting 
If you select Edit > Delete for the record of a cataloged PowerPoint slide and select 
the option Delete Record and Asset, the selected slide will be deleted from the 
catalog as well as from the presentation (with PowerPoint 97-2004 format (*.ppt) 
only.)
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The PowerPoint Add-In 
The Cumulus PowerPoint Add-In enhances your Microsoft PowerPoint application 
with additional functions. It enables you to import cataloged slides, pictures and 
media from Cumulus into Microsoft PowerPoint presentations. You may import all pic-
ture and media formats which PowerPoint supports. 

These functions are accessible within the PowerPoint application. They are added as 
an icon to the toolbar  and as options to the menus. Different ways are offered to 
import cataloged assets: 

• via the Insert menu options 
Slides from Cumulus or Picture > From Cumulus

• via the toolbar: 

NOTE: Drag and Drop without Add-In
– Microsoft PowerPoint 2008 supports drag & drop of cataloged pictures 
and media from Cumulus into the PowerPoint application. Click the ALT key 
and drag & drop the record into the PowerPoint presentation. 
– Microsoft PowerPoint 2007 supports drag & drop of cataloged pictures 
and media from Cumulus into the PowerPoint application. 
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Integrating the PowerPoint Add-In 
The installation and integration of the Cumulus PowerPoint Add-In is different for each 
operating system. 

Under Windows

Under Windows the Cumulus PowerPoint Add-In is available for Microsoft Office 
2010/2013/2016 (64-bit). It can be installed and integrated with the standard Cumulus 
Client installation process. If the PowerPoint Add-In option of the Choose Install Set 
dialog was activated during installation, the Cumulus menu entries and icons will be 
available in PowerPoint application. 

But you can also install and integrate the add-in later. For this purpose Canto provides 
a script for installation. This script as well as one for uninstalling can be found in the 
corresponding language subfolder of the PowerPoint folder in the Adapters folder inside 
the Cumulus Client installation folder, e.g. C:\Program Files\Canto\Cumulus 
Client\Adapters\PowerPoint\en 
Any script has to be executed with administrator permissions. Use right-click to invoke 
them.

Use the script InstallAddin.cmd to install the Cumulus PowerPoint Add-In. The 
Cumulus PowerPoint Add-In will be installed for all users on the machine and the 
Cumulus menu entries and icons will be available to any user of the PowerPoint appli-
cation. To uninstall the add-in, use the UninstallAddin.cmd script. 
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NOTE: Macro Security of Microsoft PowerPoint
For adding the Cumulus PowerPoint Add-In, the macro security level of your 
PowerPoint application must either be set to medium or low. To set the secu-
rity level, you have to open your PowerPoint application and select Tools > 
Macro > Security. 

Under macOS

To integrate the Cumulus PowerPoint Add-In with the PowerPoint application of MS 
Office:

1. Open your PowerPoint application.

2. Select Tools > Add-Ins. A dialog opens that lists all available Add-Ins for your 
PowerPoint installation.

3. Click the Add button. A standard dialog for selecting opens.

4. Navigate to the Adapters folder of your Cumulus Client installation folder. Open 
the Adapters folder, then the PowerPoint folder and finally the en folder. Select 
Import from Cumulus and click Open.

The list with all available Add-Ins for your PowerPoint installation is displayed and 
now contains the entry Import from Cumulus. Make sure the Import from 
Cumulus checkbox is activated.

If a warning appears that it is dangerous to install any macros, click Enable Mac-
ros.

5. Click OK. 
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Now your PowerPoint application is aware of the Cumulus PowerPoint Add-In and the 
menu entries and icons will be available accordingly. 
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Importing Cataloged Slides, Images or Objects
You can import cataloged slides, images and objects (media) from Cumulus into Mic-
rosoft PowerPoint presentations. You may import all image and object formats which 
PowerPoint supports.

When you import cataloged slides, they are always added at the end of the current 
presentation and the layout of the master slide is applied. When you import cataloged 
images or objects, they are inserted into the current slide. To import cataloged slides, 
images or objects:

1. Start your Cumulus application if it is not already running.

2. Select the record of the asset to be imported.

NOTE: Cumulus must have access to the assets – wherever it is stored: on your 
hard disk, in Cumulus Vault, on an FTP server... 

3. Open the PowerPoint presentation to which you want to add the cataloged asset.

4. If you are importing pictures or media:
Select the slide in which you want to place the picture or media.

5. Click on , OR 
select Insert > Slides from Cumulus, OR 
select Insert > Picture > From Cumulus
(in 2007/8 MS Office System to be found on the Add Ins tab).

NOTE: For Cumulus Vault Users Only!
If the asset is stored in Cumulus Vault and the option Ask for Version to Get is 
activated Cumulus will prompt you to select the version. 
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You are asked whether images or objects should be embedded or linked. 

Embedded images and objects will be stored with the presentation whereas 
linked ones require access to the files themselves to be displayed. (For more infor-
mation on linked and embedded objects, see the background information below.

6. Click the desired button.

The asset will be inserted into the current slide.

NOTE: You may also select multiple assets to be imported. Cascading files will 
be inserted on top of each other in the same order as viewed in Cumulus (last 
on top.) 

BACKGROUND INFO:  Linked and Embedded Objects

The main differences between linked objects and embedded objects are 
where the data is stored and how it is updated after it is placed. 
Linked: When an object is linked, information is updated if the source file was 
updated. Linked data is stored in the source file only. The presentation stores 
only the location of the source file and displays a representation of the linked 
data. Use linked objects if file size is a consideration. But be aware that you have 
to copy the linked objects separately if you copy the presentation to another 
storage media or computer.
Embedded: When an object is embedded, information in the presentation 
doesn't change if you modify the source file. Embedded objects become part 
of the presentation and, once inserted, are no longer part of the source file. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH INDESIGN DOCUMENTS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Working with InDesign Documents
Cumulus provides special support for InDesign documents. This support is based on 
specific modules which allow:

• multipage previews 
• separate records for pages
• full text search in captured document text
• detection of contained and referenced assets
Cumulus’ enhanced support for InDesign documents is provided for documents of 
versions up to InDesign CC.

When cataloging, Cumulus can capture general document information. If you have 
installed the Cumulus DocWatch Plug-in for Adobe InDesign on the machine where 
the InDesign documents are created and edited, Cumulus can also capture specific 
document information. (See “DocWatch Plug-ins for InDesign,” below, for details.)

Special modules for InDesign documents are:

• DocWatch Plug-ins for InDesign
• InDesign AssetStore Module
• InDesign Filter

DocWatch Plug-ins for InDesign

The Cumulus DocWatch Plug-in for Adobe InDesign enables Cumulus to embed the 
metadata of an InDesign document into the XMP (EXtensible Metadata Platform) part 
of the document. The Cumulus InDesign Filter and InDesign AssetStore can make use 
of such metadata and capture information on InDesign documents when they are cat-
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aloged or previewed. The InDesign AssetStore requires such metadata to extract 
pages in order to provide separate records for these pages. 

The Cumulus DocWatch UI Plug-in for Adobe InDesign adds a new entry to InDesign’s 
Preferences menu, Cumulus DocWatch. (See “DocWatch Properties,” below, for 
details.)

Installing the DocWatch Plug-in

The Cumulus DocWatch Plug-in and the Cumulus DocWatch UI Plug-in for Adobe 
InDesign must be installed on each computer where the InDesign documents you 
want to catalog are created or edited.

• If you are using the Cumulus InDesign Client, the proper DocWatch Plug-in and 
the DocWatch UI Plug-in for your Adobe InDesign version are installed automati-
cally with the InDesign Client installation.

• If the Cumulus InDesign Client is not installed on your system, you must add the 
DocWatch Plug-in and the DocWatch UI Plug-in manually to your InDesign instal-
lation. 

DocWatch (and DocWatch UI) Plug-ins for various Adobe InDesign versions are pro-
vided with any Cumulus standard installation. You find them in the Adapters folder in 
your Cumulus Client installation folder.

To manually install the plug-in for Adobe InDesign:

1. (Windows:) Copy the CumulusDocWatch folder for your InDesign version to the 
Plug-Ins folder of the Adobe InDesign installation.
OR
(macOS:) Copy both the CumulusDocWatch [xx].InDesignPlugin and 
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CumulusDocWatchUI [xx].InDesignPlugin files for your InDesign version to the 
Plug-Ins folder of the Adobe InDesign installation

DocWatch Plug-in folders provided under Windows:

• InDesign 2020 x64
• InDesign CC 2019 x64
• InDesign CC 2018 x64
• InDesign CC 2017 x64
• InDesign CC 2015 x64
• InDesign CC 2014 x64
• InDesign CC x64
• InDesign CS6
• InDesign CS5.5
• InDesign CS5

DocWatch Plug-in files provided under macOS:

• For InDesign 2020:
CumulusDocWatch 2020.InDesignPlugin and CumulusDocWatchUI 
2020.InDesignPlugin

• For InDesign CC 2019:
CumulusDocWatch CC2019.InDesignPlugin and CumulusDocWatchUI 
CC2019.InDesignPlugin

• For InDesign CC 2018:
CumulusDocWatch CC2018.InDesignPlugin and CumulusDocWatchUI 
CC2018.InDesignPlugin
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• For InDesign CC 2017:
CumulusDocWatch CC2017.InDesignPlugin and CumulusDocWatchUI 
CC2017.InDesignPlugin

• For InDesign CC 2015:
CumulusDocWatch CC2015.InDesignPlugin and CumulusDocWatchUI 
CC2015.InDesignPlugin

• For InDesign CC 2014: 
CumulusDocWatch CC2014.InDesignPlugin and CumulusDocWatchUI 
CC2014.InDesignPlugin

• For InDesign CC: 
CumulusDocWatch CC.InDesignPlugin and CumulusDocWatchUI CC.InDesign-
Plugin

• For InDesign CS6:
CumulusDocWatch CS6.InDesignPlugin and CumulusDocWatchUI CS6.InDesign-
Plugin

• For InDesign CS5.5:
CumulusDocWatch CS5.5.InDesignPlugin and CumulusDocWatchUI 
CS5.5.InDesignPlugin

• For InDesign CS5:
CumulusDocWatch CS5.InDesignPlugin and CumulusDocWatchUI CS5.InDesign-
Plugin

Captured Information 

The Cumulus DocWatch Plug-in for Adobe InDesign extracts the following informa-
tion from an InDesign document and saves them to the XMP section of the document:

• Document Text
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• Font Names 
• Image Height 
• Image Width
• Number Of Pages 
• Number Of Layers 
• Preview/Thumbnail of the first page (InDesign version 2.0 or later)
• Preview/Thumbnail of all pages (InDesign version CS2 or later)
• Software 
• Related Sub Assets (called ’Contained Assets’ in versions prior to Cumulus 7)

DocWatch Properties

By default, the DocWatch Plug-in extracts a preview of each page of an InDesign doc-
ument. Especially for large documents, this may increase the amount of collected 
metadata significantly. In order to reduce the amount of collected metadata and thus 
improving the overall performance, this behavior can be configured. The 
DocWatch UI Plug-in adds a new entry to InDesign’s Preferences menu, Cumulus 
DocWatch.
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To adapt the behavior of the Cumulus DocWatch Plug-in:

1. In InDesign, select Preferences > Cumulus DocWatch.
The Cumulus DocWatch Properties window is displayed.

2. Select whether there shall be a preview for each page of a document, or for the 
first page only.

3. Select the desired quality of the preview (the higher the quality, the higher the 
amount of data to be stored).

4. Confirm your settings with OK.
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NOTE: Export options
In order to increase the quality of generated PDFs via the Cumulus InDesign Cli-
ent, users of Cumulus 11.0.1 or 11.0.2 may want to activate the Embed images 
when exporting to ‘Adobe PDF (Print)’ format option (which is deactivated by 
default for performance reasons).
Starting with Cumulus 11.0.3, this option is obsolete, because PDFs are now 
always created with high quality images.

InDesign AssetStore Module

Based on the information stored in the XMP section, the InDesign AssetStores enables 
Cumulus to create one record for each page of the InDesign document during the cat-
aloging process. All these records are created in addition to creating a record for the 
entire document. The records will be assigned to the corresponding document as 
“contained”. A category for each document will automatically be created and the 
records are assigned to these categories.

NOTE: If InDesign AssetStore is not activated for the Asset Handling Set used, 
Cumulus will just create one record for the entire asset.

InDesign Filter 

The Cumulus Filter for Adobe InDesign captures the following information from an 
InDesign document:

• File Format 
• Horizontal Resolution 
• Thumbnail 
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• Vertical Resolution 
Based on the information stored in the XMP section, the InDesign Filter can also cap-
ture the following information:

• Document Text
• Font Names 
• Image Height 
• Image Width
• Number Of Pages 
• Number Of Layers 
• Thumbnail
• Software 
• Related Sub Assets (with versions prior to Cumulus 7 called ’Contained Assets’)

Defining Filter Properties

The Cumulus InDesign Filter allows you to define properties of assets cataloged with 
this filter. Under Preferences > Asset Handling Sets > Asset Formats tab, select the 
InDesign Filter entry and click on Properties. The Filter Setup dialog opens. 

You can decide whether the thumbnail and preview for an asset should be created 
from page or spread. Note that thumbnail and preview creation is only possible for the 
entire document and not for individual pages. Another setup definition enables 
Cumulus to extract the text contained in the file to the Document Text record field. 
If this option is activated, you can enter the maximal number of characters you want 
to extract. 
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Configuring 
To have the fully functional range of Cumulus for InDesign documents available, some 
configurations have to be made:

• The Cumulus catalogs in which you want to store special additional information 
on cataloged documents have to be prepared. (See “Preparing Catalogs,” below, 
for details.)

• Windows and Mac OS X only:
To capture additional information while cataloging, the Cumulus plug-in for 
Adobe InDesign has to be installed on each computer where the InDesign docu-
ments you want to catalog are created. (See “Installing the DocWatch Plug-in”, for 
details.)

• The Asset Handling Set(s) used for cataloging InDesign assets must be set up for 
optimized InDesign support. (See “Optimizing Asset Handling Sets for InDesign 
Support,” below, for details.)

Preparing Catalogs

Of course, Cumulus can only capture the information contained in the cataloged 
assets. The captured information will be stored in Cumulus record fields. The corre-
sponding record fields have to be included in the catalog to which you want to add 
the assets.

Some of the fields “fed” by the special InDesign modules may not be active in the cat-
alog to which you want to add the InDesign documents. To include them in a catalog, 
you have to add the corresponding fields to the Record Fields in the Catalog Settings 
dialog before cataloging your documents or updating your records. (For details on 
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how to add record fields to a catalog, see “Adding Fields” .) Note that only the Cumulus 
Administrator or a user who has the appropriate permissions is allowed to change the 
settings of a catalog and add record fields. 

Optimizing Asset Handling Sets for InDesign Support

To optimize an Asset Handling Set for InDesign support:

• Activate the InDesign Filter and define its properties (as described above.)
• Activate the InDesign AssetStore module (in order to have separate records for the 

document pages.)

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SPECIALIZED USAGE WORKING WITH INDESIGN DOCUMENTS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Further Special InDesign Support
The following modules also provide special support for InDesign documents:

• Cumulus AXR™ (Asset Cross References) is able to detect links and place assets in 
Adobe InDesign documents. Note when using Cumulus Workgroup, the refer-
enced assets must be cataloged before Cumulus can detect them.

• The HELIOS Filter supports HELIOS XPV preview files. This enables Cumulus to pro-
vide multipage previews for Adobe InDesign documents. If an XPV preview file for 
such a document is available, the HELIOS Filter will extract the data that Cumulus 
requires to provide a multipage preview.

• The Cumulus XMP (Extensible Metadata Platform) Filter extends Cumulus' func-
tionality, when adding XMP files (e.g. Adobe Sidecar) to your catalogs. This filter is 
primarily employed as sub filter for embedded XMP data in any file format like PDF, 
JPEG, TIFF and Adobe Photoshop, Illustrator and InDesign. This means first the filter 
for the file format is invoked and then this filter.
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Assigning Individual Permissions for 
Records and Categories 

What functions a user is allowed to perform on records, assets and categories is con-
trolled via the various permissions that are set via the User Manager. These permis-
sions can either apply to all catalogs a user has access to, or can be catalog-specific. 

The same applies to roles, if Cumulus runs in role mode. In this case, the permissions 
of a user are determined by the roles he/she is assigned to. For details on permission, 
see “Advanced View: Permissions” . For details on roles, see “Working with the Role-
Based Mode” .

In addition to these general permissions settings, users (or roles) can be granted indi-
vidual permissions on specific records, asset and categories. 

NOTE: Individual permissions are always added to the user’s general permis-
sions. There is no way to reduce or revoke permissions a user has been assigned 
via the User Manager.
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On Individual Record/Category Permissions 
Optional feature! May not be available with your Cumulus configuration.

Cumulus provides a Properties dialog for records and categories where you can grant 
a user or role individual permissions on the currently selected items. There are different 
permissions for records and for categories.

For assigning individual permissions, there are several ways:

• Employing a Permissions Template. Thus, individual permissions can be granted to 
multiple users/roles at a single blow, as defined in the Permissions Template.

OR

• Granting individual permissions to selected users/roles one by one. To do so, you 
must first select the users/roles to which you want to grant the permissions.
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Setting Individual Permissions
PRECONDITIONS: 

• In order to search for users, you must have the Browse for Users permission.
• In order to give other users individual permissions to records, you must have the 

application permission Modify Item Permissions for the respective records. 
• In order to give other users individual permissions to categories, you must have 

the application permission Modify Item Permissions for the respective categories. 
For details on how to set general user permissions, see “Application Permissions” .
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For Records/Categories
To grant a user individual permissions for selected records or categories: 

1. Right-click on a record or category and select Properties from the shortcut menu. 
The Properties window appears.

2. Click the Permissions tab. 
Users/roles that have already individual permissions are initially displayed in the 
users list. 

Now, you can either grant individual permissions to selected users or roles one by one, 
or you can employ a Permissions Template.

Granting Permissions One by One

To grant individual permissions to selected users or roles:

1. If the desired user is not already shown, click Add Users. 
The Add User window is displayed. 

2. Search for respective users. Click OK to add them to the list in the Permissions 
section.
OR
If the desired role is not already shown, click Add Role and select a role to add it 
to the list in the Permissions section.

3. Select a user or role from that list and activate the permissions you want to assign, 
or deactivate previously granted individual permissions to revoke them.
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4. Click Apply to save your changes and continue to assign individual permissions 
to further users.
OR 
Click OK to save all changes and close the Properties window.

Granting Permissions Employing Templates

To employ a Permissions Template:

1. Click Use Template and select the template you want to use.

2. Click Apply to save your changes and continue to assign individual permissions 
to further users.
OR 
Click OK to save all changes and close the Properties window.

NOTE: With Permission Templates, both the permissions to be granted and the 
respective users are specified in the template itself. You can not assign a Per-
missions Template to a user selected from the user list on the Permissions tab. 
For more information on Permissions Templates, see “Overview: Permissions 
Templates” .)
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SPECIAL TECH INFO:  Configuring Authenticators’ User Search Criteria

With the Cumulus Built-in authenticator you can search for the login names as 
well as for first, middle or last names. With LDAP authenticators, a search for 
login names is performed by default. The default search criteria for the LDAP 
authenticator can be changed in the LDAP.xml file (located in the conf folder 
inside the Cumulus Server installation folder.)

Additional Information on Category Permissions

• Categories Representing Catalogs
The Properties Window for a category representing a catalog (a “root” category) 
does not provide a Permissions tab. Because such a category is on the highest hier-
archical category level, only child permissions can be defined for it. (For details on 
child permissions, see “For Subcategories” .)

• Moving Categories
To move a category, the user needs the permission Modify Category for the cate-
gory to be moved and the permission Create Category for the ‘absorbing’ cate-
gory (the category which will house the moved category). A moved category 
maintains its permissions.
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For Subcategories 
This feature enables you to define permissions for any subcategory created under the 
selected category. These permissions are set on the Permissions for Subcategories 
tab of the Properties window for categories.

Subcategories can either inherit the permissions defined for the ‘parent’ category 
(which is the default setting), or they can have their own permissions. Note that once 
a subcategory is created, its permissions can be modified individually. Thus it is very 
easy to define the level(s) of a categories tree a user or role is allowed to edit.

NOTE: If you change permission settings for a ‘parent’ category, you will be 
asked whether these changes should be applied to its subcategories as well. 

To define explicit permissions for any subcategories created under a selected cate-
gory:

1. Right-click on a record or category and select Properties from the shortcut menu. 
The Properties window appears.

2. Click the Permissions for Subcategories tab.

3. Activate the Defined below option.

Now, you can either grant individual permissions for subcategories to selected users 
or roles, or you can employ a Permissions Template.
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Granting Permissions One by One

To grant individual permissions to selected users or roles:

1. If the desired user is not already shown, click Add Users. 
The Add User window is displayed. 

Search for respective users. Click OK to add them to the list in the Permissions 
section.

OR

If the desired role is not already shown, click Add Role and select a role to add it 
to the list in the Permissions section.

2. Select a user or role from that list and activate the permissions you want to assign, 
or deactivate previously granted permissions to revoke them.

3. Click Apply to save your changes and continue to assign individual permissions 
to further users.
OR 
Click OK to save all changes and close the Properties window.

Granting Permissions Employing Templates

To employ a Permissions Template:

1. Click Use Template and select the template you want to use.

2. Click Apply to save your changes and continue to assign individual permissions 
to further users.
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OR 
Click OK to save all changes and close the Properties window.

NOTE: With Permission Templates, both the permissions to be granted and the 
respective users are specified in the template itself. A Permissions Template can 
not be assigned to a user selected from the user list on the Permissions tab. For 
more information on Permissions Templates, see “Overview: Permissions Tem-
plates” .)
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View the Effective Permissions
The effective permissions a user/role has for a given record or category consist of the 
general permissions assigned via the User Manager, plus all individual permission that 
have been granted additionally. These individual permissions are displayed for a 
selected user/role on the Permissions tab of the Properties window. 

For an overview on the effective permission a user/role has for a given record or cate-
gory, use the Effective Permissions tab.

To view the effective permissions of a user or role: 

1. Right-click on a record or category and select Properties from the shortcut menu. 
The Properties window appears.

2. Click the Effective Permissions tab.

3. If the desired user is not already shown, click Add User. 
The Add User window is displayed. 

Search for respective users. Click OK to add them to the list in the Permissions 
section.
OR
If the desired role is not already shown, click Choose Role and select a role to add 
it to the list in the Permissions section.

4. Select a user or role from that list to see the effective permissions...

NOTE: Users/roles that you have selected on the Permissions tab will be dis-
played on the Effective Permissions tab as well, and vice versa. 
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Client Menu Reference

This section serves as a road map to the entire Cumulus product from the perspective

of the user interface. Explanations are given for each of the program’s menus and tool-

bars. 
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The Cumulus Menu 

• About Cumulus 
• Preferences
• Quit Cumulus

The File Menu

• Open Catalog
• Open Recent Catalog
• Close
• New Collection
• Open Collection
• Save Collection
• Save Collection As
• Send Collection Link
• Send Upload Link
• Add Catalog to Collection
• Remove Catalog from Collection
• Save
• Add Assets to Catalog
• Remove Catalog from Collection
• Import
• Export
• Page Setup
•  Print Preview

• Print
• Administration
• Exit

The Edit Menu

• UndoVideo Cloud
• Cut
• Copy
• Paste
• Delete
• Select All
• Deselect All
• Preview Tools
• Preferences

The View Menu

• Palette Mode
• Toolbar
• Statusbar
• Workspace
• Thumbnails
• Details
• Information
• Preview
• Report
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• Record View Set
• Category View Set
• Preview/Thumbnail Sizes
• Sort By
• Sort Direction
• Preview
• Categories

The Find Menu

• Find Records
• Find All Records
• Find Records by Query
• Find Records Assigned to Catego-

ries
• Find Duplicates
• Find Records with Invalid Field Val-

ues
• Find Offline Assets
• Find Versionable Assets
• Invert Collection
• Find Categories
• Find All Categories
• Find Categories by Query
• Show Original Category

• Show Related Categories
• Show Categories Containing
• Remove from Collection

The Metadata Menu

• Information
• Bulk Edit
• Update Record
• Update Formula Fields
• Update Formula Fields
• Assign Metadata From Template
• Run Automatic Tagging
• Find And Replace Metadata
• Assign Label
• Assign Rating
• Assign Categories
• Detach Categories
• Optimize Thumbnail
• Rotate Preview
• Rotate Thumbnail
• Assign Relation
• Show Related
• New Category
• New Related Category
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• New Master Category (optional)

The Asset Menu

• Preview
• Fullscreen Preview
• Fullscreen Slide Show
• Edit
• Video Cloud
• Compare Previews
• View With
• Edit With
• Print With
• Perform Asset Action
• Convert To
• Mail To
• Copy To
• Copy Assets Assigned to Category 

To
• Duplicate Asset and Record
• Create WebAlbum
• Show Location
• Configure Web URL
• Move To
• Rename

• Update Asset Reference(s)
• Change Asset Reference
• Transform JPEG Original
• Check Out
• Undo Check Out
• Check In
• Show History

The Workflow Menu

• [workflow name 1]

The Help Menu

• Contents and Index
• Source
•  About
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The Cumulus Menu

About Cumulus
Displays a dialog that shows the version of Cumulus you’re using. It also provides a 
button that launches your default Web browser and initiates a connection to the 
Canto Website. This requires an Internet connection.

Preferences
Opens the Preferences window, from which you can set all preferences. (See “Custom-
izing Cumulus”, for details.)

Quit Cumulus
Quits Cumulus.
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The File Menu
• Open Catalog
• Open Recent Catalog
• Close
• New Collection
• Open Collection
• Save Collection
• Save Collection As
• Send Collection Link
• Send Upload Link
• Add Catalog to Collection
• Remove Catalog from Collection
• Save
• Add Assets to Catalog
• Remove Catalog from Collection
• Import
• Export
• Page Setup
•  Print Preview
• Print
• Administration
• Exit
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Open Catalog
Opens the Catalog Access Window for the current user on the Catalogs tab. If no user 
is logged in, the Connect to Cumulus Server window is opened instead. 

When opening a catalog you either open it in a separate window or in the window of 
the current collection. Activate the desired option.

Open Recent Catalog
Opens a submenu that lists all catalogs opened recently. Selecting the entry for a cat-
alog will open it. The submenu also includes an entry that allows you to clear the list 
of recently opened catalogs. 
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Connect to Cumulus Server 
This menu item opens a dialog in which you can connect to a catalog on a remote 
Cumulus Server and open the catalog.

When the Connect to Server dialog is opened:

1. Using the drop-down list in the Server field, select the Server you wish to connect 
to. All currently active Cumulus Servers in the network appear in this list. 
If your Cumulus Administrator specified a custom TCP/IP port number for the Cli-
ent-Server connection, enter the IP address and – separated by a colon – the port 
number in the Server field (e.g. 123.123.123:1234).

2. Select either Guest or Registered User. If connecting as a registered user, type 
your user name and password. Your Cumulus Administrator can help you deter-
mine which way you should log on. 

To have Cumulus remember your password for future log-ons, select Remember 
Password.

NOTE: If this option is activated, any collection you save is password protected. 

NOTE: Exported Collections
If this option is activated, any collection you export or mail contains your login 
information. Opening such an exported or emailed collection will connect to the 
Cumulus Server with your login and password. This means that the user who 
opens the collection works as you and has your permissions. If this option is not 
activated, the Connect to Server dialog will appear when an exported or emailed 
collection is opened. 
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3. Click OK. The server is contacted. Once the connection is made, the Catalog 
Access window appears, providing two tabs:. The Catalog tab which lists all cata-
logs your Cumulus Administrator has made available to you, and the Collections 
tab which lists all collections that are available to you.

4. Select a catalog or collection. If you already have a catalog or collection is already 
open, select whether the additional catalog or collection is to be opened in a sep-
arate window or in the window of the current collection. 

5. Click OK. (If you are logged in as the Cumulus Administrator, the Catalog tab of 
the Catalog Access window offers more options. (See “Catalog Access Window 
for Administrators,” below, for details.)
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Catalog Access Window
The Catalog Access window provides two tabs:

• Catalog tab: lists all catalogs your Cumulus Administrator has made available to 
you. 

• Collections tab: lists all collections that are available to you – either your own col-
lections or shared collections provided by other users.

Select the catalog or collection you want to work with and click Open.

TIP: Collections 

The Collections tab provides two buttons:
Properties – opens a window with detailed information on the selected collec-
tion
Delete – deletes the selected collections (if you have the appropriate permis-
sions)

For more information on the Cumulus Collections, see “Collections” .

Catalog Access Window for Administrators

For the Cumulus Administrator, the Catalog Access window is the starting point for 
performing numerous administrative tasks. 

The Catalog tab of the Catalog Access window offers the following buttons and 
options to the Cumulus Administrator:

• New
Opens a dialog for creating a new catalog.
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• Add to List
Opens a dialog for adding an existing catalog to the list of catalogs Cumulus users 
see when they connect to the Cumulus Server. Catalogs already contained in that 
list are grayed out.

• Remove from List
Removes selected catalogs from the list of available catalogs. If Cumulus users are 
currently connected to such a catalog, the Disconnect Client window is displayed. 
Use this window to specify the time until the clients are disconnected and a mes-
sage that is send to the affected users, thus allowing them to finish their work
The catalogs are not deleted, but they are no longer administered by the Cumulus 
Server and thus no longer available to Clients. 

• Rebuild
Opens a dialog in which you can repair (rebuild) the selected catalog. (See “Repair-
ing Catalogs”, for more information.)(See Administrator Guide for more informa-
tion.)

• Migrate
Migrates selected catalogs to the current catalog format.

• Done
Saves the changes and closes the window.

• Open
Opens the selected catalog files. Opening a catalog as the Cumulus Administrator 
is the first step to modifying catalog settings. 

NOTE: For the Cumulus Administrator only, the Catalog Access window dis-
plays catalogs that are damaged. They are displayed in red.
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Close
Closes the active window, e.g. the Collection, Preview, Record or Category Information 
window.
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New Collection
Opens a submenu with two options for creating a new collection: 

• From Selection – The new collection will contain the currently selected records.
• Empty – The new collection will be empty.
For more information on collections see “Collections” .

Open Collection
Opens the Catalog Access window on the Collections tab, displaying all collections 
the current user is allowed to access. (If no user is logged in yet, the Connect to 
Cumulus Server window is opened instead.). 

The Collections tab offers the following buttons:

• Properties – Opens a window for displaying and editing information about the 
selected collection. Which information is provided depends on the collection type.

• Delete – Deletes the selected collection.
• Open – Opens the selected collection and closes the window.
• Done – closes the window without opening a collection
For more information on collections see “Collections” .
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Save Collection
Saves the collection as it is shown.

For more information on collections see “Collections” .

Save Collection As
Saves the collection as it is shown under a new name. A dialog is displayed for you to 
name the new collection. Enter a name for the collection and if you want the collec-
tion to be available for other users, activate the Share Collection option.

For more information on collections see “Collections” .

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE FILE MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Send Collection Link
Opens a submenu with two options for sending collection links via email:

• Selected Records to send a link to a collection that contains the currently selected 
records

• All Records to send a link to the current collection 
Using this collection link, recipients, which don't need to be Cumulus users, may open 
the collection in any web browser. An additional link is offered allowing Cumulus users 
to open the collection with the Cumulus Client application. The sender can specify 
which actions recipients may perform on the assets via Permissions checkboxes in the 
Send Collection Link dialog.

Additionally, you may send personalized collection links. In this case, each recipient 
gets an individual link to the collection which allows Cumulus to monitor usage of 
such collections.

Depending on the permissions of the current user, a new external user can be created 
if a personalized collection link is sent to an email address not known to Cumulus. By 
default, external users have no permissions and no active login. However, they serve 
as a means to monitor the usage of the collection. The Properties window of the 
respective collection provides information about the last time a recipient has 
accessed the collection.

Preconditions: 

• Your Cumulus installation includes Cumulus Portals or Sites.
• A Base Web URL was defined by your Cumulus Administrator in the Cumulus 

Server Settings (Server Console > Remote Admin).
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• Cumulus is configured to work with a mail server (Server Console > Mail Man-
ager). 

• You must have the appropriate Permissions
• The Create External Users permission (Server Permissions > User Administra-

tor Permissions) for sending links to recipients that are not yet known to 
Cumulus, or Use External Users for sending links to already existing external 
users.

• The Create Download Collections permission (Server Permissions > Collec-
tions Permissions).

• For personalized collection links, the (technical) admin user in Portals/Sites must 
have unrestricted run-as permissions (Server Permissions > Run-as Permissions).

To send a collection link:

1. Open a saved collection, or create a new one. If desired, select the records you 
want to include in the collection to be sent.

2. Select File > Send Collection Link > Selected Records or
select File > Send Collection Link > All Records

The first part of the Send Collection Link dialog is displayed, allowing to specify 
settings for the collection to be sent. Most Fields already contain proposals which 
you may adopt or simply overwrite.

3. Specify a name for the collection.

4. The embargo date is the current date by default. Optionally, change the embargo 
date. Recipients won’t be able to access the collection before this date.
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5. The expiration date is two weeks ahead of the current date by default. Optionally, 
change the expiration date. Recipients won’t be able to access the collection from 
this date onwards.

The expiration date is required. If you try to delete it, the value is automatically 
reset to the default.

6. The Base URL for Web Access field displays the base URL specified by your 
Cumulus Administrator. (Only if your Cumulus installation includes more than one 
web server, you may select a different base URL from the drop-down list.)

7. Optionally, set a password. 

If you decide to require a password, you must not forget to communicate it to the 
recipients – otherwise the recipients won’t be able to view the collection.

8. Specify which actions the recipients will be allowed to perform on the assets by 
activating or deactivating the Permissions check boxes.

9. Click Next. The second part of the Send Collection Link dialog is displayed, allow-
ing to specify the recipient(s) and a message

10. Activate Personalize Collection if you want to sent each recipient an individual 
link to the collection. 

With this option activated, the CC: and BCC: field are disabled. The usage of per-
sonalized collections is monitored by Cumulus.

NOTE: If you send a personalized collection to an email address not known to 
Cumulus, a new external user is created for that email address. In the Properties 
window of the collection, you can find information on each recipients last access 
to the collection.

11. Fill in the recipient’s addresses.
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12. The From field is prefilled with your email address. You can overwrite this with a 
different address. 

NOTE: If your Cumulus Administrator has defined a From address to be used with 
all sent mails, the content of the this field is ignored.

13. Enter a Subject and optionally modify the proposed message Text or enter a new 
one.

14. Click Send. The dialog is closed and the collection link is sent to the recipient(s) 
specified in the To field. 

TIP: Copy URL for Other Purposes

Instead of sending the collection link via Cumulus, you may as well copy it from 
the URL field and use it in a different way, e.g. sending it via your email applica-
tion or via Twitter, or inserting it on a web page. In this case, quit the dialog with 
Cancel. 
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Send Upload Link
Opens a window to configure of a link for file upload and send this link to any email 
address. When a recipient clicks the link, a landing page is opened in the Web browser 
that allows the recipient to upload files. Uploaded files are cataloged to the specified 
catalog and gathered in a dedicated upload collection.

(Disabled if you don’t have the appropriate permissions; see below for details.)

Preconditions: 

• Your Cumulus installation includes Cumulus Portals or Sites.
• A Base Web URL was defined by your Cumulus Administrator in the Cumulus 

Server Settings (Server Console > Remote Admin).
• The catalog to which the uploaded files will be added must employ a central asset 

location (Preferences > Catalog Settings > General).
• Cumulus is configured to work with a mail server (Server Console > Mail Man-

ager). 
• You must have the appropriate permissions:

• For at least one catalog, you must be allowed to create records (Catalog Permis-
sions > Application Permissions).

• The Create External Users permission for sending links to recipients that are not 
yet known to Cumulus, or the Use External Users permission for sending links 
to already existing external users. (Server Permissions > User Administrator 
Permissions).

• The Create Upload Collections permission (Server Permissions > Collections 
Permissions).
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• For enabling the upload function, the (technical) admin user in Portals/Sites must 
have unrestricted run-as permissions (Server Permissions > Run-as Permissions).

To send an upload link:

1. Select File > Send Upload Link.

The Send Upload Collection Link dialog is displayed, Most fields already contain 
proposals which you may adopt or simply overwrite. Mandatory fields are marked 
with an  icon. 

2. Specify a name for the collection that holds the uploaded files.

3. The embargo date is the current date by default. Optionally, change the embargo 
date. Recipients won’t be able to upload files before this date.

4. The expiration date is two weeks ahead of the current date by default. Optionally, 
change the expiration date. Recipients won’t be able to upload files from this date 
onwards.

The expiration date is required. If you try to delete it, the value is automatically 
reset to the default.

5. The Base URL for Web Access field displays the base URL specified by your 
Cumulus Administrator. (Only if your Cumulus installation includes more than one 
web server, you may select a different base URL from the drop-down list.)

6. Select the catalog to which the uploaded files will be added. The drop-down list 
for selecting the catalog displays only those catalogs that are employing a Central 
Asset Location and that you are allowed to add assets to, i.e. you have the permis-
sion to create records.
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7. If necessary, specify an Asset Handling Set and/or a Permission Template to be 
used with the uploaded files.

8. The From field is prefilled with your email address. You can overwrite this with a 
different address. 

NOTE: If your Cumulus Administrator has defined a From address to be used with 
all sent mails, the content of the this field is ignored.

9. Fill in the recipient’s addresses.

10. Enter a Subject and optionally modify the proposed message Text or enter a new 
one.

11. Optionally, set a password. 

If you decide to require a password, do not forget to communicate it to the recip-
ients – otherwise they won’t be able to upload files.

12. Recipients get displayed thumbnails of the files they have uploaded. By activating 
the Permissions check boxes you can allow recipients to additionally view the 
information windows for the files and/or preview them.

13. Click Send. The window is closed. an email containing an upload link is sent to 
each of the specified recipient. 

As the creator of an upload collection, you will receive a notification email each time 
someone uploads files via Sites to this collection.
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TIP: Link usage

Via the Properties window of upload or download collection you can get an 
overview on each recipient’s last access to this link.
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Add Catalog to Collection
Opens a dialog to select another catalog to be opened within the current collection.

For more information on collections see “Collections” .

Remove Catalog from Collection
Opens a dialog which lists the open catalogs and lets you choose the catalog to be 
removed from the current collection.

If the collection contains any assets stored in this catalog, their records will be 
removed from the collection.

For more information on collections see “Collections” .
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Save
Saves any changes depending on the active window; e.g. the Record or Category 
Information window.
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Add Assets to Catalog
Open a submenu with following menu options:

• Browse for Assets
• New Empty Record
• Assign Asset to Record
• Recatalog Category Folder
• Setup Auto Cataloging
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Browse for Assets 
Opens a dialog in which you can browse for assets you want to add to a catalog (in 
Cumulus-speak: you want to “catalog”.) Depending on your individual settings several 
options for cataloging might be offered to you before the dialog for selecting the 
assets is opened.

BACKGROUND INFO:  Cataloging Assets

“Cataloging assets” is Cumulus-speak for adding media files to your catalog. 
There are several ways to catalog assets: via menu item, context menu and with 
drag and drop. As you catalog your assets, Cumulus creates special catalog 
entries called records that represent the assets to be managed. Each record 
contains vital searchable information about the asset it represents. 
How Cumulus deals with your assets during the cataloging process depends 
on the Asset Handling Set used. Asset Handling Sets define many aspect of asset 
handling, including which Asset Stores and Filters should be used, where the 
assets should be stored when cataloged, and which metadata template (if any) 
should be automatically applied. 

TIP: Cataloging Asset via Drag & Drop

You also catalog assets by dragging them from an Explorer/Finder window into 
the Cumulus window.
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Options While Cataloging

Several options for the cataloging process are possible – most of them depend on the 
selections made in your User Settings ( Cumulus / Edit > Preferences > User 
Settings > General or Asset Handling.) 

Showing Progress Dialog

If activated in the User Settings, a progress dialog is shown while Cumulus is catalog-
ing the assets. With Cumulus, you can have multiple cataloging processes running 
simultaneously and you can go on working with Cumulus while cataloging. With a 
Cumulus Client under Mac OS X you see an icon for each of the processes.

Selecting Asset Handling Set

If you have activated the option Show dialog when cataloging in the Asset Handling 
section of your User Settings, you will be prompted to select an Asset Handling Set for 
each cataloging process. 

Make sure the selected Asset Handling Set fits to the catalog you want to add the 
assets to. 

In the list of Asset Handling Sets, you can use the Customize option to access the pref-
erences of the selected Asset Handling Set– if you have the appropriate permissions. 
(See “Overview: Asset Handling Sets” for details on how to set up Asset Handling Sets.)

Selecting Catalog

If you have multiple catalogs open in one window, you are prompted to select the cat-
alog to which you want to add the assets. 

If you have activated the option Show dialog while cataloging in your User Settings 
and have multiple catalogs open in one window you are prompted to select the cat-
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alog to which you want to add the assets and select an Asset Handling Set for this cat-
aloging process. Make sure the selected catalog and the selected Asset Handling Set 
match.  

Employing the Metadata Editor 

If the Asset Handling Set you use, has the Show Metadata Editor for New Records acti-
vated, a dialog is displayed when cataloging assets.It allows you to add metadata 
information to the records of those assets you are just cataloging. (The fields displayed 
depend on the Record View Set that was selected for the Metadata Editor in the set-
tings of the Asset Handling Set.) You can use a Metadata Template and/or manually 
enter metadata information.

If you don’t want to add any of your own information to the current asset’s record, 
select the Skip button. 

Creating TAG Files 

If you catalog assets from a location where you are allowed to save files, Cumulus can 
create a TAG file for each cataloged asset. The file has the same name as the asset with 
the extension .tag added and is saved in the folder where the asset resides. TAG files 
are a standard exchange file format for metadata information on the asset. TAG files 
hold all of the information that can be viewed in the Asset Information – and more. For 
example, if a particular asset has been cataloged into different catalogs, this informa-
tion is part of that asset’s TAG file.

If you want Cumulus to create these TAG files while cataloging, use an Asset Handling 
Set that has an activated asset storage module Cumulus Metadata Support (proper-
ties set to Always).
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New Empty Record
Creates an empty record. Opens a Dialog where you can specify the catalog to which 
the record is added, as well as the Asset Handling Set and the Permissions Template 
to be used with the new record. You can assign metadata and an asset to such a 
record later on. 

TIP: Assigning An Asset

To assign an asset to an empty record later on, use the Change Asset Refer-
ence function.

Assign Asset to Record

Only available if one – and only one – record is selected that has no asset assigned to.

Opens a dialog to select the asset to be assigned to the record. Subsequently, the 
asset is cataloged and assigned to the selected record. (If applicable, the asset is also 
copied or moved to a Central Asset Location.) Optionally – depending on what is 
specified for the current catalog in the User Settings – a dialog for selecting an Asset 
Handling Set is displayed first.
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Recatalog Category Folder
Synchronizes the content of the selected folder category with the contents of the 
folder represented by this category. This option compares the contents of the folder 
and Cumulus: files that are new in the folder are automatically cataloged. (Available for 
folder categories only.) 

Setup Auto Cataloging

Opens a dialog to define auto cataloging for the selected category. (See “Categories 
and Auto-cataloging”, for details.) (Available for folder categories only.)

TIP: More Autocataloging Features

Optional features provide additional auto-cataloging options; e.g. a Cumulus 
Scheduler Action that enables Cumulus to check a standard POP3 email 
account and retrieve and automatically catalog any emails it finds. For more 
information, see “Provided Scheduler Actions” .
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Import
Opens a submenu with several menu options. Each opens a dialog in which you can 
select an appropriate file type for import. The various file types are listed by the import 
type below:

• Assets – Lets you add assets to catalogs. After selecting an Asset Handling Set, a 
dialog opens to browse for the assets you want to add. For a description on how 
to go on see “Browse for Assets” .

• Records – Lets you import records that were exported to XML files or to Cumulus 
Record Exchange Files. If you have multiple catalogs open in one window, you are 
prompted to select the catalog to which you want to import the records. The 
imported records are appended to the active collection. 

• Categories – Lets you import categories that were exported to XML files or 
Cumulus Category Exchange Files. If you have multiple catalogs open in one win-
dow, you are prompted to select the catalog to which you want to import the cat-
egories. The imported categories are appended to the active/selected catalog. If a 
category in the import file has the same name as an existing category, the category 
is not imported. 

• Collection – Lets you import collections stored with previous Cumulus versions on 
the computer running the Client application and collections sent to you via email. 
If you have multiple catalogs open in one window, you are prompted to select the 
catalog which you want to import the collection to.

• From Text/CSV File – Lets you import metadata from text files (separated by 
delimiters.) As a comma is a very common delimiter, such files are also called 
Comma Separated Value (CSV) files. This import option enables you to import 
metadata from other database systems into Cumulus catalogs. 

For detailed information on importing, see “Importing and Exporting” .
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Export
Opens a submenu with several export options. Each opens a dialog in which you can 
name an appropriate file type for export. All exported files can be used on any sup-
ported Cumulus platform. The options are explained below:

• Selected Records – Exports the currently selected records. (This menu item is dis-
abled if no records are selected.)

• All Records – Exports all records of the active collection. If you want to export all 
records of the catalog(s) included in the collection, you have to perform Find > 
Find All Records first.

• Selected Categories – Exports the currently selected categories in the active col-
lection. (This menu item is disabled if no categories are selected.)

• All Categories – Exports all categories of the Category pane. 
• Collections – To store collections in any location other than the Cumulus Server, 
• Mail Collection To – Sends a collection via email to another user. However, don’t 

forget: Since a collection is always connected to catalog(s), it is necessary for the recip-
ient to have access to the catalog(s) ‘serving’ the collection. To make use of a collec-
tion you received via email you use the import function.

For detailed information on exporting, see “Importing and Exporting” .
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Page Setup
This menu item opens a standard page setup window from which you can configure 
your printing options. The options available to you will depend on your system con-
figuration. See your computer’s operating system manual for details.

Under Mac OS, the Preview button allows you to view the printed output before it gets 
sent to your printer. Under Windows, Cumulus provides a Print Preview menu item.

 Print Preview
This option allows you to view the print output before it gets sent to your printer. The 
output options are taken from the current print settings.
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Print
Opens a submenu with the following menu options: 

• Selected – Prints selected items (records, categories or preview sections) – 
depending on the active window or pane. 

• All – Prints all items – depending on the active window or pane. 
The print function is context sensitive (meaning that what is printed depends on the 
position of the cursor). If the active window or pane is: 

• the category pane, the categories (all or selected) will be printed as they appear in 
the Category window. Make sure to expand the category list if you want to see all 
the subcategories in the print out. 

• the record pane and thumbnail or details view is the current view mode, the 
records (selected or all of the active collection) are printed using Print Templates. 
(For more information on Print Templates, see “Print Templates” .)

• the record pane and information view is the current view mode, the information 
displayed will be printed.

• an information window, the information displayed in the window will be printed.
• a preview window, the preview will be printed – in case it is available as a pixel 

image (e.g. JPEG, TIF or GIF). The preview will be printed in the size of the paper 
selected under Page Setup. This may take a while! 
If your intention is to print the actual asset, instead of its record or preview, see 
“Print With” , for details.
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Administration
Opens a submenu with several administration options:

• Server Console (only if installed on the machine)
• Connect to Server As
• Change Password
• Switch Application Language
• Prepare Catalog
• Rebuild Catalog
• Backup Catalog
• Compress Catalog
• Merge Categories
• Migrate Catalog
• Convert Catalog To
• Convert WPP/ICP 3.0 Triggers
Most of these options are only available if you are Cumulus Administrator or have the 
appropriate permissions. Descriptions on how to use the administrative functions for 
catalogs see “Catalog Maintenance” . 
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Server Console (only if installed on the machine)
Opens a dialog in which you can administrate the Cumulus Server if you have the per-
missions to do so. (For more information, see “Catalog Maintenance” .)
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Connect to Server As
Opens a dialog to log in to the Cumulus Server and then act as a different user (“Run 
As”). – This function is useful for substitution purposes, e.g. for holiday replacement.

The user who logs in must have the Run-As-permission to act as the specified user. 
(For more information, see “Run-as Permissions” .)

IMPORTANT! A user A running as user B literally becomes user B, i.e. gets all 
permissions (and role assignments, if any) of user B. To become active again, 
user A must login anew.

Change Password

Opens a dialog to change your Cumulus user password. (Disabled if you don’t have 
the appropriate permissions.)
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Switch Application Language
Opens a dialog to select a different language for your Cumulus application’s user inter-
face. Expand the list to see the languages Cumulus supports.

Languages marked in bold already provide a localized user interface. For all other lan-
guages, an English user interface is displayed, but specific writing capabilities for the 
selected language are supported. This applies to the category tree, input fields and 
Quicksearch function.

Select the desired language and click OK. You must quit the Cumulus application and 
start it again before the language switch takes effect. If the selected language is not 
available on your computer, the Cumulus application language will default to English.
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Prepare Catalog
Opens a submenu with options for preparing catalogs to manage different standard 
metadata formats. (For this function, you need the Administrator permission Modify 
Catalog Settings for the catalog to be prepared, and the Server permissions Modify 
Asset Handling Sets and Manage User Asset Handling Set.) 

For IPTC

IPTC (International Press Telecommunication Council) is a standard for digital text 
applied to an image. Applications used for professional imaging support IPTC; e.g. the 
text information in Photoshop is a subset of the IPTC information. 

Cumulus can read IPTC metadata information while cataloging. You can view and edit 
this metadata and Cumulus can write your changes back to the asset. Reading and 
writing back IPTC data is possible for assets of the following formats: JPEG, TIFF, PSD, 
and EPS. (For more information on writing back metadata, see “Write back Metadata” .)

If you want to capture IPTC data from assets and to write back IPTC data to assets, the 
Asset Handling Set(s) and the catalog(s) managing these assets must be prepared for 
this feature. IPTC record fields have to be added to the catalog(s) and their properties 
have to be enabled for field linking. The Writing back Metadata option must be acti-
vated in the Asset Handling Sets used to handle the assets containing IPTC data. 

The function makes the preparation process easy. Follow the on-screen instructions.
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NOTE: To view the captured metadata, the corresponding record fields must 
be included in one of your Record View Sets. If none of your Record View Sets 
provide a view that includes the fields, you have to add these fields to one view 
of at least one Record View Set. For a description on how to add fields to a view, 
see “Adding a Field to a Record View” . 

For EXIF

EXIF (Exchangeable Image File Format) is a standard for storing interchangeable infor-
mation in image files, especially those using JPEG compression. Most digital cameras 
now use the EXIF format. Cumulus can read EXIF metadata information while catalog-
ing. You can view and edit this metadata.

If you want a catalog to store EXIF information on assets, you have to add the EXIF 
record fields to this catalog. This function does it for you. Follow the on-screen instruc-
tions.

NOTE: To view the captured metadata, the corresponding record fields must 
be included in one of your Record View Sets. If none of your Record View Sets 
provide a view that includes the fields, you have to add these fields to one view 
of at least one Record View Set. For a description on how to add fields to a view, 
see “Adding a Field to a Record View” . 

For XMP

Adobe’s XMP (Extensible Metadata Platform) is a labeling technology that allows you 
to embed metadata into the asset itself. With an XMP-enabled application (e.g. all 
applications of Adobe Creative Suite), information about a project can be captured 
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during the content creation process and embedded within the file and into a content 
management system. 

Cumulus can read XMP metadata information while cataloging from assets of the fol-
lowing formats: PDF, JPEG, DNG, TIFF and Adobe Photoshop, Illustrator and InDesign 
files. You can view and edit this metadata and Cumulus can write your changes back 
to the asset. Writing back XMP data is only possible for assets of the following formats: 
JPEG, DNG, TIFF, and PSD. (For more information on writing back metadata, see “Write 
back Metadata” .)

If you want to capture XMP data from assets and to write back XMP data to assets, the 
Asset Handling Set(s) and the catalog(s) managing these assets must be prepared for 
this feature. XMP record fields have to be added to the catalog(s) and their properties 
have to be enabled for field linking. The Writing back Metadata option must be acti-
vated in the Asset Handling Sets used to handle the assets containing XMP data. 

The function makes the process of preparation easy. Follow the on-screen instruc-
tions.

NOTE: To view the captured metadata, the corresponding record fields must 
be included in one of your Record View Sets. If none of your Record View Sets 
provide a view that includes the fields, you have to add these fields to one view 
of at least one Record View Set. For a description on how to add fields to a view, 
see “Adding a Field to a Record View” . 
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Rebuild Catalog

Opens a dialog in which you can repair (rebuild) the active catalog. (See “Repairing 
Catalogs”, for more information.)

Backup Catalog

Opens a dialog in which you can save a backup copy of the active catalog. (See “Back-
ing Up Catalogs”, for more information.)

Compress Catalog

Opens a dialog in which you can compress the active catalog. (Disabled if the catalog 
is already compressed as much as possible.) (See “Compressing Catalogs”, for more 
information.)
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Merge Categories
Merges the records assigned to different folder categories. This function affects only 
those categories created automatically by Cumulus when cataloging. If some of a cat-
alog’s assets were cataloged from a Windows computer and others were cataloged 
from a Mac computer, then you may have category structures that are the same, 
though named differently because of the directory-naming convention differences 
between the two operating systems. This application merges the records assigned to 
those two category structures. It does not affect other categories.

Migrate Catalog 

Open a dialog to convert older Cumulus catalogs into a format compatible with the 
latest Cumulus version. (See “Migrating Catalogs”, for more information.)
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Convert WPP/ICP 3.0 Triggers
Converts the triggers from Web Publisher Pro or Internet Client Pro 3.0 that are 
assigned to the catalogs included in the current collection. The Web Publisher Pro or 
Internet Client Pro 3.0 Mail Notification feature has created triggers for all users who 
have activated the Watch Asset option. These triggers need to be converted before 
they can be used with a Cumulus 7 Server. 

IMPORTANT! Have this function run on every catalog that might have triggers 
assigned. 

Exit

Quits Cumulus.
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The Edit Menu
• Undo
• Cut
• Copy
• Paste
• Delete
• Select All
• Deselect All
• Preview Tools
• Preferences
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Undo
Allows you to undo some of the errors you may have made while entering text into 
fields. It reverts to the former text entry. It works for string fields of the Information win-
dow or view, for the Quicksearch entry field and when renaming categories. (Disabled 
if not available.)

Note that this function is limited to revert text entries, it will not reverse any functions. 

Cut
Removes the current item or text selection and places it on the Clipboard so that it can 
be pasted elsewhere.
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Copy
Copies the current item or text selection to the Clipboard so that it can be pasted else-
where. When copying records or categories, a temporary metadata template is cre-
ated additionally that can be used to transfer selected metadata to other items.

Paste
Places the contents of the Clipboard into the current location or text insertion point. 
Pasting a copied record into a catalog duplicates the record, but with a different cre-
ation date. Pasting a copied category into a category tree creates a new category with 
the same name below the selected target category. (This works only if “Keep category 
names unique” is not activated in the Catalog Settings.)
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Paste Metadata
Opens the previously copied metadata in the Bulk Edit window so that it can be cop-
ied onto the current selection of records or categories. For details on how to use the 
Bulk Edit window, see “Bulk Edit” ”. 

NOTE: Pasting metadata only works with user editable fields that are displayed 
according to the Current Record View Set or Category View Set. Pasting meta-
data does not affect currently invisible fields and fields the user has no permis-
sion to edit.
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Delete
Deletes the selected records or categories from the catalog after confirmation of the 
action. (Disabled if no records or categories are selected.)

The confirmation dialog for deleting records offers two options: to delete the record 
only or to delete the record and its associated asset, too. This is not undoable. Make 
sure that you no longer need an asset or that you have a copy elsewhere before delet-
ing one. 

If you decided to have the asset deleted as well but the asset cannot be deleted (e.g. 
because it is read-only access), the record will not be deleted either. Note that records 
that represent assets stored on CDs will be deleted.

Deleting Related Assets
If the record to be deleted represents a preferred alternate, or a variant source or the 
master of a custom relation, you will get a warning that deleting the asset also will dis-
solve the asset relation. At this point you can either confirm or cancel the deletion pro-
cess.
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Select All
Selects all objects or text. The type of selection depends on which window is active 
and whether you have clicked inside a text area.

Deselect All
Cancels any previous selection.

Preview Tools
Opens a submenu that lets you toggle between Hand tool and Select tool and that 
offers functions for the comment tool. For more information on these tools, see “Over-
view: Toolbars for Previews” . (Disabled if no Preview window or view is activated.)

Preferences
Opens the Preferences window, from which you can set all preferences. (See “Custom-
izing Cumulus”, for details.)
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The View Menu
• Palette Mode
• Toolbar
• Statusbar
• Workspace
• Thumbnails
• Details
• Information
• Preview
• Report
• Record View Set
• Category View Set
• Preview/Thumbnail Sizes
• Sort By
• Sort Direction
• Preview
• Categories
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Palette Mode
Changes the view of the Cumulus application to palette mode and back. In Palette 
Mode, the thumbnails and the contents of record fields are displayed as defined in 
selected View Set. 

In palette mode the Cumulus application will shrink to a palette that can conveniently 
be used with another application. That way you can easily drag and drop cataloged 
assets into other applications. All open collections will be changed to palette mode. 
They are displayed on top of each other. The Palette Mode window can be resized to 
fit your needs (and all display changes will be kept when you reopen the palette 
mode). All Cumulus functions remain available; to display the menus select Menu. 

Toolbar
Offers a submenu to select the size of the toolbar and options to toggle the toolbar 
on and off. 

Statusbar
Toggles the statusbar on and off. 
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Workspace
Opens a submenu with options that let you toggle panes of your workspace on and 
off:

• Calendar Pane
• Category Information Pane
• Category Pane
• Collection Basket Pane
• Information Pane
• Preview Pane
• Sub-Pane for Relations
• Thumbnail Pane
Several menu options enable you to open (and close) additional panes in the current 
Collection window and to save this combination of panes as a workspace. A work-
space saves even more information. It includes:

• window size
• window location
• visible panes
• View Sets selected for each pane.
Workspace menu options are:

• Save Current as Default Workspace
• Use Default Workspace
• Save Current Workspace As
• Manage Workspace
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Below these menu options you will find more options if any saved layouts are available 
for you.

The additional panes will be displayed at the bottom of the Category pane.

TIP: Resizing Panes

You can resize the panes by pressing the ALT / Option key and dragging 
the split bar. (Just clicking the split bar will resize the topmost pane and the sub-
pane of the dragged split bar only.) 
Collapsing: Pressing the ALT / Option key and double-clicking in a pane’s 
statusbar will collapse the pane so that the statusbar is displayed only and the 
pane above will fill the area. (Just double-clicking lets the pane above retain its 
size and the topmost pane will be enlarged.) A double-click on the statusbar of 
the topmost pane will collapse all panes below.
Expanding: Pressing the ALT / Option key and double-clicking in a col-
lapsed pane’s statusbar will expand the pane again – using space from the 
above pane. (If you just click it – without the ALT / Option key – the pane 
will be expanded using space from the topmost pane.) A double-click on the 
statusbar of the collapsed topmost pane will expand all panes below.
Minimizing: Double-clicking a pane’s split bar minimizes the pane or resizes it 
again.
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Calendar Pane
Toggles the Calendar pane on and off. 

Use the Calendar pane to search for records by date. Dates that correspond records 
are highlighted. If you move the cursor over a highlighted date, a tooltip shows the 
number of corresponding records in all catalogs open in the current collection. 

Clicking on the  icon opens a menu with the following options:

• Record View Set – to change the used Record View Set
• Calendar Mode – to toggle between Month mode and Year mode. In month 

mode, you can select a single day or multiple days of the month or an entire 
month for searching. In year mode, you can select a single month or multiple 
months of the year or an entire year for searching.

• Field – to select the record field to which the highlighted items in the Calendar 
pane correspond, e.g. Asset Creation Date, Asset Modification Date, Item Creation 
Date, etc. You can select from all date fields and date-only fields that are indexed 
for searching in the currently open catalogs. 

If you move the cursor over the  icon, a tooltip shows the current settings.

Select a day/month by a single click on any highlighted item. With a Ctrl-click / 
Command-click, the selection is increased or reduced by single items. With Shift-

click, the selection is increased or reduced by a range of items. 

Double-clicking any highlighted date or the month/year title starts a record search. 
Double-clicking a date inside a multiple date selection, finds all records belonging to 
any of the selected days/months. The search result will replace the current selection 
in the record main pane.
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If you hold the Ctrl key while double-clicking a highlighted item in year view, it 
switches to the specified month displayed in month view.

The Calendar pane has its own toolbar.

Calendar Pane Toolbar Items

1 Switches to current month/year
2 Switches to the previous year
3 Switches to the previous month (disabled in year mode)
4 Switches to next month (disabled in year mode)
5 Switches to next year
6 Opens a menu with following options:

– Record View Set.
– Calendar Mode (month/year)
– Field 

7 Minimizes the pane.
8 Closes the pane.

7 81 2 4 653
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Category Pane
Toggles the Category pane on and off. (Menu equivalent to the toolbar icon.)

Category Information Pane

Toggles the Category Information pane on and off. The Category Information pane 
displays information about the selected category. Which fields are displayed in the 
Category Information pane depends on the settings in the current Category View Set.
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Collection Basket Pane
Toggles the Collection Basket pane on and off. The Collection Basket that enables you 
to gather and sort records for one-click access and optional processing.

The Collection Basket only slightly differs in function from regular collections. For this 
reason, most of the functions available while working with standard collections—
changing view sets, saving and sharing contents, resorting, etc.—are also available 
from within the Collection Basket.

The Collection Basket pane appears on the right side of the main collection window 
and has its own toolbar.

Collection Basket Pane Toolbar Items

1 Lets you choose an action as output option (action) for Collection Basket contents
2 Replaces the main collection window contents with the contents of the Collection Basket
3 Clears the Collection Basket
4 Lets you choose a Record View Set, sort field and sort order for the Collection Basket contents
5 Closes the Collection Basket

Changing the Appearance and Size of the Collection Basket

The appearance of the Collection Basket can be changed using many of the same 
options you know from standard collections:

1 2 4 53
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• Thumbnails and Details — Use the toolbar icons for changing the Collection Bas-
ket between thumbnail and detail views. (Make sure the Collection Basket is the 
active pane before making the change.)

• Record View Sets — Use the Record View Set menu found under the  icon 
located at the top of the Collection Basket pane to choose from the available 
Record View Sets. 

• Thumbnail Size — Use the standard thumbnail resizing icon located on the tool-
bar to adjust the size of Collection Basket thumbnails. You’ll also notice that when 
you reduce the width of the Basket using the vertical bar, the thumbnails scale 
down in size to remain visible.

In addition, you can resize the Collection Basket by dragging the bar that divides the 
main collection and Collection Basket panes. Double-clicking this bar minimizes the 
pane or resizes it again.

Working with the Collection Basket’s Contents

Moving Asset Records Into the Basket

Add asset records to the Collection Basket from the main collection window using 
drag & drop. Select one or more records and drag them into the Basket. You can add 
as many records at a time as you need, and you can add additional records at any time 
thereafter.

Removing Asset Records from the Basket

Select one or more records inside the Collection Basket and press the DEL key on your 
keyboard to remove them from the Basket. The items are removed from the Basket, 
but not from the main collection or catalog.

Optionally, you can use the menu command Find > Remove Record from Collection.
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Rearranging the Order of Asset Records in the Basket

As you would in any other collection window, you can drag thumbnails around in the 
Collection Basket to rearrange them. You can also sort the contents of the Basket using 
the Sort By menu found under the  icon located at the top of the Collection Basket 
pane. (Use the Sort Direction menu to reverse the sort.)

Outputting the Collection Basket’s Contents

The  icon open a list from which you can select an output option for the contents 
of the Collection Basket. It lists the asset actions available to you by permissions, and 
also includes several standard Cumulus functions, such as emailing, creating Web 
albums and printing thumbnails.

Choose an asset action and then use the buttons provided to choose whether you 
intend to output the entire contents of the Collection Basket or just the selected items. 

Once you make your selection and click OK, the Collection Basket passes the list of 
assets to the selected action. Then the asset action is processing. At that point, you 
might see the user interface of the active module and can set parameters for the pro-
cessing. (Or, if you’ve chosen an asset action that is configured for no user interaction, 
you will not see any further windows.)

• For information on asset actions, see “Cumulus Asset Actions” .
• For information on the Mail To function, see “Mailing Your Assets” .
• For information on the Web Album function, see “WebAlbum” .

Replacing the Main Collection with the Collection Basket Contents

If you ever want to replace the contents of the main collection pane with the contents 
of the Collection Basket, click the  icon. The main collection is updated. There is no 
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“undo” for this operation, so make sure you intend to replace the main collection’s 
contents when you click this icon.

Clearing and Closing the Collection Basket

Clear the contents of the Collection Basket using the  icon at the top of the Collec-
tion Basket. There is no “undo” for this operation, so make sure you intend to clear the 
basket’s contents when you click this icon.

Click  to close the Collection Basket window. Closing the Collection Baskets does 
not clear it’s contents – when you reopen the Basket, the contents appear as you left 
them. (Note that the Server permission Manage User Collections is required for sav-
ing the contents.)

NOTE: If your User Settings have the Re-open Collections and Catalogs option 
activated, the contents of your Collection Basket will reappear the next time 
you open that same catalog (or set of catalogs), even when using the Web Cli-
ents. But if you open a different catalog in the interim, the contents of the Col-
lection Basket are deleted. 
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Information Pane
Toggles the Information pane on and off. The Information pane displays information 
about the record(s) selected in the current collection. Which fields are displayed in the 
Information pane depends on the settings for the Info View of the current Record View 
Set.

Preview Pane

Toggles the Preview pane on and off. The Preview pane displays the record selected 
in the active record pane in Preview View. This means that the display depends on the 
selected Record View Set. 

Preview Pane Toolbar Items

1 Shows first page of preview (available with multi-page previews*)
2 Shows previous page of preview (available with multi-page pre-

views*)
3 Shows next page of preview (available with multi-page previews*)
4 Shows last page of preview (available with multi-page previews*)
5 Opens a list for selecting a Record View Set.
6 Minimizes the pane.
7 Closes the pane.
* For more information on multi-page previews, see “Multi-page Previews” 

TIP: The preview images can be resized using the zoom slider in the main toolbar 

1 2 4 653 7
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Sub-Pane for Relations

Opens a sub-pane below the active record or closes it. The sub-pane displays records 
or other information that are related to the selected record as defined in the active 
Sub-Pane Filter.

Thumbnail Pane

Toggles the Thumbnail pane on and off. The Thumbnail pane displays the record 
selected in the active record pane as thumbnail.

Save Current as Default Workspace

Saves the current layout as your default workspace for collection windows.

Use Default Workspace

Applies the saved default workspace as layout for the current collection window.
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Save Current Workspace As

Opens a dialog that allows saving the current workspace under a selectable name. 
Enter a name for the workspace and – if you want this layout to be available to other 
users – activate the Share Workspace option. Note that shared layouts can be saved 
by the Cumulus Administrator only.

A saved layout includes:

• window size
• window location
• visible panes
• view sets selected for each pane.

Manage Workspace 

Opens a dialog displaying all available workspaces (in alphabetic order). You can select 
one and apply it to the current collection window by clicking Open.

You can also delete workspace layouts via this dialog. Select the entry and click Delete. 
Note that shared Workspaces can be deleted by the Cumulus Administrator only.
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Thumbnails
Activates Thumbnail View: Displays records as thumbnails and the contents of record 
fields as defined in the selected view set. (Menu equivalent to the toolbar icon.) Once 
this view mode is active, you can use the zoom slider to change the size of the thumb-
nails or use predefined sizes via menu (View > Thumbnail Sizes).

Details
Activates Details View: Displays records in a sorted text list as defined and the contents 
of record fields as defined in the selected view set. (Menu equivalent to the toolbar 
icon.)

Information
Activates Information View: Displays metadata information stored with the record. The 
displayed fields are defined by the selected view set. (Menu equivalent to the toolbar 
icon.)
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Preview
Activates Preview View: Displays records as previews. The records’ assets must be 
accessible to display the preview. Once this view mode is active, you can select differ-
ent sizes for the previews. (Menu equivalent to the toolbar icon.)

TIP: Resizing

The preview image can be resized using the zoom slider.

Report
Activates Report View: Displays thumbnail and metadata information in horizontal 
order (a sort of hybrid between the Details and Info View modes.) It offers a convenient 
way to display the contents of text fields that contain lots of information. Can display 
as many lines as needed for quick browsing. (Menu equivalent to the toolbar icon.)

TIP: Resizing

The thumbnails can be resized using the zoom slider.
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Record View Set
Opens a submenu with the available Record View Sets. For more information on 
Record View Sets, see “Record View Sets” . (Disabled unless a record is selected.)

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Record View Sets by selecting the Customize entry in the list for selecting 
Record View Sets. This entry opens the preferences for the current Record View 
Set.
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Category View Set
Opens a submenu with the available Category View Sets. For more information on 
Category View Sets, see “Category View Sets” . (Disabled unless a category is selected.)

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Category View Sets by selecting the Customize entry in the list for selecting 
Category View Sets. This entry opens the preferences for the current Category 
View Set.
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Preview/Thumbnail Sizes
Opens a submenu to select the size of thumbnails or previews.

Small 

Displays records as small thumbnails/previews (default 64 x 64 pixel). You can change 
the default size. (See “User Settings”, for details.) 

Medium 

Displays records as medium thumbnails (default 128 x 128 pixel). You can change the 
default size. (See “User Settings”, for details.) 

Large Thumbnail/Preview

Displays records as large thumbnails (default 256 x 256 pixel)/previews. You can 
change the default size. (See “User Settings”, for details.) 
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Sort By
Opens a list of the available fields of the current collection. Select the field you want to 
determine the sorting of. (Menu equivalent to the statusbar field.) 

NOTE: The selected field should be one with the most records containing infor-
mation – otherwise you will be quite unhappy with the sorting. 

The option Unsorted will display the records in the order they were cataloged. 

You can sort by two fields. In Details view Cumulus lets you select a second field as 
sorting criteria. Click the column header for the field you want to use as first sorting 
criteria and then Shift-click the column header you want to use as second sorting cri-
teria. If you switch to other views, the sorting will remain until you change the sorting. 

Sort Direction
Opens a submenu that provides two options for the direction of the sort order:

• Sort Ascending – Sorts the records in an A to Z (0-9) direction.
• Sort Descending – Sorts the records in a Z to A (9-0) direction.
(Menu equivalent to the statusbar icon.)
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Language for Field Values
Opens a submenu that provides the possibility to switch the language in which mul-
tilingual metadata fields are displayed.

The first entry in the menu is Application Language which is also the default. If Appli-
cation Language is selected, multilingual fields are always displayed in the language 
of the application (see “Switch Application Language” ). 

If the language for field values is set to a language that is not defined for a multilingual 
field, this field displayed in its base language instead.

Changing the language for field values takes immediate effect.

Prerequisites and Additional Hints

The Language for Field Values function only works if the currently open catalog con-
tains record fields and/or category fields that are enabled for multi language support.

Additionally, the following prerequisites must be met:

• To allow language switching for metadata fields, the Allow language switch for 
multilingual fields option must be activated in the preferences of the current 
View Set’s active view. If this option is not activated, multilingual fields are always 
displayed in the language of the field that was added to the view. 

• To allow language switching in the Category pane, the Preferred Language 
option must be activated and set to As defined in View menu in the Category 
Pane preferences of the current Category View Set. If the Preferred Language 
option is not activated, multilingual categories are always displayed in their base 
language.

There is one more issue with the category pane.
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Instead of coupling the language of the Category pane to the selection made in the 
View menu. you may as well select a language to always be used with the category 
pane, independent of the language used for other metadata fields. Activate the Pre-
ferred Language option in the Category Pane preferences and select the desired lan-
guage.

Category Pane and the Categories Field: Making the Language Consistent

If your Category pane is set to a language different from the language of other multi-
lingual fields, you may nevertheless want to have the categories displayed always in 
the same language, both in the Category pane and in any specific View of your View 
Sets.

For example, you may have a German Category pane, whereas multilingual fields are 
set to be displayed in English. If category assignments of an asset are displayed in the 
Info View or the Asset Info Window, you would expect to see German category names 
here, as in the Category pane. However, according to the language settings for multi-
lingual fields, they are displayed in English.

To solve this inconsistency and always have the same category language used both in 
the Category pane and in the Categories field displayed in a record view, open the 
Record View Set preferences, select the desired View Set and View and make sure that 
the Preferred Language settings in the Properties of the Categories field are identical 
to the Preferred Language settings of the Category pane.

NOTE: This has to be done individually for every View in every View Set where 
the Categories field is displayed.
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Go To
Opens a submenu for navigation. The available options depend on the current focus.

Preview
Opens a submenu for preview display options. (Disabled if no Preview window or view 
is activated.)

• Zoom In
• Zoom Out
• Fit to Window
• Fit Width to Window
• Fit Height to Window
• Full Screen
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Zoom In
Doubles the size of a preview image. Preview images can be increased to eight times 
or 800% of their original size. (Disabled if no Preview window is activated.)

Zoom Out

Halves the size of a preview image. Preview images can be reduced to one eighth or 
12.5% of their original size. (Disabled if no Preview window is activated.)

Fit to Window

Resizes the Preview window to fit inside the main Cumulus window. Can be set as 
default, see “User Settings” , for details. (Disabled if no Preview window is activated.)

Fit Width to Window

Resizes the Preview window to fit the width of the main Cumulus window. Can be set 
as default, see “User Settings” , for details. (Disabled if no Preview window is activated.)
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Fit Height to Window

Resizes the Preview window to fit the height of the main Cumulus window. Can be set 
as default, see “User Settings” , for details. (Disabled if no Preview window is activated.)

Full Screen

Displays a preview using the whole screen. (Disabled if no Preview window is acti-
vated.)

TIP: Viewing Multiple Assets

To view multiple assets at once, use Asset > Fullscreen Preview. 
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Categories
Opens a submenu:

• Expand
• Expand All
• Collapse
• Collapse All
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Expand
Expands the selected categories to reveal subcategories. This works the same way as 
clicking on the arrow icon to the left of the parent category. (Disabled if no parent cat-
egories are selected.)

TIP: Expanding All

To expand all categories under a parent category, press the ALT / Option 
key when clicking on the category arrow icon.

Expand All

Expands all parent categories to reveal subcategories. (Disabled if all parent categories 
are already expanded.)

Collapse

Collapses the selected parent categories to hide subcategories. This works the same 
way as clicking on the arrow down icon to the left of the parent category. (Disabled if 
no expanded parent categories are selected.)

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE VIEW MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

TIP: Collapsing All

To collapse all categories under a parent category, press the ALT / Option 
key when clicking on the category arrow icon.

Collapse All

Collapses all parent categories to hide subcategories. (Disabled if all parent categories 
are already collapsed.)
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The Find Menu
• Find Records
• Find All Records
• Find Records by Query
• Find Records Assigned to Categories
• Find Duplicates
• Find Records with Invalid Field Values
• Find Offline Assets
• Find Versionable Assets
• Invert Collection
• Find Categories
• Find All Categories
• Find Categories by Query
• Show Original Category
• Show Related Categories
• Show Categories Containing
• Remove from Collection
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Find Records
Opens or activates the Record Find window. (See “Searching with the Find Window”, 
for details.)

Find All Records
Resets the current selection of records to the entire contents of the catalog(s) opened 
in the collection. This is useful after a search operation has reduced the number of vis-
ible records.

Find Records by Query
Opens a list for selecting a record query that will be performed immediately. (Disabled 
unless at least one record query is saved.) If the selected query contains placeholders, 
you are prompted for the respective input before the query is executed.

Find Records Assigned to Categories 
Finds all records that are associated with the selected categories. This is the menu 
equivalent to double-clicking on categories. (Disabled unless one or more categories 
are selected.) 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE FIND MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Find Duplicates
If a collection contains only records from the same catalog, this function searches it for 
records with the same record name (the assets and asset names may be different). The 
search result will replace the current collection. 

NOTE: It's not possible to find duplicates in a collection containing records of 
more than one catalog.

TIP: Performance

This function may take a while. Hence, we suggest that you put up a collection 
that fits this search before starting this function. 

Find Records with Invalid Field Values
Checks all records of the current collection for any field value that is invalid according 
to the defined field validators. 

This function will find any record with invalid field values, even if the field in question 
is not displayed in the current Record View Set.

NOTE: You may also check for invalid records on a regular base using the 
scheduler action Find Invalid Items.
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Find Offline Assets
Searches the current collection for records with asset references that cannot be 
resolved. The search result will replace the current collection. 

NOTE: This function may take a while. Hence, we suggest that you put up a col-
lection that fits this search before starting this function. 

Find Versionable Assets
Searches the current collection for records of assets under version control (e.g. 
Cumulus Vault.) The search result will replace the current collection. 

NOTE: This function may take a while. Hence, we suggest that you put up a col-
lection that fits this search before starting this function. 

Invert Collection
Searches for all records (of the catalogs opened in the collection) that are not con-
tained in the current collection and replaces the current collection with this search 
result. With one click you can obtain all records that are not currently shown.
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Find Categories 
Opens or activates the Category Find window.

Find All Categories
Resets the current selection of categories to the entire contents of the catalog. This is 
useful after a search operation has reduced the number of visible categories.

Find Categories by Query
Opens a list for selecting a category query that will be performed immediately. (Dis-
abled unless at least one category query is saved.) If the selected query contains place-
holders, you are prompted for the respective input before the query is executed.
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Show Original Category
Finds and highlights the original category of a selected related category. (See “Cate-
gory Types”.)

Show Related Categories
Finds and highlights the selected category’s related category or categories. (Disabled 
unless a category is selected.) 

Show Categories Containing
Opens a dialog where you can enter a string of text that you would like to search for 
in all category names of the active catalog. Categories whose names contain the string 
are highlighted. Related categories are included in the search.

For example: Typing “oa” would find categories like “Boat”, “Coat”, “Oasis”, “Oat”, etc.
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Remove from Collection
Removes the record/category from the current collection but not from the catalog. 
(See “Delete”, for deleting a record/category from a catalog.)
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The Metadata Menu
• Information
• Bulk Edit
• Update Record
• Update Formula Fields
• Write back Metadata
• Assign Metadata From Template
• Find And Replace Metadata
• Assign Label
• Assign Rating
• Assign Categories
• Detach Categories
• Optimize Thumbnail
• Rotate Preview
• Rotate Thumbnail
• Assign Relation
• Alternates
• Show Related
• New Category
• New Related Category
• New Master Category (optional)
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Information
Depending on the active pane this menu item opens the Asset Information window 
or the Category Information window for the selected record/category.

• Category Information window – For further information, see “Category Informa-
tion Window” . 

• Asset Information window (Menu equivalent to the toolbar icon) – For further 
information, see “Asset Information” , and “Editing Asset Information” .)

Viewing and Editing Multiple Records 

If you have selected multiple records before opening the Asset Information window, 
you can change the field values for multiple records at once. But this is only possible, 
if in your User Settings for the Display of the Asset Information window the option 
Only One Window is activated and Display values identical for all selected records 
is checked. 

If the asset information of multiple records is shown in one window, only field con-
tents which have the same values are displayed. So the Asset Reference and Thumb-
nail fields will always be empty. Check boxes (Boolean fields) with different values 
appear gray. The field Categories only displays categories that the selected records 
have in common. All other field types are displayed with no value if there are different 
values for fields.

Fields with different values do not show a value but can be edited – this also applies 
to gray (neutral) check boxes. If you add an additional category, this category is added 
to the set of categories for each record.
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If you add any text to a field that already contains values for one of the selected assets, 
you are asked whether you want the new text to replace the existing value or to be 
appended to the existing text.
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Bulk Edit
Opens a window to edit metadata of selected records or categories. 

The Bulk Edit window shows the same fields as the Information Window defined for 
the current Record View Set or Category View Set – but only if they are user editable.

For each field you can decide how its value is dealt with (default: Keep Current Value). 
Click the icon on the left to have the available options displayed and to choose from 
them. Note that these options vary slightly according to the type of field selected.

You must select an editing option first and then enter or modify the respective value. 
(With certain fields, e.g. Rating, you can also start entering or modifying a value. The 
default option is then automatically switched to Replace Current Value.) 

With the Categories field, select the desired editing option and then to use drag & 
drop or the Add and Remove buttons to configure a set of categories that will be 
assigned to or removed from the selected records.

Whether a field is set to be mandatory is ignored by the Bulk Edit – even mandatory 
fields can be left empty when Bulk edit is employed. Also field validators only take 
effect with fields that actually contain values; empty fields are not validated. 

NOTE: Be carefully with the Replace Current Value and the Clear Current 
Value options! These options delete all existing values and cannot be undone. 

Further Options

Clicking the template icon in the lower left corner of the Bulk Edit window opens a 
menu with further options:
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• Save as Template – Creates a new Metadata Template with the current values 
from the bulk edit window. Only available if values have been entered or modified.

• Load Template – Opens a list of Metadata Templates available for the currently 
edited type of metadata (record or category metadata). Select a Metadata Tem-
plate to prefill the bulk edit fields with values from that template. You may then 
edit theses values as necessary.

• Use Metadata from – Opens list of previously copied records or categories. Select 
an item to prefill the bulk edits fields with values from that item. You may then edit 
theses values as necessary

If you are the Cumulus Administrator and the catalog you are working with has sub-
scriptions enabled (see “Enabling Subscriptions” ), there is an additional checkbox: 
Notify subscribers, which is activated by default. Deactivate this option if you don’t 
want subscribed users to get notified about your administrative edits.

NOTE: Regardless of the actual content of an employed Metadata Template, 
only values for fields that are included in the Bulk Edit window are taken into 
account. 
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Update Record
Opens a submenu with functions to refresh the selected records with the asset’s up-
to-date information. This can be necessary if catalog settings have changed, but also 
if assets have been modified since they were cataloged. Records of unavailable assets 
cannot be updated. (The menu item is disabled if no records are selected.)

Update

Updates the selected records according to the settings specified in the Preferences 
(User Settings > General > Application > When Updating). Depending on the set-
tings specified for the current catalog (User Settings > Asset Handling), you may be 
prompted to select an Asset Handling Set.

Advanced

Opens a dialog to specify settings for the current update process. The settings defined 
in this dialog will not affect the settings defined in the Preferences.

Define the settings according to your needs, then click OK to perform the update.

NOTE: If the Asset Handling Set used for the update does not provide the cor-
rect settings for creating records for pages/slides (e.g. because the required 
Asset Storage Module is not activated), the records representing the individual 
pages will be deleted. Because this might not be the intended result, Cumulus 
shows a list of the records that are to be deleted. Either confirm the deletion, or 
cancel the complete update process, or select single records on this list to con-
firm their deletion only. 
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Update Formula Fields
Updates all fields containing formulas in the selected records, no matter whether 
these fields are currently displayed or not. A dialog is displayed which lets you choose 
whether the record’s Item Modification Date should be changed accordingly or not. 
(By default, the record’s Item Modification Date is not changed.)
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Write back Metadata 
Writes metadata from the selected records back to the related assets or metadata con-
tainer, e.g. XMP files. Opens a dialog to specify an appropriate Asset Handling Set and 
optionally to select the metadata fields that should be written back. (Disabled if no 
Asset Handling Set is available that has enabled the writing back metadata option.) 

When writing back metadata to assets, be aware of the following:

• Metadata can be written back to assets only
• if the assets are not write protected or stored on a write protected volume or 

media.
• if Cumulus has direct access to the assets (no Server/Client Asset Transfer).

• Some IPTC and XMP metadata fields overlap. All assets that have been edited with 
applications of the Adobe Creative Suite contain both IPTC and XMP metadata. 
When writing back metadata to such assets, make sure that both the Cumulus IPTC 
and the XMP filter are activated. If not, the IPTC and XMP data stored in the asset 
might differ.
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NOTE: Captured IPTC and XMP metadata
As some image files contain IPTC as well XMP metadata in different blocks, and 
some metadata information is stored in both blocks, the metadata captured by 
different applications might differ. Some applications give priority to XMP (e.g. 
Adobe Creative Suite). With a standard installation, Cumulus captures IPTC 
metadata prior to XMP. If you want to alter the priority to XMP, you have to 
change the order of the formats for the Asset Handling Set employed for cata-
loging. In the Asset Formats list of the Asset Handling Set, the entry for the 
Extensible Metadata Platform format supported by the XMP filter has to have a 
lower entry number than the first format supported by the IPTC filter. This is due 
to the fact that Cumulus starts searching for matching formats at the lowest 
entry number. (see Asset Format Support, for further details.) 

NOTE: Metadata size restrictions in JPEG assets
The size of meta data fields in JPEG files (e.g., EXIF data or XMP data) is restricted 
to 64 kB. However, metadata larger than 64 kB can be written back to the JPEG 
file and is saved in discrete segments of 64 kB each. Although this is conform to 
the specification, keep in mind that not every image editor / JPEG readers is 
able to read large metadata properly!

NOTE: Writing back keyword categories to assets
In order write back keywords from the $Keywords master category to assets 
(e.g. to have these keywords available in other applications), make sure that 
field linking “when writing back metadata” is activated for the “Categories” 
record field, but is disabled for the “Keywords” record field (via Field Properties 
> Field Linking tab for each field).
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Assign Metadata From Template 
Open a dialog to select the Metadata Template to be used for filling. For further infor-
mation, see “Using a Metadata Template” . (Available only, if you are allowed to modify 
records.)
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Run Automatic Tagging
Starts the configured external Automatic Tagging service for the selected records. The 
tags found by the service will be written into the configured fields. For further infor-
mation, see “Automatic Tagging of Assets” . (Available only, if the optional Automatic 
Tagging feature is part of your installation and is properly configured, and if you are 
allowed to use it.)
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Find And Replace Metadata
Finds certain information stored on assets in selected records and replaces it with 
information entered by the user. (Available only if you are allowed to modify records.)

1. Select one or more records.

2. Select Metadata > Find And Replace Metadata. A dialog opens.

3. Select the field that stores the information you want replaced. Clicking the arrow 
button reveals a list of all editable String fields of all open catalogs.

4. Enter the text to be replaced in the Text to find field.

5. Enter the replacement text in the field Replace with.

NOTE: For a line break, enter \n. 

FOR SPECIALISTS ONLY: If you activate the Use Regular Expression checkbox, 
you can enter regular expressions (Perl 5 like) in the Text to find and Replace with 
fields. For a description on using regular expressions, please refer to specific infor-
mation available in book stores and on the Web.

6. Click Start. Cumulus starts to search for the entered text in the selected field of 
the selected records. You will get a notice for each of the selected records 
whether the text was replaced or not. Replacements are not necessary if the text 
to be replaced wasn’t contained in the selected field or if a record is stored in a 
catalog that does not provide the selected field.

7. Click Close to finish.
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Assign Label
Opens a submenu for selecting the labeling you want to assign to the select record(s). 
(Disabled if no Labeling field is included in the catalog or if the effects of assigning the 
label cannot be immediately seen by the user.) For more information, see “Labeling” . 

Assign Rating 
Opens a submenu for selecting the rating you want to assign to the select record(s). 
You can rate assets from 1 to 5. (Disabled, if no Rating field is included in the catalog.) 
For more information, see “Rating” . 
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Assign Categories
Assigns a selection of records to a selection of categories, or vice versa. (This is the 
opposite of “Detach Categories.’) (Available only, if you are allowed to modify records.) 

NOTE: If you have a large number of records (more than 500) you want to 
assign, it is better that you use this function rather than drag and drop. 

1. Select one or more records.

2. Select one or more categories to which you want to assign the selected records.

3. Select Metadata > Assign Categories. The records are assigned to each of the 
categories in the selection.
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Detach Categories
Detaches a selection of records from a selection of categories, or vice versa. (This is the 
opposite of “Assign Categories’.) (Available only, if you are allowed to modify catego-
ries.)

1. Select one or more records.

2. Select one or more categories which you want to detach from the selected 
records.

3. Select Metadata > Detach Categories. The records are detached from each of 
the categories in the selection.
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Optimize Thumbnail
Equalizes the appearance of the selected records’ thumbnails. This is useful for thumb-
nails that are too dark, too light, or lacking contrast. The action cannot be undone, but 
you can force-update the record to get back the original thumbnail. (Disabled if no 
records are selected.) (See “Update Record”, for information on updating a record, 
including its thumbnail.)
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Rotate Preview
Rotates the selected preview’s images in one of three ways:

• 90° clockwise
• 90° counter-clockwise
• 180° 
(Available only in Preview view or when the Preview window is open.)

Rotate Thumbnail
Rotates the selected records’ thumbnail images in one of three ways:

• 90° clockwise
• 90° counter-clockwise
• 180° 
(Disabled if no records are selected.)

The record field Thumbnail Rotation saves the rotation value for a rotated thumbnail. 
The rotated thumbnail will be used for previewing, printing, exporting to HTML and 
creating slide shows.
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NOTE: Catalogs Created with Versions Prior to Cumulus 5.5!
If the field Thumbnail Rotation (for storing the rotation value) should be avail-
able with catalogs that have been created with previous versions, this record 
field has to be added to the catalog. The field is then empty. There are two ways 
to fill it out:
– Either, open the Asset Information window and enter the according value 
(degree of rotation) manually.
– Or, select Metadata > Update Record. This will set the thumbnail back to the 
asset's orientation. Then rotate the thumbnail again. The value of the rotation 
will then be stored in the Thumbnail Rotation field. 
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Assign Relation
Open submenu to select an relation type. Default relation types are alternates and 
variants. However, your Catalog Administrator can delete and add relation types. (For 
details on how to assign additional relation types – so called custom relation types – 
see Assigning Custom Relations.)

Variants

Assigns variants to an asset. The asset to which other assets are assigned is called the 
source of the variant. 

1. Select the records of the assets you want to assign as variants to a source asset

2. Select Metadata > Assign Relation >Variants. Then a message prompts you to 
select the source. 

3. Select the record you want to be assigned as the source of the variants (master) 
and click OK.

To have the variants of an asset displayed, open a subpane and select a corresponding 
Sub-Pane Filter. For more information on asset relations, see “Managing Related 
Assets” .
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Alternates

Assigns alternates to assets and lets you define a preferred alternate. 

1. Select the records of the assets you want to become alternates.

2. Select Metadata > Assign Relation >Alternates. Then a message prompts you to 
select the preferred alternate.

3. Select the record you want to be the preferred alternate (master) and click OK.

To have the alternates of an asset displayed, open a subpane and select a correspond-
ing Sub-Pane Filter. For more information on asset relations, see “Managing Related 
Assets” .
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Show Related
Opens a submenu displaying the available sub-pane filters. Once you have chosen a 
filter, a sup-pane displays the records of related assets according to the selected sub-
pane filter.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE METADATA MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

New Category
Creates a category under the currently selected category, named “Category”. This 
name can be changed immediately to a more fitting one. (Disabled unless a single cat-
egory is selected.)

New Related Category
Makes a related category for each of the currently selected categories. (Disabled 
unless one or more categories are selected.) (See “Category Types”.)

New Master Category (optional)
Opens a window to enter a name for the new master category that will be created 
under the currently selected catalog category. A master category has its own category 
tree. (Disabled unless a catalog category is selected. Available with Enterprise or a spe-
cial option only.)
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The Asset Menu
• Preview
• Fullscreen Preview
• Fullscreen Slide Show
• Edit
• Video Cloud
• Compare Previews
• View With
• Edit With
• Print With
• Perform Asset Action
• Convert To
• Mail To
• Copy To
• Copy Assets Assigned to Category 

To
• Duplicate Asset and Record
• Create WebAlbum
• Show Location
• Configure Web URL
• Move To
• Rename
• Update Asset Reference(s)

• Change Asset Reference
• Transform JPEG Original
• Check Out
• Undo Check Out
• Check In
• Show History
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Preview
Opens a Preview window for each selected record. The records’ assets must be avail-
able to display the Preview window. (Menu equivalent to the toolbar icon.)

The contents of the window opened depends on the asset type and on the active 
Record View Set. (For a description on how to configure the view of the Preview win-
dow see “Record View Sets” .)

Image previews can be zoomed in or out and displayed in different sizes and you can 
add user comments. For more information, see “Preview View and Window” .
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Fullscreen Preview
Shows assets as fullscreen previews. You can display up to six different assets at once. 
The records’ assets must be available to display. 

What is displayed depends on the asset type and on the active Record View Set. (For 
a description on how to configure the view of the Preview window see “Record View 
Sets” .)

For more information, see “Fullscreen Preview” .

Fullscreen Slide Show
Shows assets as fullscreen previews in a slide show. The records’ assets must be avail-
able to display. (Menu equivalent to the toolbar icon.)

What is displayed depends on the asset type and on the active Record View Set. (For 
a description on how to configure the view of the Preview window see “Record View 
Sets” .)

For more information, see “Fullscreen Slide Show” .
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Edit
Opens a submenu with options for choosing an application for editing the selected 
image asset.

Image Editor

Opens the selected image asset in a special window that allows you to edit the image. 
The Image Editor offers image cropping as well as calibration tools that can enhance 
the color, sharpness and brightness of your images. For details see “Editing Images” . 

Crop Editor

Opens the selected image asset in the crop editor of the Cumulus Web Client, in your 
default web browser. With the crop editor, you can define crop areas on an image 
asset and save these settings to the metadata of the asset. The defined crop areas will 
then be used by the Media Delivery Cloud (MDC) or Media Delivery on Premise (MDO), 
in order to deliver proper renditions oft the asset. For more information see the 
Cumulus Web Client Help.

This function is deactivated if an audio or video asset is selected.
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Prerequisites and Additional Hints

This entry is only available if the field “Media Delivery Cloud Rendition Parameters” is 
available in the open catalog.

Additionally, one single valid Base URL for Web Access of type “WebClient” must be 
configured in the Remote Admin Settings. This function won’t work properly, if multi-
ple Base URLs for Web Access are configured!

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE ASSET MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Video Cloud 
Opens a submenu with options related to the possibility of uploading a video to the 
Cumulus Video Cloud service in order to make in publicly available.
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Show Video Cloud Data

Opens a dialog displaying data related to the selected received from the Cumulus 
Video Cloud service (as opposed to data stored in Cumulus)..

For a detailed explanation of the information provided, see Video Cloud Data.
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Upload

Uploads the selected video(s) to the Cumulus Video Cloud service. All necessary deriv-
atives for different solutions and devices will then be created automatically.

Remove

Removes the selected video(s) from the Cumulus Video Cloud service. (This function 
does not impact the availability of the video within Cumulus.)

Publish

(Only available with videos that are already uploaded to the Cumulus Video Cloud ser-
vice!) Makes the selected video(s) available to the public via the provided embed code 
and video link.

Un-Publish

(Only available with videos that are already published!) Blocks the public availability of 
the selected videos. The videos remain untouched on the Cumulus Video Cloud ser-
vice and can be published again later.
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Compare Previews
Opens the selected two image assets along with a comparison image in fullscreen 
view. For details see “Comparing Previews” . (Disabled if less or more than two records 
are selected.)
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View With
Opens a submenu with options for choosing an application for viewing the selected 
asset. (Disabled if no records are selected.)

Creating Application

Opens the selected records’ assets with the application that created the assets (if it is 
known and available).

Other

Opens a dialog to choose an application with which to view the selected records’ 
assets. 

Customize

Lets you customize the options in the View With menu. You can add and delete appli-
cations. 
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Edit With
Opens a submenu with options for choosing an application for opening and editing 
the selected asset. (Disabled if no records are selected.)

NOTE: If the asset is under control of a version control system (e.g. Cumulus 
Vault), it will be checked out.

Creating Application

Opens the selected records’ assets with the application that created the assets (if it is 
known and available) and lets you edit the asset.

Other

Opens a dialog to choose an application with which to open and edit the selected 
records’ assets. 

Customize

Lets you customize the options in the Edit With menu. You can add and delete appli-
cations. 
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Print With
Opens submenu with options for choosing an application. (Disabled if no records are 
selected.)

Creating Application

Prints the selected records’ assets with the application that created the assets (if it’s 
known and available.)

Other 

Opens a dialog to choose an application with which to print the selected records’ 
assets. 

Customize

Lets you customize the options in the Print With menu. You can add and delete appli-
cations. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CLIENT MENU REFERENCE THE ASSET MENU

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Perform Asset Action
Opens a submenu that lists Cumulus Assets Actions. Selecting an Action from that 
submenu will perform it. For further information, see “Cumulus Asset Actions” .

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Asset Actions by selecting the Customize entry in the submenu for selecting 
an Action. This entry opens the preferences for the current Action.
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Convert To
Opens a dialog for converting the asset associated with the selected record to another 
file format. The target formats depend on the availability of Cumulus Converter mod-
ules. Before you decide on the Converter module, you must specify the download 
location for the converted file.

The offered modules depend on the AssetProcessor modules activated for the Asset 
Handling Set selected for asset access in your user settings. Several Converter modules 
are available with a Cumulus standard installation, e.g.:

• Pixel Image Converter (For more information, see “Converting Image Assets” )
• Watermark AssetProcessor (For more information, see “Watermarking Assets” )
• ZIP AssetProcessor (For more information, See “Creating ZIP Archives”.)

NOTE: If you have selected multiple assets' records, the chosen settings will be 
applied to convert all selected assets. 
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Mail To
Use this option to attach an asset to an outgoing email message. Cumulus 

launches your email application (in case you have more than one, offers you a 
menu to select) / launches your default email application.

Copy To
Copies the selected records’ assets to the location specified in the dialog that appears. 
The original assets are left alone. (Disabled if no records are selected.)

Copy Assets Assigned to Category To 
Opens a dialog in which you can choose a destination. Cumulus then copies the assets 
of records that are associated with the selected categories to the location you 
selected. The assets are saved in folders named for the categories selected.

This option is handy for collecting production files for output (assuming the files all 
have at least one common category, such as project name). (Disabled if no category is 
selected.)
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Duplicate Asset and Record
Duplicates the asset of the selected record and the record itself. A dialog appears in 
which you can choose a name and set several options for the new asset and record

• Copy Record Metadata – Activate to copy the metadata from the original to the 
duplicated record, except creation date and modification date.

• Update Record – Activate to update the metadata in the duplicated record from 
the duplicated asset.

• Assign as Variant – Activate to assign the duplicated asset as a variant to the orig-
inal asset.

• Assign as Alternate – Activate to assign the duplicated asset as an alternate to the 
original asset.
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Create WebAlbum
Opens a dialog in which you can create a Web Album. For further information, see 
“WebAlbum” .

Show Location
Locates the selected records’ assets and displays them in the Mac OS X Finder or Win-
dows Explorer. (Disabled if no records are selected.)

TIP: Show Location of Folder Category

The context menu for categories offers a similar function for folder categories. 
The selected category’s folder is displayed, e.g., in the Mac OS X Finder or Win-
dows Explorer. (Disabled if no folder category is selected.)

Configure Web URL
Opens a dialog to display the URL (Uniform Resource Locator) of the selected records, 
their assets, thumbnails or previews. You can copy these URLs and paste the links. The 
links will work if your Cumulus installation includes Cumulus Web Client or Sites. For 
details see “Configuring Web URL” .
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Move To
Copies the selected records’ assets to the location specified in the dialog that appears 
and updates the records’ asset references to point to the new location. The original 
assets are deleted. (Disabled if no records are selected.)

Rename
Opens a submenu:

• Single
• Batch
The options are only available if you are allowed to modify records.

Single

Opens a dialog to rename the asset represented by the selected record. If asset name 
and record name are the same, the record name will be changed according to the 
asset name.

Batch 

Opens the Rename Assets dialog to configure a rule for and to start the renaming pro-
cess for the assets represented by the selected records. If asset name and record name 
are identical, the record name will be changed according to the asset name.
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The Rename Assets Dialog

The list on the left side offers different name components available for the new asset 
name(s). The list on the right side contains the name components that are actually 
used for the renaming. Select the components you want to use in the left list and click 
the arrow button to move them to the right. Change their order with the Up and 
Down buttons.

Each selected component has to be configured before you can start the renaming 
process. Select a component in the right list and click Properties to open a specific 
properties dialog. 
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NOTE: The Define File Name and Define Field Value dialogs provide a Use 
Regular Expression checkbox. If activated, you can enter regular expressions 
(Perl 5 like) in the Replace and With fields. For example, if the checkbox is acti-
vated for file names and you enter a period (.) into the Replace field, every char-
acter in the file names will be replaced with the character(s) specified in the 
With field. – Detailed information on how to use regular expressions can be 
found on the Internet.

A Preview of the result allows you to check and adapt your configurations before you 
actually start the batch renaming process. 

Next, you must decide what Cumulus shall do if the renaming process results in file 
names that already exists in the folder where the involved assets reside: either skip the 
renaming of this asset, or add an automatic number to the new name. 

If assets can not be renamed (due to e.g. no writing rights, or not writable storage 
media), these assets are assigned to a new category the name of which indicates date 
and time of the rename failure. Such categories are created below the Rename – 
Skipped Assets category.

Using the icons on top of the window, you can save the current configuration as a set, 
or open a saved set to use it again. Existing sets can be modified, saved under a new 
name, and deleted.
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Update Asset Reference(s)
Updates the path used to find the selected asset files, e.g when assets have been 
moved. Asset references can only be updated if the assets are available. (Disabled if no 
records are selected.)

Opens a dialog to specify how to proceed if asset references cannot be resolved:

• Assign record to special category – Records with unresolvable asset references 
are assigned to a special category named Update reference -Skipped Assets and 
can be processed later. All other records are properly updated.

• Ask for asset location – The update process stops on every unresolvable asset ref-
erence and asks for the appropriate location

• Skip record – Records with unresolvable asset references are ignored. All other 
records are properly updated.
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 Change Asset Reference
Opens a submenu:

• Select Single
• Batch
The options are only available if you are allowed to modify records.

This function allows you to update selected records to reflect a new location of their 
assets. This is useful if you have cataloged assets from a remote drive or volume that 
has since been renamed or have simply moved cataloged assets to a new location 
(and did not use Cumulus for moving them). Without this function, the records would 
still “point” to the old asset paths. This function does not overwrite, move or otherwise 
affect asset files at all. However, the function is available only if you are allowed to mod-
ify records.

You can either change the asset reference for a single asset by selecting an asset or 
you change the asset references for multiple assets through a batch process.

Select Single

Opens a dialog to browse for the asset that should be represented by the selected 
record.
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Batch 
Opens a dialog to change the asset references for multiple assets through a batch pro-
cess. To change the asset references for multiple assets:

1. Select the records that still point to the old location of the assets.

2. Select Asset > Change Asset Reference. 

3. Select Batch. 

A dialog appears asking you for the new location. The new location is defined in 
relation to the old location stored as asset reference.

• Server/Volume (under Windows only)
In case the assets now reside on another location in the Network, you have to 
activate the Network Option and then: 
a) if the assets now reside on another server (but a volume with the same name), 
activate the New Server option and enter the name of this new server into the 
field on the left.
b) if the assets now reside on another volume (but still on the same server), acti-
vate the New Volume option and enter the name of this new volume into the 
field on the left.
c) if the assets now reside on another server and another volume, activate both 
the New Server and the New Volume option and enter the names into the cor-
responding fields on the left.
In case the assets now reside on another local location, you have to activate the 
Local Option and then if the assets now reside on another drive, activate the 
New Drive option and select this new drive.
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• Volume (under OS X only)
In case the assets now reside on another volume, activate the New Volume 
option and select this new volume.

• Folder Settings
– Activate the Keep Existent option if the assets now reside in the same direc-
tory structure as they did before.
– Activate the None option if the assets now reside directly in the volume/drive 
selected above (and not in any subdirectories).
– Activate the Add Parent option if the assets now reside in the same directory 
structure as they did before but this structure is now nested into another. The 
Add Parent option lets you enter the path of the directory that now nests the 
“old” directory structure.
– Activate the Change Parent option if the directory structure has partially 
changed. Enter the part of the path that you want to modify into the left field 
and the replacement string into the right field. You can monitor the result in the 
Preview section.
– Activate the New option if the assets now reside in just one new directory (and 
not in any subdirectories). The New option lets you browse for the new directory 
by clicking the  button.

4. Click Start. 

The application searches for the assets represented by the selected records in the new 
location and updates the records to the new location. If an asset is not found in the new 
location, a new category is created named Change Reference – Skipped Assets and 
inside a subcategory indicating date and time of the process to which the asset is 
assigned.
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Transform JPEG Original
Opens a submenu that allows you to rotate or flip the original asset if the asset is a 
JPEG file you have direct access to. The transformation will transverse the JPEG lossless. 
(Available only if you are allowed to modify records.)

The Advanced item opens a dialog to specify further settings.

Along with the transformation of the asset, its record will be updated as well. The 
thumbnail will be updated and resemble the transformed asset – regardless of 
whether the thumbnail was rotated before. The following record fields will be 
updated with the new values: Horizontal Pixel, Horizontal Resolution, Image Height, 
Image Width, Thumbnail Height, Thumbnail Rotation, Thumbnail Width, Vertical Pixel, 
and Vertical Resolution.
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Check Out
Checks out the asset associated with the highlighted record to your workstation. Only 
available if asset versioning is enabled, e.g via File System Versioning or Cumulus Vault. 
(For more information on Cumulus Vault, see “Checking Assets Out” .) 

Undo Check Out
Cancels a previous check-out. The asset is returned to the asset versioning system but 
not as a new version. Only available if asset versioning is enabled, e.g via File System 
Versioning or Cumulus Vault. (For more information on Cumulus Vault, see “Undoing 
a Check Out” .) 

Check In
Checks a previously checked-out asset back into the asset versioning system as a new 
version. Only available if asset versioning is enabled, e.g via File System Versioning or 
Cumulus Vault. (For more information on Cumulus Vault, see “Checking Assets In” .) 
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Show History
Opens the Version History window, from which you can view version information on 
the asset associated with the selected record. Only available if asset versioning is 
enabled, e.g via File System Versioning or Cumulus Vault. (For more information on 
Cumulus Vault, see “Viewing an Asset’s Version History” .) 
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The Workflow Menu
The Workflow Menu is displayed only if the open catalogs contain at least one work-
flow. The menu contains an entry for every workflow available with the current cata-
log:

• [workflow name 1]
• [workflow name 2] 
• etc. 
Each workflow entry provides a similar submenu structure:

• Currently assigned to me – performs a query to find the records of all assets 
attached to the workflow that are currently assigned to you.

• [activity name 1...n] – One entry for each activity defined in the workflow. Select-
ing an activity promotes the asset to the next workflow state and performs the 
actions stated in the workflow definition (e.g. changing the assigned user, execut-
ing asset actions, etc). Which of these activities are available depends on your per-
missions and on the workflow state of the selected record. Only activities that are 
allowed in the current state can be performed.

• Remove Workflow – Removes the workflow from the asset and deletes the 
respective state and assignment information. The workflow can be started again, 
if desired. (This function is available only to Workflow Administrators!)
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The Help Menu
• Contents and Index
• Source
•  About

Contents and Index
Opens the table of contents and searchable index window for Cumulus’ help system. 
It is displayed by the default Web browser of your computer.

NOTE: The Cumulus help system is based on HTML pages that can be viewed 
with any standard Web browser. However, if you employ any pop up blockers, 
the display of the help system may not be possible. 
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Source
Opens a submenu that offers the options for the source of the Using Cumulus Help 
system you use. Select the desired:

Online

Cumulus Help comes from the Canto website, where the latest updates will always be 
available. (This requires an Internet connection.)

Local

Cumulus Help comes from your hard drive – if you had it installed with your Cumulus 
Client application. 
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About 
Displays a dialog that shows the version of Cumulus you’re using. You can get detailed 
version information by clicking the More button. It also provides a button that 
launches your default Web browser and initiates a connection to the Canto Web site. 
This requires an Internet connection. (See the Microsoft Windows documentation for 
information on setting your default Web browser.)
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Windows OS X

Collection Window – Record Pane
Thumbnail View Ctrl+1 Cmd+1

Details View Ctrl+2 Cmd+2

Information View Ctrl+3 Cmd+3

Preview View Ctrl+4 Cmd+4

Open Information window Ctrl+I Cmd+I

Open Preview window Ctrl+Y Cmd+Y

Open Fullscreen Preview window Ctrl+Shift+Y Cmd+Shift+Y

Open Record Find window Ctrl+F Cmd+F

Show location Ctrl+R Cmd+R

Open asset with creating application Ctrl+E Cmd+E

Connect to server Ctrl+Shift+O Shift+Cmd+O

Open catalog Ctrl+O Cmd+O

Catalog assets Ctrl+B Cmd+B

Print Ctrl+P Cmd+P

Display all records Ctrl+G Cmd+G

Select all Ctrl+A Cmd+A

Deselect all items Ctrl+Shift+A Shift+Cmd+A

Deselect one item Ctrl+spacebar     ---

Hide Cumulus     --- Cmd+H

Hide others     --- Alt+Cmd+H

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – KEYBOARD SHORTCUTS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

New empty collection Ctrl+Shift+N Shift+Cmd+N

Close collection window Ctrl+F4 Cmd+W

Exit Cumulus Alt+F4 Cmd+Q

Undo Ctrl+Z Cmd+Z

Cut Ctrl+X Cmd+X

Copy Ctrl+C Cmd+C

Paste Ctrl+V Cmd+V

Paste Metadata Ctrl+Shift+V Cmd+Shift+V

Edit Preferences Ctrl+, Cmd+,

Delete record from catalog Ctrl+Del Cmd+Del

Remove record from collection Del Del

Delete record from catalog without asking (same 
command as Cut)

Shift+Del Cmd+X

Assign rating: 1 star Ctrl+Alt+1 Alt+Cmd+1

Assign rating: 2 stars Ctrl+Alt+2 Alt+Cmd+2

Assign rating: 3 stars Ctrl+Alt+3 Alt+Cmd+3

Assign rating: 4 stars Ctrl+Alt+4 Alt+Cmd+4

Assign rating: 5 stars Ctrl+Alt+5 Alt+Cmd+5

Assign rating: no stars (no value) Ctrl+Alt+N Alt+Cmd+N

Start/quit Palette Mode Shift+Ctrl+P Shift+Cmd+P

For Thumbnail display

– use next larger size + +

– use next smaller size  - -

Windows OS X
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– rotate 90° clockwise Ctrl+Alt+R Alt+Cmd+R

– rotate 90° counterclockwise Ctrl+Shift+R Shift+Cmd+R

– rotate 180° Ctrl+Alt+Shift+R Shift+Alt+ Cmd+R

Change to next window Ctrl+Tab/Ctrl+F6  – – –

Thumbnail view 

Go to previous record arrow left arrow left

Go to next record arrow right arrow right

Go to record above arrow up arrow up

Go to record below arrow down arrow down

Details view: 

Go to previous record arrow up arrow up

Go to next record arrow down arrow down

Go to first page (unmarked) Alt+Home Alt+Home

Go to previous page (unmarked) Alt+arrow left Alt+arrow left

Go to next page (unmarked) Alt+arrow right Alt+arrow right

Go to last page (unmarked) Alt+End Alt+End

Go to first page (marked) Home Home

Go to previous page (marked) PgUp PgUp

Go to next page (marked) PgDn PgDn

Go to last page (marked) End End

Assign categories Ctrl+Shift+5 Shift+Cmd+5

Detach categories Ctrl+Shift+6 Shift+Cmd+6

Windows OS X
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When dragging & dropping an OPI file into another 
application:
– place high resolution file 
– place low resolution file

– – –
– – –

Alt+H
Alt+L

Toggle: category and record pane Tab Tab

Collection Window – Category Pane
Create new category Ctrl+J Cmd+J

Expand all categories Ctrl+Alt+X Alt+Cmd+X

Collapse all categories Ctrl+Alt+C Alt+Cmd+C

Category search for previous category Alt+arrow up Alt+arrow up

Category search for next category Alt+arrow down Alt+arrow down

Category search for selected category Enter Enter

Enterprise: Remove categories from collection 
Workgroup: Delete categories

Del Del

Delete categories Ctrl+Del Cmd+Del

With collapsed category: 
Go to category of next higher level 
With expanded category:
Collapse category

arrow left arrow left

With collapsed category: 
Expand category 
With expanded category:
Go to next subcategory

arrow right arrow right

Go to previous category arrow up arrow up

Go to next category arrow down arrow down

Windows OS X
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Go to first category (unmarked) Ctrl+Home Cmd+Home

Go to previous category page (unmarked) Ctrl+PgUp Cmd+PgUp

Go to next category page (unmarked) Ctrl+PgDn Cmd+PgDn

Go to last category (unmarked) Ctrl+End Cmd+End

Go to first category (marked) Home Home

Go to previous category page (marked) PgUp PgUp

Go to next category page (marked) PgDn PgDn

Go to last category (marked) End End

Collection Window
Show/hide Category pane Ctrl+F3 Cmd+F3

Show/hide Information pane Ctrl+F7 Cmd+F7

Show/hide Category Information pane Ctrl+F8 Cmd+F8

Show/hide Thumbnail pane Ctrl+F9 Cmd+F9

Show/hide Preview pane Ctrl+F10 Cmd+F10

Show/hide Calendar pane Ctrl+F11 Cmd+F11

Show/hide Collection Basket pane Ctrl+F12 Cmd+F12

Use Default Workspace Ctrl+F1 Cmd+F1

Assign categories Ctrl+Shift+5 Cmd+Shift+5

Detach categories Ctrl+Shift+6 Cmd+Shift+5

Windows OS X
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Information Window / View/Pane
Save changes Ctrl+S Cmd+S

Print Information window Ctrl+P Cmd+P

Load information on

– first record in collection Alt+Home – – – 

– on next record in collection Alt+arrow right – – – 

– on previous record in collection Alt+arrow left – – – 

– on last record in collection Alt+End – – – 

Go to next field Tab Tab

Go to previous field Shift+Tab Shift+Tab

Preview Window and Preview Fullscreen
Load preview of

– first record in collection Home Home

– previous record in collection PgUp /
Alt+arrow left

PgUp /
Alt+arrow left

– next record in collection PgDn /
Alt+arrow right

PgDn /
Alt+arrow right

– last record in collection End End

100% display Alt+Ctrl+0 Alt+Cmd+0

Fit to main window Ctrl+0 Cmd+0

Zoom in Ctrl++ Cmd++

Zoom out Ctrl+- Cmd+-

Scroll in preview arrow keys arrow keys

Windows OS X
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Preview Window only
Print preview Ctrl+P Cmd+P

Edit with creating application Ctrl+E Cmd+E

Preview Fullscreen only
Start/stop loop spacebar spacebar

Close fullscreen mode Escape Escape

Multi-page Previews
Load first page of preview Alt+Shift+Home Alt+Shift+ Home

Load previous page of preview Alt+Shift+arrow left Alt+Shift+ arrow left

Load next page of preview Alt+Shift+arrow 
right

Alt+Shift+ arrow 
right

Load last page of preview Alt+Shift+End Alt+Shift+End

Windows OS X
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Administration:
Getting Started

This chapter covers some topics important for getting your Cumulus configuration up

and running. Since your workgroup needs Cumulus catalogs to access, this chapter

gives you a few guidelines about effective catalog administration, as well as informa-

tion on how to provide catalogs to your workgroup.
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How Cumulus Works
Canto offers different editions of Cumulus:

• Cumulus Workgroup Edition 
• Cumulus Enterprise Edition 
The different editions of Cumulus are designed to meet the needs of anyone who 
wants to keep track of their digital media. To meet individual workflow needs, Canto 
has developed a range of additional add-on products. For more information on 
Cumulus products, see Canto’s website.
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The Cumulus Architecture

Cumulus features a client/server architecture in which individual users (or clients) 
access the server application across a network.

The Cumulus Architecture
Cumulus can be seen as "middleware" as it 
communicates between the levels of the 
employed operating systems, storage devices 
and databases and the user interface level. The 
main components of Cumulus are the meta-
data server, an asset server and a processor 
server. These components can be installed on 
different computers with different operating 
systems.
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The Cumulus Client/Server Architecture

The overall client/server architecture is simple. The Cumulus Server is installed on a 
server computer in the network. The Cumulus Clients are then installed on computers 
that have access to the computer running the Cumulus Server. 

The communication between Clients and Server is handled via the Internet-standard 
TCP/IP, enabling Clients to access Cumulus catalogs from anywhere in the world. 
Since Cumulus is cross-platform compatible, both Mac OS X and Windows Clients can 
access catalogs administered by any Cumulus Server. The only restriction is that the 
Client has to have TCP/IP access to the computer running the Server.

You don’t have to specify which computers are running the Cumulus Client applica-
tion. The Cumulus Server allows as many Clients to connect as the number of Clients 
you purchased, no matter where they’re trying to connect from.

The Cumulus Administrator 

The Cumulus Administrator has to perform the following tasks: 

• Installing the Cumulus Server application on a server computer in the network. 
(See the online Installation Guide.)

• Registering your Cumulus configuration and activating the software. (See the 
online Installation Guide.)

• Configuring the Cumulus Server – employing the Remote Admin utility. (See 
“Remote Admin”)

http://www.canto.com
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The Cumulus Administrator is responsible for the following tasks: 

• Providing catalogs to Cumulus Clients by creating new catalogs or adding existing 
ones to the list of catalogs administered by the Cumulus Server. (See “Providing 
Catalogs”.)

• Configuring each catalog’s settings to meet the specific needs of the workgroup. 
(See “Catalog Settings”.) 

• Making catalogs available or unavailable to Cumulus Clients and defining individ-
ual user permissions. (See “Managing Users”.)

• Maintaining the catalog files themselves, including tasks such as optimizing cata-
log performance, backing up and restoring catalogs, repairing catalogs, etc. (See 
“Catalog Maintenance”.)

The permission to perform these tasks can be given to other users. The Cumulus 
Administrator has all these permissions by default and is the one who is responsible 
that the permissions are given according to the specific needs of the workgroup.

Cumulus Clients

Cumulus Clients such as Cumulus Web Client or Cumulus Desktop Client access cata-
logs by logging onto the Cumulus Server and opening catalogs administered by the 
Server. Once logged on, they have access to all of the functions described in the 
Cumulus help (provided, of course, that the Cumulus Administrator has not restricted 
their permissions to use these functions).

The Cumulus Server

Once installed, as default the Cumulus Server is launched “invisibly” every time the 
computer it’s running on is started up. Most administrative actions can be performed 
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from a Cumulus Desktop Client application logged on as Cumulus Administrator to 
the Server. Before you can log on from a Client, however, you have to register the 
Cumulus software and maybe configure the Cumulus Server properties. You config-
ure the properties of a Cumulus Server using the Remote Admin module. For details 
on the Remote Admin module, see “Remote Admin” ”. 
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The Cumulus Administrator
To administer Cumulus, there has to be a user account which functions as the 
Cumulus Administrator. This user account is created during the installation of the 
Cumulus Server with the default name cumulus. 

The Cumulus Administrator has to perform the following tasks: 

• Installing the Cumulus Server application on a server computer in the network. 
• Registering your Cumulus configuration and activating the software. 
• Configuring the Cumulus Server – employing the Remote Admin utility. 
The Cumulus Administrator is responsible for the following tasks: 

• Providing catalogs to Cumulus Clients by creating new catalogs or adding existing 
ones to the list of catalogs administered by the Cumulus Server. 

• Configuring each catalog’s settings to meet the specific needs of the workgroup. 
• Making catalogs available or unavailable to Cumulus Clients and defining individ-

ual user permissions. 
• Maintaining the catalog files themselves, including tasks such as optimizing cata-

log performance, backing up and restoring catalogs, repairing catalogs, etc. 
The permission to perform these tasks can be given to other users. The Cumulus 
Administrator has all these permissions by default and is the one who is responsible 
that the permissions are given according to the specific needs of the workgroup.

There is only one Cumulus Administrator, but to provide your workgroup with extra 
flexibility in managing catalogs, Cumulus permits more than one user to act as 
Cumulus Administrator simultaneously. It does not, however, permit more than one 
user to open a catalog as Administrator at the same time. Each one simply needs to 
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enter the user name of the Cumulus Administrator when connecting to the Cumulus 
Server. 

Initial Tasks and Their Order

The sections that follow describe how to log on as Administrator and then how to pro-
vide catalogs as this is the next step to be performed. This should be done before you 
set up any Cumulus Client users as you can only allow them access to catalogs that are 
provided by the Cumulus Server. For a description on how to set up users, see “Man-
aging Users” . However, before you let your Cumulus Clients work with these catalogs 
you should set up the catalogs as well. For a description on how to set up catalogs, see 
“Catalog Settings” . 

Logging On as Cumulus Administrator

Before you can begin managing your workgroup’s catalogs, you have to log onto the 
Server as Cumulus Administrator from a Cumulus Desktop Client application.

To log on as Cumulus Administrator:

1. From any Cumulus Desktop Client, select File > Connect to Cumulus Server.

The Connect to Server dialog box appears. 

2. In the Server field, select or enter the name of the Cumulus Server, you want to 
connect to. 

If you are logging on from the same computer as the Server is installed, you can 
type in localhost. If more than one Cumulus Servers are available to you, click on 
the arrow to get a list displayed. This list contains the names/IP addresses of all 
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currently active Cumulus Servers in the network. If necessary, edit the IP address 
of the Cumulus Server by selecting another one from the drop-down list. The IP 
address can be either a numbered address or the name of the Cumulus Server 
(e.g., cumulus.canto.com).

NOTE: To be able to connect to the Server, every Client must specify a port num-
ber. By default, Cumulus automatically determines an open port number and 
configures it for both Server and Clients (see “Remote Admin” ). Change the port 
number only to avoid a conflict with other server software. If the port number is 
changed, all Clients need to be informed of this fact or they will not be able to log 
on. 

3. Under Connect as, enable Registered User.

4. Type the user name of the Cumulus Administrator in the Name field and the cor-
responding password in the Password field. (See “The Cumulus Administrator”, 
for information on the identity of the Cumulus Administrator.)

5. Click OK. 

The Catalog Access window appears.

The Catalog Access Window

The Catalog Access window lists all catalogs currently administered by the Cumulus 
Server and is the starting point for performing numerous administrative tasks. 

Via the Catalog Access window, you can:

• Open a catalog and modify its properties (see “Catalog Settings” ).
• Create new catalogs (see “New Catalogs” ).
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• Add existing catalogs to the list of those administered by the Cumulus Server (see 
“Adding Existing Catalogs” ).

• Remove catalogs from this list. Then they are not administered by the Cumulus 
Server.

• Rebuild a damaged catalog (See “Repairing Catalogs”).
• Migrate old catalogs to the current catalog format (See “Migrating Catalogs”).
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Working Smart 
Before you jump into providing catalogs for your workgroup, it’s a good idea to 
become familiar with a few guidelines that will make your work with Cumulus as effi-
cient and effective as possible.

Name a Catalog Manager

It’s best to assign one person in your workgroup to manage assets and Cumulus cat-
alogs. Having one manager helps keep things consistent and provides your work-
group with a recognized source for asset and catalog information.

For the catalog manager to be able to effectively manage workgroup catalogs, this 
user has to log on to the Cumulus Server as the Cumulus Administrator. For details on 
acting as the Cumulus Administrator, see “The Cumulus Administrator” .

Develop an Effective File Naming Convention

Even though Cumulus makes it easy to keep track of assets with its thumbnail pre-
views and wealth of search options, there is no substitute for a well planned filing sys-
tem. There will be times that you must access files without the convenience of the 
Cumulus interface. For example, when writing scripts to enable Cumulus to automate 
the workflow, a consistent and predictable filing system can not only save many hours 
of script debugging, but it can also enable functionality that might not otherwise be 
possible.

How you name your files will depend on how you use them. A news agency may 
decide to name incoming news stories prefixed with the current date and affixed with 
the file type:
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2003-06-01-ElectionResults.txt
2003-06-01-ElectionResults.tif

Using the date in this order lists the files chronologically when sorted alphabetically. It 
also makes it easier for Cumulus scripts to select files based on a date range.

A Web design group may choose to include an image’s file size in its name to make 
entering HTML size tags more convenient: MainPageBanner200x50.gif

Or, to use this manual as an example, file names for screen shots of menus and dialog 
boxes each begin with either “M_” or “W_” to identify the platform from which the 
images come. For example, the file name for the Mac OS File menu is: M_FileMenu.tif. 
Its Windows counterpart is called: W_FileMenu.tif

Using the two file name prefixes not only helps differentiate the files at a glance, but 
also helps to make the filing system more predictable. From this example, you can 
probably guess the file names of most images in this document. Consistency and pre-
dictability are key to developing a naming convention that will serve you and your 
workgroup well.

Develop an Effective Folder Naming Convention

Apply an equally clear naming convention to your folder (directory) structures. 
Cumulus can use your folder hierarchy to create categories when cataloging assets. It 
is a real time saver if your folder structure helps to identify your assets. 

Some users may choose to store assets in folders based on file type rather than project 
name. A sound clip of audience applause, for example, may be used in many projects, 
but it will always be a sound clip. You can use Cumulus’ categories to associate assets 
with one or more projects.
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Cross-Platform Catalog Use

Though the catalogs that Cumulus creates are completely cross-platform compatible, 
it is up to you to use a catalog file naming convention compatible with each platform 
which you plan to use for your catalogs.

Keep in mind that catalog names and catalog file names are two different things. For 
cross-platform purposes, you need only be concerned with catalog file names. (see 
“Renaming Catalogs” , for catalog naming information.)

Consult your operating system’s documentation for details on the range of characters 
that can be used. In the meantime, here are a few tips:

• Windows uses a backslash (\) to differentiate folder hierarchies. Mac OS users 
should avoid using this character in their catalog names. (The Mac OS uses a colon 
(:) to differentiate folder hierarchies, but this character is not allowed in files name 
on either platform, so it is of no real concern.)

• Windows file names can be up to 255 characters in length. Mac OS file names must 
be 31 characters or less.

Characters that are safe for use on all Cumulus platforms include all upper and lower 
case letters, all numbers, the hyphen (-), and the underscore ( _ ).

Multiple Catalogs & Servers

You may want to use separate servers for different departments within your organiza-
tion. Although each server can manage one or more catalogs, you must have a sepa-
rate copy of Cumulus for each server. 

When evaluating your media management needs, consider the following questions:

• How many Clients will access the catalog?
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• How many assets do you need to manage, today and in the future?
• Where will the cataloged assets be stored? Who should have access to the cata-

loged assets (for example, to modify them)?
• Does the media archive contain logically unrelated groups of assets? 
• Do different groups of people use different groups of assets? Or do the documents 

themselves fall into multiple categories?
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Providing Catalogs
Catalogs to be shared by your workgroup must be administered by the Cumulus 
Server, which means that they must appear in the list of catalogs administered by the 
Server (in the Catalog Access window). Catalogs administered by the Cumulus Server 
have to be stored locally on the computer running the Server application. So before 
you jump into providing catalogs for your workgroup, make sure that you create or 
note the location(s) that will house the catalogs you provide.

You have a couple of options for providing catalogs to be administered by the 
Cumulus Server. You can either create new catalogs or add existing catalogs to the list 
in the Catalog Access window. If you add catalogs from previous Cumulus versions, 
you must migrate them to the current Cumulus format. The sections that follow 
describe how to provide catalogs to your workgroup using any of these routes. 

Creating New Catalogs

The first step in creating new workgroup catalogs is to create or note the location 
where they will be stored on the computer running the Cumulus Server. So if you 
haven’t already done so, do that now.

Then you can log on to the Cumulus Server from any Cumulus Desktop Client and tell 
the Server where the catalog is to be stored and what you want to call it. 

You create new catalogs via the Catalog Access window. For a detailed description see 
“New Catalogs” .
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Adding Existing Catalogs

Catalogs to be administered by the Cumulus Server must be stored locally on the 
computer running the Server application Only catalogs stored in locations approved 
by the Cumulus Administrator can be used by Cumulus. So before you add a catalog 
for your workgroup, make sure that it is stored in appropriate location. You can then 
log on to the Cumulus Server from any Cumulus Desktop Client and tell the Server 
where the catalog can be found.

Catalogs created with Cumulus version 7 or 8  can be opened with Cumulus 9, but 
must be migrated explicitly in order to support the new features. Catalogs created 
with Cumulus versions earlier than 7 can not be opened with Cumulus 9 and must be 
migrated before they can be used. (See “Migrating Catalogs”, for more information.)

To add an existing Cumulus catalog to the list:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On as 
Cumulus Administrator” ).

2. In the Catalog Access dialog box, click Add to List.

The Browse window appears.

3. If necessary, select the location where the catalog is stored from the Look In drop 
down menu

4. Select the desired catalog file (.ccf ) from the list an click Open.The added catalog 
appears in the catalog list of the Catalog Access window.

Your catalogs are now administered by the Cumulus Server and can be accessed by 
Cumulus Clients. 
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Catalog Availability

There are two levels of catalog access to keep in mind when managing user permis-
sions:

• Catalog availability – Determines whether or not a catalog is available for sharing 
at all. If available, the catalog is available to every Client who connects to the 
Server, unless you define specific user access restrictions.

• User permissions – Determines how a catalog is shared. You can define which 
access permissions users have. (See “User Properties”.)

Making Catalogs Available

Just because a catalog appears in the list of catalogs administered by the Cumulus 
Server, it doesn’t mean that it can be shared by your workgroup. You first have to make 
each catalog available before it can be accessed by Clients.

To make a catalog available to Clients in general:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On as 
Cumulus Administrator” ).

The Catalog Access window appears. You can see which catalogs are accessible 
to clients by selecting a catalog and noting whether the Share Catalog option is 
checked for that catalog.

2. Select the catalog you wish to make available to Clients and enable Share Cata-
log.

A dialog asks you to confirm the change of the sharing status of the catalog in 
question.
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3. Confirm the change.

The catalog is now available to every Client who has got the respective permissions, 
see “User Properties” .

Making Catalogs Unavailable

There are two ways to make a catalog unavailable to Clients. Both are done from the 
Catalog Access window. You can:

• temporarily deactivate it in the list of catalogs administered by the Cumulus Server 
by disabling Share Catalog.  

• permanently remove it from the list of catalogs administered by the Cumulus 
Server by clicking Remove from List. The catalog is not deleted, but is no longer 
administered by the Cumulus Server.

To make a catalog unavailable to Clients in general:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On as 
Cumulus Administrator” ).

The Catalog Access window appears. You can see which catalogs are accessible 
to clients by selecting a catalog and noting whether the Share Catalog option is 
checked for that catalog.

2. Select the catalog you wish to make unavailable to clients and disable Share Cat-
alog. A dialog box appears asking you to confirm the change of the sharing status 
of the catalog in question.

3. Click OK.
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The catalog still appears in the list of catalogs administered by the Cumulus Server, but 
it is no longer available to be shared by Clients.

To remove a catalog from the list of catalogs administered by the Cumulus Server:

1. Log on as Cumulus Administrator to the Cumulus Server (see “Logging On as 
Cumulus Administrator” ).

The Catalog Access window appears. 

2. Select the catalog you wish to remove from the list and click Remove from List.

If the catalog to be removed is being used by a Client, a dialog box appears in 
which you can determine the length of time the Clients have before they will be 
disconnected. This dialog box also lets you send these Clients a message on the 
impending disconnection.

3. Click OK.

The catalog is removed from the list in the Catalog Access window, but is not deleted 
from the system.
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Going On
As Cumulus Administrator, you are responsible 

• for setting up the catalogs to meet the needs of your workgroup. To find out how, 
see “Managing Catalogs” .

• for creating Cumulus Client users and giving them the permissions for accessing 
catalogs and functions as it best suits your workflow. To find out how, see “User 
Properties” .

• for providing View Sets, Asset Handling Sets, Actions, and Metadata Templates to 
the Cumulus Client users that meet the specific needs of your workgroup. To find 
out how to define these sets, see “Customizing Cumulus” . 
The Cumulus Administrator can also give other Client users the permissions to 
define these items. You can have users with very individual permissions. For exam-
ple, you can have users who have the permissions to define shared Asset Handling 
Sets or the permissions to define shared View Sets and others who are allowed to 
do both. This enables big organizations to delegate these tasks to different users, 
e.g. from different departments. However, as the Cumulus Administrator knows 
best about the fields included in the catalogs, it’s also the Cumulus Administrator 
who knows best how to set up View Sets that meet the specific needs of the work-
group and fit the catalogs used by the workgroup. Again it’s the Cumulus Admin-
istrator who knows best about the Asset Handling modules that are used by the 
workgroup and that’s why the Cumulus Administrator is the one who knows best 
how to set up Asset Handling Sets that are ideal for the workflow. The same goes 
for Actions and Metadata Templates. However, it is up to you either to take over 
these tasks yourself or to train other users so that they can take on these tasks.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – ADMINISTRATION: GETTING STARTED GOING ON

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

• for configuring messages sent by the mail notification function. (For details, see 
“Configuring Email Notifications” )

Default User Settings

However, the Cumulus Administrator has all permissions by default and is the only 
one who can define the User Settings before other Cumulus Client users start working 
with a new Cumulus installation. This is possible because all settings are centrally 
stored at the Cumulus Server. The Cumulus Server installation folder includes a conf 
folder that houses folders where the settings are stored. The Users folder holds the 
individual folders of Cumulus Clients (named as their login names) where their individ-
ual settings are stored. The Server folder holds the shared settings that can be used by 
all Cumulus Clients. 

When a Client user logs in to a new Cumulus installation for the first time, all settings 
are taken from the DefaultUser folder. However, only then, as with logging in for the 
first time, an individual folder is created in the Users folder for each Client user to store 
her/his individual settings. When logging in next time, the settings from this individual 
folder will be taken. 

Customizing Default User Settings

In case the Cumulus Administrator wants the Client users to have initial  User Settings 
that differ from those Canto provides, there is an easy way to prepare this before a Cli-
ent user logs in for the first time.

In order to do this, log in as Cumulus Administrator and define the User Settings as you 
want them to be for Cumulus Client users to start with. Then save them and close the 
Preferences windows (or even quit the Cumulus application). The User Settings are 
stored in the Cumulus Administrator’s folder (default: cumulus) inside the Cumulus 
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Server installation folder, e.g 
 ..\Canto\Cumulus Enterprise Server\ conf\Options\Users\%7b98ca1422-0171-4d1d-8b84-

8cdda4ab70ae%7d\cumulus or 
 /usr/local/Cumulus_Enterprise_Server/conf/Options/Users/%7b98ca1422-0171-4d1d-8b84-

8cdda4ab70ae%7d/cumulus 

Then copy the ModulePreferences.xml & ModulePreferences.pack files from the  this 
folder to the folder of the default user (named defaultuser), e.g.

..\Canto\Cumulus Enterprise Server \conf\Options\Users\ %7b98ca1422-0171-4d1d-8b84-
8cdda4ab70ae%7d\defaultuser or 

 /usr/local/Cumulus_Enterprise_Server/conf/Options/Users/%7b98ca1422-0171-4d1d-8b84-
8cdda4ab70ae%7d/defaultuser

NOTE: Do not copy any possibly existing collections.xml file! Collections can 
not be duplicated this way. 

TIP: Copying the User Settings of a Selected User for Other Users

The User Manager module offers a function that lets you copy user settings 
from one user to another. In that case the User Settings for the Cumulus appli-
cation as set in the Preferences window are copied. For details see “Copying 
User Settings” .

Default User Settings with Roles

If you employ the role-based mode of the User Manager, Cumulus offers the possibil-
ity to provide different initial settings for the different roles. Each role created with the 
User Manager has its own folder located in the Users folder, and if a user assigned to 
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certain roles logs in for the first time, she/he will get her/his individual user folder 
which contains the settings provided by the role’s folder. If the role’s folder does not 
contain certain settings they are taken from the DefaultUser folder. If a user is assigned 
to more than one role, the settings from the assigned roles will be added and merged 
before copied to the individual user folder.

To make use of this feature you must copy the desired settings ( e.g. ModulePrefer-
ences.xml & ModulePreferences.pack) to the roles’ folders.
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Just in Case: Troubleshooting
In very rare cases, the Cumulus Desktop Client can get unresponsive. If this happens, 
the Canto support team might need some information in order to properly investigate 
the reason of the issue. To facilitate this, Canto provides a dedicated tool to create cli-
ent dumps. A client dump is a bunch of files that reflect the state of your client in the 
very moment of the occurrence of the problem. This tool, Create Client Dumps, is 
installed automatically with the Cumulus Desktop Client, both on Windows and on 
Mac computers.

NOTE: The dump files may contain potentially sensitive information, e.g. about 
the name of your computer, the folder structure, and running processes, 
among others! While you could easily edit the computer’s name, the bulk of 
this information, however, is needed for a proper analysis and must not be 
altered in any way.

Invoking the creation of dumps works slightly different on Windows and Mac OS.
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Windows

To initiate the creation of client dumps on Windows:

1. Click the Start button and navigate to Cumulus node. Expand it. Depending on 
your Windows version, you see something like this:

2. Click Create Client Dumps. 
Creating the dumps may take a while. You may see several command prompts 
popping up during this time.

A folder named CumulusClientDbg will be created on your desktop. Each time the 
Create Client Dumps tool is executed, a new subfolder is created within this folder, the 
name of which is composed of your computer’s name and the date and time of the 
dump’s creation, e.g. MY-COMPUTER_2017-08-10_13-05-54. This folder contains all 
files related to the dumps and can easily be transmitted e.g. to the Canto support 
team.
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Mac OS

NOTE: A client dump from a Mac computer includes a screen shot. Therefore, 
make sure that the UI of the unresponsive Cumulus Client is in the foreground 
and completely visible when you invoke the dump. Do not hide or minimize 
the Cumulus Client! However, it is strongly advised to minimize or hide all other 
applications before you start the Create Client Dumps tool in order to prevent 
the involuntary leaking of confidential data.

To initiate the creation of client dumps on Mac OS:

1. Open the Cumulus installation folder (usually Applications/Cumulus Client).

2. Double click Create Client Dumps.
Creating the dumps may take a while.

A folder named CumulusClientDbg will be created on your desktop. Each time the 
Create Client Dumps tool is executed, an new subfolder is created within this folder, 
the name of which is composed of your computer’s name and the date and time of 
the dump’s creation, e.g. MY-COMPUTER_2017-08-10_13-05-54. This folder contains 
all files related to the dumps. For your convenience, a zip file of this folder with the 
same name is created additionally and can easily be transmitted e.g. to the Canto sup-
port team.
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Customizing Cumulus

A little up-front planning can save countless hours of work and frustration further

down the road. This section explains the setting up of Cumulus preferences and also

offers some information on Asset Handling modules and Asset Format support.

The topics of this chapter include:

• Preferences

• User Settings

• Record View Sets

• Category View Sets

• Asset Handling Sets

• Asset Handling Modules

• Asset Format Support

• Cumulus Asset Actions

• Metadata Templates

• Print Templates

• Crop Templates

• Sub-Pane Filters

• Permissions Templates
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Preferences 
There is no best way to use Cumulus. Many aspects of the program can be changed 
to adapt to your way of managing your assets. Fundamental changes can be made by 
modifying the preferences. 

The Preferences window is available only from within the Cumulus Client application 
as soon as a Cumulus catalog is open. All user settings and catalog settings are config-
ured from within this single window. The available options depend on permissions of 
the logged-in user.

When making catalog-specific changes and more than one Cumulus catalog is open, 
a drop-down list enables you to select the catalog which settings you want to change. 
(You cannot make changes to a catalog you are not connected to.)

The left column of the Preferences window displays icons for the sections you have 
the permissions to access. These permissions are Server permissions and they are 
defined employing the User Manager module of the Server Console.

What you can see in the window and what you are allowed to edit depends on the 
permissions you have for viewing, modifying and creating the different preferences. 
For details on the different sets or settings see: 

• “User Settings” 
• “Record View Sets” 
• “Category View Sets” 
• “Asset Handling Sets” 
• “Cumulus Asset Actions” 
• “Metadata Templates” 
• “Print Templates” 
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• “Sub-Pane Filters” 
• “Permissions Templates” 
• “Catalog Templates” 
• “Catalog Settings” 

TIP: Properties for Sets, Templates and Actions

Clicking on the  icon opens the Properties dialog of the selected set, tem-
plate or action – offering two tabs. The Description tab allows you to enter a dis-
play name and a description for the item in each language supported by 
Cumulus. The Sharing tab allows you to define whether you want to share an 
item with others. And if you want to share, you may define specific users or 
roles that are allowed to use the item.
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User Settings
The User Settings section of the Cumulus Preferences provide access to your individual 
user settings – at least your personal settings for the Cumulus application. It can also 
provide access to other user settings for other applications integrated in Cumulus.

The settings made for the Cumulus application affect global application behavior. They 
are specific to the connected user. They are not specific to any one catalog. Included 
here are options that control the way Cumulus conducts application category 
searches. 

User settings are not specific to computer platform, Client software or catalog. This 
means that settings made by a user at one workstation will be active when that user 
logs in to Cumulus from another workstation, no matter which catalog is used. Set-
tings made in the Client application also apply when the user is connected via a 
Cumulus Web client (Web Client)/Portals/Sites), where applicable.

PRECONDITIONS: To modify your User Settings, you must have the appropriate per-
missions (Server Permissions > User Permissions > Modify [tab name] User Set-
tings.) 

For detailed information on the options available, see “Overview: User Settings” . 
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Overview: User Settings 
The User Settings section contains tabs that separate sections. Beneath each tab are 
one or more sections that further organize options available. 

Select the tab first and then click the icon for the component. 

General Tab 

• Application

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS USER SETTINGS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Double-Click on Record
1Double-clicking on a 
record will open the 
Asset Information win-
dow.
2Double-clicking on a 
record will open the 
Preview window.
3Double-clicking on a 
record will open the 
asset for editing with 
the application used to 
create the asset. 

NOTE: If the asset is 
under control of a ver-
sion control system 
(e.g. Cumulus Vault), it 
will be checked out.

4Double-clicking on a 
record will open the 
asset for viewing with 
the application used to 
create the asset.

Measurement
5Selects preferred unit 
of measurement for 
heights and widths.

4

7
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When Updating
6 Forces Cumulus to count assets before cataloging begins, so that it can display a progress 

bar (slows performance).
7 Records of newly cataloged assets will always be added to the current collection.
8 Users carrying out auto cataloging (via a directory category) will be informed of auto cata-

loging activities: the Metadata Editor window will pop up.
9 Activate to include the records of unchanged assets in an update process useful e.g. if cata-

log settings have been changed).
10 Activate to updated the records for contained assets (related sub assets).
11 Activate to additionally delete records of no longer contained sub assets.

Category handling when dragging and dropping records into a different catalog
12 If activated, a dialog is shown for each drag and drop action, allowing users to decide on the 

category handling individually.
13 Categories to which the dragged & dropped records are assigned in the source catalog, but 

are missing in the target catalog, will be created there.
14 Categories to which the dragged & dropped records are assigned in the source catalog, but 

are missing in the target catalog, will be ignored

Checkout
15 Users carrying out a version control (e.g. the Cumulus Vault Option) can define their general 

Checkout Location. That way they can avoid being asked for the Checkout Location for each 
check out they perform. 

When Starting
16 At startup, Cumulus will open all catalogs and collections that were open when Cumulus 

was closed the last time. If this option is not enabled, Cumulus will always start without an 
open catalog or collection.
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• WebAlbum

1Automatically loads the Album Layout that 
was used last when the WebAlbum feature is 
started. (See “WebAlbum”, for a description on 
how to use the WebAlbum feature.)

Display Tab

The Display Tab provides access to general display options, options for transparency 
display and the display options for the different view modes. 

• General

Thumbnail Size
1Defines the sizes of 
small, medium and 
large thumbnails. 
The sizes defined 
here for thumbnails 
are those displayed 
when the respective 
size is selected.

Collection Window
2When selecting 
another View Set the 
settings for all win-

dows and panes will change to those of the newly selected set. If the option is not activated, 

1

1

2

3

5

4

6
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the settings will change for the currently selected pane or window only.
3 Highlights the active sub-pane in the color selected in the field on the right. Click the button 

to select a color.

Color Management
4 Shows preview with color management profile used by asset and highlights any part of the 

image that is beyond the printable color spectrum of the printer selected in # 5, below.
5 Selects a color management printer profile - Mac OS: ColorSync; Windows: ICM. (Disabled if 

# 4 is not selected.)
6 Click to select a warning color for unprintable shades in an asset.

• Transparency

Some asset for-
mats create trans-
parent areas in an 
image’s preview or 
thumbnail. For 
these you can spec-
ify how the trans-
parent areas are 
displayed. Such 
formats are: Porta-
ble Network 
Graphics (PNG), 
GIF Image, Photo-
shop (PSD, PSB), 

TARGA Image (TGA, TPIC), Windows Cursor (CUR) and Windows Icon (ICO).

1

2

3
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Transparency Grid Display
1 If activated, the transparent areas of a preview are displayed as a grid and you can select the 

grid size. If not activated, the background color selected for the Record View Set is used for 
transparency display of a preview.

2 If activated, the transparent areas of a thumbnail are displayed as a grid and you can select 
the grid size. If not activated, the background color selected for the Record View Set is used 
for transparency display of a thumbnail.

3 Allows you to choose colors for the grid. You can either choose a pre-defined color combina-
tion or define your own custom combination. Click the buttons to select the colors for your 
custom combination.

• View Modes – Groups of Options 

The options for the different view modes– that is, the Info View, the Asset Info Window, the Pre-
view View, the preview Window and the Category Info Window – comprise one or more of the 
following groups. 

Audio
1When you open the view, the voice annotation in the first 
Audio field of the Information window will be played (only 
works on Windows).

Assets/Categories
Specifies what happens once you open an Information window 

2Cumulus opens a new Information 
window for each asset/category.
3Cumulus uses one window to show 
information on all currently selected 
assets/categories. Displays and lets you 
edit common information for multiple 
records/categories.

1

2

3

4

5
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4 The open window displays the records/categories currently selected in the Collection win-
dow and follows any selection changes.

5 The open window displays the values that are identical for all currently selected records/cat-
egories.

Window Position
6Always displays the window on top of all other windows.

Preview Window Mode

7Always opens a preview in fullscreen.
8Always opens a preview in a separate preview window.
9Keeps the Preview window always on top of the Cumulus 
main window (Default). – If deactivated, the preview win-
dow remains inside the Cumulus main window, as in earlier 
versions of Cumulus.

Preview View Size
10Defines the sizes of small, medium and large preview 
views. The sizes defined here for preview views are those dis-
played when the respective size is selected.

6

7

9

8

10
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Preview Image Size
You can select one of the following options:
11Shows asset previews at the selected predefined preview 
view size.
12Shows asset previews at the actual size of the asset. (For 
large images with high resolution, this could result in a very 
large preview.)
13Enables selecting whether previews are enlarged or 
reduced to fit the size of the preview window.
14Enables selecting whether the width of previews is enlarged 
or reduced to fit the size of the preview window.
15Enables selecting whether the height of previews is 
enlarged or reduced to fit the size of the preview window.
16Selects a predetermined size for all previews.

Additional Preview Settings
17Hides the toolbar when the preview is dis-
played fullscreen (only available with the Preview 
Window settings).
18Shows an error message if a preview can’t be 
generated.

Use Mouse Wheel in Preview For
19Toggle the mouse wheel function: Either use the 
mouse wheel to cycle between records, or between 
the pages of multi-page records. 

TIP: Press Ctrl while using the mouse wheel 
to invert the way it works. 
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Search & Sort Tab 

• Records
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Category List Search 
These options affect the way the Cumulus application finds records if you double-click on cate-
gories. – Note that these settings also affect the search results when the Categories field is 
included in a search request (e.g. with Quicksearch)!
1 Found records must match at least one selected category.
2 Found records must match all selected categories.
3 Found set includes records assigned to parent categories of the selected category. (Catego-

ries that have subcategories are called parent categories.)
4 Found set includes records assigned to subcategories of the selected category.
5 Found set includes records belonging to the original category of a related subcategory. 

NOTE: Difference between finding files by Category List Search, or by Quicksearch
The Category List Search performs an “is” search, the Quick search a “contains” search. 
If, for example, you search for a category called “test” with the Category List Search, the search 
result will contain only records belonging to that category (and, depending on the Preferences, 
records belonging to categories below and/or beneath that category). 
If you perform a (record) Quicksearch with the string “test”, the search result will contain not only 
records belonging to that category, but also records belonging to any other category containing 
that string in its name, such as “testcase” or “protest”.
It is possible to obtain the same search result with the Category List Search. To do so, first select 
all categories containing the respective string (via Find > Show Categories Containing), then 
press Enter or perform a double click.

Quicksearch Fields
6 Activates the default setting for Record Quicksearch: a “contains” search in the record fields 

Record Name, Notes, Keywords, and Categories
7 Only with catalogs containing multi language record fields: If activated, the Quicksearch is 

extended to all language specific fields of the default field selection. 
8 Enables an individual setting for the Record Quicksearch. If this option is activated, Quick-

search will search the fields displayed in the list. Click Add to get a list of all available record 
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fields of the type String, String List and Integer. A “contains” search is performed for all 
included String and String List fields and an “is” search for all included Integer fields. Make 
sure the fields are correctly indexed for searching in the Catalog Settings of the catalogs 
where you want to use Record Quicksearch. 

NOTE: To allow multi-lingual searching, you must add the required language specific fields 
explicitly. The exception of this rule is the Categories field (see below).

9 Activate this option to enable multi-lingual searching in the Categories field (only relevant it 
the Categories field is contained in your individual Quicksearch settings).

Additional Options
10 Selected records remain selected even when sort criterion or order is changed, or when a 

(new) search is performed and they appear in the search result, or when a filter is applied.

NOTE: After a search/sort/filter operation, the collection automatically scrolls to the first 
selected record, i.e. the first record displayed is not necessarily the first record in the collection 
(use the scrollbar to scroll to the top of the collection). 

11 Sorting criteria are kept for the result of a search.
12 Drop-down list to select a record field’s contents as sorting criteria when a catalog is newly 

opened (aka, “initial sorting”). Additionally, select whether the sorting is performed in 
ascending (A-Z, 0-9) or descending (Z-A, 9-0) order.

NOTE: In the drop-down list, the fields are presented with their names and field types, which 
helps to select the proper field if there are fields with identical names, but different field type. 
For the rare but possible case that fields with identical names also have the same field type, 
just open the drop-down list with the CTRL key pressed. Then the fields GUIDs are displayed, 
too, in addition to name and field type, allowing for an unambiguous identification of the 
fields.
The GUID of the currently selected field is also revealed by a tool tip.
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• Categories

Category Search 
Also Finds
These options affect 
the way the Cumulus 
application finds 
categories using the 
Category Quick-
search. 
1If activated, cate-
gory nested into the 
found categories are 
also found and dis-
played.

Quicksearch Fields
2Activates the 
default setting for 

Quicksearch: a “contains” search in the category field Category Name, 
3 Only with catalogs containing multi language record fields: If activated, the Quicksearch is 

extended to all language specific fields of the default field selection. 
4 Enables an individual setting for category Quicksearch. If this option is activated, category 

Quicksearch will search the fields displayed in the list. Click Add to get a list of all available 
category fields of the type String, String List and Integer. A “contains” search is performed for 
all included String and String List fields and an “is” search for all included Integer fields. Make 
sure the fields are correctly indexed for searching in the Catalog Settings of the catalogs 
where you want to use category Quicksearch.

3
4
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2
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Printing Tab

1If a Record View Set defines the layout for printing 
(and not the Advanced Print Settings), the records’ 
thumbnails will be printed in high-resolution so 
the printouts can serve as contact sheets.

Asset Handling Tab

1You can preset one 
Asset Handling Set 
used for cataloging in 
all catalogs and one 
Asset Handling Set for 
the asset access done 
in all catalogs. 
Depending on your 
Cumulus configura-
tion, you can also 
select a Permissions 
Template for catalog-
ing. This template will 
then be applied to the 
cataloged asset. If you 
activate the Show dia-
log option, you can 
select an Asset Han-

dling Set and Permissions Template when cataloging assets.
OR

1

1

2
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2 You can assign different Asset Handling Sets to different catalogs (even different ones for cat-
aloging and asset access). 

NOTE: The Asset Handling Set selected for asset access also determines the asset processors 
offered when converting an asset. 
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Record View Sets
With Record View Sets, you can easily control which metadata fields are displayed, and 
how. This chapter explains how to customize existing Record View Sets and how to 
create and edit new ones. For a basic description of (Record) View Sets and their pur-
poses, see: View Sets.

Each Record View Set comprises different view modes for different purposes, or use 
cases. such as Thumbnail View, Report View, Details View, Info View, and Information 
window, among others. The settings for each view mode can be customized individ-
ually.

Record View Sets were designed to control the representation of information at the 
Cumulus Desktop Client. However, Record View Sets are used with other Cumulus cli-
ents, too, such as the Cumulus Web Client, Portals, and InDesign Client. For these cli-
ents, only certain view modes are taken into account (see below).

NOTE: Canto strongly recommends to create at least one dedicated Record 
View Set for each client in use!

A View Set can be restricted for your personal use, or can be shared with other users. 
Shared View Sets are displayed in italics in the list of available View Sets.

Customization Options for Record View Sets

For Thumbnail, Details and Information view as well as for Asset Information window 
and Palette Mode you can decide which record fields are displayed, their order and 
how they are displayed: font type, style, size, and color. You can also choose a back-
ground color for most of the views. For the Asset Information window, the Information 
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view and the Fullscreen Preview you can create dynamic views. You can define 
whether fields are displayed or not displayed depending on the type of the selected 
asset.

IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the 
Client runs on. Changing these settings in a Record View Set on a Windows Cli-
ent will not take effect with Clients on OS X/macOS, and vice versa. To custom-
ize Record View Sets to have the same look and feel both on Windows and 
OS X/macOS, you have to perform appropriate changes twice, on a Mac Client 
as well as on a Windows Client.

For some views you can even choose to use the color of a Label field as background 
color. For many views you can select the spacing around it and whether the record is 
displayed within a frame. For certain views you can also define that the field names are 
displayed along with the field values. 

For Preview view and Preview window you can choose a background color. For Pre-
view window you can choose whether and how the values (and names) of record 
fields should be displayed. 

For each View Set you can define the view that is to be displayed when the View Set 
is selected. As soon as you have selected a View Set from the drop-down list, the view 
will switch. This action is not activated by default. To activate this feature for a View Set, 
you have to activate this option in the Set Properties section and then select the 
desired starting view. 

Whether all views will change when changing the Record View Set or only the current 
one is determined by each user individually in her/his User Settings. (For details, see 
“Display Tab” .)
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NOTE: Record View Sets and Multilingual Working Environment
For users working in a multilingual working environment certain View Settings 
offer an Allow language switch for multilingual fields option. This option 
enables users to switch the language in which multilingual metadata fields are 
displayed. If this option is not activated, multilingual fields are always displayed 
in the language of the field that was added to the view.

Using Record View Sets for various Cumulus Clients

When Record View Sets are used with other Cumulus clients, such as the Cumulus 
Web Client, Portals, and InDesign Client, only the settings of certain view modes rele-
vant. Which clients makes use of which view modes is depicted in the following table.

Views modes 
in Record View Sets

Web Client
Settings used for:

Portals
Settings used for:

InDesign Client
Settings used for:

Thumbnail View Thumbnail view of 
• Overview pages
• Search Result
• Collection
• Basket

• Overview pages
• Search result pages
• Basket overlay

• Records panel 
(Thumbnail view)

Report View List view of 
• Overview pages
• Search Result
• Collection
• Basket

(Not used) • Records panel 
(Report view)
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In addition, some settings don’t take effect if a Record View Set is used with a client 
other than the Desktop Client. For example, field properties such as the number of 
lines, or layout settings (colors, fonts, etc.), are generally ignored. 

Some client-specific features must be considered, too:

• Web Client:
• Certain fields are always displayed in the Web Client, regardless of the settings 

in the view set (e.g. thumbnail, record name, file format type, modification 
date,...)

Details View Details View of
• Overview pages
• Search Result
• Collection
• Basket

(Not used) (Not used)

Info View (Not used) • Quick preview overlay (Not used)

Asset Info Window • Information tab of a 
file’s details page

• Edit view

• Details page • Information panel

Palette Mode (Not used) (Not used) (Not used)

Preview View (Not used) (Not used) (Not used)

Preview Window (Not used) (Not used) (Not used)

Calendar Pane (Not used) (Not used) (Not used)

Views modes 
in Record View Sets

Web Client
Settings used for:

Portals
Settings used for:

InDesign Client
Settings used for:
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• Portals:
• Certain fields are always displayed in Portals, regardless of the settings in the 

view set (e. g. preview, record name,...).
• Empty fields (fields without a value) are never displayed in Portals.
• Field names of metadata fields are displayed on overview pages, search result 

pages and the basket overlay, if Show field names is activated in the settings for 
the Thumbnail View. (Properties settings for field names, however, are always 
ignored.)
If this option is not activated, a tool tip with both field name and value is dis-
played when the mouse pointer hovers over a field. 

• Field names are always displayed on the details page, and never on the quick 
preview, because this is the default setting for the respective view modes which 
can’t be changed. On the quick preview, a tool tip with both field name and 
value is displayed when the mouse pointer hovers over a field.

• Separators defined in a Record View Set are ignored.
• InDesign Client:

• The InDesign Client respects font color settings for fields. Different colors can be 
used e.g. to highlight certain items. 

NOTE: In order to always ensure best readability, the configured font colors 
adapt to InDesign’s UI color theme changes.

Further information

For detailed information on the usage of Record View Sets with:

• Web Client, see: Select a Record View Set and a Category View Set to be used.
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• Portals, see: Layout Tab.
• InDesign Client, see: Cumulus InDesign Client Panels.
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Creating and Editing Record View Sets
You can either change existing View Sets or create new ones – if you have the appro-
priate permissions for changing or creating View Sets. You may have the permissions 
to define and customize your individual sets only or may even have the permissions 
to edit all sets. 

NOTE: When renaming a shared set, remember to update users’ permissions 
for this set. 

Record View Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Record View Set.)

PRECONDITIONS: To view and modify Record View Sets, you must have the appropri-
ate permissions (Server Permissions > Record View Set Permissions.) 

To change an existing set:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the View Set you want to edit.

4. Click the icon for the view you want to change.

5. Make the changes. For details see

• “Adding a Field to a Record View” 
• “Changing the Properties of a Displayed Field” 
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6. Click Apply to save your changes.

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Record View Sets by selecting the Customize entry in the list for selecting 
Record View Sets (e.g. in the Collection window or the Asset Information win-
dow). This entry opens the preferences for the current Record View Set.

A new View Set is created by duplicating an existing one and adapting its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the set to use as a basis for the new one.

4. Click Duplicate.

The Name and Settings dialog opens.

5. Enter a name for the new View Set, and optionally

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new View Sets).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new View 
Sets).

6. Activate the Allow Sharing option to make this View Set a shared set that is avail-
able to other users.
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7. Click OK.

8. Define the new View Set. (For details see “Adding a Field to a Record View” , and 
“Changing the Properties of a Displayed Field” .)

9. Click Apply to save your changes.
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Setting A Default Record View Set
You can define one View Set to be the default View Set for the Desktop Client. This 
default View Set will be used in case no other set is available or the selected set is not 
accessible. For example, a set that is stored with a collection was deleted after the col-
lection had been saved. The default View Set is denoted by bold characters in the list 
for selecting a View Set.

To set the default View Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the View Set you want to be the default one. This should be a 
shared set (denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.

NOTE: Defining a default View Set for the Desktop Client has no impact on 
other Cumulus clients (e.g. Web Client or Portals)!
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Adding a Field to a Record View
To add a field to one of the views:

1. Select Cumulus / Edit > Preferences.

2. Click Record View Sets.

3. Under Set, select the View Set you want to edit.

4. Click the icon of the view to which you want to add a field.

A list of fields that are shown in the selected view is displayed.

5. Optionally: select the entry of the field after which you want to place the new 
field. If no entry is selected, new fields will be added at the bottom of the list. (A 
field’s position can be adjusted anytime with the buttons on the right side.)

6. Click Add.

The Add Fields to View window appears, providing two tabs:

• The Fields tab, displaying a list of all fields contained in the catalogs of the active 
collection that are not yet included in the view. 

• The Modules tab, displaying the nodes: Catalogs, Modules and Languages.
– The Catalogs node expands to a list of all catalogs open in the active collec-
tion. Clicking the plus sign in front of a catalog’s name displays all fields con-
tained in that catalog, but not yet included in the view. Either select the name of 
a catalog to add all contained fields, or select the individual fields you want to 
add.

– The Modules node expands to a list of all Cumulus modules that provide fields. 
Clicking the plus sign in front of a module’s name displays the fields supported 
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by the respective module but not yet included in the view. Either select the name 
of a module to add all fields supported by that module, or select the individual 
fields you want to add.

– The Languages node expands to a list of all languages configured for string 
field values. Clicking the plus sign in front of a language name displays the fields 
that support values in the respective language, but are not yet included in the 
view. Either select the name of a language’s to add all respective fields, or select 
the individual language-specific fields you want to add.

Additionally, all language independent fields that are not yet included in the view 
are listed and can be added.

7. Select the field(s) you want to add.

8. Click OK to add the field(s) to the list of shown fields. 

9. Click OK or Apply. Your changes take immediate effect.

TIP: Copying/Replacing The Fields From Another View

You can copy the fields included in one view to another view of the same 
Record View Set or you can replace all fields. Select the icon for the view you 
want to have the same fields as another view and use the alternate (right) 
mouse button to open a context menu. Select first the desired function and the 
view from which you want to copy the fields.
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Adding a Separator to a View
The Asset Info window and the Category Info window as well as Info view support sep-
arator elements that allow to group fields. Separators can make it clear to users which 
metadata fields belong together. Users can close a separator to hide its fields and 
make metadata editing much easier on views that contain many fields. You can add 
as many separators as you need. 

You can add and remove a separator just as any other field.

To add a separator to an Info window or Info view:

1. Select Cumulus / Edit > Preferences.

2. Click Record View Sets or Category View Sets.

3. Under Set, select the View Set you want to edit.

4. Click the icon for the view to which you want to add the separator.

A list of fields shown in the selected view is displayed.

5. Select the entry for the field after which you want to place the separator.

6. Click Add Separator. A dialog for entering a name for the separator is opened.

7. Enter a name and click OK.

The separator is added to the view. 

To change the properties of a separator:

1. Select Cumulus / Edit > Preferences. 
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2. Click Record View Sets or Category View Sets.

3. Under Set, select the View Set you want to edit.

4. Click the icon for the view you want to edit.

5. Select the entry for the separator whose properties you want to change.

6. Click Properties.

This opens a dialog for defining the font attributes and changing the name of the 
separator.

7. Make your selections.

8. Click OK to assign the selected properties to the separator. 

9. Click Apply. The separator will be displayed according to your settings. 

NOTE: Activating the Dynamic Field Visibility option for a separator affects all 
fields below that separator: if the separator is not displayed, none of the respec-
tive fields will be displayed regardless of their individual settings. But then, if the 
separator is displayed, the settings for individual fields are taken into account.
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Changing the Properties of a Displayed Field
The properties of a displayed field define the font (type, style, size, and color) used to 
display the field contents. 

IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the 
Client runs on. Changing these settings in a Record View Set on a Windows Cli-
ent will not take effect with Clients on OS X, and vice versa. To customize 
Record View Sets to have the same look and feel both on Windows and OS X, 
you have to perform appropriate changes twice, on a Mac Client as well as on 
a Windows Client.

To change the display properties of a field: 

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the View Set you want to edit.

4. Click the icon for the view you want to edit.

5. Select the entry for the field whose properties you want to change.

6. Click Properties.

This opens a dialog for defining the font attributes and – depending on the field 
type – additional properties.
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7. Make your selections. The options differ depending on the field type. (See “Addi-
tional Display Properties for Different Field Types”, for more information on addi-
tional properties.)

8. Click OK to assign the selected properties to the field. 

9. Click Apply. The field is displayed according to your settings. 
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Additional Display Properties for Different Field Types
In addition to choosing the font, the Properties dialog offers different options depend-
ing on the field type:

• String Fields – With Info View or Info Window only
You can define the number of lines to display the contents of the field. For String 
List fields you can define the number of lines as well as display options. For String 
List fields that do not allow multi-select, you can decide to have the values dis-
played as drop-down list or radio buttons. 

NOTE: String Fields – Scroll Bar Display for Info View/Window on Mac OS!
To have a scroll bar available for a String field in Info View or Info Window, you 
need to give it at least 5 lines. 

• Picture Fields – With Info Window, Thumbnail, Report and Info View
Icons can be displayed to quickly inform about embedded metadata (e.g. EXIF, 
IPTC and XMP data as well as included color profiles, multi-page assets or the avail-
ability of versions). 

NOTE: 
To display icons for embedded metadata, a catalog must contain the Embedded 
Metadata Standards field. If you add this field to an existing catalog, make sure to 
subsequently update all records of the respective catalog in order to have the 
new field taken into account. 
To do so, select Metadata > Update Record > Advanced. Activate the Update 
even if assets are unchanged option and restrict the update to the Embedded 
Metadata Standards field, then click OK.

The following icons can be displayed:
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 EXIF data available
 XMP data available
 IPTC data available
 ICC data available
Multipage asset (only if catalog includes the Number of Pages field and its 

value is > 1.)
Versioned asset 
 Photoshop resource available

• Categories Field – With Info Window and Info View only
The language of Category tabs in the Asset Info window and in the Info view can 
be set via the Properties dialog of the Categories field. The set language governs 
the names of the Category tabs as well as the names of the categories displayed 
in the tabs. To specify a preferred language for the names activate Preferred lan-
guage and select the desired language from the list. To automatically have dis-
played the language chosen in the View menu select As defined in View Menu. 

• Vocabulary Fields 
Additional information on a vocabulary terms can be displayed.
Vocabulary fields only accept predefined values (terms) as input, which are sup-
plied by a special $Vocabularies catalog. The categories of this catalog serve as the 
vocabulary terms. Additional information about a term can be stored in the meta-
data of the respective category and can be displayed in the Add Vocabulary Term 
dialog (see Adding Terms to a Vocabulary Field), or as tool tip when hovering over 
a vocabulary term in Cumulus Portals, Cumulus Web Client and Desktop Client. 
Which additional information is displayed depends on the Category View Set for 
details (see Preparing a Cumulus Catalog for Working with Controlled Vocabular-
ies). Tool tips are only available for the contents of metadata field of type String, 
Date only, and Picture. 
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Dynamically Displaying Fields 
With the Dynamic Field Visibility option, Record View Sets and Category View Sets 
can be configured to display or not to display fields depending either on the file for-
mat type of the selected asset, or the Container Type of the selected category, or 
depending on the result of a saved query. (For more information on queries, see 
Searching with the Find Window.)

For example, you may want to see the duration information for audio or video assets, 
whereas this information doesn’t make sense for picture assets. Instead of having dif-
ferent View Sets for different types of assets, you can define just one View Set which 
adapts to the currently selected asset.

The Dynamic Field Visibility option works with the following view modes only:

• the Asset Information window and the Category Information window,
• the Information view
• the information displayed with the Fullscreen Preview 

To have record fields or category fields displayed dynamically: 

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets, or Category View Sets.

3. Under Set, select the View Set you want to configure.

4. Click the icon for either the Info View, or the Asset Info window, or the Preview 
Window.

5. Select the field whose properties you want to change.

6. Click Properties.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS RECORD VIEW SETS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

The Properties window is displayed. 

7. In the Dynamic Field Visibility section, 

activate the Only when the file format type is one of the following option, then 
select the file format type(s) or the container type(s) for which the field shall be 
displayed.
OR
activate the Only when matching the query option, then select a saved query. 

NOTE: Make sure to select a query that does not contain placeholders!

8. Click OK to assign the setting to the field. The Properties window is closed.

9. Click Apply. The field is displayed according to your settings. 

NOTE: Dynamic Field Visibility for Separators
Dynamic Field visibility works with separators, too. If a separator is not displayed 
due to the configured criteria, none of the fields below that separator will be 
displayed regardless of their individual settings. But then, if the separator is dis-
played, the settings for individual fields are taken into account.
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Category View Sets
A Category View Set defines the display options for the Category Information window 
and the Category pane display. For each tab you can define different display options. 
You need the appropriate permissions for changing the Category View Sets.

Category View Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Category View Set.)

PRECONDITIONS: To view and modify Category View Sets, you must have the appro-
priate permissions (Server Permissions > Category View Set Permissions.) 

To change a Category View Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the View Set you want to edit.

4. Make the changes. 

For details on changes for the Category Info window see: 

• “Adding a Field to the Category Info Window” 
• “Changing the Properties of a Displayed Field” 
For details on changes for the Category pane see: 

• “Changing the Category Pane Display” 
5. Click Apply to save your changes.
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Category Info Window
You can add fields to the display and change the properties of a displayed field. In any 
Category View Set, the Category Information window can be configured to display or 
not to display fields depending on the container type of the selected category.
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Adding a Field to the Category Info Window
To add a field to a Category Information window:

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets

3. Under Set, select the View Set you want to edit.

4. Click Category Info Window.

On the General tab, a list of fields that are shown in the Category Info window is 
displayed.

5. Optionally: select the entry of the field after which you want to place the new 
field. If no entry is selected, new fields will be added at the bottom of the list. (A 
field’s position can be adjusted anytime with the buttons on the right side.)

6. Click Add. 

The Add Fields to View window appears, providing two tabs:

• The Fields tab, displaying a list of all category fields contained in the catalogs of 
the active collection that are not yet included in the Category Info window. 

• The Modules tab, displaying the nodes Catalogs, Modules and Languages.
– The Catalogs node expands to a list of all catalogs open in the active collec-
tion. Clicking the plus sign in front of a catalog’s name displays all fields con-
tained in that catalog, but not yet included in the Category Info window. Either 
select the name of a catalog to add all fields contained in that catalog, or select 
the individual fields you want to add.
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– The Modules node expands to a list of all Cumulus modules that provide fields. 
Clicking the plus sign in front of a module’s name displays the fields supported 
by the respective module but not yet included in the Category Info window. 
Either select the name of a module to add all fields supported by the module, or 
select the individual fields you want to add.

– The Languages node expands to a list of all languages configured for string 
field values. Clicking the plus sign in front of a language name displays the fields 
that support values in the respective language, but are not yet included in the 
Category Info window. Either select the name of a language’s to add all respec-
tive fields, or select the individual language-specific fields you want to add.

Additionally, all language independent fields that are not yet included in the view 
are listed and can be added.

7. Select the field(s) you want to add.

8. Click OK to add the field(s) to the list of shown fields. The Add Fields to View win-
dow is closed.

9. Click OK or Apply. Your changes take immediate effect.
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Changing the Properties of a Displayed Field
The properties of a displayed field define the font (type, style, size, and color) used to 
display the field contents, as well as its visibility depending on the container type of 
the respective category.

IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the 
Client runs on. Changing these settings in a Record View Set on a Windows Cli-
ent will not take effect with Clients on OS X, and vice versa. To customize 
Record View Sets to have the same look and feel both on Windows and OS X, 
you have to perform appropriate changes twice, on a Mac Client as well as on 
a Windows Client.

To change the display properties of a field: 

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the View Set you want to edit.

4. Click Category Info Window.

5. On the General tab, select the entry for the field whose properties you want to 
change.

6. Click Properties.

This opens a dialog for defining the font attributes and – depending on the field 
type – additional properties.
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7. Make your selections.

8. Click OK to assign the selected properties to the field. The Properties window is 
closed.

9. Click Apply. The field is displayed according to your settings. 

NOTE: Category View Sets and Multilingual Working Environment
For users working in a multilingual working environment View Settings offer an 
Allow language switch for multilingual fields option. This option enables 
users to switch the language in which multilingual metadata fields are dis-
played. If this option is not activated, multilingual fields are always displayed in 
the language of the field that was added to the view.
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Changing the Category Pane Display
To set up the display of the Category Tree to your needs you can select a background 
color and define the font type, size and color.

To change the display: 

1. SeSelect Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the View Set you want to edit.

4. Click Category Pane.

5. Make your selections:

• To change the background color, click the  button next to the Background 
Color field.

• To change the font, click the  button next to the Font field. – Changing the 
font color also affects the color of the square and triangle symbols in the cate-
gory tree.

NOTE: Font Settings are Operating-System Specific! 
Cumulus uses different font settings depending on the operating system the 
Client runs on. Changing these settings in a Category View Set on a Windows 
Client will not take effect with Clients on OS X, and vice versa. To customize Cat-
egory View Sets to have the same look and feel both on Windows and OS X, 
you have to perform appropriate changes twice, on a Mac Client as well as on a 
Windows Client. 
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• To change the default display of the Category pane, you can enable/disable var-
ious display options. You can activate the option to display the number of 
records assigned to the category right next to the category name. You can 
decide which master categories are to be displayed in the drop-down list and 
which master category will be displayed when the View Set is selected. 

NOTE: These are only general options for the display of categories. Which cate-
gories are actually displayed depends also on the user permissions set in the 
User Manager and Live Filtering settings. 

For details on options only important if working in a multilingual environment 
see “Category Pane and Multilingual Working Environment” 

6. Click Apply. The Category pane is displayed according to your settings. 
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Category Pane and Multilingual Working Environment
For users working in a multilingual working environment the settings for the Category 
pane offer following options:

• To allow sorting of categories according to the rules of a specific language and 
to enable the display of a manually re-ordered category tree, activate Enable/
View language specific category sorting and custom ordering. 

NOTE: Language-specific sorting is performed either according to the rules of 
the application language or according to the rules of the selected preferred 
language, if a preferred language is specified. 

• To specify a preferred language for the display of categories, activate Preferred 
language and select the desired language from the list. To automatically have 
displayed the language chosen in the View menu select As defined in View 
Menu.

• If for any reason the name of a category is not available in the preferred lan-
guage, it is displayed in the base language. To have additionally displayed the 
name of the used base language, activate the If not available ... option.
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Asset Handling Sets
An Asset Handling Set affects how Cumulus deals with your assets – during the cata-
loging process and when accessing assets. The options of a set are not specific to any 
one catalog. 

In the Asset Handling Sets section of the Cumulus Preferences you can define different 
Asset Handling Sets. When a certain set is used depends on the individual user set-
tings defined by the user. 

In the User settings of the Cumulus Preferences, each user can define one Asset Han-
dling Set for the cataloging done in all catalogs and one Asset Handling Set for the 
asset access done in all catalogs. Each user can also assign different Asset Handling 
Sets to different catalogs (even different ones for cataloging and asset access). And 
each user can define to be asked for an Asset Handling Set when cataloging assets. 
(See “Overview: Asset Handling Sets” for details.) You can either change existing sets 
or create new ones – if you have the appropriate permissions for changing or creating 
Asset Handling Sets. There are Asset Handling Sets for individual use and Asset Han-
dling Sets that are shared with other users. Shared sets are displayed in italics. You may 
have the permission to define and customize your individual sets only or may even 
have the permissions to edit all sets. 

NOTE: When renaming a shared set remember to update users’ permissions for 
this set. 

Asset Handling Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Asset Handling Set.)

PRECONDITIONS: To view and modify Asset Handling Sets, you must have the appro-
priate permissions (Server Permissions > Asset Handling Set Permissions.) 
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Editing An Asset Handling Set
To change an existing Asset Handling Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.

See “Overview: Asset Handling Sets”, for an overview of the options available for Asset 
Handling Sets. Asset Handling Sets can only be defined by the Cumulus Administrator 
or users who have the right to do this.

Of all the various settings available within an Asset Handling Set, those concerning 
Asset Storage modules are described in detail in the section “Asset Handling Modules” 
. Asset Formats are described in the section “Asset Format Support” .
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Creating An Asset Handling Set
A new Asset Handling Set is created by duplicating an existing one and adapting its 
settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set to use as a basis for the new one.

4. Click Duplicate.

The Name and Settings dialog opens.

5. Enter a name for the new set, and optionally

• Activate the Allow Sharing option, if you want this set to be available to other 
users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new sets).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new sets).

6. Click OK.

7. Define the new set. (See “Overview: Asset Handling Sets”, for an overview of the 
options available.)

8. Click Apply to save your changes.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS ASSET HANDLING SETS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Setting A Default Asset Handling Set
You can define one Asset Handling Set to be the default set. This default set will be 
used:

• when the Cumulus Server uses an Asset Handling Set, e.g. for Server/Client Asset 
Transfer.

• when the set defined in the User Settings is not available.
• when records are imported.
The default set is denoted by bold characters in the list for selecting a set. 

To determine the default set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want as default. This should be a shared set 
(denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.
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Overview: Asset Handling Sets 
Asset Handling Sets control the way the records of newly cataloged assets are created 
and how cataloged asset are accessed. The Asset Handling Sets defined here can be 
selected in the User Settings dialog or within dialogs when cataloging or accessing 
assets.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS ASSET HANDLING SETS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Thumbnails Tab 

Create Thumbnails from
1 Some programs can save images with embedded thumbnails. This option uses those thumb-

nails, if available, instead of creating new ones. Stored thumbnails may differ in size.

1
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2 Uses embedded thumbnails, if available and large enough (the minimum is the size defined 
in the section below, see # 4).

3 Creates thumbnail images of the entire asset’s content. These thumbnails are of best quality, 
but this option slows the cataloging process. If a thumbnail cannot be created, the stored 
thumbnail is used. 

Thumbnail Size
4 Selects default thumbnail size for all newly cataloged assets. Current records’ thumbnails 

can be adjusted to the new size by updating the record. (See “Update Record”.)

Optimize Thumbnail
5 Equalizes the thumbnail images for newly cataloged assets automatically. This can also be 

done afterwards. (See “Optimize Thumbnail”.)

Quality
6 Sets thumbnail quality for the different color modes: Line art (NORMAL=2 color / HIGH=4 

color), grayscale (NORMAL=8-bit grayscale, more compression / HIGH=8-bit grayscale, less 
compression), Color (NORMAL=24-bit color, more compression / HIGH=24-bit color, less 
compression.) 

NOTE: High-quality thumbnails make records larger.

Thumbnail Preview
7 Displays the thumbnail quality and the disk space required for each thumbnail (in bytes) 

according to the selected options.

• Thumbnail Size and Quality 

The thumbnail size and quality that you select when setting up an Asset Handling Set 
influences the size of a typical record and thus Cumulus’ overall performance. Since 
Cumulus uses JPEG compression for grayscale and color thumbnails, the size of indi-
vidual records varies depending on the thumbnail content. Higher quality thumbnails 
typically create larger records.
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For example, a catalog containing 4,000 records and normal thumbnail quality (i.e., 
128 x 128 pixels) yields a catalog that is approximately 50 MB in size. The same catalog 
with high thumbnail quality (i.e., 192 x 192 pixels) is 70 MB in size.

To find out how much space thumbnails take up in a catalog, first select the thumbnail 
size and thumbnail quality. As you make your selections, the disk space required for 
each thumbnail (in bytes) is displayed in the Thumbnail Preview area.

Cataloging Tab 
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When Cataloging
1 Cumulus adds new records but doesn’t update existing records whose assets have changed.
2 Cumulus adds new records and updates those records whose assets have changed.

NOTE: For updating existing records the cataloging user must have the Update Records per-
mission.

3 Cumulus updates existing records only. No new records are added.

Add only – Asset Duplicates Handling
4 When cataloging, if Cumulus finds an asset that has already been cataloged, a duplicate 

record is created for the asset.

NOTE: This is possible only when Add Only is selected, otherwise Cumulus thinks you’re try-
ing to update the existing record.) 

5 When cataloging, if Cumulus finds an asset that has already been cataloged, it does not cre-
ate a duplicate record.

Operating System Shortcuts/Aliases/Links
6 Cumulus resolves any links/shortcuts/aliases found in the selected assets being cataloged. 

This enables Cumulus to catalog the asset that the shortcut/alias points to.
7 Links/shortcuts/aliases are not resolved and assets they represent are not cataloged.

AXR Options
8 Optional: When cataloging an asset that contains references, the referenced assets will be 

cataloged automatically with the same cataloging process. 

Central Asset Location
9 Copies all newly cataloged assets to a central location specified in the Catalog Settings and 

makes the newly created record reference the copied asset. If you enable the Delete Original 
Asset option, the asset will be deleted at its original location after it was copied to the central 
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location. Can be overridden by the Catalog Settings. (See “Overview: Catalog Settings Win-
dow”.)

10 This is the “off” position for #9. Assets are cataloged normally and not copied to a central 
location.

11 The original asset will be deleted after the asset was cataloged and successfully copied.
12 Cumulus also copies assets that are contained in a cataloged asset to the Central Asset Loca-

tion – as discrete assets. Requires an activated corresponding AssetStore that can detect this 
relation and extract sub-assets that can be saved as discrete assets. (Appropriate AssetStores 
are available e.g for ZIP and TAR files as well as for PDF, PowerPoint,, and Quark XPress doc-
uments.) Canto recommends to activate this option only in conjunction with a Web Client/
Portals/Sites installation where the machine running the Web application does not support 
the corresponding applications, e.g. PowerPoint.

Adding Metadata 
13 Metadata Editor View Set: Specifies the View Set that is used by the Metadata Editor. The 

fields included in the Information window view of this set define what can be edited with the 
Metadata Editor.

14 Use Metadata Template: If activated, the specified Metadata Template is used to add 
metadata to the records of newly cataloged assets. Make sure the permissions for the 
assigned Metadata Template correspond to those for the Asset Handling Set.

15 Show Metadata Editor for new records: If activated, the Metadata Editor is displayed 
whenever new assets are cataloged, thus allowing to add metadata information to records 
during the cataloging process. 
With the Web Client, the Add information window is displayed to serve this purpose.

16 Show Metadata Editor for updated records: If activated, the Metadata Editor is displayed 
whenever records are updated, thus allowing to add or modify metadata information during 
the update process.
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Asset Access Tab 

Writing back Metadata 
1 Record-field content is never written back.
2 Record-field content is written back to assets if possible.
3 If activated, the asset modification date will be updated when record-field content is written 

back to an asset.
4 If activated, record-field content is written back to external metadata container only, e.g 

sidecar files, without modifying the assets.
5 If activated, dialogs are suppressed that may appear while resolving the connection to an 

asset for writing back metadata.

Accessing Versions
If you employ a licensed and activated version control system with your Cumulus installation 
(e.g. Cumulus Vault), Cumulus lets you determine how to deal with versions of an asset. The 
option selected under When Getting Assets affects the Preview, Mail To, Copy To and Print 
With commands in the Cumulus Asset menu.
6 Cumulus always uses the latest version of the asset when you preview, mail, copy or print it. 
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7 Cumulus prompts you to choose the desired version when you preview, mail, copy or print it. 

Asset Formats Tab 

The list in this tab displays all formats configured for the selected Asset Handling Set. Formats, 
that are supported by filters that are not installed on the machine you are working with, are dis-
played in italics. You can click on each column heading to re-sort the list by that field. A green 
marker indicates formats that are active. Deactivated formats are indicated by red markers. Acti-
vate and deactivate formats for the selected Asset Handling Set using the button #6.
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1 Automatically adds formats supported by newly installed filters to the list and activates 
them.

2 All formats will be cataloged. For unknown formats (not listed), the Cumulus Generic Filter 
will be used. If this option is not activated, only those formats which are listed and activated 
in the list will be cataloged.

3 Opens the properties window for the format. (Only available if the filter provides any proper-
ties.)

4 Opens a dialog displaying available formats that are not included in the list.
5 Removes a format from the list. You can add it again using the Add button, but then it is 

appended to the list. 
6 Activates/deactivates the selected format for the selected Asset Handling Set.
7 Opens a menu for selecting the columns to be displayed on this tab.
8 These buttons change the selected entry’s position in the list. 

When cataloging assets Cumulus uses the filters in the order of the entry numbers of formats 
they support. This is important if you have multiple filters for the same file type. Starting from 
the top: move to top of list, move before current position, move behind current position, and 
move to end of list. (Disabled if no filter is selected.)

Modules Tab 

The Modules tab includes multiple icons that provide access to the different modules. Asset Stor-
age, Asset Processor and Metadata modules can be activated for the selected Asset Handling 
Set. 
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• Asset Storage

For details on the Asset Storage modules, see “Asset Storage Modules” .
1 Displays a window that shows the version of the module. 
2 Opens the properties window for the format. (Only available if the module provides any 

properties.)
3 Activates/deactivates the selected module for the selected Asset Handling Set.
Active modules are indicated by a green marker. Modules that have been deactivated have a red 
marker.

1 2 3
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Modules that are indicated by italics are currently not supported (not installed on the machine 
you are working on.)

• Asset Processor

For details on the Asset Processor modules, see “Asset Processor Modules” .
1 Displays a window that shows the version of the module. 
2 Opens the properties window for the format. (Only available if the module provides any 

properties.)
3 Activates/deactivates the selected module for the selected Asset Handling Set.
Active modules are indicated by a green marker. Modules that have been deactivated have a red 
marker.
Modules that are indicated by italics are currently not supported (not installed on the machine 
you are working on.)

• Metadata

For details on the Metadata modules, see “Metadata Modules” .
1 Displays a window that shows the version of the module. 
2 Opens the properties window for the format. (Only available if the module provides any 

properties.)
3 Activates/deactivates the selected module for the selected Asset Handling Set.
Active modules are indicated by a green marker. Modules that have been deactivated have a red 
marker.
Modules that are indicated by italics are currently not supported (not installed on the machine 
you are working on.)

• Filter

Under Filter you can see the Filter Modules that are available on the machine you are working 
on. 
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Modules that are indicated by italics are currently not supported (not installed on the machine 
you are working on.)
1 Displays a window that shows the version of the module. 
2 Opens the properties window for the format. (Only if available.)

1 2
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Workflows Tab 

The Workflows tab provides a list of workflows to which new assets are assigned during the cat-
aloging process. 

NOTE: Because Asset Handling Sets are not catalog-specific, this list can con-
tain workflows which are not available in a given catalog. A workflow can only 
be attached to new assets if it is contained in the catalog to which the assets 
are added. For details on how to add a workflow to a catalog, see Catalog Set-
tings/Workflows Tab,  p. 796.

1 Opens a dialog for selecting a workflow. You can select any workflow that is defined in the 
Workflow Manager tab of the Web Server Console and add it to the Asset Handling Set. How-
ever, a workflow only takes effect in an Asset Handling Set if the respective workflow is also 

1 2
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available in the catalog to which new assets are added. You can check the available work-
flows on the Workflows tab of the Catalog Settings.

2 Removes the selected workflow from the Asset Handling Set.
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Asset Handling Modules
When cataloging and accessing assets, Cumulus uses different modules: Asset Stor-
age, Asset Processor, Metadata and Filter modules. 

• Asset Storage modules manage the asset’s storage (the access to its location), 
whereas a Filter module analyzes the asset’s contents. For example, if you catalog 
a file from the file system of your computer, the Asset Storage module manages 
the access to the file system of your computer, and the employed filter reads the 
file’s content.

• Asset Processor and Metadata modules are special modules for special tasks, e.g. 
to handle DCS (Desktop Color Separation) files and OPI (Open Prepress Interface).

• Cumulus Filters extract file-type specific metadata from assets. This information 
can include color mode, resolution, file type, font names, etc., depending on the 
type of asset. 
Users who are allowed to define Asset Handling Sets can create their own Filter for-
mat options for specific file types (see “Extending Generic Filter Options” ), and 
Canto is always updating existing Filters and creating new ones. 

Cumulus makes it possible for you to determine precisely what sort of information 
should be kept on the assets. This can be defined differently for each catalog as each 
catalog has its own properties. It is the catalog properties that determine what infor-
mation is stored on the assets in the record fields. (For further information, see “Cata-
log Settings” .) Linking metadata fields to record fields “feeds” the record with asset 
metadata during cataloging. The link can work in both directions—if supported by the 
corresponding Filter or Asset Storage Module—meaning that you can also write mod-
ified record field contents back to asset fields. To find out how, see “Administering 
Field Linking” . By default, all Cumulus-supported record fields are linked to the match-
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ing asset fields. This also applies to fields that are included with Cumulus but not acti-
vated by default in every catalog. When you set up a catalog for your workgroup, you 
can define how these asset fields (from both Asset Storage modules and Filters) 
should be linked to the catalog’s record fields. You can also define how to link the cus-
tom fields you define to asset metadata. 

If you want to learn more about Cumulus’ various modules, what they do and how 
they are configured to customize Cumulus to your specific workflow, then please con-
tinue reading the following sections that describe these modules.
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(De)activating Asset Handling Modules
Depending on your workflow requirements, you may not need to use some of these 
Asset Handling modules. If, for example, you are not using services from a prepress ser-
vice provider and do not have access to an OPI server, you should deactivate the OPI 
System Support. Deactivating modules which are not needed for your specific work-
flow enhances productivity by freeing up Cumulus’ resources and speeding up the 
cataloging process. To meet individual workflow requirements Asset Storage, Asset 
Processor and Metadata modules can be activated and deactivated for each Asset 
Handling Set individually. Note that you need the appropriate permissions to change 
Asset Handling Sets. 

To activate or deactivate an Asset Handling module for an Asset Handling Set:

1. Launch your Cumulus application and open any one catalog.

2. Select Cumulus / Edit > Preferences. 

3. Click Asset Handling Sets.

4. Under Set, select the set you want to edit.

5. Click Modules and select the icon for the module type.

6. Select the desired module and click Activate /Deactivate.

7. Click Apply or OK to save your changes.

Now the module is (de)activated for the selected Asset Handling Set.
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Asset Storage Modules
The Asset Storage module manages the access to files. To catalog a file from the file 
system of a computer, the Asset Storage module for that computer’s operating system 
must be activated for the Asset-Handling Set used. It must also be activated to enable 
you to access this file. If you are working in a cross platform environment you should 
have the Asset Storage modules for the other platforms activated as well so that you can 
access assets that are stored on other operating systems.

Amazon S3 AssetStore (optional)

This Asset Storage module enables Cumulus to employ an Amazon Simple Storage 
Service (Amazon S3) bucket as Central Asset Location and it supports versioning. To 
employ it, you need an Amazon Web Services (AWS) account and must be signed up 
for Amazon S3. If you are signed up for Amazon’s CloudFront as well, it can also be 
employed for best possible performance. 

The properties you can define are the Amazon security credentials. The security cre-
dentials are used to authenticate and authorize calls that Cumulus makes to Amazon 
Web Services (AWS). 

NOTE: Only the Cumulus Administrator can view or edit the properties of the 
Amazon S3 AssetStore!

Clicking on the Properties button opens the list of available credentials. The list dis-
plays for each credential an alias name and the Amazon Web Services (AWS) access 
key – and, if configured, the Amazon CloudFront Key Pair. The buttons below the list 
let you add, edit or remove credentials. 
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For adding or editing credentials the Credentials dialog is provided. It is divided into 
two groups: the mandatory credentials and the optional CloudFront Key Pair.

The mandatory credentials include:

• Name – The alias name for the credentials identifying a bucket. The name is given 
by the user.

• Access Key – The AWS access key as received from Amazon. 
• Secret Key – The AWS secret key as received from Amazon; when you type it, it is 

displayed as asterisks or dots. 
CloudFront Key Pair 

CloudFront uses access keys to authenticate requests made to CloudFront. 

• Key Pair ID – The key pair ID as received from Amazon. 
• Key Pair ID PEM File – The associated private key file (downloaded to a local direc-

tory). The content of the PEM file will be saved encrypted at the Cumulus Server 
and the file itself can be moved to any other location.

NOTE: If CloudFront is employed, make sure that “Forward query strings” is con-
figured to YES in the CloudFront distribution. This option ensures that files are 
properly downloaded via CloudFront URLs, instead of simply being displayed 
in the browser with Cumulus Web Client or Cumulus Portals.
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BACKGROUND INFO:  Amazon S3

Objects are organized into buckets (each owned by an Amazon Web Services 
account), and identified within each bucket by a unique key. Amazon Cloud-
Front can be used to route requests for content automatically to the nearest 
edge location, so content is delivered with the best possible performance. 

Apple iWork Picture AssetStore

The Apple iWork Picture AssetStore enables Cumulus to create one record for each 
picture embedded in a Apple iWork document while cataloging. These records are 
created in addition to creating a record for the entire document and in addition to 
separate records for pages or slides. The records will be assigned to the corresponding 
document as “contained images”. A category for each document will automatically be 
created and the images’ records are assigned to these categories. The record name of 
an embedded image is either the name of the image inserted in the document, or 
“image” and a corresponding number. (No properties to be defined.) 

Apple Keynote Slides AssetStore

This Asset Storage module allows you to efficiently manage slides created with Apple 
Keynote. It automatically catalogs all slides of a Keynote presentation and in addition 
to creating a record for the entire presentation document, a record for each slide is 
created. (No properties to be defined.) For more information, see “Working with Office 
Documents” .
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HELIOS XPV AssetStore (optional)

This Asset Storage module enables Cumulus users to catalog pages within Adobe 
InDesign and Quark XPress documents. If an XPV preview file for such a document is 
available, in addition to creating a record for the entire document, the XPV Support 
module creates records for each page of the document.

An XPV preview file also contains information on referenced assets. This information 
can be captured by Cumulus filters (such as HELIOS, InDesign and Quark XPress) and 
enables Cumulus AXR (Asset Cross References.)

Because the XPV AssetStore does not use the original Quark XPress documents, you 
cannot use the ’normal’ functions for the pages, e.g. copy, move and drag & drop. 
[Whereas the Cumulus QXP AssetStore, for Mac OS only, that also catalogs pages 
within Quark XPress documents, can create a new one-page Quark XPress document 
from the record of a page.]

NOTE: The XPV Support module is available only to computers in network envi-
ronments in which the HELIOS ImageServer is licensed and installed on the 
same computer as a Cumulus Server. 

InDesign Asset Store

The InDesign AssetStores enables Cumulus to create one record for each page of an 
InDesign document while cataloging. For more information, see “Working with InDe-
sign Documents” .

Mac OS File System AssetStore

This Asset Storage module manages the access to files accessible from a Mac com-
puter. (No properties to be defined.) 
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MacBinary AssetStore

The Mac Binary AssetStore enables Cumulus to catalog MacBinary converted assets 
even on Windows machines. In addition to creating a record for the entire BIN file, it 
creates records for the compressed file in the BIN file. (No properties to be defined.)

Microsoft Azure AssetStore (optional)

This Asset Storage module enables Cumulus to employ a Microsoft Azure container as 
Central Asset Location and it supports versioning. To employ it, you need a Microsoft 
Azure account and must be signed up for Microsoft Azure. 

NOTE: This Asset Storage module is working with Azure Standard Storage only, 
but not with Azure Premium Storage.

The properties you can define are the Azure security credentials. The security creden-
tials are used to authenticate and authorize calls that Cumulus makes to Microsoft 
Azure. 

Only the Cumulus Administrator can view or edit the properties of the Microsoft Azure 
AssetStore!

Clicking on the Properties button opens the list of available credentials. The list dis-
plays for each credential an alias name. The buttons below the list let you add, edit or 
remove credentials. 

Clicking on the Properties button opens the Credentials window. The mandatory cre-
dentials include:

• Name – The alias name for the credentials identifying a container. The name is 
given by the user.

• Account Name – The Azure account name as received from Microsoft. 
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• Account Key – The corresponding account key.

MS PowerPoint AssetStore

This Asset Storage module allows you to efficiently manage slides created with Micro-
soft PowerPoint. It automatically catalogs all slides of a PowerPoint presentation in 
addition to creating a record for the entire presentation document. Such cataloged 
slides can be added to existing PowerPoint presentations – within Cumulus as well as 
within Microsoft PowerPoint. Within Cumulus you may even create new PowerPoint 
presentations out of cataloged slides. (No properties to be defined.) For more informa-
tion, see “Working with Office Documents” .

MS Power Point Picture AssetStore

The MS Power Point Picture AssetStore works in conjunction with the MS Power Point 
AssetStore only. It enables Cumulus to create one record for each picture embedded 
in an MS Power Point presentation while cataloging. These records are created in addi-
tion to creating a record for the entire document and in addition to separate records 
for pages or slides (created by the MS Power Point AssetStore.) The images’ records 
will be related to the corresponding slide/page as “contained images”. A subcategory 
for each slide/page of the presentation file is automatically created and the images’ 
records are assigned to these categories. The record name of an embedded image is 
the name of the image inserted in the document, or “image” and a corresponding 
number. (No properties to be defined.) 

Office Open XML Pages and Slides AssetStore

The Office Open XML Pages and Slides AssetStore enables Cumulus to create one 
record for each page, sheet or slide of a 2007 MS Office System document (*.DOCX, 
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*.XLSX, *.PPTX) or XML Paper Specification document (*.XPS) while cataloging. These 
records are created in addition to creating a record for the entire document. The 
records will be assigned to the corresponding document as “contained pages”. A cat-
egory for each document will automatically be created and the images’ and pages’ 
records are assigned to these categories. The record name of the pages/slide is the 
name of the document and a corresponding number. (No properties to be defined.) 

Office Open XML Pictures and Media AssetStore

The Office Open XML Pictures and Media AssetStore enables Cumulus to create one 
record for each picture or media embedded in a 2007 MS Office System document or 
XML Paper Specification document (*.XPS) while cataloging. These records are created 
in addition to creating a record for the entire document and in addition to separate 
records for image or media assets. The records will be assigned to the corresponding 
document as “contained images”. A category for each document will automatically be 
created and the media’s/images’ records are assigned to these categories. The record 
name of an embedded image/media is the name of the image/media inserted in the 
document or “image” and a corresponding number. (No properties to be defined.) 

Open Document AssetStore

The Open Document AssetStore enables Cumulus to create one record for each 
image embedded in an Open Office document while cataloging – in addition to cre-
ating a record for the entire document. The records will be assigned to the corre-
sponding document as “contained assets”. A category for each document will 
automatically be created and the images’ records are assigned to these categories. 
The record name of an embedded image is the name of the image as saved with the 
document. (No properties to be defined.) 
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Outlook Message AssetStore

The Outlook Message AssetStore enables Cumulus to create one record for each 
attachment or embedded image of a Microsoft Office Outlook message while catalog-
ing – in addition to creating a record for the message. The records will be assigned to 
the corresponding message as “related sub assets”. A category for each message will 
automatically be created and the images’ and attachments’ records are assigned to 
these categories. The record name of an attachment or an embedded image is the 
name of the image as saved with the document. (No properties to be defined.) 

TIP: Auto-cataloging Emails
Another optional feature provides a Cumulus Scheduler Action that enables Cumulus to 
check a standard POP3 email account and retrieve and automatically catalog any email 
it finds. For more information, see “Provided Scheduler Actions” .

PDF AssetStore

This Asset Storage module enables Cumulus users to catalog pages within PDF docu-
ments. In addition to creating a record for the entire PDF document, it creates records 
for each page of the PDF document. 

PDF Image AssetStore

The PDF Image AssetStore works in conjunction with the optional PDF AssetStore 
only. It enables Cumulus to create one record for each image embedded in the PDF 
file while cataloging – in addition to separate records for pages created by the PDF 
AssetStore. The records will be assigned to the corresponding page as “related sub 
assets”. If you want to have separate records for embedded images, you need to use 
an Asset Handling Set for cataloging that has the PDF Image AssetStore, the PDF 
AssetStore and the format Embedded PDF Image (provided by the PDF Filter) acti-
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vated. A subcategory for each page of the PDF file is then automatically created and 
the images’ records are assigned to these categories. The record name of an embed-
ded image consists of the word Image and its internal PDF ID number.

QXP AssetStore (optional, Mac OS only)

The Cumulus QXP AssetStore module enables Cumulus users to catalog pages within 
QuarkXPress documents. In addition to creating a record for the entire QuarkXPress 
document, it creates records for each page of the QuarkXPress document.

The Cumulus QXP AssetStore is designed specifically for use in conjunction with 
QuarkXPress. To employ the functionality of the Cumulus QXP AssetStore, QuarkX-
Press must be running in the background while accessing your QuarkXPress page 
assets (e.g. for cataloging or previewing.)

QXP Server AssetStore (optional)

The QXP Server AssetStore module enables Cumulus users to catalog pages and lay-
outs within QuarkXPress documents. In addition to creating a record for the entire 
QuarkXPress document, it creates records for each page and each layout of the 
QuarkXPress document. The QXP Server AssetStore module is available for OS X, Win-
dows and UNIX. 

SCORM AssetStore

The SCORM AssetStore module enables Cumulus users to catalog resources con-
tained in a SCORM (Sharable Content Object Reference Model) package. (No proper-
ties to be defined.)

The SCORM AssetStore automatically creates categories when cataloging files. In the 
Categories master category under a category named Scorm, a category is created for 
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each cataloged SCORM file, named after the respective file (e.g. sample.scorm). If a 
SCORM file contains another SCORM file, a subcategory named after this additional file 
will also be created. 
If any files contained within a SCORM file are archived with subfolder references, the 
SCORM AssetStore creates a category tree resembling this subfolder structure. 

TAR AssetStore

The TAR AssetStore enables Cumulus to catalog and access assets compressed within 
TAR archive files. It automatically catalogs all files in a TAR file. In addition to creating a 
record for the entire TAR file, it creates records for each file included in the TAR file - 
even for files in a TAR file within another TAR file. The Cumulus TAR AssetStore sup-
ports Bzip2, gzip and uncompressed TAR files.

The TAR AssetStore automatically creates categories when cataloging TAR files. In the 
Categories master category under a category named tar, a category is created for each 
cataloged TAR file, named after the respective file (e.g. sample.tar). If a TAR file con-
tains another TAR file, a subcategory named after this additional file will also be cre-
ated. 

You can define the character encoding used to create the TAR file that is to be 
unpacked by the TAR AssetStore. To know for sure, you should ask the person who 
packed it. If you aren’t sure the character encoding used to pack the TAR file, you 
should use the default: Local Encoding

UNIX File System AssetStore

This Asset Storage module manages the access to files accessible from a UNIX com-
puter. (No properties to be defined.)
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URL AssetStore

This Asset Storage module manages the access to files accessible from FTP or HTTP 
servers. (No properties to be defined.) For more information, see “Using Vault” .

Vault AssetStore

The Cumulus Vault Asset Storage module enables you to use the version control sys-
tem Cumulus Vault. For more information, see “Working with Vault” , and “Configuring 
Vault” .

Windows File System AssetStore

This Asset Storage module manages the access to files accessible from a Windows 
computer. You can define the resolving method for assets stored on CD ROMs. If 
enabled, Cumulus checks for the CD-ROM label.

ZIP AssetStore

The ZIP AssetStore enables Cumulus to catalog and access assets compressed within 
ZIP files. It automatically catalogs all files in a ZIP file. In addition to creating a record 
for the entire ZIP file, it creates records for each of the compressed files in the ZIP file - 
even for files in a ZIP file within another ZIP file. The Cumulus ZIP AssetStore has been 
tested with ZIP compressed assets created with WinZip®, PKZIP® and WinRAR.

The ZIP AssetStore automatically creates categories when cataloging ZIP files. In the 
Categories master category under a category named Zip, a category is created for 
each cataloged ZIP file, named after the respective file (e.g. sample.zip). If a ZIP file con-
tains another ZIP file, a subcategory named after this additional file will also be created. 
If any files contained within a ZIP file are archived with subfolder references, the ZIP 
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AssetStore creates a category tree resembling this subfolder structure. (No properties 
to be defined.)

NOTE: Password Protected ZIP Files 
If the ZIP file to be cataloged contains a password protected file, Cumulus will 
ask you for the password. Cumulus remembers this password and if there is 
another password protected file within a ZIP file, it will try the password for that 
file. If it doesn’t fit, Cumulus will also ask you for the password to that file. Then 
you can either type in the password and the file will be cataloged, or skip the 
password request and file will not be cataloged. The passwords are also 
requested for any preview of a password protected asset. Cumulus remembers 
passwords only for as long as the current session. 

NOTE: Cumulus Internet Solutions and Password Protected ZIP Files
Users of Cumulus Internet Solutions who use a Web browser cannot get a pre-
view of any password protected asset. 

You can define the character encoding used to create the ZIP file that is to be 
unpacked by the ZIP AssetStore. To know for sure you should ask the person who 
packed it. If you don’t know for sure the character encoding used to pack the ZIP file, 
you should use the default: DOS Latin US

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS ASSET HANDLING MODULES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Asset Processor Modules
Asset Processor modules enable Cumulus to perform processes on cataloged assets, 
e.g. to convert them.

DCS File Support

The DCS File Support module enables Cumulus to recognize CMYK Desktop Color 
Separation files so that it can effectively catalog and manage multiple-file DCS assets. 
This module supports DCS version 1.0. These DCS assets consist of one main file 
(which may contain a preview image) and the four standard color separation files.

When cataloging a DCS asset, this module creates a record for the main file only. It is 
important to be aware of this when viewing the Asset Information window, as the 
information such as file size, etc. only pertain to the main file. Although only one file is 
cataloged, Cumulus still manages all five. For example, if you move or copy the cata-
loged DCS asset with Cumulus, all five DCS files will be moved or copied. (No proper-
ties to be defined.)
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Generic Asset Processor (optional)

Provided by the Cumulus External Tool Connector Option. Enables Cumulus to call 
external applications from within Asset Actions. It can be used for processing, packag-
ing, and delivering tasks.

For each platform you specify the commands to be executed. (The same parameters 
have to be defined for the External Application used by the Generic Filter for thumb-
nail generation.) 

External Tool Parameters for the Generic Asset Processor

The following variables have to be used in the command line for the input and output 
files: $INPUT and $OUTPUT. They will be replaced by Cumulus before executing the 
command line depending on the module task in the following manner:

In case the application to be called expects a special file extension, you can specify the 
extension directly behind the variable:
$OUTPUT.jpg "C:\Temp\CumulusTemporary.jpg"
In the same manner you can specify suffixes to append at the destination name:

Asset Processor 
Task

$INPUT $OUTPUT

Processing Quoted path of source 
asset.

Quoted path of des-
tination asset.

Packaging Space separated list of 
quoted paths of source 
assets.

Quoted path of des-
tination asset.

Delivering Quoted path of source 
asset.

- (will be deleted)
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$OUTPUT_step01.tiff "C:\Temp\CumulusTemporary_step01.tiff"
To exactly specify the file name you can assign one:
$OUTPUT=result.png  "C:\Temp\result.png"

NOTE: Some applications require the proper file extension 
(e.g. OUTPUT.jpg or OUTPUT.flv.)

Replacement Examples for Processing
"C:\Program Files\MyConverter\conv.exe $INPUT /opt1 -prm=2 $OUTPUT"
will be replaced by:
"C:\Program Files\MyConverter\conv.exe C:\My Assets\Selected.jpg /opt1 -
prm=2 C:\Temp\Cumulus01"

Replacement Examples for Packaging
"C:\Program Files\MyZipTool\myziptool.exe -compress -zipfile=$OUTPUT 
$INPUT"
will be replaced by:
"C:\Program Files\MyZipTool\myziptool.exe -compress 
-zipfile=C:\Temp\Cumulus02" ...

"C:\My Assets\Selected1.jpg" "C:\My Assets\Selected2.pdf" "C:\My 
Assets\Selected3.doc"

Replacement Examples for Delivering
cmd /C copy "$INPUT C:\My Destination Folder"
will be replaced by:
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cmd /C copy "C:\Asset Location\The Selected Asset.ext" "C:\My Destination 
Folder"

Examples for Windows

Processing: Conversion of images to JPEG using IrfanView
"C:\Program Files\IrfanView\i_view32.exe $INPUT /convert=$OUTPUT.jpg"

Processing, Packaging: Compression of files using 7-Zip to 7z format:
"C:\Program Files\7-Zip\7z.exe a -t7z $OUTPUT.7z $INPUT"

Calling a batch script:
cmd /c "C:\My Scripts\myscript.cmd $INPUT $OUTPUT"

Examples for Mac OS / Linux / Unix:

Generate compressed tar file:
tar -czf $OUTPUT.tgz $INPUT

Generate compressed tar file with specified destination file name:
tar -czf $OUTPUT=FromProcessor.tgz $INPUT

MS PowerPoint Asset Processor

The MS PowerPoint Asset Processor enables the user to create PowerPoint presenta-
tions in PowerPoint 97-2003 format from selected PowerPoint assets (slides, presenta-
tions), image assets and previews of other asset formats within Cumulus. For more 
information on how to use the processor, see “Creating Presentations” .
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Office Open XML Presentation Asset Processor

The Office Open XML Presentation Asset Processor enables the user to create presen-
tations in Office PowerPoint 2007 format from selected presentations (slides, presen-
tations), image assets and previews of other asset formats within Cumulus. For more 
information on how to use the processor, see “Creating Presentations” .

OPI System Support

The OPI System Support module enables Cumulus to be OPI-aware. The Open Prepress 
Interface (OPI) is a technology that allows placing low resolution versions of image 
files into page layouts and letting an OPI print spooler automatically replace them 
with the high resolution versions of the files for printing. If the OPI System Support 
module is activated, Cumulus will be able to recognize OPI files and carry through the 
correct handling of high and low resolution versions of OPI files.

The module is able to read path name information and lets Cumulus manage both 
high resolution and low resolution files from OPI systems like Imation Color Central™, 
Nine Bits PrintDesk, 4-Sight OPI™ , HELIOS EtherShare OPI, and HELIOS Image Server. 

Cumulus is also OPI-compatible with many other OPI systems that use EPSF or TIFF for-
mat files as their low resolution file, like Scitex® APR. With these OPI systems, low reso-
lution files are handled as expected, but the path to the high resolution file might not 
be automatically recognized.

The OPI System Support module is used for asset access in two different ways: 

• If used with a Cumulus Action, it provides access to OPI assets as set in the module’s 
properties within the Cumulus Action. There you can define whether the action will 
access the high resolution or the low resolution file when being performed - 
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regardless of how the module is set up for the Asset Handling Set used with the 
action. 

• If used along with an Asset Handling Set (e.g. for cataloging, previewing or copy-
ing OPI assets), it provides access to OPI assets as set in the module’s properties for 
the Asset Handling Set. How to set up these properties is described below. 

The module offers special support for the following versions of HELIOS and Imation OPI 
systems

• HELIOS EtherShare OPI version 1.0 up to 2.1 
• HELIOS ImageServer 2.5 
• HELIOS ImageServer UB 
• Imation Color Central 2.1 up to 2.5
For both OPI systems you can define additional properties.

If you select the OPI Support entry in the list of Asset Processor modules and then 
select the Properties button, the OPI Support Setup window opens.

The OPI System Support Setup window has three sections: 

• General 
• HELIOS 
• Imation 
In the section General you can set up the module: 

• to run in silent mode when accessing an OPI asset or not. If Silent OPI File Access 
is not activated, you will be prompted to choose a version when accessing an OPI 
asset. If Silent OPI File Access is activated, Cumulus uses the version chosen below 
when accessing an OPI asset (e.g. for previewing or copying).
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• to use either the low resolution file or the high resolution file when in silent mode 
or when dragging and dropping an OPI asset. 

Normally you choose to use the low resolution file. The chosen file version is also used 
in silent mode. If silent mode is not activated, you will be prompted to choose a ver-
sion when accessing an OPI asset. Regardless of whether silent mode is activated or 
not, when you drag and drop assets you will never be prompted to choose the version 
– with one exception which refers to OS X only . Under OS X special functions for drag-
ging and dropping OPI files are provided. These are as follows:

• Under OS X, if Silent OPI File Access is activated, you must use the ALT key 
when dragging to have the version dropped that is defined for silent mode.

• The exception to the rule that you will never be prompted to choose the ver-
sion when you drag and drop assets: Under OS X, if Silent OPI File Access is not 
activated and you did not use the ALT key for dragging, you will be prompted to 
choose the version when dropping the asset into the Finder. If you have selected 
multiple assets, you will be prompted once and the chosen version will be taken 
for all. 

• Under OS X you have an additional option to choose between high and low 
resolution files when dragging and dropping assets into other applications: key-
board shortcuts. To place the high resolution file press ALT+H and then start drag-
ging. To place the low resolution file press ALT+L and then start dragging. 

TIP: Drag& Drop of High Resolution Files
If you have chosen to use the low resolution files but in contrary to your normal workflow 
you want to drag & drop the high resolution files, you can proceed as follows: Select the 
records representing the assets and select the Show Location menu command 
( Apple / CTRL + R). This command locates the selected records’ assets and displays 
them in OS X Finder or Windows Explorer. Now you can select the desired asset version in 
OS X Finder or Windows Explorer and drag and drop it from there. 
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For HELIOS OPI system it is recommended to catalog the high resolution file as the 
information on this file will then be available with the catalog. 

For all OPI systems (except HELIOS) it is recommended to catalog the low resolution 
file as only the low resolution file leads to the high resolution file – and not vice versa. 
If you have cataloged the low resolution files, do not enable Silent OPI File Access 
along with the option High Resolution File for these OPI systems since this combina-
tion will not work.

In the section HELIOS you can set up special properties for HELIOS EtherShare OPI and 
HELIOS Image Server. Only if the option HELIOS EtherShare OPI Aware is activated 
will Cumulus catalog either the low resolution layout file or the high resolution file. 
Although the module recognizes layout files generated in the layouts folder it also 
supports a name extension for layout files. In the field Layout file name extension 
(default: .lay) you specify the name extension to identify OPI layout files. You should 
always specify the same name extension that is used by the HELIOS EtherShare OPI 
system. A file in the same folder as the high resolution file that has this name extension 
will be treated as the layout file for this high resolution file. The following two options 
are important to avoid duplication when cataloging a whole folder. They can be used 
to create only one record for a pair of high- and low resolution files when cataloging. 
The option Catalog High Resolution Files Only (default) allows you to catalog only 
high resolution files. This is useful to get the information (size, resolution) about those 
files into the Cumulus catalog. By choosing the option Catalog Layout Files Only you 
can build a catalog of only the layout files. 

In the section Imation you can set up special properties for Imation Color Central. Only 
if the option Imation Color Central Aware is activated, will Cumulus read the IPTC 
information from the high resolution file while cataloging the sample file. 
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NOTE: This option can only work properly when the high resolution file and the 
sample file reside in the same folder. 

If the option Add Category for Sample Files is activated, Cumulus will assign every 
ColorCentral sample file to a special category while cataloging. The category name 
can be specified in the field below this option (default: Imation Color Central). This 
option is useful when you catalog both the high resolution and the sample file of an 
image and you want to distinguish between the corresponding records.

PDF Page Merge AssetProcessor

The PDF Page Merge Asset Processor enables the user to create PDF documents from 
selected PDF page assets and image assets within Cumulus. (No properties to be 
defined.) 

Pixel Image Converter

The Pixel Image Converter enables Cumulus to convert any cataloged pixel image into 
the different formats on the fly: e.g. JPEG, TIFF, BMP, GIF, ScitexCT, PNG, PCX, and PDF. 
(No properties to be defined.) For more information on how to use the Pixel Image Con-
verter, see “Converting Image Assets” .

Pixel Image Crop Processor

The Pixel Image Crop Processor enables Cumulus to crop any cataloged pixel image 
on the fly, e.g. JPEG, TIFF, BMP, GIF, PNG, etc., and to resize the final output of the 
cropped section. The resulting image will be saved as a new file. For more information 
on how to use the Pixel Image Crop Processor, see “Cropping Image Assets” .
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Pixel Image Crop Template Processor

The Pixel Image Crop Template Processor enables Cumulus to crop any cataloged 
pixel image, e.g. JPEG, TIFF, BMP, GIF, PNG, etc., and to resize the final output, by means 
of predefined templates. The resulting image will be saved as a new file. For more 
information on how to use the Pixel Image Crop Template Processor, see “Cropping 
Image Assets with Templates” .

QXP Server AssetProcessor (optional)

The QXP Server Asset Processor converts QXP documents, layouts or pages to PDF 
using a QXP Server installed in the network. (No properties to be defined.) For more 
information on the parameters available for the conversion, see the QXP Server docu-
mentation.

Rename AssetProcessor

The Rename AssetProcessor renames assets according to a predefined rule within a 
Cumulus Action. It requires that at least one rule has been defined and saved as a 
renaming set using the Rename Asset dialog (Menu Asset > Rename To > Batch; for 
more information on how to configure a renaming set see The Rename Assets Dialog. 
The desired set must be selected in the module’s properties.

Thumbnail Provider

The Thumbnail Provider is used with Cumulus Actions only. It provides the thumbnail 
stored in the asset’s record for a Cumulus Action. Using the thumbnail that is stored in 
the record might be faster than having the asset converted, e.g with the Pixel Image 
Converter. (No properties to be defined.)
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Watermark AssetProcessor

The Watermark AssetProcessor enables you to embed digital watermarks into the fol-
lowing pixel image formats: JPEG, TIFF, BMP, GIF, PNG, and PCX. You can embed visible 
text and image watermarks. For more information on the processor and on how to use 
it, see “Watermarking Assets” .

XSL Metadata Processor

The XSL Metadata Processor enables Cumulus to create metadata files based on XSL 
transformations. The XSL transformation is applied to a file that contains all metadata 
from the catalog for a processed record. Any XSLT style sheet can be chosen for the 
transformation. The output file is named the same as the asset with a chosen exten-
sion added and is saved at a chosen target location. (No properties to be defined.)

NOTE: Sequence of AssetProcessors in Asset Actions
The XML Metadata Processor should be at the end of the list of processors for 
processing in the Asset Action – otherwise no output will be written.

NOTE: Style Sheet Saved With Asset Actions
The XSLT style sheet is saved with an Asset Action. If you update such a style 
sheet, you need to update the Asset Action configuration as well by choosing 
the updated style sheet again.

ZIP AssetProcessor

The ZIP AssetProcessor enables Cumulus to compress cataloged assets into Zip 
archives. (No properties to be defined.) For more information on how to use the ZIP 
AssetProcessor, see “Creating ZIP Archives” .
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Metadata Modules
The Metadata modules are used for retrieving and managing special metadata infor-
mation.

Canon Raw Metadata Support

Most cameras supporting Canon CRW files create additional thumbnail files (THM 
files). The Canon Raw Metadata Support module enables Cumulus to capture meta-
data from these files and to manage these files. For more information, see “Canon DC 
Raw Image & Thumbnail File” 

Cumulus Metadata Support

The module Cumulus Metadata Support supports the storing of an asset’s metadata 
in a separate TAG file for each asset. This makes it possible for stored metadata to be 
used externally (e.g. by other applications). Only if the Cumulus Metadata Support 
module is activated, will Cumulus be able to create a TAG file for each asset cataloged. 
(For further information on TAG files, see “Assets/Records”  and “Browse for Assets”.) 
You can define the following properties for the Cumulus Metadata Support:

• Never – If a TAG file exists, Cumulus Metadata Support will read it, but no TAG files 
will be created. 

• Only if Metadata Exists – If metadata in a TAG file exists, it will be updated.
• Always – A TAG file for metadata will be created and continuously updated.
For Directory Categories, Folder TAG files can be created. Remember, Directory Cate-
gories are automatically created and resemble the folder hierarchy in which the assets 
reside. The Folder TAG file for a Directory Category is called Cumulus Metadata.tag 
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and resides in the corresponding folder. If the Cumulus Metadata Support is activated 
and the option Always is enabled, a Folder TAG file will be created as soon as you 
change the Category information of a Directory Category.

Folder TAG files are also created if you Drag & Drop a category to your Desktop, or if 
you employ the menu item Copy Assets Assigned to Category To (for details, see 
“Copy Assets Assigned to Category To” ). And note that if you use this way of copying 
assets, the TAG files associated to the assets themselves will not be copied even if the 
Cumulus Metadata Support module is activated.

HELIOS AssetProcessor (optional)

The HELIOS AssetProcessor enables you to convert cataloged assets into the following 
file formats: TIFF, JPEG, EPS, PNG, BMP, Scitex CT, Photoshop (PSD), and Macintosh 
PICT. Considering the ICC (International Color Consortium) profile you can select dif-
ferent color spaces and compressions supported by the OPI system. Rotation, flipping 
and cropping are also possible. The conversion produces a new file that can be stored 
wherever you want.

The HELIOS AssetProcessor can be used with Cumulus Clients under Windows or 
Mac OS X as well as with Cumulus Portals or Web Client and additional EJaPs or appli-
cations based on the Cumulus Java Classes. With the Cumulus Options, Web Client 
and Portals, all functions are also available on the Internet, e.g. prior to a download.

For details on how to use the HELIOS AssetProcessor, see the Cumulus HELIOS Com-
panion Administrator Guide.

XML Metadata Prefiller

The XML Metadata Prefiller module enables Cumulus to capture additional metadata 
for an asset from a special XML file. When the asset is cataloged, the Prefiller looks for 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS ASSET HANDLING MODULES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

an XML file called “.CumulusPrefill.xml” in the file hierarchy above the asset’s location. 
If it is found, the metadata from this file is added to the asset’s record. (No properties 
to be defined.)

NOTE: The “.CumulusPrefill.xml” file will be hidden on most platforms due to 
the dot at the beginning of its file name. 

XML MetadataBridge

The XML MetadataBridge module enables Cumulus to retrieve additional information 
from an asset during cataloging and store this information within XMD Metadata files 
in XML format. The XMD Metadata files are stored in the same location as the original 
asset. The XML MetadataBridge also allows you to write metadata, which has been 
changed within Cumulus, back to these XMD Metadata files. These files store the 
metadata in XML format so that it can be viewed in a Web browser.

The XML MetadataBridge module supports the storing of an asset’s metadata in a sep-
arate XMD file for each asset. This makes it possible for stored metadata to be used 
externally (i.e., by other applications). If you catalog assets from a location where you 
are allowed to save files, the XML MetadataBridge can create an XMD file for each asset 
cataloged. The file is named the same as the asset but with the extension .xmd added 
and is saved in the folder where the asset resides. XMD files hold all of the information 
that can be viewed in the Information window and more. For example, if a particular 
asset has been cataloged in different catalogs, this information is stored in that asset’s 
XMD file. XMD files store the metadata in XML format so that it can be viewed in a Web 
browser.
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You can define the following properties:

• Never – If an XMD file exists, the XML MetadataBridge module will read it, but no 
XMD files will be created. 

• Only if Metadata Exists – If metadata in an XMD file exists, it will be updated.
• Always – An XMD file for metadata will be created and continuously updated.
• Under XML Metadata Viewer, it is also possible to specify an XML Style Sheet file 

for viewing your XMD files in an Internet Browser. The XML MetadataBridge writes 
its location as a 'Processing Instruction' in the head of the XMD file. When installing 
the MetadataBridge, the file CumulusXMLMetaViewer.xsl is installed by default 
and its path is displayed in the corresponding field. If you would like to define a dif-
ferent XML Style Sheet, type the file's path directly into the corresponding field or 
click Browse to navigate to it. 

Writing metadata (e.g. to an XMD file) requires two preparatory steps. First the Asset 
Handling Set for accessing the asset must be set to allow the writing of metadata. 
Then each record field - with contents which should be written back as metadata - 
must have the When Saving Assets option enabled for its field linking.

NOTE: Assets in Multiple Catalogs
There is one XMD file for each asset. If the asset is cataloged in various catalogs, 
the XMD file contains which catalogs the asset is included in and all metadata 
of the asset contained in each of the various catalogs. 

XMP Metadata Support

The XMP Metadata Support module enables Cumulus to manage XMP files (e.g. 
Adobe Sidecar). (No properties to be defined.)
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XUSR MetadataBridge

The XUSR MetadataBridge module is used for the Cumulus User Manager application. 
It enables Cumulus to import user information from XML structured files. (No proper-
ties to be defined.)
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Asset Format Support
Probably one of the first questions you had about Cumulus was “What kinds of assets 
does it support?” Plain and simple, Cumulus supports all kinds of assets, in one way or 
another.

Enhanced support is offered for most popular formats, meaning that Cumulus is 
aware of them and knows what information to extract from them. Others are sup-
ported only to the extent that they can be added to a catalog, assigned to categories, 
and searched, but no preview or automatic in-depth asset information is available. 
And in some rare cases, an asset’s record will feature a thumbnail on one platform, but 
not on another. You can download an overview on Cumulus enhanced format sup-
port from Canto’s website.

Cumulus uses what are called filters to help it catalog the contents of an asset. 
Cumulus tells these filters what information to look for in that asset type so that it can 
become part of the asset’s record. Cumulus comes with a number of filters that can 
capture detailed information about particular assets. You can also create your own for-
mat support for assets that are not particularly supported. 

To see the list of file formats with enhanced support:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Click Asset Formats. The list of all supported file formats is displayed.
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Active formats are indicated by a green marker to the left of the format. Formats that 
have been deactivated have a red marker to their left.

Formats that are indicated by italics are currently not supported (not installed on the 
machine you are working on), but are included in the list so they will be activated at 
that position when the filter is available.

When cataloging, Cumulus starts searching for matching formats at the lowest entry 
number. It employs the filters in the order in which the formats they support are 
found. If you are not satisfied with the result of cataloging certain asset types, check 
the order of the formats (and the filter that support these formats). The format entry 
that is supported by a filter that best suits your needs may come later in the order than 
other matching filters. 

Use the arrow buttons to the right of the list to change the order of the entries.

NOTE: Record Field Linking
If the Read One option in the Record Field Properties is activated for the field 
link, only the metadata read by the first matching filter will be stored within the 
record. 

If you only want to use a few of the formats on the list for the selected Asset Handling 
Set, you can disable the others to increase program performance. 
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Adding Formats to the Asset Formats List
To add new or not used formats to the Asset Formats list to have them available for 
Asset Handling Sets: 

1. On the Asset Formats tab click Add.The Add Format dialog opens. It displays a list 
of all Cumulus modules that provide formats which are not included in the Asset 
Formats list. If you click the plus sign in front of a module’s entry, the list expands 
and displays the formats supported by this selected module. You can either select 
a module’s entry itself and all formats supported by the module will be added. Or 
you can expand the list and select a certain format to be added.

2. Select the format(s) you want to add and click OK. 

New formats are placed at the end of the list by default. Use the arrow buttons to the 
right of the list to move the format, if necessary.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS ASSET FORMAT SUPPORT

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Changing Format Options
Some filters have options that you can change. The range of options depends on the 
filter. 

To access a filter’s options:

1. Select Cumulus / Edit > Preferences and then click Asset Handling Sets. 

2. Click Asset Formats. The list of all supported file formats is displayed.

3. Select the entry for the desired format in the list. If the filter supporting it has 
options that you can change, Properties is activated.

4. Click Properties. The Filter Setup dialog is opened.

5. Make your selections and click OK.
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Extending Generic Filter Options
Cumulus can catalog any digital asset. If Catalog Unknown Formats (below the list of 
asset formats) is activated and Cumulus encounters an asset for which no specific filter 
is available, then it uses its Generic Filter. You can expand the Cumulus Generic Filter’s 
capabilities to create your “own formats.” For assets that don’t have specific format 
provided by Cumulus, you can define a thumbnail for the asset format by using the 
Generic Filter. 

If you use formats that you’ve created on your own, check the list available on the 
Canto Website from time to time to see if a filter has been developed that supports 
this format and you could use.

To set up a new format:

1. Select Cumulus / Edit > Preferences and then click Asset Handling Sets. 

2. Click the Modules tab and then on the Filter icon to see the list of installed filters.

3. Select the Generic Filter in the list and click Properties. The window to set up the 
properties for the new format appears.

4. Enter your format’s file name extension in the File Extension field. Do not enter 
the period.

5. Type a name for the format in the File Format field. If your system is aware of 
the asset type, its name may be entered for you.

6. Enter the Mac OS file type in the Mac OS File Type field. The file type will always be 
4 characters in length.
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7. Enter the file format identifier (typically the mime type) in the File Format Identi-
fier field.

8. Choose the kind of thumbnail you want to be displayed for the assets. You can 
use either the asset’s Finder / Windows Explorer icon, a thumbnail gener-
ated by an external application, or an image that you specify.

If you want to specify a thumbnail image to be used for the assets of the specified 
format, activate the Static Thumbnail option, which enables the Browse button. 
Then click Browse to select an image. You can use any JPEG file as a static thumb-
nail. The image is resized, if necessary, and pasted into the thumbnail image area. 
Each asset cataloged with this format will use this image as its thumbnail.

If you want a thumbnail image generated by an external application, activate the 
Call External Application option, which enables the Configure button. Then click 
Configure to specify the external application. For details on the parameters, see 
below.

9. Click OK to save your new format. 
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SPECIAL TECH INFO:  Generic Filter External Tool Parameters

The Generic Filter has got an additional option to generate the thumbnail and 
the preview by calling an external application, in the same way the Generic Pro-
cessor works. The parameters are nearly the same: command lines for each 
platform. For this module the variables which have to be used are:
– $INPUT – will be replaced by the quoted path of the cataloged asset
– $PREVIEW - will be replaced the quoted path of a temporary file.
The called application has to generate a picture in JPEG or PNG format.

Examples
Generate a PNG image from EPS assets using GhostScript on Windows
"C:\Program Files\gs\gs8.61\bin\gswin32.exe" -sDEVICE=pngalpha 
-dEPSCrop -dBATCH 

-dNOPAUSE -dNOPROMPT -dQUIET -sOutputFile=$PREVIEW.png $INPUT
If your workflow already generates a JPEG preview for an asset and saves it 
beside the asset named <assetfilename>_preview.jpg then you can access this 
preview using the following command line and make a copy for Cumulus: cmd 
/C copy $INPUT_preview.jpg $PREVIEW

To have the new format available for Asset Handling Sets you have to add it to the 
Asset Formats list: 

1. Click the Asset Formats tab and click Add.The Add Format dialog opens.
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2. Expand the Generic Filter entry by clicking on the plus sign on its left. The for-
mats available are displayed.

3. Select the format you want to add and click OK. 

New formats are placed at the end of the list by default. Use the arrow buttons to the 
right of the list to move the format, if necessary.

TIP: Cataloging & Files Extensions

If anything goes wrong while cataloging, check the file extension!
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Cumulus Asset Actions
Cumulus Actions simplify daily workflow needs. An Asset Action refers to a combina-
tion of certain functions and can be saved under a chosen name. Whenever you wish 
to perform this combination of functions, all you need to do is select the correspond-
ing action and it will be done. An Asset Action can include three different types of 
functions: Processing, Packing, Delivering

Firstly, you can have the selected assets processed, then you decide whether the result 
of this process should be packed into one file and finally, you define where this file 
should be delivered. By default the delivery destination is the file system and the only 
packing possibility is the ZIP AssetStore. 
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Processing

Defining a processing module for an Action is optional. Processing modules will 
always produce as many files as records were selected for the Action. For process-
ing, a list of possible modules is provided from which you can choose the module 
you want to use. (For descriptions of the modules, see “Asset Processor Modules” 
.) If you select more than one processing module for an Action, the sequence is 
important. 

NOTE: The sequence of the processing modules must make sense. For example, 
having the Zip AssetProcessor as the first processing module and then using the 
Pixel Image Converter to produce JPEG files does not make any sense. However, 
doing it the other way around is fine. Then you will get one ZIP file for each 
selected record and each ZIP file will contain a JPEG image.

NOTE: If an Asset Action that is intended to be used at the Cumulus Web Client 
includes either the Pixel Image Crop Processor or the Pixel Image Template Crop 
Processor, make sure that this processing module is always the first in the 
sequence. Otherwise, the Asset Action won’t work properly.

Packing

Packing modules pack the selected assets (or the files resulting from the process-
ing) into one file. For example: if you have selected Pixel Image Converter for pro-
cessing (to produce TIFF files) and then Zip AssetProcessor for packing, the result 
will be TIFF files for each selected record packed in one Zip file. Another example 
that might sound odd but also might make sense in certain circumstances: if you 
have selected the Zip AssetProcessor for processing as well as for packing, the 
result will be Zip files for each selected record packed in one easy to handle Zip file. 
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NOTE: The sequence of the packing modules must make sense. For example, hav-
ing the Zip AssetProcessor as the first packing module and then using the PDF 
Page Merge AssetProcessor does not make any sense. However, doing it the other 
way around is fine. Then you will get one PDF compressed into a ZIP archive. 

Delivering

Defining a delivering module for an Action is not optional. You have to define a 
delivering module for every Action. 

Asset Handling Set

You can also select a specific Asset Handling Set to be used for the Action. If you 
don’t specify one, the Asset Handling Set will be used that is defined in the User 
Settings of the user who uses the Action. As this Asset Handling Set might have 
some modules not activated that are needed for the action, we recommend 
selecting a certain Asset Handling Set. (We strongly recommend this for Actions 
that are set up to be used by different users.) The Asset Handling Set selected for 
an Action should be a shared one and should be available for those you want to 
perform the Action on. And it should correctly support the modules chosen for the 
Action.

See “Overview: Cumulus Asset Actions”, for an overview of the options available for a 
Cumulus Action. 

You can either change existing Actions or create new ones – if you have the appropri-
ate permissions for changing or creating Actions. There are Actions for individual use 
and Actions that are shared with other users. Shared Actions are displayed in italics in 
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the list for selecting the one to be edited. You may have the right to define and cus-
tomize your individual Actions only or may even have the right to edit all Actions. 

Asset Actions are created and edited in the Preference dialog window ( Cumulus /
Edit > Preferences > Asset Actions.)

PRECONDITIONS: To view and modify Asset Actions, you must have the appropriate 
permissions (Server Permissions > Asset Actions Permissions.) 
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Creating an Asset Action
A new Asset Action is created by duplicating an existing one and adapting its settings: 

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Action to use as a basis for the new one.

4. Click Duplicate.

The Name and Settings dialog opens.

5. Enter a name for the new Action, and optionally:

• Activate the Allow Sharing option, if you want this action to be available to 
other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new Asset 
Actions).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new 
Asset Actions).

6. Click OK.

7. Define the new Action. (See “Overview: Cumulus Asset Actions”, for an overview 
of the options available.)

8. Click Apply to save your changes.
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Editing an Asset Action
To change an existing Asset Action:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Cumulus Action you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.

See “Overview: Cumulus Asset Actions”, for an overview of the options available for 
Actions. With Workgroup or Enterprise, Actions can only be defined by the Cumulus 
Administrator or by users who have the right to do this.

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Cumulus Actions by selecting the Customize entry in the submenu for 
selecting an Action. This entry opens the preferences for the current Action.
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Setting A Default Asset Action
You can define one Asset Action to be the default. This default is not used with any 
standard function of this Cumulus version but may be used by any additional function, 
e.g. provided by a third party partner.

The default Asset Action is denoted by bold characters in the list for selecting the 
Action. To set the default Action:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Action you want as default. This should be a shared 
Action (denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.
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Overview: Cumulus Asset Actions 
Asset Actions refer to a combination of certain functions. Asset Actions defined here 
can be selected when using the menu item Asset > Perform Asset Action, when 
emailing assets and in the Collection Basket.

Header (1 - 7)

1 Displays the selected Asset Action.

1 2 4
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65 7
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2 Opens a list of available Asset Actions for selection. Shared Actions are displayed in italics.
3 Opens the Properties dialog for the selected Asset Action – providing two tabs. On the 

Description tab you may enter or modify language-specific display names and descriptions. 
The Sharing tab allows you to define whether you want to share the Asset Action with others. 
Additionally you may restrict the usage to specific users or roles.

4 Opens a dialog to create a new Asset Action by copying the selected one.
5 Opens a dialog to rename the selected Asset Action. 

NOTE: When renaming a shared Action remember to update users’ permissions for this 
Action.

6 Deletes the selected Asset Action.
7 Sets the selected Asset Action as default.

General Tab (8 - 17)

File Formats
8 If activated, the asset action will be applied only to assets that match the file type(s) specified 

in the file formats list below. – If this option is not activated, the following items (9 - 13) do 
not apply.

9 List of file types that are handled by the asset action.
10 Opens a dialog to select more file types to add them to the list.
11 Removes the selected file type(s) from the list.
12 Defines what happens if the asset action is executed on assets that don’t match one of the 

file types defined in the list above. 
13 Select from the following options:
• Treat as error – Executing the asset action on an asset that does not match a specified file 

type, or on a collections of assets containing non-matching items, aborts the asset action. 
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NOTE: This setting is interpreted differently by different clients. 
The Cumulus Desktop Client always offers the asset action, even for non- matching assets or 
collections that contain non-matching assets. Executing the asset action, however, results in 
en error. 
The Cumulus Web Client and Cumulus Sites do not offer the asset action for non- matching 
assets or collections that contain non-matching assets.

• Skip erroneous asset – Trying to execute the asset action on a collections of assets con-
taining non-matching items, results in skipping the non-matching assets, while the asset 
action is properly executed on assets with matching file types.

• Skip processors only – Assets with non-matching file types are no processed, but down-
loaded (and packed, if applicable) anyway.

• Skip processors and packers – Assets with non-matching file types are neither processed 
nor packed, but downloaded anyway.

On Error
Defines what happens if an error occurs during the execution of an asset action (e.g., due to a 
mis-configured asset processor or a wrong sequences of asset processors, etc): 
14 If an error occurs, the whole asset action is aborted.
15 If an error occurs, the erroneous asset is skipped, but the asset action is continued.

Additional Properties
16 Enables selecting a special Asset Handling Set to be used with the Action. If not enabled, the 

Asset Handling Set will be used that is defined in the User Settings of the user who uses the 
Action.

17 Displays the selected Asset Handling Set. 

IMPORTANT!  Make sure that the selected Asset Handling Set is available for those 
users you want to use the action and that it correctly supports the modules chosen 
for the Action.

18 Opens a list of available Asset Handling Sets for selection.
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Delivering
19 Displays the selected delivering module.
20 Opens a list of available delivering modules for selection.

If you select the URL AssetStore, the resulting file(s) will be uploaded to FTP (and HTTP). To 
determine the URL, click Properties (19.)

21 Opens a window to set parameters for the selected delivering module when used with the 
Action.

NOTE: If the Delivery module is the File System AssetStore, You can have the asset that 
derives from an Asset Action cataloged automatically. Note that the new asset can be cata-
loged only to a catalog that is open in the current collection when the Action is performed. If 
no packing module is included, the new asset will be determined as a variant. To have auto-
matic cataloging, activate the Catalog Resulting Files option in the File System Support 
Parameters dialog. The Settings button enables you to select a catalog as well as an Asset 
Handling Set for the cataloging and, with Enterprise only, a Permissions Template.

22 If checked, the delivering module will display dialogs (e.g. for choosing properties) when the 
action is performed.
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Process Tab

Processing
1 Lists the processor(s) selected for the Action. 

IMPORTANT!  Make sure that the sequence of the processing modules makes 
sense. 

1 2

12

14

15

13

10 11

3

54 6

7 8

9
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2 If checked, the processor will display dialogs (e.g. for choosing properties) when the action is 
performed.

3 Use these buttons for ordering the sequence of the processing modules.
4 Opens a window to set the parameters for the selected processor for the action when used 

with the Action. (Disabled if no properties available.)
5 Opens a dialog to select the processor(s) to be added.
6 Removes the selected processor.

Packing
7 Lists the selected packing module(s).
8 If checked, the packing module will display dialogs (e.g. for choosing parameters) when the 

action is performed.
9 Opens a window to set parameters for the selected packing module when used with the 

Action.
10 Opens a list of available packing module(s) to be added.
11 Removes the selected module.
12 Opens a list of available file formats to be added to the list.
13 Removes the selected file format from the list.
14 Displays how files of formats that are not specified in the list are treated.
15 Opens a list of available options for not-listed files.
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Metadata Templates
Metadata Templates are used to add information to the metadata information that is 
stored on an asset or a category. To make use of such a template, you can either use 
it while cataloging (along with an Asset Handling Set or the Prefiller Utility) or apply 
the metadata information to records of already cataloged assets. For a description on 
how to use Metadata Templates to apply metadata information to the records of 
already cataloged assets, see “Using a Metadata Template” . For a description on how 
to use Metadata Templates while cataloging, see “Employing the Metadata Editor” .

For defining a Metadata Template you can select record fields that should be filled 
when the Metadata Template is employed. These record fields can be all available field 
types except Binary fields. Clicking the Add button reveals a list of all available fields 
(provided by filters or by currently opened catalogs). For each field added to the tem-
plate, you can enter a value. For String fields you can also define whether you want the 
new text to replace the existing value or to be appended to the existing text. Clicking 
in a String field’s entry in the column Fill Mode allows you to select the desired mode. 
For all other field types, the entered value will replace the existing value. For date field 
types, the current date is shown initially. illustrating the date format to be entered. A 
date may be entered manually in the given format or selected with a date picker.

To have a field filled when the Metadata Template is used, the Use option for the field 
must be enabled.

You can either change existing templates or create new ones – if you have the appro-
priate rights for changing or creating templates. There are templates for individual use 
and templates that are shared with other users. Shared templates are displayed in ital-
ics in the list for selecting the one to be edited. You may have the right to define and 
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customize your individual templates only or may even have the right to edit all tem-
plates.

Metadata Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Metadata Templates.)

Additionally, performing a copy operation on a record or a category creates a tempo-
rary Metadata Template prefilled with the respective item’s current metadata which 
can be pasted to other items or saved as a new Metadata Template using the Bulk Edit 
window

PRECONDITIONS: To view and modify Metadata Templates, you must have the appro-
priate permissions (Server Permissions > Metadata Templates Permissions.) 
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Creating A Metadata Template
A new Metadata Template is created by duplicating an existing one and adapting its 
settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the Metadata Template to be used as the basis 
for the new one.

4. Click Duplicate. The Name and Settings dialog opens.

5. Enter a name for the new template and optionally 

• Activate the Allow Sharing option, if you want this template to be available to 
other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new templates).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new tem-
plates).

6. Click OK.

7. Define the new Metadata Template. (See “Overview: Metadata Templates”, for an 
overview of the options available.)

8. Click Apply to save your changes.
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Editing A Metadata Template
To change an existing Metadata Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the template you want to edit.

4. Make the changes. (See “Overview: Metadata Templates”, for an overview of the 
options available.)

5. Click Apply to save your changes.

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Metadata Templates by selecting the Customize entry from the list for 
selecting Metadata Template (e.g. in the Asset Information window). This entry 
opens the preferences for the current Metadata Template.
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Setting A Default Metadata Template
You can define one Metadata Template to be the default template. This default is not 
used with any standard function of this Cumulus version but may be used by any addi-
tional function, e.g. provided by a third party partner.

The default set is denoted by bold characters in the list for selecting a set. To set the 
default set:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the template you want as default. This should 
be a shared template (denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.
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Overview: Metadata Templates 
Metadata Templates are used to add information to the metadata information that is 
stored on an asset or a category. Each Metadata Template lists the affected fields, 
together with the respective values and the fill mode to be used. There are separate 
tabs for record fields and for category fields. Metadata Templates can be used while 
cataloging or for applying metadata information to records of already cataloged 
assets.

1 2 3 4 6 7

8

9 10

5

12

15

11

14

13
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Header (1 - 7)

1 Displays the selected Metadata Template.
2 Opens a list of available Metadata Templates for selecting one. Shared Metadata Templates 

are displayed in italics.
3 Opens the Properties dialog for the selected template – providing two tabs:

On the Description tab you may enter or modify language-specific display names and 
descriptions.
The Sharing tab allows you to define whether you want to share the template with others. 
Additionally you may restrict the usage to specific users or roles.

4 Opens a dialog to create a new Metadata Template by copying the selected one.
5 Opens a dialog to rename the selected Metadata Template.

NOTE: When renaming a shared template remember to update users’ permissions for this 
template.

6 Deletes the selected Metadata Template.
7 Sets the selected Metadata Template as default.
8 Tabs to switch between record metadata and category metadata. Both tabs provide the 

same columns.

Fields (9 - 15)

The Fields section contains a list of the fields that are included in the Metadata Template The list 
provides several columns
9 Use – Activate this option for each field that should be filled or modified when the Metadata 

Template is used.
10 Field Name – Name of the field that should be filled or modified.
11 Value – Displays the value that will be filled in. Click a value to modify it or enter a new one. 
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NOTE: For date field types, the current date is shown initially, illustrating the date format to 
be entered. A date may be entered manually in the given format or selected with a date 
picker.

12 If a field of type String List is selected, the arrow opens a list containing the values of the 
String List field. 

13 Fill Mode – Defines how the new value will be applied (default: Replace). Depending on the 
field type, several possibilities are offered: Replace, Set if Empty, Add, Remove, Insert Before, 
Insert After, Clear Value. Click the Fill Mode entry for any field to get a list of available options.

14 Opens a list of available fields. Available fields are the fields that are provided by filters or by 
currently opened catalogs (except Binary fields). Select the field(s) you want to add and click 
OK.

TIP: Prefill Record Fields
The list of fields contains an entry Fields of record XYZ, where XYZ is the name of the 
currently selected record. Selecting this entry will add all valid record fields to the 
metadata template and prefill them with the values from the current record. 

15 Removes the selected field from the template.
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TIP: String List Fields with Different Values

When adding fields that are contained in more that one of the catalogs you 
have access to, be carefully with string list fields that seem to be identical (same 
GUID), but have different string list values. Cumulus gives you the impression 
that you can select the catalog from which you want the field to be added via 
the Catalogs module. However, this is not the case — actually, Cumulus takes 
the field (and its values) from the catalog that was opened last at the server, not 
from the catalog you have selected. Therefore the metadata template will 
probably not include the string list field values that you want to be included 
(the ones from the catalog you have chosen as the origin of the field to be 
inserted). As a consequence, the new or modified Metadata Template will work 
only for the catalog from which Cumulus has taken the field values.
However, if you are in that situation to have two seemingly identical, but in fact 
different fields (same GUID, but different string list values), there is a work-
around that helps to get exactly the field and the values you want to add to a 
Metadata Template:
Create a special user just for creating/modifying metadata templates. This user 
may have permissions for one catalog only — the catalog from which you want 
to take the field. Then log in as this user and add the respective field to the 
Metadata template. Because the user can access one single catalog only, the 
field and its values will always be taken from this specific catalog.
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Print Templates 
Cumulus provides enhanced print options for printing records. The different combi-
nation of print options can be combined and saved as Print Templates. Print Tem-
plates make it easy to select print options that are set up for certain views or tasks. 
Once Print Templates have been appropriately defined to meet differing demands, 
the user can easily select them for printing records.

If you have the appropriate rights, you can extensively customize most templates. 
There are Print Templates for individual use and templates that are shared with other 
users. Shared templates are displayed in italics. 

A Print Template defines how records will be printed. Print Templates include defini-
tions for the document layout (page size and orientation, as well as margins) and the 
layout of the records to be printed. To serve as print layout for the records, you can 
either use a Record View Set or define advanced print settings. 

The advanced print settings allow you to specify how the printed records will appear 
on the page. They include options for: 

• the grid to be used (e.g number of rows and columns)
• the thumbnail (e.g. alignment and resolution)
• the fields to be included in the print-out of each record (including font selection)
• the header and footer text (including font selection)
• PDF creation (PDF security settings and enabling Cumulus Web Client/Sites URL-

link feature)
When defining advanced print settings for a Print Template, a Preview function 
enables you to check the result of your settings. You can see just what a page looks 
like before deciding to save the template.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS PRINT TEMPLATES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Print Templates can be used when printing records (File > Print.)

Print Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Print Templates.)

PRECONDITIONS: To view and modify Print Templates, you must have the appropri-
ate permissions (Server Permissions > Print Templates Permissions.) 
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Creating and Editing a Print Template
A new Print Template is created by duplicating an existing one and adapting its set-
tings:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the Print Template to be used as the basis for the new 
one.

4. Click Duplicate. The Name and Settings dialog opens.

5. Enter a name for the new template and optionally –

• Activate the Allow Sharing option, if you want this template to be available to 
other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new print tem-
plates).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new print 
templates).

6. Click OK.

7. Define the new Print Template. (See “Print Templates”, for an overview of the 
options available.) 
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TIP: Preview Your Settings Before Saving

If you define advanced print settings, use the Preview function to check your 
settings before you save them.

8. Click Apply to save your changes.

TIP: Previewing a Print Template including Live Previews of Images

If you want to check the result of your settings with live previews of images, you 
should select these images before you open the preference dialog. Select at 
least as many images as needed to fill the intended grid cells of one page.

To change an existing Print Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the template you want to edit.

4. Make the changes. (See “Overview: Print Templates”, for an overview of the 
options available.) 

TIP: If you define advanced print settings, use the Preview function to check your 
settings before you save them. 

5. Click Apply to save your changes.
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Setting A Default Print Template
You can define one Print Template to be the default template. This default is not 
required by any standard function of this version of Cumulus, but may be used by 
additional functions, such as those developed by third party partners. The default tem-
plate is denoted by bold characters in the list for selecting a template. 

To set the default template:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the template you want as default. This should be a shared 
template (denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.
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Overview: Print Templates
A Print Template stores a specific combination of print options. It can be used when 
printing records. Print Templates are created and edited in the Preference dialog win-
dow ( Cumulus / Edit  > Preferences  > Print Templates. 

Header (1 -7)

1 Displays the selected 
Print Template.

2 Displays a list of 
available Print Tem-
plates for selection. 
Shared Print Tem-
plates are displayed 
in italics.

3 Opens the Properties 
dialog for the 
selected template – 
providing two tabs. 
On the Description tab you may enter or modify language-specific display names and 
descriptions. The Sharing tab allows you to define whether you want to share the template 
with others. Additionally you may restrict the usage to specific users or roles.

4 Opens a dialog to create a new Print Template by copying the selected one.
5 Opens a dialog to rename the selected Print Template.

NOTE: When renaming shared templates, remember to update users’ permissions for the 
template.

1 2 4 5 6 7

8

9
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6 Deletes the selected Print Template.
7 Sets the selected Print Template as default.

Document Settings Tab (9 - 10)

The Document Settings tab defines the layout for the entire document.
8 Paper Setup settings define the paper size: either a standard size or a custom size for which 

the width, height and measurement unit can be defined.

NOTE: The Units selected here refer to all measurements of the template.

9 Orientation defines the orientation for the output (portrait or landscape).
10 Margins settings define the margins for the page layout.

Layout Tab

The Layout tab defines the layout for the printed records. You can either use a Record View Set 
for the layout, or define advanced print settings.
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Layout Definitions
11If activated, a Record 
View Set is used for the 
layout.
If Record View Set 
Defines Layout is acti-
vated, you can choose:
12The current Record 
View is used for layout. 
13A specific Record View 
from a a specific Record 
View Set is used for lay-
out. You can select the 
Record View Set and the 
view to be used.

NOTE: If a Record View 
Set defines the layout 

and if you have activated the print option Print Entire Assets as Thumbnails in the Printing tab 
and set the thumbnail size to 1024 in the Display tab of your User Settings, the records’ thumb-
nails will be printed in high-resolution, so the printouts can serve as contact sheets. This may 
take a while as each of the thumbnails has to be created.

14 If activated, you can define Advanced Print Settings for the layout.
If Advanced Print Settings Define Layout is activated, you can:

15 Select the item you want to define for layout.

12

14
13

15

11
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Advanced Print Settings

If Advanced Print Settings Define Layout is activated on the Layout tab, you can 
define various layout options. The options are grouped by topic items and repre-
sented by icons. 

Select the corresponding icon to define your layout.

• Grid 

The grid determines how many records can be printed on one page. 

Grid Layout
The number of columns and rows defines the amount (and size) of cells. Each cell contains a 
record. The grid shrinks to fit into the space left by the defined margins and spacing. 

Grid Inset Margins / Spacing between Cells
For an overview of the margins and spacing, see “Margin Settings” .

Additional Options
• Background Color: Determines the background color for the entire pages except the areas 

around the image and for the field information. (See also “Background Colors” .)
• Draw Border around Each Cell: Activate this option to have a frame drawn around each 

cell.

• Images

Each image, regardless of size, is scaled in proportion to fit to one cell. 

Printed Image Options
• Alignment: Determines the alignment point for the image with respect to the cell.
• Background Color: see “Background Colors” 
• Outer Margin: see “Margin Settings” .
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• Use entire assets at: Determines whether the entire asset should be used for printing and 
the highest resolution an image should be printed with. (The resolution for the printout can-
not be higher than that of the original.) 
Using the thumbnails is faster but using the entire assets lets you choose the dpi and so you 
can decide on the quality. Using the entire assets also lets you choose the JPEG quality.

• Use thumbnails: Determines whether the thumbnail should be used for printing an image. 
• Apply Asset Action: Activate this option to select an Asset Action to be performed, e.g. to 

watermark printed thumbnail
• Draw border around each image: Activate this option to have a frame drawn around each 

image.

• Fields

Fields Shown
Under Fields Shown define the fields which values you want to have included in the printout.
To add fields click Add. This opens a list of available fields. 
To define the display properties of a field, select the field and click Properties. 

Additional Properties
Properties concerning the layout of all displayed fields are set under Additional Properties.
• Alignment: Determines the display position for record field values – depending on Show 

Field Names activated or not. If Show Field Names is activated, the alignment point is the 
ending of the longest field name.

• Align to Image: Determines the display position with respect to the image. 
• Margin to Image, Outer Margin and Line Spacing: see “Margin Settings” .
• Background Color: see “Background Colors” 
• Show Field Names: Activate this option to have the field names displayed along with the 

field value.
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NOTE: Space for Displaying Field Information
Each image is scaled in proportion to fit to one cell. Only the space left in a cell is used to show 
field information. Take this into consideration when selecting the fields and defining their dis-
play properties. The image takes precedence over the field information. If an images fills a cell, 
the record field information will not be shown.

• Header and Footer

The header and footer are printed at the top or bottom of each page throughout the print out-
put. Headers and footers can include individual text and automatic text – for example, page 
numbers, the date, the catalog's name, or the user name. The text can be formatted.

1Opens a dialog for defining the font attributes for 
the selected text.
2Applies bold formatting to the selected text.
3Applies italic formatting attribute to the selected 
text.
4Applies underline formatting to the selected text.
5Open a menu to select a placeholder for inserting 
automatic text or a small image at cursor position in 
the header or footer text. 
Automatic text is provided for common header or 
footer items, such as running total page numbers 

(Page 1 of 10), time and date. You can also include the name(s) of the catalog(s), the Login 
name of the user who uses the Print template or the name of the computer running your 
Cumulus Server.

NOTE: You can also define your own placeholders for headers and footers. If you enter a 
word beginning with the % character (e.g., %project), Cumulus will open a dialog that asks 
you to fill this placeholder when a print process is started that uses this template.

1 2 3 4
5

6

6
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6 Ruler that displays the tab stop positions and right document margin. The measurement unit 
for the ruler is the unit selected in the Document Settings.
To insert a tab stop, click on the position where you want it.
To move a tab stop, drag the tab marker to the right or left on the horizontal ruler.

• PDF Options

Cumulus requires no additional software to generate print output as PDF. The gener-
ated PDF documents can even include links to access the records via Internet. If you 
have a Cumulus Web Client installation, you can take advantage of the URL-link fea-
ture. 

To allow the creation of a PDF document, you must activate the Allow PDF Printing 
option in a Print Template. This enables a user to choose the Print to PDF option when 
the template is selected for printing. If the user chooses Print to PDF and the Allow 
changes to PDF settings when printing option was set in template, the dialog PDF 
Print Settings opens where several PDF options can be determined. The further PDF 
Print Options set in the template serve as pre-settings which can be changed in this 
dialog.
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Chart on PDF options interrelations 

The Print Template determines whether a PDF 
can be created in general. And it can have PDF 
options set that serve as pre-settings for the 
final PDF Print Settings.

Dialog for defining PDF Print Settings when creating a 
PDF (only available when in the Print Template used for 
printing the Allow changes to PDF settings when 
printing option is activated.)
The PDF options set in the Print template serve as pre-
settings for this dialog.

enables

opens 
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For PDF creation the following options can be pre-set in a Print Template:

• Allow Web Solutions URL-Link Feature
If the records derive from catalog(s) that are published on the Internet, you can use 
this option to include links to the records in the PDF. 
• In the field Web Solutions Base URL enter the path to your Cumulus Web Client 

installation application:
http://[Web server address]/webclient for Web Client 
(e.g.: http://123.45.67.89:8080/webclient). 

• Embed user comments as annotations 
If activated, user comments contained in the selected records are embedded into 
the generated PDF file as PDF annotations.

• Enable PDF Security
When creating PDF files you can use password security to add restrictions that can 
prevent a file from being opened, printed or edited. Passwords can only be set 
when creating the PDF document. (For details, see “Record Printing to PDF with 
Cumulus” .) For details on the PDF security options that can be pre-set with a Print 
Template, see table below.
PDF security options that can be pre-set in a Cumulus Print Template are:

PDF Security Option If the option is activated, users can 

Allow printing in high resolution print the document in any resolution

Allow printing in low resolution print the document at resolution no higher than 150-dpi 

Allow document changes change the document (including assembling and filling in forms as 
well as adding digital signatures)
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• Preview

Provides a preview reflecting the current status of the print template. Use this function to check 
your settings before you save them (by clicking Apply or OK.) 

TIP: Resize the Preference window to see the preview sized to your needs. 

• Use live previews of selected records: Activate this option to see the defined template with 
live previews of images. However, depending on the images’ sizes and resolutions this may 
be time consuming.

• Use entire asset: Activate this option to have the preview generated from the entire asset 
instead from the thumbnail. (Only available if the Use entire assets at ... option is selected 
in the Images section.) 

Allow document assembly assemble the document (insert, rotate, or delete pages as well as cre-
ate bookmarks or thumbnail pages), even if Allow Document 
Changes is not set.

Allow content copying or 
extraction

copy and extract document’s contents (text and graphics)

Allow content copying or 
extraction for screen readers

use screen reader devices for copying or extracting document’s con-
tents only. Visually impaired users are allowed to read the document 
with screen reader devices in any case. This option adds the permis-
sions to copy and extract.

Allow modifying annotations can add and edit comments as well as form fields and digital signa-
tures

Allow filling in forms and signing fill in forms and add digital signatures only. 

PDF Security Option If the option is activated, users can 
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TIP: Previewing a Print Template including Live Previews of Images 
If you want to check the result of your settings with live previews of images, you 
should select these images before you open the preference dialog. Select at least as 
many images as needed to fill the intended grid cells of one page. 

• Background Colors

Background colors are defined by settings on the Grid, Images and Fields tab.

Margin Settings

The following example shows a page layout whose grid is set to two columns and two 
rows. Which makes four cells printed on a page. The grid shrinks to fit into the space 
left by the defined margins and spacing. The size of the cells depends on the size of 
the grid. Each image, regardless of size, is scaled in proportion to fit to one cell. The 
space left in a cell can be used to show field information. 

Grid Image 
Fields
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• Example

This example indicates 
the margins and spacing 
you can define by arrows. 
The height of the header 
and footer is defined by 
the text (font and lines) 
entered in the Header & 
Footer section. 
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Record Printing to PDF with Cumulus
For printing records Cumulus offers the possibility to print to PDF. To generate print 
output as PDF no additional software is required. The PDF documents can even 
include links to access the records via the Internet. If you have an installation with a 
Cumulus Web Solution, you can take advantage of the URL-link feature.

To make use of the Cumulus PDF printing feature you have to use a Print Template for 
printing that uses the advanced print settings which are set to allow printing to PDF. 

If you select a Print Template for printing records that allows PDF printing, you can 
choose to have the output saved as a PDF file. 

If the Print to PDF File and the Allow changes to PDF settings when printing options 
were set in template, clicking on the Print button opens the PDF Print Settings dialog. 
The various options are pre-set as defined in the current Print Template. Only the pass-
word options are not pre-set to prevent them to be set by mistake or/and nobody can 
remember the passwords.
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Web Solutions URL-Link Feature
If the records derive from catalog(s) that are published on the Internet, you can use 
this option to include links to the records in the PDF. Activate the Allow Web Solu-
tions URL-Link Feature option and in the field Web Solutions Base URL enter the 
path to your Cumulus Web Client application:
http://[Web server address]/webclient for Web Client 
(e.g.: http://123.45.67.89:8080/webclient) 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUSTOMIZING CUMULUS PRINT TEMPLATES

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

PDF Security
PDF security can be compared with home security. Just as you lock your doors to pre-
vent others from entering your house without permission, you may use the various 
security features to “lock” PDF documents. For example, you can add passwords to 
restrict users from opening a PDF document, or they can prevent users from printing 
or editing a document. 

A PDF file can have two kinds of password: a Document Open password and a Permis-
sions password. If you are restricting printing and editing, you should add a Document 
Open password to enhance security. 

• Opening the document with the correct Permissions password allows full access 
to the document. This unlimited access includes the ability to change the docu-
ment’s passwords and access permissions. 

• Opening the document with the correct Document Open password allows addi-
tional operations to be performed according to the set PDF security options.

With Enable PDF Security activated but Document Open and Permissions passwords 
not specified, the document will be encrypted, with user-level access, and a random 
Permissions password is generated; the user will not be prompted for a password, but 
nobody can have full access to the document.

With Enable PDF Security activated but only the Document Open password speci-
fied, a random Permissions password is generated, the document will be encrypted 
and the user will be prompted for a password. Again, nobody can have full access to 
the document. If both passwords are specified, the document will be encrypted and 
the user will be prompted for a password; depending on the password entered, the 
user can have full access, or only restricted access to the document. 

For details on the other options, see “PDF Security Option” .
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Crop Templates 
Optional feature! May not be available with your Cumulus configuration.

Crop Templates are used for generating renditions of image assets that are distributed 
via the Media Delivery Cloud (MDC), or via Media Delivery on Premise (MDO). 

Additionally, crop templates are used with the Pixel Image Crop Template Processor 
to convert assets (see Cropping Image Assets with Templates).

There are 2 types of crop templates:

• Focus Areas crop templates are used to automatically crop each asset delivered 
via the MDC or MDO. They define the output parameters (size and aspect ratio) 
of the resulting rendition, and additionally the position of the Region of Interest 
within the result. The cropping functionality takes into account these values and 
the Region of Interest defined on individual assets to determine the proper crop 
area with an algorithm.

• Crop templates for manual cropping define cropping rules, or constraints, such 
as the aspect ratio or the size of the cropped area, as well as output parameters 
(size and aspect ratio of the resulting rendition). Such templates must be applied 
manually to individual asset. At the same time, the user specifies the exact posi-
tion of the crop area on the asset (and it’s size and aspect ratio, if they are not 
defined in the selected template).

Crop Templates are created and edited in the Preferences dialog( Cumulus / 
Edit > Preferences  > Crop Templates.)

Configured Focus Area crop templates are automatically synchronized to MDC with 
every request sent to MDC (e.g. by Trigger Action or Scheduler task),.
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PRECONDITIONS: To view and modify Crop Templates, you must have the appropri-
ate permissions (Server Permissions > Crop Templates Permissions.) 
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Creating and Editing Crop Templates
A new Crop Template is created by duplicating an existing one and adapting its set-
tings:

1. Select Cumulus / Edit > Preferences. 

2. Click Crop Templates.

3. Under Crop Template, select the one you want to be the basis for the new one.

4. Click Duplicate. The Name and Settings dialog opens.

5. Enter a name for the new template and

• Activate the Allow Sharing option to make the template available for the Media 
Delivery Cloud (MDC) and Media Delivery on Premise (MDO), or if you want it to 
be available for other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new crop tem-
plates).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new crop 
templates).

6. Click OK.

7. Define the settings of the new Crop Template (see Overview: Crop Templates for 
an overview of available options).

8. Click Apply to save your changes.
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To change an existing Crop Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Crop Templates.

3. Under Crop Template, select the one you want to edit.

4. Make the changes. (See “Overview: Crop Templates” for an overview of available 
options. 

5. Click Apply to save your changes.
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Overview: Crop Templates 
Crop templates are a means to determine the generation of renditions of images that 
will be delivered via the Media Delivery Cloud and the Media Delivery on Premise.

Additionally, crop templates are used with the Pixel Image Crop Template Processor 
to convert assets (see Cropping Image Assets with Templates).

In a crop template, you can define 

• the size and the aspect ratio of the area that shall be cropped in an image, 
• the size and aspect ratio of the resulting cutout, and
• where Region of Interest defined on an image shall be placed within the resulting 

rendition. 

NOTE: A Region of Interest can be defined on the preview of a file in the 
Cumulus Web Client.

To set up Crop Templates, select Cumulus / Edit > Preferences and click 
Crop Templates. 
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Header (1 - 7)

1 Displays the selected Crop Template.
2 Opens a list of available Crop Templates. Shared Crop Templates are displayed in italics.

16

1 2 3 4 5 6

8

9

16

12

11

18

17
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13

14 15
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3 Opens the Properties dialog for the selected template – providing two tabs. On the Descrip-
tion tab you may enter or modify language-specific display names and descriptions. The 
Sharing tab allows you to define whether you want to share the template with others. Addi-
tionally you may restrict the usage to specific users or roles.

4 Opens a dialog to create a new Crop Template by copying the selected one.
5 Opens a dialog to rename the selected Crop Template.

NOTE: When renaming a shared templates, remember to update user permissions for this 
template, as needed.

6 Deletes the selected Crop Template.
7 Sets the selected Crop Template as default. 

Crop Area (8 - 12)

8 Focus area – If activated, the “Region of Interest” specified for an image asset is taken into 
account by the cropping process and included in the resulting image. – For assets without a 
specified Region of Interest, the whole image is considered as Region of interest.

9 Position region of interest in result – If activated, you can define the approximate position 
of the Region of Interest within the resulting cutout from the original image (top, bottom, 
right, left, center, etc.). If not activated, the region of interest is always centered.

The following options apply to manual cropping only!
10 Enforce aspect ratio – If activated, the cropped area always has the specified aspect ratio. 

Size and position within the image must be specified manually.
You can freely define the aspect ratio.

11 Enforce crop size – If activated, the cropped area always has the Width and Height defined 
here. The actual position of the cropped area within the image must be specified manually.

12 User defined – Aspect ratio, size and position of the area to be cropped must be specified 
manually.
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Crop Editor Option(13)

(Only relevant for manual cropping - not available if Focus area is selected!)
13 This template can have multiple parameter sets – If activated, you can define multiple 

parameter sets for this template, using the crop editor of the Cumulus Web Client. Each 
parameter set is identified by the template ID and an additional number.

14 Group – Crop templates can be ordered in groups. Selecting a Group from the drop-down list 
of available groups, or creating a new group, immediately assigns the current crop template 
to this group.
A crop templates can be assigned to one group only. Removing the last, or only, member 
from a group also deletes the group itself – you can’t have empty groups.

15 This template is master in it’s group – This option is activated by default for new tem-
plates. Deactivate it to make the current template a non-master.
A group can have any number of master and non-master templates. Non-master templates 
are restricted in that they can only be used with a specific asset, if a master template of the 
same group has already been applied to that asset before. 

Output Size of Cropped Area (14-16)

16 Same as cropped area – If activated, the size of the resulting cutout (in pixel) is identical 
with the size of the cropped area.

17 Set manually – If activated, the size of the resulting cutout (in pixel) must be defined manu-
ally. If the cropped area is larger in size, it will be scaled down.

18 Enforce output size – If activated, the resulting cutout will always have the Width and 
Height defined here. 
Additionally, you may activate the Keep the aspect ratio option. The resulting image will 
have the same aspect ratio as the cropped area. In this case, the defined values for Width 
and Height will be adapted accordingly. – Only available if either the Enforce aspect ratio 
or the Enforce crop size option is selected
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Sub-Pane Filters
Sub-Pane Filters provide enhanced support for managing related assets. The panes of 
the split view display certain assets only. Assets that are related to the assets selected 
in the main pane. Which assets are displayed is determined by the option selected in 
the pane’s display drop-down list. This option defines how they are related. Sub-Pane 
Filters make it easy to set up such options. Each Sub-Pane Filter is a list option in the 
sub-panes’ display list. Cumulus provides various pre-configured Sub-Pane Filters that 
should suffice most needs but you can also create your own Sub-Pane Filters. 

Sub-Pane Filters are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Sub-Pane Filters.)

PRECONDITIONS: To view and modify Sub-Pane Filters, you must have the appropri-
ate permissions (Server Permissions > Sub-Pane Filters Permissions.) 

Once you have set up the Sub-Pane Filters as needed, you assign them to users. So you 
can provide individual menus to your users. The availability of Sub-Pane Filters for 
users is defined with the User Manager in each user’s properties. (File > Administra-
tion > Server Console > User Manager > User/Role Properties > Sub-Pane Filters.)
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Creating and Editing a Sub-Pane Filter
A new Sub-Pane Filter is created by duplicating an existing one and adapting its set-
tings:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the Sub-Pane Filter to be used as a basis for the new one.

4. Click Duplicate. The Name and Settings dialog opens.

5. Enter a name for the new filter and optionally

• Activate the Allow Sharing option, if you want this filter to be available to other 
users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new sub-pane 
filters).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new sub-
pane filters).

6. Click OK.

7. Define the new Sub-Pane Filter. The settings define what will be displayed in a 
sub-pane for related assets view.

Choose the relation between the selected record(s) and the records displayed in 
the sub-pane by selecting a relation type from the drop-down list. For details on 
relations types, see “Relation Types” .)
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Then choose the level of relation.

• First Level only: Only directly related, contained or referenced assets are dis-
played. (Example use: to see the assets contained in a ZIP file only and not the 
assets that may be contained in these assets.) 

• Last Level only: (Example use: Remember, an image can be a variant of a source 
but it itself is also the source of another variant. But you don’t care whether the 
selected record in the main pane is a variant of another variant. You are only 
interested in the top level variant source (the origin) and that’s what you want 
to see in the sub-pane.)

• All Related Assets: The records of all related assets are displayed regardless of 
whether the relation is direct or indirect.

If you want to have only Pages and Slides or Video shots displayed in the sub-
pane, activate the Further ... option and select include only from the drop-down 
list. Then activate the asset type that you want to be displayed only.

If you don’t want to have Pages and Slides or Video shots displayed in the sub-
pane, activate the Further ... option and select exclude from the drop-down list. 
Then activate the asset type that you don’t want to be displayed.

If you want the displayed result to be based on selected records only, you can 
include a record query in the settings of the Sub-Pane Filter. To do so, activate the 
Use Additional Query option. The Use Query and Use File buttons are enabled. 
Click Use Query or Use File. A dialog for selecting the corresponding query will 
open. Select the query you want to apply as filter option and click OK/Select.

NOTE: Make sure to select a query that does not contain placeholders! 

The query is saved with the filter settings and the search conditions of the query 
are displayed. Note that the data of the query is saved with the Sub-Pane Filter 
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and if you change the query later on, the Sub-Pane Filter will not be changed 
accordingly.

NOTE:  If you cannot open the default folder for storing queries, it may be due 
to its folder properties. If the folder properties are set to Hidden, this folder cannot 
be addressed by the Select dialog. Then you either have to change the folder 
properties or save the queries to another location that you can access. 

8. Click Apply to save your changes.

To change an existing Sub-Pane Filter:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the one you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.
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Setting A Default Sub-Pane Filter
You can define one Sub-Pane Filter to be the default. This default is not required by 
any standard function of this version of Cumulus, but may be used by additional func-
tions, such as those developed by third party partners. The Sub-Pane Filter is denoted 
by bold characters in the list for selecting a filter. 

To set the default Sub-Pane Filter:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the one you want as default. This should be a shared one 
(denoted by italics).

4. Click Set as Default.

5. Click Apply to save your changes.
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Permissions Templates 
Permissions templates enable you to assign, remove or explicitly set individual asset 
or category permissions for users or entire groups at once. 

Optional feature! May not be available with your Cumulus configuration.

A Permissions Template includes permissions for records and categories. Depending 
on the context in which a template is used, either the record or category permissions 
will be used. With selected records, the defined record permissions will be used; with 
categories, the defined category permissions will be used.

IMPORTANT! Permissions Templates refer to individual record or category 
permissions only. Remember that these are always added to the permissions a 
user has in general for all records and categories of the catalog. A user’s permis-
sions cannot be reduced by individual record or category permissions. If a user 
is given an Application permission for the records or categories of a catalog, he/
she will have this permission – no matter whether this permission is set to be 
removed in a Permissions Template used. Only an individual record or category 
permission can be removed by a Permissions Template. 

Permissions Templates can be used in the Properties dialog window for records or cat-
egories. With records, they can also be used when cataloging assets or updating 
records. For cataloging, a Permissions Template is used when the cataloging user has 
access to at least one Permissions Template. Users who have access to more than one 
Permissions Template are prompted to select one for the cataloging process. 

Permissions Templates can also be used for auto-cataloging. This requires that the cat-
alog contains the Category field AutoSync Permissions Template.
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Permissions Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Permissions Templates.)

PRECONDITIONS: To view and modify Permissions Templates, you must have the 
appropriate permissions (Server Permissions > Permissions Templates Permissions.) 
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Creating and Editing Permissions Templates
A new Permissions Template is created by duplicating an existing one and adapting 
its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want to be the basis for the 
new one.

4. Click Duplicate. The Name and Settings dialog opens.

5. Enter a name for the new template and optionally

• Activate the Allow Sharing option, if you want this View Set to be available to 
other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new permis-
sions templates).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new per-
missions templates).

6. Click OK.

7. Define the new Permissions Template.

• Add the user(s) and/or role(s) to which you want to assign the record/category 
permissions by clicking the appropriate button (Add User or Add Role). (The 
Add User button is available only if you have the Browse for Users permission.) 
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These buttons open a corresponding dialog.
To add users, you can search for available users. The possible search criteria 
depend on the authentication method (see above). Default search criteria is the 
login name. Enter the search value (a matching string) and click Find. The result 
of this search is listed below. Select the user(s) you want and click OK. The users 
are added.
When adding roles, Cumulus will list the available roles. Select the role(s) you 
want and click OK. The roles are added.

• Select the user/role you want to assign permissions to.
• Activate the permissions you want to be set with this template. Then define for 

each activated permission whether it should be added to or removed from the 
permissions already given. (See “Overview: Permissions Templates”, for an over-
view of the options available. For more information on the permissions available 
with Cumulus, see “Catalog Permissions Tab” .)

8. Click Apply to save your changes.

To change an existing Permissions Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want to edit.

4. Make the changes. (See “Overview: Permissions Templates”, for an overview of the 
options available. For more information on the permissions available with 
Cumulus, see “Catalog Permissions Tab” .)
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5. Click Apply to save your changes.

TIP: Shortcut to Preferences

If you have the appropriate permissions, you can easily access the preferences 
of Permissions Templates by selecting the Customize entry in the list for select-
ing Permissions Template. This entry opens the preferences for the current Per-
missions Template.
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Setting A Default Permissions Template
You can define one Permissions Template as the default template. This default is not 
used by any standard function of Cumulus, but it can and might be used by custom 
program functions, such as those added by third party partners.

The default set is denoted in the templates list by bold characters. To set the default 
set:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want as default. This should be 
a shared one (denoted by italics).

4. Click Default.

5. Click Apply to save your changes.
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Overview: Permissions Templates 
Permissions Templates are used to set record and category permissions for selected 
records or categories. They can be used in the Properties dialog window for records or 
categories. With records, they can also be used when cataloging assets or updating 
records. 

To set up Permissions Templates, select Cumulus / Edit > Preferences and click 
Permissions Templates. 
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Header (1 -7)

1 Displays the selected Permissions Template.
2 Opens a list of available Permissions Templates. Shared Permissions Templates are displayed 

in italics.

1 2 3 4 5 6

8 9

13

1211

1514

7

10

16
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3 Opens the Properties dialog for the selected template – providing two tabs. On the Descrip-
tion tab you may enter or modify language-specific display names and descriptions. The 
Sharing tab allows you to define whether you want to share the template with others. Addi-
tionally you may restrict the usage to specific users or roles.

4 Opens a dialog used to create a new Permissions Template by copying the selected one.
5 Opens a dialog used to rename the selected Permissions Template.

NOTE: When renaming a shared templates, remember to update user permissions for this 
template, as needed.

6 Deletes the selected Permissions Template.
7 Sets the selected Permissions Template as default.

Permissions (8 - 16)

8 Indicates type: User or Role
9 Lists the names of users or roles the template will affect.
10 Opens a dialog used to select users. (Available only if you have the Browse for Users permis-

sion.)
11 Opens a dialog used to select roles.
12 Removes the selected user/role from the list.

• Record & Category Permissions, Asset Permissions

13 Activates the permission to be set. If a permission is not activated in a template it will not be 
set when the template is used. Then the existing permission remains untouched.

14 If activated, the permission will be added to the existing permission when the template is 
used.

15 If activated, the permission will be removed when the template is used. 
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NOTE: The permission will be removed only if it was set as individual record or category per-
mission.

• Table Specific Permissions

16 Use for advanced configurations only.
For more information on the permissions available with Cumulus, see “Catalog Permissions 
Tab” .
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Managing Catalogs

This chapter describes how to set the catalog settings to suit your needs and offers

some suggestions for effective cataloging strategies, also it covers some catalog main-

tenance issues.

The topics of this chapter include:

• Catalog Settings

• Administering Asset Relations

• Preparing Catalogs for Special Purposes

• Securing Catalogs

• New Catalogs

• Catalog Maintenance

• Using Server Console Modules

• Archiving Information
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Catalog Settings
Fundamental changes can be made to each catalog by modifying its settings. These 
settings have no effect on catalogs other than on the one for which they are set. It’s 
important to consider a catalog’s settings when the catalog is new, before you add 
records to it. 

PRECONDITIONS: To modify a catalog’s settings, you must have the appropriate 
Administrator permissions (Permissions > Administrator Permissions > Modify Cat-
alog Settings.) To view a catalog’s settings, you must have the appropriate Adminis-
trator permissions (Permissions > Administrator Permissions > View Catalog 
Settings.) 

To access the settings of a catalog: 

1. Make sure the collection window containing the catalog is the active window in 
Cumulus. If you have more than one catalog opened in the active collection win-
dow, the Catalog Settings window provides a list from which you can select the 
catalog you want to modify. 

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to modify under Cata-
log.

The settings for the selected catalog are displayed in the Catalog Settings win-
dow.
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The Catalog Settings allows to precisely configure the settings for a catalog. The avail-
able options are divided into the following sections:

• General – Catalog location and name, sharing options and options on a central 
location for the assets.

• Record Fields – Displays the record fields that the catalog contains. You can add 
or delete fields and customize selected fields. This allows you to organize the infor-
mation that can be stored on an asset in its record. Remember, metadata retrieved 
from assets while cataloging can only be stored if the corresponding record fields 
are included in the catalog.

• Category Fields – Displays the category fields that the catalog contains. You can 
add or delete fields and customize the fields.

• Relations – Displays the asset relation types available with the catalog. You can 
edit, add and remove relation types.

• Mirroring – Displays the current mirroring settings for the catalog. You can activate 
mirroring and define the database that serves as the mirror. (For more information 
on mirroring, see “Database Mirroring” .)

• Workflows – Display the workflows available with the catalog. You can add work-
flows stored at the Cumulus Server, update workflows that have been modified at 
the Cumulus Server, and remove workflows from the catalog.

• Permissions Summary – Shows what permissions each user or role has for the cat-
alog. You can only view the information, for editing you have to employ the User 
Manager of the Server Console.

Additionally, the Catalog Settings window provides buttons for saving the settings of 
the current catalog as a catalog template, and for copying permissions and triggers 
from another catalog to the currently selected one.
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See “Overview: Catalog Settings Window” for an overview of the options available 
from this window.
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Overview: Catalog Settings Window
The Catalog Settings window provides several tabs for different groups of options. The 
options are valid for the active/selected catalog only. They have no effect on other cat-
alogs.

1 The catalog whose settings are currently displayed. You can select any catalog available to 
you.

2 Button to save the settings of the current catalog as a catalog template.
3 Button to copy the permissions settings from a different catalog to the current one.
4 Button to copy the trigger settings from a different catalog to the current one.

NOTE: Copying permissions or triggers from a different catalog overwrites the respective setting 
of the current catalog!

5 Row of tabs for different option groups (details see below).

1 4

5

2 3
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General Tab 

Catalog
1Catalog file name and 
path (not editable).
2Catalog name. Defaults 
to file name, can be 
changed. (See “Renaming 
Catalogs”, for details. 
Note that catalogs cannot 
be renamed while set to 
use the Cumulus Vault in 
Always and Exclusive 
mode.)
3Displays the catalog for-
mat 
4Displays the catalog size 
(actual size/maximum 
size).

5 If activated, the name of a new category must differ from any existing category name.
6 If activated, journaling is employed for the catalog. (See “Journaling Catalogs”)

IMPORTANT!  Do not employ journaling and mirroring for the same catalog! Use 
one of these mechanisms depending on how the catalog is used.: (See “Securing Cat-
alogs”, for more information.) 

Sharing
7 If activated, the catalog is available to Cumulus Clients.
8 If activated, the catalog is available via the Web, e.g. for the Cumulus Web Client. 

1

4

5

8

7

6

2
3

9

12

1110
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IMPORTANT!  The Allow Web Access option does not affect the availability of 
catalogs for applications based on the Cumulus Integration Platform(CIP), such as 
Cumulus Portals!

Copy Asset to Central Location
9 If activated, a Central Asset Location (i.e. a dedicated storage space) is used for newly cata-

loged assets, according to the selected mode. (If not activated, cataloged assets remain 
wherever they are stored.)

10 Displays the selected Asset Storage Module and location
11 Opens a dialog for selecting the Asset Storage Module and the location.
12 Opens a menu for selecting how asset are copied to the Central Asset Location.

– As Set in Asset Handling Set – the Asset Handling Set employed for cataloging decides 
whether assets are copied to the selected Central Asset Location, or not.
– Always – Assets are always copied to the selected Central Asset Location, regardless of the 
Asset Handling Set settings.
– Always and Exclusive – Assets are always copied to Vault and their asset storage location 
is Vault exclusively. (This option is available only if Vault is selected as Central Asset Loca-
tion.)

NOTE: Duplicates control with Central Asset Location!
For controlling duplicates with Central Asset Location activated, the record fields Original Asset 
Identifier, Original Asset Name and Original Asset Reference are required. You have to add these 
fields to catalogs with Central Asset Location activated if you also want duplicates control. 
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Record Fields Tab and Category Fields Tab

1Field name.
2Field type.
3Overview on how the field is 
used for sorting and search-
ing.
4Overview on whether the 
user may edit the content of 
the field. Checkboxes can be 
activated/deactivated 
directly.
5Overview on whether a field 
is a mandatory field, or 
whether the field value is 

checked by a validator. Checkboxes are for display only!
6 Overview on the value mode
7 Opens a menu for selecting the columns to be displayed on this tab.
8 Opens a dialog for defining common properties that apply to all fields in general, e. g. for 

enabling subscriptions, and configuring the Solr integration. (Record Fields tab only.) For 
details, see Enabling Subscriptions and Apache Solr integration

9 Opens dialog for defining field properties. For details, see Overview: Field Properties.

NOTE: Catalog Name, Record ID and Category ID are so-called virtual fields. These fields are 
meant to be used for display and processing purposes only. Therefore you cannot define their 
properties. 

10 Opens dialog for selecting a field to be added.
11 Removes the selected field from the list.

8 9 10

21 3 54 6 7

11
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Enabling Subscriptions

Enabling subscriptions in a catalog allows users of the Cumulus Web Client to sub-
scribe to individual files in order to get notified each time the metadata of these files 
are modified. You can administrate which metadata fields are taken into account for 
notifications.

To enable subscriptions for a catalog:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields.

5. Click Common Properties.

6. In the Common Properties window, select the Subscriptions tab and activate 
the Enable Subscriptions option. 

7. Additionally, select the metadata fields that are to be taken into account. 
It is strongly recommended to restrict the metadata fields that are taken into 
account to such fields that are relevant to users or to tasks they have to perform.

NOTE: Cumulus can not create notifications for changed table fields. Therefore, 
do not select table fields!
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8. Click OK to close the Common Properties window. This brings you back to the 
fields list. 

NOTE: Web Client only
Files can only be subscribed employing the Web Client. The Desktop Client 
does not provide this function.

Apache Solr integration

Cumulus indexes the content of string fields for faster searching. However, indexing 
string fields with lots of data (e.g. the Document text field) and also searching in such 
indexes can be very time- and resources-consuming. With the (optional) Extended 
Search Indexing feature, an external indexing and search service, Apache Solr, can be 
integrated into Cumulus. Solr adds the power of distributed servers to Cumulus, thus 
making indexing and searching of Cumulus content scalable and, consequently, 
increasing the overall performance. 

To use Solr, the following prerequisites must be met:

• Catalogs on which Solr shall be used must be migrated to the Cumulus 11 catalog 
format.

• A valid Solr license must be available.
• A Solr installation must be set up and accessible within the network. If you need 

assistance, contact Canto Professional Services.

To enable Solr integration for a catalog:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.
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2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields.

5. Click Common Properties.

6. In the Common Properties window, select the Apache Solr Integration tab 

7. Activate the Enable Solr Integration option. 

8. In the Base URL ... field, enter the URL obtained by Solr.

9. Click OK to close the Common Properties window. This brings you back to the 
fields list. 

Usage of the Solr index can now be activated for each string field individually via its 
Properties.

NOTE: Solr integration for table fields
To use of the Solr index for string fields inside of tables, you must enable the 
Solr integration for each table separately, with an individual base URL for each 
table!

NOTE: Mirroring and backup of catalogs employing Solr index 
Mirroring: When mirroring a catalog that uses the Solr index, the mirrored cat-
alog uses the same Solr instance as the original catalog. When using the mir-
rored catalog, it might be possible that the Solr indexes need to be rebuilt.
Using a Backup: All Solr indexes need to be rebuilt.
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Asset Relations Tab

Shows the types of asset relations available for the catalog. The asset relation types Contained 
and Referenced are available by default in any catalog and can not be removed. These relations 
are detected and set automatically. The relation types Alternates and Variants are also avail-
able by default in any catalog but can be removed. In addition to these types you can add asset 
relations types of your own – so called custom relations. (For more information on how Cumulus 
deals with asset relations see Managing Related Assets.) 

1Order number. Can 
be changed. (See 10)
2Name of the rela-
tion type
3Description of the 
relation type.
4Opens a dialog to 
localize the name 
and description of 
the selected relation 
type. (For details see 
Localizing Relation 
Types.)
5Opens the Proper-
ties dialog for the 
selected relation 
type. (For details see 
Properties of a Rela-

tion Type.)
6 Opens a dialog to add a relation type that already exists in an other catalog or catalog tem-

plate managed by your Cumulus Server. 

2 31

5 6 7 84

9

10
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7 Opens a dialog to add a new custom relation type. (For details about the properties set, see 
Properties of a Relation Type.) TIP: With Web Client, a custom icon can be displayed for a cus-
tom relation. For details see Custom Icons and watch the video tutorial Configuring Asset 
Relations.)

8 Removes the relation type from the current catalog. Already set relations will be kept but the 
relation type cannot be assigned any longer.)

9 Opens a menu for selecting the columns to be displayed on this tab.
10 These buttons change the selected entry’s position in the list.
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See how creating a custom relation type works ...

and how a custom icon is set for the Web Client
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Mirroring Tab

IMPORTANT!  Do not employ journaling and mirroring for the same catalog! Use 
one of the mechanisms depending on how the catalog is used.: (See “Securing Cata-
logs”, for more information.)

1Activates mir-
roring for the 
catalog. (See 
“Setting up a 
Catalog for 
Mirroring”)
2Selects the 
database sys-
tem used for 
mirroring the 
catalog.
3Defines the 
actual data-
base used for 
mirroring the 
catalog. The 

displayed fields depend on the on the selected database system.
4 Displays information on the actual mirroring process.
For more information on mirroring, see “Database Mirroring” .

2

3

1

4
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Workflows Tab

Shows all workflows applied to the catalog. You can add new workflows that are stored at the 
Cumulus Server, remove existing workflows or update them, if their definition has been modified 
with the Workflow Manager at the Cumulus Web Server Console. 
Applying a workflow to a catalog copies the respective settings to the catalog. For each work-
flow, 3 fields are added to the catalog: 
1 <workflow name> - Workflow Activities
2 <workflow name> - Workflow Assignments and 
3 <workflow name> - Workflow State.
As soon as a workflow is assigned to a catalog, it is available to Cumulus users.

NOTE: Updating Workflows
Workflows that are applied to a catalog reside there independent of the original definition 
stored in the Workflow Manager at the Cumulus Server. Thus, editing a given workflow defini-
tion in the Workflow Manager does not affect the actual workflow in a catalog. To make modi-
fications to a workflow effective, you must explicitly update the workflow assigned to the 
catalog to the new definition.
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1 Indicates whether a workflow definition is still up-to-date, or whether there is a newer ver-
sion available at the Cumulus Server.

2 Name of the Workflow.
3 Date when this workflow version was defined first. 
4 Date when this workflow was last modified with the Workflow Manager at the Cumulus Web 

Server Console.
5 Updates the selected workflow. This button is only active if the workflow definition has been 

updated at the Cumulus Server.
6 Opens a dialog for selecting workflow definitions stored at the Cumulus Server and applying 

them to the catalog.
7 Removes the selected workflow from the catalog. This also deletes the respective fields from 

the catalog.

2 31

5 6 7

4
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Permissions Summary Tab
 

Shows what permissions each user or role has for the catalog. 

NOTE: You can only view the information, for editing you have to employ the User Manager of 
the Server Console. 

1 List of users (and roles, if Cumulus runs in role mode) the permissions of whom are to be dis-
played. Initially, no user is displayed in this list. However, available roles are always dis-
played.

1

3 4 42
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2 Opens a window to search for users and add them to the list.
3 Displays the permissions the above selected user/role has for the catalog.
4 Displays the sets, actions, queries, and templates available for the above selected user/role 

with that catalog.
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Employing a Central Asset Location
A Central Asset Location is a single storage location used to store specific digital assets. 
Employing a Central Asset Location ensures your assets remain accessible to all, and 
can more easily be accounted for. Cumulus lets you choose between different types 
of Central Asset Locations:

• File System – Any standard file system location can be used as a Central Asset Loca-
tion. The most common example is a network file server. This type is supported by 
the Asset Storage Modules for the operating systems.

• Internet (FTP) Servers – If you need to keep files accessible from an Internet FTP 
server, you can choose an FTP server as Central Asset Location. This option is less 
popular for works-in-progress because of performance and other limitations asso-
ciated with this type of server access; but when archiving assets, this option can be 
ideal. This type is supported by the URL AssetStore.

• Cumulus Vault – This type provides asset check in/out and version control services 
not available with the other two types. The file system on the Vault Server machine 
physically stores the assets kept in the Vault, but Cumulus Vault controls access to 
the files, which enables it to offer these advanced services not available when 
using the file system directly. This type is supported by the Vault AssetStore.

• Amazon S3 – If you want to employ a cloud service, you can choose an Amazon 
Simple Storage Service (Amazon S3) bucket as Central Asset Location. You need an 
Amazon Web Services account and must be signed up for Amazon S3. Amazon’s 
CloudFront can be employed for best possible performance as well. This type of 
Central Asset Location is supported by the Amazon S3 AssetStore (optional) that 
provides versioning.
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A Central Asset Location is chosen as a catalog property setting. Each catalog can have 
its own Central Asset Location. What the best choice is depends on how the catalog 
is used. 

PRECONDITIONS: To set up a Central Asset Location for a catalog, you must have the 
appropriate Administrator permissions (Permissions > Administrator Permissions > 
Modify Central Asset Location (option for the Modify Catalog Settings permission.) 

To configure a catalog to employ a Central Asset Location:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click General.

5. Under Copy Assets to Central Location, enable Use Central Asset Location.

The next step is to choose where to store the copies and which Asset Storage 
module you want to use.

6. Click Browse. The Choose an Asset Storage Module dialog opens. 

7. Select the desired module and click OK. The next steps depend on the selected 
module:

• Selecting the URL AssetStore opens a dialog for entering a URL.
Enter a valid URL of an existing FTP directory and click OK.
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• Selecting a File System AssetStore opens a dialog to select a folder. Browse for 
the folder you want the asset to be stored in and then click OK. A further dialog 
appears offering options for the automatic creation of subfolders:
None: All cataloged assets are stored in the same folder

By Date: Subfolders are created on a daily basis. Assets cataloged on the same 
day are stored in the same folder. If two or more assets have identical file names, 
a unique identifier will be added to the file name.

By Unique Identifier: Every cataloged Asset gets it’s own folder and unique path 
where it is stored within the Central Asset Location.

Select the desired option and click OK.

• Selecting the Vault AssetStore opens the Select Remote Module dialog.
Select the computer running the file system or the Vault Server from the Com-
puter field. Your next step is to decide whether you want the assets to be stored 
directly in the folder of the Vault Server or in a subfolder nested in the Vault 
Server folder. Such a subfolder is called a Vault Folder. 
Select the desired option. If you decided on Use Vault Server Directly, your next 
step is to click OK.
If you decided on Use Vault Folder, the list for selecting this folder is activated. 
Then your next step is to select the Vault Folder you want the asset to be stored 
in and click OK. 

NOTE: If a catalog is set as exclusive for a Vault Folder this folder cannot be used 
as a central asset storage location for any other catalog. If you want a catalog to 
be set as exclusive, you have to create a new Vault Folder for it. 

• Selecting the Amazon S3 AssetStore opens a dialog to define the Amazon S3 
location where the assets should be stored.
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Select the credential used to authenticate and authorize calls that Cumulus 
makes to Amazon Web Services (AWS). You can also add a new credential by 
clicking the  button to the right of the Credentials field. This opens the list of 
available credentials which allows you to add or edit credentials. (For a descrip-
tion on how a credential is defined, see “Amazon S3 AssetStore (optional)” .) 
Define the bucket to store the assets. Either select it from the drop-down-list or 
enter the name. The listed buckets depend on your Amazon account permis-
sions. 
Click OK to save the chosen location.

8. Select the mode for copying assets to the central asset storage location chosen 
above. The mode determines when the Central Asset Location is used:

• As Set in Asset Handling Set – the Asset Handling Set employed for cataloging 
decides if assets are copied to the selected Central Location.

• Always – Assets are always copied to the selected Central Location, regardless 
of the Asset Handling Set used.

• Always and Exclusive (available with Vault AssetStore only) – Assets are always 
copied to Vault and their asset storage location is exclusively Vault. 

9. Click Apply to save your changes and select the next catalog you want to set up 
for a Central Asset Location.
OR 
Click OK to save your changes and close the Preferences window.

When users catalog assets to this catalog from now on, the asset can be copied or will 
be copied to the selected Central Asset Location.
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NOTE: Central Asset Locations and Asset Handling Sets
Every Asset Handling Set that is to be used with a Central Asset Location (for 
cataloging or access), must be configured with the Central Asset Location’s cor-
responding asset storage module activated. So, activate the Mac OS and Win-
dows AssetStore modules for file system locations, the URL AssetStore for FTP 
locations and the Vault AssetStore for Vault locations. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING CATALOGS CATALOG SETTINGS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Copy Triggers and Permissions between Catalogs
Having spent time and effort to fine tune user/role permissions settings and catalog 
triggers for a specific catalog, you may want to reuse these settings in other catalogs, 
too. To do so, you just have to copy them from one catalog to another.

PRECONDITIONS: To copy permissions and triggers from one catalog to another, you 
must have the View Catalog Settings permissions (in order to see the Catalog Settings 
tab in the Preferences window), as well as the following permissions: Modify Catalog 
Category Permissions, and Manage Catalog Triggers. 

To copy permissions or triggers between catalogs:

1. Open both the source catalog and the target catalog in the same collection win-
dow.

2. Select Preferences > Catalog Settings.

3. From the Catalogs drop down list, select the target catalog.

4. Click Copy permissions or Copy triggers.

5. Select the source catalog (the catalog the permission/triggers of which you want 
to copy), then click OK.

The trigger/ permissions settings are copied from the source catalog to the target cat-
alog.

NOTE: Caution! The settings in the target catalog will be completely overwrit-
ten with the settings from the source catalog!
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Administering Catalog Fields
Catalogs fields is where the information is stored. The tasks of a Catalog Administrator 
include:

• Customizing Field Properties
• Defining Field Formulas
• Administering Field Linking
• Adding Fields
• Creating a Custom Field
• Editing a String List Field

Customizing Field Properties 

The properties of a catalog field can be extensively customized. You can define:

• whether the field can be edited
• whether the field values should be based on formulas
• whether the visibility of the field is restricted, and to which users or roles
• whether and how the field is indexed for sorting and searching
• whether and how the record field is linked with the asset and its metadata fields
• and whether string fields support multiple languages
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To access the properties of a record field: 

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields or Category Fields. This displays a list of the current record or 
category fields included in the catalog.

5. Select the entry for the field whose properties you want to change.

6. Check the Sorting, Contain Search and User Editable options for the field and 
activate the desired options. (See “Record Fields Tab and Category Fields Tab”, for 
all available options.)

7. Click the Properties button. This brings up a dialog in which you can set the prop-
erties for the field. The properties depend on the field type. (See “Overview: Field 
Properties”, for all available options.)

8. Define the properties as you want them. 

9. Click OK to close the Field Properties window. This brings you back to the fields 
list. 
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TIP: Editing Field Properties of Multiple Record Fields At Once

Certain field properties can be activated or deactivated for multiple fields at 
once. On the record fields list, select the fields and use the alternate (right) 
mouse button to open a context menu. The menu options match the field 
properties you can (de)activate for multiple fields at once. 
Selecting a menu item opens a submenu that offers Enable and Disable 
options. Select the desired option and the field property will be enabled/dis-
abled for your selection of fields. If your selection of fields includes a field type 
that does not have the selected property, this field will just be ignored.

Editing Language-Specific Field Names

The names of fields as they are shown in the user interface (also known as display 
names) may be translated to different languages, in order to have them displayed in 
the language of the application or the preferred language, respectively. The names of 
the fields provided by Canto are already translated in several languages.

To edit language-specific names of a field:

1. Open the Properties window of the field which display names you want to edit.

2. Click the  button to the right of the Field Name field.

The Name Editor window appears.

3. Edit the Name fields for any desired language. Optionally, add a description in the 
respective language.
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If a description exists, an info icon is displayed next to the name of the field in Info 
View, Info Window and Info Pane. Hovering the cursor over this icon will reveal the 
description in a tool tip.

4. Click OK.

The language-specific field names are changed accordingly.

5. If you are editing names of a multilingual field, you will additionally be asked 
whether you want to apply your changes to all additional languages. It is strongly 
recommended to do so in order to keep the names of the multilingual fields con-
sistent in all languages.

6. Click Yes to apply your changes to all languages.

Example: The following table shows the display names of the multilingual field Head-
line as used in the user interfaces (UIs) of different languages. In addition to the field 
in the base language, multi language fields comprehend one extra field for each lan-
guage enabled. To view or edit the content of these field, they must be added to View 
Sets, either individually or in any desired combination.

The base language of the field in this example is English; it is set to support two addi-
tional languages (German, French).

English Field German Field French Field

Display Name in the English UI Headline Headline 
(German)

Headline 
(French)

Display Name in the German UI Überschrift 
(Englisch)

Überschrift Überschrift 
(Französisch)
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NOTE: To quickly remove a language-specific name of a field and replace it 
with the technical name of the field, just select the languages you want to 
change and click Reset Name, or select Reset Name from the shortcut menu.

Defining Field Values

The values of fields can either be defined by the user, or can be based on formulas. If 
defined by the user, a field can have an initial value and you can allow users to edit it 
or even force them to edit it (mandatory fields).

Initial Value for Fields

To add a default text to a field (e.g. the Notes field) of all newly cataloged assets in a 
certain catalog, you must enable the option Initial Value for the field and enter the 
desired default. If the asset’s metadata already contain a value for this field, the initial 
value will be ignored.

With a string list field, select an initial value from the list of predefined terms that is dis-
played when you click the  button next to the field.

The default value of a boolean field is “no value”. Activating the Use initial value 
option sets the initial value to “not activated”, additionally activating the Active option 
sets the initial value to “activated”. 

Display Name in the French UI Titre (Anglais) Titre 
(Allemand)

Titre

English Field German Field French Field
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NOTE: Changing the settings for the initial value only takes effect on records 
created after the change. Existing records are remain unchanged!.

Mandatory Fields 

If the Mandatory Field option is activated for a field, the field must be filled with meta-
data when the metadata are edited. If windows or views which allow the editing of 
metadata contain empty mandatory fields, these fields are marked with a special icon 
and a validator pane is displayed at the bottom of the Information Window or Infor-
mation View. Changes to the metadata can only be saved if all required fields are filled 
in. 

The Mandatory Field option is available for the following field types: Data Size, Date, 
Date Only, Integer, Label, Length, Long, Rating, Real, Resolution, String, String List, 
Time Only.

NOTE: With automatic cataloging the mandatory option attribute is not con-
sidered valid but as soon as a user edits any metadata of a record that includes 
an empty mandatory field and is going to save the changes, a message reminds 
him/her when the record is saved. 

Table Fields

Table fields are special field type that can include other metadata fields. The properties 
of Table fields differ from other field types. 

This field type serves as the basis for the statistics and commenting available in 
Cumulus, and can serve as the foundation for new capabilities. For more information 
on Table fields, contact Canto. 
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Overview: Field Properties

The Field Properties window reflects the field type. Most properties are the same for 
all field types, but certain field types, e.g. Audio fields, cannot be used for indexing, and 
an initial value would not make sense. That’s why the properties dialog for such field 
type does not provide these settings.

General Tab

Field Properties
1 Field Name. Name of the field. Can be edited.
2 Opens the Field Name Editor to enter/edit the display names and, if desired, descriptions of 

the fields in other languages. Language-specific names will be displayed according to the 

3
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selected application language. The according field description will be displayed as the field’s 
tool tip in the information window, information view and information pane. Useful in multi-
lingual environments. (See “Editing Language-Specific Field Names”)

3 Field Type (display only)
4 Enable Multi Select (with String List Fields and Vocabulary Fields only)

• String List Fields: If activated, the users can select multiple values for this field in the Info 
View or the Information window.

• Vocabulary Fields: If activated, the field can contain multiple values (terms).

NOTE: Whether this option is activated or not influences the available indexing options. If 
activated, the field can be indexed for contain-searching but not for sorting. 

5 Restrict terms ... (with Vocabulary Fields only)
The container types available in the special $Vocabularies catalog are displayed. Select the 
container type(s) to serve this field. (See Configuring Controlled Vocabulary for details.)

6 Restrict field visibility ... 
If activated, the visibility of the field is restricted to the users (and roles, if Cumulus runs in role 
mode) specified here. 
Click the appropriate button, Add User or Add Role (note that the Add User button is avail-
able only if you have the Browse for Users permission), to open a corresponding dialog. For 
adding users, you can search for available users. The possible search criteria depend on the 
authentication method (see above). 

NOTE: Field visibility can not be restricted for users or roles with the “Modify Catalog Set-
tings” permission. Such users/roles always can see all fields.

7 List of the users /roles which are allowed to see the field. 
8 Add User – Opens a dialog to search for users and add them to the list. 
9 Add Role – Opens a dialog to select roles and add them to the list. 
10 Remove – Removes selected users/roles from the list. 
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Indexing
The options available depend on the field type.

11 Index for sorting/searching – If activated, the field can be used for sorting and searching. 
(Equivalent to the Sort/Search check box in the Field List column.)

12 Sorting of records can be set to respect the rules of the language of the Cumulus Client (appli-
cation language). For any language activated here, a specific sorting index is created that 
will be used for sorting, if the Client runs is this language. This applies to fields without mul-
tiple language support. For Fields that have multiple language support enabled, refer to no. 
18! 

13 Index for contain-searching – If activated, the field can be used for searching by means of 
the operators “contain” or “doesn’t contain.” (Equivalent to the Contain-Search check box in 
the Field List column.)

14 Favor speed over size – If activated, searching the contents of String fields can be acceler-
ated up significantly. Use this option with care because it enlarges the catalog size. The opti-
mization of the search index requires more memory in the catalog and therefore activating 
this option is only recommended for fields with little data content.

15 Use segmented index – If activated, the indexing process can be accelerated significantly. 

11

12

13
14

17

15
16
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NOTE: Activating the Use segmented index option only takes effect with fields containing 
large amounts of text (e.g., Document Text), and with a Cumulus Server running on a 
machine with several CPUs.

16 Use Solr index – if activated, indexing (and searching) of the field is performed by an exter-
nal service, Solr. – This is recommended only for string fields with extensive content in large 
catalogs, and works only if Solr integration is properly configured and enabled via the Com-
mon Properties).

17 Index for word-searching – If activated, Cumulus provides an additional search function 
for the Find window, the Advanced Find window, and for Quicksearch. You can search for 
whole words, not just for matching strings. Enclose the word you are searching for in single 
quotation marks and Cumulus will only find the records that contain the exact word. 
For example, searching for copy will always find records containing the words copy as well 
as copyright, copyhold, copyfree and so on. If Index for word-searching is activated, 
searching for ‘copy’ will find records containing the word copy only

18 Only when multiple language support is enabled: If activated, Cumulus provides language-
specific sorting of records for all languages enabled under the Languages tab. 

Additional Options for Record Fields

18

19
20
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19 Field will be included in the Record pane’s drop-down list for sorting.
20 Field will be offered as search criterion in the drop-down lists of Find windows and filter defi-

nitions.

Additional Options for Category Fields

21 Field will be offered as search criterion in the drop-down lists of Find windows.

Field Values Tab 

Field values can either be defined by the user, or they can be based on formulas. On this tab, you 
can define the value mode for each field and the respective properties.
A Drop-down list to toggle the Field Value Mode between User generated field values and 

Formula based field values.

21
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User Generated Field Values

Which properties are actually avail-
able depends on the field type.
1Use initial value – If activated, the 
field will be filled with an initial value 
(as defined here). (See “Initial Value 
for Fields”, for details.)
2Allow user to edit – If activated, 
users are allowed to edit the field 
contents. (Equivalent to the User 
Editable check box in the Field List 
column.) 
3Mandatory field– If activated, the 
field must be filled with a value when 
metadata are edited. In the Informa-
tion window or view, empty manda-
tory fields are marked with a special 
icon and a validator pane is dis-
played. Changed metadata can only 
be saved if all required fields are filled 
in. (For details, see “Mandatory 
Fields” .).

4 Restrict to specific values – If activated, the content of the field must match certain criteria, 
depending on the type of the field; either a defined regular expression (string fields), or spe-
cific values (fields that contain numbers and dates). 

5 Customize – Opens a dialog to specify a regular expression (string fields) or specific values 
(fields that contain numbers and dates) to be used as validators for the field content. 

6 Restrict edit to the following Users and Roles – With Cumulus Enterprise or permissions 
add-on products only: 

A
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The Allow User to Edit property is enhanced by the option to restrict editing to specified 
users and roles only. If the Restrict Edit option is activated, you must add those users to the 
list you want to permit editing the field. Click the appropriate button (Add User or Add Role. 
Note that the Add User button is available only if you have the Browse for Users permission.) 
These buttons open a corresponding dialog. For adding users, you can search for available 
users.
The possible search criteria depend on the authentication method (see above). Default 
search criteria is the login name. Enter the search value (a string) and click the Find button. 
The result of this search is listed below. Select the user(s) you want and click OK. The users are 
added. When adding roles, Cumulus will list the available roles. Select the role(s) you want 
and click OK. The roles are added. 
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Formula Based Field Values

1Edit field to compose the formula that 
defines the field value. 
2If activated, you can define the fields 
that will trigger an update of the for-
mula field if their values had changed. 
Thus you can make the value of a for-
mula field dependent of other values.
3Displays the field(s) or subtable 
entries of fields on which the value 
update of the formula field depends.
4Decide what happens if a formula 
error occurs:
5The value is left untouched.
6The value is cleared.
7 A fallback string value you define is 
used.
For details on how to compose formu-
las, see “Defining Field Formulas” .

String List Editor Tab

This tab is provided for String List fields only. See “Editing a String List Field”, for details.
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Languages Tab (String Fields only!)

Multiple Languages
The contents of string fields may be kept in more than one language. This is especially useful in 
multilingual environments, e.g. to provide image captions in several languages. 
For each additional language, a new field is introduced to the catalog. However, these fields are 
not visible in the Record Fields tab or the Category Fields tab of the preferences dialog, but only 
from within the properties of the base field.
Language-specific fields may be selected for display in Record View Sets, e.g. to provide different 
view sets for different languages, or to display information in different languages simultane-
ously.
If multiple languages are enabled, Cumulus can be configured to display the field contents in the 
application language of the user interface (as defined via File > Administration > Switch 
Application Language), or in a specific language. If no language field corresponding to the 
specified language can be found, the base language of the field is used instead. 

1If activated, the content of the field 
may be kept in more than one lan-
guage.
2Displays and allows to specify the 
base language. This is the language 
where already existing content will be 
kept once the field has been enabled 
for multiple languages and to which 
extracted metadata will be added 
while cataloging. And the base lan-
guage is used as fall back, e.g. if a 
specified language cannot be found. 

3 Displays all specified languages for which sub-fields are introduced.
4 Opens a dialog for defining properties for the selected language-specific sub-field.

1
2

3
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5 Opens a dialog to select one or more additional languages for which a sub-field is intro-
duced.

6 Removes selected languages from the list, and sub-fields from the catalog. 

TIP: You may easily check which fields are configured for multiple language support. Just 
have the Multilingual column displayed on the Record Fields tab or the Category Fields 
tab (see “Record Fields Tab and Category Fields Tab” ). Multilingual fields show an acti-
vated checkbox.
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Field Linking Tab

Linking
1When cataloging assets, the selected 
record field will be filled automatically. 
(Read One: only the first matching field 
will be used).
2When updating records, the selected 
record field will be filled automatically. 
(Read One: only the first matching field 
will be used).

NOTE: Do not activate this option if you 
want to keep the additional information 
you have entered. 

3Before updating records, existing val-
ues will be removed from the selected 
record field. Allows to refresh the field’s 
contents from new asset values, without 
accumulating unnecessary metadata in 
the field.

4 Any changes in field contents will be written back to the asset, if the file format and the filter 
for the asset format support this function and if Always or Silently is enabled under Writing 
Metadata to Assets in the Asset Handling Set used. 

NOTE: In order to write back IPTC information edited in Cumulus, this option must be acti-
vated for IPTC fields. 
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Link Matching Fields
5 List of fields with the same GUID (globally unique identifier) or name and type that can fill 

data into the record field. If activated the asset field will fill the record field.
6 Activates/deactivates the selected field for matching.
7 If a new Filter module provides any matching fields, these fields will be added and activated 

automatically.

Also Link Following Fields
8 List of fields that are also linked. Use the Add/Remove buttons to add/remove fields to/from 

this list.
9 Opens a dialog to select the field to be added.
10 Removes the selected field from the list.

Referenced Tab

Provides an overview of the View Sets (and their 
views and windows), Metadata Templates and 
Print Templates that bear a reference to the field 
in order to display or use it. 
A reference to the field may be removed from or 
added to any of these items via a shortcut 
menu.
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Defining Field Formulas
Cumulus field values can be determined by formulas that are authored as part of a 
field’s properties. A formula can be as simple as the concatenation of two field values 
into a single string, or as complex as if-then decision making. 

Formulas can be assigned to record and category fields. Values for existing records 
and categories are calculated (or recalculated) when the record or category’s meta-
data is saved after an edit. Formulas are executed during cataloging operations for 
newly created asset records and categories.

Field formulas offer many significant benefits:

Metadata display versatility

Used in conjunction with “display only” metadata fields you add to your catalogs, 
field formulas enable you to provide users with data displays formatted in more 
meaningful ways. 

Example: A video’s Duration field might contain the value “25.566.” Even when dis-
played using the field’s label, the user sees “Duration: 25.566,” which could be 
more clear. A simple field formula can round that value and display it with adjacent 
strings that tell a more complete story: “Length: 26 seconds.”

Another usage example would be to combine the values of the fields Horizontal 
Pixels, Vertical Pixels and the appropriate resolution field to provide a single line of 
commonly used information:

“2400 x 1200 @ 300 DPI”

This single formula, applied to the properties of a string field you add to your cat-
alog, saves you a full 5 lines of vertical space in your thumbnail display. The added 
string field ensures that each field’s original value remains intact.
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Calculations

Field values can be calculated to provide useful, searchable metadata values that 
would not otherwise exist in your catalogs without manual data entry. Example: 
say you have a field for Cost Per Use. Another field, Times Used, tracks how many 
times you’ve used the particular asset. A third field, Total Cost of Use, uses a simple 
multiplication formula to offer a sum of the total costs associated with the asset.

Workflow monitoring and guidance

Field formulas can combine the values of several status fields into one resulting 
field that can be used for Live Filtering, or as a trigger for Scheduler actions, or by 
the person in charge to decide on further actions. 

Metadata Write-back Flexibility

The flexibility of the Cumulus architecture makes it possible (and easy) to use 
metadata taxonomies and field types that cannot be written back to assets 
because of the “string only” limitation of most metadata standards. You can cir-
cumvent this limitation in many cases by using formulas in conjunction with 
Cumulus’s Field Linking. By adding special “metadata write back” fields to your cat-
alogs, you can add formulas that concatenate the contents of several fields (or 
fields with data types incompatible with write-back operations, such as string lists) 
and “field link” them for write-back to your assets. 

Generate printer-friendly reports

Setting up formula-filled fields that you use on print templates offers you a great 
way to output metadata in formats suitable for review by others. Formulas enable 
you to combine metadata fields that would otherwise be “report hostile,” such as 
string lists, Booleans, and labels and ratings, into strings that fit nicely onto printed 
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pages. Formulas also enable you to manipulate metadata that you intend to 
export from Cumulus for use in other systems.

Syntax Overview

A field formula is an expression that returns a single value, which can be of type num-
ber, real, boolean, string, date, date only or time only. The constant value null can also be 
returned to represent an empty field value.

When applying operators on two values of different types, one or both values are con-
verted into a compatible type. Example: (“Cumulus ” + 7.5) results in the string 
“Cumulus 7.5” because 7.5 is converted to a string before the + operator is applied. 

If an error occurs, the field’s value is set according to settings you determine while 
authoring the formula. (See “Multiplying the Values of Two Catalog Fields,” below, for 
details.) If no error occurs, the resulting value is automatically converted to match the 
field’s type.

The arithmetic operators available are a subset of those available in programming lan-
guages such as C, Java, or JavaScript.

Function Reference

The Cumulus formula editor includes an in-line help reference that describes each 
function and how it can be used (see “In-line Help” ). 

Additionally, a field formula syntax overview is provided as HTML page. This document 
assembles the most recent information on all functions, including the formal syntax. 
For a detailed description see Field Formula Syntax.

http://help.canto.com/FieldFormulaSyntax.html
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Formula Examples

The following formula examples rely on specific catalog fields. If using these formulas 
in your catalogs, make sure you substitute the same field names with fields from your 
own catalogs.

Adding Text Labels, Formatting Output and Rounding Numeric Values

Catalog field: disp_Duration (String)
"Length: " + String(fieldValue("Duration") , "%.1f")+ " seconds"
Duration field value: 3.467

Output: “Length: 3.5 seconds”

This formula takes the real value in the catalog’s Duration field, rounds it to a single 
decimal place, and surrounds the resulting value with text strings. 

The "%.1f" portion of this formula will be familiar to those who have worked with the 
printf function available in many programming languages. Cumulus supports the 
following printf formatting options:

In addition, you may use the new line escape character "\n" within a string to force a 
line break where needed:

Data Type Supported Example

String s %-20.20s

Integer d, I, o, u, x, X %d

Real e, E, f, g, G %5.2f
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"Vertical: " + fieldvalue("Vertical Pixels") + "\n" +
"Horizontal: " + fieldvalue("Horizontal Pixels")

Multiplying the Values of Two Catalog Fields

Catalog field: disp_Megapixels (String)
fieldvalue("Horizontal Pixels") * fieldvalue("Vertical Pixels") / 
(1024*1024) + “ megapixels”
Horizontal Pixels field value: 3456

Vertical Pixels field value: 2304

Output: “7 megapixels”

This formula multiples the values of the Horizontal Pixel and Vertical Pixel fields, 
divides that value by 1,048,576 in order to get the number of megapixels in an image, 
and appends that value with a text string that describes the result.

If-then Decision Making

Catalog field: disp_Orientation (String)
(fieldvalue("Horizontal Pixel") == null || fieldvalue("Vertical Pixel") == 
null) ? "N/A" : ((fieldvalue("Horizontal Pixel") > fieldvalue("Vertical 
Pixel")) ? "Landscape" : (fieldvalue("Horizontal Pixel") < 
fieldvalue("Vertical Pixel") ? "Portrait" : "Square"))
Horizontal Pixels field value: 2400

Vertical Pixels field value: 1200

Output: “Landscape”

This formula compares values found in the Horizontal Pixel and Vertical Pixel fields. If 
the Horizontal Pixel value is larger, the image is determined to be “Landscape.” If 
smaller, it’s “Portrait.” If the two values are the same, the image is “Square.”
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The Field Formula Editor

The field formula editor can be found on the Field Values tab of the Field Properties 
windows for record fields as well as for category fields. To open the field formula edi-
tor, select Use Formula based field values from the Field Value Mode drop-down list.

NOTE: Fields using formula based field values cannot be edited by users!

The Formula area is where you define your formulas. 

Take advantage of the drop-down lists provided by the Fields and Functions buttons 
to save time and help you avoid syntax errors due to simple typos. 

By default, the value of a formula field is newly calculated every time the record has 
changed, i.e. every time any field value has been changed. This not only can be very 
time consuming, but is completely unnecessary in may cases. Therefore, you can 
restrict the re-calculation of a formula field in such a way that it is only performed if 
specific fields or sub-table entries of a field have changed.

Use the Add button to select the field(s) on which you want the update of the formula 
field to depend. The Auto Detect button supports you by searching for all fields con-
tained in the formula itself and adding them to the list. 

NOTE: For technical reasons, the auto detect function can not be perfectly reli-
able. Make sure to check the results of the auto detection and correct them 
manually, if necessary. 

Such dependencies of formula fields not only can speed up your system. Moreover, It 
makes it easy to determine the order in which fields are calculated. This is helpful e.g. 
if work flows are to be defined within Cumulus
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Finally, choose your preferred option for error handling. An error occurs when for 
whatever reason your formula cannot be executed. Errors can include syntax issues in 
the formula itself, or problems evaluating field data used in the formula.

When you click OK the Field Properties window is closed, and your formula is saved 
and activated. 

In-line Help

An in-line function and syntax reference is built into the formula editor. This feature 
provides a handy reference that will save you time and help you avoid syntax errors.

Three types of in-line help are available:

• Syntax reference – See an example of the syntax used with a function.
• Usage reference – See information about the purpose of a function, the value it 

returns, and a usage example.
• Autocompletion – See a menu list of functions whose names match characters 

you’ve typed.

To activate in-line help:

1. Click to place your cursor within the function’s name in the formula editing field.

2. Type CTRL p (syntax reference) or CTRL q (usage reference). The usage reference 
help window that appears may be resized as needed.

Both windows disappear when another key is pressed or the mouse is clicked in 
the Formula editing field itself. (Hint: Escape, Shift, CTRL or ALT are good keys to 
use to dismiss the window because they don’t introduce any new characters into 
the Formula field.)
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3. For function name autocomplete assistance, type the first few characters of a 
function’s name and press CTRL-Spacebar to see a list of functions whose names 
match the characters you’ve typed.
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Administering Field Linking 
Some asset formats (e.g., JPEG) can store metadata. Cumulus can read, store and man-
age this metadata by linking it to record fields. The record fields are provided by the 
Cumulus application, the Asset Storage modules, Metadata modules, and the filters. 

You can decide when the linking should happen (when cataloging assets and/or 
updating records), and whether changes to the metadata should be written back to 
the asset. Changed metadata can only be written back if this function is supported by 
the file format, the filter and Asset Storage module used for accessing the asset.

If the record field’s type is String, you can also decide whether the linking applies to all 
or only the first matching asset field. If the Read All option is activated, the values of 
the linked fields are read consecutively. Under Link Matching Fields, all fields which 
“feed” the field are listed – fields that have the same GUID (Globally Unique Identifier) 
or name and type. If the Read All option is activated, Cumulus will fill the record field 
with the data from all activated modules. If a module is deactivated, its data are 
“ignored” by Cumulus. 

NOTE: Field Linking Checks for Field Types
In addition to its own type, a field may be linked to certain other field types only.
– Integer fields accept: String, Boolean, Real
– Real fields accept: String, Boolean, Integer
– Boolean fields accept: String, Integer, Real
– Date fields accept: String
– String List fields accept: String
– String fields accept: Boolean (true, false), Integer, Real, Date, String List (exact 
string matching)
– Binary fields accept: Audio, Picture
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Automatic Creation of Folder Categories 

The fields linked to the Categories record field are responsible for the automatic cre-
ation of folder categories in a catalog. The master category below which such a folder 
category is created is defined in the Category Target column. You can change the 
default target by clicking into the field and selecting another master category.

If you don’t want automatically created folder categories in a catalog, you have to 
deactivate the corresponding modules. 

To avoid the automatic creation of folder categories you have to change the default 
linking of the Categories field:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields.

5. Select the field named Categories and click the Properties button. 

6. Click Field Linking.

7. Select the module which to be deactivated (the one that should not create cate-
gories during the cataloging process. e.g. Windows or Mac OS File System Asset-
Store).

8. Click Deactivate. 
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9. Click OK. This brings you back to the fields list. 

10. Click Apply to save your changes. If you now catalog assets employing this mod-
ule, no directory categories will be automatically created and assigned to the 
record.
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Adding Fields
To store information in addition to, or different from the default settings, you can add 
fields to the catalog, either by activating them from the list of fields that Cumulus sup-
ports or by defining a custom field.

In any catalog, you can additionally update fields stemming from catalog templates. 
This is useful if the definition of a field in a template was changed, e. g. by adding more 
values to a string list. See Updating Fields With Modified Definitions From Catalog 
Templates.

To add a record or category field:

1. Make sure the collection window is the active window in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. Select the catalog you want to edit 
under Catalogs.

4. Click Record Fields or Category Fields. This displays a list of the current record or 
category fields included in the catalog.

5. Click the Add Field button. This opens the Add Field dialog. 

This dialog displays all fields provides by Cumulus that can be added to the 
selected catalog, i.e. all fields that have not yet been added to it. 

NOTE: For fields stemming from Catalog Templates – and for such fields only! – 
you can decide whether to display the fields that have not yet been added to the 
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catalog, or all fields contained in the templates, by activating the Show all fields 
from catalog templates option.

The display of available fields is organized in two tabs, Modules and Fields. 

• The Modules tab presents the fields sorted by their sources and provides the 
sections Catalogs, Catalog Templates, Modules and Languages.
– Catalogs expands to a list of all available catalogs. Clicking the plus sign in 
front of a catalog’s name displays all fields of that catalog that are not included in 
the catalog you want to edit. Either select the name of a catalog to add all con-
tained fields, or select the individual fields you want to add.

When a field from an existing catalog is added, all field-specific settings from the 
source catalog are preserved.

NOTE: If the catalog that you are editing is listed itself, this catalog contains 
table fields (e.g. Asset Usage History). Table fields introduce a second level into 
the catalog, as they themselves contain fields. The fields contained in a table 
field can also be contained in the top level of the catalog, or in any other table 
field. At any level of the catalog – top level or table field level – all fields are 
listed which are contained in this catalog, but not in the current level.

– Catalog Templates expands to a list of all available catalog templates. Clicking 
the plus sign in front of a catalog template’s name displays either the fields of 
that catalog template that are not yet included in the selected catalog, OR all fields 
from that template, depending on the state of the Show all fields from catalog 
templates option. For adding fields, make sure the option is not activated.
Either select the name of a catalog template to add all contained fields, or select 
the individual fields you want to add.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING CATALOGS CATALOG SETTINGS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

– Modules expands to a list of all Cumulus modules that provide fields. Clicking 
the plus sign in front of a module’s name displays the fields supported by the 
respective module that are not included in the selected catalog. Either select the 
name of a module to add all fields supported by that module, or select the indi-
vidual fields you want to add.

– Languages expands to a list of all languages configured for string field values. 
Clicking the plus sign in front of a language name displays the fields that support 
values in the respective language that are not included in the selected catalog. 
Either select the name of a language to add all respective fields, or select indi-
vidual fields to be added.

Additionally, all language independent fields that are not included in the catalog 
are listed and can be added.

• The Fields tab displays a list of all the fields that are not yet included in the cat-
alog. For fields stemming from catalog templates, it depends on the state of the 
Show all fields from catalog templates option whether all these fields are dis-
played, or just the fields that are not yet included in the catalog.

A third tab, the Custom Field tab, enables the definition of your own custom 
fields so you can store information in addition to fields that Cumulus supports. 
(For details, see Creating a Custom Field.)

6. Select the field(s) you want to add.

7. Click OK. This brings you back to the fields list. 

8. Click Apply to save your changes.

If you want newly added fields to be shown in a view, you must customize the corre-
sponding view set and add this fields. 
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TIP: Copying String List Fields From One Catalog to Another

Copying a string list field with predefined values from one catalog to an other 
catalog would result (correctly) in having identical fields (same GUID, same list 
of values) in each of the two catalogs. However, if you then change the values 
of that string list field in one of the catalogs, but not in the other one, you end 
up having two seemingly identical fields (same GUID) in 2 different catalogs, 
but which in fact are not identical, because they have different list values. This 
could yield unwanted results in certain circumstances, e.g when you add such 
a field to a metadata template. (For details see String List Fields with Different 
Values.)
Therefore, make it a rule to copy string list fields from one catalog to an other 
only if you really want to have identical fields. And if for any reason you must 
change the field list definitions later, make sure to modify them the same way 
in all catalogs that contain the field in question.
On the other hand, if you want to have similar fields (as opposed to identical 
fields), i.e. fields with more or less different string list values in different catalogs, 
don't copy a field from one catalog to an other, but rather create a new field in 
the second catalog, thus ensuring that each of the fields has its own GUID.
Even then you may end up having (different) fields with identical names in dif-
ferent catalogs, which is confusing enough. Try to avoid this annoyance by giv-
ing your fields names that are truly unique and descriptive for all concerned 
catalogs.
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Updating Fields With Modified Definitions From Catalog Templates

The Add Field dialog can as well be used to update a catalog, or multiple catalogs, 
with modified field definitions derived from catalog templates. Especially if you want 
to update field definitions in multiple catalogs in a consistent way, it is strongly 
advised to first modify the field definitions in a catalog template, then import the mod-
ified field(s) from the template into the catalogs.

To update record or category fields from a catalog template:

1. Make sure the collection window is the active window in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings, then select the catalog you want to edit under Catalogs.

4. Select the Record Fields tab or the Category Fields tab.

5. Click Add Field. The Add Field dialog is displayed.

6. Make sure the Show all fields from catalog templates option is activated 
(checked).

7. Select the Modules tab and expand the Catalog Templates node and, if neces-
sary, the respective template node(s).

8. Select the fields that you want to update, or select an entire template.

9. Click OK. You will be prompted to confirm the update of the catalog fields.

10. In the Preferences dialog, click OK or Apply to finally make the changes take 
effect.
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Creating a Custom Field
To set up a catalog to store information in addition to fields that Cumulus supports, 
you can define your own custom fields.

NOTE: Same Custom Field for Multiple Catalogs
If you have created a custom field for one catalog, you can easily copy this field 
to another catalog. If multiple catalogs are opened in the same window, 
Cumulus will display the custom record fields of all these open catalogs in the 
list of the Fields tab. You can select a custom field of another catalog and add 
it to the current catalog. We recommend using this way of adding the same 
custom field to several catalogs, as only then will the field have the same GUID 
(Globally Unique Identifier) in different catalogs. And only when the GUID is the 
same, a custom field can be used for searching in different catalogs. Another 
advantage is that fields of the type String List already include the entries that 
have been made. 

With a standard Workgroup Edition you can create custom record fields only. An 
Enterprise Edition or an corresponding add-on product enables you to create custom 
category fields, too.

To add a custom field:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.
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The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields or Category Fields. This displays a list of the current record or 
category fields included in the catalog. 

5. Click the Add Field button. This brings up a dialog in which you can add a new 
field. 

6. Click the Custom Field tab. 

7. Enter a name for the field and select the type of field. 

8. Click OK. The new field is added to the list of fields included in the catalog. 

9. Define the field properties. 

• In the list you can activate certain options
– Sorting
– Contain Search 
– User Editable: If this is not checked, the field contents cannot be modified.

• In the Field Properties dialog you can define more options for the field. Select 
the field’s entry in the list and click the Properties button. The options available 
from the Field Properties dialog depend on the field type. For details, see “Over-
view: Field Properties” .

10. Click OK to close the Field Properties window. This brings you back to the fields 
list.

11. Click Apply to save your changes.

If you want this field to be shown in a view, you have to customize the corresponding 
view set and add this field. 
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Editing a String List Field 
To edit the entries of a String List field, the Field Properties dialog for the field must be 
displayed. The String List Editor tab lets you view and edit the terms of the selected 
String List.

Each term has an ID and can be stored in multiple languages. This is only important 
when working in a multilingual environment. If you want users who open the catalog 
with another language version of Cumulus to see the term in this language, you have 
to store the translation of this term. Depending on the language version of Cumulus, 
the term in the corresponding column will be displayed.

The String List Editor tab lets you edit an existing entry, add a new term or delete an 
existing term by using the corresponding buttons. Save any changes you make with 
the OK button of Field Properties window. They are valid as soon as you click the Apply 
button to save your Catalog Settings.

NOTE: When you edit a String List field that is contained in several catalogs, it is 
strongly recommended that you edit it in the same way in all containing cata-
logs. Otherwise you end up with seemingly identical fields (same GUID) in dif-
ferent catalogs, which in fact are not identical (different list values). This may 
yield unwanted results, e.g. when you try to add such a field to a metadata tem-
plate. (For details see String List Fields with Different Values.)

To create a new term for a String List field:

1. Click Add. 

2. Enter the new term in the dialog that appears and click OK.
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The new term appears in each language field of the list. 

If you are working in a multilingual environment, you can now double-click the field 
for a language and enter the translation for the term. A user will only have the terms 
of one language displayed. The language a user gets displayed initially depends on 
the language defined during the installation, but can be changed by the user anytime 
(see “Switch Application Language” , for details).

To edit a term of a String List field

1. Select the entry for the term you wish to edit.

2. Double-click the term in the language you want to edit in and type the new term 
in the field.

The term will be changed in all records that use it when you have saved the 
changes and closed the Properties window.

You can define the sorting of the terms of a String List field. You can select different 
sorting modes for a String List field:

• Alphabetical (default sorting mode) 
The terms of the String List field will be displayed sorted alphabetically according 
to the rules of the language of the application (e.g the Cumulus Client). This sort-
ing mode is useful for e.g. keywords.

• Content
The terms of the String List field will be displayed as sorted in this list – indepen-
dent from the language defined for the user. This sorting mode is useful for e.g. sta-
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tus descriptions. Use the arrow buttons to the right of the list to change the order of 
the entries.

• Language Specific
This mode allows you to define different sort orders for different languages. This 
sorting mode is useful for e.g. country selection where depending on language, 
different countries should appear on top of the list.

The sorting mode displayed for the String List field in the Select Mode field is the active 
mode, once you click OK for the Field Properties dialog.

If you want to define a sorting mode other than alphabetical: 

1. Select the Sorting Mode.

2. In case you decided on the Content sorting mode, use the arrow button on the 
right to define the order of the terms.

3. In case you decided on the Language Specific sorting mode, select a language 
and then use the arrow button on the right to define the display order of the 
terms of the selected language. Repeat this for each language.

You can delete an entry that you no longer need and replace it with another entry. 

To delete an entry:

1. Select the entry you wish to delete.

2. Click Remove. 

Cumulus prompts you to assign a new entry to those records or categories and 
displays a list of terms (in the language that is defined for you as Cumulus user).
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3. Select a replacement entry from the list and click OK. The new entry is assigned to 
all records previously associated with the deleted entry. This may take a while, 
depending on the number of records that require reassignment.
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Administering Asset Relations 
Asset relation types are catalog specific. Therefore they are administered via the Cata-
log Setting of the Preferences dialog. The Catalog Settings provide a Relations tab 
where you localize, edit, add, and remove asset relations types. (For details see Asset 
Relations Tab.)

Properties of a Relation Type
The properties of a relation type are:

• Name – Name of the relation type
• Description – Describes the relation type.
• Label Master Asset – Describes the relation from the master asset to its sub assets.
• Label Sub Asset – Describes the relation from a sub asset to its master asset. 
• Treat as master – If activated, the sub assets will be displayed and can be searched 

for by Cumulus Web Client.
Default: activated for the asset relation type Referenced only; not activated for all 
other relation types.

• Restrict edit to the following users and roles – If activated, the visibility of the field 
is restricted to the users (and roles, if your Cumulus runs in role mode) specified 
here. 
Click the appropriate button (Add User or Add Role. Note that the Add User but-
ton is available only if you have the Browse for Users permission.) These buttons 
open a corresponding dialog. For adding users, you can search for available users. 
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Localizing Relation Types
If you are working in a multi-language environment, you might want to translate the 
names and descriptions of asset relation types into other languages.

To translate a relation type’s name and descriptions:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Relations. This displays a list of the current relation types included in the cat-
alog.

5. Select the relation type you want to localize.

6. Click Localize. This opens a list containing the languages supported by Cumulus.

7. On the entry of the language you want to localize, click on the field you want to 
translate and replace the default text with your translation.

8. Click OK. This brings you back to the relation type list. 

9. Click Apply to save your changes.
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Preparing Catalogs for Special Purposes
Cumulus catalogs can serve various purposes. For some special purposes catalogs 
require special preparations. 

Optimizing Standard Metadata Format Support

Cumulus supports the standard metadata formats IPTC, EXIF and XMP. To prepare a 
catalog to support these standards Cumulus offers wizards. See “Prepare Catalog”, for 
details.

Configuring Web Links

The Cumulus Client offers a function that enables users to get Web link URLs for 
selected records, their assets, thumbnails or previews (Asset > Configure Web Link 
URL.) The links will work only if your Cumulus installation includes Cumulus Portals or 
Sites and the catalogs containing the records are set to be accessible via the Web (Cat-
alog Settings > General). The catalogs must:

• contain the following record fields (provided by the Cumulus application module): 
– Asset URL enabled (allows users to get links for the assets)
– Preview URL enabled (allows users to get links for the previews)
– Thumbnail URL enabled (allows users to get links for the thumbnails)
Note that if a catalog does not contain one of the corresponding fields the respec-
tive links cannot be created by any user. 

Also following prerequisites must be met:

• The function is available to users only if at least one Base URL for Web Access is 
defined in the Cumulus Server Settings (Server Console > Remote Admin> Set-
tings). (See “Cumulus Server Settings”,for details.)
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• In order to be able to configure Web link URLs, a user must have permission to 
write metadata for the catalog containing the respective records. 
• If using the User Manager in advanced mode the following Application Permis-

sions for records:
– Modify Items 

• If using the User Manager in simple mode the following permissions:
– Write Metadata
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Configuring Controlled Vocabulary

Controlled vocabulary schemes provide a way to organize knowledge for subsequent 
retrieval. Any Cumulus catalog supports controlled vocabularies once a custom field 
of the type Vocabulary was added. This type of field only accepts predefined values (= 
vocabulary terms) as input. 

Both record fields and category fields can be of the type vocabulary. Users can add 
vocabulary terms as metadata to records, but controlled vocabulary terms can also be 
used to build the categories in Cumulus catalogs, or to provide additional information 
on the categories.

The $Vocabularies Catalog

The predefined values that are needed for vocabulary fields – the vocabulary terms – 
are stored in a special catalog, $Vocabularies. This catalog has no records, but only cat-
egories. Each category of the $Vocabularies catalog represents a term of the vocabu-
lary. Therefore, adding terms to or removing terms from the vocabulary is a matter of 
creating or deleting categories in the $Vocabularies catalog.

Cumulus categories have their own metadata. The metadata fields of a category in the 
$Vocabularies catalog can be used to store various additional information on a vocab-
ulary term – a definition, information about the scope, or the terms that must not be 
used, a thumbnail, whatever.

However, there is one category metadata that is especially important: the Container 
Type. With the controlled vocabulary feature, the Container Type of a category is used 
to distinguish different vocabularies within one single $Vocabularies catalog – terms 
(categories) with the same Container Type belong to the same vocabulary. The Con-
tainer Type is also used as a means to precisely control which terms can be entered 
into a given vocabulary field, and which not (see below).
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A vocabulary administrator can add terms and their metadata either manually, or by 
import (for details see Importing and Exporting). Importing offers an easy way auto-
matically maintain or update your controlled vocabularies, and to use common con-
trolled vocabularies instead of developing your own. There are many different 
vocabulary schemes available in a broad variety of user environments and disciplines.

The $Vocabularies catalog must only be available to the user(s) who are in charge with 
maintaining the vocabularies. It must not be shared.

Preparing a Cumulus Catalog for Working with Controlled Vocabularies

• Adding vocabulary fields to Cumulus catalogs
As said before, controlled vocabularies can be used with any Cumulus catalog that 
contains at least one field of the type Vocabulary. You can add as many such fields 
as you need.

When adding a Vocabulary field to a Cumulus catalog, you can specify 

• whether the field can contain one single term only, or multiple terms (Enable 
multi-select);

• whether the field accepts terms fro all available vocabularies, or from selected 
vocabularies only by selecting the respective container types (Restrict Terms).
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.

• Preparing View Sets
In order to use controlled vocabularies, the respective fields in a catalog must be 
available to Cumulus users, which is achieved via Record View Sets and Category 
View Sets that contain these fields. The view sets must be shared. (For details see 
Record View Sets and Category View Sets)

Additional information on vocabulary terms can be stored in the category meta-
data fields of the $Vocabularies catalog and can be made available to Cumulus 
users. Such information can be provided in the Add Vocabulary Term dialog, or as 
a tool tip that is displayed when the mouse pointer hovers over a vocabulary term 
in Cumulus Portals, Cumulus Web Client, or Desktop Client. For this purpose, you 
need to prepare at least one additional (shared) Category View Set that specifies 
the category fields of the $Vocabularies catalog that shall be displayed. 

General tab of a Vocabulary field’s properties in the Catalog Settings.
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NOTE: Only metadata fields of type String, Date only, and Picture can be displayed 
as tool tips.

This category view set must be referred to as Category View Set for details in the 
display properties of any Vocabulary field that is enclosed in any view set to be 
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used with the Cumulus Web Client, or Portals, or the Desktop Client. If no Category 
View Set is selected here, the standard Category View Set is used.

The properties of a Vocabulary field in a Record View Set specify a Category View set that defines which 
additional information on a vocabulary term is displayed in the Add Vocabulary Term dialog, or the tool 
tip that is displayed when the mouse pointer hovers over a vocabulary term in Cumulus Portals, Cumulus 
Web Client, or Desktop Client.
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NOTE: With the Dynamic Field Visibility feature and the usage of separators you 
can refine and optimize the display of additional information even more, which is 
especially advisable if you employ multiple vocabularies that require different 
information on their terms. Thus you can ensure that only relevant information for 
a specific term is displayed. (See Dynamically Displaying Fields). 
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Securing Catalogs 
To prevent an unforeseen technical mishap from damaging or destroying your cata-
logs you should have a strategy. Cumulus offers the following mechanisms to pre-
serve catalog data in case of a failure:

• Backing up 
• Journaling 
• Mirroring
Canto recommends you to backup your catalogs regularly and in addition, to avoid 
losing changes made to a catalog after the most recent backup, employ either catalog 
journaling or mirroring as a second mechanism. Which mechanism is best depends on 
your needs. 

The advantage of journaling is that you can immediately continue working after a fail-
ure. 

Use mirroring for a catalog that is intended to serve as a ‘caching engine’ which for 
example saves data into an external SQL-compatible database Or with a second 
Cumulus Server, you can use mirroring for failover functionality and load balancing. 
The disadvantage of mirroring is that rebuilding a catalog from its mirror database 
might be very time consuming. (For a description on how to rebuild catalogs from 
mirrors, see “Repairing Catalogs” .)

IMPORTANT! Do not employ journaling and mirroring for the same catalog! 
Use one of the mechanisms depending on how the catalog is used. 

For backing up your catalogs regularly, Canto recommends you to use the Cumulus 
Backup Manager and in addition, to have rotating backups, you should include the 
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catalog files in your regular system backup provided by your server platform. (For a 
description on how to use the Backup Manager, see “Backup Manager” .)

TIP: Avoiding Improper Shutdowns of the Cumulus Server

To avoid improper shutdowns of the Cumulus Server always stop the Cumulus 
Server before you make any changes to the operating system that might cause 
a shut down of the system (e.g. updates). Shutting down the Cumulus Server 
might take a while depending on the number and size of catalogs managed by 
the Cumulus Server. Do not interrupt the shutdown process!

Windows only: When stopping a Cumulus Server under Windows check that 
the Cumulus Server service has stopped. You can check this either via the Ser-
vices Control Panel using the Refresh function (F5) or via the Task Manager (no 
Cumulus Server.exe in the processes list.)
UNIX only: When you are stopping a Cumulus Server under UNIX and stop-
cumulus.sh runs into a time-out, use status.sh to check that the Cumulus Server 
has stopped.

The next sections give more details on the journaling and mirroring mechanisms and 
describe how to activate them.
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Journaling Catalogs
Journaling Cumulus catalogs improves data security. A journaling catalog logs 
changes to a journal (special circular log files) before actually writing them to the cat-
alog. Such a journal is used to repair any inconsistencies that occur as a result of an 
improper shutdown of the Cumulus Server or the computer running the Cumulus 
Server. In the event of an improper shutdown, a given set of changes may have either 
been fully committed to the catalog (i.e., written to the hard disk), in which case there 
is no problem, or the changes will have been marked as not yet fully committed, in 
which case the system will read the journal, which can be rolled up to the most recent 
point of data consistency. Every time a Cumulus Server opens a catalog the journals 
will be read and executed.

SPECIAL TECH INFO:  Cumulus Catalog Journal

A Cumulus catalog journal consists of circular log files named as the catalog file 
with the extension .redo. These files are saved along with the catalog file in the 
same folder and can become quite large. Therefore, you must make sure that 
there is enough free disk space available. As rule of thumb: twice the size of the 
catalog file, or at least 5 GB is recommended. 

IMPORTANT! Copying or Moving Journaling Catalogs
When copying, moving or backing up a catalog externally, the journal of the 
catalog (all 5 *.redo log files) must be included, e.g. copied or moved along with 
the catalog file. 
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IMPORTANT! Using Backup Files Created by Cumulus
If you want to replace a damaged catalog file of a journaling catalog with a 
backup file created by Cumulus, you must delete the journal of the catalog (all 
5 *.redo log files) before you copy and/or rename the backup file. 

You activate journaling for a catalog in the Catalog Settings ( Cumulus / Edit > 
Preferences > Catalog Settings > General.)
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Database Mirroring
Mirroring enables you to use the Cumulus database as a ‘caching engine’ that for 
example saves data into an external SQL-compatible database. In this role, a Cumulus 
catalog serves as a permanent cache.

Saving the data in an SQL database offers the advantage that any SQL analyses are 
possible. However, changes made to the catalog data from within the SQL database 
are not copied back to Cumulus and therefore should not be made. When a mirrored 
catalog is rebuilt, the SQL database serves as master. Each catalog requires its own SQL 
database.

Canto provides a plug-in that includes support for different SQL database systems. 
(The support for Oracle is available with Cumulus Enterprise only.) If you require sup-
port for another database system, contact Canto. Each database system requires it 
own JDBC driver. The JDBC drivers for most systems are pre-installed; except one: The 
official JDBC driver for MySQL must be downloaded from the MySQL website 
(www.mysql.com). Currently the driver is available under: 
http://dev.mysql.com/downloads/. The driver must be copied to the appropriate subfolder 
of the esp folder in your Cumulus Server installation folder. The subfolder dbmirror 
contains a folder named lib. Copy the downloaded driver into this lib folder (e.g to 
..esp/dbmirror/lib).

Cumulus catalogs of a second Cumulus Server installation can also serve as mirroring 
target databases. For more information, see “Using Cumulus Catalogs as Mirroring Tar-
get Databases” .

A catalog is set up for mirroring on the Mirroring tab of a catalog’s settings 
( Cumulus / Edit > Preferences > Catalog Settings.) 
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PRECONDITIONS: To set up a catalog for mirroring, you must have the appropriate 
Administrator permissions (Permissions > Administrator Permissions > Manage Mir-
roring (option for the Modify Catalog Settings permission.) 

If you want to use mirroring, you should activate it directly after you have installed 
Cumulus, or after new catalogs are created. Note that once you activate the mirroring 
option for a catalog, the initialization can take some time, depending on the size of the 
catalog. (And the process cannot be paused – if interrupted, it must be started from 
the beginning.)

NOTE: Never set up multiple catalogs for mirroring at once! 
Start the process for a subsequent catalog only after the previous catalog has 
been completely processed. 

If mirroring is activated, the events to be saved in the SQL database are written in a task 
queue. For safety reasons, each task is saved in a temporary internal file. This file is 
deleted after the task is successfully processed. Storage locations for the queues and 
safety files are defined in the server.xml file found in the conf folder in the Cumulus 
Server installation folder. You define the basic or “root” folder for the files. This folder 
will house the subfolders for the queues—one subfolder for each queue (named as 
the unique identifier given for the queue). The default storage location is the Cumulus 
Server installation folder. If you want to use mirroring, you should define the storage 
location directly after you install Cumulus. The collection of these files can become 
quite large, requiring ample storage space. The required space depends on the SQL 
database system and the amount of data stored in each asset. There is a difference 
between the initial process and normal operation. As rule of thumb: twice the size of 
the mirrored catalog file is recommended. 
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Note that if you have a catalog mirrored to a SQL database, you should back up the 
target database and not the original Cumulus catalog. For information on how to 
repair a mirrored catalog using the target database, see “Repairing Catalogs” . 

NOTE: Mirroring catalogs employing Solr index 
When mirroring a catalog that uses the Solr index, the mirrored catalog uses 
the same Solr instance as the original catalog. When using the mirrored catalog, 
it might be possible that the Solr indexes need to be rebuilt.
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Error Management
Basic mirroring errors are written to the system log of the Cumulus Server (e.g. when 
mirroring could not be started.) Errors that occur while mirroring is running are logged 
as configured in the log4j.xml file, which is found in the conf folder in the Cumulus 
Server installation folder. Canto recommends you have one log file for all mirroring 
events and set up email notification for all errors that occur while mirroring. 

If the SQL database addressed by mirroring is not available, an error will be logged and 
the Cumulus Server will try to process the current task again and again. As soon as SQL 
database is available again, the process is resumed automatically. However, if it cannot 
be resumed, the size of the task queue will grow with any change performed on the 
catalog.

TIP: Finding the Short ID of a Field

To find out the IDs of a field you can have them displayed in the list of fields in 
the Record Fields tab or the Category Fields tab of the Catalog Settings (Edit 
> Preferences > Catalog Settings). 
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BACKGROUND INFO:  Performance

The performance depends on the SQL database system in use. During normal 
runtime testing, Canto did not experience performance delays or differences 
between different SQL database systems. The time needed for the initial pro-
cess, however, depends on the SQL database in use. The time needed for the 
initial process is also influenced by the cache size available for the Cumulus 
Server (can be configured in the Server Console: Remote Admin > Settings > 
Optimization.)
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Using Cumulus Catalogs as Mirroring Target Databases
Cumulus catalogs can also serve as mirroring target databases. This requires a second 
Cumulus Server installation. Then one Cumulus catalog can be mirrored to another 
Cumulus catalog of the other Cumulus Server installation. This offers failover function-
ality and load balancing. A target Cumulus catalog at the secondary Cumulus Server 
is set to read only. With read-only applications (e.g. Web Publisher Pro) it can be used 
as a read-only replica and take load from the primary Cumulus Server. Note that 
Cumulus Triggers only work in the original catalog. 

NOTE: Mirroring Cumulus 6 Catalogs
If you mirror a Cumulus 6 catalog, the target catalog will always be a Cumulus 7 
catalog. 

When using Cumulus as target database system, the following data are required to 
define the database serving as mirror: 

• Server – IP address of the computer hosting the Cumulus Server
• User – Login name of the Cumulus Administrator of the Cumulus Server used as 

mirror. 
• Password – Password of the Cumulus Administrator of the Cumulus Server used as 

mirror.
• Database Path – Path of the Cumulus catalog file 

NOTE: You can either enter the path of an existing catalog or have a new one cre-
ated by entering its path. 
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Setting up a Catalog for Mirroring
Before you activate mirroring for any catalog, the location for queues and the task 
safety files should be configured. The location is defined in server.xml file, which is 
found in the conf folder in the Cumulus Server installation folder.

The initial process setting up a catalog for mirroring takes some time, depending on 
the size of the catalog file and the SQL database system in use. During this time, other 
users are blocked from accessing the catalog. For this reason, Canto recommends you 
deactivate the sharing option for this catalog before you start the initial process. 

To set up a catalog for mirroring:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window appears. If the active collection window contains 
more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Mirroring. This displays the current settings for the selected catalog. 

5. Activate the Use Database Mirroring option.

The fields for the mirroring target database are activated.

6. Select the database system you want to use. Depending on the selected data-
base system, the fields for defining the actual database are displayed. 

7. Enter the data required. You must define a different target database for each cata-
log to be mirrored.
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Example: With a MySQL 5 database, the following data are required:

• Server – IP address of the server hosting the SQL database
• Database – Name of the SQL database 
• User – Login name of the SQL database user 
• Password – Password for the SQL database user

NOTE: If the target database is another Cumulus catalog, you can either enter the 
path of an existing catalog or have a new one created by entering its path. 

8. Click OK to start the mirroring. The field below the definition fields informs you on 
the status of the mirroring.

NOTE: If you want to set up multiple catalogs for mirroring, don’t start the process 
for the next catalog before the current catalog has been completely processed. 

To stop the mirroring for a catalog, deactivate the Use Database Mirroring option and 
confirm the action by clicking Apply or OK. Before you stop the mirroring you should 
consider that starting it again, will start the mirroring for the entire catalog from the 
beginning again. 
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New Catalogs
New catalogs can be created by the Cumulus Administrator only. The Cumulus 
Administrator is also responsible for providing catalogs to Client users. 

Creating Catalogs
To create a new catalog you can log on to the Cumulus Server from any Cumulus 
Client and tell the Server where the catalog is to be stored and what you want to call it.

To create new catalogs:

1. Log on as Cumulus Administrator to the Cumulus Server.

2. In the Catalog Access window, click New.

The Create New Catalog window and, on top of it, the Browse window appear.

3. From the Look In drop-down list, select the location where the new catalog shall 
be stored. (Only locations approved by the Cumulus Administrator are accessible).

4. In the File Name field enter a name for the new catalog, then click OK.

The Browse window is closed. In the Location field of the Create New Catalog 
window, the location and the name of the new catalog are displayed. The file 
extension.ccf is added automatically.

5. From the Select a Template drop-down list, select a template.

6. Click OK.
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The new catalog now appears in the catalog list of the Catalog Access window. 

So far, the new catalog is only available to the Cumulus Administrator. In order to make 
a catalog available to other Cumulus users the Cumulus Administrator must share it.
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Sharing Catalogs
In order to be available to Cumulus users, a catalog must be shared by the Cumulus 
Administrator. Catalog access can be shared to users of the Cumulus Desktop Client 
only, or granted to users of the Desktop Client, Cumulus Web Client and Cumulus Por-
tals likewise. Sharing catalogs is performed via the Preferences window of the 
Cumulus Desktop Client.

To share a catalog:

1. Logged in as the Cumulus Administrator, select Cumulus / Edit > Prefer-
ences. 

2. Click Catalog Settings.

3. Under Catalog, select the catalog that you want to share.

4. Select the General tab.

5. In the Sharing section activate Share catalog.
This makes the catalog available to Cumulus Desktop Client users.

Additionally, activate Allow Web Access.
This makes the catalog available to users of the Cumulus Web Client.

Click Apply to save your settings.

The selected catalog now is available to other Cumulus users. 
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NOTE: The Allow Web Access option does not affect the availability of catalogs 
for applications based on the Cumulus Integration Platform(CIP), such as 
Cumulus Portals!
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Catalog Templates
You can define templates that you can use to create new catalogs, prepare existing 
catalogs for specific usage or even update older catalogs. There’s no faster way to get 
new catalogs up and running, or to consistently replicate updates made to one cata-
log on another catalog. Create new, pre-configured image databases, video catalogs, 
PDF archives and more, from a single menu item – no more redundant catalog tweak-
ing necessary!

PRECONDITIONS: To create and edit Catalog Templates, you must have the appropri-
ate permissions (Server Permissions > Catalog Template Permissions.) 
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Creating and Editing a Catalog Template
To create a new Catalog Template you can save the settings of an existing catalog as 
Catalog Template or duplicate a template.

To create a new Catalog Template by duplicating an existing one and adapting its set-
tings:

1. Select Cumulus / Edit > Preferences. 

2. Click Catalog Templates.

3. Under Template, select the Catalog Template to be used as a basis for the new 
one.

4. Click the Duplicate button. The Name and Settings dialog opens.

5. Enter a name for the new template, and optionally

• Activate the Allow Sharing option, if you want this view set to be available to 
other users.

• Activate Copy display names only, if you also want to take over the language-
specific display names from the original (not recommended for new catalog 
templates).

• Activate Copy description only, if you also want to take over the descriptions 
specified for other languages from the original (not recommended for new cat-
alog templates).

6. Click OK. The Catalog Template window is displayed.

7. Define the new Catalog Template. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING CATALOGS NEW CATALOGS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

8. Click Apply to save your changes.

To create a new Catalog Template by saving the settings of an existing catalog as Cat-
alog Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Catalog Settings.

3. Under Catalog, select the Catalog to be used as a basis for the new Catalog Tem-
plate.

4. Click the Save as Catalog Template button. The Name and Settings dialog 
opens.

5. Enter a name for the new template, and optionally

• Activate the Allow Sharing option, if you want this view set to be available to 
other users.

• Leave Copy display names activated, if want to take over the display names 
specified for other languages from the original.

• Leave Copy description activated, if you want to take over the descriptions 
specified for other languages from the original

6. Click OK. 

To change an existing Catalog Template:

1. Select Cumulus / Edit > Preferences. 
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2. Click Catalog Templates.

3. Under Template, select the template you want to edit. The settings for the 
selected template are displayed in the Catalog Template window.

4. Make your changes. 

5. Click Apply to save your changes.
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The Catalog Template Window
The Catalog Template window controls several important factors that come into play 
while managing assets. The options are divided into the following sections:

• General – Options for Catalog Templates
– Keep Category Names Unique – Prevents the creation of new categories that 
share names with existing categories.
– Use Journaling – Activates journaling for the catalog. (See “Journaling Catalogs”)
– Use Template for Catalog Creation – Makes the template appear in the Get Cat-
alog Template dialog when creating a new catalog. So do not activate this option, 
if you want to use a Catalog Template for preparing other catalogs only. 

• Record Fields – Displays the record fields that a new catalog will contain. You can 
add or delete fields and customize selected fields. This allows you to organize the 
information that can be stored on an asset in its record. Remember, metadata 
retrieved from assets while cataloging can only be stored if the corresponding 
record fields are included in the catalog. For details on how to add and configure 
record fields, see the corresponding descriptions in the chapter “Catalog Settings” .

• Category Fields – Displays the category fields that a new catalog will contain. You 
can add or delete fields and customize the fields. For details on how to add and 
configure category fields, see the corresponding descriptions in the chapter “Cat-
alog Settings” .
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TIP: Using Catalog Templates to Update Older Catalogs

You can use Catalog Templates to provide specific catalog fields for other cat-
alogs. When adding fields to a catalog, click on Modules and you are also 
offered the fields of Catalog Templates.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING CATALOGS CATALOG MAINTENANCE

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Catalog Maintenance 
Taking regular care of your catalogs ensures not only the best performance, but also 
your data security.

• Catalog Size and Performance
• Compressing Catalogs
• Backing Up Catalogs
• Preparing Catalogs for Special Metadata
• Copying Catalogs
• Repairing Catalogs
• Renaming Catalogs
• Deleting Catalogs
• Dividing Catalogs
• Merging Catalogs
• Migrating Catalogs
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Catalog Size and Performance
The biggest factor affecting catalog size is the number of records in the catalog. There 
is no hard limit on the number of records that a catalog can hold, but catalog files can-
not be larger than one terabyte in size. 

As multiple catalogs can be opened in one window, an advantage of this is that it 
makes it easier to search for an asset. Workgroups with large catalogs can now split 
them into multiple catalogs and be able to open and search them in one Window. The 
beauty of smaller catalogs is that, the time required to repair, restructure or reorganize 
a catalog is reduced tremendously. Furthermore, if a particular catalog is being 
repaired or restructured, the assets in the other catalogs will be unaffected and can still 
be accessed.

Search times, however, are not affected by catalog size. 

Record Size

The actual number of records you can fit into the catalog size limit depends on the 
individual records’ sizes. Factors that determine a record’s size include:

• The type of asset the record represents. Different asset types have different infor-
mation that needs to be stored to identify them, so their records use varying 
amounts of catalog space. For example, a video clip uses space for frame rate and 
total frame number fields that a simple image doesn’t require.

• The amount of text in the record’s Notes field. All those characters in the Notes 
field have to be stored somewhere! If you add 1k worth of text, you add 1k to the 
record size. Multiply that times a thousand or so records and you have added an 
entire megabyte to your catalog’s size.
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• The record’s thumbnail size and quality. Larger and higher quality thumbnail 
images take up more space. (See “Catalog Settings” , for information on thumbnail 
settings.)

Typically, your catalogs will never reach the maximum size. If they do, you’ll need to 
divide them. (See “Dividing Catalogs”.)

Speeding Up Cataloging

As a catalog grows, the time required to catalog new assets increases. There are a few 
tricks for Asset Handling Sets that you can do to increase performance when catalog-
ing large amounts of assets at once:

• Choose Catalog Duplicates on the Cataloging tab. This option prevents Cumulus 
from having to “think” too much about what it is cataloging. (See Client User Guide 
“Overview: Asset Handling Sets” for details.)

• Deactivate any asset formats that you don’t need.  (See Client User Guide “Asset 
Format Support” for details.)
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Compressing Catalogs
Compressing a catalog reduces the actual size of the catalog file. This can be useful e.g. 
if you have deleted a huge amount of records (because deleting records does not alter 
the size of a catalog file). Smaller catalog files can speed up both cataloging and 
retrieval processes. Furthermore, they are easier to back up than bigger ones. 

To compress a catalog:

1. Make sure the catalog you want to compress is the active window in Cumulus. If 
you have more than one catalog opened in the active window, you will be asked 
to select the catalog.

2. Select File > Administration > Compress Catalog. (Only active if the catalog is 
not yet compressed as much as possible.) A confirmation window is displayed.

3. Click OK to compress the catalog.
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Backing Up Catalogs
The value and usefulness of a Cumulus catalog increases exponentially as the catalog 
grows. To prevent an unforeseen technical mishap from damaging or destroying your 
catalogs (and your work schedule), consider regular and frequent backups.

It is important to remember that backing up a Cumulus catalog does not back up the 
catalog records’ associated asset files. Make sure that all your important files are 
included in your regular backups.

There are different ways of backing up a catalog:

• Any backup software program
• With the Cumulus Backup feature
• With the Cumulus Backup Manager
The first way may be the quickest and most convenient, particularly if you already use 
a backup software program. A Cumulus catalog, being just another file on your com-
puter, can be copied to other volumes, or included in a network or automated backup. 
Catalogs should be closed before they are copied to other volumes to ensure that all 
changes are safely saved. However, you can back up an open catalog, if you employ 
the Cumulus Backup feature. The Cumulus Backup Manager is included in the 
Cumulus Server Console. 

To back up a catalog using the Backup feature:

1. Make sure the catalog you want to back up is the active window in Cumulus. If 
you have more than one catalog opened in the active window, you will be asked 
to select a catalog.
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2. Select File > Administration > Backup Catalog. The Backup window opens. 

3. In the Backup File Name field, either 
– enter the name and path for the backup catalog (using the path and file naming 
conventions of the operating system your Cumulus Server is installed on)
OR
– click Browse to select a location for the backup catalog and then enter the 
name for the backup catalog. (The area you are allowed to browse is defined in 
the Cumulus Server Settings).

NOTE: The name for the backup catalog file can be the same name as the original 
catalog file with the file name extension .bak. You may also choose the file name 
extension .ccf. There is no difference in format, but then you may need to choose 
a different name or a special backup location to avoid confusion with the original 
catalog. 

4. Click OK. The catalog is saved in the format selected.

IMPORTANT! Using Backups of Catalogs Employing Solr Index 
Before using a backup of catalog that employs Solr indexes, all Solr indexes 
need to be rebuilt.
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Preparing Catalogs for Special Metadata
If you want to capture IPTC, XMP or EXIF data from assets (and to write back such data 
to assets), the catalog(s) managing these assets and the Asset Handling Set(s) to be 
used must be prepared. Cumulus provides special functions for this. 

File > Administration > Prepare Catalog opens a submenu with options for prepar-
ing catalogs to manage different standard metadata formats.  
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Copying Catalogs
The Backup function described above is Cumulus’ mechanism for copying catalogs in 
their ready-to-use state. You can also use the conventional ways of copying files on 
your computing platform to make copies of Cumulus catalogs. Remember, copying 
catalogs does not copy the associated asset files. 
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Repairing Catalogs
If a catalog becomes damaged, Cumulus may be able to rebuild it. When you try to 
open a damaged catalog, Cumulus asks to repair it. You can also initiate the repair pro-
cess for local catalogs from within the program by selecting File > Administration > 
Rebuild Catalog. For repairing remote or mirrored catalogs, use the Rebuild button in 
the Catalog Access window when logged in as administrator (File > Connect To.)

Catalogs are most commonly damaged by an abnormal termination of the Cumulus 
Server that, for example was caused by an improper shutdown or a system crash.

After choosing the rebuild function, a dialog opens that asks whether you really want 
to do this. If you used the Rebuild button in the Catalog Access window, you are 
offered two options. 

If you choose Rebuild Locally, the catalog is rebuilt locally on the information found. 

If you choose Rebuild from Mirror, a window is displayed that contains all relevant 
information, if the catalog can provide it. If this is not the case, you must enter the 
information required to identify the mirror manually. 

Enter the required information, if necessary, and click OK. Then Cumulus will rebuild 
the catalog with the data from the mirror and – if there is one – from the queue.

The rebuilt catalog becomes the master of the catalog from which it was rebuilt (the 
slave catalog), i.e., all further changes to the rebuilt catalog are automatically mirrored 
to this slave catalog. 

NOTE: Catalog rebuilding is performed in the background. However, this pro-
cess can affect the performance of the Cumulus system. 
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Where to Get the Queue ID?

Each mirrored catalog has an XML file (*.ccm) that contains the mirroring information. 
This file is stored in the same folder as the Cumulus catalog. It provides the information 
on the queue ID under CUID. In the following example the queue ID is {FF9E643F-
11BB-4E95-9B62-6BAFE841A5F8}.
<?xml version="1.0" encoding="UTF-8"?>
<ns:record xmlns:ns="http://www.canto.com/XML/ns/Package/1.0">
<ns:guid
ns:key="MMod">{FAB9CC52-C721-4720-A2D4-3450EABA88F2}</ns:guid>
<ns:int32 ns:key="UseM">1</ns:int32>
<ns:guid
ns:key="CUID">{FF9E643F-11BB-4E95-9B62-6BAFE841A5F8}</ns:guid>
<ns:record ns:key="MCnf">
<ns:string ns:key="Serv">dell470</ns:string>
<ns:string ns:key="DBas">test</ns:string>
<ns:string ns:key="User">thomas</ns:string>
<ns:binary
ns:key="Pass">8106DF418C242DD52F0D31C1E9012969BE05FF0C</
ns:binary>
</ns:record>
</ns:record>
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Renaming Catalogs
Cumulus catalogs actually have two names:

• One is the name of the catalog file, as you see it from your computer’s desktop. This 
is called the catalog file name.

• The other is the name of the catalog, as seen in the catalog window’s title bar. This 
is simply called the catalog name.

When a catalog is first created, the catalog name defaults to the same name as the cat-
alog file. Newly created catalogs are named the same as their file names by default, but 
the catalog name can be changed at any time. 

Before you rename a catalog, be aware that a catalog’s name is an internal reference 
within Cumulus. The catalog name is the name users will see when connecting to cat-
alogs, and it also appears at the top of catalog windows. It’s important to remember 
after renaming a catalog, that you must update the permissions of any users (or roles) 
that have restricted catalog access that includes access to the renamed catalog. This 
is because restricted catalog access permission is based on the names of catalog, so 
users will not be able to access renamed catalogs until those newly renamed catalogs 
are added back into the list of accessible catalogs for that user (or role). 

Note that catalogs cannot be renamed while set to use the Cumulus Vault in Always 
and Exclusive mode.

To change a catalog name (what you see in the catalog window):

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.
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2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click General. You’ll see a field labeled Name.

5. Enter a new name for the catalog in the Name field and click OK. The change is 
saved and the window closes.

You change a catalog’s file name as you would any other file. 
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Deleting Catalogs
Unlike deleting records, deleting catalogs is not undoable. (Unless you have a disk util-
ity program that makes recovering deleted files possible.) Cumulus has no built-in 
mechanism for deleting catalogs. Delete catalogs as you would any other file on your 
computer. Remember that assets are not deleted with catalogs. Catalogs must be 
closed to be deleted.
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Dividing Catalogs
At some point you may wish to divide the contents of one catalog into smaller cata-
logs. Reasons for doing so include:

• The catalog has grown close to its maximum size (e.g. 1 terabyte).
• Your computer can no longer accommodate the number of records in the catalog 

effectively (processor or RAM limitations).
• The contents of the catalog have become too diverse to be usefully categorized in 

one catalog.
Like many operations in Cumulus, there is more than one way to divide a catalog. The 
first way is best suited to smaller numbers of records.

To divide a catalog using drag and drop:

1. Make sure the catalog from which you wish to divide is the active window in 
Cumulus.

2. Create or open the catalog you wish to move records into in a separate window. 
Arrange the catalog windows so that you can see both.

3. Search for the records you wish to move to the new catalog, using any of 
Cumulus’ search options. 

4. Click on or near a thumbnail in the original catalog and select Edit > Select All to 
select the records. (At this point you could cut and paste the records between the 
catalogs as one way of moving them, which would save you the step of deleting 
the old records in the old catalog.)
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5. Click on the thumbnail of any of the selected records and drag the set into the 
new catalog window. A window is displayed allowing you to select whether the 
copied records shall maintain their category assignments (categories not yet 
existing in the target catalog will be created), or whether all category assignments 
shall be ignored. 
The records are copied with or without category assignments, according to your 
selection. 

NOTE: Cumulus doesn’t consider copying records from one catalog to another as 
“cataloging assets.” Therefore, the Asset Handling Sets have no effect on this 
action. 

6. You can optionally delete the records from the old catalog by first clicking on the 
old catalog’s window to activate it, and then selecting Edit > Delete before the 
selection of records has changed.

To divide a catalog containing a very large number of records, it may be easier to 
export the records from the old catalog and import them into the new catalog. (See 
“Importing and Exporting”.)

After the export/import process is over, you can delete the records from the old cata-
log, as described above.

NOTE: Only with the drag & drop method you can decide on the handling of 
category assignments, The copy & paste and the export & import methods 
always preserve the category assignments of the copied records.
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Merging Catalogs
Merging catalogs requires some forethought in order to be done properly. If both cat-
alogs contain identical category structures, the process is easy and can be done in dif-
ferent ways:

• Drag and drop records between catalogs.
• Using Cumulus’ export and import features.
“Dividing Catalogs,” above, describes each process.

But if the category structures of the two catalogs differ, there are a few extra steps to 
take. (See “Importing and Exporting”.)
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Migrating Catalogs
With Cumulus 11, catalogs created with Cumulus 9 or 10 can be used without prob-
lems. However, if you want to use the Extended Search Indexing option with a catalog, 
this catalog must first be explicitly migrated to the Cumulus 11 catalog format.

A catalog’s type and size is displayed in its Catalog Settings window ( Cumulus / 
Edit > Preferences > Catalog Settings > General tab.)

Explicit catalog migration can be performed with catalogs that are opened at the 
Cumulus Server, as well as with catalog files that are disconnected from the Cumulus 
Serverin:

• Migrating a Catalog while opened at the Cumulus Server 
• Migrating a Cumulus Catalog File 

IMPORTANT! Once a catalog has been explicitly migrated to the current 
Cumulus version, it can no longer be opened with a previous version of 
Cumulus! Canto recommends you to backup the catalog before you start the 
migration process!
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Migrating a Catalog while opened at the Cumulus Server
If you need to migrate a Cumulus catalog while it is opened at the Cumulus Server:

1. On the Cumulus Client, select File > Open Catalog.
The CatalogAccess window is displayed.

2. Select the catalog you want to migrate and click Migrate.
The migration process is started. A progress bar is displayed.

During the migration process, the catalog is disconnected from the Cumulus 
Server and can not be used. Once the progress bar disappears, your catalog is 
migrated to the current Cumulus catalog format, connected with the Cumulus 
Server and ready for use.

The catalog will be migrated in place. The time needed for the migration depends on 
the size of the catalog file: the larger the catalog file, the more time is required. 
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Migrating a Cumulus Catalog File 
To migrate a catalog created with an earlier Cumulus version, which is currently not 
opened at the Cumulus Server:

1. On the Cumulus Client, select File > Administration > Migrate Catalog. A win-
dow for selecting a catalog file is displayed. 

2. Select the Cumulus catalog file you want to migrate and click Open. 

3. Select a name and location for the migrated Cumulus catalog file and click Save. 
A progress bar is displayed indicating the status of the conversion.

Once the progress bar disappears, your catalog file is migrated to the current 
Cumulus catalog format and saved in the location you selected.

Catalogs that are disconnected from the Cumulus Server can also be migrated to the 
current Cumulus version on the Cumulus Server machine, using the Cumulus Tool. 

To migrate a catalog with the Cumulus Tool:

1. On the Cumulus Server machine, open a shell and type
CumulusTool -migrate <catalog source file> <catalog target file>

In order to be used in Cumulus, the resulting new catalog file must be added to the 
Cumulus Server using the Catalog Access window.
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NOTE: If problems occur during a catalog migration, try repairing the catalog 
using your former Cumulus version. Choose the Repair option under the 
Administration menu and then try the migration again. 
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Using Server Console Modules
The Server Console combines administration tools for Cumulus Workgroup and Enter-
prise. Some of the Server Console modules are specially designed for catalog manage-
ment. You need the appropriate Administrator permissions to use these modules.

• Logging of Catalog Activities
• Activity Monitor
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Logging of Catalog Activities
The Log Manager module presents a number of options from which you can enable 
a log file for a catalog and define its content.

PRECONDITIONS: To manage a log file for a catalog, you must have the appropriate 
Administrator permissions (Catalog Permissions > Administrator Permissions > 
Manage Log Files.) 

To enable and define the logging of a catalog:

1. Select File > Administration > Server Console, or connect to the Web Server 
Console via a Web browser.

2. The Server Console application is started. Log on as Cumulus Administrator to the 
Cumulus Server that manages the catalogs you want to have logged.

3. Select Log Manager. The Log Manager Properties window opens.

In the field Default Log Folder you may enter another folder to serve as the 
default folder for log files.

4. In the field Catalog, select the catalog you want to have logged. You can only set 
the logging properties for catalogs for which you have the appropriate Adminis-
trator permissions: Manage Log Files.

5. Then define the logging properties for the selected catalog.

• Click Enable Logging if you want the logging to be active. 
• In the field Log Folder you may enter another folder other than the default 

folder to serve as the folder for the log file(s) of the current catalog. 
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• If you want a separate log file for each day, enable Daily Log File. Daily log files 
have the advantage that you can delete those you no longer need.

• Select the columns you want the log file to contain as well as their sequence by 
clicking the arrow buttons. To delete a column just click the minus option in the 
list: –

• Select the events you want the log file to contain by check marking them.
6. Click Save Changes. The catalog’s activities will be logged in a file named after the 

catalog. If you enabled Daily Log File the date is added to the name (year-month-
day).
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Activity Monitor
You can monitor catalog activities with the Activity Monitor module of the Server Con-
sole.

PRECONDITIONS: To monitor a catalog’s activity, you must have the appropriate 
Administrator permissions (Catalog Permissions > Administrator Permissions > 
Monitor activity) for the respective catalog.

The Activity Monitor shows:

• the activity on the Cumulus Server
• information about any logged-in user, e.g. host address, catalog(s) the user is con-

nected to, time of login, duration of session, etc.
Furthermore, the Activity Monitor allows to

• disconnect users (see Disconnecting Users from a Catalog)
• send a message to selected users (see Sending a Message to Selected Users)
• show server statistics (see Obtaining Server Statistics)

To access the Activity Monitor:

1. Select File > Administration > Server Console, OR connect to the Web Server 
Console via a Web browser.

2. The Server Console application is started. Log on as Cumulus Administrator to the 
Cumulus Server that manages the catalog you want to monitor.

3. Select Activity Monitor to open it in the right side panel.
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The activity bar at the top of the window indicates the activity of the Cumulus Server 
(the Server Console of the Desktop Client additionally provides a Server Statistics but-
ton).
Below the activity bar, the Connected Users list is displayed with the following col-
umns:

• USER – names of currently connected users 
• HOST – name/IP address of the computers from which a user is connecting
• CATALOGS – the catalog(s) to which the user has been connected during the cur-

rent session
• TIME OF LOGIN – date and time when the connection was started
• DURATION OF SESSION – in hh:mm:ss
• CONNECTION ID – unique ID of the current connection
• VALID CONNECTION – indicates whether the connection with the given connec-

tion ID is still valid (true), or no longer (false)
• ADMINISTRATOR – whether the user is an administrator: true or false
• READ-WRITE – indicates whether it’s a red-write connection (true), or a read only 

connection (false) 
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Disconnecting Users from a Catalog
Before you configure catalog properties or perform catalog maintenance tasks, you 
should disconnect all users currently working with the catalog.

To disconnect users from a catalog:

1. In the Activity Monitor window select the user(s) to be disconnected and click 
Disconnect User.

A dialog appears for you to specify how long Cumulus should wait before discon-
necting, and to write an instant message to these users, letting them know why 
they’re being disconnected.
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Sending a Message to Selected Users
You may send messages to a single user or to multiple users at once. To send a mes-
sage:

1. In the Activity Monitor window select the user(s) to which you want to send a 
message and click Send Message. 
The Send Message window appears.

2. Enter the text of your message and click OK. The message is sent.

The message is displayed in an information window on the desktop of the selected 
user(s). The user must click OK to close the information window.
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Obtaining Server Statistics 
With Server Statistics, you can obtain a lot of information about performance, work-
load and capacity of the Cumulus Server. Such information can be useful to track 
down and identify the source of various performance problems that may occur with 
a Cumulus Server. If in doubt on how to act on these information, contact Cumulus 
Professional Service!

To display server statistics, either on the Web Server Console or on the Server Console:

1. When the Activity Monitor pane is displayed, select Actions > Server Satistics 
from the menu bar, OR
rigth-click the Activity Monitor entry in the navigation pane and select Server 
Satistics, OR
click the Server Statistics Button (Server Console only).

The Server Statistics window is displayed.
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The Server Statistics window is an information window that provides two tabs, Mea-
sured Sizes and Numbers and Time-based Statistics.

• Measured Sizes and Numbers – this tab provides information on memory usage, 
required disk space, and some characteristic numbers.

• Virtual Memory Size – amount of memory needed by the Cumulus Server.
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• Memory in Use – actual amounts and percentage values of currently used 
memory, specified by catalogs, connections, temporary cached session data, 
shared sets, private sets, and cached user data.

• Memory Used by Cumulus Tool Processes – amount of memory used by all 
currently active Cumulus Tool Processes.

• Sizes on Disk – amount and percentage value of disk size currently used for 
each catalog, and for Session Data.

• Numbers – of sessions, connected clients, cached users, and Cumulus Tool pro-
cesses. Also for each catalog the numbers of free, used, and finalized Redo files.

• Time-based Statistics – this tab reveals how often the cache limit has been hit in 
each of the past 24 hours. If there is a significant number of page limit hits, you may 
consider to adapt the cache size of the Cumulus Server (via Remote Admin > Set-
tings > Optimization; for details see Optimization (29 - 31).

Saving Server Statistics

The displayed server statistics values can be saved in JSON format, e.g. to communi-
cate them to Cumulus Professional Service.

To save the server statistics values

1. Click Save As.

A file named ServerStatistics.json is saved to your browser’s standard download 
folder. (Depending on your browser, you may additionally be prompted to decide 
how to handle the downloaded file.)
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Archiving Information
Many organizations maintain several catalogs: one catalog for production assets and 
a second catalog to manage archives. With Cumulus you can also take your assets off-
line, update the file references, and still be able to search and retrieve them. 

In general, archiving assets involves the following steps:

1. Copy and/or move the assets you wish to archive to the other media. 

2. Merge the records you wish to archive into an archival catalog by first copying the 
categories and then the records. For more information, see “Merging Catalogs” .

3. Update all asset references in the archive catalog. 

4. If desired, delete the records you archived from your production catalog.

IMPORTANT! Updating Asset References
Cumulus tracks the location of media assets through asset references. When-
ever you move an asset, you must update the asset reference to reflect the new 
location. 
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Setting Up
Multilingual Cumulus

For users working in a multi-language environment Cumulus provides full multi-lan-

guage support. What does full multi-language support mean? In addition to providing

the software UI in different languages, it means maintaining metadata in multiple lan-

guages.

Cumulus can store the translation of metadata in multiple languages and the user can

work with the metadata in the matching language. 

The following sections describe how Cumulus has to be set up for displaying and main-

taining metadata in different languages and how the different Cumulus Clients deal

with the multi-language support.
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Overview
Cumulus supports various languages in various ways. 

• localized user interface (5 languages in addition to English)
• language specific writing and sorting capabilities
• localized names for all metadata fields shipped with Cumulus (11 languages)
(For details on which languages are supported see below.)

And in addition to that – or even on top of that – following can be localized to any lan-
guage supported by Cumulus: 

• the names and descriptions of catalogs, catalog fields, sets and templates can be 
localized to multiple languages 

• the values of String fields and String List fields (multilingual metadata fields)
String fields need to be enabled for multi-language support. Once enabled, they let 
Cumulus users store their translations of metadata in multiple languages. The multi-
lingual settings available with View Sets ensure the user can work with the metadata 
in the matching language.
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Supported Languages

Cumulus can organize, share and man-
age any type of digital file in multiple 
languages. By default Cumulus sup-
ports following languages:

For languages marked in bold a local-
ized user interface is provided. For all 
other languages, an English user inter-
face is displayed, but specific writing 
capabilities for the selected language 
are supported. This applies to the cate-
gory tree, input fields and Quicksearch 
function. And if localized names and 
descriptions of catalogs, catalog fields, 
sets and templates are available for the 
selected language, these are displayed.

By default the names of standard cata-
log fields are provided localized to fol-
lowing languages:

•Danish
•Dutch
•Finish
•French
•German
•Japanese
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• Korean
• Norwegian Bokmål
• Portuguese 
• Spanish 
• Swedish
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Localizing
Names, descriptions, String List values (list entries) are translated via the Preference 
window). For the translation of String field values the Information window can be 
used.

As the Preference window is only available with the Cumulus Desktop Client, names 
and descriptions as well as values of String List fields can only be translated with the 
Desktop Client. String field values can be translated employing any of the Cumulus cli-
ents – sufficient permissions provided. However, String fields have to be set up for 
supporting multiple languages.

Localizing Names and Descriptions
Open the Preference window to translate the names and descriptions of any catalog, 
set, template etc. or catalog field into any of the languages supported by Cumulus. 

How to translate names and descriptions of catalog, sets, templates ....

1. In the Preference window select the type of item (e.g. Category View Set) on the 
left and then the desired set, template etc. from the drop-down 

2. Click the info icon . The Properties window opens.

3. On the Description tab select the language and then enter a translation for the 
name and description.

4. Click OK. The Properties window is closed.
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5. Click Apply to save your translations and/or changes. 

For translating the names and descriptions of catalog fields (standard and custom), 
Cumulus provides the Field Name Editor.

How to translate names and descriptions of catalog fields ....

1. In the Preference window select Catalog Settings and then the desired catalog 
and click on the Record Fields or Category Fields tab.

2. Select the field and click Properties. 

3. Click the browse button . 
The Field Name Editor is opened.

4. Double-click into the corresponding field of the desired language to enter the 
translation for the field’s name and description.

5. Click OK. The Field Name Editor window is closed.

6. Click Apply to save your translations and/or changes. 
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Localizing String List Entries
The list entries of String List fields are edited and translated via the Preferences win-
dow. The editor provided on the String List Editor tab of the field’s properties offers all 
supported languages. 

Screenshot String List editor

For a description on how to translate list entries see “Editing a String List Field” .

Double-clicking a field for a language lets you enter the translation for the list entry. 
A user will only have the entries of one language displayed.
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Localizing String Fields
String fields have to be enabled to support multiple languages. Then the required lan-
guages can be added to the field. 

Preparing 

On the Languages tab of the field’s properties you can add languages after you have 
enabled the field for multiple languages. For each added language an additional sub-
field is created that has its own properties and can hold its own text content (value).
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Screenshot Language tab

For more information see “Languages Tab (String Fields only!)” .

NOTE: String Fields & Language Specific Sorting 
String Fields can have a language specific sorting index.
For more details, see “Overview: Field Properties” section “Indexing”. (For fields 
without multiple language support see no. 12 in the overview and for fields 
with multiple language support no. 18).
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Translating
The language specific subfields can be added to any view. Adding them to the Info 
window, for example, offers an easy way to translate the content (value). Another way 
can be to take advantage of the Allow language switch for multilingual fields option. 
(For more information on this option, see “View Sets” ). 
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Example for an Info window customized for translation:

Example of an Infor-
mation window set up 
for translation. All sub-
fields for languages 
are displayed so the 
translator can view all 
translations of all lan-
guages.
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And as each language specific subfield has its own properties, the permissions can be 
set for each language separately – ensuring that only authorized users can provide the 
translated content.

So it is up to the administrator, to provide View Sets that meet the individual needs. 
(For more information, see “View Sets” ). 
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Language Specific View Settings
Further language specific setting define what a user will or can see in a multilingual 
environment.

View Sets

As View Sets define for each view which fields are displayed and how, they include 
multilingual settings. View Sets meeting the individual needs ensure that Cumulus 
users can work with the metadata in the matching languages. For multilingual envi-
ronments with multilingual metadata fields, language specific View Sets are recom-
mended.

The setting for certain views offer an Allow language switch for multilingual fields 
option. This option enables users to switch the language in which multilingual meta-
data fields are displayed. If this option is not activated, multilingual fields are always 
displayed in the language of the field that is included with the view.

When adding String fields to a View Set, the Modules tab includes a Languages node. 
It expands to a list of all languages configured for string field values. Clicking the plus 
sign in front of a language name displays the fields that support values in the respec-
tive language, but are not yet included in the view. You can either select the name of a 
language’s to add all respective fields, or select the individual language-specific fields 
you want to add. (See also “Adding a Field to a Record View “and “Adding a Field to 
the Category Info Window”.)

Category Pane

For the Category pane special multilingual setting are available in a Category View Set. 
You can:
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• allow sorting of categories according to the rules of a specific language 
• specify a preferred language for the display of categories
For more information, see “Category Pane and Multilingual Working Environment” .
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User Interface & Language
All Cumulus clients (Web Client, Portals and Desktop Client) provide a dynamic adap-
tion to the user’s language. Cumulus Desktop Client and Portals offer the possibility to 
select a language. Web Client and Portals detect the language the employed Web 
browser requests. 

Even if no localized user interface is available for the selected or detected language, it 
can be utilized. This includes:

• Display names and descriptions of catalogs, catalog fields, sets and templates
• Sorting of records, categories and string list terms
• Names of categories
• Default View Sets (Portals only)
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Cumulus Web Client 
The user interface language of the Web Client depends on the language of the 
employed Web browser. Web Client tries to support the language the Web browser 
requests (preferred browser language). If a language is not available, English is used by 
default. 

The names and descriptions of catalog field, catalogs, sets, templates etc. will be dis-
played in the language the browser requests – if available. Also the settings of the 
View Set defined for the Web Client will be utilized – if possible.

Exception: The Categories field is handled by a special Web Client implementation. It 
shows the assigned categories in two different fields: Keyword and Category. These 
two fields will only appear localized in the languages for which Web Client provides a 
localized user interface.

NOTE: Customized Tag Line and/or Welcome Text 
If the tag line and welcome text are customized they are always displayed as 
entered via the Web Client Configurator, regardless of the language setting in 
the browser of the user. A customized tag line and/or welcome text cannot be 
localized. For more details, see chapter “Configuring Web Client” section “The 
Layout Tab – Login”.
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Cumulus Portals
By default, the language of the Portals user interface is dynamic. It depends on the lan-
guage of the employed Web browser. Portals tries to support the language the Web 
browser requests. If a specific language is not available, the first configured language 
is used – by default: English. 
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Cumulus Desktop Client
Users of the Desktop Client can switch the user interface language and can be 
enabled to select the display language for field values.

Selecting User Interface Language

To change the current user interface language of the Desktop Client a menu option is 
provided: File > Administration > Switch Application Language. The user selects the 
desired language. Once the Cumulus application was closed and started again, the 
language switch takes effect. If the selected language is not available as localized user 
interface, the Cumulus user interface language will be English – but specific writing 
capabilities for the selected language are supported.

(See also “Switch Application Language” .)

Settings For Language Switching

If a View Set has the Allow language switch for multilingual fields option activated, 
users can switch the language in which multilingual metadata fields are displayed. If 
this option is not activated, multilingual fields are always displayed in the language of 
the field that was added to the view (See also “Customization Options for Record View 
Sets”.)

To allow language switching in the Category pane, the Preferred Language option 
must be activated and set to As defined in View menu in the Category Pane prefer-
ences of the current Category View Set. If the Preferred Language option is not acti-
vated, multilingual categories are always displayed in their base language (defined in 
the field properties Language tab).

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – SETTING UP MULTILINGUAL CUMULUS USER INTERFACE & LANGUAGE

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

There is one more issue with the category pane.

Instead of coupling the language of the Category pane to the selection made in the 
View menu, you may as well select a language to always be used with the category 
pane, independent of the language used for other metadata fields. Activate the Pre-
ferred Language option in the Category Pane preferences and select the desired lan-
guage.

Selecting the Display Language for Field Values

The Desktop Client user can select language in which multilingual metadata fields are 
displayed via the View menu. For more information see “Language for Field Values” .
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Using the Server
Console

This chapter describes the Cumulus Server Console and covers some of the administra-

tive actions that are performed with the Server Console utilities. 

Cumulus Server Console combines utilities for different administrative tasks. It can be

accessed either via the Server Console application installed along with your Cumulus

Desktop Client, or as the Web Server Console via a Web browser from anywhere, if the

Cumulus Web Solutions are installed on your Cumulus system. 
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Both the Web Server Console and the Server Console application provide almost the 
same look and feel. However, the Server Console application comprises only a subset 
of the configuration options and modules that are available in the Web Server Con-
sole.

Prerequisites

In order to work with the modules of the Server Console, you need appropriate 
Administrator permissions for each module. These permissions are set in the User 
Manager module for each user or role. As the Server Console modules Log Manager 
and Activity Monitor refer to tasks for catalog management, these permissions are set 
in the Catalog Permissions section. All other Server Console modules refer to admin-
istrative tasks concerning the Cumulus Server, therefore the permissions are set in the 
Server Permissions section.

Opening the Server Console Application

To open the Server Console application:

1. Start the Cumulus Desktop Client application on the machine that you installed 
the Server Console application on.

2. Select File > Administration > Server Console.

The Login window opens.

3. Enter the name or the IP address of the Cumulus Server you want to administrate.

4. Enter the name and the password of the Cumulus Administrator or the user who 
has the permissions to perform the required administrative tasks.
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5. Click Connect.

The modules of the Server Console application are loaded.

Opening the Web Server Console

To open the Web Server Console:

1. Open a Web browser and enter the address of the Web Server console into the 
address field:
<servername or IP address>:8080/serverconsole

The Web Server Console login window is displayed.

2. Optionally, select a different language.

3. Enter the name or the IP address of the Cumulus Server you want to administrate.

4. Enter the name and the password of the Cumulus Administrator or the user who 
has the permissions to perform the required administrative tasks.

5. Click Login.

The Web Server Console page is loaded.

The Server Console is divided into two areas: to the left, the navigation panel lists all 
accessible modules of the server(s) you are connected to, and to the right, the options 
of the selected module are displayed. In the navigation panel, the name of the logged-
in administrator is displayed in brackets next to the server’s IP address or name, e.g.: 
localhost (cumulus).
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Web Server Console only: If you select the server’s IP address or name (instead of a spe-
cific module), the versions of the installed Cumulus Server and Web Solutions are dis-
played.

The Server Console provides its own menus. 

• The Server menu lets you connect to additional Cumulus Servers that you want to 
administrate, or to quit the connection to a selected Cumulus Server. 

• The Actions menu offers the (additional) functions available for the currently 
selected module, if any. These functions can also be accessed with a right/alter-
nate mouse click on a module.

• The Help Menu connects to the Server Console related section of the Cumulus 
Help

Using Server Console with Multiple Cumulus Servers

If you have a Cumulus installation with more than one Cumulus Server, Server Console 
lets you administer these multiple Servers. Select Server > Connect to connect to 
another Cumulus Server. The panel on the left then provides entries for each server 
and its accessible modules. Next to each server name, the name of the logged-in 
administrator is displayed in brackets.
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Modules of the Server Console
Which of the available modules are actually accessible depends on the configuration 
of the Cumulus Server as well as on your permissions. Some modules can be further 
expanded. Click the triangle icon to reveal further options. 

Select the module that you want to administrate in the left pane of the Server Console. 

The following modules are available (in alphabetical order, as in the Server Console):

• Activity Monitor – Displays information on the Cumulus Server activity and users 
connected to the selected catalog. Allows you to disconnect users, to send mes-
sages to selected users, and – on the Web Server Console – to display server statis-
tics.

• Automatic Tagging Setup Enables you to configure the usage of the Cumulus 
Automatic Tagging feature.

• Backup Manager – Enables you to define rules for the automatic backup of cata-
logs and your Cumulus configuration files.

• CIP Configurator (Web Server Console only!) – Enables you to define catalog alias 
configurations (Cumulus Server, catalogs, and users) as well as basic settings for 
Cumulus Portals and the Cumulus Mobile App.

• FileSystem Companion Manager – Enables you to configure instances of the 
Cumulus FileSystem Companion, an optional component which listens to file sys-
tem events and converts them into Cumulus actions.

• File System Versioning – Enables you to set up and configure asset versioning for 
any Central Asset Location on your file system.

• Log Manager – Allows you to activate the logging process for selected catalogs 
and set up log properties.
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• Mail Manager – Enables you to configure Cumulus to work with your email server, 
to choose sending Cumulus Server notifications, and see the queue of mails to be 
sent and – employing the Web Server Console only – to configure the mail notifi-
cations.

• Media Delivery Cloud Setup – Enables you to configure the usage of the Cumulus 
Media Delivery Cloud.

• Remote Admin – Displays the Cumulus Server status and lets you stop or start the 
Server. The options of these modules let you view and edit the current Server set-
tings and license status and provide a utility to ease the configuration of the File-
Sharing.Info file.

• Report Manager – Enables you to configure and generate reports based on cata-
log statistics or on Cumulus Server activity.

• RoboFlow Configurator (Web Server Console only!) – Enables you to configure 
Canto RoboFlow and define workflows. 

• Scheduler Manager – Enables you to define and schedule tasks to be automatically 
performed by Cumulus. 

• Set Manager – enables you to export and import shared Cumulus items (Sets, Tem-
plates, etc.). And enables you to unload all individual sets.

• User Manager – Enables you to specify users and their access rights to certain cat-
alogs and functions.

• Vault Server – Displays the current Cumulus Vault Server Setup and lets you con-
figure and administer the Vault Server.

• Video Cloud Setup – Enables you to configure the usage of the Cumulus Video 
Cloud.

• Web Client Configurator (Web Server Console only!) – Enables you to configure 
Cumulus Web Client. 
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• Workflow Manager Enables you to configure asset-centric workflows. 
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Backup Manager
The Backup Manager allows you to automatically backup your Cumulus configuration 
files and catalogs – if the catalogs are based on the Cumulus database engine. 

PRECONDITIONS: To work with the Backup Manager you must have the appropriate 
Administrator permissions for the Cumulus Server: Backup Administrator.
 

You can define jobs for the backup. These jobs include options for:
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• Items to be backed up – You can either have a backup of your Cumulus configu-
ration files, of all catalogs that are available at your Cumulus Server or just of 
selected catalogs.

• Destination for the backup files
• Time data when the backup should be performed
When you backup your Cumulus configuration files, a ZIP archive with all configura-
tion files inside the conf folder will be created and stored at the chosen destination. 
Unless you activate the option Append time of backup to file name, this ZIP file will 
be overwritten by the next backup copy that is made due to the defined backup job.

• When backing up your Cumulus configuration files, you can additionally delete 
shared collections older than a specified number of days. This can help speeding 
up your Cumulus system.

NOTE: Private collections will never be deleted this way.

It is not necessary to close a catalog to back it up. The backup can even be performed 
while clients are connected. When backing up a catalog, a temporary file is created for 
the catalog the moment the backup was started. This temporary file will be saved to 
the selected destination. under the catalog file name with the extension BAK. Unless 
you activate the option Append time of backup to file name, this BAK file will be over-
written by the next backup copy that is made due to the defined backup job. 

When scheduling backups, remember to take into account the time that Cumulus 
needs for creating and saving the catalog backup files. 

Email confirmations can be sent automatically after catalog back-up operations con-
ducted by the Backup Manager, if the Mail Manager is set to send notifications.
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IMPORTANT! It’s important to remember that backing up a Cumulus catalog 
does not back up the asset files associated with its records. Make sure that all 
your important files are included in your regular backups. 

When defining the destination for the backups, the Select Destination Folder dialog 
opens. It allows you to navigate in the Remote File Browser Sections that are defined 
in the Cumulus Server Settings of the Remote Admin module.
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FileSystem Companion Manager
The Cumulus FileSystem Companion is an add-on which listens to file system events 
and converts these to Cumulus actions in a smart way. This allows Cumulus to auto-
matically catalog assets and to create, update or delete records based on changes in 
the file system.

Optional feature! May not be available with your Cumulus configuration.

The FileSystem Companion is available for Windows and Linux file servers only (which 
however may be accessed from any client platform). It runs as a separate service, 
called an instance, on the respective server machine. Each of the instances of the ser-
vice has its own configuration xml file specifying the unique name of the instance, the 
address of the Cumulus Server and the technical user which is used to connect to that 
Cumulus Server.

Beyond these basic settings, the instances of the Cumulus FileSystem Companion are 
configured via the FileSystem Companion Manager of the Cumulus Server Console. 
This comprises the specification of the folder(s) to be watched as well as the catalog, 
Asset Handling Set and Permission Template to be used, certain time out values and 
a list of items to be ignored by an instance of the FileSystem Companion. Last but not 
least, these instances can be activated/deactivated via the FileSystem Companion 
Manager.

IMPORTANT! The FileSystem Companion and the watched folders must be 
physically located on the same machine. 
Do not use the FileSystem Companion with network shares mounted into the 
file system because this can result in erroneous behavior.
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The following table shows which file system event results in which Cumulus action:

However, there is no one-to-one relation between a file system event and a Cumulus 
action. Cumulus puts file system events in a queue and processes them with a config-
urable delay, thus allowing to collect multiple events for a file in a given time and 
finally applying an appropriate Cumulus action that is the result of a number of file sys-
tem events. This time out, or delay, is helpful e.g. if an application creates, renames 
and/or deletes temporary files while processing an asset.

For example, if there a sequence of file system events like: CREATE, UPDATE, UPDATE, 
DELETE, the resulting Cumulus action would be IGNORE, because it is impossible to 
create a record before the newly created asset is deleted again.

As a special case, RENAME operations on the file system are always executed immedi-
ately in Cumulus, without any delay.

PRECONDITIONS: To use the functions of the FileSystem Companion Manager you 
must have the appropriate permissions for the Cumulus Server: Create, modify and 
delete shared FileSystem Companion instances. The create permission always 
includes the modify and delete permissions. The modify and delete permissions can 
be granted separately. (Server Permissions > FileSystem Companion Instances)

File System Event Resulting Cumulus Action

CREATE catalog created asset

UPDATE update existing record or catalog asset if no record is found

DELETE delete existing record

RENAME rename existing record as well
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Configuring FileSystem Companion Instances
The FileSystem Companion Manager displays a list of existing configurations. You can 
create new configurations, as well as edit, delete and activate/deactivate existing 
ones. If the name of an existing FileSystem Companion instance and the name of a 
configuration match, the settings specified in the configuration take effect for the 
respective instance.

The following Information is displayed for each instance:

• Status – Running/Not Running/Deactivated
• Name – Name of the instance. Should match the name of an existing instance of 

the FileSystem Companion
• Folders – Number of and path to folders to be watched, and name of the catalog 

to which the file system events are synchronised 
• Event Queue Size – Number of assets for which file system events are waiting to 

be processed
The following columns provide information on inconsistencies found by the 
resync process running in the background. Usually, these inconsistencies are 
solved automatically within a certain amount of time.

• Missing Records – number of assets with no corresponding records
• Missing Assets – number of records with no corresponding asset
• Checksum Problems – number of reference inconsistencies 
Existing or new instances are configured via the Edit Instance Configuration window.
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Folders 

A list of folders to be watched by the instance. The following information is displayed 
for each folder:

• Folder – Absolute path to the folder to be watched. All folders below this folder 
will be watched, too

NOTE: This leads to a (technical) source category tree which is visible under All in 
the Category pane. This category tree must not be modified manually!

• Catalog – Name of the catalog to which file system events from the specified 
folder are synchronized. Catalogs can be selected via d drop-down list

NOTE: It is not possible to apply system events from different folder paths to the 
same catalog!.

• Asset Handling Set – Name of the Asset Handling Set to be used with the 
Cumulus action. Can be selected via a drop-down list

• Permissions Template – Name of the Permissions Template to be applied. Can be 
selected via d drop-down list

Settings 

In this section, several time out values can be specified. 

• Activity time-out – Minimum delay between the receipt of a file system event and 
its conversion into a Cumulus action. 

NOTE: Usually, the actual time between a file system event and the resulting 
Cumulus action is larger than this value, depending on the load on the machine 
and the number of file system events coming in.
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• Timeout for record resync runs – Resync thread waits at least that amount of time 
between checking for records without asset and assets without record

• Timeout for category resync runs – Resync thread waits at least that amount of 
time between checking the technical FileSystem Companion category structure 
for categories without matching folders on disk.

• Timeout for delaying actions in resyncs – Resync thread waits at least that 
amount of time after it has detected an inconsistency (for example a record in the 
catalog with missing asset) and before the according cleanup function is executed 
(in this example, deleting the record).

Exclusion List

A list of files, file types and folders which are to be ignored by the FileSystem Compan-
ion. 

These settings must be notated in regular expressions!
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File System Versioning
Cumulus supports asset versioning for assets stored in an asset versioning system like 
Cumulus Vault (see “Configuring Vault” ), as well as for assets stored in a Central Asset 
Location on your file system.

The proper way to modify a versioned asset and to create a new version is to check 
the asset out first, then edit it, then check it in again. However, with file system based 
asset storage – and in contrast to Vault based asset storage – an asset may be revealed 
and modified directly within the file system, i.e. without previously been checked out 
from Cumulus. Cumulus therefore allows to check in and create a new version of a 
modified asset that has not been checked out before.

Prerequisites

Versioning of assets can be set up for any catalog which employs a file system based 
Central Asset Location (Edit > Preferences > Catalog Settings > General > Use Cen-
tral Asset Location). 

The following prerequisites must be met to make file system based versioning work 
for a catalog:

• The special fields for versioning (contained in the catalog template Fields for Asset 
Versioning Control) must be included in the catalog. 

• The respective Central Asset Location must be configured as a Versioning Location 
(see Configuring the File System Versioning).

• The configured Versioning Location – that is, the server and/or the path – must be 
available on every machine on which the Cumulus Desktop Client runs. If the Web 
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Client is used, the Versioning Location must be available from the machine on 
which the Cumulus Web solutions are running.

Some Technical Background

Cumulus stores the versions of assets in hidden folders within the central asset loca-
tion so that they can’t be revealed by simply browsing the file system. Only the current 
version of an asset is always visible in the file system.

NOTE: In order to prevent the accidental destruction of a current version of an 
asset, Cumulus always keeps a second copy of that version in a hidden folder. 
Every time Cumulus generates a new version from a changed, but not checked-
out asset, this hidden file becomes the penultimate version.

Cumulus can generate new versions of changed assets every time the respective 
records are updated. Records can be updated either manually (via Metadata > 
Update Record) or automatically, e.g. via the auto cataloging function for source cat-
egories, or a scheduler action.
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Configuring the File System Versioning
PRECONDITIONS: You need to be logged in as the Cumulus Administrator to config-
ure File System Versioning.

File system based versioning of assets can be configured via the Server Console.

Configuration

The following settings can be configured:

• Create new version when record is updated (and asset was modified): This takes 
effect both with manual and automatic updates of the record.
If this option is not activated, new versions must be explicitly created via the Asset 
> Check In menu command.

• Reduce creation of new versions. Minimal time gap between versions: If acti-
vated, at least the specified number of minutes must go by before a new version 
is created, even if the asset has been changed in the meantime. – Depending on 
the system load, the length of the task queue, etc, the effective gap may exceed 
the specified value.
This is useful to avoid clutter whenever an application creates frequent updates of 
a file. 

NOTE: This setting only affects the creation of versions via an update record pro-
cess. It does not affect the creation of new versions via checking in assets!

• Restrict numbers of versions to be kept to: If activated, only the specified number 
of versions are kept.

• Always keep oldest version: If activated, the oldest version – the “original” file – is 
never deleted.
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Versioning Locations

Basically, any central asset location defined in any catalog can be configured for ver-
sioning. As a prerequisite, the location – that is, the server and/or the path – must be 
available on the machine on which the Server Console runs or – if the Web Server Con-
sole is used – on the machine on which the Cumulus Web Solutions are running.

To configure a central asset location for asset versioning:

1. Click Add Location. 

A window appears displaying any central asset location defined in any catalog 
that is not yet configured for versioning, and that is currently accessible.

2. Select the desired location, then click OK.

A window appears asking whether all not yet versionable assets in the selected 
location shall be made versionable:
Yes: Existing assets in the central asset location are made versionable.
No: Existing assets are not made versionable; but new assets are always created as 
versionable. – You may transform not versionable assets to versionable ones any-
time later via the Prepare Assets in Location button

3. Select the desired option. The location and the catalog to which the respective 
assets are cataloged are is displayed in the Versioning Locations list.

You may stop asset versioning for a location anytime via the Remove Location button. 
If you do so, you may also disable versioning for currently versioned assets (i.e. make 
them unversionable) and remove all existing versions.
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SPECIAL TECH INFO:  Autoversioning on Update

File system versioning checks the file modification date and the file size to 
decide whether it has to create a new version on update or check-in. Starting 
with Cumulus 9.2.4, the contents is no longer checked to increase the perfor-
mance, especially on slow network shares. If you use a tool that does not 
change the file modification date and the file size and you need to employ the 
content check, contact Canto.
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Mail Manager
The Mail Manager lets you configure Cumulus to work with your email server. It 
enables you to define and test your email server settings, choose to send Cumulus 
Server notifications, and see the queue of mail to be sent. Cumulus Server notifications 
include messages generated by the Cumulus Scheduler and Cumulus Server (e.g. sys-
log system messages, error messages or informations on successfully performed pro-
cesses such as catalog backups.)

Additionally, you can administer email notifications as well as configure their look and 
feel.

PRECONDITIONS: To work with the Mail Manager you must have the appropriate 
Administrator permissions for the Cumulus Server: Mail Administrator
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Overview: Main Panel 
The Mail Manager module of the Cumulus Server Console or Web Server Console pro-
vides access to the central Cumulus mail configuration settings and the mail queue.

1 Displays the central Cumulus mail configuration settings.
2 Displays the list of messages to be sent. Provides buttons for deleting selected messages or 

refreshing the list
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Mail Server Tab (3 - 14)

Server
The following settings define the mail server employed for sending emails from within Cumulus 
and its configuration. 
3 Address of the SMTP Server employed.
4 SMTP Port. It the port is set automatically according to the security settings. (Port 25 is the 

SMTP standard TCP port)
5 Security level for mail server communication. Options are:

– None: no security level defined
– Secure SMTP (SSL): Secure Sockets Layer 
– Start-TLS – Transport Layer Security (TLS) 
For setting the security level ask your mail server administrator. 

6 Name of the mail server user account (used for authentication at the mail server)
7 Password of the mail server user account
8 Email address of the sender - either used for all mails sent or only for mails without a From 

address. 
9 Options for the From address. If the option For mails without From address is activated, 

the address of the sender will be used by default.

Notifications
The following settings define whether and how notifications are sent:
10 If activated, notifications generated by the Cumulus Server and Scheduler are sent as mail 

messages to the email addresses defined below. 
11 Defines the level of notifications that shall be sent via mail. Levels of notification include 

information, warning and error. The more severe levels are always included.
12 Mail address of the recipients of the notification. You can enter multiple addresses separated 

by commas.
13 Saves your settings and closes the window.
14 Sends a test mail messages employing the current settings.
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TIP: The notification emails or other automatically generated email messages (e.g. URLs) 
might be very short and therefore might be identified as unwanted email messages 
(email spam or junk). Canto recommends you to send test mails and – if necessary – to 
request the recipients to include the From address in the safe senders lists of their local 
emails clients. 

Queue Tab

List of messages to be sent. Use according buttons for deleting selected messages or refreshing 
the list.
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Configuring Email Notifications
Cumulus sends email notifications for certain events, such as password changes, Web 
down- and uploads. To administer these various email notifications Cumulus provides 
templates and template classes – one class for each situation that can trigger an email 
notification. The general layout (including header and footer) is defined by a theme. An 
email template defines the subject and text body.

How Does it Work

Notification emails can be sent with, or without employing the theme. If the theme is 
used, Cumulus assembles the entire email by putting the appropriate body text, as 
defined in the template, in between the header and footer texts, as defined in the 
theme.

Notification emails can be sent either in HTML format, or as plain text mails. If you pre-
fer HTML mails, make sure that the entire mail is enclosed between the <html> and </
html> tags. This means:

• Using the theme: header text must start with <html>, footer text must end with 
</html>

• Without theme: body text must start with <html> and end with </html>
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Theme
The theme defines the layout of an email notification, or more precisely, its header and 
footer. Currently, only one single theme is supported for all notifications.

The Theme panel is to edit the header and footer to be used with email notifications. 

You can adapt the header and footer settings to your needs.

The Theme panel provides following tabs:

General Tab

Name and (optional) description of the theme. You can modify name and description. 

NOTE: Names and descriptions of themes and can be easily adapted to a mul-
titude of languages via the  button. Clicking this button opens a win-
dow for entering translations of the name and description.

Header Tab

here is where you configure the information in the header of the mail theme. 

Select a language for which you want to enter the header information, or select 
Default to enter informations that is displayed in any language for which no informa-
tion is specified.

Enter the header text. You can use plain text and HTML code. On the right side, a list 
provides several placeholders that you can embed in the header text. Select a place-
holder and click Insert.
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Footer Tab

Here is where you configure the information in the footer of the mail theme.

Select a language for which you want to enter the footer information, or select Default 
to enter informations that is displayed in any language for which no information is 
specified.

Enter the footer text. You can use plain text and HTML code. On the right side, a list 
provides several placeholders that you can embed in the footer text. Select a place-
holder and click Insert.

Attachments Tab

Here is where you specify which pictures, logos etc are available for the theme. All files 
added here available in the Placeholders lists on the Header and Footers tabs of the 
Theme panel, as well as in the Placeholders lists on the Subject and Body tabs of the 
Templates panel.
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Template Classes
For every situation in Cumulus that can trigger a notification email, a template class is 
provided. The Template Classes panel displays a list of all available template classes.

By default there are only built-in template classes that ship with Cumulus and can not 
be modified.

You can add custom template classes, if necessary.
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Templates
With templates, the subjects and text bodies of the emails that are sent in different sit-
uations are defined. The Templates panel provides an overview, grouped by template 
classes. Select a template class from the drop-down list to have the respective tem-
plates displayed. 

The list of templates shows the following information on each template: its name, the 
class it belongs to, whether it is enabled and whether it is the default template.

You can edit or remove existing templates, and you can create new templates, either 
by adding a new one from scratch, or by duplicating and then modifying an existing 
one. 

If there are multiple templates for a single class, you can define which of these tem-
plates is the default one. Only the default template will be used to create emails.

The Edit Template window provides the following tabs:

General Tab

Name and (optional) description of the template. You can modify name and descrip-
tion. 

NOTE: Names and descriptions of templates and can be easily adapted to a 
multitude of languages via the  button. Clicking this button opens a 
window for entering translations of the name and description.

Two check boxes provide additional options:

• Use theme – if deactivated, the theme is not used with this template.
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• Enabled – if deactivated, the template can’t be used or set as default template, but 
is still displayed in the templates list.

Subject Tab

Here is where you configure the subject of the email. Select a language for which you 
want to enter the subject text, or select Default to enter informations that is displayed 
in any language for which no text is specified.

Enter the subject text. On the right side, a list provides several placeholders that you 
can embed in the subject text. Select a placeholder and click Insert.

Body Tab

Here is where you configure the body of the email. Select a language for which you 
want to enter the body text, or select Default to enter information that is displayed in 
any language for which no text is specified.

Enter the body text. You can use plain text and HTML code. On the right side, a list pro-
vides several placeholders that you can embed in the body. Select a placeholder and 
click Insert.
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Remote Admin
You use the Remote Admin module to stop or start the Cumulus Server and to config-
ure Cumulus Server Settings, such as the identity of the Cumulus Administrator, the 
TCP/IP port number of the Server, and time-outs for various actions. You also use the 
Remote Admin module to activate your Cumulus installation and/or additional 
options, and to view and, if necessary, modify, license information.

PRECONDITIONS: You need to be logged in as the Cumulus Administrator to work 
with Remote Admin.

The Remote Admin function can be performed via the Cumulus Server Console or 
Web Server Console from any computer. 
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Cumulus Server Status
Once you click the Remote Admin entry in the Server Console, the Cumulus Server Sta-
tus is displayed. You can start and stop the Cumulus Server.

Cumulus Server Settings
To reveal the Cumulus Server Settings click the + icon on the left side of the Remote 
Admin entry. Then click on the entry Settings. The Cumulus Server Settings will be dis-
played. The Server Settings options affect global Cumulus Server behavior.

If you want to change the settings, edit the settings and click Save Changes to send 
them to the Cumulus Server application. See “Overview: Cumulus Server Settings”, for 
an overview of the setting options available.
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Overview: Cumulus Server Settings 
 • General (1 - 10)

1 User name of the Cumulus Administrator.
2 Password for the Cumulus Administrator. 
3 Click to change the password for the Cumulus Administrator. 
4 Displays and lets you change the name of the guest account for the 

Cumulus guest connection login. The name you enter must be an existing 
Cumulus user account.

5 Displays and lets you change the language of the messages the Cumulus 
Server sends. Click the arrow button to select a language.

6 Maximum age for Cumulus users’ passwords. After time period entered has 
passed since the last change, the user has to change it. Cumulus will 
request this change automatically. If you enter the value “0”, passwords 
will never expire. 

TIP: If you want to set the password to “never expire” of a certain 
user only, you can do this with the User Manager.

7 Displays the path to the folder containing the temporary files for catalog 
mirroring. The path is relative to Cumulus Server installation unless an 
absolute path is entered.

8 The Remote File Browser Section defines the starting point (highest point in 
the hierarchy of the file system) for the Remote File Browser dialog within 
Cumulus. 

9 Click to add another Remote File Browser Section. Then enter a name for it. 
To set the path for the new section, click in the section’s entry in the column 
Path and enter an existing path.

10 To remove a section, mark the section’s entry and click this button.
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• Base URLs for Web Access (11 - 13)

11 Base URLs For Web Access define the Web addresses to catalogs that are set 
to be accessible via the Web (e.g. via the Cumulus Web Client or Cumulus 
Portals). Base URLs are used to create proper Web links for records, assets, 
preview or thumbnails. Cumulus can manage multiple base URLs for mul-
tiple Web applications (Web Client, Portals, Sites). They are distinguished 
either by their type, or by a significant part within the Base URL (e.g., /cwc, 
or /sites).
The URL creation can be requested by the Cumulus Client employing the 
Configure Web Link URL function which is available only if at least one 
Base URL is defined here. (Fore more information, see “Configuring Web 
Links” .)

12 Click to add a Base URL. Then enter a name for it. To set the Web address, 
click in the Base URL’s entry in the Base URL column and enter the address 
of the Web application in the following format: [http://[Web server IP 
address]:[Port No.]/[Name of Web application folder]. It’s recommended to 
select a type (e.g. Web Client, Portals, Sites) for the Base URL in order to 
ensure the usage of the proper base URL in any given context.

13 To remove a Base URL, mark its entry and click this button.

1312
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• Cumulus Server (14 - 17)

14 List of server machines running Cumulus Servers. This list is of importance 
in a multi-server environment only. The servers listed here are employed 
when cataloging, resolving/creating asset references from other plat-
forms, communicating with Vault and for license check. You can either 
enter servers manually or have them detected by the system.

15 Click to have servers detected by the system. Depending on your network 
environment this may take a while. Once your entire system was checked 
and the list is completed, the detected list will replace the current list. 

16 Click to add another server manually.
17 To remove a server from this list, mark its entry and click this button. For 

best performance Canto recommends you check this list regularly and 
remove all servers that are not available.

• Restrict Client Asset Access To (18 - 20)

18 If activated, the server locations for assets that can be delivered via Server/
Client Asset Transfer are restricted to the folder(s) (including subfolders) 
specified here. 
Default: activated.

19 Click to specify a new folder.
20 To remove a folder from the list, mark its entry and click this button.

1715
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• Timeouts (21 - 24)

21 When the Server disconnects a Client (e.g., for shutdown), it waits for a cer-
tain amount of time (e.g., 1 minute) plus the specified number of seconds 
before closing the Client connection.

22 The Server expects to get the next request from a Client within the specified 
time.

23 Number of seconds the Server waits for Clients to disconnect on shutdown.
24 When the Server sends data to a Client, the data must be transferred within 

the specified number of seconds or the Server automatically disconnects 
the Client.

21
22
23
24
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• TCP/IP (25 -28)

25 You can define a custom TCP/IP port number (in the field to the right) for 
Server and Clients. It is recommended using 9287 (this is registered for 
Cumulus). 
If you use any other number, you must set up the port number used by 
Portals, the Web Client, and the Vault Server (if installed on a machine 
other than the Cumulus Server) accordingly. You will also have to inform 
all Cumulus Clients to use the changed port number in the Connect To 
Server dialog (e.g. 123.123.123.123:9288 or ServerName:9288) OR change 
the port number in each Client’s XML file - found in the conf folder of the 
Cumulus Client installation folder. Under OS X, you open this folder by 
opening the installation folder of your Cumulus application and then 
pressing the CTRL key and selecting the Cumulus application icon simulta-
neously to get the context menu for the application. In this menu select 
Show Package Contents, then open contents and finally open Mac OS.

NOTE: If you use any other number, you may have to change your firewall 
settings accordingly.

26 Defines the number of bytes sent as a block by the network interface card. 
Change the standard value of 65536 for special purposes only.

27 Defines the number of bytes received as a block by the network interface 
card. Change the standard value of 16384 for special purposes only.

28 Size of a message that the server will send as one block. The default value 
“0” should be used with any local network as then the messages will be sent 
as one block by the server. You should only change this value if you have a 
Cumulus installation that includes Clients with a slow connection (e.g. 
modem or ISDN). If you change the fragmentation size under UNIX or OS X, 
the value should be half (or less) of value set for the send buffer.

25
26

27
28
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• Optimization (29 - 31)

29 If not enabled, Cumulus automatically determines the optimum size of the 
RAM cache for catalogs administered by the Server. If enabled, you can 
define a custom cache size (in the field Cache Size). 

30 Cumulus Enterprise only: Number of threads that can reply to a Client 
request at the same time. Default: 0 = the number of CPU cores (including 
hyper-threading) that are installed in the system. Maximum is 128.
With Cumulus Workgroup, the number of server threads is always limited 
to 4.

31 If enabled, the Cumulus Server preloads the indexes for the contain-search 
in string lists, which improves the performance when the indexes are used 
for the first time (e.g. for searches).

NOTE: Changing this setting only takes effect after a restart of the Cumulus 
Server. Depending on the size of the index(es) and the performance of the 
used hardware, a restart can take its time (up top several minutes or even 
more).

• Button (32)

32 Confirms the changes and sends them to the Cumulus Server application.

31

29

30

32
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License
To reveal the License information, click the + icon on the left side of the Remote 
Admin entry. Then click on the entry License. The license information for your 
Cumulus installation will be displayed.

Registering And Activating Additional Licenses

Newly purchased options or additional licenses can easily be activated. In the License 
information pane, click on Activate Cumulus, then log in to your Canto Customer 
Community Account. Activate the appropriate checkboxes, then click OK. 

For more information on activating and registering Cumulus, see the Installation 
Guide.

http://help.canto.com/CIG/InstallationGuides_Versions.htm
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FileSharing Info Settings
The FileSharing.Info file is used by Cumulus Servers to build: 

• UNIX asset references based upon OS X or Windows file system asset references
• OS X asset references based upon UNIX or Windows file system asset references 
It contains information on how a Windows, UNIX or OS X asset reference should be 
converted to a corresponding UNIX or OS X reference. The information stored in this 
file must be adapted to your Cumulus configuration. 

Remote Admin provides a utility to ease the configuration of the FileSharing.Info file. 
The utility provides different tabs:

For the volumes from which assets are cataloged, you need to add entries for the File-
Sharing.Info that contain the required information.

NOTE: HELIOS EtherShare and HELIOS PCShare
If HELIOS EtherShare is installed on the machine that runs the Cumulus Server, 
you do not need to update the Macintosh section settings of the FileShar-
ing.Info file manually; Cumulus does this automatically. 
If you have also installed HELIOS PCShare, you do not need to update the Win-
dows section settings manually. The HELIOS EtherShare and HELIOS PCShare 
tabs display the information that is provided to the FileSharing.Info by this soft-
ware.

To add the information on the platform volume from which assets are cataloged, click 
the tab for the appropriate platform and click the Add button. A dialog opens that asks 
for the information needed to create the correct platform asset reference based upon 
the asset references already provided. 
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Information Needed

• Volume Path – volume path of the share point in the notation of the platform (e.g. 
UNIX notation: /shares/volume)

• Server Name – Name of the file server. This can be the IP address or the real server 
name (DNS-resolvable name).

• Zone Name – AppleTalk zone name as it appears to OS X clients (OS X only)
• Volume Name – Name of the volume on the file server
• Encoding – The encoding for the Macintosh section definitions should always be 

set to UTF-8. The encoding for the Windows section definitions should always be 
set to WinLatin1.

Make sure you enter the server names and volume names (case sensitive) exactly as 
they are displayed for the appropriate platform in an Asset Reference field of the 
Cumulus Information window/view. This field also shows what you should enter as 
server name (the IP address or the real server name). The volume names entered must 
match exactly the names of the volumes themselves. (Note that spaces must not be 
escaped by quotes.) Make sure you don’t enter a UNIX server name.

After the FileSharing.Info is edited, the records must be updated to get valid entries 
for the missing platform asset references. Use a Cumulus Client (Mac or Windows) to 
update the records (Metadata > Update Records > Update now). Use an Asset Han-
dling Set that has the File System AssetStore for the missing platform asset references 
activated. After doing so, the Asset Reference field in the Information window/view 
will show the following UNIX path for a cataloged asset: 
//MyServer/MySharedVolume/MyFolderStructure/MyAsset 

Without correct FileSharing.Info entries, a UNIX reference would look something like 
this: 
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MyServer:/home/LoginName/MySharedVolume/MyFolderStructure/MyAsset 
This is a non existing path and Cumulus cannot resolve it.

The entries on the Cumulus FileSharing.Info Macintosh and Cumulus FileSharing.Info 
Windows tab of Remote Admin FileSharing.Info Settings window can be edited or 
deleted. To edit an entry, select the desired entry and click Edit. To delete an entry, 
select the desired entry and click Delete.

To save the changes you made in the Remote Admin FileSharing.Info Settings win-
dow, select Actions > Save.

Additional Notes

• Best Guess
If the Unix File System AssetStore is activated, during cataloging, the Cumulus 
Client tries to create a corresponding UNIX asset reference and sends a request to 
the Cumulus Server. Using the FileSharing.Info file, the Cumulus Server answers 
this request. If a UNIX asset reference could be created, it is stored with the cata-
loged asset. If the Cumulus Server cannot create a UNIX asset reference, it stores 
instead a “best guess” reference such as: /usr/home/images/picture.jpg. 

• Asset Handling Sets
When working in a cross-platform environment, Canto recommends using Asset 
Handling Sets that have the Asset Storage modules for all three different file sys-
tems activated: Mac OS File System, UNIX File System and Windows File System.

• Cumulus Internet Solutions and Local Access
If you run Cumulus Web Client or Portals on a computer other than your Cumulus 
Server, you might need a configured FileSharing.Info file on the computer run-
ning the Cumulus Internet Solution. The FileSharing.Info file is needed in case the 
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Cumulus Internet Solution accesses assets that were cataloged locally from the 
same computer the Cumulus Internet Solution is running on. In this special case, a 
properly configured FileSharing.Info file must be copied to the etc (UNIX) or conf 
(Windows) subfolder of the installation folder of the Cumulus Internet Solution.
If you use a Cumulus Java Classes installation different from the one in the 
Cumulus Internet Solution installation folder, the configured FileSharing.Info file 
must be copied to the etc (UNIX) or conf (Windows) subfolder of that Cumulus 
Java Classes installation folder.

• Applications based on Cumulus Java Classes
If you use an additional application with your Cumulus installation, and this appli-
cation is running under UNIX or OS X on a computer other than your Cumulus 
Server, you might need a FileSharing.Info file on this computer. In this case the 
configured FileSharing.Info file must be copied to the etc (UNIX) or conf (Win-
dows) subfolder of the Cumulus Java Classes installation folder used by the appli-
cation.
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Report Manager
Cumulus can generate reports based on catalog statistics (number of previews, print 
outs, mail to, etc.) and reports based on Cumulus Server activity, such as successful 
and failed search results, client connection rates, and more.

Optional feature! May not be available with your Cumulus configuration.

The Report Manager enables you to configure reports customized to your needs. The 
created reports can be exported. For example, reports can help you “fine-tune” your 
metadata values, because you can see exactly what users are searching for. When a 
search fails, now you can see the term used. Reporting helps you ensure your system 
is tuned to perfection and that you’re getting the most out of it. 
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Requirements
Generating usage evaluation reports is based on the record field Asset Usage History. 
This field has to be added to each catalog where you want to track usage. Once added 
you configure it and mark the activities you want to be tracked in the catalog.

TIP: Asset Usage History Field

The asset usage tracked by this field can also be viewed in the Client applica-
tion. Divide the Record pane with a sup-pane and select the Asset Usage His-
tory filter. 

Generating time related reports (search term and licensing reports) is based on a spe-
cial Cumulus catalog. Its catalog name is $Statistics and its catalog file name is 
Statistics.ccf. This manual refers to it as the Statistics catalog. 

The Statistics catalog has to be managed by your Cumulus Server, meaning it has to 
be included in the Catalog Access list. It must not be shared nor published to the Inter-
net.

It is possible to open the Statistics catalog with a Cumulus Desktop Client, but this is 
not recommended. There is only one reason to open the Statistics catalog with a 
Cumulus Desktop Client: If you want to have more fields than the default configura-
tion offers, you can add record fields to the Statistics catalog. 
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Working with the Report Manager
To generate a report you create a report configuration and then use it to generate a 
report on demand. 

Once you have created a report configuration, it is saved and listed under Configured 
Reports. To generate a report you select its entry and click the Generate Now button. 

PRECONDITIONS: To use the functions of the Report Manager you must have the 
appropriate permissions for the Cumulus Server: Create, modify, and delete shared 
reports. The create permission always includes the modify and delete permissions. The 
modify and delete permissions can be granted separately. (Server Permissions > 
Report Permissions)
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Configuring Reports
Reports are easy to configure. You can select from different report types: 

The options available for the report configuration depend on the selected report type.

Usage Reports

Remember that all usage reports require a configured Asset Usage History record 
field in the catalog tracked. Only usage types activated in the fields properties can be 
tracked and used for reports.

• Checkouts
This report lists all combinations of user + asset along with the number of check-
outs and checkout times during the given date range.

• Number of Asset Usages
Depending on the time period, the list contains the number of asset usages (e.g. 
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“Download” and “Email”). The interval is either minute, hour, day or month 
depending on the length of the period.

• Top Asset Usage
Select the asset usage kind that should be reported (e.g. “Download”). The report 
shows the names of the assets that were used and the usage type, sorted by usage 
frequency. 
The results are displayed in a table that can be sorted by number of occurrence, 
date, etc. The table contents can be saved into a tab-separated text file to be 
imported into Microsoft Excel for evaluation and presentation.

• Top File Formats
This report shows the number of assets and the total asset data size per file format 
for each selected catalog. The purpose is to get an overview of how many assets 
of each format the catalogs contain and how much disk space they are occupying.

Under Asset Usages you will find all usage history options – even those currently not 
activated for the corresponding catalog. This enables you to generate reports even for 
usages that are no longer tracked in the catalog. However, make sure that for a report 
you only activate asset usages for such usages the corresponding catalog can provide 
tracked data for.

Time Related Reports

Remember that time related reports require the Statistics catalog.

• Assets Added
Depending on the time period the list contains assets that were added to the 
selected catalogs.

• Number of Searches
Depending on the time period, the list contains the number of queries being per-
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formed. The interval is either minute, hour, day or month depending on the length 
of the period. Note that only textual search operations are taken into account (e.g. 
in string or string list fields.)

• Top Successful Search Terms
Search terms of queries that had a result. The report contains the frequency as well 
as the search term that the user entered, sorted by the frequency. Note that only 
textual search operations are taken into account (e.g. in string or string list fields.)

• Top Unsuccessful Search Terms
Search terms of queries that led to no results. The report contains the frequency as 
well as the search term that the user entered, sorted by the frequency. Note that 
only textual search operations are taken into account (e.g. in string or string list 
fields.)

• Client License Usage
Depending on the time period the list contains the number of users logged on as 
well as the number of licenses being used. The interval is either minute, hour, day 
or month depending on the length of the period.
The results can be displayed either in a table or in a graph. They can be saved into 
a tab-separated text file to be opened by MS Excel or in a graphics file (e.g. PNG).

• Generic Asset Query
This type of report returns a list of assets that match the given date range and also 
an optional server-side query. You can select the date field for the range and also 
sort the result by a given field.
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Time Settings for Reports

For any report, you can specify the period of time for which the report shall be gener-
ated, e.g. the current year, or the last two months, or the time between July 1st and 
August 12th, etc. 

Note that if you set the period to be covered to “In the last x units of time” (i.e. years/
months/weeks/days/hours/minutes/seconds), this always means the last fully com-
pleted respective unit(s). For example,

• “In the last 2 days” means yesterday and the day before yesterday, but not today.
• “In the last 2 days up til now” means yesterday, the day before yesterday and today 

until the current second.
• “In the last 2 days plus current” means yesterday, the day before yesterday and 

today (entire 24 hours).
Usually, a record covers a period that lies entirely in the past or extends to the very 
moment a report is generated. However, in certain scenarios even a time period with 
an end date anytime in the future makes perfect sense – for example, if you want to 
generate a report on which files will expire within the next three months. 

Of course, this will only work if your catalog contains a date field that can contain 
future dates, such as the field Expiration date. To configure such a report, you must first 
select the Report Type Assets found by query and then an appropriate Date field for 
range. In all other cases, setting a future end date will be without effect.
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Generating Reports
To generate a report you select its entry and click the Generate Now button.

The generated reports can include text tables and images, which can be exported for 
use and analysis in spreadsheets, presentations and other programs. The Save As but-
ton lets you save the reports in formats that can be imported by other applications. 

TIP: Defining Times for Reports

The Cumulus Scheduler can run your configured reports at times you define. 
For more information see “Generating Reports” 

Editing or Removing Report Configurations

To edit or remove report configurations select the report’s entry and then click the 
appropriate button. 
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Scheduler Manager
The Cumulus Scheduler enables you to define and schedule tasks to be automatically 
performed by Cumulus. It will save you time and increase your productivity by auto-
mating frequent tasks. The Scheduler enables you to run time consuming functions 
during off-peak hours, and also enables you to automate routine tasks. In combination 
with the Cumulus Trigger feature, the Cumulus Scheduler makes a powerful tool to 
automate business processes and save wasted resources.

The Cumulus Scheduler consists of the Scheduler Manager and the Scheduler Server 
Application. The Scheduler Server Application be installed separately (on the com-
puter that you want to perform the tasks; for details see the Installation Guide.) The 
Scheduler Manager lets you set up tasks that are to be performed by the Scheduler 
Server Application.

PRECONDITIONS: To use the functions of the Scheduler Manager you must have the 
appropriate permissions for the Cumulus Server: Create, modify and delete shared 
scheduler tasks. The create permission always includes the modify and delete permis-
sions. The modify and delete permissions can be granted separately. (Server Permis-
sions > Scheduler Task Permissions)
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Setting Up a Scheduler Task
Setting up a Scheduler task includes the specification of:

• the Scheduler Action to be performed, 
• the catalogs on which the Scheduler Action will be performed,
• the Scheduler instance that shall perform the task (required if you have one or 

more Scheduler instances with unique Instance Names installed. Must be left 
empty if only if there is one Scheduler instance in your Cumulus system, without a 
specified Instance Name).

• when the Scheduler Action will be performed.
The Scheduler Actions are selected from a list and can be configured. The Scheduler 
Actions available depend on the Cumulus Server you are connected to. Available 
actions are stored in a special folder. 

How to install and configure the Scheduler Server Application is described in the 
Installation Guide.

The Scheduler Manager utility is included in the Cumulus Server Console. To work with 
the Scheduler Manager, a user /role must have the appropriate Scheduler Task Per-
missions (part of the Server Permissions of the respective user/role).

To set up a Scheduler Task with the Scheduler Manager: 

1. Select the File > Administration > Server Console, or connect to the Web Server 
Console via a Web browser.
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2. The Server Console is started. Log on as Cumulus Administrator (or the user who 
has the Scheduler Administrator permission) to the Cumulus Server that manages 
the catalogs you want to have Scheduler Tasks performed on.

3. Select Scheduler Manager. A window opens that lists all Scheduler Tasks.

4. To set up a new task, click the Create button. You are prompted to give the new 
Task a name. Subsequently, the Add Task dialog opens.

5. Select the Scheduler Action you want to be performed. 
If the selected action can be configured, the Configure button is activated and 
you can configure the action to your needs. (For more information see “Provided 
Scheduler Actions” .)

6. Determine where the action is to be performed. Click Add to choose the catalogs. 
The list of catalogs is displayed that are managed by the Cumulus Server you are 
connected to. Select the desired catalogs in the list and click OK. 

7. Specify the Scheduler instance you want to perform this task by entering its 
Instance Name.

NOTE: This instance name must match with an existing Scheduler instance name, 
as defined in the Scheduler’s config.xml file (for details, see the Installation 
Guide). – If there is only one Scheduler installed, with no instance name specified, 
this field must be left empty!

8. Specify when the action is to be performed. Under Schedule define:

• date and time for the first run. 
• the Repeat Interval. You can choose to have it repeated on specific days or use 

cron notation for more specific time data. If you decide on certain days, simply 
activate the check box(es) for the corresponding day(s). Cron notation should be 
used by specialists only. 
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9. Decide whether and about what you want to be notified via email concerning 
the run of the Scheduler task under Notifications:

NOTE: Notifications are sent only if the Notification option is activated in the Mail 
Manager. Also check there whether the email address of the intended recipient is 
included. 

10. Click OK to save your settings. Your new Scheduler Task is added to the list.

11. To activate the task, click the Activate button. – On activated tasks, the button 
changes to Deactivate.

All activated tasks are performed by the Scheduler Server Application at the time 
defined in the task. You need only make sure that the Scheduler Server Application is 
running and that the computer running it is online and can access the Cumulus 
Server. 

From time to time you should check the status of the tasks, as it cannot be granted 
that they could be executed.

Use the Run Now button to execute any Scheduler task immediately. This is very 
handy when testing, when you don’t want a task to run at intervals, or when you need 
a task to run just once.
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Provided Scheduler Actions 
Most of the Scheduler actions that Cumulus provides are the basis for powerful work-
flow possibilities. 
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NOTE: Note that some of the provided actions belong to optional features 
which may not be available with your Cumulus configuration.
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Autocatalog Assets

You can configure the Cumulus Scheduler to autocatalog assets from any location on 
your network, at any interval you need. There’s no need to leave a Cumulus Client 
application running, because the Cumulus Scheduler will handle it all. More so than 
drop-folder cataloging, this capability can serve as a basis for interfacing Cumulus with 
other systems that produce documents, such as invoicing systems or software that 
produces on-demand PDFs (or other formats). Within minutes of those files being pro-
duced, they can be safely cataloged into Cumulus and available to you from any-
where.

This Cumulus Scheduler action also provides an email cataloging technology. 
Cumulus can check a standard POP3 email account and retrieve and catalog any email 
it finds. Email text is extracted into an asset record, and all attachments are cataloged 
and linked to the email record. 

Select the option to catalog emails from a POP3 or POP3s account, enter the data of 
your POP3 or PO3s Server, and you can have emails cataloged automatically.

For a POP3s account, the following syntax is required: 
pop3s:pop_server_name:Port (e.g., pop3s:pop.gmail.com:995 for Gmail 
using port 995 and SSL).

NOTE: Autocataloging emails from a POP3 account only works if the respective 
catalog is set up to use a Central Asset Location (Edit > Preferences > Catalog 
Settings > General > Use Central Asset Location). 

Copy, Move or Delete Assets

This action moves assets to archive locations, or deletes temporary or obsolete assets 
– all automatically, all based on metadata values. It even enables you to use Cumulus 
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as the distribution system that moves files created by other systems to the locations 
you need.

You can define metadata values in your catalogs that direct the Cumulus Scheduler to 
copy, move or even delete assets. 

Video Cloud

This action reads the content of certain Video Cloud related record fields and initiates 
respective actions (upload to / remove from Video Cloud, publish/un-publish). For the 
Video Cloud feature to work, it is required that a Scheduler task with this Scheduler 
Action is set up properly. 

NOTE: When a Cumulus Video Cloud license or Cumulus Video connector 
License is added to your Cumulus system, the Cumulus Scheduler must be 
restarted in order to make the Video Cloud Scheduler action available.

Export Records

This action exports records found by a query to an xml file. 
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You can select which metadata fields shall be exported from the found records, as well 
a s a Metadata Template to be applied before the export. You can also choose whether 
the resulting file is to be compressed or whether an XSL transformation is to be 
applied.

Generate Usage and Statistic Report

Cumulus reports can be scheduled to occur at intervals you define, ensuring their con-
tents are up to date and accurate. You can determine which reports you want run, 
choose when you want them run, and choose the catalogs to report on. You can also 
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choose the output format and the destination for the output. The options available for 
the output format depend on the report type employed.

Select one of the reports you defined with the Report Manager and then have the 
Scheduler generate it at times you define for this Scheduler task.

NOTE: Autocataloging Reports: You can use the Scheduler’s autocataloging to 
automatically catalog each new report back into Cumulus.

Start Workflow

This action is used to start a workflow (see Workflows) on all assets that are found by a 
query. 

Note that such a query must be created manually. It is not possible to use a previously 
saved query! The most convenient way to create a query is to compose it in the 
Cumulus Desktop Client’s Find window in Advanced Mode, then copy it into the 
Query to match field of the Configure Module window.
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Set Manager
The Set Manager enables you to export and import shared Cumulus items such as 
View and Asset Handling Sets as well as Templates, Actions, Collections and Queries. 
You can select the items before the Import/Export process is started. Another function 
enables you to unload all individual sets of all disconnected users in order to force a 
refresh when the users connect to the Cumulus Server again. This function lets the 
Cumulus Client application reload the individual sets of a user.

PRECONDITIONS: You need to be logged in as the Cumulus Administrator to work 
with the Set Manager.

To import or export Cumulus items (shortly called: sets) with the Set Manager:

1. Select the File > Administration > Server Console, or connect to the Web Server 
Console via a Web browser.

2. The Server Console is started. Log on as Cumulus Administrator to the Cumulus 
Server that manages sets you want to export or that you want to import sets to. 

3. Click the button for the function you want to perform. 

4. Follow the on-screen instructions. 
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Managing Users

As a user administrator you have the job of managing user access to catalogs. Not only

does Cumulus let you define whether each catalog is shared by your workgroup, but

also how each catalog is shared by each user. In this chapter, you will learn how to set

up Client users, how to make catalogs available to Client users, and how to define spe-

cific user permissions.
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User Management
The Cumulus user management enables you to create users and specify their access 
rights to catalogs and functions.

Cumulus permissions are based on an additive concept. This means that a new user 
does not have any permissions by default. This minimizes the risk of granting permis-
sions accidentally but implies that you have to grant any new user at least the mini-
mum permissions a user needs to work with Cumulus. 

Cumulus users are managed with the User Manager module of the Server Console.

The Users Catalog
The user management is based on a special Cumulus catalog. Its catalog name is 
$Users and its catalog file name is Users.ccf. This manual refers to it as the Users cata-
log. 

The Users catalog has to be managed by your Cumulus Server, meaning it has to be 
included in the Catalog Access list. It must not be shared nor published to the Internet.

It is possible to open the Users catalog with a Cumulus Client, but this is not recom-
mended for user management. There is only one reason to open the Users catalog 
with a Cumulus Client: The user data are stored in record fields. If you want to have 
more fields than the default configuration offers, you can add record fields to the Users 
catalog. If you do this, always use the version of the Cumulus Client application that 
fits the version of your Cumulus Server.
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Modes
Cumulus is intended to meet the needs of many different customers. This is why the 
Cumulus user management offers different modes. Whether you settle for user-based 
or role-based mode defines the method by which permissions are assigned. For both 
methods a simple and advanced view is offered for granting the permissions.

User- and Role-Based Mode

Cumulus provides two different modes for the method of managing users:

• the user-based mode where you assign the permissions to each user individually
OR

• the role-based mode where each user can be assigned to roles that include certain 
permissions (Note that this is an optional feature which may not be available with 
your Cumulus configuration.)

While the user-based mode is intended for a small number of users to be adminis-
tered, the   role-based mode is intended for a large number of users. You can create 
roles that you use to assign a common set of permissions and catalogs to multiple 
users. Organizing users by defining roles makes it easier to manage access rights. With 
this strategy, rather than assigning permissions to each user for each object, you 
assign permissions to a few roles and then add users to the appropriate role. When 
using Cumulus, users are granted permissions based on any roles to which they 
belong.

When you create a user account for a new user, you add that account to the appropri-
ate role. Then, the user has the permissions associated with that role. Also, changing 
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permissions is easier: rather than having to change permissions for each and any user 
individually, you simply change the permissions assigned to the role. 

If you work with the role-based mode and you have a LDAP server, you can define 
mappings from LDAP groups to Cumulus roles. By using this mapping you no longer 
need an entry for this user in the User Manager. (See “Cumulus Roles”, for further infor-
mation.)

You have to decide which mode you want to work with. Once you have switched to 
the role-based mode you cannot switch back to the user-based mode. Both modes 
offer the same range of functions – except that the role-based mode offers roles to 
“bundle” users. So in case you have Cumulus users that can easily be “bundled” or split 
into different groups, we recommend that you employ the role-based mode. And we 
do not recommend that you start with the user-based mode and then switch to the 
role-based mode, otherwise each user you have defined will be converted to be a role.

The user-based as well as the role-based mode works with the Users catalog and the 
User Manager module to manage users with this catalog.

Simple View and Advanced View

The user-based as well as the role-based mode can be used in either the simple or the 
advanced view. The simple view subsumes several permissions whereas the advanced 
view lets you assign permissions in a very granular manner. For more information, see 
“Simple View: Permissions” , and “Advanced View: Permissions” .

The simple view enables you to set user or role permissions for a single catalog, or your 
entire Cumulus Server with just a few mouse clicks. You can switch to the advanced 
view when you need to make more granular changes. Both modes are always avail-
able, so you don’t have to choose just one.
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User Manager
To work with the User Manager you need to have the appropriate Administrator per-
missions for the server: Global User Administrator.

The User Manager is one module of the Cumulus Server Console. To start the User 
Manager:

1. From within the Cumulus Client, select File > Administration > Server Console, 
or connect to the Web Server Console via a Web browser.

2. Log on to the Cumulus Server you want to administrate as Cumulus Administra-
tor or as user who has the permission: Global User Administrator.

The modules of the Server Console application are loaded.

3. Click the + icon on the left side of the User Manager entry. Then click on Users or 
External Users. The Users list is displayed. 
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User Types
The User Manager has two sections, corresponding to two user types: Users and Exter-
nal Users.

Basically, there is no difference between external and ‘normal’ users. This distinction is 
only a descriptive one. Both normal and external users can be created and configured 
manually. External users, however, can also be created automatically.

An external user is created automatically each time a collection link is sent to an email 
address so far unknown to Cumulus. The purpose of such a user is to allow Cumulus 
to monitor the usage of the collection link. Initially, automatically created external 
users have no permissions at all, and the only thing Cumulus knows about them is 
their email address.

The User Administrator may add more information to an external user and may grant 
any desired permission. Thus a user without any permissions can eventually be pro-
moted to a full-fledged Cumulus user. Changing a user’s type from external to “nor-
mal” or vice versa is also possible any time. However, changing the User Type value 
does not affect the permissions a user is granted.
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Creating Users
A new user does not have any permissions by default. We recommend that you create 
“typical” user accounts that fit the needs of your organization first and then duplicate 
these user accounts to set up the real users. However, when using this method, 
remember to keep such users up-to-date, e.g. when adding new catalogs. Create as 
many of these template users as you need.

TIP: Specific Initial User Settings

Administrators have no access to a user’s preference settings, so users must 
perform user setting changes on their own. If you want to provide specific ini-
tial User Settings for each newly created user, log in as the user that is used as 
a template for new users and configure the user settings as needed. New users 
created by duplicating this template user will then have the same initial user 
settings.

To add a new user to the Users list:

1. Click the Create button. 
OR
Select your “typical” user and click the Duplicate button.

IMPORTANT! Check whether this user’s properties are up-to-date – especially 
the catalogs that she/he is allowed to access. 

The Input window appears.
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2. Enter the Login name for the new user and click OK. The name must be unique.

The properties window for the new user appears.

The Unique User ID option is activated by default. Deactivate this option only if 
an external UUID (e.g. provided by LDAP) is to be used exclusively instead of the 
UUID provided by the Cumulus built-in authenticator. (For more information on 
the Unique User ID, see “User Identification” .) 

3. Activate  Login Active  if you want to allow the user to work with Cumulus as 
soon as you have closed the user’s properties window.

4. Select the authentication method. You can choose different methods for different 
users of your Cumulus installation. The provided choice of authentication meth-
ods is:

• Built-in – The Cumulus built-in authentication will be used exclusively. Advan-
tage: Independent from the operating system you are using.
With this authentication method only, different options for changing the pass-
word are available.

• System – The user password will be authenticated by the Operating System. 
Advantage: No need to administrate a separate Cumulus password.

• LDAP – If you are employing LDAP (Lightweight Directory Access Protocol) the 
user password will be authenticated by LDAP. Advantage: No need to adminis-
trate a separate Cumulus password. (See “LDAP Authentication Method”, for 
details on how to use this method with Cumulus.)

5. Click the  button to enter a password for the new user.

NOTE: Don’t forget to inform your new user about this login name and password. 
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6. Enter the data for the new user in the corresponding fields of the General and 
Additional Fields sections. (See “Overview: User Properties – General & Additional 
Fields”, for more information on the sections and fields). 

7. If working in user-based mode: Set the permissions for the new user. (See “Simple 
View: Permissions”, or “Advanced View: Permissions” , for more information.) 

If working in role-based mode: Assign the user to a role. On the Role tab click the 
Add button to get a list of available roles. Select the role(s) you want to assign to 
the user and click OK.

NOTE: Due to the additive permissions concept, the permissions a user has got 
are the sum of the permissions given to all roles the user is assigned to. 

8. Click OK to save the defined properties.
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Duplicating, Editing and Deleting Users
For duplicating, editing and deleting users select the user’s entry and then click the 
appropriate button. Duplicating a user works the same way as creating a new user 
except that when duplicating the properties of the duplicated user are copied for the 
new user – all properties except the login name.
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User Properties
A Cumulus user’s properties include her/his contact information and, in the user-
based mode, the permissions she/he has for functions and catalogs. The User Proper-
ties window has several tabs that provide access to the information stored on a user. 
These tabs are:

• General Tab – Login information and basic personal information 
• Additional Fields Tab – Additional contact information on the user
Tab provided in Simple View mode only:

• Simple View: Permissions Tab – Global permissions and catalog permissions
Tabs provided in Advanced View mode only:

• Catalog Access Tab – Cumulus catalogs the user is allowed to access
• Catalog Permissions Tab – Permissions the user has on these catalogs
• Server Permissions Tab – Permissions the user has for functions and objects man-

aged by the Cumulus Server.
Tab provided if Cumulus is running in role-based mode:

• Roles – Roles the user is assigned to
The following overview describes the General and Additional Fields sections only. 
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Overview: User Properties – General & Additional 
Fields

The User Properties window has several sections that provide access to the informa-
tion on the selected user. 

General Tab 

The General tab contains the basic information on a user.

1 Login Active – Must be activated to enable the user to log in.
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2 Login Name – The user’s login name; the name must be unique.
3 Unique User ID – If activated, user will always be identified by the UUID. For more informa-

tion, see “User Identification” .
4 Authentication Method – The current authentication method.
5 Click her to open a drop-dow n list with available authentication methods. For more infor-

mation on authentication methods, see “Creating Users” .
6 Password – The encrypted password. (Note that the placeholder stars are shown even if no 

password is set, e.g. when creating a new user.)
7 Click here to enter or change the password. 

NOTE: Don’t forget to inform the user about a new or changed password!

8 Password Modification Date – Date of the last password modification. This date along 
with the maximum password age defines when users must to change their password. The 
value for the maximum password age is defined in the Cumulus Server Settings (see “Over-
view: Cumulus Server Settings” ).

9 E-Mail Address – A valid email address. If no email address is specified, the user cannot 
make use of any of the email functions of Cumulus Web Client or Portals.

10 Login Expiration Date – If no date is specified, the user’s login will never expire.
11 Click this button to select an expiration date for the user’s login.
12 Password Options – Select an option for changing the password. (Only available with the 

Cumulus built-in authentication method.)

NOTE: The Password never expires option overwrites the maximum password age set for 
Cumulus users’ passwords in the Cumulus Server Settings (see “Overview: Cumulus Server 
Settings” ).

13 Switch to Advanced View – Button to toggle the permissions management from Advanced 
View to Simple View and vice versa. The Advanced View provides three tabs for the permis-
sions management, whereas in Simple View the user or role permissions are subsumed and 
offered on one tab. For details see “Simple View and Advanced View” .
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Additional Fields Tab 

What is displayed in this tab depends on the 
record fields of the Users catalog. These fields 
generally contain optional information and 
are displayed in alphabetical order (A-Z). Most 
of them are self-explanatory.
14User Language – The language the user 
prefers for email messages sent by Cumulus. 
Select the desired language from the drop-
down list.

NOTE: Selecting a user language only take 
effect if there are mail templates available in 
the selected language. Out-of-the-box, 
Cumulus currently provides English and Ger-
man templates only. If you select a language 
that has no localized templates, English will 
be used as the fall back language.

15User Type – Depending on this value, the 
user is either listed in the User section, or in the 
External User section of the User Manager.

16 Saves the information on the user and closes the window. 
The changes will take effect with the users next login. 

17 Closes the window without saving any changes.

Simple View: Permissions Tab

For details see “Simple View: Permissions” 

16 17

14
15
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Advanced View: Catalog Access, Catalog and Server Permissions 
Tabs

For details see “Advanced View: Permissions” 
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User Identification
Cumulus uses a Unique User ID (UUID) for user identification as well as for checking a 
user’s record and category permissions. A UUID consists of a definition of the authen-
ticator and a unique ID from the authenticator. The authenticator is required to pro-
vide a unique ID. 

By default, the user will always be identified by the UUID provided by the Cumulus 
built-in authenticator and stored in the Users catalog. The Unique User ID option on 
the General tab of the user’s Properties window is activated, 

If you employ a different authenticator (e.g. LDAP), it might provide own UUIDs. If you 
want to use these UUIDs, you must deactivate the Unique User ID option in the 
Cumulus user’s properties. 

NOTE: Changing the Authentication Method!
If you change the authenticator and use its UUIDs, the permissions set for a user 
are no longer valid. They must be set again for the ’new’ user (identified by the 
UUID of the other authenticator.) 
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Simple View: Permissions
In simple view the user or role permissions are subsumed to global permissions or per-
missions on catalog base.

Permissions Tab
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You can either grant a user global permissions or grant “individual” permissions for 
catalogs. Once you grant a user the global permission, the user has this permission for 
any catalog – no matter whether the permission is given for the catalog or not.

Global Permissions 

• Read Metadata – User can view catalogs and the metadata of all records and cat-
egories.

• Write Metadata – User can edit the metadata of all records and categories, e.g. can 
catalog assets and add metadata to records.

• Delete Records & Categories – User can delete records (and their assets) as well as 
categories.

• Manage Sets & Templates – User can create, edit and delete sets, templates and 
actions (all items defined for the Cumulus application in the Preferences window 
– except Catalog Templates and Catalog Settings). 

• Administrator – User can perform all administrative tasks and use the according 
utilities (e.g. User Manager, Backup Manager). The user is also allowed to configure 
Cumulus Vault, define Scheduler tasks and generate reports.

Permissions for Individual Catalogs

• Read – short for Read Metadata (description see above)
• Write – short for Write Metadata (description see above)
• Delete – short for Delete Records & Categories (description see above)

IMPORTANT! Minimum Permissions 
In simple view the minimum permissions required for a user to work with 
Cumulus are: Read for at least one catalog. Or if catalog specific permissions are 
not required, Global Permission Read Metadata. 
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TIP: Simple View in Conjunction with Advanced

You can use the simple view in conjunction with the advanced view – make 
“broad stroke” permissions settings in simple view and then fine tune them 
exactly as you need in advanced view.
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Advanced View: Permissions
Cumulus provides an enhanced permissions management. Each user’s or role’s prop-
erties include several permission sections:

• Catalog Access – Cumulus catalogs the user is allowed to access.
• Catalog Permissions – Permissions the user has for these catalogs.
• Server Permissions – Permissions the user has for functions and objects managed 

by the Cumulus Server.

NOTE: Permission changes made to the account of a connected user will not 
take effect until that user logs out and back in again. Keep this in mind when-
ever you’re testing permissions options on your Server. 
If you don’t log out of your test account, you might think your changes are not 
taking effect. 

IMPORTANT! Minimum Permissions
In advanced view the minimum permissions required for a user to work with 
Cumulus are: the Application Permissions Open Catalog with any Cumulus 
Client, View Item for Records and access to at least one catalog, one Record 
View Set and one Category View Set. 

Catalog Access Tab

The permissions for a user’s access to catalogs are defined in the Catalogs section of 
the Properties window for the user or role. 
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You can allow a user to have access to all catalogs that are managed by the Cumulus 
Server or restrict the access to selected catalogs.

Access to All Catalogs

If the Restrict Catalog Access option is not enabled, the user is allowed to access all 
catalogs that are managed by the Cumulus Server and enabled for sharing. In this case 

• all catalogs added to the Cumulus Server are automatically available to this user 
• the permissions set in the Permissions section are valid for all catalogs.

Restricted Access to Selected Catalogs

If the Restrict Catalog Access option is activated, you can set the permissions either 
for all of the allowed catalogs at once, or  for each of the allowed catalogs individually. 

Before you consider activating the Restrict Catalog Access option, you should be 
aware of the following. In this case, each newly created catalog which you want this 
user to have access to must be added to the list of catalogs.

IMPORTANT! Restrict Catalog Access Option
Any user should have access to at least one shared catalog!

Catalog Permissions Tab

A user’s permissions for catalogs are defined in the Catalog Permissions section of the 
Properties window for the user. The catalog permissions refer to the catalogs defined 
in the Catalogs section of the Properties window.

A user’s permissions for catalogs can be set collectively for all allowed catalogs or indi-
vidually for selected catalogs. However, note that the permissions individually set for 
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selected catalogs are always added to the permissions that are set for all allowed cat-
alogs.

Once you have clicked on the Catalog Permissions section of a user’s properties, you 
select the catalog you want to set the permissions for. Set the permission for All 
Allowed Catalogs first and then select the catalog for which you want to set the per-
missions individually. 

Application Permissions

The Application Permissions define the user’s general permissions for functions on 
catalogs, records, categories and assets as well as the user’s permissions when access-
ing Cumulus via Web. 

NOTE: If you give one of these permissions for All Allowed Catalogs, the user 
will have this permission for all catalogs managed by your Cumulus Server. 

IMPORTANT! Minimum Application Permissions
The minimum Application permission required for a user to work with Cumulus 
is Open Catalog. 

Individual Record or Category permissions.

With Enterprise or the Extended Permissions add-on, these Application permissions 
can be expanded by individual Record or Category permissions. If you want to make 
use of this feature, you can follow two different concepts:

• You assign the Application permissions as needed in general and use the individ-
ual Record or Category permissions to add permissions for selected records and 
categories due to special purposes.
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• You reduce the Application permissions to a minimum of permissions (even none) 
and use the individual Record or Category permissions to set permissions on the 
record/category level. This concept offers the advantage that you can remove per-
missions for specific users/roles on the record/category level. You can even use a 
Permissions Template to do so. If following this concept, Canto recommends you 
to set up a special Permissions Template used for cataloging that assigns the per-
missions you would like a ’normal’ user to have.

For more information on individual Record or Category permissions, see “Assigning 
Individual Permissions for Records and Categories “.

The following section describes which permission is needed to perform which func-
tion.

Permissions for Entire Catalog

These permissions govern the user’s access to the selected catalog itself.

• Open Catalog with any Cumulus Client – needed to gain access to the catalog in 
order to open it; e.g with a Cumulus Client application to get the catalog displayed 
in the Catalog Access window. “Any Cumulus Client” includes the Cumulus Client 
application, Cumulus Web Client, Portals, HELIOS Companion, and any individually 
programmed application based on Cumulus Java Classes. 

NOTE: The catalog access can be restricted to certain Cumulus Client versions 
and variations. See “Client Groups”, for further information. If you have set up any 
Client Groups, the options for the Catalog Permissions will be enhanced with an 
entry Open Catalog with for each defined group. 

• Modify Catalog Category Permissions – needed to define permissions for cate-
gories that represent catalogs (optional.)
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• Manage Catalog Triggers – needed to create, edit and delete own triggers for cat-
alogs. 

Permissions for All Records and Categories

The following permissions govern the user’s access to the records or categories of the 
selected catalog(s). 

• View Item – With Enterprise or the Extended Permissions add-on only: allows a 
user to see all records/categories – even if Live Filtering is active. 

• Create Item – needed to catalog assets/create categories and to import records/
categories.

• Modify Items – For records: needed to modify records (manually or via automation) 
and to update records (as this includes modifying the records). This permission is 
also needed for checking assets in or out with any version control system, e.g. 
Cumulus Vault. 
A user who is allowed to modify records, may additionally be allowed to change 
the asset reference that is included in the record. The permission for modifying the 
asset reference must be given explicitly by assigning the Modify Item Reference 
permission.
For categories: needed to rename, modify and move categories and for the syn-
chronization and auto-cataloging functions. 

• Delete Items – needed to delete records/categories.
• Modify Item Permissions – With Enterprise or the Extended Permissions add-on 

only: needed to edit individual record/category permissions.
• Manage Item Triggers – needed to create, edit and delete own triggers for 

records/categories.
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Asset Permissions

The following permissions govern the user’s access to the assets of the selected cata-
log(s). 

• Delete Assets – needed to delete assets.
• Transfer Assets – needed for any function where accessing the asset directly is 

required but where the user of a Cumulus Client application (e.g. Desktop or Web) 
cannot access the assets directly. In other words, this permission grants the Server/
Client asset transfer function. This function allows e.g. to copy files from the Server 
to a client without direct access to the asset or to provide a rendered preview. 
With Cumulus Vault, this permission is needed for accessing assets (e.g. copying, 
moving).

• Asset Versioning – needed to use any version control system, e.g. Cumulus Vault. 
Along with this permission the Modify Item permission is always needed on the 
respective asset record to check assets out or in.

• Download Asset – needed e.g. with Cumulus Web Client and Portals. 
• Show Original Asset– needed e.g. with Cumulus Web Client and Portals to have 

the original asset displayed or downloaded. 
• Email Assets – needed with Cumulus Web Client versions prior 9.0 for emailing 

assets. Might be used for individual integrations. 
For information on the component related use of permissions see:

• Cumulus Web Client: “Configure user permissions”
• CIP: “Permissions for Accessing/Downloading Files via CIP-based Applications”

Subtable Permissions

The Application Permissions also define a user’s permissions for Table fields. The User 
Comments feature is based on such a subtable. This means that the permissions for 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING USERS ADVANCED VIEW: PERMISSIONS

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

this feature are managed with the permissions granted for the corresponding field: 
User Comment Thread. To make full use of the User Comments feature, a user needs 
the view, create, modify and delete permissions. 

Tracking an asset’s usage history is also based on a Table field: Asset Usage History. If 
you want a user to be able to see an asset’s usage history, you have to grant the view 
permission to that user.

Administrator Permissions

The Administrator Permissions refer to administrative functions for catalogs.

NOTE: If you grant one of these permissions for All Allowed Catalogs, the user 
will have this permission for all catalogs managed by your Cumulus Server. 

• View Catalog Settings – The user is allowed to view the selected catalog’s settings 
in the Catalog Settings window of the central Cumulus Preference window. 

• Modify Catalog Settings – The user is allowed to make modifications for the 
selected catalog in the Catalog Settings window of the central Cumulus Prefer-
ence window. A user who is allowed to modify the catalog’s settings, may addi-
tionally be allowed to set up and modify a central asset location for the selected 
catalog. The permission for modifying the central asset location must be given 
explicitly by assigning the Modify Central Asset Location permission. The permis-
sion for setting up mirroring for the catalog must be given explicitly by assigning 
the Manage Mirroring permission.

NOTE: Canto recommends that you allow only one user to have access to this or 
have one person responsible per catalog. If several users have the permission for 
modifying the Catalog Settings you might get into trouble when they modify at 
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the same time, as the first user accessing the Catalog Settings and saving changes 
blocks those with access to the Catalog Settings from saving their changes. 

• Manage Log Files – The user is allowed to start the Log Manager module and set 
up a log file for the selected catalog.

• Monitor Activity – The user is allowed to start the Activity Monitor module and to 
view the list of users connected to the selected catalog. The user is also allowed to 
disconnect users from the selected catalog.

• Trigger Administrator – needed to create, edit and delete all triggers of all users.
• Media Delivery Cloud Administrator – needed to operate the Media Delivery 

Cloud (MDC) plugin.

Automatic Tagging Permissions

The Automatic Tagging permission controls the use of the Automatic Tagging feature. 

• Automatic Tagging User – users with this permission can use the Automatic Tag-
ging feature.

Video Cloud Permissions

Video Cloud permissions define in which way and to which extent a user can make use 
of the Cumulus Video Cloud feature. 

• Video Cloud Administrator – needed for any user who can access the Video 
Cloud module of the Web Server Console, and who can manage video files on the 
Video Cloud service (uploading to/removing from Video Cloud, publishing/un-
publishing).
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• Video Cloud Contributor – needed for users who can make use of the embed 
code with different skins, make use of derivatives, and can view same status infor-
mation.

• Video Cloud Consumer – needed for users who only can make use of the video 
link URLs and embed codes, and can select different size values for the embed 
code.

Additional Permissions

This section gives you the possibility to include permissions that are used by addi-
tional EJaPs, Internet solutions and solutions based on Cumulus Java Classes. For 
details as to which permission should be included, ask the producer or programmer 
of the additional software.

Set, Action, Query and Template Permissions

For the selected catalog, you can restrict the user’s access to selected items of one 
type (sets, actions, queries and templates). If you restrict the user’s access to a selection 
of shared items of this type, the items not selected will not be available for the user. 

NOTE: If you grant one of these permissions for All Allowed Catalogs, the user 
will have this permission for all catalogs managed by your Cumulus Server. 

If the Restrict Access option is not enabled, the user is allowed to access all shared 
items of the selected type that are enabled for sharing. 

To restrict a user’s access to a selection of shared items only, enable the Restrict 
Access to option. Use the Add button to set up the selection.

If the Restrict Access option is enabled, you have to add items. Otherwise the user has 
no access to any item of the selected type in the catalog.
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Before you consider activating the Restrict Access option, you should be aware of the 
following: each newly created item which you want this user to have access to must 
be added to the list.

If the user is working with a multi-catalog collection (a collection that includes records 
from more than one catalog), the new impact of the Restrict Access option has the 
following consequences when selecting sets, actions, queries and templates: The user 
can only choose items that are available for him/her for all catalogs included in the col-
lection. In other words, only such items that belong to the intersection of the permis-
sions that the user has for all catalogs included in the collection. If the user opens 
another catalog in an existing collection, the selection of available sets, actions, que-
ries and templates might change. 

NOTE: Be careful when using this permission feature. Erroneous configurations 
for Record and Category View Sets can prevent the user from seeing any 
records/categories. 

IMPORTANT! Restrict Access Option
A user needs at least access to one Record View Set, one Category View Set and 
one Asset Handling Set. Without these permission granted, a user cannot open 
a catalog. 

TIP: Checking Assigned Sets, Templates etc.
The Server Console Action menu offers a Check Users Catalog function for the User 
Manager item. This function searches for settings (sets, templates etc.) that are assigned 
to users (or roles) in the Users catalog but no longer available with your Cumulus instal-
lation. If any settings are found that are assigned but not available, the function lets you 
remove the assignments from all users (or roles) in the catalog.
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NOTE: Migration
The permissions for sets, actions, queries and templates are new since Cumulus 
6.5. You have to add these permissions to the properties of each user of your 
former Cumulus 6 installation.
In Cumulus 7, this Restrict Access option for the items listed above has been 
moved from Server Permissions to Catalog Permissions. This enhances the 
impact of the option: now the restricted access can be set on a catalog-by-cat-
alog basis.
The only Restrict Access option available under Server Permissions belongs to 
Collections Permissions because collections can span across catalogs.

Server Permissions Tab

A user’s permissions referring to the Cumulus Server are defined in the Server Permis-
sions section of the Properties window for the user. The permissions defined in this 
section do not refer to any catalog but to the settings managed by the Cumulus 
Server. 

User Permissions

These permissions define what the user is allowed to modify on her/his own user set-
tings in the User Settings window of the central Cumulus Preference window.

The permissions refer to the different sections of the User Settings window.

If you are working in role mode, the User Permissions section additionally provides 
the possibility to replace certain user settings of all users belonging to a role with the 
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settings of a defined user. Thus you can easily achieve that all users belonging to a cer-
tain role have, for example, identical search and sort settings.

All you have to do is to create a new user, specify his/her user settings according to 
your ideas, then take this user to have the appropriate settings applied to all other 
users belonging to the role. Changing the settings of your template user, affects the 
settings of these users accordingly as soon as they log in (again).

If certain user settings are replaced by the settings of a specific user, the members of 
the role are no longer allowed to change their respective user setting by themselves. 
If, for example, the Replace Search & Sort Settings with settings of is activated (as 
seen in the screenshot above), the Modify Search & Sort User Settings option is deac-
tivated automatically.

IMPORTANT! Be careful with users belonging to more than one role!
If different roles have defined user settings replacement for the same parts of 
the user settings, but from different template users and with different values, 
the result for a user belonging to several roles is a purely random replacement!

Run-as Permissions

The Run-as permissions define as which other user(s) a user may act.

You can allow a user to have access to all catalogs that are managed by the Cumulus 
Server or restrict the access to selected catalogs.

The Run-as function (File > Administration > Connect to Server As) is useful e.g. for 
substitution purposes, or for an administrator who needs to test the configuration of 
users or roles.
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Administrator Permissions

You can assign the following administrator permissions:

• Backup Administrator – The user is allowed to start the Backup Manager module 
and define rules for the automatic backup of catalogs.

• Vault Administrator – The user is allowed to administer the Vault Server.
• Mail Administrator – The user is allowed to work with the Mail Manager and con-

figure Cumulus to work with an email server. 
• Web Solutions Administrator – The user is allowed to work with the Configurator 

modules for Cumulus Web Solutions to administrate e.g. Web Client. 
• Workflow Administrator – The user is allowed to:

• create, edit and delete workflows (via the Web Server Console);
• add them to, remove them from, and update them in catalogs (via the prefer-

ences dialog). – Note that this requires additional permissions: Catalog Permis-
sions > Administrator Permissions > View Catalog Settings and Modify 
catalog Settings!

• Additionally, the user is allowed to remove workflows from files (via the Desktop 
Client or Web Client).
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User Administrator Permissions

You can assign the following user administrator permissions:

• Browse for Users – The user is allowed to employ the Add User button to search 
for users when setting up Triggers with Mail Notification for other users and – 
optional only – individual permissions for records/categories and Permissions 
Templates. With Cumulus Enterprise, this permission is also required to be able to 
search for users with the Restrict Edit to the following Users and Roles or the 
Restrict field visibility to the following users and roles options in the properties 
of a record or category field.
The Browse for Users permission always includes the Browse for External Users per-
mission. (See User Types to find out about the difference between external and 
internal users.)

• Use External Users – The user can send upload links or personalized collection 
links to already existing external users, and can assign such users to workflows
• Browse for External Users – When entering recipients’ email addresses for 

upload links, personalized collection links, or workflow assignments, the user 
gets proposals for already existing external users according to the characters 
entered into the address field.

NOTE: The status of this check box only takes effect if the Browse for Users check 
box is not activated! In this case, activating this check box will allow a user to 
browse for external users, but not for internal ones.

• Create External Users – The user can send upload links or personalized collec-
tion links to recipients so far unknown to Cumulus. A new external user is cre-
ated in the $users catalog whenever such a link is sent to an unknown user.
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NOTE: Users having only the Use External Users permission (but not the Browse 
for External Users or the Create External Users permissions) can send links to exist-
ing external users anyway, if they know their email addresses. If a valid email 
address of an external user is entered, Cumulus displays a respective notification 
(depending on the used client).

• Global User Administrator – The user is allowed to work with the User Manager. 
If Cumulus runs in role mode and you work with departments, a user with the 
Global User Administrator permission can manage users and roles for all depart-
ments.

• Department User Administrator Permissions (available only if Cumulus runs in role 
mode, you work with departments, and Global User Administrator is not acti-
vated). – The user can have department-specific user administration permissions 
which are specified in this table.
Keep in mind that the effective permissions may differ from the assigned permis-
sions! For example, assigning read-write permission to a top-level department 
results in read-write permissions for all subordinate departments, no matter what 
permissions they are assigned to individually. If Global User Administrator is acti-
vated, the Effective Permission is always Read Write.

NOTE: Department-specific user administrator permissions only operate if 
Global User Administrator permissions is deactivated.

Additional Permissions

This section gives you the possibility to include permission that are used by additional 
EJaPs, Internet solutions and solutions based on Cumulus Java Classes. For details as 
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to which permission should be included, ask the producer or programmer of the addi-
tional software.

Collections Permissions

You can assign the following collections permissions:

• Create Shared Collection – The user can create collections that can be share with 
others.

• Create Download Collections – The user can create download collections.
• Create Upload Collections – The user can create upload collections (by sending 

out upload links).
• Modify Shared Collections – The user can modify shared collections, including 

upload and download collections (add or remove items; edit a collection’s name). 
– Note that you can’t manually add items to upload collections!

• Delete Shared Collections – The user can delete shared collections, including 
upload and download collections.

• Manage User Collections – The user can create, modify and delete private collec-
tions

NOTE: Manage User Collections
This permission is also required for saving the contents of the Collection Basket 
of the Cumulus Web Client, or of Cumulus Portals. 

Set, Action, Query and Template Permissions

These permissions define how the user is allowed to work with:

• Record View Sets
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• Category View Sets
• Asset Handling Sets
• Asset Actions
• Metadata Templates
• Print Templates 
• Crop Templates
• Permissions Templates (optional) 
• Sub-Pane Filters 
• Scheduler Jobs
• Record Queries
• Category Queries (optional)
The permissions you can set for all these items are similar. For each type you can define 
whether the user is allowed to manage her/his own sets, actions, queries and tem-
plates. The permission manage includes creating, viewing, modifying and deleting.

For shared items you can grant the following permissions to a user (or role):

• Create
• View (in the Preferences window)
• Modify
• Set Default
• Delete
You can set these permissions for all shared items.
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Live Filtering 

Optional feature! May not be available with your Cumulus configuration.

You can configure users to have a “filtered view” on a catalog. The view of a user or a 
user group can be limited to preselected categories and/or records. For example the 
asset access for the sales staff can be limited to final, approved material, while the work 
in progress in the Marketing department should not be visible. 

If you want to restrict a user or a role to seeing and working with only certain catego-
ries and/or records, you can do so by means of Categories and/or Records Live Filter. 
These filters are defined via saved search queries. If you restrict the access to a catalog 
by means of a Live Filter, the user’s access to the catalog is restricted to the search 
result of the query employed as filter. Each time the user opens the catalog, a search 
employing the selected query is performed. That way the user gets a current result of 
the search query you defined to work with.

Live Filtering works and must be specified for each catalog individually.

As a prerequisite to make Live Filtering work with a specific catalog, the user’s View 
Items permission for Records or Categories must not be set for the this catalog (see 
below, step 4 and step 5).

To restrict the access to a catalog through filters:

1. Open the user’s or role’s properties in Advanced View.

2. Select the Catalog Permissions tab.

3. Via the Permissions for menu, select the catalog for which you want to activate 
the Live Filtering. 
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NOTE: You cannot activate Live Filtering if All allowed catalogs is selected in the 
Permissions for menu.

4. In the icon column on the left side, click the Application Permissions icon.

5. In the Permissions for All Records and Categories section, deactivate the View 
Item permission for records and/or categories, depending on the kind of Live Fil-
ter you want to apply.

6. In the icon column on the left side, click the Live Filtering icon.

7. To restrict the access to selected categories, enable the Use Category Live Filter-
ing option. Then select the query to be used. For a centrally stored shared query 
use the Use Query button. For any other exported query use the Use File button.

NOTE: Make sure to select a query that does not contain placeholders!

8. To restrict the access to selected records, enable the Use Record Live Filtering 
option. For this option you can select one of the following ways of filtering 
records:

• Automatically Use Resulting Categories for Record Live Filtering
The user will only see the records that are assigned to categories that have been 
found by the query used for Category Live Filtering.

• Use Record Query
The user will only see the records found by the selected record query. For a cen-
trally stored shared query use the Use Query button. For any other exported 
query use the Use File. 

9. Click the Use Query or Use File button to open a window for selecting the corre-
sponding query or file.
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NOTE:  If you cannot open the default folder for storing queries, check the 
folder’s properties. If they are set to Hidden, this folder cannot be addressed by 
the Select dialog. You either have to change the folder properties or save the que-
ries to another location that you can access.

10. Select the query you want to apply as filter and click OK/Select. Make sure to 
select a query that does not contain placeholders! The query is saved with the fil-
ter and the search conditions of the query are displayed. Note that the data of the 
query is saved with the filter and if you change the query later on, the filter will 
not be changed accordingly.

NOTE: If you want to use an exported query file, make sure that the query you 
select matches the corresponding Live Filtering option:
– For Live Filtering Categories, use a category query (i.e., saved with the Find 
Categories window).
– For Live Filtering Records, use a record query (i.e., saved with the Find Records 
window).
It is a good idea to give the queries meaningful names. 

For Live Filtering Records additional options are offered. Under Live Filtering 
Options, you can define if the records displayed for the user include records from 
categories above and/or below the found categories. This is important only if 
your defined Record Live Filtering includes categories as a filtering condition 
(either based on the result of Category Live Filtering or using a record query that 
searches in the Categories record field). 

11. Click OK to save the user’s properties.

The Live Filtering access restrictions are valid next time the user or a member of 
the respective role logs on to the Cumulus Server. 
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To undo a Live Filtering restriction, disable the corresponding option. The query will 
not be active any more. If you want all records/categories to be available for the user/
role again on the next log in, you must additionally activate the View Items permission 
for records and/or categories.   
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Live Filtering and the Additive Permissions Concept
Remember that Cumulus permissions are based on an additive concept. By default, 
Live Filtering works in accordance with this concept. 

Multiple Roles

If a user is assigned to multiple roles, her/his permissions are the sum of the permis-
sions of these multiple roles. So if assigned to multiple roles with different Live Filtering 
restrictions, the user has access to the sum of the search results defined by the queries 
applied to those roles.

Queries and View Permissions 

A user who is allowed to open a catalog but not to view its records or categories will 
nevertheless be able to see the records/categories found by the queries assigned to 
her/him by Live Filtering. 

Individual Permissions for Records and Categories Precede Queries

A user who by individual permissions for records/categories is allowed to view 
records/categories will always see them – regardless of the results of Live Filtering 
queries. Individual permissions for records /categories have priority.
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Working with the Role-Based Mode
Optional feature! May not be available with your Cumulus configuration.

Before you start working with the role-based mode, you should set up a role concept 
that fits the company needs. 

You can create roles that you use to assign a common set of permissions and catalogs 
to multiple users. A role includes:

• Catalogs – Cumulus catalogs an assigned user is allowed to access.
• Catalog Permissions – Permissions an assigned user has for these catalogs (includ-

ing Live Filtering options).
• Server Permissions – Permissions an assigned user has for functions and objects 

managed by the Cumulus Server.
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Switching to Role-Based Mode
Once you have decided to work with the role-based mode, you have to switch to this 
mode. 

NOTE: This switch cannot be undone. 

1. Highlight the User Manager entry in the left panel of the Server Console. 

2. Select Actions > Switch to Role-Based Mode. A warning is displayed.

3. Click Yes. A message informs you that you have to disconnect from the Server in 
order to have the role-based mode activated. 

4. Click OK.

5. Select Server > Disconnect. 

6. Select Server > Connect. Log on to the Cumulus Server again as Cumulus Admin-
istrator or the user who has the permission (User Administrator). Now the role-
based mode of the User Manager is active.

If the you have switched to role-based mode of the User Manager, the User Manager 
entry in the Server Console offers a new option: Roles

To reveal the Roles click the + icon on the left side of the User Manager entry. Then 
click on the entry Roles. The list of roles will be displayed. 

The first step when working with the role-based mode is creating roles.
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Creating New Roles
To create a new role:

1. In the Roles list, click the Create button...

2. Enter a name for the new role and click OK.

NOTE: If you want to use the automatic role mapping between LDAP groups and 
Cumulus roles, the role name needs to match the value of an attribute of the cor-
responding LDAP group. (For details on how to map roles and LDAP groups, see 
“Cumulus Roles” .) 

The properties window for the new role is opened. 

NOTE: The Department section is displayed only if you have set up departments. 
Departments is an optional feature which may not be available with your 
Cumulus configuration. 

3. Set the permissions for the new role in the Catalogs, Permissions and Server Per-
mission sections. (See “Advanced View: Permissions”, for more information on the 
sections). 

4. Assign users to this role either 

• by clicking the Add button to assign users managed by the Cumulus User Man-
ager, or

• by mapping of LDAP groups to this role if you want to assign users managed by 
your LDAP server only. For information on how to map roles and LDAP groups, 
see “Cumulus Roles” .
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5. Click OK to save the defined properties.
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Duplicating, Editing and Deleting Roles
For duplicating, editing and deleting roles select the role’s entry and then click the 
appropriate button. Duplicating a role works the same way as creating a new role 
except that when duplicating, the properties of the duplicated role are copied for the 
role user.
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Actions for User Manager
The Actions menu for the User Manager module provides several administration utili-
ties. 

• Importing User Data
• Client Groups
• Departments
• Checking the Users Catalog
• Copying User Settings
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Importing User Data
Use Actions > Import XUSR Files to import the user data provided by Cumulus Web 
Publisher Pro or Internet Client Pro.
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Client Groups
Client Groups are a means to restrict access to Cumulus to certain applications (e.g. 
Cumulus Client, Web Client, etc) or versions of applications.

For each defined Client Group an entry Open Catalog with is added to the available 
Catalog Permissions of a user or role.

Additionally, you may Force Read Only Catalog Access for any defined client group. 
If the user opens a catalog with a Cumulus product that is contained in such a client 
group, only read access is possible, regardless of any other permissions set for the user. 

To work with Client Groups:

1. In the left panel of the Server Console window, click on the entry User Manager. 

2. Select Actions > Edit Client Groups.

The Edit Client Groups window is opened. It lists the existing Client Groups.

Use the appropriate buttons for creating, duplicating, editing, renaming or deleting a 
Client Group. A Client Group is defined by its name and the application products that 
are assigned to it. 

Click the Add button in the Products window to add a product.

A list offers a range of Cumulus products that can be included. The list will also offer 
other products if they are registered and activated with the Cumulus Server.

NOTE: Updating! 
Remember to update the products assigned to Client Groups as well. 
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Departments
Optional feature! May not be available with your Cumulus configuration.

IMPORTANT! If you have the Department feature activated in addition to your 
already running Cumulus system, you must restart the Cumulus Server in order 
to make this feature available to the users.

With Cumulus departments, users and roles may be grouped together, e.g. according 
the organizational structure of a company. Then specific administrators (sub-adminis-
trators) may be defined who are in charge of the users/roles of a department, or sev-
eral departments, but can not interfere with users/roles of departments they are not 
in charge of.

Sub-administrators can grant or revoke permissions to the role(s) assigned to the 
department(s) they are in charge of, but only if they have the respective permissions 
themselves. For example, there might be a role called ”picture editor” with the permis-
sion of editing metadata and which belongs to the department “Research”. The 
administrator in charge can revoke the editing metadata permissions from the picture 
editor role only if the administrator role (or any other role he or she acts in) itself has 
the editing metadata permission.

Defining departments does in no way interfere with user permissions and catalog 
access, which is controlled as always by the role(s) assigned to a user, nor does it influ-
ence the assignment of users to roles or vice versa.

The department feature is available in role-based mode only.
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To create departments:

1. Log in to the Server Console as administrator.

2. In the left pane of the Server Console, click on User Manager, then select Actions 
> Edit Departments. 
A dialog appears allowing to create new departments and to edit or remove 
existing ones.

3. Click Create to add a new department, then enter a name for the new depart-
ment and click OK

You may create as many departments and sub-departments as you need.

4. When you are done, click OK.
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Checking the Users Catalog
This utility scans the Users catalog for inconsistencies. It checks whether all catalogs, 
sets and templates that are assigned to users/roles are available. If an item is found 
that is assigned but not available, it is recognized as invalid and you will be asked 
whether the according assignments should be deleted. You can have Cumulus do this 
item for item or just ask you once for all items. Be careful when deleting assignments 
for catalogs: Cumulus considers catalogs as available only if they are opened with the 
Cumulus Server. 
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Copying User Settings
When the Users entry is selected in the User Manager module, the Actions menu offers 
another option: Copy User Settings. This option allows you to copy user settings from 
one user to another. The User Settings for the Cumulus application as set in the Pref-
erences window are then copied.

1. In the left panel of the Server Console window, click the entry User Manager and 
reveal its options. Then click on Users.

2. Select Actions > Copy User Settings. A dialog opens to select the user you want 
to serve as template.

3. Enter search criteria to find the desired user by her/his name. (The Cumulus built-
in authentication will search login name, first, middle and last name.) 

4. Click Find. The found users are listed. (Note that by default the result list can 
include a maximum of 50 entries.) 

5. Select the user you want to use as template and click OK. 
The next step is to collect the users/roles you want to apply the settings to.

6. Click Add User or Add Role to find those you want to inherit the settings.

• Clicking Add User opens a dialog to find and select users. 
Enter search criteria to find the desired user by her/his name. (The Cumulus 
built-in authentication will search login name, first, middle and last name.) Then 
click Find. The found users are listed. (Note that by default the result list can 
include a maximum of 50 entries.)

• Clicking Add Roles opens a dialog that lists the roles. 
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7. Select the users/roles you want to inherit the settings and click OK. They are trans-
ferred to the list of the Collect Users window.

If a role is listed, the settings will be applied to all users assigned to the role.

8. Click OK to apply the settings to the users addressed in the window.
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LDAP Authentication Method
This section describes the way the  LDAP Authenticator plug-in for the Cumulus Server  
works. 

If you want to employ LDAP for user authentication with your Cumulus installation, 
you need profound LDAP knowledge to configure the set up for the co-operation 
between your existing LDAP server configuration and the Cumulus user management 
properly. In order to employ LDAP for user authentication with your Cumulus installa-
tion, you don’t need to change your existing LDAP schema or contents to add infor-
mation needed for Cumulus.

The Cumulus LDAP Authenticator can be used in the following scenarios:

• The user is already included in the $Users catalog of Cumulus and the password 
should be checked using an existing LDAP server configuration. 

• The user is already included in the $Users catalog of Cumulus and the E-Mail 
Address field of her/his properties should be filled using an existing LDAP server 
configuration.

• The user is already included in an existing LDAP server configuration and no sepa-
rate entry (user record in the $Users catalog) should be created for the user (with 
the role-based user management only).

The LDAP Authenticator is part of the Cumulus Server installation. It is configured 
through the LDAP.xml file in the conf folder (located in the Cumulus Server installa-
tion folder). The Server installation provides two example files that are pre-configured 
for ActiveDirectory and OpenDirectory LDAP schemes. It is best to start making a copy 
of the example that fits your LDAP installation and rename it to LDAP.xml. The pro-
vided pre-configured files contain detailed comments on the configuration items. If 
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you use any other LDAP scheme than ActiveDirectory and OpenDirectory (e.g. eDirec-
tory), you have to adapt the structure to the structure of your LDAP scheme. 

The LDAP.xml file contains the LDAP host name and also the distinguished name (DN) 
of a user that is allowed to read the necessary LDAP information. The file also contains 
the password of this user in clear text so you should set up file permissions so that the 
LDAP.xml cannot be read by unauthorized users.

You can also specify whether to use Secure Socket Layer (SSL) communication with 
the LDAP server.
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User Password Authentication
The LDAP Authenticator can check the user password for authentication. The LDAP 
Authenticator is used only if the field Authentication Method in a user’s properties is 
set to LDAP. Then LDAP will check the password a user logs in with, against a login 
name that matches the Login Name field of the user’s properties stored in the $Users 
catalog. With the role-based mode of the User Manager, it is always used if the user 
has no record in the $Users catalog.

The LDAP Authentication module uses the simple LDAP authentication method.

To employ the LDAP authentication method for a user’s password you have to config-
ure the following items of the LDAP.xml file:

<ns:authenticator> 

<ns:search>

The example LDAP.xml files are syntactically correct for ActiveDirectory and OpenDi-
rectory LDAP schemes. However, they contain placeholders. In order to make your ver-
sion of the LDAP.xml work, you have to replace these placeholders with real values 
only. If you use any LDAP scheme other than ActiveDirectory and OpenDirectory, you 
have to adapt the structure to the structure of your LDAP scheme also.
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User Fields 
Optional feature! May not be available with your Cumulus configuration.

The LDAP Authenticator can provide field values for the user record (user properties) 
to be used in any client application for customized solutions. In the LDAP.xml file you 
can specify which field corresponds to which LDAP user node attribute. The field can 
be either an existing field from the $Users catalog in Cumulus or you can define your 
own field by specifying a new unique ID for it. (To specify a new unique ID, you should 
use the function provided by your operating system, e.g. for Linux use the command 
uuidgen -t or for Mac OS X use the command uuidgen.)

In any Cumulus Internet solution, you can display the field value using the standard 
<cumulus:fieldValue> JSP tag with the unique ID of the field.

If the user has a record in the $Users catalog of Cumulus, the field values from this 
record have precedence over values from the LDAP Authenticator.

To have LDAP Authenticator providing field values you have to configure the follow-
ing items of the LDAP.xml file:

<ns:authenticator> 

<ns:search>

<ns:fields>

The example LDAP.xml files provide one by one mappings of LDAP attribute values to 
Cumulus field values. The examples include those attributes included in a standard 
ActiveDirectory and OpenDirectory LDAP installation that have corresponding 
Cumulus fields in the $Users catalog. If you want your mapping to include another 
attribute from a user node, you have to add it as a new field element to your LDAP.xml 
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file. If you use any LDAP scheme other than ActiveDirectory and OpenDirectory, you 
have to adapt the structure to the structure of your LDAP scheme and replace the pre-
configured field elements by field elements fitting your LDAP scheme.
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Cumulus Roles
Optional feature! May not be available with your Cumulus configuration.

If you work with the role-based mode of the User Manager, you can define mappings 
from LDAP groups to Cumulus roles. By using this mapping you no longer need an 
entry for this user in the User Manager (a user record in your $Users catalog). All you 
need is to define Cumulus roles and assign permission to them. Assigning users to 
these roles is done using the role mapping of the LDAP Authenticator. All role assign-
ments done by the LDAP Authenticator module are added to the roles already 
assigned to the user through a record in the $Users catalog.

The LDAP Authenticator supports different kinds of role mappings:

• Automatic mapping of all LDAP groups to Cumulus roles by matching one of the 
group's attributes (e.g. the group's name)
This is the easiest way of mapping LDAP groups to Cumulus roles. All you need to 
do is give your Cumulus roles names that correspond to an attribute of an LDAP 
group. For example you can name your Cumulus roles so that they match the "cn" 
attribute of your LDAP groups.

• Manual mapping of groups to a Cumulus role
You can define additional mappings of specific LDAP groups to a specific Cumulus 
role so that a user is assigned that role if he or she is a member of any or each of 
the given LDAP groups. For example you can define a mapping to assign all users 
to the "CumulusAdmin" role if they are members of both the "Administrators"  and 
the "Backup Operators" group.

To have LDAP Authenticator supporting role mapping you have to configure the fol-
lowing items of the LDAP.xml file:
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<ns:authenticator> 

<ns:search>

<ns:roles>

<ns:role-mapping>

The example LDAP.xml files are syntactically correct for ActiveDirectory and OpenDi-
rectory LDAP schemes. However, they contain placeholders for the names of Cumulus 
roles and LDAP groups. In order to make your version of the LDAP.xml work, you have 
to replace these placeholders with real values only. If you use any LDAP scheme other 
than ActiveDirectory and OpenDirectory, you also have to adapt the structure to the 
structure of your LDAP scheme.

Automatic mapping can be used if the names of your Cumulus roles correspond to 
attribute values of your LDAP groups. The easiest way is to use the cn attribute of the 
LDAP group node to match the Cumulus role name. 

Manual role mapping is based on rules that define which LDAP group memberships 
are mapped to a Cumulus role membership. These rules are defined using <ns:role-
mapping> elements. 

The membership conditions inside a <ns:role-mapping> element are combined by 
“and”. A user will be assigned to a role only if the user fulfils all conditions. See also the 
following example:

Exam-
ple for automatic role mapping using the cn attribute to 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – MANAGING USERS LDAP AUTHENTICATION METHOD

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

 

If you want to use “or” combinations, you simply add new <ns:role-mapping> ele-
ments for the same Cumulus role name. All role mapping elements are combined 
using “or”. A user will be assigned to a role if the user fulfils the conditions of at least 
one <ns:role-mapping> element. See also the following example:

Example for the “and“ combination: a user will be a member of the Cumulus role “Admins” only if 
the user fulfils all conditions – being a member of both of the LDAP groups “Administrators” and 
“Backup Operators” .

Example for the “or“ combination: all members of the LDAP group “Administrators” as well as
all members of LDAP group “Backup Operators” will be members of the Cumulus role “Admins”.
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Security Aspects
The LDAP.xml configuration file needs to specify a user that is able to read the LDAP 
server's information. This user only needs read access to the LDAP parts you specify in 
your LDAP.xml file (typically the users node and possibly the groups node). As you also 
need to specify this user's password in the LDAP.xml file, you need to make sure the 
file cannot be read by any unauthorized user.

The LDAP Authenticator module does not make any changes to the LDAP server. It 
only reads information from it.
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Configuring Vault

Cumulus® Vault is a version control system that gives your workgroup added data

security and up-to-the-minute information on the status of each asset. As its name

suggests, Vault enhances the security of your team’s assets – controlling who accesses

them, how and when (via check in and check out). It also gives you more ways of work-

ing with your assets in Cumulus, providing version retention and tracking, at-a-glance

version information, and integration into the existing Cumulus environment. Addition-

ally, Cumulus Vault enables Client users to access assets independent of platforms.

Another Cumulus Vault feature enables you to set up Vault exclusive catalogs. All

assets added to such a catalog are handed over to Vault and their asset storage loca-

tion is Vault exclusively. 

This chapter addresses the Administrator. It covers activating and administering the

Vault Server as well as configuring Cumulus catalogs to be controlled by Cumulus

Vault. Information on using Vault to check assets in and out as well as on managing

asset versions are provided in the chapter “Using Vault” .
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How Cumulus Vault Works
As the Cumulus Vault Administrator, it’s up to you to configure Cumulus Vault to meet 
the needs of your workgroup. But before you jump in, it’s good to get a basic idea of 
how your Cumulus catalogs interact with Vault. And if you don’t want to miss out on 
any of the technical details, you can read “Behind the Scenes” , to find out what’s going 
on in the background.

Cumulus Vault can control and monitor access to all assets. Think of it as the Cumulus 
librarian. Users check assets out for editing and check them back in again when they’re 
through. Every time an asset is checked out, Vault automatically gives the user the lat-
est version to ensure that versions remain up-to-date.

Vault allows only one user at a time to check out an asset, preventing multiple edits 
that can result in conflicting – and confusing – versions. If another user attempts to 
check the asset out, Vault informs the would-be editor which user has the file. When a 
user checks an asset back in, Vault saves the updated file as a new version without 
overwriting previous versions. It keeps all back versions, making it possible to track 
changes to an asset during the production cycle – a concept referred to as a version 
control system. It also provides information on all versions: Who made the changes? 
When? With Vault, these questions are easy to answer, making last week’s edits just as 
accessible as today’s.

Cumulus Vault consists of the Vault Server and Vault Client software.
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Vault Server
Cumulus Vault as a version control system controls and tracks the access to your 
team’s assets. Vault also provides a place to store your team’s assets, in all of their ver-
sions.

As Vault Administrator, you define where Vault keeps your workgroup’s assets by con-
figuring the Vault Server. This location can be wherever you want it to be, with one 
restriction: the physical location must be a local disk on the computer running the 
Vault Server. It’s up to you to create the folder that will actually house the assets. You 
then tell the Vault Server to store the assets in this Vault Server Storage location. You 
may even tell the Vault Server to store the assets in automatically created subfolders. 
And when setting up catalogs to work with Vault, you can create special folders inside 
the Vault Server Storage folder, so called Vault Folders. 

For information on setting up the Vault Server, see “Configuring the Vault Server” .
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Vault and Catalogs
Every Cumulus catalog can work with Cumulus Vault. For those that do, either all of its 
assets are stored in Vault – and are subject to its control – or only selected ones. 
Cumulus Vault enhances the possibilities of using a central location for a catalog. As 
the Cumulus Vault Administrator, you define for each catalog whether and how it is 
going to interact with Vault.

The first step is to prepare a catalog to work with Vault, which is done by adding spe-
cial version control fields to the catalog. The fields that belong to Cumulus Vault are 
Check out Location, Check out Date, Check out User and Version History. They 
enable Clients to check an asset out to a particular location and provide information 
describing who checked out which version when. For information on adding these 
version control fields to catalogs, see “Preparing Catalogs for Vault” .

The next step is to set up the catalog to hand over its assets to Vault whenever they 
are cataloged. You can either tell the catalog to hand over all assets, or let each user 
decide whether the assets they’re cataloging should be placed under Vault’s control. 
You then specify Vault as the central location for the catalog. (Central Location is 
Cumulus-speak for a location to which Cumulus copies assets during the cataloging 
process; e.g. a folder on your file server or an FTP server.) For information on specifying 
Vault as Central Asset Location for a catalog, see “Linking Catalogs to Vault” .

A further consideration is whether users have the permissions required to check assets 
out of and into Vault. For information on these permissions, see “User Access to Vault” .

Once assets are stored in Vault, users can retrieve them by checking them out, a pro-
cedure that locks the associated record in the catalog for other users. When an asset 
is checked back in, Cumulus moves it as a new version to Vault, and unlocks and 
updates the associated record in the catalog. Previous versions of the asset are 
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retained in Vault so that users can view their histories or access them, if they become 
useful again.
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Vault and Asset Handling Sets 
Once you decide to employ Cumulus Vault, you should adjust the Asset Handling Sets 
that your workgroup uses. At least the Asset Handling Sets must have the Asset Stor-
age module Cumulus Vault activated. And if you have set a catalog to let each user 
decide whether cataloged assets should be placed under Vault’s control or not, the 
Copy to Central Asset Location option must be activated also. In addition, Asset Han-
dling Sets include the Vault settings for version handling. For more information setting 
up Asset Handling Sets for Vault, see “Configuring Asset Handling Sets for Vault” .
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Behind the Scenes
From a technical perspective, Cumulus Vault is an Asset Storage module that interacts 
with the Cumulus application. Asset Storage modules manage the access to an asset’s 
location (where it’s stored on a file system) and provide Cumulus with information on 
the asset. In the case of Vault, this information is provided in the form of the version 
control fields (Check out Location, Check out Date, Check out User and Version His-
tory).

When you specify Vault as a Central Location, Cumulus works with the assets placed 
there only via the Vault Asset Storage module. This module enables check out, check 
in and version tracking by means of the special version control fields mentioned 
above.

When an asset is cataloged to Vault, an entire folder for the asset is created in the 
folder you specified as the Central Location for the catalog. This folder has the same 
name as the asset itself and contains two files for each asset version: one is the asset 
itself ( with the extension .data) and the other is an information file ( with the 
extension .info) containing the contents of the version control fields described above. 
Except for the file extension, each of these files has the same name: a serial number 
starting at one for the first cataloged version. Note that when assets are cataloged to 
Vault, no corresponding folder category will be automatically created under the 
Sources master category.

Every time a user checks an asset out of Vault, Cumulus copies the latest version – 
based on its serial number – to the location the user specifies. It then locks the associ-
ated record in the catalog so that no other users may check the asset out.

When the asset is checked back in, Cumulus moves the updated version back to that 
asset’s folder in Vault. It renames the latest version, raising the previous serial number 
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by one. It then re-catalogs that version to update the associated record in the catalog. 
Finally, Cumulus unlocks the record so that other users may access the asset.

Cumulus Vault Servers fully support the storing and versioning of resource forks, file 
types and file creators.
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Installation
The Vault Client software is included in the Cumulus Client software. The Vault Server 
software is included in the Cumulus Server software. 

Vault Server on Another Computer

The Vault Server does not have to be on the same computer running the Cumulus 
Server. You can decide to have the Vault Server running on a computer other than the 
Cumulus Server. The computer you select for the Vault Server will not only manage Cli-
ent access to Vault but also physically store all versions of all assets controlled by Vault, 
so it should have enough storage space available. You can also have the Vault Server 
running on a different computer, and it will still communicate seamlessly with your 
Cumulus Server. 

If you decide to have the Vault Server running on a computer other than the Cumulus 
Server, you have to install the Cumulus Server software on that computer. 

When selecting the computer for the Vault Server, keep in mind that not only will it 
store all assets – and all versions – under Vault’s control, but also that every Client will 
need continuous TCP/IP access to it for checking these assets in and out.

Whichever route you choose, this documentation refers to the installation as a Vault 
How to Make Vault Work

In order to make Vault work with your Cumulus configuration, you have to perform the 
following tasks:

• Specify the Cumulus Vault Administrator. You use the User Manager module of the 
Server Console for this. 
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• Activate Vault and configure the Vault Server meeting your requirements. You use 
the Vault module of the Server Console for this.

• Set up your Cumulus catalogs to work with Vault. Using the Catalog Settings of the 
Preferences window, you prepare the catalog by adding special version control 
record fields and linking the catalog to Vault. 

• Last but not least configure the Asset Handling Sets used by your workgroup. 
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Configuring the Vault Server
You configure the Vault Server by telling it where to store the assets that are to be con-
trolled by Cumulus Vault. Only the Cumulus Vault Administrator can configure the 
Vault Server, meaning that there has to be a user account that functions as the Vault 
Administrator.

Specifying the Cumulus Vault Administrator

To configure the Vault Server, there has to be a user account which functions as the 
Cumulus Vault Administrator. 

If the Vault Server is running on the same computer as the Cumulus Server, you can 
give any existing user the Vault Administrator permission. 

However, if the Vault Server is not on the same computer as the Cumulus Server, you 
need to specify the Vault Administrator on this computer. You may even have to set 
up a user who is given the Vault Administrator permission. 

In both cases use the User Manager module of the Server Console to do so:

1. From within the Cumulus Client, select File > Administration > Server Console, 
or connect to the Web Server Console via a Web browser

2. Log on to the computer running the Vault Server you want to administrate as 
Cumulus Administrator or the user who has the permission: User Administrator.

3. Select User Manager.
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4. Edit the user’s description who is supposed to be the Vault Administrator and 
under Server Permissions, select the Administrator Permissions to assign the 
Vault Administrator permission.

5. Click OK to save the defined properties.

In order to make it easy for the Vault Administrator user to perform all administrative 
tasks, this user should also have the following permissions for the catalogs that use 
Vault: 

• Application Permissions
Open Catalog, Create Record, Delete Asset

• Administrator Permissions
View Catalog Settings, Modify Catalog Settings, Modify Central Asset Location

Activating Vault and Specifying the Vault Storage Location

As the Vault Administrator, it’s up to you to create and specify the location of the main 
Vault folder where Vault will store the assets it controls. Where this location actually 
exists is up to you, with one restriction: it must physically be on a local disk of the com-
puter running the Vault Server.

There are a couple of things to keep in mind when creating the folder to house your 
team’s assets:

• All versions of your Vault-controlled assets from all catalogs will be housed there, 
so sufficient storage space should be available.

• You can specify a new location for the main Vault folder at any time (end of project, 
month, year, etc.), but once you do your workgroup will not be able to use 
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Cumulus Vault to access the assets stored in the previous location unless you have 
made use of a special utility that updates the asset references to the new location .

First, create this main Vault Storage folder on the computer running the Vault Server, 
and then configure the Vault Server application by telling it where this folder is. You 
can structure this main Vault Storage folder when setting up catalogs for Vault. Use 
this way to create any subfolders in the main Vault folder, only. When you create new 
folders inside the main Vault Storage folder when setting up catalogs. These folders 
are created as special folders for Vault and called Vault Folders. Such a special Vault 
Folder contains an XML file that describes it and that is necessary for certain functions, 
e.g. the exclusive assignment of a catalog to Vault as its central asset location.

Setting up the Vault Server

When setting up the Vault Server you are offered to have Vault Folders automatically 
structured when a certain number of days or assets is reached. For better performance 
we strongly recommend you to make use of the functions that automatically create 
subfolders.

To set up the Vault Server:

1. From within a Cumulus Client, select File > Administration > Server Console, or 
connect to the Web Server Console via a Web browser.

2. Log on to the Cumulus Server you want to administrate as Cumulus Administra-
tor or the user who has the permission: Vault Administrator.

The modules of the Server Console application are loaded.

3. The Server Console application is started. Log on to the computer running the 
Vault Server as a user who has Vault Administrator permission.
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4. Select Vault Server.

The Cumulus Vault Server Setup window is displayed. 

5. Under General, enable Activate Vault Server.

6. In the Vault Storage Folder field, enter the path to the folder on the Vault Server 
computer into which the assets shall be placed when cataloged.

The path you enter here refers to a location on the computer running the Vault 
Server. Make sure to observe the conventions for describing paths of the operat-
ing system where the Vault Server is installed, regardless of whether you are con-
necting from a Windows or Mac OS Client.

NOTE: Vault Server for OS X
As the Vault Server for OS X is based on UNIX technology you have to use UNIX 
path and file naming conventions for administration. 

7. Under Automatically Created Subfolders, decide on the handling of subfolders by 
selecting the desired option:

• Do Not Use Automatically Created Subfolders
All assets will be stored directly in the Vault folders. 
This option is only available while none of the subfolder options is activated. 
Once the automatic creation of subfolders is activated, there is no point of 
return. 

NOTE: If you decide on this option and later decide on using subdirectories, all 
assets stored directly in Vault folders will be moved to a special subdirectory 
called Default. This will also happen to assets stored in Vault with former ver-
sions of Cumulus Vault when you decide to use subdirectories with the current 
Cumulus Vault version. 
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• Use 
Enter the complete path of an existing subfolder or a folder to be created within 
the Vault Storage Folder (using the path naming conventions of the operating 
system where your Vault Server is installed). 
Remember, that for better performance we strongly recommend you to activate 
this option.

NOTE: If you don’t enter a name and leave the default unchanged, new cata-
loged assets are stored in the same Default folder as the assets that were auto-
matically moved there after the use of automatically created subfolders was 
activated. 

• Create a New Folder After ... Days
Enter the number of days (1 to 10,000) after which a new subfolder will be cre-
ated to house the assets to be cataloged hereafter. This number is the minimum 
number of days before a new subfolder will be automatically created. 

• Create a New Folder Upon Reaching ... Assets
Enter the maximum number of assets (1 to 10,000) a subfolder may contain 
before a new subfolder will be created to house the assets to be cataloged here-
after. (Due to Cumulus TAG files or other metadata files, the actual number 
might differ.)

NOTE: These automatically created subfolders are named after their creation 
date and time (YYYY-MM-DD_hh-mm-ss). 

8. Under Version Limitations, decide on the handling of versions. You can either 
keep all versions or limit the versions of an asset kept in Vault. If you activate the 
option Only Keep, enter the number of latest versions you want to be kept in 
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Vault. If you also want the oldest version to be kept, enable the option Addition-
ally Keep Oldest Version. 

9. Click Save Changes.

Once you have set up the Vault Server you should go on and set up your Cumulus cat-
alogs to work with Vault.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CONFIGURING VAULT IMPLEMENTING CUMULUS VAULT

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

Implementing Cumulus Vault
You implement Cumulus Vault by setting up your Cumulus catalogs to work with 
Vault. There are two things that you need to do with a catalog to subject its assets to 
Vault’s control:

• Prepare the catalog by adding the special version control record fields to all 
records of the catalog. (See “Preparing Catalogs for Vault”.)

• Link the catalog to Vault by having its assets placed there whenever they are cat-
aloged. You can either store all of a catalog’s assets in Vault, or let the users decide 
which assets are to be stored there. (See “Linking Catalogs to Vault”.)

Another consideration is user access to the assets controlled by Vault. You need to 
make sure that the desired users can work with these assets. To find out how, see “User 
Access to Vault” .

If a catalog is configured to work with Vault, you also have the option of handing over 
already cataloged assets to Vault. For more information, see “Adding Already Cata-
loged Assets to Vault” .

Configuring catalogs to work with Vault is similar to configuring catalogs in general. 
You first log on as Cumulus Administrator to the Cumulus Server, then open the 
desired catalog and specify its properties.

Opening a Catalog

The following is a brief review of opening a catalog:

1. From any Cumulus Client, select File > Connect to Server.

The Connect to Server dialog opens. 
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2. Type the name of the user who has the appropriate permissions for the catalogs 
to be set up for Vault in the Name field and the corresponding password in the 
Password field. 

3. Click OK. The Catalog Access window opens.

4. In the Catalog Access window, select the catalog(s) you would like to open and 
click Open.

Once the catalog is open, you are ready to add the record fields required to work with 
Cumulus Vault.
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Preparing Catalogs for Vault
To make a catalog work with Vault, you have to add the version control record fields 
to the catalog. These fields are:

• Check out Location – Contains encoded information on where the asset has been 
checked out to, i.e., the location to which it has been saved on the user’s file sys-
tem. You must add this field for Vault to be able to copy and track assets.

• Check out Date – Contains information on the date and time the asset was 
checked out.

• Check out User – Contains information on who checked the asset out.
• Version History – Contains information on each version of an asset, i.e., when it 

was checked out and in as well as by whom. This field is a text field and can be 
edited by the user (if allowed).

NOTE: Check out Duration
If the Check out Date field is also contained in the catalog, the Version History 
field contains information on the check out duration at the end of each entry. This 
information is only available via this field. If this information is deleted from this 
field it cannot be reconstructed. 

NOTE: Reconstructing Data
If the content of the Version History field was completely deleted, the field is 
treated as containing no value and will be filled with the information stored on 
the server upon the next checking or record update. 

The fields Check out Date and Check out User also enable catalog users to view 
whether or not an asset is currently checked out and, if so, by whom. But to view the 
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contents of these fields, they have to be added to the Record View Sets. (For informa-
tion on adding fields to a view, see “Adding a Field to a Record View” .)

To add version control fields to your catalog:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click Record Fields. This displays a list of the current record fields included in the 
catalog.

5. Click the Add Field button. This opens the dialog Add Field. 

6. Click the Modules tab.

7. Select Cumulus Application.

8. Select the field(s) you want to add. Version control fields are: Check out Location, 
Check out Date, Check out User, Version History

TIP: Using Catalog Template

Under Modules, you can use also use the Catalog Template Fields for Asset 
Version Control for adding the fields.

9. Click OK. This brings you back to the fields list to which the fields have been 
added.
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10. Click Apply to save your changes.

The catalog can now work with Vault, but there are no assets in Vault for it to work 
with. The next step is to have Cumulus place assets under Vault’s control whenever 
they are cataloged.
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Linking Catalogs to Vault
When a catalog is linked to Cumulus Vault, assets can be handed over to Vault when 
they are cataloged by any user. As the Cumulus Administrator, you link a catalog to 
Vault by telling Cumulus essentially two things.

First, you have to configure Cumulus to be able to add assets to Vault when they are 
cataloged. You do this by specifying Cumulus Vault as a central location for the cata-
log. You even have a couple of options for specifying when assets should be handed 
over to Vault:

Always 

All assets added to the catalog are handed over to Vault. Should be considered the 
default setting, because it ensures that all of the catalog’s assets are subject to 
Vault’s access and version control.

As Set in Asset Handling Set

You let each user specify (with the Asset Handling Set they employ) whether or not 
to catalog assets to Vault. Useful if only certain types of assets – as your workgroup 
defines them – need to be subject to access and version control. 

Always and Exclusive

All assets added to the catalog are handed over to Vault and their asset storage 
location is Vault exclusively. A catalog that is set to this option will have a forced 1-
to-1 relation with its Vault Folder: every record in the catalog represents an asset 
stored in the corresponding Vault Folder and each asset in this Vault Folder is rep-
resented by a record in this catalog. This is the guiding principle for all functions 
performed. For example this means that assets managed by this catalog cannot be 
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moved and that deleting the records representing them will always delete the 
assets as well. A catalog that is set to this option is called a Vault exclusive catalog.

NOTE: After the Always and Exclusive option has been activated for a catalog, all 
assets already contained in the catalog will be copied to the corresponding Vault 
Folder and their records will be updated to reflect the new asset storage location. 

Second, you have to tell Cumulus where to store the assets to be controlled by Vault, 
in effect tell Cumulus which computer in your network is running the Vault Server. You 
specify this computer by its network name or TCP/IP address. At this point, you don’t 
need to specify the actual folder on the Vault Server computer, since you already spec-
ified it when you configured the Vault Server.

To link a catalog to Vault:

1. Make sure the collection window containing the catalog is the active window in 
Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window con-
tains more than one catalog, select the catalog you want to edit under Catalogs.

4. Click General.

5. Under Copy Assets to Central Location, enable Use Central Asset Location.

6. Choose where to store the copies and which Asset Storage module you want to 
use.

The Choose an Asset Storage Module dialog opens.
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7. Select Cumulus Vault and click OK.

The Select Remote Module dialog opens.

8. Select the computer running the Vault Server from the Computer field. This is the 
computer that contains the folder you specified as the Vault location (see “Config-
uring the Vault Server” ). You can click the arrow button to the right of the field for 
a list of currently active Vault Servers in your network. 

The Choose Asset Location dialog is opened. You now have to decide whether 
you want the assets to be stored directly in the folder of the Vault Server or in a 
subfolder nested in the Vault Server folder. Such a subfolder is called a Vault 
Folder. 

9. Select the desired option. 

10. If you decided on Use Vault Server Directly, your next step is to click OK.
If you decided on Use Vault Folder, the list for selecting this folder is activated. 
Then your next step is to select the Vault Folder you want the asset to be stored 
in and click OK. 
If you want a new Vault Folder to be created for storing the assets of this catalog, 
click New Folder. A dialog for entering a name for the folder is displayed. It con-
tains the name of the catalog as default. 

NOTE: If a catalog is set exclusive for a Vault Folder this folder cannot be used as a 
central asset storage location for any other catalog. If you want a catalog to be set 
exclusive, you have to create a new Vault Folder for it. 

You return to the General section of the Catalog Settings window. The name or IP 
address of the computer running the Vault Server and the name of the Vault 
Folder are displayed.
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11. Select the mode for copying assets to the central asset storage location chosen 
above:

• Always
• As Set in Asset Handling Set
• Always and Exclusive (available with Vault only)
(For more information on the different modes, see page 1076.)

12. Click Apply to save your changes and select the next catalog you want to set up 
for Vault.
OR 
Click OK to save your changes and close the Preferences window.

When users catalog assets to this catalog from now on, the asset can be placed or will 
be placed into the folders inside the Vault Server folder you specified when you con-
figured the Vault Server.
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Configuring Asset Handling Sets for Vault
The Asset Handling Sets your workgroup users use have to be configured for Vault. 
Asset Handling Sets are important for Vault in the various aspects:

For Cataloging 

For cataloging they are important as the user must use Asset Handling Sets with the 
Asset Storage module Cumulus Vault activated for cataloging assets to be placed 
under Vault’s control. And Asset Handling Sets are very important for cataloging if you 
have set a catalog to let each user decide whether the assets they’re cataloging should 
be placed under Vault’s control or not. The user decides this by selecting an Asset Han-
dling Set. If the user employs an Asset Handling Set with the Copy to Central Asset 
Location option and the Asset Storage module Cumulus Vault activated for catalog-
ing, the cataloged assets are placed under Vault’s control.

For Asset Access

For asset access they are important, as the user must use Asset Handling Sets with the 
Asset Storage module Cumulus Vault activated for accessing assets that are stored in 
Vault. 

For Asset Version Handling

For asset version handling they are important, as they include the Vault settings for 
version handling. Since Vault controlled assets may exist in multiple versions, you may 
have to make a choice between the different versions available when you preview, 
mail, and copy assets controlled by Vault. Cumulus makes it easy for you to make this 
choice. It even enables you to pre-set your decision to best suit the way you work. This 
setup is defined in an Asset Handling Set. By selecting an Asset Handling Set, the user 
decides on the way of asset version handling. 
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See the help system of the Cumulus application for information on how to set up 
Asset Handling Sets in general. The Vault chapter of the Cumulus application help sys-
tem provides information on how to set up Asset Handling Sets for asset version han-
dling. 

With Vault we recommend you to have your Cumulus users using shared Asset Han-
dling Sets only. As these Asset Handling Sets can be centrally administered. You can 
also restrict the users’ access to certain Asset Handling Sets only. However, whichever 
way you choose, make sure that at least the Asset Handling Sets selected in the User 
Settings of your users have the Cumulus Vault module activated.

If you ever decide that you want to change the Vault Server for this catalog, you can 
return to the Catalog Settings and click Browse to specify a new computer. However, 
then you have to redirect the assets. Cumulus provides a special utility for redirecting 
Vault assets. For information on this utility, see “Redirecting Asset References” .
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User Access to Vault
Users’ access to assets controlled by Vault is catalog-specific, since they access these 
assets via Cumulus catalogs.

You have to assign those users who are to work with Vault the corresponding permis-
sions. You assign individual user permissions with the User Manager module of the 
Server Console.

If you want users to be able to check assets out, check them back in, undo a check out 
and move assets out of Vault, they have to be assigned the permissions:

• Open Catalog
• Create Records, Modify Records
• Check Out/In, Transfer Asset 
If you also want users to be able to delete records, you have to assign them the Delete 
 Item permission for records.

If you also want users to be able to delete assets – and individual asset versions – from 
Vault, you have to assign them the Delete Item permission for records and the Delete 
Asset permission. 

In Vault exclusive catalogs you can only delete a record along with its asset only. If you 
want users to be able to delete records from such catalogs you have to assign them 
the Delete Item  permission for records and the Delete Asset permission. 

For a detailed description of user permissions, see “Catalog Permissions Tab” .
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NOTE: Permissions on Records from a Vault Exclusive Catalog!
If a user has a catalog housing records that derive from a Vault exclusive catalog 
(Central Asset Location set to Always and Exclusive) the user’s permissions on 
these records are the user’s permissions given for the catalog the records derive 
from. For example: Even if a user has all permissions for catalog A her/his per-
missions for records that derive from catalog B (which is a Vault exclusive cata-
log) are the user’s permission for catalog B. 
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Administration Utilities
Cumulus provides several utilities for special Vault administration tasks:

• Managing Non-cataloged Assets Stored in Vault
• Update Folder Information
• Redirecting Asset References
The utilities can either be started via the Actions menu (when Vault Server is selected) 
or via buttons in the Vault Server Setup window.
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Managing Non-cataloged Assets Stored in Vault
Due to whatever reason, Vault may contain assets which are not cataloged. You can 
search for these and either delete them or add them to a catalog. As you can only 
search catalog for catalog, this function is most helpful when you manage all assets 
stored in Vault via one catalog.

To manage non-cataloged assets stored in Vault:

1. From within a Cumulus Client, select File > Administration > Server Console, or 
connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running the 
Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed.

4. Click the Unreferenced Assets button.

The Choose Server Connection dialog is displayed. 

5. If the catalogs you want to scan are managed by a Cumulus Server running on 
the same computer as the Vault Server you are connected to, then you can use 
the current connection and click Next. 

However, check if you are logged on to the Vault Server as a user who has the 
required permissions for the catalogs to be scanned and has access to the Asset 
Handling Sets needed for cataloging. If not, you should change the connection as 
described below. Required permissions are: Open Catalog, Create Record and 
Delete Asset.
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If the catalogs you want to scan are managed by a Cumulus Server running on a 
different computer as the Vault Server you are connected to, then you have to 
change the connection and connect to this computer.

To change the connection:

• Enable the Use Other Connection option.
• In the Server field, enter the server name or the IP address of the computer run-

ning the Cumulus Server managing the desired catalogs. 
• Enter the name and the password of a user who has the required permissions 

for the catalogs you want to scan.
• Click Connect and Next.
The Select a Catalog dialog is displayed. It lists the catalogs that are managed by 
the Cumulus Server chosen in the previous dialog and which the logged on user 
has access to. 

6. Select the catalog to be scanned and click Next.

The Select a Folder dialog is displayed. It lists the folders inside the Vault Storage 
folder. 

7. Select the folder to be matched with the catalog chosen in the previous dialog. 
The selected folder(s) will be scanned as well as its/their automatically created 
subfolders.

NOTE: If you don’t select a folder, the level of the Vault Storage folder will be 
scanned – including all automatically created subfolders but not the Vault Folders. 

8. Click Next to start the process. 

A list shows those assets that are stored in the selected folder but not contained 
in the selected catalog.
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If the list is empty, no unreferenced assets were found. Then you can either quit 
the utility by clicking Close or go back to previous steps by clicking Previous.

9. Select the desired asset(s) and

• if you want to delete the asset(s) (and all its/their versions) from Vault, click Mark 
to Be Deleted.

• if you want to add the asset(s) to the selected catalog, click Mark to Be Cata-
loged.

• if you don’t want to touch the asset, click Mark to Retain Unchanged.

TIP: Selecting Task

You can also click in the Task column to select the task to be performed on an 
asset.

The assets get marked for the task to be performed. 

10. For assets to be cataloged, you should choose an Asset Handling Set for the cata-
loging:

• Select the entry for the asset to be cataloged and click Choose Asset Handling 
Set. A list shows those Asset Handling Sets that have Cumulus Vault activated as 
Asset Storage module and that are available to the user you are logged on with.

• Choose the Asset Handling Set you want to be used for cataloging the selected 
asset.

11. When the tasks for all assets are defined and all Asset Handling Sets are chosen, 
click Start. The assets are processed as defined. A list informs you on the tasks that 
were performed.
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12. Click Close to quit the utility.

This function was designed for clearing assets which are in Vault but not cataloged. 
However, you may also use this function for cataloging assets in Vault to other cata-
logs.
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Update Folder Information
Folders set up as central asset location for catalogs are called Vault Folders. Vault Fold-
ers are located in the folder chosen as Vault Storage Folder. Each asset that is copied 
to the central asset location is copied to the selected Vault Folder. How does Cumulus 
recognize such a Vault Folder? A Vault Folder contains an XML file that holds the infor-
mation Cumulus needs. To see and update this information, Cumulus provides a util-
ity. 

To update the information on Vault folders:

1. From within a Cumulus Client, select File > Administration > Server Console, or 
connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running the 
Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed. 

4. Click the Update Folder Info button.

The Select a Folder dialog is displayed. It lists the Vault folders of the Vault Server 
you are connected to. 

5. Select the Vault Folder on which you want to see information and click Next. 

The information on the selected Vault Folder is displayed.

• Catalog Name – Name of the catalog
• Catalog Server – IP address of computer running the Cumulus Server managing 

the catalog.
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• Exclusive – If the catalog is a Vault exclusive catalog this option shows a check 
mark.

• Delete Catalog Entry – This option can be activated in order to delete the entry 
for this catalog from the Vault Folder’s information. This is useful for catalogs that 
were deleted and no longer exist.

6. If you want to delete the entry for this catalog, activate the Delete Catalog Entry 
option and click Start.

7. Click Close or Cancel to quit the utility.
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Redirecting Asset References
Asset references contain information on the server the assets are stored on; e.g. IP 
address and/or server name. Therefore they have to be updated when the server 
changes. Canto provides utilities to help make the process of updating the records 
easy and trouble-free. 

The utility will scan selected catalogs for records ’pointing’ to the former Vault location 
and then update these records to reflect the new location of the Vault assets. Without 
this utility, the records would still 'point' to the former Vault Server. The utility does not 
overwrite, move or otherwise affect asset files at all.

To update the asset references of assets kept in Vault after the Vault Server has 
changed:

1. From within a Cumulus Client, select File > Administration > Server Console, or 
connect to the Web Server Console via a Web browser.

2. The Server Console application is started. Log on to the computer running the 
Vault Server as a user who has Vault Administrator permission.

3. Select Vault Server.

The Vault Server Setup window is displayed. 

4. Click the Redirect Asset References button. 

The Choose Server Connection dialog is displayed. 

5. If the catalogs you want to scan are managed by a Cumulus Server running on 
the same computer as the Vault Server you are connected to, then you can use 
the current connection and click Next. 
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However, check if you are logged on to the Vault Server as a user who has the 
required permissions for the catalogs. If not, you should change the connection 
as described below. Required permission are: Open Catalog, Modify Record 
including Modify Asset Reference.

If the catalogs are managed by a Cumulus Server running on a different computer 
than the Vault Server you are connected to, then you have to change the connec-
tion and connect to this computer.

To change the connection:

• Enable the Use Other Connection option.
• In the Server field, enter the server name or the IP address of the computer run-

ning the Cumulus Server managing the desired catalogs. 
• Enter the name and the password of a user who has the required permissions 

for the catalogs you want to scan.
• Click Connect and Next.
The Select a Catalog dialog is displayed. It lists the catalogs that are managed by 
the Cumulus Server chosen in the previous dialog and which the logged on user 
has access to. 

6. Select the catalog(s) managing the Vault assets and click Next.

The Specify Vault Server Names dialog is displayed. 

7. In the Old Server Name to Replace field, enter the DNS name or IP address of the 
computer where your former Vault Server was installed. As default, Cumulus 
prompts the name of the first Vault Server computer which it finds in the selected 
catalog’s records.

8. In the New Server Name to Write field, enter the DNS name or IP address of the 
computer where your current Vault Server is installed.
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9. In the New Alternate Server Name to Write field, you can optionally enter the 
alternate information on the computer where your current Vault Server is 
installed – the information you did not enter in the New Server Name to Write 
field above (DNS name or IP address).

10. If you want to have the complete information that is stored in the record field 
Asset References updated, activate the Automatically Update Asset Reference 
option.

11. Click Start. The utility will search the selected catalog(s) for records that ’point’ to 
the former Vault location. Then it will check whether the corresponding assets 
exist in the new Vault location and finally will update the assets’ references. A list 
informs you which assets’ references were redirected. 

NOTE: If you cancel the function, it will be stopped but the updates of the already 
processed records are kept. 

12. Click Close to quit the utility.
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Automatic Tagging Setup

Optional feature! May not be available with your 
Cumulus configuration.

Automatic Tagging brings the power of artificial intelligence (AI) to Cumulus. With this

optional Cumulus feature, external image recognition services can be configured to

analyze your assets and, as a result, to provide a number of tags denoting the contents

of the images. These tags can be added to the metadata of the assets and used e.g. as

keywords, or as descriptions, or captions, thus making your assets more researchable.

Automatic Tagging can be evoked via a menu command, both on the Desktop Client

and on the Web Client, or via a dedicated Scheduler task. The tags received from the

tagging service will be written into the field(s) configured for this purpose.

This section describes which prerequisites must be met for using Automatic Tagging

services with Cumulus, and how to configure them via the Automatic Tagging module

of the Cumulus Server Console or Web Server Console.
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For details on how to use the Automatic Tagging feature with the Cumulus Desktop Client, see Manually

starting the Automatic Tagging.

For details on how to use the Automatic Tagging feature with the Cumulus Web Client, see the Web Client

Help, section “Manually Start the Automatic Tagging”.

For details on how to use the Automatic Tagging feature with the Cumulus Scheduler, see Using the

Scheduler to start the Automatic Tagging.
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Prerequisites
In order to make use of the Automatic Tagging feature, some prerequisites concern-
ing licensing, permissions, and catalog settings must be met.

Licensing
A respective license must be purchased, and activated via the Remote Admin module 
of the Cumulus Server Console or Web Server Console. This can be 

EITHER:

• A Cumulus Automatic Tagging OEM (one year) license,
OR:

• an Automatic Tagging license.
• Additionally, you need a valid account with one of the supported Automatic Tag-

ging providers.

Cumulus Automatic Tagging OEM vs. Automatic Tagging 
• The Cumulus Automatic Tagging is a genuine carefree package that allows to use 

a ready-configured Automatic Tagging solution out of the box – no need to worry 
about which Automatic Tagging provider to choose, or contract or licensing 
details, or configuration specifics.

• Automatic Tagging is aimed at Cumulus customers who want to choose a Auto-
matic Tagging provider of their own, or already have a contract with such a pro-
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vider. There are dedicated Automatic Tagging Connectors for the different 
providers supported by Cumulus.

Permissions
Only the Cumulus Administrator can set up the Automatic Tagging feature at the 
Cumulus Server Console or Web Server Console.

Cumulus users who want to use the Automatic Tagging feature must have the Auto-
matic Tagging User permission (Permissions > Catalog Permissions > Automatic 
Tagging Permissions).

• Automatic Tagging User – can start the automatic tagging process

Catalog-related Prerequisites
Automatic Tagging Specific Record Fields

Before using the Cumulus Automatic Tagging feature, make sure that the Automatic 
Tagging specific fields (provided in the Fields for Automatic Tagging catalog tem-
plate) are added to each affected catalog! For details on how to add fields to a catalog, 
see Adding Fields.

The Automatic Tagging feature needs the following fields:
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• Automatic Tagging Log – table field into which messages related to the Auto-
matic Tagging process are written. Which messages are included depends on the 
specified logging level (see below)

• Automatic Tagging Request – string list field with two possible values, Analyze 
and Review. This field is required if the Automatic Tagging process is to be started 
via the Cumulus Scheduler

Scheduler Task 

If the Automatic Tagging process is to be started via the Cumulus Scheduler, a Sched-
uler task with the Cumulus Scheduler action Automatic Tagging must be set up, 
specifying the catalogs on which the action shall be performed, and its frequency in 
time (Repeat interval or Cron Notation). 

NOTE: Depending, among others, on the number of assets to be tagged and 
the speed of your Internet connection, the tagging process may take same 
time. It should only be restarted after it is properly terminated. Also, running the 
Automatic Tagging may generate expenses. Therefore it is crucial to choose a 
reasonable repeat interval.

For details on how to set up a Scheduler task, see Setting Up a Scheduler Task.

Other Prerequisites
To make use of the Automatic Tagging feature, it must be ensured that the service 
URL(s) of the configured Automatic Tagging providers can be reached from any 
machine on which the Automatic Tagging is evoked. These are the machines on 
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which the Cumulus Clients run, the machine on which the Cumulus Web Solutions 
run, and the machine on which the Cumulus Server runs. 

For the initial configuration, the URLs in question are

• https://vision-api.eyeem.com 
• https://api.clarifai.com. 
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Setting up Automatic Tagging
The Automatic Tagging module of the Cumulus Server Console or Web Server Con-
sole is available if either a Cumulus Automatic Tagging OEM license, or an Automatic 
Tagging license, is activated via the Remote Admin module of the Cumulus (Web) 
Server Console.

The Automatic Tagging module looks different depending on whether a Cumulus 
Automatic Tagging OEM license is activated, or an Automatic Tagging license.

In both cases, the set up includes the configuration of the fields into which the tags 
will be written, the fill mode, the log level, the user’s credentials, and the specification 
of the probability threshold. The Automatic Tagging set up additionally requires the 
selection of a default tagging provider.

Automatic Tagging only works with fields of type string, multi-select string list, multi-
select vocabulary, and with the Categories field (under $Keywords master category). 

NOTE: For multi-select string list fields, multi-select vocabulary fields, and the 
Categories field only such tags are accepted that correspond to values that 
already exist in the catalog. For example, if the tagging service returns the tag 
“urban” for an image, this asset would be assigned to an already existing cate-
gory “urban” (under $Keywords master category). However, if such a category 
does not exist, this tag would be ignored.
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Configuration Settings for the Cumulus 
Automatic Tagging OEM

The Automatic Tagging module of the Cumulus Server Console or Web Server Con-
sole provides two panes, General and Automatic Tagging Providers.

Modifications to the configuration settings must be explicitly saved in order to take 
effect.

General 

The General pane provides the following items:

• Fields – table that lists the fields into which the tags found by Cumulus Automatic 
Tagging OEM are written, and the fill mode for each field. You can add more fields 
from your catalog(s), you can remove fields from the list, and you can edit the fill 
mode for each field.
For string fields, the following fill modes are available:

• Replace
• Set if Empty
• Insert After
• Insert Before
For multi-select string list fields, multi-select vocabulary fields, and the Categories 
field, the following fill modes are available:

• Replace
• Set if Empty
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• Add
• Logging Level – list to select the level of messages that shall be logged. Possible 

levels are
• Error
• Warning
• Information

Cumulus 

The Cumulus pane provides fields for the login credentials that must be entered. Addi-
tionally, a probability threshold value can be set. 

• ClientID – account credential)
• Client Secret – account credential 
• Probability Threshold [%] –Cumulus Automatic Tagging calculates the probabil-

ity of the tags they find. The less this value is set to, the more tags are found, but 
the less is their potential accuracy. The default value of 80% is a good starting point 
to find the most suitable value.

NOTE: After adding a the Cumulus Automatic Tagging to your Cumulus sys-
tem, the Cumulus Scheduler must be restarted in order to make the Automatic 
Tagging Scheduler action available. 
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Configuration Settings for Automatic Tagging
The Automatic Tagging module of the Cumulus Server Console or Web Server Con-
sole provides two panes, General and Automatic Tagging Providers.

Modifications to the configuration settings must be explicitly saved in order to take 
effect.

General 

The General pane provides the following items:

• Fields – table that lists the fields into which the tags found by the tagging provider 
are written, and the fill mode for each field. You can add more fields from your cat-
alog(s), you can remove fields from the list, and you can edit the fill mode for each 
field.
For string fields, the following fill modes are available:

• Replace
• Set if Empty
• Insert After
• Insert Before
For multi-select string list fields, multi-select vocabulary fields, and the Categories 
field, the following fill modes are available:

• Replace
• Set if Empty
• Add
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• Logging Level – list to select the level of messages that shall be logged. Possible 
levels are
• Error
• Warning
• Information

• Provider for Automatic Tagging – your Automatic Tagging provider of choice, 
selected from the drop-down list of available providers.

Automatic Tagging Providers 

The Automatic Tagging Providers pane provides several tabs, one for each provider 
supported by Cumulus. The login credentials required by a provider – ClientID and Cli-
ent Secret, or API Key – must be entered. Additionally, a probability threshold value 
can be set. For details about the required credentials and other provider-specific infor-
mation, refer to the documentation of the respective Automatic Tagging provider.

• API Key – account credential (depending on the selected provider)
• ClientID – account credential (depending on the selected provider)
• Client Secret – account credential (depending on the selected provider)
• Probability Threshold [%] – Automatic Tagging services calculate the probability 

of the tags they find. The less this value is set to, the more tags are found, but the 
less is their potential accuracy. The default value of 80% is a good starting point to 
find the most suitable value.

• Model – Select a (custom) model to be used for tagging (depending on the 
selected provider). 
Note that the language selection below only works with the standard model 
(“General”), and is deactivated if any other model is selected. 
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• Languages – languages for Automatic Tagging (depending on the selected pro-
vider). The Automatic Tagging is performed in the configured language. If multiple 
languages are configured, all selected languages are processed in parallel. If no 
language is configured, English is used as the fall back language
For Automatic Tagging working properly with multiple languages, the target 
metadata field must be set to multi-lingual. Otherwise, only the first of the config-
ured languages would be taken into account.

NOTE: After adding a new Automatic Tagging provider to your Cumulus sys-
tem, the Cumulus Scheduler must be restarted in order to make the Automatic 
Tagging Scheduler action available to the newly added service. 
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Video Cloud Setup

In order to provide better worldwide distribution and availability for videos, Cumulus

can be enhanced with a Video Cloud option. Cataloged videos can then be uploaded

and published to a dedicated Video Cloud provider which is responsible for delivering

the video to websites, including Cumulus Portals and the Web Client. This grants a

smooth user experience to customers and viewers while simultaneously the load on

the Cumulus Server is significantly relieved. 

This section describes which prerequisites must be met for using a Video Cloud with

Cumulus, and how to configure the Video Cloud settings via the Video Cloud module

of the (Web) Server Console.

For details on how to work with the Video Cloud feature, see Working with the Video

Cloud.
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Prerequisites
In order to make use of the Video Cloud feature, some prerequisites concerning licens-
ing, permissions, and catalog settings must be met.

Licensing
A respective license is must be purchased, and activated via the Remote Admin mod-
ule of the Cumulus (Web) Server Console. This can be 

EITHER:

• A Cumulus Video Cloud license,
OR:

• a Video Cloud Connectors license. Additionally,
• a valid account with one of the supported Video Cloud provider must exist.

The credentials required by the provider must be entered on the Settings tab of 
the Video Cloud module of the (Web) Server Console. (For details, see Setting up 
the Video Cloud.)

Cumulus Video Cloud vs. Video Cloud Connectors
• The Cumulus Video Cloud is a genuine carefree package that allows to use a 

ready-configured Video Cloud solution out of the box – no need to worry about 
which Video Cloud provider to choose, or contract or licensing details, or configu-
ration specifics.
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• Video Cloud Connectors are aimed at Cumulus customers who want to choose a 
Video Cloud provider of their own, or already have a contract with such a provider. 
A Video Cloud Connector permits to integrate the capabilities of a Video Cloud 
provider into Cumulus. There are dedicated Video Cloud Connectors for the differ-
ent providers supported by Cumulus.

Permissions
Cumulus users who want to use the Video Cloud feature (i.e. uploading and publish-
ing videos, making use of video links and embed codes) must have special Video 
Cloud Catalog Permissions.

Cumulus provides three Video Cloud specific Catalog Permissions (Permissions > Cat-
alog Permissions > Video Cloud Permissions).

• Video Cloud Consumer – can view and make use of video links and embed codes
• Video Cloud Contributor – can (additionally) alter the embed code with different 

player skins, can make use of derivatives, can view some video-related statistics 
data, and can control the availability period (from - to)

• Video Cloud Administrator – can (additionally) manage video files on the Video 
Cloud service (upload to/remove from Video Cloud, publish/un-publish), can 
access the Video Cloud module of the (Web) Server Console, and can see the 
upload queue.
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Catalog-related Prerequisites
Video Cloud Specific Record Fields

The Cumulus Video Cloud feature can be used only with catalogs that contain some 
Video Cloud specific fields. These fields are provided in the catalog template for Video 
Cloud and can be added to any existing catalog from there.

For details on how to add fields to a catalog, see Adding Fields

Scheduler Task

Cumulus provides a Video Cloud Scheduler action that reads the content of certain 
Video Cloud related record fields and initiates respective actions (upload to / remove 
from Video Cloud, publish/un-publish). A Scheduler task with this scheduler action 
must be set up, specifying the catalogs on which the action shall be performed, and 
its frequency in time. 

NOTE: When a Cumulus Video Cloud license or Video Cloud connectors 
License is added to your Cumulus system, the Cumulus Scheduler must be 
restarted in order to make the Video Cloud Scheduler action available.

For details on how to set up a Scheduler task, see Setting Up a Scheduler Task.

Trigger

Cumulus provides a Video Cloud trigger action that communicates modified values in 
the Video valid from and Video valid to record fields to the Video Cloud service – but 
only if the respective video is published (Video Cloud State = Published). Thus, the 
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availability period of published videos can be easily modified. Furthermore, this trigger 
action can initiate the removal of a video from the Video Cloud after it has been 
deleted from Cumulus.

Canto recommends to set up the following catalog triggers with the Video Cloud trig-
ger action:

• A field specific trigger that is fired when the Video valid from is modified.
• A field specific trigger that is fired when the Video valid to field is modified.
• A field specific trigger that is fired when the Video Cloud Asset Modification Date 

field is modified.
• A trigger that is fired when an uploaded video is deleted from the catalog.
• Additional field specific triggers must be specified, if field mapping is configured, 

in order to sync changed field values to the Video Cloud service.
For details on how to set up triggers, see Setting Up Triggers for Catalogs.
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Setting up the Video Cloud
The Video Cloud module of the Cumulus (Web) Server Console is available if either a 
Cumulus Video Cloud license, or a Video Cloud Connectors license, is activated via the 
Remote Admin module of the Cumulus (Web) Server Console.

The Video Cloud module looks different depending on whether a Cumulus Video 
Cloud license is activated, or a Video Cloud Connectors license

To work with the Video Cloud module, a user must have the Video Cloud Administra-
tor permissions (Permissions > Catalog Permissions > Video Cloud Permissions).

Configuration Settings for the Cumulus Video 
Cloud

There is not much to configure with the carefree Cumulus Video Cloud solution, just 
the account credentials must be entered.

Modifications to the configuration settings must be explicitly saved in order to take 
effect.

The Settings Tab

The Settings tab provides the following items:

• Logging Level – Drop down list to select the level of error messages that shall be 
logged. Possible levels are Error, Warning, and Information.
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• Account credentials, such as User Name and Password, for the Cumulus Video 
Cloud.

NOTE: Depending on your geographic location, different Video Cloud providers 
may be involved in providing the Cumulus Video Cloud. Therefore, different 
account credentials may be displayed, according to the conditions of the actual 
Video Cloud provider.

• Import player skins into catalogs... button to import the player skins available 
with the Cumulus Video Cloud into Cumulus catalogs. 
A player skin is required and must be specified in the metadata of each video 
uploaded to the Cumulus Video Cloud. Without a specified player skin, uploaded 
videos can’t be streamed from the Video Cloud in Cumulus Portals or Cumulus 
Web Client 

The Queue Tab

This tab contains a table of currently pending or unfinished upload task, if any.  
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Configuration Settings for Video Cloud 
Connectors

With an activated Video Cloud Connectors License, all available connectors are dis-
played. Select the connector to the Video Cloud provider of your choice (the one that 
hosts your account) end enter the required credentials. 

At any given time, only one connector (the connector to the configured default pro-
vider, see below) is supported.

Modifications to the configuration settings must be explicitly saved in order to take 
effect.

The Settings Tab

The Settings tab provides two panes, General and Video Cloud Providers.

General

The General pane provides the following items:

• Logging Level – Drop down list to select the level of error messages that shall be 
logged. Possible levels are Error, Warning, and Information. 

• Default provider for video uploads – Drop down list to select the provider that 
will host all newly uploaded videos. The currently active provider must be selected. 
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Video Cloud Providers
This pane provides one tab for every available Video Cloud provider. The login creden-
tials required by a provider must be entered; additional information may be displayed 
or required. For details, refer to the documentation of the respective Video Cloud pro-
vider.

Some providers support the mapping of Cumulus fields to their own metadata fields. 

Currently, the following Video Cloud providers are supported:

• Brightcove 

Brightcove requires the following information:

• Account ID

• Client ID

• Client Secret

The Import player skins into catalogs... button allows to import the player skins 
available from Brightcove into Cumulus catalogs.

A player skin is required and must be specified in the metadata of each video 
uploaded to Brightcove. Without a specified player skin, uploaded videos can’t be 
streamed from the Video Cloud in Cumulus Portals or Cumulus Web Client 

• Kaltura
Kaltura requires the following credentials:

• Partner ID
• Sub Partner ID
• Administrator ID
• Administrator Secret
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• Service Endpoint
• Conversion Profile
• Field Mapping (see below)
• Player Code URL
The Import player skins into catalogs... button allows to import the player skins 
available from Kaltura into Cumulus catalogs.

A player skin is required and must be specified in the metadata of each video 
uploaded to Kaltura. Without a specified player skin, uploaded videos can’t be 
streamed from the Video Cloud in Cumulus Portals or Cumulus Web Client 

The Update Conversion Profiles list button allows to import list of conversion pro-
files available at Kaltura.

Field Mapping: Use this table to configure the mapping of Cumulus fields to 
Kaltura fields. All fields listed in this table will be mapped. Fields can be added to 
the list via the Add button. 

Cumulus fields can be mapped to standard Kaltura fields (such as creatorID, userID, 
and description), or to custom fields defined at Kaltura.

At Kaltura, custom fields are contained in so called Metadata Profiles. There can be 
a multitude of such profiles, each of which can contain many custom fields. When 
setting up the Field Mapping, you first select the Cumulus field you want to map, 
then the Metadata Profile that contains the target field, then the target field itself.

Mapping itself is initially performed during the upload of a video to Kaltura. Field 
values modified in Cumulus can be synced to Kaltura anytime by means of a Video 
Coud trigger action (see Trigger). (Exception: the Kaltura standard field creatorID is 
set once during the upload, and can not be changed later.)
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• movingimage
requires the following credentials:

• User Name
• Password
• Field Mapping (see below)
The Import player skins into catalogs... button allows to import the player skins 
available from movingimage into Cumulus catalogs

A player skin is required and must be specified in the metadata of each video 
uploaded to movingimage. Without a specified player skin, uploaded videos can’t 
be streamed from the Video Cloud in Cumulus Portals or Cumulus Web Client 

Field Mapping: Use this table to configure the mapping of Cumulus fields to 
movingimage VideoManagerPro fields. All fields listed in this table will be mapped. 
Fields can be added to the list via the Add button. 

Cumulus fields can be mapped to standard movingimage fields (such as Descrip-
tion, Video Title, Keywords), or to custom fields defined at movingimage. When 
setting up the Field Mapping, you first select the Cumulus field you want to map, 
then the target field. However, only the movingimage standard fields are dis-
played and can be selected in the Add Field dialog. To set a custom field as target, 
you must enter its name manually in the Add Field dialog.

Field mapping is initially performed during the upload of a video to movingimage. 
Field values modified in Cumulus can be synced to movingimage anytime by 
means of a Video Cloud trigger action (see Trigger).

• Screen9
requires the following credentials:

• Account ID
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• Access Token

• Wistia
requires the following credentials:

• Master Token
• Default Project to Upload to
The Import Player projects into catalogs... button allows to import the Wistia 
projects into Cumulus catalogs. – On the first import of such projects, a corre-
sponding record field “Wistia projects” is added to the affected catalogs.

The Queue Tab

This tab contains a table of currently pending or unfinished upload task, if any.  
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Media Delivery Cloud
Setup

In order to provide worldwide distribution and availability for assets, Cumulus can be

enhanced with theMedia Delivery Cloud (MDC) option. Various renditions of cataloged

assets can then be provided through a Content Delivery Network (CDN) based on

Amazon Web Services.

For more details on how to work with the Cumulus Media Delivery Cloud, see Using the

Media Delivery Cloud.

For setting up Media Delivery on Premise (MDO) – i.e. in-house media delivery without

the benefits of CDN –, see The Media Delivery Tab.
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Setting up the Media Delivery Cloud
The Media Delivery Cloud module is only available if a Media Delivery Cloud license is 
activated via the Remote Admin module of the Cumulus (Web) Server Console. This 
section describes how to configure the Media Delivery Cloud option via the Media 
Delivery Cloud module.

PRECONDITIONS: 

• You need to be logged in as the Cumulus Administrator to work with the Media 
Delivery Cloud module.

• A Media Delivery Cloud license must be purchased and activated via the Remote 
Admin module of the Cumulus (Web) Server Console. 

The Media Delivery Cloud is configured as follows:

Configuration

Basic Media Delivery Cloud settings are configured here.

• Customer ID – Amazon S3 account identifier. Customers may use an already exist-
ing account of their own, or an account provided by Canto. 

• Endpoint URL – Provided by Canto.
• Password – The password belonging to the customer’s AWS Customer ID. 

Required to ensure that only authorized users can upload files to the Media Deliv-
ery Cloud (including e.g. watermark images)

• Master Image Asset Action – A table with the Asset Actions that will generate 
master images. You can add more Asset Actions (from the Asset Actions available 
at the Cumulus Server), remove Asset Actions from the list, and define the order in 
which they will be performed, using the appropriate buttons.
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If there are multiple Asset Actions listed, they will be performed in the given order. 
However, as soon as an Asset Action generates a result, the rest of the Asset 
Actions in the list is ignored. This behavior can be used to easily generate master 
images from different asset types, e.g. images or videos, that require different asset 
actions to generate them.

• Generate asset download names from field value – In order to make MDC-deliv-
ered assets more SEO-friendly, and to provide downloads like PDF-brochures with 
a speaking name, the value of a metadata field is added to the generated URLs.
• Field for asset download name – The field who’s value is added the URL. Use 

the ... button to select a field. Only fields of type “string” are available.
• Fallback fields – If there is no field configured, or the configured field has no 

value, the Record Name will be added to the URL. In the unlikely case that this 
field has no value, too, the Asset Name is used. If even this field has no value, 
nothing is added to the asset URL.

The added string is shortened to 500 characters to make a reasonable URL size.

Typically the record or asset name contains a file name extension, separated by a 
period character. If the string to be added does not contain any period character 
Cumulus tries to determine the correct file name extension based on the “File For-
mat Identifier” field.

• Image ID of fallback image – The Media Delivery Cloud Image ID of the image that 
shall be displayed if a published image is no longer available on the MDC.
Any image published to the MDC can serve as fallback image. To use an image as 
fallback, you copy it’s Media Delivery Cloud Image ID field value into this field.

Note that fallback images can be provided for delivered renditions only, not for 
original assets. Also keep in mind that every operation that is applied to generate 
a rendition (e.g. crop, resize) is also applied to the fallback image!
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Watermarks

A watermark can be applied to any asset or asset rendition that is distributed via the 
Media Delivery Cloud. 

You can upload multiple files that can be used as watermarks.

• Watermark images – List of uploaded images that are available to be used as 
watermarks. You can add more images from your hard drive or network environ-
ment, replace existing watermark images, or remove them entirely vie the respec-
tive buttons.
If you replace a watermark image (via the Edit button), the ID stays the same as 
before. In other words, existing watermarks will be updated to the new image. 

NOTE: Only image files can be used for watermarking. Before an image is actually 
uploaded, it is converted to PNG and downscaled to the configured size of the 
master image.
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Configuring Workflows

Cumulus provides different workflow support functions – status-based workflows or

Action type based workflows. For details on Action type based workflows, see “Work-

flow Automation with Cumulus”. The following sections deal with status-based work-

flows:

• Overview – Gives an overview on Cumulus status-based workflows.

• Workflow Manager – Describes the necessary steps to configure workflows in the

Workflow Manager of the Cumulus Server Console or Web Server Console.

http://www.canto.com/cumulus


CUMULUS – CONFIGURING WORKFLOWS OVERVIEW

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Overview
Cumulus offers status-based, asset-centric workflows, i.e. workflows that are always 
attached to individual assets (but not, for example, to collections). 

A workflow defines a bunch of states an assets can be in, and the activities that lead 
from one state to the next one.

Workflow states can be freely defined, such as Pending, In progress, To be approved, 
Done, etc.

Any workflow state can offer a toolbox with multiple functions that can be applied to 
an asset immediately from within the workflow view, e.g. Add to Basket, Download, 
Print, Relate, Share, among others. Whether functions are available in a state, an which 
ones, depends on administrative settings.

Workflow activities lead from one state to another state, or, if it is a starting activity, 
attach an asset to a workflow. With an activity you define 

• the following state (and thus, ultimately, the sequence of the states within a work-
flow),

• preconditions that must be met for the activity to be applicable,
• users/roles that are allowed to perform the activity (and thus to promote the work-

flow to the next state).
• the user/role the asset is assigned to in the following state,
• asset actions that are to be applied to the assets during the transition,
As a Cumulus Administrator, you create and edit your own workflows in the Workflow 
Manager module of the Cumulus Server Console or Web Server Console. 

In order to be usable, a workflow created within the Workflow Manager must be 
applied to a catalog. Only workflows applied to a catalog can be attached to assets. 
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Applying a workflow to a catalog via the Catalog Setting module of the Preferences 
dialog copies the respective settings to the catalog. For each workflow, 3 fields are 
added to the catalog: [workflow name] - Workflow Activities, [workflow name] - Work-
flow Assignments, and [workflow name] - Workflow State.

As soon as a workflow is assigned to a catalog, it is available to Cumulus users.

Assigning a workflow to a catalog is performed with the preferences dialog of the 
Cumulus Desktop Client. For details, see Catalog Settings / Workflows Tab.

NOTE: Workflows that are applied to a catalog reside there independent of the 
original definition stored in the Workflow Manager. Thus, editing a given work-
flow definition in the Workflow Manager does not affect the actual workflow in 
any catalog. To make modifications to a workflow effective, you must 
explitcitely update the workflow assigned to the catalog to the new definition.

Furthermore, workflows can be attached to new assets during the cataloging process 
via an action handling set. For details, see Asset Handling Sets / Workflows Tab
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Workflow Manager
The following sections describe how workflows are configured via the Workflow Man-
ger of the Cumulus Server Console or Web Server Console.

PRECONDITIONS: To configure workflows, you must have the appropriate permis-
sions (Permissions > Server Permissions >Administrator Permissions > Workflow 
Administrator).

The Workflow Manger displays a list of all defined workflow. You can create new work-
flows or edit and remove existing ones. For editing the definition of new or existing 
workflows, the Configure Workflow [workflow name] pane is displayed.

NOTE: Creating/modifying workflows
If workflows are created or edited with the Workflow Manger, they are not 
immediately available for usage. 
To use a workflow, it must be assigned to each catalog you want it to use with. 
Likewise, if you have modified the definition of a workflow, you must 
explitcitely update this workflow for every catalog to which it is assigned in 
order to make the modifications effective.
For details on how to assign workflows to catalogs, and how to update modi-
fied workflow definitions, via the Catalog Settings pane of the Preferences dia-
log, see Workflows Tab.

The Configure Workflow [workflow name] pane contains the following tabs:
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The General Tab

This tab contains general information on the workflow. Use this tab to define:

• Name – The name of the workflow. Required Value!
• Description – short description of the workflow, providing helpful hints to the 

users (optional).

The States Tab

This tab contains a table of all states defined for the current workflow. Use this tab to 
add new states and to edit or remove existing ones.

States are always displayed in alphabetical order. Their sequence in the actual work-
flow is defined with the activities.

A state consists of a name and a description (optional). Additionally, you can specify 
which functions shall be available to assignees directly from within a state. Click Cre-
ate to define a new state, or click Edit to modify name, description and/or available 
functions for an existing state. Clicking Create or Edit opens the Configure Work State 
dialog.

The Configure Workflow State dialog

The Configure Workflow States dialog defines a state:

• Name – The name of the state. Required Value!
• Description – short description of the state, providing helpful hints to the users 

(optional).
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• Available Functions – functions that are available in a toolbox in the workflow 
state and can be applied to assets immediately. Click Add to get a list of functions 
that can be added to the toolbox.
It is recommended to choose only such functions that make sense within the cur-
rent workflow state.

The Activities Tab

This tab contains a table of all activities defined for the current workflow. Use this tab 
to add new activities and edit or remove existing ones.

For each activity, the table displays 

• its name and description
• the source state (activity can only be performed if the asset is in one of the avail-

able source state)
• the target states (the state the asset is promoted to by the activity)
• a radio button to make the activity to the starting activity, i.e. the activity which 

attaches the asset to the workflow. Every workflow must have a starting activity.
Click Create to add a new activity, or click Edit to modify an existing activity. Clicking 
Create or Edit opens the Configure Workflow Activity dialog.

The Configure Workflow Activity dialog

The Configure Workflow Activity dialog provides the following tabs:

The General Tab

This tab defines general information on the activity.

• Name – The name of the activity. Required Value!
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• Description – short description of the activity, providing helpful hints to the users 
(optional).

• Source States – one or more states in which the activity is applicable.
• Target State – the state the asset is promoted to by the activity.

The Pre-conditions Tab

This tab defines conditions that must be met for the activity to be applicable. 

• Enable activity only for record matching – if activated, you can select a query to 
filter the assets to which the activity is applicable. Any query saved at the Desktop 
Client can be selected, however, make sure to select a query that does not contain 
placeholders!

• Restrict activity to – if activated, you can select users/roles which are allowed to 
perform the activity (and implicitly, to promote an asset to the respective target 
state).

The Assignments Tab

This tab defines to which users/roles the asset is assigned in the target state. The fol-
lowing assignments are possible:

• Do not change assignment is – the asset remain assigned to the same user/role 
as in the source state.

• Clear assignment – the asset will no longer be assigned to a user/role in the target 
state (select this option only for the last state of the workflow!)

• Assign to user invoking this activity – the current user is assigned in the target 
state.

• User selects assignment – the user invoking the activity must select a user/role to 
which the asset is assigned in the target state.
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• Set assignment to – select one or several users/roles to which the asset is assigned 
in the target state. Note that it is possible to assign an asset to several users/roles.

The Actions Tab

This tab defines actions that will be performed on the asset during the transition to the 
target state. 

• Apply metadata template – if activated, you can select a metadata template that 
will be applied to the asset.

• Apply permission template – if activated, you can select a permission template 
that will be applied to the asset.

• Execute asset action – if activated, you can select one or more asset actions that 
will be performed on the asset during the transition to the target state.
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Configuring Web Client

Cumulus Web Client is the perfect tool to access Cumulus with a modern and easy-to-

use interface. Users can add files to catalogs, search for files, preview files, edit their

metadata, share them with others or download them – all via a standard Web browser. 

Appropriate access rights are granted via the Cumulus user management.

This section describes how to configure Cumulus Web Client. To gain an overview of

the key features and get explained the basic usage, see its user assistance.
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Overview
Cumulus Web Client is installed on a Web application server and communicates via 
TCP/IP with your Cumulus Server. The Web application server can be operated on the 
same machine on which the Cumulus Server is installed, or on another remote 
machine accessible by a TCP/IP connection. As with all Web server solutions, this con-
figuration requires an appropriate Internet connection if you want your external visi-
tors to have 24-hour access.

The Cumulus Web Client provides the data according to the user access rights config-
ured via the user management of your Cumulus edition – your data is secure at all 
times. 

IMPORTANT! The Cumulus Web Client represents the categories of a 
Cumulus catalog as Container. However, only such categories are displayed at 
the Cumulus Web Client which have a Container Type assigned to them. Cat-
egories without a container type are not visible at the Web Client!

This section collects the necessary steps to configure a Cumulus installation so that all 
features like versioning are enabled in the Web Client, explaining the Why? and the 
How?
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Prerequisites for Using the Cumulus Web Client
A Cumulus Server and the Cumulus Web Solutions (including Web Client, Portals, and 
the Web Server Console) must be installed and running. A Cumulus Client is also 
required for certain configuration tasks that must be performed via the client’s Prefer-
ences window.

For detailed information on how to install Cumulus, the Cumulus Web Solutions and 
the Cumulus Client, see the respective Installation Guide.

Cumulus Web Client must be installed as a part of the Cumulus Web Solutions. It must 
be configured to have access to a Cumulus Server via the Cumulus Web Client Con-
figurator (see “The Settings Tab” )

Following sections describe the required configuration tasks:

• Server Settings
• Catalogs
• Asset Handling Sets
• Users
• Web Client Configuration
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Server Settings
These basic settings must be performed via the Web Server Console, or the Cumulus 
Client’s Server Console.

Configure a base URL for Web access

Why: A base URL is required for the Send collection link feature as well as for the Send 
upload link feature to work.

How: Open the Server Console or the Web Server Console and select Remote Admin > Set-
tings > Base URLs for Web Access and add an URL. A base URL must point to a valid 
Portals installation, e.g. http://localhost:8080/portals.

See also: Configuring Web URL

Configure a mail server to be used by Cumulus

Why: This is a prerequisite for sending collection links or upload links via email from within 
Cumulus or the Cumulus Web Client.

How: Open the Server Console or the Web Server Console and select Mail Manager, then 
enter the information for the mail server that you want to use.

See also: Mail Manager

Add a versioning location 

Why: A versioning location is required if you are using the file system versioning feature. 
Without a versioning location, this feature won’t work.
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How: Open the Server Console or the Web Server Console and select File System Version-
ing, then add the Central Asset Location that is configured for the catalog to be used 
as versioning location, and configure its behavior.

See also: Configuring the File System Versioning
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Catalogs
Any catalog that shall be used with the Web Client must be prepared as follows.

These settings must be performed with the Preferences window of the Cumulus 
Client.

Enable Sharing and Web Access 

Why: If the Allow Web access option is deactivated, the catalog can’t be accessed with the 
Web Client.

How: Select Preferences > Catalog Settings > General > Sharing and activate the Sharing 
and Allow Web access options.

This must be performed individually for each catalog that shall be accessed with the 
Web Client.

See also: Overview: Catalog Settings Window

Set a Central Asset Location

Why: A Central Asset Location is required e.g. for the send upload link feature to work. 
Beyond that, it is strongly recommended to employ a Central asset location for all cat-
alogs that shall be accessed with the Web Client (e.g., because Tomcat should not 
have direct access to file server)

How: Select Preferences > Catalog Settings > General > Copy Assets to Central Location 
and configure the usage of a Central Asset Location

• As Mode, select Always. This will override whatever is specified in the Asset Han-
dling Set, if applicable.
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• If a Vault address is used as the Central Asset Location, don't forget to enable the 
Vault AssetStore in the default Asset Handling Set!

• If File System versioning is to be used, additionally, configure the Central Asset 
Location as versioning location (see “Add a versioning location” )

See also: Overview: Catalog Settings Window; Employing a Central Asset Location

Add fields for versioning information to the catalog

Why: These fields are required for the file system versioning feature to function.

How: Select Preferences > Catalog Settings > Record Fields and add the fields from the 
Fields for Versioning catalog template.

See also: Adding Fields; File System Versioning

Add fields for asset usage history information to the catalog 

Why: These fields are required to track a file’s usage history and to show information about 
recent activities on the Web Client Dashboard as well as on the file’s History tab.

How: Select Preferences > Catalog Settings > Record Fields and add the fields from the 
Fields for Tracking Usage History catalog template.

In the Asset Usage History field properties, select the Usage History Options tab and 
activate the actions that you want to track.

Additionally, you must make sure that users have the appropriate permissions on the 
Asset Usage History field (“view”) so that they can see the activities on the Dashboard.

NOTE: Currently, only the history for Check Out, Check In, Download and 
Comments are shown in the Dashboard of the Web Client
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See also: Adding Fields; Report Manager

Add fields for commenting to the catalog 

Why: These fields are required for the commenting function to work.

How: Select Preferences > Catalog Settings > Record Fields and add the fields from the 
Fields for User Commenting catalog template.

Additionally, you must make sure that users have the appropriate permissions on 
these fields.

See also Adding Fields; Subtable Permissions

Make the category field "Description" user editable

Why: A user should be able to enter or modify the description of a container/category, not 
only its name.

How: Select Preferences > Catalog Settings > Category Fields >Description > Properties. 
On the Field Values tab, activate Allow user to edit.

See also: User Generated Field Values

Enable text extraction from documents 

Why: Without text extraction, the contents of documents (e.g. PDF files or MS Word docu-
ments) can’t be searched with the Web Client.

How: To configure text extraction you have to perform several tasks:

• Add the Document Text record field to the catalog and enable it for indexing.
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• Add the Document Text field to the Asset Info Window view of the Record View 
Set that is to be used with the Web Client.

• In the Asset Handling Set that is to be used for cataloging, enable the modules for 
PDF, DOCX, etc. to have access to sub-records.

• In the Asset Handling Set that is to be used for cataloging, enable the filters for PDF 
and DOCX (i.e. Office Open XML Filter). In the Properties of each filter, activate the 
Extract Text option.

See also: Cumulus Office Document Filters
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Asset Handling Sets
Cataloging and accessing files via the Cumulus Web Client is performed according to 
the Asset Handling Sets specified for the user and the current catalog. If no Asset Han-
dling Set is specified, the default Asset Handling Sets is employed.

These settings must be performed with the Preferences window of the Cumulus 
Client.

Enlarge the size of thumbnails

Why: Large thumbnails are required for the Dashboard key visual to work properly; besides, 
they provide a better visual quality.

How: Select Preferences > Asset Handling Sets; then select the Asset Handling Set you 
want to be used by the Web Client. On the Thumbnails tab, set the size to 1024 pixel.

See also: Asset Handling Sets
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Users
These settings must be configured via the Web Server Console, or the Cumulus 
Client’s Server Console.

Configure user permissions

Why: As always with Cumulus, what a user can see and do within a catalog can be precisely 
defined by granting or revoking respective permissions. 

What • To access a Cumulus catalog via the Cumulus Web Client, a user must have at least 
the permission to open this catalog with any client.

• To download files a user must have the Download Asset permission. 
• To upload files via the Web Client, users must have the View Item, Create Item, and 

Transfer Asset permissions.
• To check out files via the Web Client, users must have th Modify Record, Transfer 

Asset and the Check-In/Out Asset permissions.
• To check in files via the Web Client, users must have the View Item, Create Item, 

Modify Item, Modify Item Asset Reference, Transfer Asset, and Asset Versioning 
permissions. 

• To be able to make full use of the comments function, users must have the View, 
Create, Modify and Delete permissions on the User Comments Thread field and its 
subtables.

• To see recent activities on the Dashboard, users must have the View permission on 
the Asset Usage History field.
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How: Permissions are set via the User Manager module of the Cumulus Server Console. 
Open the Server Console or the Web Server Console an select the User Manager mod-
ule.

See also: Simple View: Permissions; Advanced View: Permissions.
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Web Client Configuration
Behavior and appearance of the Web Client are controlled via the Web Client Config-
urator which is a Module of the Web Server Console. The configuration options 
offered by the Web Client Configurator and the handling is described in the following 
sections. This section lists the minimal/initial configuration tasks that must be per-
formed in order to use the Web Client.

To use the Web Client Configurator, open the Web Server Console and select Web Cli-
ent Configurator.

Select a Record View Set and a Category View Set to be used

What The Record View set – referred to as File View in the Cumulus Web Client – affects file 
overview pages as well as file profile pages. The Category View set – referred to as Con-
tainer View in the Cumulus Web Client – only affects container profile pages

How: On the Layout tab of the Web Client Configurator (see “The Layout Tab” ), select the 
Record View Set / Category View sets that shall be mandatory for all users of the 
Cumulus Web Client, or allow the user to change the view(s) individually. 

NOTE: Canto recommends to use View Set that are specially adapted for the 
use with the Web Client.

Keep in mind that there are certain restrictions if a View Set is used with the Web Cli-
ent:

• The number of lines setting for the display of a field (via the Properties of a field in 
a view) does not take effect with the Web Client.
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• Color settings for fields (via the Properties of a field in a view) do not take effect 
with the Web Client.

• Certain fields are always displayed in the Web Client, regardless of the settings in 
the view set.

• Layout settings in Category View Sets (colors, fonts, etc.) are ignored by the Web 
Client. 

See also: For a general description of View Sets, see: 

Record View Sets and Category View Sets.

For a description on how to create or edit Record View Sets, see: Creating and Editing 
Record View Sets.

For an overview on which view modes of a Record View Set are relevant for the Web 
Client, see: Using Record View Sets for various Cumulus Clients.

Configure available filter options

How: Select the default filter options for newly created users on the Filter tab of the Web 
Client Configurator.

See also: The Search & Filter Tab

NOTE: These filter options only take effect if new users are created from scratch. 
New users that are created by duplicating existing ones inherit the filter options 
from the parent user.

Configure available asset actions

How: Select the asset actions that are available for Web Client users with the Download 
functions on the Download tab of the Web Client Configurator 
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See also: The Download Tab
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Web Client Configurator
The following sections describe how Cumulus Web Client is configured via the various 
tabs of the Cumulus Web Client Configurator.

• The Settings Tab
• The Layout Tab
• The Search & Filter Tab
• The Download Tab
• The History Tab
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The Settings Tab
This tab contains 

• the name or the IP address of the Cumulus Server that Cumulus Web Client 
accesses;

• the user name and password of the technical user employed for the reset pass-
words feature. If no technical user is specified, the reset passwords feature is not 
available in the Web Client

• a setting for the UI language of the Cumulus Web Client

Cumulus Server

Server Address – Enter the IP address or DNS-resolvable name of the machine run-
ning the Cumulus Server in th field. Required Value!

If the Cumulus Server and the web application server of the Cumulus Web Client are 
running on the same machine, you can enter localhost instead of an IP address or 
server name.

Reset Passwords

• Admin User – Enter the user name of a technical user that can change the pas-
word of users. 

NOTE: This technical user must have Global User Administrator permissions!

• Password – Pass word of the technical user (as set in the Cumulus User Adminis-
tration).
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• Email Sender Address – The address to be displayed as From-address in the reset 
password mail sent by Cumulus.

The reset password feature is enabled as soon as a valid admin user is set. A Reset 
password link is shown on the login page of the Web Client.

To disable the reset password feature, delete either the admin user’s user name, or 
password, or both. The Reset password link is no longer displayed on the login page 
of the Web Client.

Language

An administrator can determine the UI language for the Cumulus Web Client, e.g. to 
force the use of a corporate language.

Web Client Language – Displays the selected UI language (default: According to 
browser settings, i.e. no specific language is set). Select the language you want to be 
used for the Web Client from the drop-down list.

NOTE: Selecting a specific UI language only works if the Web Client UI is localize 
into that language. Out-of-the-box, Cumulus Web Client currently supports 
English, German, French and Japanese. If you select a language that is not yet 
localized, English will be used as the fall back language – just as it is the case if 
the language is set to According to browser settings, and the browser is set to 
a language that is not available for the Web Client.
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The Layout Tab
This tab contains layout options for the Cumulus Web Client.

View Sets 

This section is for specifying the View Sets to be used with the Cumulus Web Client. 

The selected Record or Category View Set controls which metadata are displayed, and 
in which order. The Record View set – referred to as File View in the Cumulus Web Cli-
ent – affects file overview pages as well as file profile pages. The Category View set – 
referred to as Container View in the Cumulus Web Client – only affects container profile 
pages.

You can either specify a Record View Set and/or a Category View Set that is mandatory 
for all users of the Cumulus Web Client, or you can allow the user to change the view(s) 
individually.

Make sure that all Record View Sets / Category View sets are shared sets (see Creating 
and Editing Record View Sets). Also make sure that users have access to the view sets 
they are supposed to use. Users can’t log in if they are unable to access either the man-
datory view set or at least one of the view sets they are supposed to choose from.

Cumulus remembers a user’s selection of views and uses the respective View Sets the 
next time the user logs in. Only on the initial log-in of a brand new user, the standard 
view sets would be employed. 

• Record View Set – Drop-down list to select the Record View Set to be used as 
mandatory file view, or to allow users to change their file view.

• Category View Set – Drop-down list to select the Category View Set to be used as 
mandatory container view, or to allow users to change their container view.
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NOTE: Not all settings in a View set will take effect with the Web Client. For a 
short overview on possible restrictions see Select a Record View Set and a Cat-
egory View Set to be used.

Message and Footer

This section is for specifying messages the administrator wants to be displayed to 
users as well as for adding and customizing an additional footer. This footer can be 
used to display further information or navigation options. 

The custom footer is displayed in addition to the default footer on every page. The 
default footer can not be modified or deleted.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CONFIGURING WEB CLIENT WEB CLIENT CONFIGURATOR

© 2019, CANTO GMBH. ALL RIGHTS RESERVED. 

• Administrator Message – You can specify a message that is shown to logged-in 
users on every page.
• Show message – If activated, you can enter a message. This message is dis-

played as soon as you save your changes.
• Message – Enter the message to be displayed.

• Footer – You can specify a custom footer that is displayed just above the default 
footer of the Cumulus Web Client. 

Administrator 
Message

Footer 

Default Footer 
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• HTML Text – Define the footer you want to be displayed. Use standard HTML to 
design the footer’s appearance. 

NOTE: When using HTML, be carefully not to interfere with the general layout of 
the page.

Login 

This section is for specifying the layout of the login page (logo, tag line, and back-
ground image).

• Logo – Select the logo file you want to use, then upload it. Any file in either SVG, 
PNG, JPG or GIF format can be used. The ideal size for the logo on the login page 

Logo 

Tag line
Heading

Background 
image

Tag line
Sub heading
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is 130 x 130 pixels. As soon as you save your changes, the uploaded file is used as 
the new logo.
To delete a file you have uploaded and return to the default logo, click Reset to 
Default. As soon as you save your changes, the default logo file is used again.

• Background image – Select the image file that you want to use, then upload it. 
Any file in either PNG, JPG or GIF format of at least 800 x 600 pixels can be used as 
background image. As soon as you save your changes, the uploaded file is used as 
the new background image.
To delete a file you have uploaded and return to the default background image, 
click Reset to Default. As soon as you save your changes, the default background 
image file is used again.

• The Tag Line customization:
• Heading – Enter the text to be displayed as tag line heading. As soon as you save 

your changes, this text is used as tag line heading.
To return to the default tag line heading, delete any text in this field. As soon as 
you save your changes, the default heading is used again.

• Heading text color – Activate Use custom color, then define the desired color 
for the tag line heading. As soon as you save your changes, the tag line heading 
is displayed in the selected color.
To return to the default text color, deactivate Use custom color. As soon as you 
save your changes, the default text color for the tag line is used again.

• Sub heading text – Enter the text to be displayed as sub heading. As soon as 
you save your changes, this text is used as sub heading. 
The sub heading text color can’t be changed.
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To return to the default sub heading, delete any text in this field. As soon as you 
save your changes, the default sub heading text is used again.

• Tag line localization: Both heading and sub heading texts can be localized to 
other languages. Click the language button  at the right side of the 
respective field to get the Translate Heading Text or Translate Sub Heading 
Text dialog displayed. Enter your translation(s) into the respective language 
field(s) and click Save.
Note that you don’t have to literally translate your original heading or sub head-
ing text, but can enter any text that fits your needs.

Localized heading and subheading texts will be displayed in a specific language 
if the user’s browser is set to that language, or if an administrator has set the Web 
Client Language to that specific language (see Language)

Dashboard 

This section is for customizing the layout of the Dashboard (logo, welcome text, text 
color, key visual).
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• Logo – Select the file you want to use, then upload it. Any file in either SVG, PNG, 
JPG or GIF format can be used. The ideal size for the logo on the dashboard is 160 
x 43 pixels. As soon as you save your changes, the uploaded file is used as the new 
logo.
To delete a file you have uploaded and return to the default logo, click Reset to 
Default. As soon as you save your changes, the default logo file is used again.

• Welcome Text – You can customize the welcome text.
• Text – Enter the text to be displayed as welcome text. As soon as you save your 

changes, this text is used as welcome text.
To return to the default welcome text, delete any text in this field. As soon as you 
save your changes, the default welcome text is used again.

Logo 

Welcome
text

Key visual
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• Welcome text color – Activate Use custom color, then define the desired color 
for the welcome text. As soon as you save your changes, the text is displayed in 
the selected color.
To return to the default text color, deactivate Use custom color. As soon as you 
save your changes, the default text color is used again.

• Welcome text localization: The welcome text can be localized to other lan-
guages. Click the language button at the right side of the text field to get 
the Translate WelcomeText dialog displayed. Enter your translation(s) into the 
respective language field(s) and click Save.
Not that you don’t have to literally translate your original welcome text, but can 
enter any text that fits your needs.

Localized welcome texts will be displayed in a specific language if the user’s 
browser is set to that language, or if an administrator has set the Web Client Lan-
guage to that specific language (see Language)

• Key Visual
• Show random images from catalog on user’s dashboard – If activated, ran-

domly selected images (or parts of images) from the catalog are displayed in the 
Dashboard’s header to make it visually appealing (key visual). At the same time, 
the color of the Dashboard’s header is adapted to the prevailing color of the 
image. 
If deactivated, the key visual is taken from a predefined set of special images 
delivered with the Web Client. Instead of the default images, you can use an 
image of your own as key visual.

• Select the file you want to use, then upload it. Any file in either PNG, JPG or GIF 
format can be used as key visual. The ideal size for the key visual file is 1024 x 220 
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pixels. As soon as you save your changes, the uploaded file is used as the key 
visual.
To delete a file you have uploaded and return to the default key visual files, click 
Reset to Default. As soon as you save your changes, the default key visual files 
are used again.

Custom Icons

This section is for customizing the icons used for asset relation types. The Cumulus 
Web Client can display each custom relation type with its own significant icon. Use 
this section to assign icons to relation types.

• Asset Relations – Table displaying all relation types from all accessible catalogs 
and the icons currently assigned to them.
Select the row for the asset relation for which you want to change the icon, then 
select an icon file and upload it. In the Web Client, the asset relation type will be 
displayed with the new icon.

NOTE: You can only use SVG files (adjusted to a 512 x 512 stage) as icons for asset 
relation types!
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The Search & Filter Tab
This tab contains sections for the configuration of search and filter options in the 
Cumulus Web Client.

Filters

This section is for specifying filters based on record fields. these filters can be 
employed in the Cumulus Web Client to narrow down the number of displayed items.

• Configured Filters – List of filters that can be selected the Web Client. You can add 
more filters, edit existing filters, or remove filters using the according buttons 
below the list, and you can change the sequence of the filters with the according 
buttons on the right side of the list. 
If Default is activated, the respective filters are displayed in the Manage Filter sec-
tion of the Cumulus Web Client’s filter bar when a user logs in on the Cumulus 
Web Client for the first time. 

NOTE: Employing filters influences the performance. The more filters are 
employed, the more load for the Cumulus Server.

Searches

This section is for specifying searches that are displayed in the main menu of the Web 
Client.

• Predefined Searches – list of specified searches. Each search consists of an icon, a 
name, a description (optional) and a query (a query is a combination of search cri-
teria and logical operators). You can add more searches, edit existing searches, or 
remove searches using the according buttons below the list, and you can change 
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the sequence of the searches with the according buttons on the right side of the 
list. 

To add a search:

1. Click Add.
The Define Search window is displayed.

2. Enter a name and (optionally) a description for the new search.

3. Select an icon for the search.

4. Enter a query that defines the search.

• Note that queries for filters must be created individually. 
It is not possible to use previously saved queries! The most convenient way to 
create a query is to compose it in the Cumulus Desktop Client’s Find window in 
Advanced Mode, then to copy it into the Query field. (For more information on 
how to compose queries, see the chapter Searching with the Find Window.)

5. If desired, restrict the availability of the defined searches to selected users (or 
roles, if any) by activating the respective option. Click the Add User or Add Role 
button, then search for and select the user(s) or role(s) to which the search shall 
be available,

6. Click Save.

The Define Search window is closed.
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NOTE: Names and descriptions of filters and can be easily adapted to a multi-
tude of languages via the  button in the respective windows. Clicking 
this button opens a window for entering translations of the name and descrip-
tion.
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Customized Search

This section is for specifying the search criteria that are available in the customized 
search area of the Web Client.

Only if at least one search criterion is defined here, the customized search button is 
displayed in the Web Client’s header. This button opens the customized search area.

With the customized search, users can search for files only, not for containers.

• Configured customized search criteria – list of criteria that are available as search 
fields in the Web Client’s customized search. You can add more criteria, and edit or 
remove existing ones using the according buttons below the list. And you can 
change the order of the criteria with the according buttons on the right side of the 
list.

NOTE: Users can select one or more search criteria to perform a customized 
search. If multiple search criteria are selected, they will be combined with AND.

There are two types of search criteria:

• Search criteria based on a single record field. In the Web Client, a field-base crite-
rion is displayed if t the respective field is contained in the currently open catalog. 
Users then can select the search criterion and enter a term to be searched for (e.g. 
a string, or a date), or can select en entry from a list of predefined field values (e.g. 
rating stars).

NOTE: Using a search criterion in the customized search always performs an IS-
search!

• Search criteria based on predefined queries. Such queries can be quite complex. 
They can span multiple record fields and can contain operators such as AND, OR, 
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CONTAINS, etc. Any query-based search criterion can contain multiple queries. 
They are presented to the Web Client user as a drop-down list.

NOTE: With the customized search, it is not possible to use queries with place-
holders!

Adding New Criteria to the Customized Search

To add a new criterion:

1. Click Add.
The Configure customized search criterion window is displayed

2. Enter a name for the new criterion in the Name field. Additionally, you can enter a 
descriptive text into the Description field. The search criterion will be displayed 
under that name in the customized search area of the Web Client. The description 
will be displayed as a tooltip.

The following steps depend on the type of the new criterion:

• For a field based criterion, continue with step 3. 
• For a query based criterion, continue with step 6.

3. For a field based criterion, select the Field based option and click the browse but-
ton ( ).
The Select field window is displayed.
This window displays all fields from all catalogs available at the server. Addition-
ally, the Source catalogs – the catalog(s) that contain the currently selected field 
– are displayed. This information can be helpful in order to select the proper field. 
For example, standard fields always have the same internal ID and are therefore 
listed only once, even if they exist in various catalogs. Custom fields, however – 
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even if they have the same name – usually have different IDs in different catalogs 
and are therefore listed multiple times, once for each different ID

4. Select the field you want to use, then click OK.
The Select field window is closed. The name of the selected field is displayed

5. Click OK to finalize the configuration of the new search criterion.
The Configure customized search criterion window is closed, the newly defined 
search criterion is displayed in the Configured customized search criteria list.

6. For a query-based criterion, activate the Query based option. 

7. Add the queries you want to make use of to the Queries list: 

• Click Add.
The Configure query window is displayed

• Enter a name, a description (optional) and the query definition.
The query will be displayed under that name in the drop-down list belonging to 
the search criterion. The description will be displayed as a tooltip
Note that such queries must be created individually.
It is not possible to use previously saved queries! The most convenient way to 
create a query is to compose it in the Cumulus Desktop Client’s Find window in 
Advanced Mode, then to copy it into the Query field of the Configure query 
window. (For more information on how to compose queries, see the chapter 
Searching with the Find Window.)

• Click OK.
The Configure query window is closed, the query is displayed in the Queries list.

8. Add (or edit) more queries, if necessary.
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9. Click OK to finalize the definition of the new search criterion.
The Configure customized search criterion window is closed, the newly defined 
search criterion is displayed in the Configured customized search criteria list.

NOTE: Names and descriptions of search criteria and queries can be easily 
adapted to a multitude of languages via the  button in the respective 
windows. Clicking this button opens a window for entering translations of the 
name and description.
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The Download Tab
This tab contains a section to select Asset Actions available when items are down-
loaded from the Cumulus Web Client.

Asset Actions
This section is for specifying asset actions the administrator wants to be specially high-
lighted in the Cumulus Web Client.

If the list is empty, all actions available to a user are offered in no particular order when 
files are downloaded via the Cumulus Web Client. If you add Asset actions to this list, 
these asset actions will be offered on top of the list of available asset actions under the 
label Most used.

You can add Asset Actions to, or remove them from the list using the according but-
tons.
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The History Tab
This tab contains a list of old versions of the Cumulus Web Client configuration. A new 
entry is added each time you save changes made with the Cumulus Web Client Con-
figurator. While saving, you can add a description of your changes which might be 
helpful in order to keep track of them. You can load an old configuration and make it 
current again, and you can delete old configurations.

Current Change Description: Displays the description entered for the current version 
of the configuration.
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CIP Configurator

The Cumulus Integration Platform (CIP) is a web application that serves as a technical

interface to the entire Canto Cumulus world. As such, it can be used with all kinds of

clients and solutions built on top of it. Cumulus Portals and Cumulus Mobile App are

Cumulus Web Solutions that are built on CIP. 

This chapter provides information on the configuration of CIP, Portals and Mobile App.
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Overview 
The CIP Configurator is a module of the Cumulus Web Server Console. Once you open 
it you see a list of CIP configuration files. These are cip-config.xml of different CIP 
instances. You can add existing cip-config.xml or edit existing ones

As Cumulus Portals and Cumulus Mobile App are Cumulus Web Solutions that are 
built on CIP, they retrieve their configuration data from the CIP Configurator. CIP can 
support multiple Cumulus Portals and Cumulus Mobile App instances. (For more 
information on how to set up multiple instances, see Configuring Multiple Instances.)

The most important information is the name of the CIP configuration an applications 
uses.

The following sections describe how CIP and the applications built on it are config-
ured via the various tabs of the CIP Configurator.

• The Settings Tab
• The Portals Tab
• The Mobile App Tab
• The Media Delivery Tab
• The History Tab
Once a CIP configuration is saved, it will be employed next time a user logs into the 
corresponding CIP instance, e.g. Cumulus Portals; e.g. the defined filters are displayed 
in the chosen sequence and the user can apply them.

http://www.canto.com
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Permissions for Accessing/Downloading Files via CIP-based 
Applications

CIP based applications such as Portals, CADA, or the Mobile Client are by default pro-
hibited from directly accessing or downloading assets stored in Cumulus. 

However, certain use cases rely on direct access to the original files, e.g. if you want to 
make files accessible offline for the Mobile Client, or if CADA is employed to import 
files into Adobe applications such as InDesign. To enable direct access to files, you 
must grant the "Show Original Asset" permission in addition to the "Download Asset" 
permission to the affected users for all catalogs they have to use.

Because downloading files e.g. in Portals is always processed via Asset Actions – even 
with the "Copy Original Asset" option –, only the "Download Asset" permission is 
required.

However, for assets stored in Amazon AWS or Windows Azure, Portals supports down-
loading from the original cloud location. To use this feature, the user needs the "Show 
Original Asset" permission in addition to the "Download Asset" permission.

For more details on permissions see Advanced View: Permissions.

http://www.canto.com
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The Settings Tab
Lists configurations that contain the information required by the Cumulus Server that 
serves the CIP web application:

• Catalog Access
• Filters

http://www.canto.com
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Catalog Access
A list of Catalog Alias Configurations is displayed. A Catalog Alias Configuration 
defines the Cumulus Server, the user and the catalogs used with a CIP instance. Canto 
provides several pre-configured Catalog Alias Configurations to be used with 
Cumulus Portals and Cumulus Mobile App. 

You can add more Catalog Alias Configurations or edit existing ones. Clicking on the 
appropriate button opens the Catalog Configuration window.

Catalog Configuration

The Catalog Configuration window contains following fields: 

• Catalog Alias – The name must be unique.
• Cumulus Server Address – IP address or DNS resolvable name of the machine run-

ning the Cumulus Server. Required Value!
• User Name – the Cumulus user used for web visitors that are not logged in. 

This user also is the one whose settings are employed for the landing page of the 
Send Collection Links (PIN). Therefore this user should have access to all catalogs 
configured for Web Access and to all shared collections.

NOTE: This user must be created via the Cumulus User Administration and must 
have appropriate permissions. 

• Password – The password for the specified user (as set in the Cumulus User 
Administration). 

http://www.canto.com
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• Catalogs – Lists the catalogs available with this configuration by name. You can 
remove catalogs or add catalogs that are managed by the Cumulus Server defined 
for this configuration.
If the option Required is activated for catalogs, the CIP alias can be used only, if all 
required catalogs are available at the server and can be opened by the user. – Cat-
alogs that are not set as required will not impact the usage of the respective CIP 
alias. 

NOTE: Lock
You can lock the above four setting so that they cannot be overwritten with the 
values set for a logged in user. If, for example, the User Name and Password are 
locked, only the specified user can use this catalog alias. If User Name and Pass-
word are not locked, any Cumulus user can log in and use this catalog alias.

• Usage – Drop-down list to select the designated usage of the catalog alias. The fol-
lowing possibilities are provided:
• General Access
• Opening Upload Collection
• Opening Download Collection
• Resetting Passwords

• Only allow the following operations – Activate this option to restrict the usage of 
the catalog alias to specified operations. If this option is not activated, the usage of 
the catalog alias is controlled by the permissions of the specified user. 

• Operations – List of allowed operations. You can add or remove operations via the 
respective buttons.

http://www.canto.com
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Catalog Aliases for Special Purposes

Reset Password Catalog Alias

The reset password feature requires a (technical) user with Global User Administrator 
permissions. Make sure to lock this user and its password!
No catalog needs to be specified for the reset password feature.

Portals Preview Landing Page Catalog Alias

This catalog alias is needed for the Video Link to videos published on the Video Cloud 
to work properly. Such links direct to Portals, where a landing page is generated that 
contains the player to which the video is streamed from the Video Cloud. 

The catalog alias for the Portals preview landing page must be configured as follows:

• A technical user with appropriate permission must be specified. Make sure to lock 
this user and its password!

• All catalogs containing the originals of the videos that shall be streamed from the 
Video Cloud must be specified (must be locked).

• It is strongly recommended to limit the allowed operations to preview/video in 
order to prevent other operations to be executed with this catalog alias.

http://www.canto.com
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Filters
A list of Filter Set Configurations is displayed. A Filter Set defines a set of filters and their 
options. Canto provides preconfigured Filter Sets to be used e.g. with Cumulus Portals 
and Cumulus Mobile App. 

You can adjust the sequence of the Filter Set Configurations with the buttons on the 
right side. 

You can edit existing Filter Set Configurations or add new ones. Clicking the according 
buttons opens the Filter Set Configuration window.

http://www.canto.com
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Filter Set Configuration

This window is for editing existing filter sets, or specifying new ones. 

• Filter Set Name – Name of the filter set to be edited (existing or new one). 
• Configured Filters – List of filters that are contained in the current filter set. 

You can edit or remove existing filters or ad new ones according buttons below 
the list. And you can change the sequence of the filters with the according buttons 
on the right side of the list.

NOTE: Employing filters influences the performance. The more filters are 
employed, the more load for the Cumulus Server.

There are different types of filters: 

• Standard – filters based on the values of record fields, 
• Input – field-based filters which can be further controlled via input by the user.
• Range Input – field-based filters which can be further controlled via input by the 

user. The user can enter a range of desired field values.
• Query-based – filters based on queries, which are usually more complex than sim-

ple field-based filters
• Type-ahead – filters based on the values of string lists. 
You can adjust the sequence of the filters with the buttons on the right side. 

You can add more filter or edit existing ones via the appropriate buttons.

http://www.canto.com
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Adding Standard Field-based Filters

To add a field based filter:

1. Click Add.
The Select Filter Type window is displayed.

2. Click Standard.
The Select the field for filtering window is displayed.

3. Select the field you want to use for filtering. Click OK.
The Configure Filter window is displayed.

4. You can

• enter a name for the filter (default: the name of the selected field)
• enter a description
• define whether this filter is displayed collapsed or expanded at startup
Depending on the selected field you can

• define whether this filter is displayed hierarchically (default: a flat list of options) 
• define whether the flat list is ordered by frequency (default: alphabetically), and 

the number of initially shown entries
• define, whether the user can select multiple options from the list (default: no) 

and the logical operator used to combine these options (default: OR)
5. Click OK.

http://www.canto.com
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Adding Input Filters

To add an input filter:

1. Click Add.
The Select Filter Type window is displayed.

2. Select Input.
The Select the field for filtering window is displayed.

3. Select the field you want to use for filtering.
The Configure Filter window is displayed.

4. Enter a name for the filter (default: the name of the selected field).

5. Enter a description (optional).

6. Define whether this filter is displayed collapsed or expanded at startup.

For most field types, filtering is performed according to the user’s input. 
If you have selected a string field in step 2), you must

7. define how filtering is processed: either

• according to the users input (Filter by entered value), OR
• according to values suggested by Cumulus (Filter by suggested values). 

Initially, Cumulus suggests the values most frequently contained in the selected 
field. When the user starts typing, the initial suggestions are replaced with sug-
gestions matching the user’s input. 

8. If Filter by entered value is selected, you must additionally specify the search 
operator to be used with the user’s input (Starts with / Does not start with / Equal 
to / Not equal to).

http://www.canto.com
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If Filter by suggested values is selected, you must additionally specify the initial 
number of suggestions for the most frequently contained values, and the number 
of suggestions matching the user’s input.

9. Click OK.

Adding Range Filters

To add an range input filter:

1. Click Add.
The Select Filter Type window is displayed.

2. Select Range input.
The Select the field for filtering window is displayed.

3. Select the field you want to use for filtering.
The Configure Filter window is displayed.

4. Enter a name for the filter (default: the name of the selected field).

5. Enter a description.

6. Define whether this filter is displayed collapsed or expanded at startup.

7. Click OK.

NOTE: Field-based filters are only available to Portals users if the respective field is 
contained in each catalog the user can access. A filter based on a field that is not 
part of all accessible catalogs is not displayed to the user!

http://www.canto.com
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Adding Query-based Filters

To add a query based filter:

1. Click Add.
The Select Filter Type window is displayed.

2. Select Query-based.
The Configure Filter window is displayed.

3. Enter a name for the new filter. Additionally, you can

• enter a description
• define whether this filter is displayed collapsed or expanded at startup

4. Define the options for this filter. An option is a query with a name (and an 
optional description):

• Click Add.
The Configure Filter Option window is displayed

• Enter a name and the desired query.
Note that queries for filters must be created individually. It is not possible to use 
previously saved queries! The most convenient way to create a query is to com-
pose it in the Cumulus  Client’s Find window in Advanced Mode, then copy it 
into the Query field of the Configure Filter Option window.

5. Click OK.

6. Add (or edit) more filter options, if necessary.

7. Define which logical operator you want to use to combine the defined options: 
AND or OR.

http://www.canto.com
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8. Click OK.

Names and descriptions of filters and filter options can be easily adapted to a multi-
tude of languages via the  button in the respective windows. Clicking this but-
ton opens a window for entering translations of the name and description.

Known Issue: Filters and Localization

After installing Cumulus Web Solutions going to the CIP Configurator, then, Settings 
and Filters, you may not be able to add a filter because the Standard button is deac-
tivated and other options return an error. This probably means you have not installed 
your Cumulus Products in the English language.

The sample below shows the CIP Configurator issue after installing Cumulus in French 
(The Standard button is disabled and clicking on another button will return an error):

http://www.canto.com
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To build the fields list needed for filter settings, the CIP Configurator is checking the 
catalogs configured in the Catalog Aliases (under Catalog Access) and try to find such 
catalog name in your catalogs folder. When installing Cumulus in another language 
than English, the Sample Catalog name is localized but the default cip-config.xml file 
still has the English catalog name.

For instance, in a French installation, the Sample Catalog will be named "Catalogue 
d'exemple" (which is it's  ccf file name as well). CIP Configurator finds "Sample Catalog" 
for all catalog aliases and no file is matching that name, so no field can be loaded to 
configure filters.

http://www.canto.com
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What to do? Just go the Catalog Access and for at least one Catalog Alias, remove the 
Sample Catalog and add an existing catalog. Then, everything works as expected.
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The Portals Tab
The list of Portals Configurations is displayed. 

NOTE: The initial Portals configuration is done via the customization.js file. For 
details, see the Cumulus Web Solutions chapter of the appropriate Installation 
Guide; under “Cumulus Web Solutions: Initial Steps” you will find the section 
“Initially Configuring Cumulus Portals.” However, you need a properly set up 
Portals configuration to be referenced by the customization.js file.

A Portals configuration is defined via various tabs:

Catalog Access Tab

• Require Login
If activated, any website visitor must log in and therefore needs a Cumulus user 
account. Connecting to Portals opens a Welcome page with login prompt only.
If not activated, website visitors can use the configured catalog without being 
logged in.

• Catalog Aliases – For each usage case, select the desired Catalog Aliases from 
those that are configured under Catalog Access on the Settings tab (for the Server 
displayed).

NOTE: Video Cloud – Video Link
If you publish videos to the Video Cloud and want to make use of the Video Link 
feature, you must specify an appropriate Catalog Alias, as defined in the CIP con-
figuration. See also: Portals Preview Landing Page Catalog Alias.

http://www.canto.com
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• Catalog Name - Root Category – Name of the catalog and name of the category 
that will be displayed as the topmost level on the Portals landing Page. Only cate-
gories below the specified root category will be visible to the Portals user and dis-
played in the filter panel. – Any category with a valid Container Type can be 
configured as root category for Portals.

NOTE: This setting only affects the visibility of categories, not the visibility/accessi-
bility of records or assets. Even items that are not assigned to any category, or to a 
category outside the tree defined by the specified root category, can be retrieved, 
e.g. via a quicksearch. To restrict the visibility/ accessibility of records and assets, 
you must use item permissions and user/role permissions.

• Offer Feature to Reset the Password – If activated, Portals users are enabled to 
reset their passwords themselves. A Reset password link is shown on the login 
page of Portals.

• Catalog alias to use – The catalog alias to be used for password reset requests. 

NOTE: For security reasons it is strongly recommended to only use a specifically 
dedicated catalog alias for this purpose!

http://www.canto.com
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Layout Tab

This section is for specifying the Record View Sets to be used, and the asset relations 
types to be displayed in Portals. 

• Default Record View Set – The Record View set that is employed for all users with-
out a specific setting. Use the drop-down list to select a Record View Set to be used 
as default.

• Default Relation Types – The relation types that are displayed for all users without 
a specific setting. The ... button opens a dialog to configure the default Relations 
types.

• User/role specific Settings – Record View Set and Relation Types settings for indi-
vidual users/roles. It’s a table with 3 columns: User (or Role, depending on the con-
figuration of your Cumulus), Record View Set and Relation Types. 

• Assets per Page – The maximum number of assets that will be displayed on any 
page in Portals, to be defined for different screen sizes.

Click Add to open the User/role specific settings dialog. Select a user or role. You 
must deactivate the Use Default option(s), before you can assign a specific Record 
View Set or specific Relation Types to a user or role. When you are done, Click OK. The 
user or role is added to the table. 

Additional information on Record View Sets for Portals

Canto strongly recommends to create (and use) at least one dedicated Record View 
Set to be used with Portals.

For a general description on how to create Record View Sets, see: Creating and Editing 
Record View Sets.

http://www.canto.com
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For an overview on which view modes of a Record View Set control which pages in 
Portals, and what specifics must be taken into account, see: Using Record View Sets for 
various Cumulus Clients.

Additional information on Asset Relation Types

For a general description of Related Assets, see: Managing Related Assets, and Admin-
istering Asset Relations..

Filters Tab

• Only Find Masters – If activated, records for contained or referenced assets are not 
displayed.

• Filter Set – Select the desired Filter Set from those that are configured under Filters 
on the Settings tab.

NOTE: If the selected filter set contains field-based filters (standard, input or range 
filters), the respective fields must be contained in all catalogs that are accessible 
for a Portals user. Otherwise, the filter won’t be displayed to the user.

Sorting Tab

• Available Sorting Fields –The fields available for sorting are listed. You can edit, 
add and remove fields with the appropriate buttons.

• Initial Sorting – If activated, you can select the field to be used for sorting and the 
sorting direction.

• Show – Select how many fields you want to be displayed, all others will be hidden 
in a drop-down list.
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Plug-Ins Tab

The Portals Plug-in API allows you to add additional functionality. This tab lists the 
uploaded and available plug-ins. You can configure, add and remove plug-ins with 
the appropriate buttons. The Configure button is only active with plug-ins that offer 
to configure parameters. The check marks under ACTIVE denote whether a plug-in is 
active and available to users.

Click Add to add a plug-in. Then you can select a plug-in file (ZIP archive) and upload 
it. Save it with your configuration and, if required, configure it. Once it is ready for use 
activate it. Then the additional functionality of the plug-in is immediately available for 
your Portals users.

NOTE: A plug-in with the same ID and version as one that is already installed 
cannot be uploaded. If you want to re-upload the same plug-in version, you 
need to remove the installed plug-in.

A plug-in for Portals consists of a number of files packaged into a ZIP archive. For more 
information on Portals plug-ins see the technical documentation provided with the 
Cumulus Portals SDK.
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IMPORTANT! Migration of Plug-ins Prior to Cumulus 11.0
With Cumulus 11.0 Portals' code structure was improved - heading towards a 
design approach that helps customer developers with customization and 
theming. Therefore, all plug-ins developed prior to Cumulus 11.0 must be 
tested again and, if necessary, migrated. Also, UI customizations will no longer 
work and must be migrated! However, as the reworking of the Portals code is 
not yet finished, Canto cannot guarantee that migrated customizations will 
properly work in future releases. Therefore, it is strongly recommended to post-
pone migration of UI customizations until further notice. For more information 
see the technical documentation provided with the Cumulus Portals SDK.
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Advanced Tab

• Skip landing page – If activated, users will not see a landing page when Portals is 
started (e.g. a top level categories overview), but the unfiltered content of the 
open catalog(s) below the root categories as defined on the Catalog Access tab.

• Enable terms and conditions while download – If activated, users who want to 
download files first must agree to certain terms and conditions by activating a 
respective checkbox in the download dialog. Only then, the download can be 
started. Additionally, a link to the terms and conditions in questions can be pro-
vided.
• Terms and conditions page – Link to a page that holds the terms and condi-

tions in question. Any valid URL can be used.

NOTE: It’s up to you as a provider of downloadable content whether you 
require users to agree to certain terms and conditions, or not. But if you do so, 
it’s your responsibility to prepare, upload and maintain an appropriate terms 
and conditions page 
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Configuring Multiple Instances

You can configure and run simultaneously multiple Portals instances. 

To create a new instance, you must perform following steps to:

• Copy and rename the Portals web application folder 
(e.g. C:\Program Files\Canto\Cumulus Web Solutions\apache-tomcat-x.x.xx\webapps\portals).

• Edit the customization.js file in the copied and renamed web application folder 
and give your new instance a new Portals Configuration name; e.g. set 
clientConfiguration to com.canto.cumulus.NewName
(For details, see the Cumulus Web Solutions chapter of the appropriate Installation 
Guide; under “Cumulus Web Solutions: Initial Steps” you will find the section “Ini-
tially Configuring Cumulus Portals.”)

• Add your new Portals Configuration (use the new name) to the Portals Configura-
tions on Portals tab of the CIP Configurator and configure it (see above).
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The Media Delivery Tab
With the Media Delivery on Premise (MDO) option, Cumulus can act as a provider and 
distributor for assets. Renditions of cataloged assets can be integrated e.g. in web sites 
and accessed via specific URLs.

Use this tab to define:

• The Asset Action that will be performed on an asset to create the master image 
which will either be used to generate arbitrary renditions. 

• The Cumulus record field that will be used to identify assets and renditions.
• The settings of the cache, that is, the amount of time during which a requested 

rendition is delivered out of the cache, before Cumulus checks for necessary 
updates, and the amount of disk space available for the cache.

• The default output format and compression quality.

NOTE: No MDO-specific trigger action available for MDO!
As this question came up repeatedly, please remember that Cumulus does not 
provide a specific trigger action for MDO, as it does for MDC. With the Media 
Delivery Cloud, this trigger action is used to synchronize certain altered meta 
data from the Cumulus Server to the MDC server. As there is no external server 
involved with the Media Delivery on Premise, there is no need for data synchro-
nization — the MDO alway knows about the most recent meta data changes.

Master Image

Asset Actions – a table with the asset actions that will generate master images. You 
can add more Asset Actions (from the Asset Actions available at the Cumulus Server), 
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remove Asset Actions from the list, and define the order in which they will be per-
formed, using the appropriate buttons.

If there are multiple Asset Actions listed, they will be performed in the given order. 
However, as soon as an Asset Action generates a result, the rest of the Asset Actions in 
the list is ignored. This behavior can be used to easily generate master images from 
different asset types, e.g. images or videos, that require different asset actions to gen-
erate them. 

NOTE: Asset Actions – Required Settings 
When defining Asset Actions for this purpose, make sure that you have speci-
fied appropriate pixel values for Width and Height in the Scale Dimensions 
Section of the Pixel Image Converter Parameters dialog. Additionally, the 
options: “Use Size as Bounding Box” and “Work at Image Size” must be acti-
vated, while the option “Enlarge Smaller Images” must be deactivated!

Catalog Access

Catalog Alias – Select the desired Catalog Alias from those that are configured under 
Catalog Access on the Settings tab (for the Server displayed).

Item Identifier

Radio buttons to toggle between the methods to identify assets and renditions. This 
value is necessary for 3rd party systems to build a proper MDO URL. If 3rd party sys-
tems don’t have access to Cumulus and therefore can’t retrieve the default values, a 
value from a different field can serve as identifier, e.g. an article number already known 
to the 3rd party system. Any field of type string or integer that is indexed for Sorting/
Searching can be selected, however it is highly recommended to only work with val-
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ues that are unique for all concerned catalogs. Otherwise, only the first found asset or 
rendition would be taken into account.

• Use default – By default, either the Media Delivery Cloud Asset ID (for assets), or the 
Media Delivery Cloud Image ID (for renditions), or the Unique Item ID (for both assets 
and renditions) can be used as item identifier in an MDO URL.

• Use specific field – Select a field from the drop-down list to be used as item iden-
tifier.

Cache

• Cache Expiration [s] – Time (in seconds) during which an asset and it’s renditions 
are delivered from the cache after the initial request. After that time, Cumulus 
checks whether the current rendition is still up-to-date, and updates it, if necessary.

• Fallback Image Cache Expiration [s] – Time (in seconds) during which a fallback 
image is delivered from the cache after the initial request. After that time, Cumulus 
checks whether the original asset or rendition is available again, and replaces the 
cache content.
The fallback image is used if the original image is not available for any reason. By 
default, the expiration time is the same as for the asset and rendition cache. 

• Cache Max. Disc Size [MB] – Amount of disk space the cache may use at the most.

Output Format

These values are only relevant, if the desired output format or compression quality is 
not specified in the URL that request the rendition. 

• Default Format – Select the default output format (JPEG, PNG, or GIF). 
• JPEG compression Quality – Select the desired quality for JPEGs.

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CIP CONFIGURATOR THE MEDIA DELIVERY TAB

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

• PNG compression Quality – Select the desired quality for PNGs.
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The Mobile App Tab
The list of Cumulus Mobile App Configurations is displayed. A Mobile App configura-
tion is defined via the various tabs:

Catalog Access Tab

• Catalog Alias – Select the desired Catalog Alias from those that are configured 
under Catalog Access on the Settings tab (for the Server displayed).

Layout Tab

This section is for specifying Record View Set options.

• Default Record View Set – Drop-down list to select the shared Record View Set to 
be used as default

Additionally, you can assign specific Record View Sets to individual users or roles. 

Click Add to select a user or role and assign a Record View Set. The user or role is dis-
played in the User/Role list, together with the assigned View Set. You can modify such 
users or roles and remove them from the list using the according buttons.

Filters Tab

• Filter Set – Select the desired Filter Set from those that are configured under Filters 
on the Settings tab.
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NOTE: With the Cumulus Mobile App the Only Find Masters option is always 
active and therefore records for contained or referenced assets are not dis-
played.

TIP: URL Used With Mobile

On your iPhone/iPad use the iOS settings for the Cumulus Mobile App to con-
figure the URL to be used (http://IP_Server:port). 
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The History Tab
This tab displays a list of former versions of the CIP configuration. A new entry is added 
each time you save changes made with the CIP Configurator. While saving, you can 
add a description of your changes which might be helpful in order to keep track of 
them. You can load an old configuration and make it current again, and you can delete 
old configurations.
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Configuring RoboFlow

All RoboFlow configuration tasks are performed with the RoboFlow module of the

Cumulus Web Server Console

First you configure the global settings for RoboFlow to define parameters valid for all

workflows and then you define workflows. 
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Prerequisites for Configuring RoboFlow
The RoboFlow Server Application needs to know the Cumulus Server to connect to 
and the user account to be employed for the connection. 

This Cumulus user (or role) must have all the permissions required for the tasks to be 
performed within workflows and access to all catalogs required. 

IMPORTANT! It is highly recommended employing the Cumulus Administra-
tor as that user because some functionalities can only be performed by the 
Cumulus Administrator (e.g. deletion of $Source categories). Also, no specific 
permission settings are required for the Cumulus Administrator.

Additionally, the user employed for RoboFlow must create the specific sets used in 
RoboFlow (Asset Handling Set, Asset Actions, Permission Template, …) at the 
Cumulus Desktop Client. Note that these sets are best not shared with other users, in 
order to avoid them being changed inadvertently.
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RoboFlow Configurator
All RoboFlow configuration tasks are performed with the RoboFlow module of the 
Cumulus Web Server Console.

NOTE: If the RoboFlow Server Application runs on a different machine than the 
Web Server Console and you access the RoboFlow module for the first time, an 
error message is displayed because it does not know the IP or DNS-name of the 
RoboFlow server. It assumes by default "localhost".  You can type in the IP or 
DNS-name and click connect. It will remember it for the next time.. 
Enter the required information and click Connect. 

A list of all RoboFlow workflows defined for your installation is displayed. If you start 
RoboFlow for the first time, this list will be empty.

The following sections describe the configuration options. Before you start to config-
ure workflows, you have to define a few global settings.
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Defining Global Workflow Settings
The global settings define parameters valid for all workflows. To specify them click 
Global settings.

It is mandatory is to define the Cumulus Server and the user account to be employed 
for the connection. 
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Since RoboFlow is a back-end-server-process, it is best to configure the email param-
eters. So you can be notified in case of a problem. Some workflows might require it, 
too. RoboFlow does not use the Cumulus email-engine because it needs to be able to 
notify when Cumulus is down or unreachable.

If your Cumulus installation uses Roles, you should specify the default Cumulus Per-
missions Template. 
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Defining Workflows
In Canto RoboFlow, the work to be done is defined as one or many workflows. 
Depending on the workflow type, a workflow consists of one or several action scripts. 
Each action script is comprised of several actions. The workflow type determines the 
available action scripts but the user defines the concrete actions to be executed 
within an action script.

Workflows may process different inputs. The input processed by a workflow deter-
mines its type. The following types exist:

• processing results of a SQL query
• synchronizing files from file system folder structure with a catalog
• processing a list of categories
• processing a list of records
• processing files newly placed in a file system folder (hot folder)
The workflow type is selected while creating a new workflow via the Cumulus Web 
Server Console. The type of a workflow cannot be changed after the workflow has 
been created.
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Creating a Workflow
Click Create new workflow and the window for defining it appears: 

Depending on the workflow type, a workflow has different parameters. For example, 
in case of a workflow processing an SQL query, database connection settings and the 
SQL query to execute must be set via the workflow parameters.

If a workflow is enabled, it is started by an event. The following events exist:

• a Cumulus trigger
• a timer
• another workflow
During the startup phase of a workflow, the workflow might check a pre-condition 
and stop running if the pre-condition is not met. A common example for such a pre-
condition is whether a monitored file system path contains a new file.
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Action Scripts and Actions
Depending on the workflow type, each workflow consists of 1 to 3 independent 
action scripts. For example, a workflow processing the results of a SQL query has the 
following 2 action scripts:

• action script for SQL results
• action script for records
The available action scripts are shown in the user interface of the workflow as tabs. 

Each action script may contain an arbitrary number and a collection of actions. Each 
action defines a step in the workflow like opening a catalog, moving a file to a different 
folder or substituting text in a string.
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You need to define the actions and their order. You choose the action from the 
Actions drop down menu. Actions are grouped by categories, e.g. actions manipulat-
ing a file or actions able to create a notification. 

Depending on the action selected, different parameters are available like input values. 
Information is passed between actions via variables. Variables are only visible within 
the action script they were defined in. A workflow might have some global parameters 
which are available as global variables, too.

Canto RoboFlow also supports conditions allowing parts of an action script to be only 
executed if a certain condition holds. Conditions can be nested.
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Legacy Pre-defined Workflows of Canto 
RoboFlow 8

Canto RoboFlow 8 only provided a set of pre-defined workflows. The user was not 
able to define new workflows with different action scripts.

Those legacy pre-defined workflows were still available with 9.0 and 9.1 and will be no 
longer available starting with 9.2. They will still run with Canto RoboFlow 9.2 but the 
user cannot configure them or create new ones. 
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Cumulus Glossary

This Glossary offers an alphabetical listing of terms and phrases used throughout this 

manual and Cumulus.
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Action 
Function or combination of certain functions. Cumulus provides different types of 
actions. See also Asset Action, Trigger Action.

Asset
A general term describing any type of digital media (including graphic, page layout, 
presentation, sound, and video files) that has value to its owner. 

Asset Action
Combination of certain functions saved under a chosen name that is performed on 
assets in Cumulus. 

Asset Relations
Cumulus supports several types of relations between files. Cumulus relation types are: 

• Contained and Referenced – A file can contain other files or reference to other files, 
or a file can be contained in or referenced by other files.

• Variant – A file can be a variant of another file, or have other files as variants.
• Alternate – A file can be an alternate of another file, or have other files as alternates. 
• Custom– in addition to the above listed relations, a Cumulus Catalog Administra-

tor can add other relations to a catalog. 

Asset Handling Module
When cataloging and accessing assets, Cumulus uses different modules: Asset Stor-
age, Asset Processor, Metadata and Filter modules. 
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Asset Handling Set
A setting that defines how Cumulus handles assets – during the cataloging process 
and when accessing assets.

Asset Information
The information about an asset as stored in the record associated with the asset.

Asset Information window
A special Cumulus Desktop Client window that displays the information about a cata-
loged asset. This information is stored in the asset’s record. (See also Record.) Cumulus 
also provides an Information View and an Information Pane.

Asset Reference
The mechanism by which Cumulus tracks the actual location of an asset managed in 
a Cumulus catalog.

AXR (Asset Cross References)
Automatic detection of usage and cross-references of assets within Cumulus. Cumu-
lus is able to detect links and placed assets in compound documents such as QuarkX-
Press, EPS, Adobe InDesign, and Illustrator (version 8, 9) as well as Microsoft Word and 
PowerPoint documents. 

Basket
A temporary or intermediate repository which is especially useful to collect files from 
different locations within the catalog hierarchy. 
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Boolean
A system of logic based on two possible values: true or false. Cumulus uses the Bool-
ean operators "and" and "or" to combine search conditions.

Cache
A temporary storage area where frequently accessed data can be stored for rapid 
access.

Catalog
A special file (with the extension .ccf ) that Cumulus creates to manage cataloged 
assets. See also Asset and Cumulus Catalog File.

Catalog file name
Name of the special file for a catalog (  with the extension .ccf). The catalog name 
defaults to this file name (without the extension). The catalog name can be changed 
without changing the catalog file name. See also Cumulus Catalog File.

Cataloging
The process by which a user adds one or more assets to a catalog. 

Catalog Administrator
Cumulus user with administrator permissions for a catalog who can edit the Catalog 
Settings.

Category
Cumulus categories are used to organize records, much like folders are used to orga-
nize files in a traditional filing cabinet. But the asset can appear in any number of 
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Cumulus categories at one time. They are similar in purpose to keywords used in other 
programs. See also Folder category and Related category.

Category Information window
A special Cumulus Desktop Client window that displays the information about cate-
gories.

Category Exchange File
See Cumulus Category Exchange File. 

Category pane
With Cumulus Desktop Client, it is located on the left side of the Collection window 
and displays category names in a hierarchical list. Multiple tabs are provided so that 
categories can be created and displayed in separate tabs.

Category View Set 
A setting that defines the display options for the Category Information window of the 
Cumulus Desktop Client. For each tab different display options can be set.

Central asset location
A central asset location is a single storage location used to store certain digital assets. 
Employing a central asset location ensures your assets remain accessible to all, and 
can more easily be accounted for.

Client
A computer user who accesses a server application (such as the Cumulus Server) 
across a network.
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Client/server architecture
A software configuration in which users (also called clients) access a server application 
across a network.

Collection
Any set of records from any one catalog. With Cumulus Desktop Client, a collection 
includes the records’ display properties and it can be saved (see Cumulus Collection 
File) and opened again. A collection – whether saved or unsaved – is always con-
nected to its catalog. In order to open a particular collection you must have access to 
its catalog.

Collections overlay
List of all collections available to a user of Cumulus Portals. 

Collection window
A Cumulus Desktop Client window featuring two panes (Category pane and Record 
pane) that function as the central user interface. 

Compound search
A search query consisting of two or more search conditions.

Container
With Cumulus Web Client containers are used to organize files, much like folders are 
used to organize files in a traditional filing cabinet. 
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Container browser 
Cumulus Web Client means to browse through and navigate in the container hierar-
chy. 

Context menu
Also called shortcut menu. A menu that opens when clicking the right mouse but-
ton /  Control key + mouse button. The available options are related to the selected 
object.

Controlled vocabulary
A restricted list of words or terms used for labeling, indexing or categorizing. Con-
trolled vocabulary schemes provide a way to organize knowledge for subsequent 
retrieval. They mandate the use of predefined, authorized terms, in contrast to natural 
language vocabularies, where there is no such restriction.

CSS
Cascading Style Sheets. A stylesheet language used to describe the presentation of a 
document written in HTML or XML. A CSS file defines how elements should be ren-
dered on screen, on paper, in speech, or on other media.

Cumulus 
An indispensable digital asset management system for organizing and managing dig-
ital assets. See also Asset.

There are different editions of Cumulus designed to meet the needs of anyone who 
wants to keep track of their digital media: Cumulus Workgroup and Cumulus Enter-
prise. 

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUMULUS GLOSSARY

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

Cumulus Administrator 
A person who configures and manages Cumulus catalogs. The Administrator is 
responsible for keeping the catalogs running smoothly for Cumulus Client users, back-
ing up catalogs, and other tasks. 

Cumulus application window
The main Cumulus Desktop Client window containing the menu bar, the toolbar, the 
statusbar, and – as “child” window(s) – the Collection window(s) with various panes.

Cumulus Action
See Asset Action.

Cumulus Catalog File
A special file (with the extension .ccf) that Cumulus creates to manage cataloged 
assets (digital media).

Cumulus Category Exchange File
A file (  with the extension .cce) that Cumulus creates when exporting category infor-
mation.

Cumulus Collection File
A special file (  with the extension .cfe) that Cumulus creates to manage saved col-
lections.

Cumulus Portals
The Cumulus tool to publish and market digital assets on dynamically generated Web 
pages to the Web. 
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Cumulus Record Exchange File
A special file (  with the extension .cre) that Cumulus creates when exporting record 
information.

Cumulus Server
The computer where Cumulus Server software is installed and where Cumulus cata-
logs should reside.

Cumulus Vault
Cumulus full-featured Version Control System that manages user access to asset files 
and provides up-to-the-minute information on each asset’s version history.

Cumulus Web Client
Provides Cumulus catalogs online and offers read/write access for metadata edits as 
well as asset uploads and downloads to users with a standard Web browser. 

Details page
Can be displayed with Cumulus Portals. It provides a preview image of the file and 
selected metadata, as defined by an administrator. 

Details view
Cumulus view mode. With Cumulus Desktop Client, each record appears in the 
Record pane as a text listing that includes fields you can define (e.g., record name, file 
format, resolution, etc.). See also Thumbnail view, Information view.
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Drag and Drop
A way to move user-interface objects by dragging them with the mouse and drop-
ping them into targets.

EJaP
Embedded Java PlugIn. Technology that provides unlimited possibilities to add new 
functionality or to integrate Cumulus into workflows. EJaPs are Java code that runs 
within the Cumulus application. 

EJSP
Embedded Server Plug-In. Technology that provides possibilities to add new function-
ality, or to integrate Cumulus into workflows. ESPs are similar to EJaPs (Embedded Java 
PlugIn). Whereas EJaPs are Java code that runs within the Cumulus application, ESPs 
are Java code that runs at the Cumulus Server. 

EXIF
Exchangeable Image File Format. Standard for storing interchangeable information in 
image files, especially those using JPEG compression. Most digital cameras now use 
the EXIF format. The format is part of the DCF standard created by JEIDA (Japan Elec-
tronics and Information Technology Industries Association) to encourage inter-opera-
bility between imaging devices. Cumulus can read EXIF metadata information while 
cataloging. You can view and edit this metadata. See also Metadata.

Filters
Ambiguous:

http://www.canto.com
http://www.canto.com
http://www.canto.com


CUMULUS – CUMULUS GLOSSARY

© 2019, CANTO GMBH. ALL RIGHTS RESERVED.

• Software utilities that Cumulus uses to capture information about an asset during 
the cataloging process. For more information on the availability of new file filters, 
please see the Canto Website (www.canto.com).

• With Web Client and Portals: means to filter to narrow down the number of dis-
played files in order to just get what is needed.

Find window
Cumulus tool provided by the Desktop Client that enables users to search catalogs for 
records or categories that match search conditions.

Folder category
Folder categories are automatically created by Cumulus during the cataloging pro-
cess. These automatically created categories resemble the folder or directory hierar-
chy in which the assets reside. 

With Desktop Client, they are identified by a smaller folder in their icons. They are cre-
ated by default but this option can be disabled.

FTP
File Transfer Protocol. A standard Internet protocol, which is the simplest way to 
exchange files between computers on the Internet. 

HTTP
HyperText Transfer Protocol. A standard Internet protocol, which is the protocol most 
often used in the World Wide Web to transfer information between servers and brows-
ers.
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Information view
Cumulus view mode displaying a file’s metadata. See also Thumbnail view, Details 
view.

Information window
Special Cumulus Desktop Client windows that display the information about records 
or categories. See also Asset Information window and Category Information window.

IPTC 
International Press Telecommunication Council. Standard for digital text applied to an 
image. Applications used for professional imaging, support IPTC; e.g. the text informa-
tion in Photoshop is a subset of the IPTC information. Cumulus can read IPTC meta-
data information while cataloging. You can view and edit this metadata and Cumulus 
can write your changes back to the asset. See also Metadata.

Java Server Page
Java Server Page (JSP) is a technology for controlling the content or appearance of 
Web pages through the use of servlets, small programs that are specified in the Web 
page and run on the Web server to modify the Web page before it is sent to the user 
who requested it. 

JSON
JavaScript Object Notation. An open-standard format that provides a syntax for stor-
ing and exchanging data. This common data format is used for asynchronous 
browser/server communication.
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LDAP
Lightweight Directory Access Protocol. Directories containing information such as 
names, phone numbers, and addresses are often stored on a variety of incompatible 
systems. LDAP provides a simple protocol that allows you to access and search these 
disparate directories over the Internet.

Media file
Any electronic or digital media file (including graphic, page layout, presentation, 
sound and video files). See also Asset.

Menubar
Horizontal bar containing the labels of drop down menus. The menu bar's purpose is 
to provide the majority of a program's essential functions at a standard place.

Metadata
Metadata is any data that helps to describe the content or characteristics of an asset. 
It is the information stored with each asset—such as file name, location, etc. Different 
types of assets have different metadata fields: an image file, for example, would con-
tain information on color and resolution, while an audio file would have a field for the 
playback duration.

Palette mode
Cumulus view mode that is specially designed for using Cumulus with another appli-
cation, e.g. a desktop publishing application. In palette mode the Cumulus application 
shrinks to a palette that can conveniently be used with another application. That way 
you can easily drag and drop cataloged assets into other applications. 
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Path/Pathname
A description of the location where a file is stored on a computer hard drive, server, or 
removable medium (such as CD-ROM, Syquest, Zip, Jaz, or MO cartridges).

Preview
A special program mode in which you can examine cataloged assets such as video 
clips, sound files, and image files.

Query
A combination of search conditions. Queries can be saved to disk and loaded into the 
Find window or provided as a predefined search to Web Client users. See also 
Searches, predefined.

Record
The actual catalog entry that Cumulus creates when an asset is added to a catalog. 
Records store valuable information about an asset, such as the file name, file location, 
file type, resolution, etc. 

Record Exchange File
See Cumulus Record Exchange file.

Record pane
Located on the right side of the Desktop Client Collection window, the Record pane 
displays records as thumbnails or plain text. See also Record, Thumbnail view and 
Details view.
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Related category
An alias of an existing category that acts as a virtual cross reference to the original cat-
egory. You can use related categories to place multiple instances of the same category 
under various parent categories, without having to copy the entire contents of the 
category. By default, the names of related categories are displayed in italics with a 
“(related)” appendix. 

Record View Set
A setting that defines how records are displayed in the different view modes Cumulus 
Desktop Client provides: Thumbnail View, Details View, Info View and Information win-
dow.

Resolution
The number of pixels per inch in any graphic file format. Higher-resolution files have a 
higher number of pixels per inch than lower-resolution files. Working with higher-res-
olution files usually requires more memory and hard disk space than working with 
lower-resolution files.

Responsive Web Design (RWD)
Approach to web design allowing web applications to adapt to the size and capabili-
ties of the device used and size of the browser window running in. Cumulus Portals is 
such a state-of-the-at web application.

Script
A list of instructions executed by a computer. Scripts are used by Cumulus to perform 
complex tasks automatically.
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Search icon, customized
Customizable icons for queries available for Cumulus Web Client if an administrator 
has defined search criteria that fit with the currently open catalog.

Searches, predefined
Queries made available for Cumulus Web Client users by an administrator. They are 
displayed as search entries in the main menu.

Server/Client Asset Transfer
A Cumulus feature (especially useful in a cross platform environment) that allows users 
in a network to access assets for previewing, copying and transferring via their con-
nection to the Cumulus Server. With this feature the user is not forced to have direct 
access to the computer where the asset is stored. Only the computer running the 
Cumulus Server requires this access. 

Simple search
A search query consisting of one search condition.

Portals
See Cumulus Portals.

Skin
A term for the particular way in which information is arranged and displayed on a 
computer screen.

Statusbar
A Cumulus Desktop Client bar providing descriptions on category/record status.
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Thumbnail
A miniature display of a cataloged asset.

Thumbnail view
Cumulus view mode. With Desktop Client the record appears with a miniature display 
of the cataloged asset in the Record pane.

Toolbar
A standard program tool that offers buttons as shortcuts to commonly used com-
mands.

Tooltip
A small floating descriptive window that appears above a toolbar button when the 
cursor is positioned over it.

Trigger
A stored procedure that is activated automatically when a specified event occurs. 
Cumulus Triggers can be used to perform many tasks, such as auditing catalogs, 
records and categories. Cumulus Triggers can be set for catalogs, records and catego-
ries. 

Trigger Action
The action performed when a Cumulus Trigger is activated. See also Action.

URL
Uniform Resource Locator. The address of a file (resource) accessible on the Internet. 
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Video Cloud
Utility for better availability, worldwide distribution and public streaming of videos. 
Videos in Cumulus can additionally be published to a 

Video Cloud, as offered by various providers. The “original” video files and all their 
metadata remain safe in Cumulus (stored in a Vault or on a file server), but the delivery 
of the video to websites – including Cumulus Portals and the Web Client – is per-
formed by the Video Cloud.

Workflow Administrator
Cumulus user with Workflow Administrator permissions. A Workflow Administrator 
can create, edit and delete workflows; add them to, delete them from and update 
them in catalogs; and remove them from assets (files).

XMP
Extensible Metadata Platform. Adobe’s XMP™ is a labeling technology that allows you 
to embed metadata into the asset itself. With an XMP-enabled application (e.g. all 
applications of Adobe Creative Suite), information about a project can be captured 
during the content creation process and embedded within the file and into a content 
management system. Cumulus can read XMP metadata information while cataloging. 
You can view and edit this metadata and Cumulus can write your changes back to the 
asset. See also Metadata.

Web Client
See Cumulus Web Client.
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